....;,;... r'"'

t

I

~i

Special Introductory Offer

·~·

15% Package Discount for:

·-

~

.

_.

~~...
~

~ff
...
r--

~

.

~

-

r

A Macintosh Journey with Guided Projects
and

' I

~~·-~
.
. ...

I

Reference Guide to Your Macintosh ,•
One of the best tools you can give your students is Benjamin/Cummings' new Reference
Guide to Your Macintosh. And now when you order our special Macintosh Journey Package, your students get A Macintosh Journey, plus the Reference Guide at a considerable
savings off the regular price!

.,.

•

l-"

A Reference Guide

to Your Macintosh
• IL'

I

-

. ;- I

L ..

....

A Reference Guide to Your Macintosh is a handy
at-your-fingertips resource for all your students'
Macintosh questions. Part I - A Mini Manual explains everything from the Macintosh's "desk
accessories," to how to format a disk.
Part II -How to Buy Your Own Macintoshprovides a bhyer's checklist to help students
assess their microcomputer needs, and includes a
complete reT ew of Macintosh hardware products.
(0-8053-1264- 1Y softcover /96 pages/1991)

Features:
•Gives students a complete tour of the Macintosh, with easy-to-understand descriptions of
icons, menus, the CHOOSER, the system folder and ~uch more.
• Provides clear, concise explanations of frequently used computer terms including windows, hard disks, and CD-ROM.
I
•Offers Timesaver Tips and Cautions to help students t.J.Se the Macintosh more efficiently and
avoid common mistakes.
•Includes plenty of helpful figures, sample screens, and illustrations.
• Provides a buyer's guide to the latest Macintosh models and a Buyer's Checklist.
For more information about Benjamin/Cummings' special Macintosh Journey Package,
contact your local Benjamin/Cummings sales repres ntative or callB00/447-2226.
The Benjamin/Cummings Publishing Company, Inc.
390 Bridge Parkway
Redwood City, California 94065

•
•

AAfacintosh®fourney
with Guided Projects for
• Microsoft®Word 4
• Microsoft®Excel 2.2
• HyperCard™ 1.2
• FileMaker®II
• MacDraw®ll
• MacPaint®2.0

John Dilbeck

Nicki Fink

The Benjamin/Cummings Publishing Company, Inc.

Ci~,

Redwood
Califo rnia • Menlo Park, Califo rnia
Reading, Massachusetts • New York • Don Mills, Ontario
Wokingham, U.K. • Amsterdam • Bonn • Sydn ey
s·ngapore • Tokyo • Madrid • San juan

Sponsoring Editor: Michelle Baxter
Developmental Editor: Evelyn Spire
Productio n Coordinato r: Cath y Lewis
Copy Editor: Anna Huff
Sr. Manufacturing Coordinator: Merry Free Osborn
Cover: Detta Penna
Production Service: Fog Press
Film O utput: The Courier Connection
Cover Art: Michael Swain

Copyright ©1991 by The Benjam in/Cummings Publishing Company, Inc.
All righ ts rese rved. No part o f th is publication may be reproduced, stored in a
retrieval system, o r transmi tted, in any form or by an y m eans, elect ronic, mechanical
photocopying, recording, o r o therwise, w ithout the prior written permission of the
publi sher. Prin ted in the United States of America. Publi shed simultan eous ly in
Can ada.
Many of t h e designatio n s used by manu fac turers and seller to d istinguish their products
are claime d as trad e marks. Where those d esig nations a ppea r in this book, and
Benjamin/C ummings was awa re of a trademark cl aim, the design ations have been
printed in initial caps o r al l caps.

Library of Congress Cataloging-in-Publication Data
Dilbeck, j o hn.
A Macintosh journey: with guided projects for Microsoft Word 4,
Microsoft Excel 2.2, Hype rCard 1.2, FileMaker ll, MacDraw II,
MacPaint 2.0 I Jo hn Dilbeck, Nicki Fink
p. em.
Includes index.
ISBN 0-8053-1 260-9
1. Maci ntosh (Computer)-Programming.
I. Fink, Nicki.
II. Title.
QA76.8.M3D548 1991
005.265-dc20
90-28794
CIP

ISBN 0-8053-1 260-9
12345678910-MU-9594939291

The Benja min /Cummings Publi shing Compa ny, Inc.
390 Bridge Parkway
Redwood City, California 94065

Preface

iii

Preface
Within these pages are thirty projects to guide your introduction to the Apple Macintosh.
We developed these projects after several years of teaching a broad range of stude nts, from
novices to computer p rogramme rs. W hile ma ny o f t hese projects h elp you create useful
ite ms, all will provide yo u with a fresh look a t o rganizing your world, allowing you to be
creative and to en joy your journ ey as yo u master ind ividual software packages. A Macintosh
foumey with Guided Projects provides ste p-by-ste p in structions to individuals inte rested in
learning to use an Apple Macintosh at sch oo l, in t he office, or at h ome. It is an in troducti on
to using man y popular softwa re packages available fo r the Macintosh-Microsoft Wo rd,
Microsoft Excel, MacPaint, MacDraw II , Fi leMake r II, a nd HyperCard.
Each of the five parts of our book begins wi th a brief ch apter on the basic concepts o f
computing, graphics, word processing, spreadsheets and information management softwa re.
The applica tio n chapter(s) t hat fo llow are a series of pro jects that reinforce learni ng by
building upo n the successful completio n of the previous p ro ject. Howeve r, each application
chapter is independent of the others. You m ay choose to skip an entire appl ication
package, o r learn the packages in an y o rde r you require.
The Applicatio n chapters a re structu red on this model:
•
•
•
•
•
•
•
•
•
•
•

Ob jectives
Two -to -Four h a nds-on Projects with each completed Project provided
Visual integration of Icons, Command Key Eq ui vale nts, Menus,
Dialog boxes and Screen s
Enhanced selected screens as checkpo in ts for you r work
Suggested points to quit and instruc ti ons fo r starting up aga in
Cautions and Warnings for beginning computer users
Suggested points to Save Your Work
Summa ry with Key Terms
Command Key Equi valents and Sho rtcuts Summa ry Table
Additio nal Project(s) for independen t stud y

Conventions Used in This Book
You will see li nes in the applications chapte rs that are formatted as follows.
3€ -S

• C hoose Save from the File m enu.
The a rrow indicates that t his is an actio n step that the reader should perform. Comm and
key eq uivalents and keyboard sho rtcuts for these actio ns, whe n available, a re listed in th e
left column.

Ancillaries
• Reference Guide to Your Macinlosll by j ohn Dil beck and Nicki Fink. A brief guide in
two pa rts:
1. A Mini Manual (essentia l in fo rmation a nd practical tips for beginn ing computer
users); and
2. How to Bu y Your Own Macintosh (a concise overview of Macintosh hardware) with
Buyer's C hecklist.
• lnstmctor's Manual to Acco111pany A Macinto.sh joume by Ann Quade with Lecture Outlines,
Project Summaries, Teaching Hints and Test Q uestio ns.
• Macintosh j o urney Projects d isk. An opti o nal d isk with data files and project grap h ics.
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Part 1: Introduction to
Using the Macintosh

P

art I teaches you the basics of using the Macintosh and introduces
you to some of the concepts, terminology, and procedures that
are standard on this c01;nputer.

The concepts include the Macintosh user interface and its components:
the desktop, windows, buttons, menus, and ico ns. You will learn to use
the Finder, format a disk, create and move fo lders, use menus, open a
program and quit from it, and be able to identify the parts of the deskto p
and windows.
You will learn the background information necessa ry to interact with
the Mac and to use programs that implement the standard Macintosh
interface.

2

Part I: Introduction to Using the Macintosh

Chapter 1: Getting Started
What You Will Learn in This Chapter
After reading this chapter and completing the projects in it, you
should be able to:
•

Identify the parts of the Macintosh desktop and windows

•

Maneuver around the desktop

•

Use the keyboard and mouse

•

Issue commands from menus

•

Open and close windows

•

Open a program and quit from it

•

Format a data disk

•

Create and move folders

•

Duplicate documents, folders, and disks

•

Organize documents, folders, and disks

•

Erase documents and folders

he Macintosh is one of the easiest of all computers to use. You
can learn the basic operations of the system in less than an hour.
The programs you will be using-graphics, word processing,
spreadsheets, information managers, and others-all share a common
method of operation. Once you learn the standard methods of interacting
with the Mac, you will be on your way to knowing how to use these other
programs as well.

T

The Macintosh introduced a graphical user interface. Instead of typing
commands to the Macintosh, you interact with it using icons, windows,
menus, buttons, and a mouse.
When you first start a Macintosh, it runs a program named Finder, which
allows you to run programs, copy and erase documents, format disks,
find files, tell the computer when you are ready to quit, and many other
tasks.
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THE DESKTOP
The Finder presents a view of the system known as the desktop (see
Figure 1-1).

Figure 1-1

T he desktop

In most offices you can usually find items that you already know how
to use. These items cou ld include such things as clocks, calculators, note
pads, file folders, and trash cans. By building on your real-world skills
and knowledge, the Macintosh lets you interact easily with the computer
as you perform tasks that are simi lar to equivalent tasks in an office.
The desktop metaphor is one of the reasons the Macintosh is easy to
learn to use. If you want to file a document, you already know how to
put it into a file folder and then put the file folder into a filing cabinet.
On the Macintosh you also put a document into a folder, and the folder
is contained in a disk.

LJ

You already know how to drop something into a folder, open a folder,
take someth ing o ut of a folder, close a folder, and store a fo lder or throw
it away. The Macintosh lets you build on your real-world experience as
you work in the Mac's desktop. You can prepare a docume nt, store it o n
a disk, place it into a folder with similar documents, move it into a
different folder, place it on the ~esktop, and throw it away.

I

O n the Macintosh, there are no cane commands tha t you have to lea rn
to do these things wi th documents. If you want to throw something
away, you already have practice putting it into a tras h can. On the
Macintosh, you can discard a document by selecting its icon and
dragging the icon into the Trash.

Applications

Tr-ash
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The desktop allows you to contro l the Macin tos h and tell it what to do.
At t he same time, the computer will be communicati ng with you, so you
can see the results of your actions. For example, when you place a
d ocument in the Trash, the Trash icon changes to a bulging trash can
to show that something is in it.
Th ere are two icuns (pictures representi ng objects) s howing on the
screen (see Figure 1-1). One icon is named My Ha rd Disk and the o ther
is named Trash.
My Hard Disk contains the programs and documents currently avai lable
fo r use. T he Trash al lows you to discard (erase) a ny documents you no
longer need. (Since the Trash has straight- as opposed to bulgingsides, yo u know it is empty.)
In addition to allowing you to organ ize your disks and dispose of
unwanted documents, the desktop enables you to start application
programs. Many popular programs are available fo r usc o n the Macintosh.
One of the first programs written for the Macintosh is named MacPaint.
This program a llows you to create and modify graph ics on your
computer.
for the next several pages yo u will be led through the process of fi nding,
starti ng, and qu ittin g MacPaint. Read along, a nd fo llow the process
with ou t trying the steps yourself. Your disk will proba bly be organ ized
differently from what is demonstrated he re, and it could get confusing
if you we re to try to fo llow along at th is point. In Pro ject 1, however, you
will work through a brie f tutorial to learn how to work w ith the d esktop.
(Lnte1~

in Cl!npter 4, )'Oil will lenni how to use MncPaint.)

USING THE MOUSE
Most of the actio ns o n the desktop are initiated using the 111ouse. The
pointer on the screen is controlled by moving the mouse o n a d esk o r
table. Pull the mouse toward you and it moves the pointer down on the
screen. Push the mouse away from you and the pointer moves up.
Moving the mouse left o r right causes t he pointe r to move in a
correspond ing direction o n th e scree n.
The mouse has a single button on its top. There are four main ways to
use the mo use and its button.

Click

Press down on the mouse button, and then release it.

Double-click C lick the mouse button twice in rapid succession without
moving the mouse.

Drag

Press the mouse button and keep ho lding it down whi le
you move the mouse to a new location. Then release the
button.

s
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Shift-click

Wh ile you are pressing the Shift key on th e keyboard, click
the mouse button.

The poin ter chan ges shape d epending upon what you are do ing at any
particula r mo ment. Whe n yo u a re working on the desktop, you will be
using the arrow pointer most of the time. This is the sh ape it wi ll be when
you are working with the icons and controls on the desktop. If you select
an icon and then move the pointer over the icon's name, the pointer wil l
change to th e !-beam pointer, which indicates that you can now change
the nam e o f the icon if you wish. When you tell the Macintosh to
perform some operation that may take more than a second or two, the
pointer w ill usuall y change to a wristwatch pointer, which essen tia lly
means, "Wait a minute, I' m busy."
Figu re 1-2 shows the pointers that you will see most freque ntly
wh en working on the d esktop.

111ro..

Arrow pointer, used to

imerac~

with windows,

~ controls, the menu bar, and icqns on the desktop.

I

!-beam pointer, used in editing text. Clicking moves
the insertion point, and dragging selects text.

~

Wristwatch po inter, shows that the current

~ operation will take some time 'to complete.

Figure 1-2

Pointe rs used w he n workin g o n th e deskto p

ISSUING A COMMAND
Issuing a comm and is a two-step process. First you select an object, and
then you tell th e computer what to do to it. You can also issue a
command when mo re than one ob ject is selected.
In the top right corner of Figure 1-1 is the icon of a disk n amed My Hard
Di sk (yours will probably say something e lse) . You want to o pen this
disk to see what is in it. The easiest way to d o this is to move the mo use
po inter so that the tip of the arrow is touching the disk icon . Then,
without moving th e m ouse, double-click on the icon .
As soon as you double-click on it, the disk icon opens a wi ndow, as
shown in Figure 1-3. Thi s window sh ows six icons representing fo lders.
The System Folder icon h as a p icture of a Maci n tosh on it, w hich means
t hat it is the folder containing all the n ecessary fil es for the Macintosh
to operate . All the o ther folders look alike, but each h as a differen t n ame.
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.,

Syst em Folder

LJ

Correspondence

Figure 1-3

LJ

Applications

LJ

Clip Ar t

LJ

Utilities

LJ

Homework

The window fo r My Hard Disk

Every ha rd disk is probably organized differently. Some have more o r
fewer fold ers than this one.

TWO TYPES OF PROGRAMS
There a re two ma in ty pes of computer program s. System progrnms are used
to control the syste m, and they are stored in the System Folde r o n a
Macintosh. The desktop on a Macintosh computer is provided by a
system program known as the Finder.
Applicntion progmms are used by a person to perform a task. MacPaint is
used to draw images, so it is an application program. On this hard d isk,
MacPaint is located in t he Applications fo lder.

Your next step is to open the Application s fo lder by double-clickin g o n
its icon.
When you do uble-click o n the Applications folder, the Finde r opens
the fo lder and sh ows its directaty window (see Figu re 1-4), wh ich contains
six mo re folde rs. Th is directo ry window shows all the docume n ts
and folders conta ined in the Applications folder just opened.

Chapter 1: Getting Started
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File

Ed i t

Uie w

.,

Speci al

System Folder

Graphics

LJ

Word Processing

Excel

LJ

PageHak•r

LJ

HyJl"rCard

FileMak•r II

Fig ure 1-4

LJ

Directo ry window fo r t he Applicatio n s fo lde r

FOLDERS WITHIN FOLDERS
Th e p rocess o f sto ring fo lde rs within fold e rs is known as nesti11g. Nesting
a ll ows yo u to sto re la rge quantities o f info rm ation o n a disk an d still be
able to find it qu ickl y.
MacPaint is a gra p hics program , so you will find it inside the G rap hi cs
fo lde r. O pe ning the Graphi cs fo (der reveals other folde rs a nd docume nts
(see Figure 1-5).

r

.,

5 File Edit Uiew Special

MacPainl 2.0

Figure 1-5

The G rap hics

lrlacDr a\i II

s contents
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The Gra phics fo lde r contains two item s, including o ne with an icon
representing a h and painting on a sheet o f paper. This is the icon for
MacPaint. It is named MacPaint 2.0.

RUNNING A PROGRAM

MacP aint 2 .0

Let's tell th e Finder t o run MacPaint. You ha ve a lread y seen that you can
o pe n a disk by double-clicking o n its icon, and yo u can open a fo lder by
double-cli cking o n its icon. Th is would lead you to guess that yo u can
ope n MacPaint by double-clicking o n its ico n, and you would be correct.
Po inting to a n icon and d o u ble-clicking is actuall y a shortcut method
pre fe rred by many Macintosh users. T he standard m ethod fo r o pe ning
a documen t o r fo lde r, or for running a p rogram, is to select the icon, and
th en choose the Open comm and fro m the File m e nu. Many people who
are new to the Maci ntosh prefer this m ethod, at least until th ey become
comfortable using th e mouse and d o uble-clicking.
Ano th er shortcu t m ethod for opening a document o r folder, o r for
running a program, in volves using a Command-key equivalent.
As you ca n see in the top po rtion o f the File menu (at left), the O pen
comm and has som ethi ng to its right in the m e nu. There is a cloverleaf
symbol and the lette r "0". The cloverlea f symbol represents the Command
key o n th e keyboa rd . In the Fi nde r, the process of pressing the "0" key
wh ile t he Command key is held down is equivalent to ch oosing the
Open command fro m the File me nu.
In th e remainder of this book, Comm and-key equiva le nts are shown as
Co mmand-O (with the "0" replaced by the appropriate key). You also
ca n see from t he m e nu that Command-N is equivalent to choosing New
Folder from the Fi le m e nu. The Print command does n ot have a
Command-key eq ui valent in Finder, but it may in o the r program s.
When you open MacPaint, it runs the applicatio n, creates a blank
docu m e n t, and presents you wit h the view shown in Figure 1-6. As you
ca n see, the pointer has changed to the shape o f a penc il , but if you move
the pointe r up to th e menu ba r, it w ill cha nge back to the arrow pointer,
which is used to se lect commands from a m enu .

Ch apter 1: Getting Started
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File
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Goodies

Font Style

Po t erns

Tools

"Unlillcd- 1" ot ' t00'7.
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Figure 1-6

The opening screen of MacPain t

You will learn h ow to use MacPai nt in Cha pter 4. Now that you o pen ed
MacPaint, h ow do you te ll the Macin tosh that yo u don 't wa nt to use it
a nymo re?
W hen you are fi rst learning to use the mo use, you may feel unco mfortable
with it a nd ha ve tro uble pointing to the icon you wa n t. If you
accidentally open an applicatio n tha t yo u don't want to use, you sho u ld
h ave no problem q uitti ng the program, eve n if you don' t know how to
use that program ye t.

QUITTING A PROGRAM
The main t hing that makes th e Macintosh easy to use is t he consistency
of commands given to all programs. You wi ll tell MacPaint to quit t he
same way you tell almost all Macintosh programs to q uit.
To d o th is, you will use one of the commands in a menu. On the top o f
t he screen is a menu bnrthat lists eight menu names. The first is the Apple
( ) menu, and the n ext two are the File menu and the Edit menu. These
three menus are sta ndard on a ll Maci n tosh programs (except games and
special-purpose progra ms).
A file is computer termino logy for a collectio n of info rmation. In
Macintos h termino logy a fil e is a lso ca lled a dowment. Th e Fi le m en u
allows you to con tro l ope rations concern ing a document, including the
ability to tell th e program to qu it.
Let's te ll MacPa int to q uit a nd l·eturn to the desktop. To do this, m ove
the mouse poin ter so that it toLr hes t he ri le men u. Pressi ng the mouse
butto n pulls the menu down o nto the screen. Wh ile you are stil l
pressing t he button, d rag th e m use towa rd you unti l it selects the menu
item you wa nt.
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When a menu item is selected, it is highlighted. This mea ns that the white
parts in the item turn black, and vice versa. Continue dragging the
pointer down until it hig hlig hts the word Quit at the bottom of the
menu (see figure 1-7). Stop dragging the mouse, and release the button
whi le Quit is still selected. The command will blink several times, and
MacPaint will return yo u to the desktop.
Goodies

Font

Style

Patterns Tools

XN nlllled- 1" at l 00%

XO

xw
Soue
SoueRs ...
Reut.>r I ro S<n•ed

xs

Toke Snapshot
XY
Throw Awoy Snapshot
Poge Setup ...
Print ...
Pr ln I Sel e< Uon ...
~Q

Quit

Figure 1-7

Selecting the Quit command from the File m enu

(Most progra ms a llow you to quit by typing Command-Q.)
That's al l there is to issuin g a command using the Macintosh's pull-down
111enus.

CLOSING OPEN FOLDERS
The find er now returns yo u to the same place you were before you
launc hed MacPaint. Now you want to close all the folders and return to
an uncluttered desktop. There are several ways to do this.
The easiest way is to click in the window's close box (see Figure 1-8). Notice
th at the pointer in the figure is in a small square box to the left of the
Graphics fold er title.
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File

Edit

Ui ew

MacPaint 2 .0

Figure 1-8

.,

Spe cia l

MacDraw II

Closing a window with the close box

Each window has a title bnr at its top. Most also have a cl ose box on the
left and a zoorn box o n th e right side of the title bar.
As its name i m pi ies, the close box causes the win dow to close. The screen
sho uld re turn to the same appeara nce it had before you opened the
fo lder that is represented by t he window.
The zoom box, if it is present, ca uses the window to zoom to a larger size.
Some application program s caus~ the window to fil l t h e screen w he n th e
zoom box is cl icked. Others ca use the win dow to get larger, but not to
fill t he en ti re screen. If you click in the zoom box a second t ime, most
applications wi ll return the window to the size it was before yo u first
clicked in t he zoom box.
You ca n also see in Figure 1-8 th at the Graphics folder window h as
several ho rizontal lines in its ti tle bar, but the wi ndow named My Hard
Disk does no t. The p rese nce of the ho rizontal lines tells you that a
window is the active window.
A standa rd feature of the Maci ntosh user interface is tha t actions occur
in the ac ti ve w indow. There is another way to close a window that will
ill ustrate this. Instead of clicking in the close box of a window, you can
go to the Fi le menu and choose C lose. Th is will cause only the act ive
window to close a nd wil l h ave no effect on any others that may be
presen t.
There is ano ther way to close wihdows that is even easier and faster if
you want to close a ll open windqws on the desktop. First, position the
pointe r so that it is in the close pox of the active w indow. Then hold
down the Option key and click in \the close box. This tells the Finder to
close the acti ve window, make the next one active, close it, and con tin ue
thi s process until a ll the window are closed a nd the desktop o nce agai n
looks like figure 1-1.
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Project 1: Preparing a Data Disk
Now it's time fo r yo u to g ive it a try. Sin ce you will pro bably be working
thro ugh several of the projects presented Ia ter in th e boo k, it is a good
idea for you to (on nat a disk o n whi ch to store your work.
Yo u may be wo rking o n a computer that has a lwrd disk, o r you m ay have
only floppy disks o n wh ich to work. Eith e r way, you will need to know
how to fo rmat a d isk, to keep a spa re copy, o r backup, of you r impo rtant
wo rk.
Formatting a disk is the process o f letting the compute r magneti cally
o rga ni ze the disk, so that the di sk ca n sto re your info rmation and
re trieve it. You ca n think o f fo rm atting as setting up a fil e cabi n et a nd
hanging folders, in wh ic h yo u ca n sto re real information at a late r time.
Many different computers use 3.5-inch di sks, and each type of compute r
h as a d ifferent routine that it uses to format the disk for its pattern o f
sto rage.
You will need a blank disk, or o ne you can erase, to proceed wit h this
project.

A pamgmpl1 siiOwll indented with a rig!It-poiutiug arrow (such as tile uextoue)
is the indicntion tlint you are to do wliat is stated in that paragraph.
Paragraphs that are italicized (such as this oue) are COIIIIIIents to the reade1~
!Iinls, or 1/lild warnings.
•

The first thing you need to do is have your compute r turned on. If
you are wo rking on a Mac that has a n ex te rn al hard di sk, turn o n the
power to the di sk drive a nd the n to the compute r. If you are working
with a fl o ppy-based syste m, t urn o n the compute r and in sert a
syste m disk.

Since //l OSt readers will probably be usiug a Maciutosl1 with a liard disk, that
is the basic coufigumtiou assumed for the projects. We will also assume that
you will be storiug these projects on a floppy disk rather than the hard disk.
If you are usiug n syste/11 that does uot have a hard disk, you will ueed to
remember to insert a startup disk into your computer tlwt couta ins the system
and applicatious you will need to complete tile particular project. For the
projects i11 this clwpte1~ you willueed a startup disk containing a System Folder
and a blouk disk.
};ou should also hove a copy, or access to a copy, o(t/1e Macintosh j o urney
Pro jects disk. !(you are i11 a class tlwt lias adopted this book, your teacher
should hove oue or more copies available for you to use. !(you purchased this
book to learn 011 your owu, you will fi nd a cord with instructious fur obtaining
this disk attocl1ed iuside the rear cover. You dou 't absolutely need tile Projects
disk to col/lplete tile projects ill A Macintosh j o u rney, but in a few projects,
suc/1 as this oue, the disk will make it easier.

Chapter 1: Getting Started
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When your computer is started, yo u will see a desktop similar to t he o ne
in r:igure 1-9. Your deskto p may look different, de pending on the
nu mber and type of disk d ri ves you have attach ed to your system.
•

Fil e

Edit

Uiew

The desktop

Figure 1-9

•

Special

Yo ur system wil l have o ne or more 3.5-inch floppy disk drives.
When you and yo ur Macintosh are ready, insert a blank disk in to
an y available d rive.

If the di sk you inserted is blank o r has been formatted o n a d ifferen t type
of computer, yo u wi ll see a dinlos box like th e one in Figure 1-10.

1· - t l

This dislc is unreadable:
Do you want to

f

Eject

Figure 1-10

)

initi ~ li ze

(One - Sided)

it?

(Two- Sided)

Unreadable disk noti ce

This d ia log box allows you to respo nd in one of three ways. If you in sert
a disk that h as valid data on it and receive this notice, imm ediate ly cl ick
the Eject butto n . Th is means that something is wrong with the disk o r
t he way the data is stored o n it. If you do not know how to correct th e
situation, take the d isk to someone who may be able to recover your
data.
The o ther two buttons, One-Sided and Two-Sided, a re there so you can
tell the Mac how you wan t the d isk to be formatted. Many single-sided
disk drives a re still in use, and these drives can read disks that are
fo rmatted fo r 400K storage on ly. If you wa n t to use the disk you are
formatting in a drive that reads 400K disks, you must click One-Sided.
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If you r disk d ri ve sto res and reads 800K disks, yo u sho uld click Two-Sided.

(If you nre using n Macintosh witll n "SuperDrive" you will see one of two
din/us boxes, depending upon wllet/1er you i11.serted n DSDD (double-sided,
double density) or hig h-de nsity disk into the dri ve. If you put n DSDD disk
(tl1e most common one) into the drive, you will see tile din log shown in Figure
1-10. if you inserted n high-density disk into tile dri ve, the computer cnn
recognize this nnd will show the same dinlog box with only two choices: Eject
or initialize. JV!ncintoshes without n SuperDrive nre not nble to rend highdensity disks.)
•

You probably wi ll wa nt to format (initialize) the d isk fo r use in an
800K disk dri ve, so clic k Two-Sided.

If you are using System 6 .0 or late r, the Maci ntosh will the n res po n d
with a n other di alog box (see Figure 1-11 ).

This process will erase all
information on this disk.

n EraSP~

Cancel

Figure 1-11
•

Wa rning aga inst erasing conte nts o f disk

This sh o u ld be a bla nk disk; you d o n ' t h ave to be con cern ed with
losin g any info rma tio n , so cli ck Erase.

Before form a tt ing your d isk, th e compute r as ks for a n a me to assign to
the d isk (see Figure 1-12). If you are using this textbook in a classroom
setting, you p robably sh o uld h ave you r n a m e as pa rt of the disk's n am e
so th at even if the label were to com e o ff, som eone could recognize the
disk as you rs by insert ing it into th e com puter and read ing the d isk's
name.

Plea se name this disk:

IAlan White Data

n OK;)
Figure 1-12
•

Na ming your d isk

Ente r you r n a m e, fo llowed by t he wo rd Data fo r the disk's name.
Clic k OK.
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For the n ex t few seconds, the Macintosh will forma t the d isk and t he n
ve ri fy that the formatting process wo rked correctly. If the initializa tion
was successfu l, the icon o f yo ur d isk will show on the desktop (see
Figure 1-13).

Figure 1-13

Fo rmatted disk's icon on the deskto p

Do n' t wo rry if part of th e name goes o ff the side of the screen . The full
name is st ill t here. However, if thi s appearance bothers you, yo u can
either drag the icon a Iittle to the left o r use shorter names o r a bbreviations.
If you wa n t to m ove the disk icon, you move the mouse pointer to the
icon, press the button, a nd th e n drag the disk to the left w h ile the b utto n
is held down. Whe n you release the mouse button, th e icon will move
to its new locat io n and stay there.
If the initia liza ti o n was not successful , you wi ll receive a notice that the
ini tialization fa il ed. At that point, you have the optio n of t rying it again
or using a different di sk. Sometimes a disk w ill fo rmat correctly the
second t ime . If the initializatio n stil l fai ls, you sho u ld use an other disk.
If the initia lization fails, you m ay want to d isca rd the d isk now, before
you save important info rmation on to it. All d isks eventually fa il, so
d isca rding one tha t d oes n ot fo rm at correctl y m ay save yo u fro m losing
va luable time and inform atio n later.
".. O pe n yo ur d isk's directo ry wlind ow by double-clicking o n its icon.
Ano th er way to open a disk's d i r~ctory w in dow is to click once o n the
disk's icon to select it. The n ty pe o m mand-0 to open t he d isk. It is your
ch o ice whethe r t o issue a comm, nd wit h the mouse and m e nu o r wi th
a Co mmand-key eq ui va le nt.
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As yo u can see in Figu re 1-1 4, n o docume nts are currently located on this
newly forma tted d isk. The status lin e just below the wi n dow's n am e
shows th at the re a re 0 items on the disk. Seven kilo bytes of storage a re
already u sed by the system, w hich h as rese rved a portio n o f the d isk fo r
directory information and a place to store how the di rectory w indow
w ill appea r o n the desktop.

' a

File

Edit

0 tttms

Figure J-14
•

Sp eci al

Al an While 011111

}

~ -W

Uiew

7K

tn

disk

Di rectory w indow of n ewly initialized d isk

Close th e w indow by clicking in the close box, th e small white
rectang le a t th e left e nd of the title ba r just above "0 items."

Tl1e symbol to the le{to{tl1e instmction above represents Conmwnd- W, which
is the Conn nand-key equivalent for closing the active window. Throughout the
book we will usually indicate a Command-key equivalent (a lso known as a
keyboard equivalent) when one exists. It will be your option to select frorn the
111enu or issue the cormnand from the keyboard.

DUPLICATING A DISK
Th e n ex t part of this proj ect in volves copying the documents in the
Macintosh foum ey Projects d isk onto yo ur newly fo rmatted data d isk. If
yo u do not h ave that d isk, you ca n read a lon g and complete o nly th e
pa rts th at do n ot d e pen d o n h aving th e Projects d isk.
All Macintosh comp u te rs h ave at least o n e flo ppy disk drive, and some
have two o r more. For thi s pro ject, we w ill assume that your Macintosh
has a ha rd d isk and on e floppy dri ve .
Pat yo urself o n the back if yo u noticed t he re is a problem a risin g. You
h ave two disks and o nl y o n e fl o p py d isk drive. How can you copy one
d isk o nto the o th e r w ith only one d ri ve?
Duplicating one di sk onto ano the r is a fa irl y easy process, even if you
on ly h ave one drive. (If you have two fl oppy d ri ves, o f course, it is fast
and easy.)

Chapter 1: Getting Sta rted
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Ejecting a Disk and Still Showing Its Icon
T he first ste p is to eject your data d isk from th e drive in such a way that
th e Macintosh will still reme mbe r it. Th en yo u can insert the Projects
disk and d rag its icon onto your da ta disk's icon , even tho ugh the data
disk is not currently in the drive.
As was stated before whe n you were lea rning how to sta rt MacPaint,
doing som ething on a Macintos h usually involves two steps: se lecting
a n object and the n issuing the command th at w ill affect that object.
First, select the o bject. ..
•

Select your data disk by m oving the pointe r so that the tip to uches
yo ur d ata disk's ico n , and th en click the m o use button o nce.

And th en issue the command ...

3€ - E

•

Eject yo ur data disk by ch oosing Eject fro m the file m e nu, and then
re m ove the disk from the drive.

This will e ject the disk and leave its icon showing o n the desktop. No tice
that the re is now a gray pattern in your data disk's icon (see figure 1-15).
An icon that looks like th is is known as a dimmed icon. Th is indicates
that the Mac remembe rs the disk bu t that it is not c urre ntl y in a disk
drive .

~e

1-15

Disks not presently in a drive have dimm ed icons.
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Copying the Projects Disk onto the Data Disk
You have to insert the document d isk, so you ca n copy the info rmatio n
stored on it.
•

Insert the Macintosh Journey Projects disk into the drive.

Anoth er icon, representin g the Projects disk, wi ll appear o n the desktop
below the icon of your data disk. Now that both icons are visible o n the
screen , you have largely overcome th e problem of two d isks and o nl y
one drive.
Since both disks are form atted the same (double-sided or SOOK), you can
copy the Projects disk onto your data disk by dragging the icon representing
the Projects disk onto the icon of the data disk and then releasing the
mouse button.
•

Move the mouse poi n ter so the tip is on the Macintosh joumey Projects
icon .

•

Press th e mouse butto n and, while keeping the button pressed,
move the m ouse forward soth eoutlin eoftheProjectsdisk icon moves
up o n the screen . When the pointer is on your data disk icon, the
data disk icon wi ll change appea rance, indicating that you have
chosen it as the disk onto w hich the documen ts will be copied.
Release the mouse button to start the copying process .

W h en copying fro m on e disk to another, the disks are usually referred
to as the source and destination disks. Since you are copyingfi·om the Projects
d isk, it is the source disk. The d ata disk is the destination disk, beca use
it is th e destination of th e fil es being copied.
If you have correctly told the Macintosh to copy the fi les on the Projects
disk o n to your d ata disk, a dialog box (see Figure 1-16) w ill appear aski ng
if you want to compl etely replace the contents of you r data disk with th e
contents of the Projects disk.
15 File Edi I Uie w

Are you sure you w ant to comple t ely
repl ace contents or
" Rian Whi t e Data" (not in any driu e)
with contents or
" Macintosh Journey Projects" (Inte rn a l
driue)?

F~""''\ [ Cancel )

Figure 1-16

Dialog box to confirm disk duplication
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•

This is what you want to d , so click OK.

The dark oval around the OK button shows that it is the default button.
Pressing the Enter or Return key is interpreted the same as clicking the
default button.
Once you give the Mac you r permission to replace the contents of the
data disk with the contents o f the Projecl.s d isk, a new dialog box wi ll
appea r showing th e progress of copying the disk. This process begins
with reading the information on the Projects disk.
When the computer has read all the information on the disk, or al l that
it can conta in in memory, it will eject the Projects disk and ask you to
insert you r data disk. It will then continue the copying process by
writing information to your data disk.
Depending on how much in formation is o n the source disk and the
amount o f main memory in the Macintosh you are using, you may be
asked to swap disks on e or more times. When the computer is fini shed
copying the information from the Projects d isk, the operation wil l end
with your data disk in the computer's disk drive.
(If you h ave two o r more floppy disk drives, you ca n insert both disks

in to the computer at the same tim e and then drag the Projects disk's icon
onto the data disk. The copying operatio n will proceed without requiring
any d isk swapping.)
Warn ing: You can use this process ofdragginga disk's icon onto another
disk whenever you want to duplicate all of the information on one disk
onto another. This process will erase the information on the destination
disk, so be sure this is what you really want to do before you tell the Mac
it is okay to completely replace the destination disk's contents.
Th is process will only work if both disks a re formatted the same. This
restriction is t here to insure the safety of you r info rmation. You would
never want to completely replace the contents of a hard disk with the
contents of a floppy disk.

COPYING A DOCUMENT
There is anot her waytocopyoneor more documen ts from onediskonlo
another one without replacing the entire contents of the destination
disk.
just as you ca n drag a disk o nto! another d isk to make a complete d isk
d u plicate, you ca n drag o ne o r ore selected documents from o n e d isk
o nto another disk.
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Let's d rag o ne file from the Projects disk onto yo ur data di sk. You will
drag the Mys te ry Document onto yo ur d isk. The process of dupl ica ting
the di sk that you just com p leted has al ready p laced th is fi le o n your d isk.
The Macin tosh wi ll recognize this a nd ask if you want to replace a file
with th e sa me n a me as th e selected fi le.
O n ly one fil e with a particular nam e may exist on a disk o r in a folde r.
If you copy ano ther file wi th the same name, the Mac wo uld have to
erase th e one alread y on the disk. There is potentia l that th is situatio n
could be accidentally en countered and would result in the loss o f the
o rigi nat fi Ie. Therefo re, the Mac asks yo ur permission before it con tinues.
If you have any doubt about the conten ts of the fi les in questi on, tell the
Mac to cancel the copy o perati o n and deter m ine if this is what you real ly
want to do by loo king at the contents of both d ocuments.
In this case, you alread y know that it is okay to replace the document,
so you will tell the Mac to go a head with the o peration.
Notice that the icons of both di sks a re sti ll o n th e desktop. You ca n look
at the conte nts of th e Projects disk by d ouble-clicking o n its icon . T he n
you wi ll copy the Mystery Document o nto yo ur data disk aga in.
•

Do uble-cl ick on the Macintosh joum ey Projects disk icon. Yo u ma y be
pro mpted to swap disks one o r mo re times. If the icons are d immed,
eject your data d isk and insert the Projects disk.

The d irectory window o pe ns, and yo u will see the Mys tery Document
in the fo urth row of icons.
•

C lick on the Mystery Document a nd then drag it on to the icon o f
you r data di sk (see fi gure 1-17).
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Copying one fi le to a nother disk
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Th e process of copying th e file wi ll involve at least o ne d isk swap (if you
are using o nl y o n e flo ppy d rive) . As soon as the computer determines
that a docu ment w ith the same name already exists on yo ur d ata disk,
it will ask if you want to continue (see Figure 1-18).

Vnu1l Effeots

~
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lilJfibiJiij.rglf..iJ.Q

lnvtntorv

~

l2J
B & K0r•w"'9
Figure 1-18

Enter or Return

••

Dialog box for pennissio n to replace a documen t o n data
disk

Sin ce you are sure you wan t to replace the Mystery Document, cl ic k
OK.

You wi ll see a d ia log box showing the progress of the copy o peratio n and
may be asked to swap d isks o ne o r more times.
If a document named M ystery Document h ad not al ready been stored
on yo ur data disk, the Macintosh would no t have encountered a
situatio n with the pote ntial fo r los ing data. In that case, it wo uld no t
have asked permission befo recopyingthe file. lt will only ask permissio n
befo re engaging in a copy o peration that m ay erase information.

Of course, o nce you tell it to proceed, the Macintosh will replace the
o riginal document, so be sure yo u know what you are do ing before you
tell the computer to continue.

Ejecting a Disk and Removing Its Icon
Now that yo u have copied the fi les fro m the Macintosh joumey Projects
d isk, yo u are fin ished with it and ca n eject it (if it is in the computer) and
remove its icon from the desktop.

usi~g

When ever you a re finished
a disk, you sho u ld tell t he com pute r
to eject the d isk and re move th e~ i s k's icon from th e des kto p. It doesn't
matte r if the disk is in the comr uter o r no t.
-

Drag the Projects di sk icon
button.

nto the Trash and release the mo use
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T hi s will no t erase t he disk; it just te lls the computer that you are
fin ished usi ng th e d isk fo r now and to fo rget wh at it knows a bout that
disk. Not on ly d oes this rem ove the icon fro m the d eskto p, it also frees
some of the com pute r's m e mo ry fo r o ther uses.
..

Double-cl ick on your data disk icon to o pen its directo ry wind ow.

You ca n now see, as shown in Figure 1-19, that the Myste ry Docum ent
icon is o ut of place. It m ay no t be in the positio n sh ow n, but it sho uld
be located in the first available pos itio n in the to p row.
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Figure 1-1 9

Myst e ry Document's icon is out o f place.

W he n you du plicated the entire Projects disk o nto your d ata disk, the
icons we re placed in this window the sam e as they were o n the o riginal
d isk. However, when you copied the Myst ery Docum ent o nto th e d isk
ind ivid ually, its icon was placed in th e first available positio n .
(

Since t his is not whe re we wa n t the icon, you can m ove it to its o riginal
positio n . (Note: lt is n ot impo rtan t to try to place the icon p recisely, just
get it in its approx im ate positio n. )

Moving a Document's Icon
You have alread y seen th at yo u can copy a d ocum en t fro m o ne disk o nto
anoth er o ne by d ragging t he d ocum ent's icon o nto the des tin atio n d isk.
This does not e rase the fil e fro m the source disk.
If yo u d rag a docume nt icon around inside the sa m e window, it does not
copy th e file; it just cha nges the locatio n wh ere t he ico n will be
di splayed. If you d rag the ico n o nto a fo lde r on the sa m e disk, it d oes not
copy th e fi le and place a copy in to the fo ld er; it m oves the documen t
in to t he folder a nd removes it fro m its p revio us locatio n.

Chapter 1: Getting Started

23

In a few minutes, you will mo e a file into a fo lder, but for n ow just
m ove the Mystery Document's icon to the fourth row of icons (see
Figure 1-20).
'
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Figure 1-20

Moving a fil e's icon to a different location

.. Drag the Mystery Document icon to its new position and release it.
Be sure to keep the mouse po inter inside the directory window of
your data disk.
Notice, w hen you drag the icon, that a gray outline of t he icon moves
wi th the pointer. This is to show th e position the icon wi ll assume if you
release the mouse button. It enables you to move and place icons
accurately in the window.
If you release the mouse button before you have the icon where you
want it, just drag it again until you get it to its proper new location.

TAKING DIFFERENT VIEWS OF A DIRECTORY
WINDOW
Up until now you have been viewing the directory window using icons.
This is only one way you can view the contents of a disk or folder.
Every application uses a particular icon to represent its documents. Each
of t hese icons is diffe rent from the others. W hen you become familiar
with the different icons, this is a conveni ent way to find and access the
document in which you are interested.
There a re times, however, wher it is more conven ient to view the
directory in o ther ways. Two of t:h e other most useful views are by date
and by name.
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By Date
Viewing a di sk or folder window by date shows all the documents sorted
by reverse chrono logica l o rder based o n the last time each document
was modified (see figure 1-21). If you wan t to quickly find a document
you worked on recently, it is conven ient to view by date so that the most
recently modifi ed fi les are shown first.
•

Choose by Date from the View menu.
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Figure 1-21

Speci al

6K
1K
24K
16K
8K
4K
6K
9K
8K

.,

MacPain\ 2 .0 doo... Sun, Oo\ 28, 1990
MacDraw II docu... Fr i , Oct 26, 1990
Microsoft Word d... Mon, S~p 24 , 1990
Hypor Car d documon\ Wod , Aug 8, 1990
HyporCard documon\ Wod, Aug 8 , 1990
Microsoft Word d... Tuo, Aug 7 , 1990
Microsoft Word d... Sa\, Aug 4 , 1990
Microsoft Word d... Sat, Aug 4 , 1990
Microsoft Word d. .. Mon, Ju130, 1990
MacPain\ 2 .0 doc... Mon, Jul 9 , 1990

Viewing your data disk by date

Another conven ien t way to view the window's contents is by n ame.

By Name
Viewing a disk o r folder window by name shows all the documents
sorted alphabetically by n ame (see Figure 1-22). If you want to quickly
find a document and you know its n ame, the view by name o ptio n may
be helpful.
•

Choose b y Name from the View menu.
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6K
3K
24K
4K
337K
8K
5K
9K
1K
8K
6K
16K

MacDraw II docu... Fri, Oct 26, 1990
MacPaint 2 .0 doc... Sun, Oct 28, 1990
HyperCard document Wed, Aug 8, 1990
Microsoft Word d... Sat, Aug 4, 1990
HyperCard document Thu, Nov 1, 1990
MacPaint 2 .0 doc... Mon , Ju19, 1990
FiloMakor II docu... Wed , Oct 3 1, 1990
Microsoft Word d... Mon, Ju130, 1990
Microsoft Word d... Mon, Sop 24 , 1990
Microsoft Word d... Tue, Aug 7, 1990
Microsoft Word d... Sat , Aug 4, 1990
Hyper Card document Wed , Aug 8 , 1990

Viewing your data disk by name

By leon
You will find all of th ese methods of viewing the directory window
useful.
•

Choose by Icon from the View menu to change back to the original
view of the disk's directory.

This is the Macintosh's default view. When you format a new disk, it will
automatica lly be viewed by icon. Next time you insert the disk, the v iew
will be the same as it was the last time you used it.

DUPLICATING A DOCUMENT
Now you will learn how to create an exact duplicate of a document. This
is useful if you want to make a backup copy of a document on the same
disk befo re you try an operation that might result in damage to the
current state of the document. For example, you mightwanttoduplicate
a spreadsheet before sorting it, backup a complex drawing before
modi fying it, or backup a long word processing document befo re
starting an involved formatting process.
Copying a document and duplicating a document are similar, but use
different mechanisms. Copying a document involves making a new
copy of the document on a different disk. To copy a document, click on
its icon and drag it to a different disk. The Finder will then create a copy
of the file, with the same name, o n the other disk.
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Duplicating a document in volves m aking a n ew co py of the document
o n the same disk and in the sa me folde r as the original document. To
duplica te a document, click o n its icon, and then choose Duplicate
fro m th e File m enu (or use Comma nd-D). The Finder will then create a
copy o f the fil e, with the wo rds "Copy o f " added to the beginning ofthe
file's nam e. Since the origin al fil e, and the new copy of it, are located at
the sam e level o n the disk, they must have diffe rent n am es.
In this case, you will go through t he steps involved in duplicating a
document.

~ -D

•

Select Myste ry Document by clicking on its icon .

•

Ch oose Duplicate fro m the File menu.

In a couple of seconds, yo u w ill see a new document named Copy o f
Mystery Document appear in your disk's directory window just below
and to the right of the selected document (see Figure 1-23). The new
document is selected so you can cha nge its n am e if you want.
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Figure 1-23

The n ew copy of the Mystery Document

That's a ll you will be do ing with this new document for a few minutes.
,.

Deselect the Copy of Mystery Docume nt icon by clicking in the
white area o f th e window.
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CREATING A NEW FOLDER
Now you will create and place a folder on your disk. This will allow you
to organize the storage of the projects you will later create. You may
decide that you would like to organize your disk differently later. Feel
free to customize it so th at it works best for you, but for now, try it like
this.

:3€- N

•

Create a new folder by choosing New Folder from the File menu
(see Figure 1-24).
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Creating a new folder on your disk

This will create a new folder on your disk labeled Empty Folder.
,. Do not click anywhere yet.
When the Empty Folder is created, it is automatically selected so you can
easily change its name.
•

Rename the folder Final Projects by typing this name on the
keyboard . As you type, you will see the name change.

If you make any typing mistakes, use the Backspace key (Delete key on
some keyboards) to erase the mistake and retype the name.

•

Move the Final Projects folder to the last row just below and to the
right of the two Mystery Documents.

•

Deselect the fo lder by clicking in the white area of the win dow.

You may h ave to resize the window so the folder will fit and be visible.
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When you finish, the new folder will be n am ed Final Projects and will
be in the lower right side of the window (see Figure 1-25).

r

•

File

Edit

Uiew

..,

Special

Greeting Card Art

Geno's Menu Unformatted

Traveling Times Unformatted

Glossary

I --

Menu Artwor k

Traveling Times Logo

Visual Effects

Class Notes Buttons

In ven tory

.

[Q
B & K Painting

Figure 1-25

B& K

'
Dra~ing

Copy of Mystern

ent

Final Projects

~

New Final Projects folder

DRAGGING A DOCUMENT INTO A FOLDER
The main use for folders is to he lp yo u organize many files o n a disk by
placing them into folders where you will be able to loca te them as you
need to access the informatio n they contain.
Putting a document into a folder is a m atter of dragging its icon onto the
icon of the folder and releasing the mouse button.
•

Using what you have learned, drag the icon representing Copy of
Mystery Document into the Final Projects folder.

The Final Projects folder wi ll be highlighted when the cursor gets on top
of it. When you release the mouse button the Copy of Mystery Document
ico n will disappear.
How can you tell if the document was really m oved into the fold er?
Open the folder and take a look.
•

Double-click o n th e Final Projects fo lder to open its directory
window.

When the window opens, part of the documen t's n am e may be missing
on the left. If it is, you can click in the le ft scroll arrow so that the entire
n am e becom es visible.
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Your screen should now look l"ke the one shown in Figure 1-26.
,.
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Figure 1-26

Th e document after dragging it into the folder

Now that you have verified that the document is really inside the
fold er, you can close the folder.
00 -W

, . Close the window by choosing Close from the File menu o r by
clicking in the window's close box.

DUPLICATING A FOLDER
You have seen how easy it is to duplicate a disk and a document. Now
let's duplicate a folder. Duplicating a folder is very similar to duplicating
a document.

8€ -D

•

Select the Final Projects folder.

•

Choose Duplicate from the File menu.

In a couple of seconds you will see another folder appear on your
desktop. (see Figure 1-27).
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The duplica ted folder

Duplicating a fold er is similar to duplica ting a document, but not
exactly. W hen you duplicate a folder, its entire contents are duplicated
as well. This includes all doc uments in th e fold er and even o ther folders
and their contents that are located within the selected fo lder.
Th is means that you now h ave two docume nts n amed Copy of Mystery
Document. One is contai ned in the Final Projects folder, and the o ther
is in Copy o f Final Projects.
If the fo lder you select for duplica tion has a lot of info rmati on in it, the
duplicatio n process may result in more info rmation than the disk has
room to store. In this case, your Macintosh will info rm you and will
terminate the duplicatio n process.

ERASING A FOLDER AND ITS CONTENTS
This is all you will be doing with the Copy of Final Proj ects folder and
its contents, so you can now erase it from you r disk.
•

Drag the icon of the Copy of Final Projects fo lder into the Trash
and release it there.

Be sure that t he Trash is highlighted (turns black) before you release the
m o use button; o the rwise, the folder will be placed close to the Trash but
will no t go into it. You ca n tell if you were successful in putting the folder
into the Trash in a couple of ways.
If the fo lder icon di sappears and the sides of the Trash bulge, the folder
was placed inside the Trash (see figure 1-28). lfyou can still see the folder
icon next to the Trash, the fold er is just on top of th e Trash and n ot
inside it.
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The Trash bulges when there is something inside it.

Warning: Dragging a folder into the trash will erase not only the folder,
but also all of its contents. This includes any folders it contains and all
of their contents. Before dragging a folder into the Trash, be sure that it
does not contain other folders whose information you want to keep.
You can accidentall y erase a lot of information from your disk by not
being aware of what is inside a folder before putting it in the Trash.
As long as the Trash's sides still bulge, you can open the Trash and
remove any of its contents by dragging the icon(s) back where you want
it. When the Trash is emptied, th e files that were in the Trash are erased
from the disk and cannot be retrieved.
Th ere are several ways to empty the Trash . You can choose Empty Trash
from the Special menu, start any application, or choose Shut Down
from th e Special menu. All of these methods empty the Trash and erase
whatever was inside it
In this case, you know what is in the Trash, and you are sure you want
to delete it.
•

Select Empty Trash from the Special menu.

•

Click the up scrol l arrow to make the top row of icons visible again.

ERASING A DOCUMENT
You have learned how to duplicate documents, disks, and folders. You
h ave learned to move an icon around inside a window. You can move
a document into a fo lder, an~ you know how to erase unwanted
information.
I
•

Using what you have learned, open the Final Projects folder and
drag Copy of Mystery Doc ment into the Trash. Empty the Trash
and close the Final Project folder.
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This will leave your d ata disk set up for completing the rest of the
projects in A Macintosh Journey.
You still h ave the Final Projects folder on your data disk. You do not have
to make use of this folder unless you want to, but you might find it
convenient for storing your completed projects from the following
chapters. When you complete a project, you can drag it into this folder
where it will be out of your way.
All that remains in this project is to eject your data disk and turn off the
computer.
•

Choose Shut Down from the Special menu.

This ejects any floppies that are in any of the Mac's disk drives an d
positions the hard disks for shutting down. A Mac Plus, SE, Classic, or
SE/30 shows a dialog box telling you that you can now turn off the
power. Any model in the Mac II series automatically shuts the power off
to the computer.
Congratulation s! You have completed this proj ect.
This completes your quick tour of using the Macintosh and setting up
a data disk. Although the Finder and other programs on the Mac do
much more than you have seen so far, you have touched o n many o f the
basics you need to know to get started.
For more detailed information on using the Macintosh, see Reference Guide
to Your Macintosh, a reference that covers Macin tosh subjects in
alphabetical order by topic. It also includes an overview of Macintosh
systems. Refer to the glossary in this book for defnitions of key terms
used in this book.
If you want more background about computers in general, continue
with Chapter 2.
If you are anxious to start working, turn to Part II and continue there.

SUMMARY
• The Macintosh employs a graphical user interface consisting of windows, me nus, icons,
d ialog boxes, buttons, and the use of a mouse for a person to interact with the computer.
• Windows have title bars, close boxes, and zoom boxes . A window contains information th at
varies d epending on the application that created the window.
• Only the topmost window is active, and all action takes p lace in the active window. Active
windows are indicated by title bars and oth er visible controls, such as scroll bars, that are not
present in inactive windows.
• Di sks are used to store information in a fo rm that is readable by computers. Disks must be
formatted, or initia lized, before they ca n be used to store this information .
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• Disks are organized by the use of folders on the Macintosh. Folders may be placed inside other
folders, a process that is known as n esting.
• Moving the mouse m oves a po inter on the screen and allows the user to interact with the
computer by pointing at icons that represent objects and by clicking, dragging, or doubleclicking the button on the mo use. The pointer changes shape depending upon the task being
performed. In some applications, the pointer can take many shapes.
• To issue a command to the Macintosh, point at a m enu name, pull down the m enu, and select
a m enu item from the list. Command-key equivalents are combination s of key presses that
substitute for using the menus to issue commands with the mouse.
• The Finder is an application that allows the user to organize and rearrange the storage of
inform a tion on d isks, to copy and move files and folders, and to open applications. Th e
Finder is the program that provides the desktop when you first start your Mac.

KEY TERMS
active window
Apple menu
application program
arrow pointer

graphical user interface
hard disk
high-density disk
highlight

backup
click
close box
Comm and key
Command-key equiva le nt
d efa ult
desktop
d estin ation disk
dialog box
dimmed
directory window
disk drive
docum ent
double-click
dragging an icon
DSDD disk

!-beam pointer
icon
initialize
menu
menu bar
menu item
mou se
mouse button
nesting folders
Option key
po inter
pull-down menus
Return key

Edit menu
Enter key
fil e
File m enu
Finder
floppy disk
folders
formatting a disk

scroll bar
Shi~ key
Shi~-click

source disk
startup disk
System Folder
system program
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title bar
Trash
window
wristwatch pointer
zoom box

COMMAND KEYS AND SHORTCUTS
File Menu
New Folder
Open
Close
Duplicate

00-N
~-0
~

-W

~-D

Edit Menu
Undo
Cut
Copy
Paste
Select All

00 -Z
~-X
~ -C
00 -V
~-A
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Chapter 2: Computer Cone pts
I
What You Will Learn in This Chapter
After reading this ch apter, yo u sho uld be able to:
•

Understand some o f the concept s and te rmino logy appl icable to
persona l computing

•

Nam e the two ma in ca tegories of software

•

Nam e the standard parts o f a compute r system

•

Name the most commo n peripherals attac hed to a computer

I

f you are new to computers, this section sho uld help you understand
some of the concepts and te rminology used in data processing. If you
al ready have experience w ith com puters and are an xious to start
working, you migh t wan t to skip the general discussion and go straight
to Part II.

A BRIEF OVERVIEW OF TERMS
In persona l computing, as in all other technical areas, a standard
term ino logy is used by the people working in t hat field. Som etim es the
terms are used on ly in a pa rticular area. Oth er times, wo rds take on a
different meaning when they a re used as technical jargon fro m wh en
they are used in ordinary con versa tion. The computer fie ld is filled with
examples of these wo rds and phrases.
Some exa mples o f term s that have a d iffere nt mean ing wh en refe rring
to computers and t he use of computers are: bug (error), debug (find a nd
correct erro rs), and bo mb o r crash (the program enco unters a problem
and stops working properly). This is onl y a sm all sample of a large gro up
of such words.
In addition to red efining some words, th e computer industry con s tan tl y
uses acro nyms, such as ROM (read-on ly m emory), RAM (random access
memo ry), SCS I (small compute r system interface), GUI (graphical user
interface), and WYSIWYG (wh at you see is what you get).
Believe it o r no t, a lm ost all of the co mputer-related acronyms you will
encounter are pronounceable, and in ordi nary speech those of us who
use th is terminology pro n ounce them; we do n't spell th em as you mig ht
expect. For example, RAM and Rb M are obviously pronounceable, SCSI
is pronoun ced "scuzzy," GU I is "gooey," and WYSIWYG is spoken as
"w issy-wig" o r "w izzy-wig."
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You will encounter a number of these terms in any book that discusses
computers. Many are defined and expl ained in the following sections of
this chapter.

PARTS OF A COMPUTER SYSTEM
There a re three main compone nts of a computer system: hardware,
software, and people.
You may be so new to using computers that you d on ' t know how to turn
one on, or you may h ave many years of experience with o ther computers.
Either way, you are about to set out on a journey that will increase your
knowledge of computers and enhance your skills in using them.
Hardware a nd software are the te rms used for equipment and programs,
respectively. Many people have a difficult time at first understanding
wh at these terms m ean. The hardware part is easy. If you can touch it,
it's hardware. The equ ipment that m akes up the system is the h a rdware.

Software
Softl.vare is a little more difficult to grasp beca use it is an abstraction.
Information and method s for solving problems are known as software.
When using a computer, you process data (or facts) to produce
information. The me thods for solving problems o r performing tasks are
called algorithms. When you combine data and proper algorithms you
produce a program. All o f these-data, informatio n, a lgorithms, and
programs- are known as software. This is one o f the reasons it can be a
confusing term. However, most of the time software means a computer
program.
A com puter program is a set of steps for the computer to follow to arri ve
at a particular goal. Part of these instructio ns allow the com puter to
interact with you- the user. Other instructio n s tell the computer to
accept data, modify it, output it, and store it for further use.
Usually, when someone refers to software, they mea n a program, such
as Microsoft Word or MacPaint. Since "software" and "program" are
synonymous, it is redundant to call some thing a software program.
Software is d ivided into two categories: systern so{tl.vare and application
softl.vare.
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System Software
System software is a program that controls the interaction among
different parts of the computer system or between the user a nd the
system. It allows you to find information on the disk, m ake copies of it,
and send it to the printer as well as many other tasks. The Finder is the
system software o n the Macintosh that allows you to control the system
and the info rmatio n it contain s.
Application Software
Ap plication software is design ed to allow you to complete a task. If you
want to write a letter or a book, you use a word processor, such as
Microsoft Word. To produce a budget o r cash flow analysis, you use a
spreadsheet, such as Excel. If you have a list of custom er informatio n,
you store it using a d atabase or file managem ent program, such as
FileMaker o r HyperCard.
All of these are examples of applications. They are not designed to
facilitate your interaction with the com puter system ; they are design ed
to allo w you to complete a task.
Applicati on software o n the Macintosh is available fo r purchase from
many third-party companies. This means that neither you nor Apple
Computer produced this prograr;n. Tf you want to do the tasks a program
allows, you can purchase the p~ogram from whomever produced itMicrosoft, Claris, Apple, and so on-and use it on your computer.

Hardware
The software tells the hard ware how to do tasks. The hardware performs
the operations and handles the flow of information. The hardware
comprises a central processing unit, memory, storage, and input/output
peripherals.
Central Processing Unit
The central processing unit, o r CPU, is the part of the computer that
processes information. This is the part of the computer that con trols
d ata flow and the interaction amon g other hardware compon ents. It
performs arithmetic calculations and logical operations.
The CPU accesses and controls the computer's memory and directs the
fl ow o f inform ation into the system and out o f it. The CPU performs the
tasks that convert da ta into the info rmatio n you need from the system .
In a microcomputer, tjlis CPU is o n a single microprocessor. You may have
heard o f a microprocessor being referred to as a "com puter chip. " The
MC68000 is the microprocessor, or brain, used in the first generation of
Macintosh computers (128K, 512K, 512Ke, Plus, SE, and Classic) a nd the
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Macintosh Portable. The "sixty-eight thousand" is produced by Motorola,
and it a nd its descendants provid e the computing power for the
Macintosh line o f computers.
The second generation of Macintosh computers (Mac II, Mac LC) uses
a newer and more powerful processor-the MC68020. The "sixty-eightoh-twenty" runs at a faster speed and processes information m ore
quickly than the 68000. This in turn was followed by the MC68030,
which is even more powerful and faster and is found in the Macintosh
SE/30, llx, llcx, Ilci, Ilsi, and llfx computers.
Newer and more powerful microprocessors are in the works (such as th e
MC68040), and Apple will undoubtedly introduce computers that use
them as they become available. Change is in evitable in the world of
computers.

Memory

Memory in a computer is a group of integrated circuits where information
can be stored and from which the CPU can access and read this
information.
Thereareessentially twotypesofcomputermemory:ROMandRAM.ROM
m ean s read-only mem01y. This is a t ype of permanent storage. ROM retains
its contents eve n when the power is rem oved from the system. However,
it cannot be modified by a user. Once t he info rmatio n is stored in ROM
it stays there for the life of the chip. On the Macintosh, th e instruction s
that produce windows, pull-down menus, and other parts of the
Macintosh user interface are stored mostly in ROM.
The second type of m em ory is RAM, or random access memory. It is not
truly random access; it is really direct access, but probably nobody
wanted to call it DAM mem ory. (If computers really had random access
m emory, it would be quite a trick to get any work done.)
Whatever the n ame, RAM is the changeable memory used to store the
inform ation the system is currently processing. This memory is temporary
(or volatile) storage only. If the power to the computer goes o ut for a
fraction of a second, this m emory is erased. When you see the lights
blink in a room where people are using computers, it is not uncommon
to hear vario us socially unacceptable phrases uttered by users who have
not recently saved their work onto disks. Any work done since the last
time it was saved is usua lly lost.
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(There is n simple way to protect yo Irs elffrom losing your work whenlhe power
goes out. A II you have to rio is save your work every ten or fifteen minutes. Get
into the habit of doing this. fn fact, since many applications supp01t
Comma nrl-5 as the equi vn lent ofchaosi ng Save, many Mac users have len mer/
to type this command routinely as they work. You hardly ever hear this group
groaning and moaning about losing n day's work when the power goes out!)
Several arca ne-sounding term s are used to describe various amounts of
m emory. Th ese terms apply to both ROM and RAM.
You have probably hea rd of bits and bytes. Bit is the contraction for
Binary digiT. Computers don't process English, or words or numbe rs as
you are familiar with the m. Everything the compute r does is in the form
of a code. Many ingenious people have devised codes for all types of data
sto rage and representatio n.
All the computer knows is high voltage or low voltage, on or off, positive
or negati ve. Each of these groups is composed of exactly two conditions.
The computer works using binary numbers, which allow only the digits
0 and 1. (This is also known as the base two number system.) For most
purposes, one bit is not very useful, so eigh t bits are combin ed into a
byte.
A byte is the smallest unit of storage for most uses. For example, each of
the le tters that compose thi s sentence is stored in the computer as one
byte. Even th e blank spaces are stored as a single character in one byte
of th e computer's memo ry.
Often, you need to store more than a few bytes of information, so bytes
are grouped into larger units. The next unit of storage commonly used
is the kilobyte. This is not 1,000 bytes as you might expect; it is 1,024
bytes. (1,024 is a ro und number in the base two number system:
100000000002 , which is the bin ary represe ntation for 2 raised to the
lOth power.) You shou ld remember that kilo- (as in kilobyte) mea ns
1,024, not 1,000, when referring to computer storage, even though you
wi ll probably tend to think of it as roughl y 1,000.
The nex t unit ofstorage is the megabyte. This is approximately one millio n
bytes (1,024 x 1,024 = 1,048,576). Since humans can't easily rem ember
these kinds of numbers, we don't like to be concerned with the extra
48,000 bytes or so. Megabyte is easier to pron ounce and rem ember,
anyway.

Input and Output
If a computer is going to process information, there has to be some
means for entering info rmatio n ,into the computer and getting it back.

In formation is input into the computer (reading data) and is output from
the compute r (writing data).
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Many form s o f in put and outp ut are available to computers, depend ing
on wh ich periphera ls are attached to the computer. Aperipheral is a device
that is external to the C PU and t h at allows the computer to interact w ith
the outside world or to store information for later retrieval. Peripherals
may be mounted externa lly to the computer by m ean s of cables or may
be internally mounted inside the computer's case, where they are
connected by cables o r by being plugged into expansion ports or expansion

slots.
Expansion slots are places wh ere peripherals may be attached to t he
computer by plugging in additio nal electronic circuit boards, and these
slots are located inside the computer's case. Expansion ports allow
periphera ls to be attached by means of a cable and may be located
internally or externall y.
All mi crocompute rs have at least one main electronic circuit board. Th is
board holds the microprocessor and other electronic compon ents that
make up the computer. TheSE and Mac II series of computers all h ave
at least one expan sion slot t hat allows the addition of oth er circuit
boards designed for special purposes. For example, many Macintosh
computers are now equipped with large monitors that are capable of
displ aying o ne, or even two, letter-size pages at actu al size. These
monito rs require a video carq that plugs into an expansio n slo t o n the
com puter's main circuit board.
The most common peripherals attach ed to a Macintosh computer are a
mouse, keyboard, mo nitor, printer, modem, disk drive, and tape drive.
Mouse

A mouse is a hand-h eld device that slides on a desktop and allows you
to co ntrol the position of a pointer o n the computer screen. The pointer
ind icates wh ere the next action wi ll take place if you click the m ouse
button .
A m ouse used w ith the Macintosh has only one button. When you press
and release the button, it tells the Macintosh that you want to do
som ething at the position where the pointer is located on the screen.
Most computer system s other than the Macintosh make the user
inte ract mostly th rough th e keyboard, and that can be very frustrating
if you are not a touch typist. On the Macintosh, m ost of your interactio ns
wi ll involve pointing at something a nd clicking the mouse button.
Although the mouse is the most commo n poin ting device for the
Macintosh, many people use alternate devices, such as trackballs, which
consist of ba lls m ounted in a stationary housing. Moving your h and
over the ball causes the pointer to move in the same directio n . The
Macintosh Portable has a trackball, and they are available for attachment
to oth er Macs as well.
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Keyboard

The keyboard is used for entering text. Unless you are actually e ntering
text, you don't n eed to use the keyboard at all. Some people prefer to
keep their ha nds on the keyboard, so most Macintosh programs prov ide
keyboard equivalents to using the mo use and pulling down menus.
These keyboard equivalents are also known as Command-keyequivalellt5.
They allow you to issue commands using the Command key. For
example, Command-S o ften m eans Save. When a Comm and-key
equi valent is available for a particular command, it is listed nex t to the
command o n the right side of the menu. Other keyboard sho rtcuts and
Command-key equivalents are listed in the m anual fo r each program .
Monitors

A monitor is the TV screen used with a compute r. You also will h ear this
referred to as a CRT (cathode ray tube) or sometimes as a VDT (video
displ ay terminal).
The monitor is the output device you will u se the most wh en wo rking
on a Macintosh. As you type, draw, paint, calculate, or compose pages,
you will see the results of your actions on the mo nitor.
This almost instantaneous feedback is what allows you to interact so
intuitively with the Mac. As you do something with the mo use o r
keyboard, it is shown o n the screen. As the computer perfo rms a n
o peration, you ca n quickl y see the results.
Some models of the Macintosh o nly suppo rt black-and -white mo nito rs.
All Macs in the o riginal-sh aped case (128 K, 512K, 5 12Ke, Plus, SE, SE/30,
Mac Classic) and the Mac Portable come equipped with a built-in blackand-white monitor. TheSE, SE/30, and Portable also have slots o r po rts
that m ake it easy to add other monitors that support color, or that can
display a full letter-size page of text or mo re.
The m od ula r Macintosh compute rs (II, llx, llcx, Ilci, ll fx, LC, Ilsi) do no t
come bundled with a m onito r. You can ch oose to add a black-and-white
or a color m onitor. In fact, if you can affo rd it, you can add both, o r even
severa l of them in any combinatio n to all of these models but th e LC a nd
llsi. Drawbacks to adding extra monitors, ho wever, include the am ount
o f extra RAM required to use them and the delay caused by updating
more than o ne screen .
The standard Macintosh screen has a resolutio n of 72 dots per inch . Dots
per inch (dpi) refers to the numb~of d ots that are displayed h orizontally
a nd vertically by th e screen in o e inch . As this numbe r (5,184 dots per
square inch ) increases, so does t e resolution o f the device. Resolution is
a measure of how well a d evice cbn produce an image. High er resolution
produces clearer images. (The Mac screen , at 72 dpi, has a resolution o f
5,184 do ts per square inch; a LaserWriter, at 300 dpi, has a resolution o f
90,000 dots per square inch . The number o f ho rizontal and vertical dots
per inch is a little over 4 times greater, and the resolutio n improves by
a facto r of a little m ore than 16.)
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Each dot on the screen is known as a pixel (pictu re element) an d is used
to represent the info rmatio n you see. The Macintosh screen uses square
pixels so that wh en a circle or square is d rawn on the screen, that is what
you see. Ma ny o ther compu ters use rectangu lar pixels that are taller
than they are wide, because they were designed for use with text rath er
than graphics.
Printers

Wh en you h ave in formation that you wan t to preserve or send to
someone, you can print it on paper. This is kn own as hard copy. Soft copy
is what you see on the screen. It is called soft because it is chan geable and
transitory.
Th ere are many types of printers. On the Macintosh, you are mostly
concerned with two types of printers: ImageWriters an d LaserWriters.
The ImageWriteris a dot-matrix printercapable of printing text and graphics
at a resolution o f 72 or 144 dpi, dependin g upon whether you choose
fastero r betterquality when you print. Faster printing uses lower resolution.
Better uses high er resolution but prints much slower.
The LaserWriter was a dramatic development in printer technology
when it was introduced. It offered, and con tinues to offer, much h igher
resolution than an y dot-matrix printer and its o utput is often referred
to as near-typeset quality. The LaserWriter p rints 300 d ots per inch an d
supports the PostScript page description language, wh ich is a programming
language d esigned to facilitate graph ics printing and p rovide sm ooth
outline fonts. (This includes text, since the characters printed by
PostScript are mathematical descriptions of th e shapes used to represent
those characters.)
LaserWriters come equipped with a set of built-in, high-quality fonts.
The LaserWriter Plus, liNT, Personal liNT, IINTX, and Person al IINTX all
come with 11 fonts in 35 typefaces. If the font you want to use is n ot
included in this selection, you can down load others from your computer.
Th e LaserWriter liNT and IINTX can use mo re additional, downloadable
fonts due to their increased RAM. The LaserWriter IINTX also offers th e
option of attaching a hard disk to the printer so th at additio nal fonts will
be readily accessible to the printer.

Modems

Modems are devices that allow comp uters to com mun icate with each
other over the phon e lines . The speed of this communication is
increasing. The standard communication speed was 300 baud (about 30
ch aracters per secon d) just a few years ago. Then it wen t to 1200 baud,
and n ow many people are using 2400, 4800, and 9600 baud over no rmal
pho n e lines.

Chapter 2: Computer Concepts

43

If you have a computer, a mode , and communica tion software, you
ca n access o the r computers arou r d th e wo rld.ln computer-to-compute r
communicatio n , both users have to have a modem and communication
software, but you d on 't have to have the sam e type of computer. In fact,
dissimilar computers, such as IBM PCs and Macs, can communicate
using mod em s. Man y people a re usi ng their computers and modems to
transm it a nd receive electronic mail.

Storage
Because RAM is temporary memo ry, you must have some other way to
retain info rmatio n after yo u turn off the computer. For this p urpose you
generally use some type of magn etic mass storage such as disks or tapes.
On the Macintosh, hard disk drives are the primary form of data storage
because o f th eir ability to h old large amounts of information. You
sh o uld keep a copy of what is o n yo u r hard disk, and backing up the
info rm atio n to floppy di sks is very popular because every Macintosh h as
at least on e floppy disk drive. Tape drives, however, are becomin g mo re
widely available and are in creasingly popular because they ho ld so
much mo re information than floppy disks, and backing up u sing a tape
drive is much faster and easier.
Most info rmatio n is distributed on 3.5-inch floppy disks in the Macin tosh
world . These disks are n o t really floppy, because they are enclosed in a
ha rd p las ti c case. Most people just refer to them as disks.
Disks are called permanent, o r no nvolatile, sto rage. However, do not
make the mi stake o f thinking tha t once you have stored your data o n a
d isk th at it will be available forever. Although the in formation on a disk
is no nvo latile, the dis k itself has an unpredictable lifetim e. Disk
techno logy, in its simplest terms, is a m eth od of sto ring information
mag netically on to very small m etallic particles glued to plastic (disks) or
a luminum (hard disks). An yth ing that dam ages the surface of the disk
wi ll ca use you to lose an y informatio n that might be sto red there, and
it can even cause you to lose all of the informatio n on that disk.
Fo r th is reason, it is standard p ractice to m akebackupsofyour information.
You ca n copy a document o n to two or m ore disks. If one of them goes
bad, you can use the other backup copy. If you do n ot h ave a backup
copy, you will probably lose wha tever informatio n was stored o n that
disk.
The n u mber of backups you make, and the frequency with which you
m ake them, depe nds on how valuable the in format ion is and how
d ifficult it would be to recover o r re produce. Accounting info rmatio n o r
impo rtant strategic plann ing docum ents for a who le compa ny sho uld
be backed up frequen tl y.
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SUMMARY
• A computer system is composed of memory (ROM and RAM), a central processing unit (CPU),
input and output devices, storage devices, and oth er attached peripherals.
• Com puter systems can be divided into two major categories: softwa re and ha rdware.
• There are two types of software: system software and application software. System software
allows various parts of the computer system to interact . Application software is used to solve
a problem or perform a task, such as writing a letter or planning a budget.
• Common peripherals attached to a Macintosh computer include a mouse, keyboard,
monitor, printer, modem, and storage devices such as disk and tape drives.
• Two main types of printers are most commonly used on microcomputer systems: dot-matrix
and laser. Dot-matrix printers have the advantages of being able to produce multiple copies
on multipart forms, many can print in color, an d they can print on continuous fo rms such
as computer paper, mailing labels, 3x5 ca rds, and pre-printed checks. Laser printers have the
advantages of being faster, q uieter, and producin g better quality out put, but they accept only
cut-sheet paper and cannot print on multipart forms.
• Most computer information is stored on hard disks. Since the life of a disk is indeterminate,
data is backed up on floppy disks and/or tape cartridges. Floppy disks have the adva ntage of
being available on all computer systems, but backing u p large quantities of data is a slow,
boring process wh en using th em. Tape drives are optional and cost more, but they have the
advantage of being faster and easier to use, and a cartridge stores much more information
than a floppy disk.

KEY TERMS
algorithms
application software
backup
baud
bit
byte
cable
Command-key equivalent
CPU (central processing unit)
CRT (cathode ray tube)

Finder
floppy disk
hard copy
hard d isk drive
hardware
input
Image Writer
keyboard
kilobyte
LaserWriter

dot-matrix printer
dpi (dots per inch)
electronic circuit board
expansion port
expansion slot

m egabyte
memory
microprocessor
modem
monitor (also called CRT or VDT)
mouse
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output
pe ripheral
pi xel
pointer
PostScript
printer
program
RAM (rando m access m emory)
resolution
ROM (read-o nl y memory)

soft copy
software
system software
tape drive
trackball
VDT (video display terminal)
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P

art II introduces Macintosh graphics.
Chapter 3 presents the basic concepts of graphics applications.

Chapter 4 introduces you to usmg MacPaint. MacPaint was the first
graphics application created for the Macintosh, and it is both fun and
easy to use. You will create some drawings of your own in this chapter
and copy some existing MacPaint artwork into your drawing.
Chapter 5 teaches you how to use MacDraw II. MacDraw II's ease of use
and high quality output make it one of the most popular drawing
programs for the Macintosh. You will create drawings using some of
MacDraw II's text and layout CaJ?abilities.
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Chapter 3: Graphics Concepts
What You Will Learn in This Chapter
After readi ng th is chapter, you shou ld be able to :
•

See that there is a familiar drawin g environ m en t used in a
graphics ap plicatio n

•

List some uses fo r com puter graphics

•

Understa nd the differen ces be tween bitmapped a nd ob jectoriented graphics

ost people don 't associate fun with a computer, but d rawing
with a graphics application is just that-fun. The combination
of using the mouse, the Macintosh 's screen resolutio n, its
graphical user interface, and the Laser Writer creates an environment of
easy-to-use, h igh-quality gra ph ics.

M

just how do you go about drawin g with a computer? Gra ph ics
application s make it easy by p roviding a familiar en viro n ment-your
screen acts as the paper, and you have available the various tools you
would need for any drawing, such as pen cils and paint brushes. You can
draw lin es a nd sh apes, even perfectly straight lin es and perfect circles
and squares, without h aving a ny specia l skills. You ca n paint lines and
fill sh apes using an array of patterns. Not o nly can you d raw ob jects in
varying shapes and sizes, but yo u can erase, move, duplicate, flip, invert,
rotate, sh rink, and stretch your creatio ns. Once you have created your
masterpieces, you can save them and copy them into other drawings
an d othe r types of documents.
There are endless usesforcomputer graphics. You ca n create noteworthy
greeting cards, an no uncements, inv itations, sig n s, posters, a n d
letterh eads. You can illustrate term papers and reports, create logos, and
design floor plans. You can create decorative m ailing labels and
illustrated n ewsletters. Graphics can also make a business presentation
impressive. Your im agination is all that limits your uses of a graphics
application .
If you don' t h ave the inte rest or the talent to crea te freeh and drawings,
you can use some of th e th ousands o f drawings ava ilable fro m firm
whose artists produce some useful libraries of clip art. There are a lso
p ublic domain drawings available from users groups a nd public domain
libraries. Creativity an d drawing ability are not prerequ isites for using
and en joying a graphics application.
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BITMAPPED GRAPHICS
There are basically two types o f graphics applications: paint (bitmapped)
programs and draw (obj ect-oriented) programs.
·
Painted, o r bitmapped, shapes are a collection of dots. Drawing with a
painting program consists of turning on or off a series of dots on the
screen . If the dot is on, it is black; if the dot is off, it is white.
To mod ify a shape created in a paint program, you must turn off, or
"erase," the dots fro m the part oft h e shape that you wantto modify. The
concepts of painting with a program such as this are relatively easy to
understand, and even beginners can quickly master bitmapped drawing
techniques.
A dot is also called a pixel, for "picture element." A pixel is stored
internally as a bit, and a map of these bits and their on or off status is
stored for each drawing, hence the term "bitmapped ."
The Macintosh screen displays 72 dots per inch, measured both
h orizon tally and vertically, giving each square inch 5, 184 dots that can
each be either on or off. Paint programs su ch as MacPaint use each of
these pixels to compose the drawing page.
The main drawback of paint programs is the resulting jagged lines and
edges of some of the objects when they are printed. This is often referred
to as the j aggies. Figure 3-1 illustrates the differen ce between the output
of a bitm apped drawing and that of an object-oriented drawing. Notice
the jagged curves of the bitmapped drawing o n the left.

bilmapped drawing
Figure 3-1

object-oriented drawing

Comparison of bitmapped and ob ject-oriented output

so

Part II : Graphics

There are many excellent paint programs on the market, som e of which
arc m ore sop hi sti cated th at others. MacPaint, Ful!Paint, DeskPaint,
Stud io/1, Studio/8, Pi xel Paint, and SuperPaint are all paint programs of
varying degrees of sophistication and difficulty. Studio/8, DeskPaint,
Pixel Paint, and Supe rPai nt support color. SuperPain t uses two layers to
allow you to paint bitmapped objects on one laye r and object-oriented
objects on the other.
The bitmapped paint program you' ll be using in C h apter 4 is MacPaint.

OBJECT-ORIENTED GRAPHICS
In an object-oriented drawing program, each object in the drawing is
stored as mathematical information in the computer rather than as a
collection of dots.
In an ob ject-ori en ted drawing you can move one item on top of the
other and the "foreground" item does not "erase" the item it obscures,
li ke it would in a bitmapped program. You also use a different technique
to edit object-oriented images. Objects cannot be edited dot-by-dot as
bitmapped images can. Modifying an object-oriented item is easier,
since you can resize an item and change its fill pattern, line pattern, and
thickness without red rawing it.
Using an object-o riented progra m is different from using a bitmapped
program, and object-oriented programs are generally more soph isticated.
Also, the output of object-oriented graphics program s is gene rally
superior to that of bi tmapped programs. This is because object-oriented
drawing programs use the attributes of each ob ject to create an image
that contains as many dots per inch as the printer can produce.
Therefore, images to be printed on the LaserWriter will be converted to
300 dots per inch before they are printed.
MacOraw II, SuperPaint, and OeskDraw are examples of object-oriented
drawing programs. There are also some soph isticated 3D drawing
programs available, such as Pro 30. Two professional level drawing
programs for technical illustrators and artists are Aldus Freehand and
Adobe Illustrator. While technically object-oriented, these programs
create graphics using the PostScript printer description language and
work o nly with PostScript printers, such as the Apple LaserWriter. In
PostScript graph ics, the description of each drawing element is stored in
PostScript, which is the sa me language that a PostScript printer uses.
You'll be exploring some of the many object-oriented features of
MacDraw II in C hapter 5 .
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SUMMARY
• The mouse, the Macintosh's screen resolution and its graphical user interface, and the
LaserWriter have created an environment of easy-to-use and high-quality graphics.
• Graphics applications provide a familiar drawing environment. Your screen acts as the paper
or canvas and you have available the various tools you would need for any drawing, such as
pencils and paint brushes.
• Drawings created in a graphics application can be saved and copied into other drawings and
into other types of documents.
• There are man y uses for computer graphics . You can create greeting cards, announcements,
invitations, signs, posters, logos, and letterheads. You can illustrate term papers and reports,
design floor plans, and incorporate graphics into business presentations. Your imagination
is all that limits your uses of a graphics application.
• There are basically two types of graphics applications: paint (bitmapped) programs and draw
(object-oriented) programs.
• Bitmapped shapes are drawn by turning on or off a series of dots on the screen. If the dot is
on, it is black; if the dot is off, it is white. To modify a shape created in a bitmapped graphics
program, you must turn off, or "erase," the dots from the part of the shape that you want to
modify.
• In an object-oriented drawing program each object in the drawing is stored as mathematical
information in the computer rather than as a collection of dots. It is easier to modify an
object-oriented item, since you can resize an item and change its fill pattern without
redrawing it.
• The output of an obj ect-oriented graphics application is usually superior to that of a
bitmapped application.

KEY TERMS
bitmapped
jaggies
object-oriented
pixel
PostScript
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Chapter 4: MacPaint 2.0
What You Will Learn in This Chapter
After reading this chapter and completing the projects in it, you sho uld
be able to:
•

Positio n tear-off menus on the drawing window

•

Select, move, an d duplicate objects

•

Use the Shift key for horizontal and vertical co nstraints

•

Change line weights with the border palette

•

Draw objects filled with a selected pattern

•

Draw lines and unfilled ovals, circles, and rectangles

•

Use Zoom In and Zoo m Out for detailed drawing

•

Position the drawing using the grabber tool and the scroll bars

•

Use different brush shapes and patterns

•

Copy drawings to the Clipboard

•

Paste drawings into a document from the Clipboard

•

Use the Flip Horizontal and Rotate commands

•

Fill objects using the paint bucket tool

•

Add text to a drawing using the text tool

•

Save and print docum ents

acPaint was one of the first two application s available on the
Macintosh, and it set the standard for bitmapped graphics on
this computer. These standards are still in effect today, which
means users can tra nsfer graphic images fo r most applicatio ns to almost
every other applicatio n.

M

Imagine drawing a picture using only the keys on a typewriter a nd n o
other tools. Producing gra phics on a computer prio r to the introduction
o f the microcomputer just te n years ago was essen tia lly like producing
pictures o n a typewriter. Using this method o f ch aracter-based graphics,
your picture was formed with wh atever cha racters were available.
MacPaint is a good example of just h ow fa r we've progressed in the field
o f computer graphics in the last decade or so.
Instead of trying to paint a picture with a typewriter, wouldn 't it be
easie r to use tools you' re already familiar with? Most people started th eir
a rtistic endeavors using crayons, and when they learned to stay inside
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the lines they progressed to colo ed pencil s, watercolor sets, charcoal, or
pen and in k. With each new tool that was adopted, they were able to
overlay new ski lls on top of the skills that were developed using crayons.
MacPa in t allows you to take skills you've al ready developed and apply
them to compu ter gra phics. MacPaint provides tools that you are
fam iliar with , such as pencils, brushes, erasers, and spray can s, and
introduces new tools such as t h ose for producing geometric shapes and
stra ight lines.
Remember as a child when you watched your favorite cartoon character
on TV and you were amazed and entertained when he or she threw a
bucket of plaid paint on a wall? You knew, even as a chi ld, that this
cou ld n't be done in th e real world. However, using a Macintosh and
Mac Paint, if you want to t hrow a bucket of pla id painton a wall, you can.
MacPaint 2.0 is the second generation of this program and has all the
original featu res as well as some very inte resting new abilities. This
ch apter will start you on your journey to discovering the fascinating
capabilities of MacPa int.

STARTING MACPAINT
•

MacPaint 2 .0

Double-click on th e MacPaint 2.0 icon to open a new, untitled
drawing window.

Every new documen t h as the title "'Untitled-1' at lOOo/o" until you save
it for the first time an d give it a na me.
The drawing window shows only a part of the 8- by 10-inch a rea
available for drawing.
A menu bar ru ns across t he top of the screen:
,..

•

File

Edit

Goodies

Font

Style

Pa ttern s Tools

You'll learn about each menu as you get to it.

GETTING HELP
Many applications provide online help for qu ick refe rence when you are
using different tools and com m hnds. Unfortuna tely, MacPaint is not
one of th ese programs. Th e rkference manual you get when you
purchase MacPaint is very conpreh ensive, however, and includes a
tuto ria l as well as detailed descriptions of the features of each tool and
command.
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SAVING YOUR WORK
The first time you save yo ur document, MacPaint asks you, by way of the
dialog box shown in Figure 4-1, where you wa nt your document saved
and what you wa nt it to be named. After you have saved it the first time,
the next time you choose Save, MacPaint assumes you want the
document to be saved in the same place and under the sam e name. Be
ca refu l about saving your document in the correct place the first time
you save it so you can find it later. The save process is much quicker the
seco nd and subsequent times, because yo u are not prompted fo r any
additional information.
Unfortunately, sometimes people are not careful, and they occasionally
lose their work because they save it but do not think about where they
are saving it and then can't find it aga in. Clicking the Drive button (see
Figure 4-1) toggles between one or more flo ppy drives and hard drives,
depending on the hardwa re you are using. The Save dialog box shows
the name of the floppy disk or hard drive as th at drive is selected. You
are saving you r document o n th e selected disk or hard drive with the
name showing in the Save dialog box. In the dialog box shown in Figure
4-1, the name ofthed isk, Connie Barlow, is shown in two places. Always
be aware of where you are savin g your work.
The Save As command is similar to the Save command, except that it
enables you to give yo ur document a d ifferent name and save it in a
different location . Every time you choose Save As from the Fi le m enu,
you a re prompted with the dialog box shown in Figure 4-1. This is the
same dialog box you see the first time you save your document.
When you use the Save As comm and and you attempt to save the
docume nt with the same nam e and in the sa me location as before, you
w ill be asked if you want to replace the old document. Th is is because
no two files in a particular location can have the same name. If you want
to save different versions of the same document, use the Save As
com mand and give the document a different n a me and/or location.
Save your work often-at least every ten minutes, so you n ever lose more
than ten minutes of work. The Comma nd-key equivalent of the Save
command, Command-S, is a helpful shortcut. Always save yo ur work
before printing.

Ijg) Connie Borlow I

Saue Point document as:
Document format:
@ MocPoint

Figure 4-1

0 Stationery

0 St artup screen

Th e Save dialog box
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Be aware that you can save a documen t before you actually type
anyth ing into it, and that many people do it this way. However, you will
be given explicit instructions for saving your work at appropriate times
throughout the projects in this chapter.

USING MACPAINT'S TOOLS
"•

II II

Click Tools in the menu bar.

This shows you the toolbox. The toolbox is what is referred to as a tearoffmenu. It can be placed and moved to wherever it is most accessible
on the screen. Placing the toolbox on the screen gives you faster access
to the different tools and allows you to see at a glance which tool is
selected. You can move the toolbox to a different place on your screen
if it gets in your way.
To tear off the toolbox, click and drag downward until the cursor goes
past its bottom edge. When you do this, the outline of the toolbox
follows the cursor around on the screen, as shown in Figure 4-2.
Wherever you stop and release the mouse button, the toolbox will
remain. The patterns palette is also a tear-off menu .
,.. Tear the toolbox off the menu bar and position it in the bottom right
portion of the screen, as shown in Figu re 4-2.

s
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Figure 4-2

The Tools menu is a tear-off menu.

Now that you've got the Tools menu positioned, you'll learn how each
tool works, and you'll get practice working with each one before you
start the actual project.
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Drawing Lines
The pencil is the tool that is automatically selected when you open a n ew,
untitled drawing window. It is used to draw a one-pixel-wide li ne. You
can tell it is selected because it is highlighted. When the pencil is selected,
th e pointer becomes a pencil wh en positioned over the drawing area.
•

Hold down th e mouse button while you drag the pencil across the
drawing window in the direction you wa nt to d raw. Release the
mouse button when the line is the length you want it to be.

The pen cil tool draws a freehand line. The line you d raw will be crooked,
but you get the idea of how the pencil works. Draw a few li nes with the
pencil to get the feel of it.
The line tool is used to draw straight lines. When the line tool is selected ,
the pointer becomes a cross-beam(+) . As you draw a li ne you can control
the len gth of the line and its p osi tion o n the screen. When the line is
positioned and sized like you want then you release the mouse button.
•

Select the line tool by clicking on it in the toolbox.

•

Hold the mouse button down while you drag the pointer across the
drawing window, and release the mouse button when the line is the
desired length and angle.

Practice drawing a few more lines with th is tool.

Using the Eraser
Now is a good time to learn how the eraser tool works, because you can
use it to clear the screen of the lines you just drew. When you select the
eraser by clicking o n it, the pointer becomes a small square. To erase,
hold down the mouse button while dragging across the object you want
to erase.

CAUTION

Caution: doubl e-clicking on the eraser in the toolbox erases the entire
screen. This is a great sh ortcut if you want to clear your screen. Be sure
to click o nly on ce on th e eraser to select it when you don't want to erase
the who le screen.
•

To get rid of the lines you practiced drawing, d ouble-cli ck on the
eraser tool to clear the wh ole screen, or drag the eraser across the
lines to erase them.

Drawing Shapes
MacPaint provides severa l tools for easi ly d rawi ng a variety o f shapes.
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Rectangles and Squares
Unfilled and filled rectangles and unfilled and filled rounded rectangles
allow you to draw rectangles and squares. The unfilled rectangle draws
hollow rectangles and squares, and the filled rectangle draws rectangles
and squares that are filled with the currently selected pattern in the
Patterns menu. The rounded rectangles work the same way, except that
they have rounded corners. The pointer becomes a cross-beam when
you select any of these shapes.
•

Click on the unfilled rectangle tool in the toolbox to select it, and
then place the cursor in the upper left corner of the screen.

.. Hold down the mouse button and drag diagonally to the bottom
center of the screen, and then release the mouse button.
You use the filled rectangle tools in the same manner.
•

To change the currently selected pattern, choose Patterns from the
menu bar, and drag down to the pattern on the palette that you want
to use. Release the mouse button while the pointer is on the desired
pattern.

If you choose Patterns again from the menu bar, you'll see that the

wider box on the left side of the first row reflects the currently selected
pattern, as shown in Figure 4-3.

Figure 4-3
•

The currently selected pattern in the Patterns menu

Click on the filled rounded rectangle, and draw a rectangle in the
same manner as you did the hollow rectangle. It is filled with the
pattern that you select or with the default pattern.

To draw a perfect square, hold down the Shift key while using the
rectangle tools.
•

Draw a few filled and unfilled squares, rectangles, rounded squares,
and rounded rectangles for practice, and then clear the screen with
the eraser tool when you're leady to go on.
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Ovals and Circles
The unfilled and fill ed ovals are used to draw ovals and circles. The
unfilled oval draws h ollow ova ls and circles, and th e filled oval draws
ovals and circles that a re fill ed with the selected pattern. The pointer
becomes a cross-beam when you select either of these sh apes.
•

Click on the filled oval tool in the toolbox to select it, select a pattern
fro m the Patterns me nu, and the n place the pointer in the center o f
the screen.

•

Hold down the mouse button and drag diagonally to create an oval.
Release the mouse button when the oval is the shape and size you
want.

To draw a perfect circle, ho ld down the Sh ift key when using either of
the oval tools.
•

Draw severa l circles and ova ls using bot h o f these tools, and then use
the e raser to clear the screen when you are ready to go on.

Freehand Shapes
The unfilled and fill ed {reella11d tools allow you to draw curved irregular
freehand shapes, e ither filled with the currently selected pattern or
hollow. The pointer becomes a cross-beam when you select e ither of
these tools.
-

Click on the fill ed freehand tool in the toolbox to select it, and then
hold down the mo use button w hile you drag the pointer to create
the shape of a banana o n the screen. Release the mouse button
wh en the lines are connected to close the shape.

Polygons
The unfilled and fi lled polygon tools allow you to create angular shapes
consisting of different angles and short connected lines, such as L-shapes
and stars, e ither filled with the currently selected pattern or hollow.
When you select either of t hese too ls the poin ter becomes a cross-beam.
•

Select the unfilled polygon tool from the toolbox, and click once on
the screen to create a starting point for your polygo n.

•

Move the pointer about o ne in ch to the right, and th en cl ick again
to a11chor that line.

..

Move the pointe r in a different directio n this time, and click again
to an chor th e n ew line, as shown in Figure 4-4.
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•

Shapes drawn with the freehand and polygon tools

When you've drawn all the angles and lines that you'd like in this
polygon, double-click on the screen where th e last line should end
to finish the po lygon and release the polygon tool.

When you've finished practicing with these tools, use the eraser to clear
the screen.

Painting
The spray can tool is used to spray a "mist " of the currently selected
pattern onto the drawing area. You can make the mist mo re dense by
moving the pointer repeatedly over the same area. The pointer changes
to a series of small dots when this tool is selected.
•

Click on the spray can in the toolbox to select it, and then move the
pointer into the drawing window.

.. Ho ld d own the mouse button and drag the pointer across the screen,
moving the mouse in a side-to-side motion. Release the mouse
butto n when you've painted the desired area.
When you've finished experimenting with this tool, double-click on t he
eraser tool to clear the screen.
The paint brush too/lets you paint brush-st rokes of the selected pattern.
There are m any brush shapes available. You access them by dou bleclicking on the paint brush tool. The pointer changes to the currently
selected bru sh shape when this tool is selected.
,,. Doubl e-click on the paint rush tool in the toolbox to display the
selection of brush shapes a ailable.
.. Click once on any of the brush shapes to select it, and then position
the po inter in the drawing window.
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•

Try writing your first name by holding down the mouse butto n and
dragging the pointer around in the drawing window.

•

Practice with the paint brush using different patterns and brush
sh apes. When you are finished, clear the screen by double-clicking
on the eraser.

Using Different Line Weights
The border palette is used to change the weight of a line. It affects the
thickness of the lines that you draw with the line tool and the borders
of any of the shapes. When you click on one of the line weights in the
bo rder palette, the cross-beam indicato r on the left of the border palette
reflects the currently selected horizontal and vertical weights of the line.
The position of the small triangle above the line controls the vertical line
weight, and the positio n of the triangle below the line controls the
ho rizontal line weight, as shown in Figure 4-S.

Figure 4-5

Different horizontal and vertical line weights

Entering Text
The text tool allows you to add text to a drawing. The text characters are
created in the type style, or font, that is selected from the Font menu .
The o ptio ns in the Style menu also apply to the text you type. When you
select the text to ol, the pointer changes t o an !-beam.
,,. Click o n the text tool to select it, and then m ove the pointer into the
drawing window.
,,. Click in the center of the drawing window to set the insertion point.
The insertion point is where the text will begin on the screen, and it is
represented by a small, blinking vertical line.
•

Choose a fo nt of your cho ice from the Font menu by dragging to a
font name and releasing the mouse button.

•

Choose one of the larger font sizes from the Style menu by d ragging
to a size and releasing the mouse button .

Font sizes are shown in points. Since there are 72 points, or dots, per inch
o n the Macintosh screen, a 72-point character is 1 inch high, and 36point type is 1/z in ch high.
•

Type your name. If you make an error, press the Backspace key
(Delete key on some keyboards) to delete the incorrect characters
and then retype . To go to another line, press the Return key.
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MacPaint's text capabilities are ~ery limited. As long as you do not click
the mouse button to reset the msertion point, you can backspace to
delete and correct mistakes. Once you have moved on to another tool
or have clicked elsewhere on the screen, you can no longer use the
Backspace key to delete characters-at that point you must retype.

Selecting Objects
In MacPaint, as in most Macintosh applications, you have to point out
an object that you want to do something with, and then you either issue
a command or take some action with the mouse. You select something
as a means of pointing it out. For example, to copy an object you select
it first, and then you choose Copy from the Edit menu. If you didn't
select the object first, MacPaint would not know what you wanted to
copy.
Two tools are used to select objects in MacPaint: the selection rectangle
and the lasso.

u
I
....0

Selection Rectangle

To use the selection rectangle, also called the selection marquee, you click
and drag through an object in a diagonal manner to encompass the
selection with a dotted rectangle. The border of the rectangle surrounding
the object will look animated-the effect has been described as looking
like marching ants. The pointer changes to a dotted cross-beam when
this tool is selected (see Figure 4-6).
,,. Click on the selection rectangle in the toolbox to select it.
•

' a

Beginning slightly above and to the left of the name you just typed,
click and drag diagonally to slightly below and to the right of your
name, and then release the mouse button. See Figure 4-6.
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Figure 4-6

Selecting with the selection rectangle
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Your n ame and the white space around it with in the dotted rectangle are
now selected.
•

Now that th e object is selected you can click within the border of the
dotted rectangle and drag to reposition your name on the screen.

To deselect a selected ob ject, click somewhere on the screen (outside the
selected area) or click o n a tool in the toolbox.
•

Click somewh ere outside the selected area to deselect your name.

You can also select the entire contents of your window by do ubleclicking the selection rectangle in the toolbox.

Lasso
The other tool used for selecting objects is the lasso. Th e poin ter changes
to a lasso wh en this tool is selected (see Figure 4-7).
The difference between the selection rectangle and the lasso is that the
selectio n rectangle also selects all the area inside the rectangle, including
th e white space surrounding an ob ject, whereas the lasso shrinks to the
exact size of the ob ject and selects only the object.
•

Click on the lasso in the toolbox to select it.

•

While holding down the mouse button, move the lasso around your
n ame on the screen. The line it creates must completely encircle the
object you are selecting and must not cut into the object.

When you release the mouse button, th e name you selected looks
animated, as shown in Figure 4-7.
'
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Selecting with the lasso
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Clicking elsewhere o n th e screen or in the toolbox will deselect a nything
that you select with the lasso.
•

Without pressing the mouse button, position the pointer on the
selected name until the pointer changes from a lasso to an arrow.

If you click wh ile the pointer is not an arrow, it will deselect the
selected ob ject. You will need to encircle the object with the lasso again
to select it.

,,. Once the pointer changes to an arrow, click and drag to reposition
your name on th e screen, a nd then click somewhere else on the
screen to deselect your name.
Whether you use the selection rectangle or the lasso to select ob jects
depends on whether you want the area surrounding the object selected
also. The selection rectangle is easier to use, but sometimes you will
need the precision afforded by the lasso.

The Grabber
The grabber tool is not rea lly used for selecting, but it is used to drag a
portion of the window into view. The pointer changes to a hand whe n
this tool is selected.
•

Click o n the grabber in the toolbox to select it.

•

Position the hand on the screen, and then click a nd drag to shift the
position of the page on the screen.

Filling Objects
Filling an ob ject with a pattern involves using the Patterns menu and
the paint bucket. The Patterns menu is used to select the pattern that
you want to fill the o bject with.

Patterns Menu
The Patterns menu is a tear-off menu like the toolbox. You can position
it anywhere on your screen so you can easily access any of the patterns
it contains. The curre ntly selected pattern is shown in the wide box in
the upper left portio n of the Patterns menu. You click on a pattern to
make it the currently selected pattern.
.. Choose Patterns from the menu bar and select a pattern of your
choice by dragging to a patte rn and releasing the mouse button
when the pointer is on the pattern you want.
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Paint Bucket
The paint bucket is used to fill a hollow shape with a pattern. You select
the paint bucket and move it so that the drip of the paint bucket is inside
the shape to be filled with the selected pattern; then you click once
to fill the shape. Be sure there are no leaks, or gaps in the border of
the shape you are filling, or the paint will "spill out" and fill the
background area.
•

Click on the unfilled rectangle tool to select that tool, and then draw
a hollow rectangle about the size of a matchbox somewhere on the
screen.

•

Click on the paint bucket in the toolbox, and, without holding
down the mouse button, position the drip of the paint bucket inside
the rectangle. Click the mouse button once.

This fills your shape with the selected pattern. Use the eraser to clear the
screen when you've finished experimenting with this tool.

Project 1: Creating a Flyer
This project teaches you how to use MacPaint to create a flyer advertising
a yard sale. You'll use most of the tools in MacPaint's toolbox to
create the different shapes and pictures, and you'll use the text tool
to create the body of the yard sale flyer. The completed project is shown
in Figure 4-8.
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fi nal output of Project 1
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You' ll begin the project by drawing the garbage can in the upper left
corner of the flyer.
•

Select the line tool by clicking on it.

To draw the sides oft he garbage can, you'll draw one line and then you'll
select it, duplicate it, and fli p it horizontally.
•

Beginning in the upper left corner of the screen, click and drag
the pointer down, angling slightly to the right, to create a line about
2 1/z inches long, as shown in Figure 4-9.
"Un titled- I " ot I OO'Z.
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Drawing the first line

•

Next, select the selection rectangle by clicking on it.

•

Place the pointe r just above and to the left of the line you just drew
and, while holding down the mouse butto n, drag to the bottom
right of the line so that a dotted rectangle completely e ncompasses
the line. See Figure 4-10.
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Figure 4-10

Using the selection rectangle

Now the line you drew is selected.
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1

If you press the Backspace key
choose Clear or Cut from the Edit
menu) while an object is selected, you erase that object from the
drawing.

DUPLICATING OBJECTS
Now you'll duplicate the line you just selected .
There are a couple of ways to duplicate objects .in MacPaint. In each case,
the object you want to duplicate must be selected first.
3€: -C

3€: -V

One way to duplicate an object is to choose Copy from the Edit menu.
This copies it to the Clipboard, which is an area in memory that contains
the most recently copied or cut item. After copying an object to the
Clipboard, you click in your drawing wi ndow where you want the
duplicate to be placed, and then you choose Paste from the Edit menu.
The duplicate obj ect is then pasted into your drawing.

Using the Option Key
Another way to duplicate an object in MacPai nt is to hold down the
Option key while dragging the selected ob ject to a diffe rent position on
the screen . This leaves the original object in place and the object you
drag becomes the duplicate.

Using the Shift Key
The Shift key is used with the Option key when the duplicate object is
to be a ligned vertically or horizontally to the o riginal-for example, to
align objects alo ng their bottom edge, as you want to do in this case.
The Shift key has many oth er uses. It is used toconstmin a motion vertically
or horizonta lly. To draw a straight line, you hold down the Shift key
while using the line tool. To draw a circle, you hold down the Shift key
while using the ova l tool. To draw a square, you ho ld down t h e Shift key
while using the rectangle tool. To erase in a straight line, you hold down
the Shift key while using the e rase r.
You want the duplicate line you' re about to m ake to a lign with the
o rigin al line alo ng the bottom. You'lluse the Sh ift-Optio n combination
to accomplish this.
•

Press and ho ld down the Shift an d Option keys.

•

Move the pointer into the selection rectangle that surrounds the
line on the screen. While holding down the Option and Shift keys,
hold down the mouse button. Now drag the mouse to the right.
W hen the duplicated obj ect is where you want it, release the mouse
button. See Figure 4-11.
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Duplicating an ob ject

FLIPPING OBJECTS
111111
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While the duplicated line is still selected, choose Flip Horizontal
from the Edit menu .
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If you deselected the duplicate line by clicking somewhere else on the
screen, you must select it again so you can flip it.
Flipping this line horizontally makes the duplicate line have an angle

that is the mirror image of the first one. Now you have drawn both sides
of the garbage can.
•

Click on the line tool to select that tool.

•

To connect the two lines to form the bottom of the garbage can,
move the pointer to one end, hold down the Shift key, and draw a
horizontal line connecting the bottom ends of the lines, as shown
in Figure 4-12.
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Figure 4-12
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Using the Shift key with the line tool
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SAVING THE DOCUMENT
•
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Choose Save from the File menu.

You'll be presented with a dialog box similar to the o ne shown in
Figure 4-13.
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The Save dialog box

When saving a MacPaint document, you can choose o ne of three
document formats, as shown at th e bottom of t he d ialog box in Figure
4-13. MacPaint format is the preset option, and it causes the document
to be saved as a MacPaint p icture. The Station ery option lets you save
the document as a template that records the page setup, m enu positions,
and other preferences. The Startup screen option lets you save the
MacPaint drawing as a sta rtup screen that is displayed when you turn on
your Macintosh. You will use the defau lt MacPaint format for the
projects in this book.
It is important that you save your work in a place wh ere you know it will
be wh en you go back to modify or print that docum ent later. If you are
usi ng a data disk, be sure you save your work on it. Since you probably
named your data disk when you initialized it, you will want that name
to be at the top of the dialog box when it is presented to you, where
"Connie Barlow" is showi ng in Figure 4-13.
•

If n ecessary, cl ick t he Drive button to switch drives until the name

of your disk is s howing at the top of the window, as shown in Figure
4-13.

·•

In the box m arked Save Paint document as:, type the name that you
want this docume nt to h ave when it is saved: Yard Sale Flyer. Then
click the Save button.

Your document will no lo nger be named Un titled , as it h as been up to
this point- it will come back on the screen with the name Yard Sale
Flyer.
After you've named and saved the document once, when you next
ch oose Save, it wi ll automatically be saved with the same n am e, and in
the same locatio n , as when you originally saved it.
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CORRECTING MISTAKES
As you are working through this assignment, it is likely that you may
accidenta lly do something in the drawing window that you would like
to undo. MacPaint gives you a couple of options to use to fix your
drawing.
There are several ways to erase in MacPaint. You can erase all or part of
an unwanted drawing with the eraser tool. You drag the eraser across
an object to e rase it, o r you can double-click on the eraser tool in the
toolbox to erase the entire screen.
Another way to get rid of an unwanted part of your drawing is to select
it with the selectio n rectangle or the lasso and then press the Backspace
key (Delete on some keyboards). You can also use the Cut or Clear
command from the Edit menu to remove the selected object from the
drawing.
When typing with the text tool, you can press the Backspace key
to delete th e characters you just ty ped, as long as you haven't clicked
elsewhere on the screen or selected another tool. If you have done
either of these things, you have to erase the text in some other way and
retype it.

Using the Undo Command
One way to undo your last action is with the Undo Command from the
Edit menu. This command allows you to undo the effects created on the
drawing window with the last action ofthe mouse. Immediately after you
realize you did som ething in the drawing window that you didn't want
to d o, and before clicking an ywh ere else with the mouse, choose Undo
from the Edit menu. The key words here are "before clicking anywhere else
in the drawing window," because MacPaint will consider the last clicking
action the one to be undone.

Using the Revert To Saved Command
Another way to correct a mistake takes a certain amount of fo rethought.

If you always remember to save your documen t whenever you create anything
in it that you definitely do not want to lose, you 'll h ave no problem using
the Revert To Saved command in the File menu. This command brings
back to the drawing window the last version you saved on disk. Use this
command especia lly when you are trying something that you are not
sure will work. Save your work first, experiment, and then you can
a lways use Revert To Saved if your experiment didn't work. No matter
how badly you mess up, if you save your work wh enever you make a
significant change to your drawing window, you can always go back to
that last saved version using the Revert To Saved comman d.
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When you choose RevertToSav d from the File menu, you are presented
with the dialog box shown in Fi ure 4-14. Clicking OK will restore the
last saved version from your disk; clicking Cancel will cancel the
command.

Reuert to the last uerslon
SIIUed 1
( Cancel

LJLJ

)

Figure 4-14

Revert To Saved dialog box

Now you're ready to draw thicker vertical lines on the garbage can.

CHANGING THE LINE WEIGHT
You change the line weight by clicking on one of the other weights in
the border palette at the top of the toolbox.
,.

Click on the fourth line weight from the left.

-

While holding down the Shift key so that the line will be straight,
draw a thick, straight line down the center of the garbage can,
stopping before you touch the bottom line, as shown in Figure 4-15.
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Drawing a vertical line with the Shift key

Without using the Shift key,idraw some lines on either side of this
straight line, spaced about t e same distance apart.

Next you'll draw the lid to the garbage can.
•

Change the line weight back to the second one in the border palette,
where the pointer is in Figu1e 4-16.
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Chan ging the line weight

•

Select the unfilled oval tool from the toolbox.

•

Place the pointer above the garbage can on the upper left , and click
and drag to the right to make an oval about the same size as the
opening of the garbage can. Do this a pout 1/2 inch above th e can,
so you can place the oval o n top of the can after it is done, as shown
in Figure 4-17.
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Using the unfilled oval tool

SELECTING OBJECTS IN YOUR DRAWING
If you experime nted with the lasso a nd the selection rectangle in the

first part of this chapter, you'll recall the difference between t h em-the
selection rectangle a lso selects all the area inside the rectangle, includin g
the white space surro undin g a n object, whereas the lasso shrinks to the
exact size of the object and selects only the o bj ect. Yo u want to use the
lasso in this case because you want to select o nly the oval, not an y space
aro und it.
•

Click on the lasso.
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•

While holding down them , use button, move the lasso around the
oval. This line must comple ely encircle the object you are selecting
and must not cut into the object. See Figure 4-18.
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Figure 4-18

Using the Jasso tool

When selecting with the Jasso, you create a line around the object you
are selecting. If you release the mouse button without moving the lasso
back to the starting point of that line, MacPaint will close the gap and
finish the line between the point where you pressed the mouse button
and the point where you released it. This line will be a straight line.
.. Without pressing the mouse button, position the pointer on the
object until the pointer changes to an arrow.

If you click while the pointer is not an arrow, you will deselect the
selected object. You will need to encircle the object with the lasso again
to select it.
•

Click and drag the oval down to form the lid of the garbage can, as
shown in Figure 4-19. Don't worry about the lines showing through
the lid-you'll clean them up in a minute.
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Placing the lid on the garbage can
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Now is a good time to save your work.

3€ -S

•

Choose Save from the File menu.

Now you need to clean up any overlapping lines on your garbage can lid.

TOUCHING UP YOUR DRAWING IN A
MAGNIFIED VIEW
Zooming in on your drawing allows you to work in detail on any part
of your drawing. The first time you use the Zoom In command you magnify
your drawing to 200%. In the title bar of the window the percent
magnification that you are viewing is displayed next to the name of the
document.
The next time you choose Zoom In takes you to a 400% magnification,
and the next time to 800%, or what was originally called FatBits. (FatBits
is the term used throughout this chapter when referring to the 800%
magnification view.) Each level of the Zoom In magnification can be
useful for different purposes. FatBits gives you the ability to work in the
greatest detail.
•

Click on the pencil tool to select it, and then click once on the lid
of the garbage can.

MacPaint zooms in to the most recent point clicked on the screen.
Clicking on the lid of the garbage can will enable you to zoom in to
precisely that spot.

3€ -M

,,. Choose Zoom In from the Goodies menu.

3€ - M

,.

Choose Zoom In twice more in succession.

You should now be viewing your document in FatBits, as shown in
Figure 4-20.
A shortcut for getting directly to FatBits is double-clicking on the pencil
tool.
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Figure 4-20

Working in FatBits
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Notice the small actual size win[ow. This reflects your drawing as it
appears in the actual (100%) sizk. You can reposition this actual size
window by dragging it aro und b~ its title bar, or you can get rid of it by
clicking in its close box. If you want to see the actual size window again
after closing it, choose Show Actual Size from the Goodies Menu.
•

Select the eraser tool.

While you are pressing the mouse button, the e raser is active. When you
release the mouse button, the eraser does not erase.
Caution: Double-clicking 011 the eraser will erase the entire screen. If you
accidentally double-click on the eraser, you can always choose Undo
from the Edit menu.
•

Erase the dot created when you clicked on the lid with the pencil,
and then the parts of the thick lines that are on the lid, as shown in
Figure 4-21.
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Erasing in FatBits

To move to a different portion of the drawin g, select the grabber
tool.

If you click and drag with this tool selected, it moves the portion of the
drawing that you want to work with into view. Im agine it shifting the
page across the screen.

•

Continue touching up your drawing in th is manner until all the
parts of the lines that overlapped onto the oval lid h ave been
eliminated.

This is a good time to clean up any overlapping li n es that you may have
drawn when you drew the base of the garbage can.
You can erase o ne dot (or pixel) at a time with the penci l tool. If you click
in a white area with the pencil it yvill leave a black d ot, and if you click
on a black dot that dot will change to white (erasing the dot). All the
tools work in th e FatBits window n d in all the magnification views, but
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the pencil is probably the most useful in FatBits since you can work at
the level of the individual pixel.
•

When you are finished cleaning up the garbage can in FatBits,
double-click on the pencil tool to take you back to the normall 00%
size drawing. You can also use the Zoom Out command from the
Goodies menu, but that takes you back to 100% size in stages, and
it req uires choosing Zoom Out three times.

Since you've made changes to your drawing that you don't want to lose,
now is a good time to save your work.
~
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•

Choose Save from the File menu.

SHORTCUTS
Double-clicking o n the pencil tool is a shortcut when using FatBits. If
you would like to learn more MacPaint shortcuts, you can always access
a h elp screen called Shortcuts.
~
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•

Choose Shortcuts from the Goodies menu. The screen shown in
Figure 4-22 will appear.
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Select window
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Select contents of window
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Choose brush shape
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Select document
Select contents of document

lsc -' I [~J Select contents of wi ndow
!shift l l:!C -' I [~J Select contents of doc

Multiple Copies

Figure 4-22

•

The Shortcuts screen

To return to your drawing window, click anywhere in the Shortcuts
screen.

Try out some of these shortcuts. Whenever you need to refresh your
m emory while working in MacPaint, you can access this option.

ADDING ELEMENTS TO YOUR DRAWING
The last thing you need to do to your garbage can is to put handles on
both sides and on the lid.
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Drawing Filled Rectangles
You'll use the filled rectangle tool to draw the handles.
•

Click o n the filled rectangle tool in the toolbox.

Since filled rectangle means the object will be fi lled with a pattern, you'll
need to select a pattern with which to fill it.
•

Choose Patterns from th e menu bar, and d rag the pointer to the first
dotted pattern on the second row in the pattern palette to select that
pattern for your filled rectan gle (see Figure 4-23).

Figure 4-23

•

Selecting a pattern

Using the filled rectangle tool, draw a small rectangle near the center
of the screen, about the size of the one sh own in Figure 4-24.

If the toolbox gets in your way, you can move it to a new location by
dragging its title bar.
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After drawing the rectangle, choose the selection rectangle and
select the rectangle you just drew, as in Figure 4-24 .

You will duplicate this rectangle so you have a total of three, and then
yo u'll use them as handles for the garbage can sides and lid.
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•

To duplicate this rectangle, hold down the Option key and press the
mo use button and drag the selected rectangle. Wherever you release
your mouse button, it will leave a duplicate behind. Make three
duplicate rectangles, as shown in Figure 4-25.
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Duplicating rectangles

Rotating an Object
.. While the last of the three rectangles is still selected, choose Rotate
from the Ed it menu.
This will cause th e selected object to rotate 90° counterclockwise, as
shown in Figure 4-26. You'll use this rotated rectangle for th e handle
on the lid .
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Ro tating a rectangle

Select the lasso, and encircle the first of the three small rectangles.
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•• Move that rectangle to the l ft side of the garbage can and position
it against the can as a handle, as shown in Figure 4-27.
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Figure 4-27 Placing the left garbage can hand le

.. Place the other handle on the right side of the garbage can and the
horizontal handle on the lid, as shown in Figure 4-28.
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Figure 4-28

Finished garbage can

Your garbage ca n is complete.
•

Save your document now

b~

choosing Save from the File m enu.

Drawing Unfilled Rectangles
The next ob ject to draw is t he box of toys.
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•

Move the toolbox to the left side of the screen by dragging in its
title bar, so you can draw in the right side of the screen. In t he scroll
bar at the bottom of the scree n, drag the scroll box to the far right so
you' ll be working in th e right side of the window, as shown in
Figure 4-29.
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Figure 4-29

Move the toolbox and drag the scroll box

.. Select the unfilled rectangle tool.
•

Draw a recta ngle abou t 3 inches long and 1 inch high.

•

Use the line tool to draw the box flaps on either side of the box, so
your box looks sim ilar to the one sh own in Figure 4-30.
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Drawing the box and flaps

To d raw the teddy bear's h ead, select the unfilled oval tool. Wh ile
holding down the Sh ift key to get a circle, draw a circle about 1 inch
in diameter, as shown in Figure 4-31.
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Figure 4-31

Drawing a teddy bear h ead

Painting with Different Brush Shapes
To draw the ears, n ose and eyes o n the teddy bear, you'll use some of the
paint brush sh apes.
•

Dou ble-click o n th e paint brus h tool.

This b ri ngs up a box sh owing the available brush sh apes (see
Figure 4-32).
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Paint brush sh apes

.. Select the largest rou nd brush shape, second from the left on th e top
row (where the poi n ter is in Figure 4-32), by clicking on that shape.
Since the current pattern is th e one you used to draw the handles on the
garbage can, you n eed to change the pattern back to black.
•

Click to select solid black o n h e patterns palette, which is next to
the currently selected patter o n the top row.
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•

Draw two ears and two eyes on the teddy bear by clickin g this brush
sh ape wh ere you wan t the black circles. See Figure 4-33.
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Drawing the teddy bear's ears and eyes

Double-cl ick o n the paint brush tool again, and this time select the
circle that is secon d from left in the th ird row down, as shown by th e
po inter in Figure 4-34.
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Figure 4-34

Selectin g a d ifferen t brush shape

•

Draw the n ose with this brush sh ape.

•

Select the wh ite pattern from the patterns palette.

This is the pattern you' ll be using with the paint brush to create th e
white in the eyes.
•

Using the white brush shape, cl ick inside each eye of the teddy bea r
to p roduce an "eyeball" effect, as shown in Figure 4-35.
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Figure 4-35

Adding the teddy bear's eyes

.. To draw the ball, select the unfilled oval tool. Hold down the Shift
key and draw a circle about 2 inches in diameter, like the one shown
in Figure 4-36.
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Drawing the ball

Filling an Object with a Pattern
Next you'll use the paint bucket tool to fill the ball with a pattern .
•

Select the paint bucket tool.

•

Select a pattern of your choice from the Patterns menu.

It's always a good idea to save your work prior to painting with the paint
bucket, since you can accidentally click in the wrong portion of your
drawing and fill your whole screen with the selected pattern. For
instance, if you used the paint bucket tool inside the garbage can lid, it
would paint the whole screen because the oval tool often leaves gaps
that the paint can "leak" through. You can use Undo from the Edit
menu if you don't click somewhere else first.
3€ -S

.. Choose Save from the File 1enu.
.. Positio n the drip portion of the paint bucket within the boundaries
of the circle you just drew, ahd then click.
The ci rcle fills with the selected pattern, as shown in Figure 4-37.
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Figure 4-37

Filling the ball

Remember that where the drip of the bucket is positioned determines
where the fill pattern wi ll be painted. Each tool has a hot spot, and the
end of the drip is the hot spot for the paint bucket tool. You need to be
very careful where you click when the paint bucket tool is selected.
As soon as you have fin ished filling the desired ob ject, always select a
tool that is less likely to mess you up, such as the pencil o r one of the
selection tools. That way, if you accidentally click on the screen, you
won't do as much damage. The same holds true with the eraser toolselect a d ifferent, less destructive tool when you're fi nished using it.

Moving Objects
Once you've completed the teddy bear's head and the ball, the box
needs to be positioned so it looks as though those objects are in the box.
•

Using the lasso tool, encircle the entire box to select it, as shown in
Figure 4-38.

Figure 4-38

Selecting the box with the lasso

Chapter 4: MacPaint 2.0

85

• Drag the selected box up so that it partial ly covers the teddy bear's
n ose.
Now the teddy bear and ba ll appear to be in the box, as sh own in
Figu re 4-39.

Figure 4-39

The toys appear to be in the box

Drawing Text
Th e last step to finish this box o f toys is to add text to it.
Th ere a re two ways to add text to a MacPaint drawing-by drawing it or
by typing it. You 'll draw the text o n the toy box using the pa int brush
tool, an d in a few minutes you' ll type th e text in the middle of th e fl yer
using the text tool.
•

Select the pain t brush tool, bu t double-cl ick o n it so the selection of
pa int brush sh apes is also displayed. Select t he brush pattern t h at
is fourth fro m the left in the bo ttom row, as show n in Figu re 4-40 .
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Selecti ng a diffe rent paint brush sh ape
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Change the currently selected pattern to an y shade of gray from the
patterns palette.

•

Position the paint brush inside the box, o n the left side, and write
Toys across the front of the box. See Figure 4-41.

Figure 4-41
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Box of toys completed

Choose Save from the File menu.

Drawing and Filling Additional Objects
That com pletes the box o f toys. Next you'll draw the gaudy roll of
carpeting such as you'd find only at a yard sale.
S€ _L

•

Choose Zoom Out fro m the Goodies menu.

This will show you the drawing at SO% o f its actual size and a gray area
that represents the area outside the drawing.
•

Drag the toolbox over to the gray area so it doesn't obscure the
d rawing area.

Zooming out to SO% view allows you to see three-fourths o f the picture
at o ne time so that you can get an idea o f the overall effect. All the tools
work in SO% view. Use the vertical scroll bar to move a differe nt po rtion
of the picture into view.
•

Using the vertical scroll bar on the right, drag the scroll box all the
way to the botto m of the scroll bar so the botto m edge of the
drawing is visible, as shown in Figure 4-42.
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Fig11re 4-42

Moving to the bottom of the drawing

•

Select the unfilled oval tool, and draw an oval in the bottom right
portion of the page, about 1 inch from the bottom.

•

Select the ova l using the selection rectangle or t he lasso, and
dupl icate it by holding down Option-Shift while dragging. Place the
duplicate 3 or 4 inches to the left of the origina l oval, as shown in
figure 4-43.

Figure 4-43

•

Drawing and copyi ng ovals

Using the li ne tool, with the Shift key held down, con nect both
ova ls on the top and bottom, as shown in Figure 4-44.
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Figure 4-44

•

Crea ting the cyli nder

Use the eraser to e rase the inside po rtio n of the left oval. You shou ld
now h ave a cylinder lying on its side.

Now is a good tim e to save your work.
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•

Ch oose Save from t he File menu.

00 -M

•

Ch oose Zoom In from the Goodies m enu so yo u ca n d raw the
details m o re easily.

•

Position th e toolbox so it is no t in the way, a nd then select the
unfil led oval tool.

You may have to drag th e scroll box to the bo tto m of th e ve rtical scroll
bar to view the cylinder and t he space ben eath it.
•

Draw two mo re ovals above the cyli nder, o n e sligh t ly sm aller than
t h e other a nd bo th smaller than the o rigin al oval, as shown in
Figure 4-45.
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Drawing add itio n al ovals
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Select the smallest oval with the lasso, and drag it so that it is inside
the next largest oval, as shown in Figure 4-46.
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Figure 4-46

Positioning the smaller oval

·• Select both of those two ovals and place them inside the oval at the
end of the cylinder, as shown in Figure 4-47.
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Placing ovals to simulate a rolled rug

•

Using the line tool, draw a diagonal line underneath the three ovals,
as shown in Figure 4-48.

•

Duplicate that line by selecting it with the lasso and then dragging
it while holding down the Option-Shift keys. Place the duplicate
line on the other end of th cylinder, as shown in Figure 4-48.
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Figure 4-48 Drawing and d up licating lines

•

Hold ing down th e Sh ift key, draw a h orizonta l li ne to connect th e
ends of the two diagon al lines, as sh own in Figure 4-49.

~0

Figur e 4-49

rr==:.l

lLJ

•

E!ll

" Yord Sole Flyer" 111 I 00%

Connecting the lines

Select that group of three lines with th e lasso an d drag the lines up
to the cylinder to form the unrolled piece of carpet, as shown in
Figure 4-50.
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Figure 4-50

Creating the flap of the rug
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•

Save your work now before you add the pattern to the carpet.

•

To create a pattern on the carpet, use any combination of fil led or
unfi lled ovals, circles, rectangles, squares, and rounded rectangles.
If you use unfilled shapes, select the paint bucket and choose
different patterns with which to fill the shapes.

Take a good look at your roll of carpeting. If you have any lines that
don't conn ect, use FatBits (double-cl ick on the pencil tool) and clean u p
any lines that need it.

Typing Text
The last thing needed to complete your yard sale flyer is the text.
~

-L

•

Zoom out to SO% size aga in , and position the tool box in the gray
a rea.

,,.. Select the text tool, which is indi cated by the" A" in the bottom left
corn er of the toolbox.
When you move the pointer into the drawing window, notice that it is
now an !-beam.
•

Center the !-beam pointe r in the area below the top two drawings
and click to set the inse rtion point, as shown in Figure 4-51.

Figure 4-51

•

Setting the insertion poin t for text entry

Ch oose 36 point from th e Style menu. Go back to the St yle m enu
and choose Bold, and go ba k again and choose Align Middle. (See
Figure 4-52.)

If you do n ot have 36 point available, choose another large size.
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•

Align Right

Figure 4 -52

•

The selected options on the Style menu

Type Trash and Treasure, press the Return key, and then type Yard
Sale. (See figure 4-53.)

If you make an y errors while typing, press the Backspace key to delete
the character and then retype it.

Trash and Treas ur e
Yard Sal e

Figure 4-53

•

Adding text

Click in the line beneath Yard Sale, under t he "d", and then choose
24 point fro m the Style menu .

If you do no t have 24 point available, select the next smaller size from
the first size you used. You will still be typing in bold text.
•

Type th e street address, 4712 Blount Ave. N.W . Press Return, and
on the next line type (5th house on right) . See Figure 4-54.
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4712 Blount Ave. N.W
(5th house on right)

Figure 4-54

•

Adding the address and location

Finish up by typing Friday- Saturday -Sunday on one line and
April 7, 8, 9 from 9:00-5:00 on the next line. Press Return again to
make a blank line, and then type Rain or Shine!! ! on the next line.
Your screen should look like the one shown in figure 4-SS.

Trash and Treasure
Yard Sale
4712 Blount Ave. N.W
(5th house on right)

Friday - Saturday - sunday
Apri l 7, 8, 9 from 9:00- 5 :00
Rain or Shtne!ll

Figure 4-55

Completion of text entry

PRINTING YOUR DOCUMENT
Now you're done wi th the yard sale fl yer-i t's ready to print. There is
no need to zoom in again to take your drawing back to its 100% size,
because MacPaint will open ydur docume nt at 100% each time, no
matter what view it was in when you last worked with it.
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It's a good h abit to save yo ur work before printing it.
W -S

,. Save your work by choosi ng Save from the File menu.
•

Choose Print from the Fi le menu.

Your dialog box for the Print command may not look exactly like the
one sh own in Figure 4-56, since this box is for a LaserWriter. The dialog
box for an Image Writer is sim ilar, and clicking OK and accepting all the
default settings will print your document as well.

LaserUJriter "l aserUJrller"
Copies:l•l
Couer Page:

Pages:@ All 0 From:C]To:
® No 0 First Page 0 Last Page

vS.I

t::liL:J

CJ ~
~
~

Po per Source:® Po per Cassette 0 Manual Feed

Figure 4-56

LaserWriter Print dialog box

The Copies box in the Print dialog box specifies the number of copies
to print. The Pages options specify w hether to print all pages of a
multipage document or just certain pages in a multipage document.
The Cover Page option, which is only available fo r the LaserWriter and
is for use wh en more than one Macintosh prints to a single shared
printer, lets you print a page identifying you r docum ent. The Paper
Source option, also only available to the LaserWri ter, lets you specify
whether to print from the paper cassette or from th e manual feed slot.
The Cancel button is used to cancel the Print command. Clicking the
Help button will present you with information about printing your
document. The OK button accepts the settings in the dialog box and
executes the Print command.
Return

•

Click OK in the dialog box to print one copy.

W -Q

••

To exit MacPaint, choose Quit from the File menu. If you want to
continue working with the next project, just close the document to
remain in MacPaint.

Project 2: Creating a Greeting Card
In this project you'll create a greeting card that combines what you
learned in the first proj ect with MacPaint's copy and paste features.
Let your creativity be your guide. The Macintosh Journey Projects disk that
accompanies this book includes the artwork for this project. If you
desire, however, you can let these instructions be a guide line for creating
your own, individually designed greeting card.
The finished greeting card from this project is shown in Figure 4-57.
When it is folded, it wi ll open as a greetin g card does.
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recognized for your
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Cheapo Caxds Company
$17.50

Figure 4-57

We'll be proud Ft'llen
you get your diploma ...

Final output o f P o ject 2
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•

Double-click on the MacPaint 2.0 icon to open a new, untitled
drawing window. If you did not qu it MacPaint after finishing the
first project, choose New from the f ile menu to open a new, untitled
document.

Since yo u' re going to be wo rking on an 8- by 10-inch a rea, you w ill b e
folding the finished prin ted sheet to open and close as a greeting card
does-sh owing a m essage (and drawing) on the fro n t, other m essages
and drawings on the inside, and even a price a nd "created by" message
o n the back. You'll start by drawing some lines o n the page that w ill act
as boundaries for each of the four sections of the card: the front, inside
left, inside right, and back.
It's easier to get a proportional view of your entire drawing page by
viewing it at 50% size .
00 - L ,.,.

Choose Zoom Out fro m the Goodies menu.

DRAWING GUIDE LINES
•

Tear off the toolbox and p lace it in the gray area of the screen. See
Figure 4-58.

Figure 4-58

Placem ent of t he toolbox at 50°AJ size

•

Select the line tool.

•

Holdin g down the Shi ft key to constrain the line vertical ly, position
the pointer at the cente r of the top of the page (approximately)
and d raw a line to di vide the page in half vertically, as shown in
figure 4-59.
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T

Figure 4-59

Dividi ng the page vertically

Notice the vertical scroll bar at the right of your screen. The scro ll box
moves down as your line is drawn, indicating your position relative to
the entire page. When the scroll box is a ll the way at the bottom of the
scro ll bar, your vertical line is complete.
When yo u have finished drawing the line, be su re to release the mouse
button before you release the Shift key. Otherwise, if you move your
pointer to the left or to the right as you are drawing, the line will snnp
to the pointer when you release the Shift key.
You'll notice that you don't have a h o rizontal scroll bar when you' re
view ing at SO% size. This is because the width of the page is en tire ly
visible in this view.
,.

Drag the vertical scroll box to the center of the scroll bar, as sh own
in rigure 4-60.

Figure 4-60

Moving the scroll box in the scroll bar

This positions the page so that you are looking at the middle portion of
it. The very top a nd very bottom are not visible on the screen.
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•

Holding down the Shift key, place the cross-beam pointer of the line
tool in the center of the left edge of the page, a nd drag to the right
to create a horizontal line that in tersects the vertical line you just
drew (see Figure 4-61). Be sure to release the mouse button before you
release the Shift key when you are fin ished drawi ng the line.

Figure 4-61

Dividing the page into quarters

As exp lained earlier, the greeting card contains four sectio ns tha t you'll
be worki ng with. Now th at yo u have ma rked these boundaries on your
page with guide lines, it's easier to understand how you r card will be
created using the guide lines as fold li nes, as shown in Figure 4-62.

Inside
Right

Inside
Left

Back

Front

Figure 4-62

Greeting card layout-un folded
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Whatever you place on the lower right corner of the drawing, in the
rectangle that is labeled "Front" in Figure 4-63, will be displayed on the
frontof yourcard once it is folded. Anything that you place on the lower
left side of the page will be displayed on the back of the fo lded card. Take
a piece of paper and try folding it.

Figure 4-63

Folded greeting card

The two sections that will be in the center of the greeting card, those
marked "Inside Right" and "Inside Left" in Figure 4-62, will need to have
an y drawing or text turned upside down so th at when the page is fol ded
to form the ca rd, the images are positioned correctly. You'll learn how
to do this in the instructions for this project.

SAVING THE DOCUMENT
Now is a good tim e to save what you have done so far and to n am e your
document.
00 -S

•

Choose Save from the File m enu.

•

If necessary, click the Drive button until your name, or whatever
name you gave your data disk, is showing at the top of the screen,
where "Connie Barlow" is showing in Figure 4-64.

.. Type Greeting Card in the box marked Save Paint document as:,
and then click Save.
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I(g) Connie Oerlow I
!=!

D Gre<!Hng C<trd fh1
D Y<Jnl ~~~h~ l' l!J<!r

(g) Connie 011 .•.
Eject
Drlue

Seue

S11ue P11lnt document 11s:

[ Cencel
Document forme!:

0

@MIICPIIInt

0

Stationery

Startup screen

Saving the document Greeting Card

Figure 4-64

COPYING AND PASTING AN EXISTING GRAPHIC
Now that you have created the layout of the card, you'll place a graphic
on the front of the card. On the Macintosh Joumey Projects disk is a MacPaint
document entitled Greeting Card Art.
(If you are using this book in a classroom environment, check with the

instructor to ensure that this document has been made available to you.)

Opening the Document
First you'll open the document that contains the artwork.
3€ -0

•

To open an existing piece of artwork, choose Open from the File
menu.

Your screen shows a dialog box that lists the MacPaint documents
available to be opened, as shown in Figure 4-65.

I(g) Connie Oerlow I
I D Greeting Cerd
I

(g) Connie 011 •••

I

D Y11rd Sele Flyer

Q

Figure 4-65

[

Eject

[

Drlue

[

Open

1
1

[ C11ncel

The Open dialog box

•

Click the Drive button, if necessary, to view the contents of the disk
that contains Greeting Card Art.

•

Select Greeting Card Art from the list by clicking on it, and then
click the Open button. A faster way to open a document is to
double-click on its name in the list.
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Your screen sho uld now sho~ the Greeting Ca rd Art document,
a nd your greeting card should peek out from beneath it, as shown in
Figure 4-66.
•

File

Edit

Goodies

Font

St yl e

Patterns

Tools

" Gr eeting Card " a t 5 0%
~

"Gr ee ting Card Rrj" a t I 00%

Figure 4-66

,.

Greeting Card Art

Drag the toolbox by its title bar to reposition it o n the left side o fthe
screen, and use the bo tto m scroll bar to scroll so that the entire
Co ngratulations Grad box is showing, as in Figure 4-67.
•

File

Edit

Go odies

Font

St yl e

Pattern s Tool s

"Gr ee tin Card " at 5 0%
"Gree tln Cord Rrt" ot I OO%

Fgu re 4-67

EJI

Positionin g the toolbox and the scroll bar

Selecting the Artwork You Want to Copy
Congratu lations Grad will go o r the front o f the ca rd. To use it in your
greeting card, yo u'll select it and then copy it to the Cli pboard.
•

Click on the selection rectanple, and then select the Co ngratulations
Grad rectangle, as shown in Figure 4-68.
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•

File Edit

Goodies

Font

St yl e

Patterns Tools

" Greetln Card " at 5 0%

¥4

Figure 4-68

38 -C

•

"Gr eeting Card Art" at I 00%

Selecting the drawing

W ith the desi red drawing selected, choose Copy from the Edit m enu.

Activating Your Document
•
Turn Grid On
Draw From Cent er
Show Mouse Position

SE:G

il8K

Zoom I n
Zoom Ou t
Show fl< tu ol Si7e
Shortcuts...
Preferences ...
Edit Pattern .•.
Brush Sh ape .. .
Brush Mirrors .. .
S<lllf' Sele< tlon .••

The Greeting Card window moves to the topmost position.
XH

- ---------·----I

i

I

Greeting Card Art

To make yo ur greeting card the active d rawing (or active window),
ch oose Greeting Card from t he Goodies menu, or click o n an y part
of its window.

W hen ever yo u h ave more than one wi ndow open in MacPaint, you can
switch between th em by ch oosing the n ame of the document you want
from the Goodies menu. You can also just click anywhere in the
window of the documen t you wa n t active, and th at docume n t will
move to t h e topmost position and become active.

:!82

Your o riginal Greeting Ca rd should now be showing on t he screen.
•

Use the ve rt ical scro ll bar to scroll d own so the entire fron t sectio n
of the ca rd is showing, as in Figure 4-69.

Fig ure 4-69

Scrolling to view t he front section of t he card
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Pasting the Artwork into Your Document
Now yo u' ll paste th e draw ing that was co pied to the C lipboa rd in to your
MacPaint docum ent.

3€:- V

.. Choose Paste fro m the Edit m e nu.
Your screen sho u ld look like the on e shown in Fig ure 4-70.

Figure 4-70

Pasting the drawing into the d ocum ent

The drawing will appear in the cen ter of the ca rd, and it will be
selected- notice the ~' mar c hin g a nts~' aro u nd the border of the d rawi ng.

Positioning the Artwork
Now that you have copi ed and pasted t he Congratu latio ns G rad
artwork, you can put it whe re yo u want it.
•

Position th e pointer on top of the drawing a nd cl ick and drag,
placing the drawing in the to p po rtion of the area reserved for the
front of th e card (see figure 4-71) .

!
$J
!
:~i
re,

ow.,.

! ~!
t--------- - ---~·-------J

Figure 4-71

Posit ioning th e
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"•

Now is a good time to save your greeting card. Choose Save from
the File menu.

ADDING TEXT
Now that the drawing is positioned on the front of the card, you can
finish the front by typing your message on it.
00 -M

•

Since it is easier to see your typed message at 100% size, choose
Zoom In from the Goodies menu.

•

Position the toolbox in the lower left corner of the screen by clicking
on the title bar of the toolbox and dragging it.

,.,.. Drag the scroll box in the horizontal scroll bar all the way to the
right, and drag the scroll box in the vertical scroll bar all the way to
the bottom.
This will ensure that you are working in the lower right corner of the
page.

[A] . ..

..

Select the text tool.
Position the insertion point in the center of the front section of the
card, just beneath the drawing, and click to set the insertion point,
as shown in Figure 4-72.

Figure 4-72

Centering the insertion point under the drawing

,.. Choose New York from the Font menu.
,.. Choose the following options from the Style menu:
14 point
Bold
Italic
Align Middle
(Th is will take four trips to the Style menu.)
You can be sure that you have the right selections, because they will
have checkmarks next to them. See Figure 4-73. If you accidentally
select the wrong item, you can choose it again to deselect it.
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Figure 4-73

•

The settings in the Style menu

Now type the following lines on the card (press Return where
indicated):
You've achieved your goal (press Return)
and deserve to be (press Return)
recognized for your (press Return)
accomplishment. (press Return twice)
We'll be proud when (press Return)
you get your diploma ... (press Return)

Your screen should look similar to the one shown in Figure 4-74.
iO

"Greet in

~chieved

You 've
your /l(J81
anq deserve to be
recognized for your
acljomplfshment.
We 'JJ. be proud when
you J!8 your diploma ...

Figure 4-74
3€ -S

•

Text on the front of the card

Save your work by choosing Save from the File menu.
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ADDING MORE ARTWORK TO YOUR DOCUMENT
Now you have completed the front of the card. Next you'll copy and
paste the graduatio n cap art from Greeting Card Art into the "inside
right" section of th e document.
,. Choose Greeting Card Art from the Goodies menu.
,.. When you're viewing the Greeting Card Art document, move the
toolbox to the right part of the screen, and drag the bottom scroll
box to the left. You should be viewing the entire cap, as shown in
Figure 4-75.

*

File Edit Goodies

I

Figur e 4-75

•

Font Style Pa tte rns Tools
" Greeting Card" at I 00%
" Gree ting Card Rrt" a t I 00%

Positioning the art in the window

Click on the selection rectangle, and then select th e entire cap, as
shown in Figure 4-76.

*

File Edit Goodies Font Style Potte rns Tools
"Greeting Cord" ot 100%
"Gre e tin Cnrd Rrt" ot 100'7.
10
r ------ ----- - -- --- - ----- ------~

I

Figure 4-76
~ -C

•

Selecting the cap

Choose Copy from the Edit menu to copy the selection to the
Cli pboard.
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No w that you 've co pied the sec0 nd draw ing to the Clipboard, you no
longer n eed to have the Greetink Card Art document open.

:3€: - W

•

Close Greeting Card Art by clicking in its close box o r by choosing
Close from the File menu.

•

Click No in the dialog box that asks if you want to save changes to
the document before closing.

WORKING IN ANOTHER PORTION OF THE
DOCUMENT
Now you' ll positio n your greeting card so you can work in another
portio n of it.

:3€: -L

•

:3€: - V

.. Ch oose Paste from the Edit m enu.

Choose Zoom Out from the Goodies menu toviewyour cardatSO%
size. Drag the toolbox into the gray area at the right side of the
screen.

This will cause the drawing of the cap to be placed in the cente r of the
document. The drawing will automatically be selected.
•

Positio n the drawing in the center o f th e upper left section, and
t hen click elsewhere on the screen to deselect the drawing. See
Figure 4-77.

Figure 4-77

Positio ning the second piece of artwork o n the card

ROTATING THE ARTWORK

I

Since everything in the top sectio n o f the page must be upside down so
that it will be positioned prope ly when the paper is folded as a card,
you' ll rotate t he graduation cap artwork.
•

Select the graduation cap ar work with t he selectio n rectan gle.
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Any item you choose to rotate or flip h orizontally or vertically must first
be selected with the sel ection rectangle, not with the lasso.
3€ -T

•

Choose Rotate from the Edit menu.

This causes the selected drawing to be rotated 90°. Since you want the
ca p rotated 180°, you will rotate it again.
3€ -T

•

Choose Rotate from the Edit menu.

Now that the drawing has been turned upside down, your drawings
should have the same placem ent as t hose shown in Figure 4-78.
I •
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Figure 4-78
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•

The rotated cap

Save your work now by choosing Save fro m the File m enu .

ROTATING TEXT
Now you'll typ e the text in the "inside left" sectio n of the ca rd.
3€ -M

•

Choose Zoom In from the Goodies m enu to go to 100% size.

•

Position the horizontal scroll box to the fa r right in t h e scro ll bar,
and position the vertical scroll box at the top of the scroll bar, as they
are positioned in Figure 4-79.

This will ensure that you are workin g in the upper right portio n of
the page.
•

Move the toolbox to the left side of th e screen so it's out of th e way,
and then select the text too l.

•

Position the pointer in the center of th e ri gh t side of th e sc reen, as
shown in Figure 4-79, and click to set the insertion point.
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Figure 4-79 Setting th e insertion point

•

Select 18 point from the Style menu. Then go back and select Italic
to remove th e checkma rk beside it, which deselects it.

•

Type th e following, pressing Return where indicated:
It's a shame you're (press Return)
going to look so silly (press Return)
in that hat!! (press Return)

,,. Save your work.

Now you n eed to select the text so that you can rotate it, as you did the
drawing of th e ca p.
,,. Select the text with the selection rectangle, and then choose Rotate
twice in successio n from th e Edit menu.
Your scree n should now look like the one shown in Figure 4-80.
=0 - -

"Greetin Cord" at I 00%
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Figure 4 -80

•

Rotating the text

Once th e text is rotated 180° click somewhere e lse on the screen to
deselect the text.
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ADDING A PERSONALIZED MESSAGE
Now that you've placed all th e artwork a nd have typed a ll the text in the
card, you may want to put a "created by" message on the back of the card
to personalize it.
•

Drag the scro ll box to the far left in the horizontal scroll bar, and to
the bottom in the vertical scroll bar, as shown in Figure 4-81. Drag
the toolbox out of your way to the right side of the screen.

•

Select the tex t tool, and then position the pointer in the lower
portion of the left side of the screen, as shown in Figure 4-81.
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Positioning the pointer on the back of the card

Figur e 4-81

•

Choose 9 point from the Style menu.

•

Type Ch eapo Card s Company and press Return.

•

Type $17.50, or wha teveryou feel is a good price for your masterpiece
(see Figure 4-82).
"Gree tln

You've ochfeved your ~\
and deserve to
r ecOIJnfzed fa
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Figure 4-82

a

Finishing the back of the ca rd

•
"
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111

Chapter 4: MacPaint 2.0

ERASING THE GUIDE LINES
All that remains to be done n ow is to erase the gui de lines that you d rew
to partition the four sections of the card for folding.
•

Save your work.

, . Choose Zoom Out from the Goodies menu so you'll be v iewing the
card at SO% size.
•

Select the eraser tool. Whi le ho lding down the Shift key, use the
eraser to e rase the lines.

Using the Shift key with the eraser will constrain the eraser's movement
horizontally or vertically, depending on which way you move first, thus
reducing the risk of erasing other parts of the card.
If your lines are close to images or text, you may need to zoom in to

FatBits to delete the lines with more precisio n. Refer to the first project
in this chapter, if necessary, to refresh your memory about using FatBits.
•

After you've erased the lines, be sure to save you r work.

Now you're ready to print your card.

PRINTING THE DOCUMENT
•

Choose Print from the File menu.

The Print dialog box will look simila r to the on e shown in Figure 4-83.

LoserWriter "LoserWrlter"
Pages: ® Rll 0 From:

Coples:lllll
Couer Page:

5.2

(;EJ

CJ To: CJ ~

® No 0 First PBge 0 Los t Page

r.:=::::;-"1

~

Paper Source:® Poper Cossette 0 Monuol Feed

Figure 4-83

The Print dialog box

•

Click OK to accept the default settings.

·•

Using the fold Jines shown in Figure 4-62 as a guide, fold the page
to form a greeting card.

•

If any of the drawings or text are not p laced the way you'd like them
to be, select the item and repositio n it to your satisfaction. The n
reprint the page.

•

Choose Quit from the File 1enu to exit MacPaint. If you want to
stay in MacPaint and continue with th e additional projects, close
the Greeting Card document
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SUMMARY
• MacPain t provides fami liar tools for creating d rawing effects. The tools are found in the
toolbox, wh ich is a tear-off menu that can be positioned wherever you like in t he drawi ng
w indow. You select a tool by clicking on it in the toolbox. A selected tool is high ligh ted .
• Lin es are drawn using the line tool a nd the pen cil tool. The pencil too l draws a freeha nd o nepixel-wide line, and t he line tool d raws a straight line.
• Shapes are draw n using the oval tool, the rectangle tool, the rounded recta ngle tool, the
freeh and tool, and the polygon tool. Shapes can be draw n eith er unfilled or fi lled wi th the
currently selected pattern.
• The Shift key constrains the movem ent of m any of the tools. It is used to draw perfect sq ua res,
perfect circles, and straight lines. It also con strains the movement of the eraser to horizontal
o r vertical move me nts.
• The eraser is used to erase all or part of an ob ject from the drawing window. Double-clicking
the eraser tool erases the entire contents of th e dra wing w in dow.
• You select a pattern by clicking on a pattern in the Patterns menu, which is a lso a tear-off
menu that ca n be position ed anywhere on the screen.
• Painting is do ne with the spray can tool and the paint brush tool. The spray ca n too l paints
a "mist", and the paint brush tool pa ints in th e sh ape of any of th e many available brush
shapes. Both of t h ese tool s paint in the currently selected pat tern .
• The bo rder palette is used to ch ange the vertical and horizontal weights of lines draw n with
the lin e too l or in the border of a shape.
• Text ca n be draw n e ith er with t he pencil tool or with the pain t brush tool o r typed using the
text tool. The optio ns in t he Style m enu and Font menu apply to the te.xt typed with the text
tool.
• Ob jects are selected using the selection rectangle or the lasso. The difference between the
selection recta ngle and the lasso is tha t the selectio n rectangle a lso selects the area inside the
rectangle, including th e white space surrounding an object, w hereas the lasso sh rin ks to t he
exact size of t he ob ject and selects on ly the object. An item must be selected before yo u can
issue a command that w ill affect it-to copy o r move it, fo r exam ple .
• The pa int bucket tool is used to fill an o bject with the curren tly selected pattern fro m the
Patte rns m enu.
• O nce an ob ject is draw n, you can mod ify it in several ways. For example, yo u ca n fl ip a n object
vertically o r h o rizontally, ro tate it, duplicate it, or delete it.
• Th e Zoom In comma nd a llows yo u to wo rk in a m agni fied v iew of your drawing, wh ic h takes
you in 200% incremen ts u p to 800% view. The details of the drawing can be modi fied with
more precisio n in soo<J-·6 view, because you can erase o r add on e pixe l at a time.
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KEY TERMS
active window
actual size window
align
anchor
border palette
brush shapes
Clipboard
constrain
copy
cross-beam pointer
currently selected pattern
deselect
duplicate
eraser tool
FatBits
filled
flip
font
freehand tools
grabber tool
guide lines
highlighted
hot spot
I-beam pointer
insertion point
lasso selection tool
leaks
line tool
line weight

magnify
marching ants
menu bar
paint bucket tool
paint brush tool
paste
Patterns menu
pencil tool
pixel
points, point size
polygon tools
Revert To Saved command
rotate
rounded rectangles
scroll bar
scroll box
select
selection marquee
selection rectangle
snap
spray can tool
tear-off menu
text tool
title bar
toolbox
Undo command
unfilled
Zoom In command
Zoom Out command
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MACPAINT COMMAND KEYS AND SHORTCUTS
File Menu
New
Open
Close
Save
Quit

3€-N
3€-0
3€ -W
3€ -S
3€-Q

Edit Menu
Undo
Cut
Copy
Paste
Ro tate

3€-Z
3€ - X
3€ -C
3€ - V
3€ -T

Goodies Menu
Zoom In
Zoom Out
Shortcuts

3€-M
3€ -L
3€-H

Style Menu
Bold
Italics
Underline

3€ - B
3€ -I
3€-U

Shortcuts Window

IAI

a

loptionl Scroll document, except in
13€ I [~J Shrin k marq uee to fit; stretch selection
13€ a I[lor ~ Change font size
13€ I Patterned lines and borders
13€ lls hift I[l or ~ Change font
Se1ect wi ndow
loption ll3€ a I[] or ~ Change line spacing
Se1ect contents of wi ndow
loption ll3€ a I Multiple copies; optional paint mode
Choose brush shape
Is hift lloptionll3€ IMultiple, pattern-aligned copies
Toggl e 100% and 800% zoom
13€ I
Zoo m in
Double
13€ a llshift I
Zoom out
Erase window or document
Cl ick
l"i':'h'' Use special pattern effects while
Toggle " Draw from Center"
L.:.:::......J dragging a selection

a

a

a tJ

a

tJ

~OOODDDDDDDOO~

:---; Select document
p Select contents of document

IT!DDDDDDDDDDDDDD
CJDDDDDDDDDDDCJ

rc.:iU'l•--'

~~~------------~

Ishift 113€ a I [~J Select conte nts of doc

lconatrainiOOOOOOO~~Oc:J

~

13€

a I [~J Select co ntents of window

Multiple Copies

Additional Projects
The followi n g projects are accompanied by briefer instructions than
those you h ave previously completed in this chapter. They require that
you apply what you learned in the first two projects. If necessary, refe r
to "Using MacPai nt's Tools" at the beginning of this ch apter for
information and instructions about using any tools th at you aren't
familiar with. Experi ment with the sho rtcuts available from the
Goodies menu .
You will not be reminded to save your work-you should be developing
good saving habits of your own by now.
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Project 3: Drawing Perspective
Everybody dreams of having a lot of money, and this project gives you
that chance. You'll use the polygon tool to draw the bills and the oval
tool to draw the coins to achieve a look of perspective in the drawing.
The finished project is shown in Figure 4-84.

Figure 4-84

•

Final output for Project 3

Use the polygon tool to draw the shape of the bill in the lower left
part of the screen, as shown in Figure 4-85.

I

"Project 3" ot 100%
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Figure 4-85
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•

IR

The bill drawn wir the polygon tool

Select the polygon with the lselection rectangle, and then choose
Trace Edges from the Edit menu.
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The Trace Edges command traces the edges of the selected object, as
sh own in Figure 4-86. When you use this command, the object must be
selected with the selection rectangle, not the lasso.
"Pro ee l 3" at I OO't

+ I I IID II
·-·~ ~
........ 0
~ I'll 0
~\:::)

•••
•

It olll•
··'

Figure 4-86

•

'

The bill with the edges traced

Erase the top and right outline of the bill, so the bill looks "thick."

Zoom in to clean up the corners of the bill using the following shortcut
to zero in on a particular area.

[fJ •

Select the pencil tool, and then hold down the Command key.

The pointer turns into a small magnifying glass when you move it into
the drawing area.
•

Click on the area you want to edit in a magnified view.

The view is magnified in 200% incremen ts each time you click the
screen with the magnifying glass. See Figure 4-87.
10

Figure 4-87

"Pro e el 3" at 2 00 ~

Zooming in to the selected area
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•

To crea te the border on th e face of t he bill, select a heavier line
weight from the border pale te, a nd select a gray pattern.

•

Select the polygon tool.

•

Ho ld dow n the Command key while drawing the border on the top
of the bill to get a patterned lin e.

Holding down the Command key while drawi ng a line o r sha pe draws
the border in the curre ntl y selected pattern.
•

Use the oval tool to draw the ovals and any oth er design you want
on the top of the bi ll.

Next yo u' ll c reate the "stack" of bills.
•

Select the bill w ith the lasso.

•

Ho ld down the Option and Command keys, and drag the bil l toward
the menu bar at the to p of the screen. See Figure 4-88.

The Option-Command keys allow you to make multip le copies of the
selected object. If you don ' t li ke the effect you get with your first try, use
the Undo command and try agai n un til the stack is to your liking.
"Pro ee l

Figure 4-88

~"

ot 100%

The stack of bills

•

To draw the coin s, d raw an oval w ith the oval tool and th en
duplicate it.

•

Zoom in to work in grea ter d etail on the rest of the coin.

•

Place on e oval on top of the other. Erase where they overlap, as
sh own in Figure 4-89.
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Figure 4-89

Erasing the overlapping ovals

•

Connect the two ova ls with a vertical line on each side to form a
coin .

•

Close up a ll the gaps in the borde rs of the ova ls.

•

Fill the edge of the coin (the space between the two ovals) with the
paint bucket usin g the vertical line patte rn in the Patterns menu, as
shown in f-i gure 4-90.
i

"Project 3" a t 200%
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Figure 4-90
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Fillin g the edge of the coin with the paint bucket

Choose Draw from Center from the Goodies m enu.

You' ll use this option to draw the ova l o n the face of the coin . The Draw
Fro m Cen ter command allows you to d raw shapes from the center
instead of from the edge. This usually makes drawing shapes in a
pa rticu lar loca tion easier. When Draw From Center is in effect, you'll
see smal l crosses in the center of some of the tools in the toolbox. To
turn off Draw From Ce n te r, choose Draw From Edge from the Goodies
menu.
•

Select the ova l tool, and then positio n the cross-bea m pointer in
the center of the face of th e coin .
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•

Drag to create an oval slighJly smaller than the face of the coin.

•

Use the penci l tool in FatBits to draw a face or other design o n the
coin.

•

Select the coin with the lasso a nd, using the Option key, duplicate
the coi n to form several stacks of coins.

·•

Position the coin stacks around the stack of bills.

Project 4: Creating a Logo
In thi s proj ect you' ll put together a few simple shapes-a polygon, two
circles, and some li nes- to create a logo. You'll a lso create some special
effects with the eraser tool and with the In vert command. The finished
project is shown in Figure 4-91.

Figure 4 -91

Final output for Pro ject 4

•

Select the li ne tool, and th en select th e third line weight on the
border palette.

•

Ho ld down the Shift key to constrain the line to a 45° angle and draw
six lin es each about 2 inches long.

If you rest the bottom of the cross-beam pointer on one line as you draw
1
the next one it h elps you keep n equal distance between each line.
,,. Select the group of lines with the selectio n rectangle, and use the
Option key to du plicate th e111 , as shown in Figure 4-92.
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i!J- - - - -

Figure 4-92

" Pro ·e el 4" at I 00%

Du plicating the group of li nes

.. Whi le the duplicate lines are stil l selected, choose Flip Horizontal
from the Edit menu.
Now you'll duplicate these flipped lines to fo rm the background of th e
arrow.
•

Select the top part of the duplicated li nes with the lasso. Using the
Option key, place a duplicate of tha t portion on either side o f the
group of lines, as shown in Figure 4-93 .

mJ

Figure 4-93

"Pro e el 4" at 100%

Dup licating the lines for th e arrow background

.. Zoom in to 200% size, and then use t he polygon tool to draw the
a rrow, as shown in Figure 4-94.
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Figure 4-94

Creating the arrow with the polygon tool

•

Zoom in to 400% or larger, and use the eraser and the pencil to erase
all the lines that extend beyond the outline of the arrow.

•

Zoom out to 100% size and select the eraser tool. Hold down the
Shift key to constrain the eraser's movement, and erase the top of
the left group of lines, as shown in Figure 4-95.

'
Figure 4-95

•

Erasing the lines horizontally

Hold down the Shift key to erase first vertically and then horizontally
so the bottom of the left group of lines forms a point, as shown in
Figure 4-96.
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" Project 4" 81 1 DO%

'
Figure 4-96
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Erasing to form a point

•

Select on e group of lines and move them away from the other so
you'll have room to work. Scroll the screen so you're not working
on top of the lines.

•

Use the oval tool with the Shift key to create a circle about 1 3/4
inches wide.

•

Select that circle with the lasso and place it on top of the group of
lines that forms the arrow, as shown in Figure 4-97.

~0

Figure 4-97

"Pro eel 4 " 81 1DO%

Positioning the circle on the arrow

... Select Draw From Center from the Goodies menu, and then draw
another slightly smaller circle inside the first one.

lnl
L!:J

.. Select the left group of lines with the lasso, and place them on the
circles, as shown in Figure 4-98.
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Figure 4-98

IRl
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Positioning the lines on the circles

, . Zoom in to FatBits and use the pencil tool to e rase the parts of the
circles that show through the lines.
.. Zoom out to 100% size.
Now you'll type the text for the logo.

u
I
..J

•

Select the text tool and set the inserti on point away from the rest of
the drawing.

•

Type Stanford Recycling Center in a bold, 18 po int fo nt of your
cho ice (the example uses Helvetica) .

•

Select the text with the selection rectangle. Select only a small
amount of the background with the text, as shown in Figure 4-99 .

r----------------- ~ -------- - ---

: Stanford Recycling Center:
L-----------------------------~

Figure 4-99

Selecting the background with the text

, . Choose Inve rt from the Edit me nu.
The Invert command changes bl ack dots to white and white dots to
black in a selected area.
•

Positio n the text on the logo. Refer to th e finished logo shown in
Figure 4-91 at the beginnin&of thi s p ro ject.
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Chapter 5: MacDraw II
What You Will Learn in This Chapter
After reading this chapter, you should be able to:
•

Draw lines and rectangles

•

Resize rectangles, lines, and tex t

•

Use the Sh ift key to constrai n lines horizontally and vertically

•

Draw objects fill ed with a selected pattern

•

Change line weights from the Pen menu

•

Add text to a drawing using the text tool

•

Change the style and font of text

•

Reposition objects and text

•

Group objects to form a composite object

•

Save and print documents

•

Select and move multiple objects at o ne t ime

•

Change th e fi ll pattern of selected o b jects

•

Change the line pattern of selected lines

•

Fill t he text background with a pattern

•

Move ob jects in their stacking o rder

•

Use Autogrid fo r precise alignment of objects

•

Align objects to one another

•

Use the zoom controls to v iew a large r portion of the drawing

M

acPaint wo rks like using a pen, pencil, or brush on paper to
create your drawin g. If you wan t to m odify an object in
MacPaint, you "erase" by changing a black dot to w hite. If you
move o r d raw a shape o n top of an othe r in a bitmapped drawing
program such as MacPaint, the shape beneath is re moved beca use the
dots are c ha nged to represent t he one that was d rawn or moved o n top.
No record of the o ne beneath remains, just as if you had e rased it fro m
the pape r.

MacDraw II wo rks mo re like cutting ob jects o ut of constructio n paper
and then arranging th em to fo rm a pictu re. If you draw or place an
ob ject on top o f ano ther in an ob ject-o rie nted drawing program such as
Mac Draw II, the item beneath sti ll rem ains. Yo u ca n move aside the o ne
o n top and the shape undern eath is un changed, just as it would be with
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shapes cut ou t of construction paper, because object-oriented drawing
programs store a definition of each object's location, shape, size, and
depth level.
MacDraw II's drawing surface can be 69 square feet, compared with
MacPaint's 80 square inches. MacDraw II's grid and ruler allow you to
precisely place objects o n the drawing page. A less soph isti ca ted grid is
avail able in MacPaint, but a ruler is not. In MacDraw Il yo u can edit text
in more o f a word p rocessi ng fashion, where you can select tex t and then
type over it to mod ify it, and you can control the placement o f the
insertion point. MacPaint's text editing is very limited-you can either
correct errors by backspaci ng w hile typing or erase the text and retype.
Since the printed output of MacDraw II and most object-orien ted
programs is superior to that of paint programs, MacDraw II is popular
among draftspersons as well as artists. Although MacDraw II is a
powerful drawing program w ith many features that exceed the scope of
this book, you'll use many of the tools of this object-oriented d rawing
program to create some introductory and intermediate level drawings.
MacDraw II is best for jobs that involve a lot of text and text editing, o r
ones that require precise placement and alignment of o bjects, o r ones
that require smooth, high-quality output. Freeh and drawing and quick
illustrations are easier in Mac Paint. In working through these projects,
you'll see some of the d ifferences, advan tages, and d isadva ntages of
working with a bitmapped graphics program vs. an object-oriented
graphics program.

STARTING MACDRAW II
•

Double-click o n the MacDraw II icon to o pen a new, untitled
d rawing window.

Every n ew documen t h as the title "Untitled-Layer#l" until yo u save it
for the first time a nd give it a n am e.
The draw ing window shows o n ly a part of the available drawing a rea,
which is preset to a single page for a n ew document. The drawings you'll
be creating in the projects in this chapter will fit on one page, al tho ugh
a MacDraw II drawing can be as large as 69 square feet.
A menu bnr runs across the top of the screen:
'

li File Edit Layout Arrange Pen Font Size Style

You' ll learn about many of the options on the menus as you work
through the projects.
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GETTING HELP
Many applications provide o nline help fo r q uick re ference when you are
using different tools a nd commands. U nfortunately, MacDraw II is not
one of these programs. The reference manua l that you get when you
purchase MacDraw II is very comprehensive, however, and includes a
tutorial as well as detailed descriptions of the features of each tool and
command.

SAVING YOUR WORK
The first time you save your document, Mac Draw ll asks you, by way of
the dialog box shown in Figure S-1 , where you want your document
saved and wh at you want it to be named. After you h ave saved a
document the first time, the next time you choose Save, MacDraw II
assumes that you want the document to be saved in the same place and
under the sam e name. Be carefu l about saving your document in the
correct place the first time you save it so yo u can find it later. The save
process is much quicker the second and subsequent times, because you
a re not prompted for any additional informa tion.
Unfortunately, sometimes people are not ca reful, a nd they occasionally
lose their work because they save it but do not think about w here they
a re saving it and then can't find it again. Clicking the Drive button (see
Figure 5-1 ) toggles between on e or m ore floppy d rives and hard drives,
depe nding on t he hardware you are us ing. The Save dialog box shows
the n ame of the floppy disk or hard drive as that drive is selected . You
are saving you r document on the selected disk o r hard drive with th e
name showing in the Save dialog box. In the dialog box shown in Figure
5-l , the n ame of the disk, Pamela Gurnari, is shown in two places.
Always be aware of where you are saving yo ur work.
The Save As command is similar to the Save command, except that it
enables you to give yo ur document a diffe rent name and save it in a
different loca tion. Every time you choose Save As from the File me nu,
you are prompted with the dialog box shown in Figure 5-1. This is the
same dialog box you see the first time you save your documen t.
Wh en you use th e Save As command and you attempt to save the
document with the same name and in the same location as before, you
will b e asked if you want to replace th e o ld documen t. This is because
no two files in a particular locatio n can have the same name. If you wa nt
to save different versions of the same document, use the Save As
com mand and give the document a differen t name and/or location.
Saveyour work often-at least every ten mi n utes, so you never lose more
than ten minutes of work. The Command-key eq uivalent of the Save
comman d, Command-S, is a helpful sh ortcut. Practice it often, and it
will become auto m atic. Always save your work before printing.
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I(g) Pamela Gumartl
p,! (g) Pamela Gu . .
Eject
Orlue

Sou e

Saue drawing as:

[ Concel

® Drowlng 0

Figure 5-1

Stotlonery

0

PICT

The Save dialog box

Be aware th at you can save a document before you actua lly type
anything into it, and th at ma ny people do it this way. However, you will
be given instructio ns fo r saving yo ur work at appro pria te times
through o ut the projects in this ch apter.

USING MACDRAW'S TOOLS
The tools palette sh ows the drawing tools that you can use to create
graphics. The nine icons in th e tools palette represent the types of
objects that the tools create.
The po inter changes to a cross-beam when it moves into the drawing
window, which is the grid yo u see on the screen. The cross-beam and th e
gridlines make it easier to positio n objects.

sele~t

To draw a n obj ect, yo u first
a tool by clicking on it. After you've
drawn an object, black squares called handles appear around the obj ect.
The selection arrow (at the top o f the tools palette) becomes automatically
active, and the tool you d rew with is n o lon ger active. You can
m anipulate th e object with the selection arrow.
A tool becom es highlighted in gray when you select it by clicking on ce
on it. It becom es highlighted in black wh en you click twice o n it. When
it is highlighted in black, it remains the selected tool after you complete
an action with it, rath er th an a uto mati cally defa ulting to the selectio n
arrow.
Now you' ll get som e practice with each of these tools before beginning
Project 1.

Text Tool
The text too/ is used for typing te it. Not only does text typed in Mac Draw
11 print in a very high qua lity, it is also easy to cha nge parts of words o r
sentences.
•

Select the text tool by double-clicking on it.

Double-clicking on the text tool will keep it active until you select
another tool.
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Click in the center of the screen to set the insertion point for where
the text will begin, and then type Using the text tool.
-

Clickanddragthrough the word the in the line you just typed. (You
can also double-click on a word to select it.)

The selected word becomes highlighted, as shown in figu re S-2.

::

. ;--·····-···--·--···-'··--·····--······-···-··-, .

: ! Using Ill text tool !:
. ...........................-..-···········-···-·············:.

Figure 5-2

•

Selecting a word with the text tool

Type MacDraw II's to replace the word "the" that you highlighted.

Your sentence now reads "Using MacDraw Il's text tool".
You can reposition text on the screen without having to retype it. You
use the selection arrow for this.
•

Click on the selection arrow to select it, a nd then click anywhere on
the text you just typed.

Notice that small black squares, called handles, appea r around the block
of text. The presence of these handles indicates that the object is
selected.
•

Click on th e text with the selectio n arrow, but don't cli ck on one of
the handles.

•

Drag the text to a nother part of the screen, and then release the
mouse button.

Your text should be positioned in another part of the screen.
To delete an object, you select it by clicking on it, and then you press the
Backspace key (Delete key o n some keyboards).
•

Select the text (if it is not already selected), and the n press the
Backspace key.
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Line Tool
The line tool is used to draw straight
lines. The width of the line is
I
controlled by the Pen menu. Yjo u' ll learn more about the Pen menu
later, in Project 1.
.,..

Select the line toot and then draw a line about 2 inches long.

When you release the mouse button, the line is selected, as shown by the
handles on either end.
Now you'll lengthen the line ydu just drew .
.,.

Click on the line's right handle with the selection arrow and drag
about '/z inch to the right, and then release the mouse button, as
shown in Figure S-3.

Figure 5-3

Resizing the line

Your line should now be

length~ened by

' f, inch.

You can shorten a line in the same manner.
,,..

Practice drawing and resizing some lin es now, and wh en you are
ready to go on to the n ext tobl, select the lines and then delete them
using the Backspace key.

Rectangle and Rounded Rectangle Tools
j
rr==il 1 0 1 The rectangle and rounded rectangle tools allow you to draw rectangles
~
and squa res, filled with a patternlthat you select. Any Mac Draw II object
that you create can have its size changed, its border chan ged, and its fill
pattern changed. You'll experi~ent with t he rectangle border later in
this chapter. To resize an object) you drag the handles on its boundary.
When the m ouse button is rele~sed, the ob ject takes on its new size.
,..

Select one of the patterns i the pattern palette at the to p of the
drawing window, and then elect the recta ngle tool.
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It doesn ' t matter wh ether you se lect the pa ttern o r the tool first. To
select a pa ttern from the pattern palette, just cl ick on the pattern. You'll
learn more abou t t he pattern pa lette in a few minutes.
•

Click and drag in a di agon al ma nner from upper left to bottom right,
a nd re lease the mo use butto n when you have a recta ngle.

W hen you release t he mo use button, the recta ngle is selected. Your
screen sh ows t h e rectangle filled with t he pattern you chose before you
drew th e recta n gle. You can also cha nge the pattern o f an ob ject after
you d raw it.
•

W hi le the recta ngle you just drew is sti ll selected, click on the white
pattern in the pattern pa lette.

Th is causes the pattern in t he rectangle to change to wh ite.
To ch a nge the size of an object, click on one of t he ha ndles. Drag towa rd
the object to make it smaller, and drag away from it to make it la rger.
•

C lick o n one of th e handles of the selected rectangle, and drag
toward th e rectangle to m ake it sma ller, as shown in figure S-4.

. :.. . •llH
,

·

·

:

i

t:_:··-·-:----\

Figure 5-4
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Resizing the rectangle

If you want to m ove an object to reposition it, don't place the poi nter
on one o f th e han dles-p lace it o n anot he r pa rt of the object a nd drag
to t he new posit io n .
•

Drag to reposition the rectangle on another part of the screen (do
not d rag by one of the ha nd les).

•

De lete the rectangle by pressing the Backspace key whe n the
recta ngle is selected.

To draw a perfect square, hold down the Shift key w hen d rawing with
either t he recta ngle or rou nded rectangle.
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Corner/Center Control
~

~

In ma n y cases, you will need to control t h e placement of the center
po int o f the o bj ect you are drawing. MacDraw lets you control it using
the comer/center control, which appears below the tool palette. The
rectangles and lines you just d rew were drawn from the corner.
•

~

L:iJ

Click once on the corner/center control.

The control changes to represent an object drawn from the center.
•

Select the rou nded recta ngle tool.

•

Positio n the pointer in the center of the screen. Ho ld down the Shift
key while dragging to create a rounded square that is drawn from the
center.

If you click once on the corner/center control, it becomes center/corner;
if yo u click it again, it goes back to corner/center.
Practice drawing some other rectangles and squares, from the center and
from the corner. Practice resizing the rectangles you draw by dragging
one o f the handles. Delete the ob jects w hen you are ready to go on to
the next tool.

Oval Tool
The ova l tool is used to draw ovals and circles filled with a pattern of yo ur
ch oice. Like the rectangles, you can change the border thickn ess a nd
patte rn of the oval either befo re you draw it or after, and you can resize
the oval or circle by d ragging one if its handles. The corner/center
control is also usefu l with the oval tool.
To crea te a perfect circl e, h old down the Shift key when you draw with
the ova l tool.
~

L:iJ

• Check to see that the corner/center control is set to draw from th e
center.
•

Double-click o n th e oval too l to select it if you want to d raw more
than on e object.

The ova l tool is high lighted in black to show that it will be selected until
you ch oose another tool.
•

Position the pointer in the center of the screen, ho ld down the Shift
key, and click and d rag to draw a circle about 2 inches across.

•

Position the pointer at the same center point that you just used to
c rea te the fi rst circle, and use the Shift key again to draw a circle
about 1 inch across.
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You sh ould h ave one circle centered inside of the other circle, as sh own
in Figure 5-S.

Figure S-5

O ne circle centered inside of the other

Practice drawing additio n al circles and ovals using the corner/center
contro l and differen t patterns. Delete the ob jects from your screen
before going o n to th e next tool.
• Set the corner/center control back to "draw fro m corner" before
going on .

Arc Tool
The arc tool is used to draw part of a circle or part o f an ellipse. When it
is used in con junctio n with the Shift key, the result is a q uarter o f a circle.
You can cha nge the thickness of the border of the arc before you draw
it, but you fill it with a pattern after it is drawn. Whe n a n arc is filled
with a pattern, it takes o n a pie-shaped appearan ce.
•

Click on the arc tool to select it.

•

Click an d drag to create a n arc.

Th e d irectio n in which you move the mouse while drawing the arc
determin es th e shape of th e arc. Figure 5-6 shows several arcs and the
direction the mouse was moved wh en they were drawn.
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Arc shapes created by different mouse directions

Click on a pattern in the pattern palette to fill th e arc with tha t
pattern.

Practice drawing some arcs by dragging in di ffe re nt d irections to see
how the directio n affects the shape of the arc. Use the Sh ift key to create
quarter-circles. Clear the screen before goin g on to the next tool.

Freehand Drawing Tool
The freehand tool allows you to draw a n irregular o r curved freehand
shape similar to that created with a penci l. Freehand sha pes do not fill
w ith a pattern as you draw them, but yo u ca n select a freehand sh ape
and fill it with a pattern afte r it is drawn. You can also change the border
thickness and border pattern. As with the other shapes you've learn ed
about, you can resize an object drawn with the freehand tool by
dragging one of its handles.
After you draw a freehand ob ject, MacDraw II a utomati call y srnooths the
shape to get rid of any jagged lin es.
••

Click on the freehand tool to select it, an d then position the pointer
in the drawing window.

•

W ith the mouse button h'td down, cl ick and drag to create the
shape of a fish or your favorite ani ma l. Do not release the mouse
butto n until the shape is com p leted.

When you release the mo use butto n, the s hape is smoothed, and
handles appear that enclose the sh ape in a rectangular border.
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• W h ile the shape is sti ll selected, cl ick to select a pattern from the
pattern pal let.
The shape you d rew sho u ld be selected and filled with a pattern , as
shown in Figu re S-7.

· ··········-. ···:·········
.
.

.

Figure S-7
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The freeha nd shape selected and filled with a pattern

Smoothing and Unsmoothing
If yo u d o n' t wan t th e ob ject you drew with the freeh and tool to be
smoo th ed, you ca n use t he Unsm ootll command from the Edit m enu to
te ll MacDraw to leave the object in angular form.
3C -S hi ft -E

•

Select the a n imal you drew if it is not still selected, a nd choose
Unsmoo th from the Edit m enu.

ow the shape appears as it would if it had n ot been smoothed after you
d rew it. To smoo th the drawing again, ch oose Smooth from the Edi t
me nu.

Reshaping
You ca n also use th e Reshape command t o change the shape of a n o bject
d rawn with the freehand tool. When yo u choose this command from
t he Ed it menu, h and les are placed along the length o f the border of the
ob ject, and you can drag those handles to change the o bject's sh ape.
W hen a freehand object has been unsmoo thed, you ca n also add extra
h andles by clic king o n th e o utline of the shape.
3C- R

•

Select the shape you drew if it is no t a lready selected, a nd ch oose
Reshape fro m the Edit menu.
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The pointer cha nges to a small quare wi th a cross-beam in it.
•

Cli ck and drag one of the h andles on the border of the shape, and
then release the mouse button .

Figure 5-8 shows the fish with its head reshaped.
Untltled-Layer/1 1

Figure S-8

Reshaping the fish's head

,,. Continue to reshape your drawing, and then click on another part
of the screen to stop reshaping. If your drawing is still unsmoothed,
ch oose Smooth from the Ed it menu.
When you are finished perfecti ng your drawing, clear your screen before
going on to the next tool.

Polygon Tool
The polygon tool is used to d raw shapes that are composed of straight
lines and angles. After the polygon is drawn, you can fill it with
a pattern. You can also modify a polygon 's border thickness and border
pattern.
This tool is si milar to the freeha nd tool, since you can use the Smooth,
Unsmooth, and Reshape commands with polygons as well. When
you draw a polygon, it is not automatically smoothed as a freehand
shape is.
•

Select t he polygon tool, an d then click once in the center of the
screen to set the starting point of the polygon.
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You do n ot drag while using the polygon tool; you just click to direct the
line between the two points it is connecting.
•

Now click a n inch o r so to the right of the starting point. A line will
fo llow th e poin ter o n th e screen.

•

C lick to create several mo re points and lines, and then double-cli ck
to finish drawing the sha pe.

Figure S-9 sh ows a shape draw n wit h the polygon tool.

Figure S-9

3€ - E

•

A shape drawn with the polygon tool

Ch oose Smooth from the Edit men u.

Figure 5-10 shows the same sh ape afte r it h as been sm oothed.
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A smoothed shape draw n with the polygon tool
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Practice using the polygon tool.! Use the Reshape command from the
Edit menu to modify the shape.
•

Do not clear the screen, because you'll use the shapes to practice
with the selection arrow.

Selection Arrow
The selection arrow is automatically active when you open a new
untitled drawing window. You've already used it for selecting and
resizing objects and text.
There are several ways to select an object (any shape you create in
MacDraw is considered an object, including text). One way that you've
already used is to click on the object with the selection arrow.
Another way to select with the selection arrow is to click and drag the
selection arrow around an object, which draws a dotted rectangle
around the object. The object must be completely enclosed by the
rectangle for it to be selected. This method is especially helpful when
you select multiple objects. You click and drag around a group of
objects, and all that are completely enclosed by the dotted rectangle
become selected and can be manipulated together. You can tell that the
objects are selected because their handles will show.
"•

If you do not have more than one object on your screen, draw a few
now.

",.. Click at the top left of the group of drawings and drag diagonally to
the bottom right, so that all the drawings are enclosed by a dotted
rectangle. See Figure 5-11.
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Dragging

multiple objects
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When you release the mouse button all objects that were completely
enclosed by the dotted rectangle are selected, as shown in Figure 5-12.
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All objects selected

Click somewhere on the screen to deselect the objects, but don't
delete them yet. Yo u' ll use them in a minute.

Layer Controls
The layer controls appear at the bottom of the tools palette, and they
enable you to move between the layers in a MacDraw document. Working
with layers in MacDraw II is similar to working with transparent film.
You can create many layers in a document and work with each as a
separate drawing or view them all at once in a specific stacking order.
Due to the introductory nature of this book, we have not included any
projects that use MacDraw's layers. All MacDraw documents consist of
one layer-Layer #1-unless you specify otherwise. The layer controls
are not functional unless there is mo re than on e layer in a document.

Zoom Controls
100
......

The zoom controls in the lower left corner of the screen allow you to
enlarge a drawing to see details or reduce it so you can see more of it on
the screen. The zoom controls look like mountains.
To enlarge your view, click the right zoom control. You can keep
clicking on the right zoom control to magnify up to 3200% in
predetermined increme nts. The zoom percentage box just above the zoom
controls shows at what percent you are currently viewing the document.
The right zoom con trol dims when the drawing has reached its maximum
viewing size . The left zoom control works the same way for red ucing the
viewing size, enabling you to reduce the drawing to 3. 12% in
predetermined increments. To bring the drawing back to its original
size, click the zoom percentage box. You can edit your drawing at any
zoom level.
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•

Click the right zoom control to enlarge the view of yo ur document
to 200(Yo.

Notice that the zoom percentage box now reads "200".
•

Use the zoom controls to experiment with reducing and magnifying
the view of your document. When you are finished, click on t he
zoom percentage box to return the view to 100%.

Pattern Palette

The pattem palette, at the top of the screen, allows you to fill an existing
object with a pattern and to fi ll an object as you draw it.
To fill an existing object, click on the object to select it. Handles appear
to show that the object is selected. Select the desired pattern from the
palette. You can change the pattern whenever the object is selected.
To create a new filled object, select a drawing tool, select a pattern from
the palette, and then d raw t he object.
r-r;.t:;l
L___L::d

The fill pattern box, at the far left of the palette and to the left of the arrow,
reflects the currently selected fill pattern. MacDraw's preset fill pattern
is white. An ob ject filled with white blocks the view of ob jects behind
it. You can use t he left and right scroll arrows on the pattern palette to
view other patterns.
The line pattern box is at the far right of the pattern palette and to the
right of the arrow, and it reflects th e currently selected line pattern. To
draw a patterned line, you click the line pattern box and choose a
pattern before you draw. MacDraw's default line pattern is black. To
change the li ne pattern of an existing line, t he line must be selected fi rst.
Th en you click t he line pattern box and select the pattern you wan t
to use.
,.

Select o n e of the ob jects in your drawing, and then select a pattern
in the pattern palette to change the fill pattern.

, . With that same ob ject still sJlected, click on the line pattern box at
the far right of the pattern palette, and then select the sam e pattern
that you used as a fill pattern.
The ob ject should now have the same line and fill patterns.
Experiment with different line and fill patterns, and then delete all the
objects on t he screen.
•

Before continuing with the rest of the project, cha nge the line
pattern to black and the fill pattern to wh ite.
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AUTOGRID ON/OFF
The Autogrid feature of MacDraw II controls where you draw objects in
a document and what size the ob jects can be.
When you first o pen an untitled MacDraw II drawing window, Autogrid
is automatically turned o n. This mean s that whe n you draw an object,
it will snap to the grid inc rements on the screen.
Using Autogrid en sures tha t your objects are placed on the drawing's
grid and m akes it easier to align ob jects. When you move objects, they
will always align to the divisions of the grid. You cannot place or draw
objects between these grid divisions as long as Autogrid is on.
To have MacDraw II ignore th e grid, choose Turn Autogrid Off fro m the
Layout menu. This allows you to place and draw objects anywhere on
the screen. Placement o f objects can be more precise when you work
with Autogrid off.
There will be times w hen it will be easier to draw and place objects with
Autogrid on a nd times when you 'll want to turn off the Autogrid feature.
The screen loo ks the sam e w hether Autogrid is on or off. The presence
of the gridlines in an untitled drawing window is controlled by a
different command .

HIDE/SHOW GRIDLINES
When you first open an untitled drawing window, the gridlines
automatically sh ow. The grid lines are composed of dots that represent
where Autogrid will constrain your objects, and they can be used as
guides to h elp you place objects accurately. Gridlines do n ot appear
when the document is printed .
To hide the gridlines, choose Hide Gridlines from the Layout men u.
Hide Gridlines is not availabl e on the m enu unless gridlines are showing
on the screen .

HIDE/SHOW RULERS
When you first open an untitled docu ment, the rulers are n ot turn ed on.
If you want to use them, yo u h ave to turn them on.

•

Choose Show Rulers from the Layout menu.
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A ruler now runs along the top a , d left sides of the drawing window, as
shown in Figure 5-13.

Figure 5-13

The MacDraw window with rulers showing

The current ruler settings control the spacing of the grid that is in effect
when you begin to draw. The default ruler settings set the grid to
1
/s-inch increments, and you can see the incremental markers on
the ruler.

Project 1: Creating a Form
This assignment shows you how to create a telephone message form
using Mac Draw II. You'lluse the rectangle tool to create the background
border and message option box and the line tool to create the lines in
the form . The text tool will be used to create text that will be
repositioned in the body of the form. Once you've completed the form,
you'll duplicate the entire message slip so that four will print on a page.
The finished project is shown il Figure 5-14.
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URGENT

Chapter 5: MacDraw II

143

•

Before you begin the projec , your screen should be showing the
rulers at the top and left of he drawing window. If they are not
showing, choose Show Rul rs from the Layout menu.

•

The corner/center control should be set to drawing from the corner.
If it is not, click once on the control to change it.

•

The line pattern should be black, and the fill patte rn should be
white. If they are not, refer to the information about the pattern
palette earlier in this chapter for instructio ns about changing the fill
and line patterns.

•

If necessary, clear the screen of your practice drawings.

DRAWING AND FILLING A RECTANGLE
The first part of the form that you'll draw is the rectangle that is the
border.
,.. Select the rectangle tool.
,,, .

Using the top and side rulers as gu ides, place the pointer at 1/4 inch
on the top (horizontal) ruler and 1/4 inch on the left (vertical) rule r.

,..

Click and drag to form a rectangle that ends at 4 inches on the
horizontal ruler and 4 1/ 4 inches on the vertical ruler.

Theviewofthe rectangle you are creating will auto matically scroll when
you drag the cursor past the bottom edge of the window to reach the 4
1
/4-inch mark. Figure 5-15 shows the drawing window after it has
scrolled, with the vertical scroll box in about the middle of the screen.

Figure 5-15

Scrolling to view the bottom of the rectangle

If you make an error and want to dele te the whole rectangle, press
Backspace (or Delete on some keyboards) while the object is selected.
This works for any object that you create in Mac Draw. You cannot erase
part of an object in MacDraw.
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Next you'll ch an ge the fill pattern of the rectangle you just drew.
The empty fill pattern creates transparent objects, w hich lets obj ects
D
L..::J underneath show throu gh.
When you select an obj ect that is filled with a transparent pattern, you
must click on its border to select it. If an object is filled with any other
pattern, including white, you can click anywhere on the obj ect to select
it. White is the default fill pa ttern (except with polygon s a nd freehand
sh apes, which are filled with the transpa rent pattern).
•

If the rectangle you created is no t alread y selected, select it by
clicking anywh ere on it. Since you want the rectangle to be
tran sparent, select the empty fill pattern from the pattern palette, as
shown in Figure 5-16.
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Figure 5-16

Cha nging fill pattern to em pty

Now is a good time to save wh at you h ave do ne so far.

SAVING THE DOCUMENT
Yo u save a document t he sam e way in all sta nd ard Macintosh
application s, by choosing Save from the file menu.
~ -S

•

Choose Save from the File menu.

•

In the resulting dialog box, click the Drive butto n, if n ecessary, to
be sure that your name is showing wh ere "Pa mela Gurnari " is
showing in Figure 5-1 7 o r that you are saving to th e correct drive a nd
folder.
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Figure 5-17

0

Stationery

0

PICT

The Save dialog box

When saving a MacDraw II document, you can choose one of three
document formats. They are sho'wn in the bottom of the dialog box in
Figure S-17. Drawing format is the preset option, and it causes the
document to be saved as a MacDraw picture. The Stationery option lets
you save the document as a te¢ plate that records settings, drawing
elements, and other preferences. IThe PICT option saves the drawing in
a special format so you can transfer the drawing to another application
that uses the PICT file format. You will use the default Drawing format
for the projects in this book.
•

Type the name of this document as Telephone Message Slip, and
then click the Save button.

The name at the top of your document is now "Telephone Message
Slip-Layer#l".

SELECTING OBJECTS
Earlier in this chapter you learned two ways to select objects: by clicking
on an object with the selection arrow and by dragging completely
around one or more objects with the selection arrow. The second
method is useful for selecting multiple objects at one time.
You can also select multiple objects by using the Shift-click method.
Hold down the Shift key and click on each successive object that you
want to select. If you do not hold down the Shift key, each object will
be deselected when you select the next one.
8€ -A To select all the objects in the drawing window, choose Select All from
the Edit menu.

MOVING OBJECTS
To move an object, you select it and then drag the object to its new
locatio n. (Do not click on one of the handles to drag it, because that will
resize it.) An outline of the object follows the pointer. When you release
the mouse button, the object will be in its new location.
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To m ove multiple objects at one time, you first select the o bj ects using
one of the methods described above. Then, dragging any one o f the
group o f objects will move all the selected objects at one time. Be sure
to click o n on e of the selected o bjects or you will d eselect all yo u have
ch osen.

DELETING OBJECTS
The m ost straightforward way to delete an object from the drawing is to
select it a nd then press the Backspace key. Another way to delete an
obj ect after selecting it is to choose Cut or Clear from the Edit menu. To
delete the entire drawing, ch oose Select AH from t he Edit m enu and
then press the Backspace key.
3€ -Z

To undo a chan ge m ade to yo ur screen , wh ether you mistakenly delete
an ob ject o r you don ' t like the results of a change to an object,
immediately ch oose Undo from the Edit m enu. Undo will undo the last
comm and o r the last action of the mouse.

CREATING LINES OF VARYING WEIGHTS
Yo u can use a variety of line weights in MacDraw. The weights of lin es
are m easured in points-the higher the point size, the heavier the line
weight (the thicker the line). To create a new lin e of a certain size, or to
create a shape that has a certain size border, select the appropriat e tool,
a nd then select the po int size from the Pen menu. This line width w ill
be used for all lin es and shapes you dra w until you select a different point
size. The preset line weight in MacDraw is 1 point.
To change the line weight of an existing line or sh ape, you first select the
o bject. The obj ect will have h andles around it to show it is selected.
On ce it is selected, you can choose a different point size from the Pen
menu. The line weight then changes to the point size you selected.
Yo u' ll change the line weight of the rectangle you just drew.
•

Select the rectan gle if it is not already selected, and the n choose 2
point from the Pen m enu. Notice that th e border of the rectangle
becomes thicker.

Next you' ll draw the lines in the message form .
1 ·--~-~

I •

To draw the lines for the message form, d ouble-click on the line tool.

This will enable you to draw mo re tha n one line without h aving to
reselect the line tool each time.
•

Ch oose 1 point from the Pen menu.

•

At 1/4 inch fro m the top of the rectangle (I /z in ch on the vertical ruler)
draw a h orizontal line inside the rectangle beginning at 3 /s inch
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from the rectangle (5/s inch on the horizontal ruler), and end it at
1
/4inch before the end of the rectangle, which will be at the 33 /4-inch
mark on the horizontal ruler. See Figure 5-18.

- - ----- :- +

........ ..................l..
Figure 5-18
•

Drawing a horizontal line

1/ 4

inch beneath that line, draw two more shorter lines. Begin the
first at 7/s inches on the ho rizontal ruler and end it at the 2 inch
mark. Start the one next to it at 2 1/2 inches on the horizontal ruler
and end it at the 33/4-inch mark.

You should now have two more lines in your rectangle, like those shown
in Figure 5-19.

Figure 5-19

The second set of lines

Since you want two more lines the same length as the first line you drew,
1
you'll make two copies of that li e and position them in the rectangle.

38 - 0

•

Click on the selection arrow.

•

Click anywhere on the
line to select it, and then choose
Duplicate from the Edit menu.

firs~
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The duplicate line will be placed slightly below and to the right of the
original line, and it will a uto matically be selected.
The Duplicate command places a copy of the selected object in the
d rawing. The Copy command places a copy of the selected object in the
Clipboard, and you use the Paste command to paste the ob ject in the
d rawing. Duplicate works like a combination Copy/Paste command.
•

Drag that new line down to the 1 1/4-inch mark on the vertical ruler,
so th at it is placed 1/z inch below the short lines above it, as shown
in Figure 5-20.

Figure 5-20

Positio ning the duplicate line

•

Click somewhe re else on the screen to deselect the new line.

•

Select the bottom line again and duplicate it in the same manner.

•

Place the duplicate line 1/4 inch ben eath the last line.

•

Duplicate the line one more time and place it 1/4 inch beneath th e
one above it, so you r drawing has three duplicate lines 1/ 4 inch apart,
as shown in Figure S-21.

------,~

. ........

Figure 5-21

Duplicating lines
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Now you' ll resize the last line to make it sligh t ly sh orter than the one
above it.
•

If it's n o t already selected, select the last line and t hen click o n its
left h a ndle. Drag to the right so it is 5/s inch sho rter th an the one
above it, as sh own in figure 5-22.

_

_

:~·

~-------~

.. . . . . . . .

. " f ..

. . ..... .

.J..... .
Figure 5-22

Resizing a line

The next step is to draw another rectangle for the message options.
•

Select the rectan gle tool.

•

Beginning at the 2-inch mark on the vertical ruler and 3 /s inches o n
the h orizontal ruler, click an d drag to form a rectangle that is 1 inch
deep and that extends to Y /s inches o n the horizontal ruler. See
Figure 5-23.

- -.-. .-! ..

Figure 5-23

r:::-1
L...=::J

•

Drawing the second rectangle

Double-click on the line tool and draw three ho rizontal lines within
that rectangle, 1 /~ inch apant and the e ntire len gth of the inner
rectangle, as shown in Figur 5-24.
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Figure 5-24

The lines in the smaller rectangle

,.

Draw fou r more lin es beneath the rectangle, beginning at 1/4 inch
below the inner rectangle. Th ere sh ould be 1/4 inch between each
line. Start the first at 1 in ch on the horizontal ruler and end it at the
33 /4 -in ch mark. See figure 5-25.

,.

The n ext two lines should begin at 1/z inch o n the horizontal ruler
and also end at 3 1/.t inches .

•

The last lin e should start at 2 inches on the horizonta l ruler and end
at 3:1/ 4 inches.

Your lines should look like those sh own in Figure 5-25.

~---------:--------: ---Jl

Figure 5-25

•

Finishing the lines

If yo u've not already saved your work, do so n ow by choosi ng Save
from the File me nu.
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ADDING TEXT
The n ext task is to type the text. To create text, you select the text tool.
Th e pointer changes to an !-beam and is used to set the place where the
text begins.
Once you enter the text, it becomes a separate object that you can select
like an y other object. Once you se lect it, you ca n drag it around the
screen to reposition it. You can also place text on top of an object.
•

Double-click o n the text tool.

•

C hoose Geneva from the Font m enu.

,.

C hoose 9 point from the Size m enu .

"..

Click in the blank area to th e right o f yo ur partially completed
message slip and type the word To .

"',.

Click next to that word and type Date. See Figure 5-26.

M

J'toono No.

of

. Mtr...9t . :S~

...... :.

tJ

TELEPHONED

[-:--·-~
Figure 5-26

: I

Adding text

•

Continue in this manner: Type a word, a nd then click next to or
ben eath it to create each word as a separate object. Type the
fo llowing words:
Time
M
of
Phone No.
Message
By

•

Type the following in all ca s, also as sepa rate ob jects:
TELEPHONED
WAS IN TO SEE YOU
WANTS TO SEE YOU
RETURNED YOUR CALL
PLEASE CALL
WILL CALL BACK
URGENT
WHILE YOU WERE OUT
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•

Save yo ur work now.

•

If you used the Caps Lock key when you typed the last words, be sure
to press the Ca ps Lock key again to release it.

When the Caps Lock key is d own, it const ra ins the movem ent of the
po inter and restricts where you can draw and position objects on the
screen.
Another kind of text used in MacDraw II is paragraph text. It uses text
wrap around and confines text to specifi c areas. To create a p aragraph,
select the text tool, and then drag the pointer to create a tempo rary text
box . You don' t need to set an insertion point because MacDraw will
ente r t he text begin ning at the blinking I-beam. When you are finished
entering the text, clicking anywhere on the screen removes the temporary
text box and leaves th e paragraph automatically selected with handles
until yo u click som ewhere else. Dragging any handle will resize the
margins of the paragraph. You can move the paragraph by clicking in
it and dragging it around on the screen.

EDITING TEXT
To edit text, you use the text tool. To select text you'd like to edit, first
click on the text tool, and then drag across the text you want to change.
Yo u can also double-click on a single word to select it. Thi s will highlight
the text. You can then type n ew text over the selected text.
To d elete text, select it with the text tool in the same manne r as above
and then press the Backspace key or ch oose Cut or Clear from the Ed it
m enu.
To insert text, you position the pointer in the line oftextwhereyou want
to insert a character, wo rd, or words, and then you click to set the
inserti on point. As you type, the rest o f the text moves, or wraps, to make
room for the inserted characters.

FORMATTING TEXT
You can format an y text that you create using the option s in the Font,
Size, and Style m enus. To select text for formatting, you can either wipe
through it using the text tool, or you can select t he text block using the
selection arrow.
The phrases "URGENT" and "WHILE YO U WERE OUT" n eed to be
c hanged to a larger, bo ld font.
•

Ch oose the selection arrow and click o n the word URGENT. Drag
the h andle o n the bottom right of the word so that a lon ger rectangle
is created fo r the word, as shown in Figure S-27.
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This will allow you to change t a larger font and still keep the words
from going on to more than on line.

M

or

Phon• No .

. . . Mru •g• . ilv ... .

g---.----]
.

Figure 5-27
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VLL CALL !lACK

•
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. ............... .

Resizing the text box

While URGENT is still selected, choose Bold from the Style menu,
and choose 14 point from the Size menu. See Figure 5-28.

V oVITS TO $EE YOU

E_____]
Figure 5-28

•

. AETIJI!NEQ ~CAl.~ .• : .
PlEASE C~L

VLL CALL !lACK

'tJRGENt
. • . ....

• :

: ...... \ :.

Changing the text size and style

Go through the same procedure for "WHILE YOU WERE OUT".

REPOSITIONING TEXT
Now that you have created and formatted the text, you'll position it on
the message slip.
•

To make it easier to position t e text precisely, choose Turn Autogrid
Off from the Layout menu.
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Now you can select each t ext block individually and positio n it next
to the appropriate line. Do this with all the text except what
goes in the message optio ns blocks (t he text that is in all caps). See
Figure 5-29.

To see ho w the text sho uld be positio n ed, refer to Figure 5-1 4 at the
beginning of this project.

To
Dat~

---- Tim~

.

M

.

TELEPHONED . 'tl AS IN TO SEE.

of

WANTS TO SEE YOU

Phon~ Np. - --

- ---- - -

·- - - - - - - ------ --:~---

.

RETURNEe' YOUR CALL

.

.

· · PlEASE C ALL · · · · • · · ·
WILL CALL BACK

.
.

URGENT

: t

.
· WHILE YOU WERE·
.

Figur e 5-29
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Repositio ning text

•

Ch oose Save fro m the File m enu .

•

To determi n e ho w lo ng to make the m essage optio n s blocks, place
TELEPHONED, WAS IN TO SEE YOU, WANTS TO SEE YOU, an d
RETURNED YO UR CALL in the areas sh own in Figu re 5-30.
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·

~I ANTS

·

·

RETURNED YOUR CALL

.

.

M essage - - --

-- - -- - -

TO SEE YOU
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Figure 5-30
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Moving m o re text

Do t h is by selecting each tex t block indi vidually an d dragging it to
its n ew loca tion .
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ADDING AND DUPLICATING LINE
Now you can determine where the vertical lines need to be placed
within the inner rectangle.
,,. Select the line tool, and then draw a vertical lin e begi nning after
RETURNED YOUR CALL. Make that line the same height as the
rectangle, as sh own in Figure 5-31.

TELEPHONED

----------~---·
·

WAS IN TO SEE YOU

~

·

WANTS TO SEE YOU

•

·

RETURNED YOUR CALL

·

·

---------- ---------------

Figure 5-31
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PLEASE CA(L
WILL CALL BACK

URGENt
·wHiLE Ydu ·wERE:

Drawing the first vertical line

.. To duplicate that line, ch oose Duplicate from the Edit menu.
.. Place the duplicate line about 1/4 inch to the right of the original, as
shown in Figure 5-32.

M

of

Phone Ni>. - -- - --

-'--- - -PLEASE CA( L
WILL CALL BACK

URGENt
·wHiLE Ydu ·wERt

Figur e 5-32

Duplicating the
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•

Duplicate the line agai n in the same manner, and place it about
1/4 inch from the edge of the rectangle, as shown in Figure S-33.

M

of
Phone

Np.

TELEPHONED
WAS IN TO SEE YOU

·
•
-~---~-·
·

WANTS TO SEE YOU

·

•

RETURNED YOUR CALL

·

•

---------- - -----------

Figure 5-33
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PLEASE CA(L
WILL CALL BACK

URGENt

·wHiLE Ydl.J ·wERt .

Duplicating the line again

Select the line between WANTS TO SEE YOU and RETURNED YOUR
CALL. Shorten that line by dragging on the right handle so th at it
stops at the second vertical line, as shown in Figure S-34 .

. . . . . . . . . . . . . . . . . .I
M
of

Phone Ni>.

:~:~':~~~:'tl ANTS TO SEE YOU

----------E
·

~---------+-~

·

.

R~~~:_D_Y~UR C!':_L _ _j_ _ _ _ _ _·___ _

Message - - - - - - - - - - - -- - - - - -

Figure 5-34
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PLEASE CA(L
WILL CALL BACK

URGENt

·wHiLE Ydl.J ·wERt 0

Making room for URGENT

•

Now you can place the remainder of the text into the form in th e
appropriate places.

•

Choose Save fro m the file menu.
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You can place as many m essage a rm s o n a page as will fit, to save paper
and printing costs. Four m essage forms will fit on one page, so t hat is
how you 'll print them. Now that yo u've com pleted the fi rst m essage
form, creatin g the other ones is easy.

USING THE ZOOM CONTROLS
You'll use the zoom controls to reduce your view of the d rawing and see
more of it o n the screen.
•

Click once o n t h e left zoom cont ro l to reduce your view to SO% .

The zoom percentage box now shows "SO" . Th is e nables you to see m o re
of your dra wing at one time.
8€-A

•

C hoose Select All from the Edit me n u.

You have just told MacDraw to select every ob ject in your drawing.

GROUPING OBJECTS
Grouping consolidates a set of ob jects in to on e combined o bj ect. Th is
en ables you to manipulate the group as a si ngle object. It also allows you
to set each object's position in relatio n to othe r objects in the group.
8€ -G

•

Choose Group from the Arra nge m enu.

Now all the lines, text, and rectangles that make up the message fo rm
are grouped as o ne object, and o nly one set o f hand les appears around
the whole form. See Figu re S-3S .

. ... • J t _ _

Figure 5-35

_

The grouped ob je

On ce you group several objects,! you ca nnot change a single object in
the group. To make changes to "ndividua l parts of an o bject, you m ust
first select th e grouped ob ject, and then ch oose Ungroup fro m t he
Arran ge menu.
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DUPLICATING OBJECTS
Next you'll move the message form so you ca n fit two fo rms s ide-by-side
on the page, and then yo u'll duplicate the message for m.
•

Drag the message form as far as it w ill go to the left edge of the
d ocume nt, as shown in Figure 5-36.

Figure 5-36
3€ -D

Moving the form to th e left edge of the page

•

Choose Duplicate from the Edit menu .

•

Drag the duplica te message form and place it to the righ t of the
o riginal, as shown in Figu re 5-37.

Figure 5-37

Placi ng th e dupl icate message form
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•

Select both message form s by hoosingSelcctAllfrom the

:3€ -D

•

Choose Duplicate fro m the Edit m enu.

•

Position the two dup li cates o n the bo tto m portion of the p
shown in figure S-38 .

•

Figure 5-38

•

• ••
•••

••

••

0

Placing two more duplica te fo rms

Now you have four telephone message fo rms in one d ocument.

PRINTING THE DOCUMENT
Before you print the docum ent, save your work.
•

Choose Save from the Fi le m enu.

•

C hoose Print from the File m enu . C lick OK to accept the default
print options and print o ne copy.

Compa re your printed document with the o ne shown in Hgure 5-14.
:3€ -Q

•

To ex it MacDraw, choose Quit from the file me nu. To continue
working o n the next exercise and rema in in MacDraw, close the
document by cl icking in its close box.

Project 2: Creating an Organizational Chart

·

In this pro ject you'll create a cor,)orate o rga n izationa l chart. You' ll use
som e of the tools and commaljdS that you lea rn ed about in the first
pro ject, and you' ll a lso learn ha~1 dy ways to create some special effects.
You'll learn about pe n and fill patterns and about alig ning and a rranging
o bjects. The finished organizatio nal chart is shown in .figure 5-39.
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Figure 5-39

J udith Crippin
Controller

Fi nal output of Project 2
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Dou ble-click on the MacDraw II icon to op en a n e>
drawing w indow. If you d id rot exit MacDraw after wo rki.
previo us pro ject, ch oose New from the File menu to get
untitled drawing window.

I

Keep in mind that if you need to de lete an object, select it and press
Backspace key (Delete key on som e keyboards).
•

Select Show Rulers from the Layout menu.

You will be using the rulers to determine the size and spacing of the
objects in your o rganiza tion al chart.

DISPLAYING THE SIZE OF AN OBJECT
A h an dy feat ure in Mac Draw II is the 5/ww Size command. Th e size of an y
obj ect you d raw is immed iately reflected on the botto m of the screen as
you d raw it. Also, any time you cl ick o n the border of an object after it
is drawn , it shows you the size of th at object.
•

Choose Show Size from the Layout menu.

•

Select the rectan gle tool.

•

C reate a rectan gle 2 inches wide and 1 inch high .

Notice that th e size of the rectan gle is displayed at the bottom of the
screen as you draw it, as shown in Figure 5-40.
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Figure 5-4 0

•
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Using the Show Size feature

If you clicked elsewh ere on the screen a fte r you drew the rectangle,
click anywhere o n the rectan gle to select it.

CHANGING LINE WEIGHTS
•

To change the thi ckness of the lines forming the rectangle, choose
2 point from th e Pen menu, as shown in Figure 5-41.
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Arrow At Start
Arrow At End
Pens ...
Dashes...
Arrows ...

Figure 5-41

The Pen m enu

You learned abo ut line weights in Project 1. The Pen menu also offers
different line styles.
Plain Line, which is checked in the Pen menu shown in Figure S-41 , is
the default line style. The Dashed Line option creates a dashed line, and
you can customize the dash size and space between dashes by choosing
Dashes from the Pen Men u.
An Autosize Line has the line's length automatically printed in the
middle. Autosize Lines are used for d rawing dimension lines that show
the measurement of objects in a drawing, such as in a floor plan.
The Arrow At Start and Arrow At End options enable you to draw lines
that begin or end (or both) with arrowheads. You can m odify the shape
of the arrowhead by choosing Arrows from the Pen menu .
You can use any combination of line weights, dashes, arrows, and
dimensio ns on any line you draw.

SAVING THE DOCUMENT
Before you get too deep into this project, it's a good idea to save what
you've done so far and give the d rawing a name.
3€ -S

•

Choose Save from the File menu.

Remember to be careful about where you are saving your document.
Always verify that the name of the d isk (or folder) that you want your
document saved on is showing at the top of the Save dialog box- in this
case, where "Pamela Gurnari" is showing in Figure S-42. If necessary,
click the Drive button so that you are viewing the correct name.
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Figure 5-42
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The Save dialog box

Type Organizational Chart in the Save drawing as: box, and then
click the Save button.

Your drawing window should now have the name of your document
and the current layer showing at the top: Organizational Chart-Layer#l.

ADDING TEXT
Now you need to add some text inside the box you just drew. The first
name and title will be the company president's name.
,. . Click o n the text tool to select it, and then click inside the rectangle
in approximately the center of it.
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•

Choose New York from the Font menu, and then choose 12 point
from the Size menu.

•

Choose Bold and then Center from the Style menu.

•

Type the following text in the block, pressing return where indicated:
James W. Nielsen (press Return)
President

Your screen should look like the one shown in Figure 5-43.

!James W. Nielsen !
1
Presldenq
J

Figure 5-43

•

· · · ·· · · ·

Adding text to the rectangle

Click somewhere else on the screen to deselect the text tool.

I
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JECTS
:I • To select both the box and the text within it, place the selection
.ill
arrow above and to the left of the box and drag diagonally past the
bottom right corner of the box.
A dotted rectangle is creat ed around the objects, as shown in
Figure 5-44. When you release the mouse button, all objects within the
temporary rectangle are selected. All objects that are selected will have
handles showing.

/
'
.
: jlunes W . JUetsen
· · · · :· · : · ·Presid~ut· · · ·

·---

Figure 5 -44
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Selecting multiple objects

Selecting multiple objects is not the same as grouping objects. Grouping
objects creates on e composite object made up of all the objects that are
selected when the Group command is invoked. Selecting multiple
objects enables you to work with all selected objects at one time, but
each can still be selected separately.
Next you'll center the text within the rectangle.

CENTERING TEXT WITHIN A RECTANGLE
The Alignment command allows you to align and distribute selected
objects with each other or with the grid. Aligning refers to moving selected
objects so that their boundaries line up in a specified manner. Distributing
obj ects spaces them evenly in a document, either vertically or
horizontally.
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•

Ch oose Alignment from the

•

In the resulting dialog box, •
portion o f the box, and se lec~
the box, as shown in Figure S -~5

I

Alignment. ..
@ To eoch other O To grid
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( Cencei

Figure 5-45
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The Align m ent dialog box

The settings you just ch ose for th is dialog box told MacDraw to align the
objects to the cen ter both vertica lly and h orizontally. Notice that the
sm all diagram in the dialog box shows you the effect these setti ngs wi ll
h ave o n the objects.
•

Click OK to accept the changes yo u've made to the dialog box.

Now you' ll use the box you just drew as a template for the others, since
it is already the correct size and has the text centered within it. To do
so, you'll duplicate it.

DUPLICATING USING AUTOMATIC ALIGNMENT
You'll duplicate the box as well as the name inside it, even though you' ll
change the n ames in just a moment, because you want the text to retain
the same formatting ch aracteristics (New York font, bold, and centered)
when you retype a different name.
3€ - D

.. If both the text and the rectangle are not already selected, select
them now, and then choose Duplicate from the Edit menu.
•

Click on the duplicate set of objects, but not o n a ny of their
handles. Drag them to th e lower left side of the screen, as shown in
Figure S-46.
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Figure 5-46
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Click on an other part of th e sc reen to deselect the objects.

MacDraw "rem embers" where you placed the last duplicate object with
re fere nce to the o rigina l as long as you do no t deselect the duplicate
obj ect . This feature is o ne of the reason s that MacDraw works well for
creating business forms and charts. You can create horizontal, vertical,
and diagona l rows of identical objects without h aving to draw each
ob ject separately or copy th em a nd then align them in a row. When you
position the duplica te object, you establish the spacing and direction of
the row, a nd each dup licate is positio ned and align ed automatically.
You'll use this feature to crea te the rest of the boxes in the second row
of the organization al ch art.
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•

Select t he du plica te box and text within it that you just position ed
in the lower left corne r of the screen.

•

Choose Duplicate fro m t he Edit m enu.

When you p osition the duplicate th at you just created, you'll establish
the direction and spacin g o f the second row of objects.
•

Position th e secon d dup licate box to the right of the original an d
a lign the top edges of both o bj ects, as shown in Figure 5-47.
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•

While the ob ject is still sele ted , choose Duplicate from th e Edit
menu.

Notice h ow that actio n caused the n ext copy to be placed to the right
of the center block. The box is auto matically aligned according to its
relative position to the first, as shown in Figure 5-48.

james w. Nielsen
. : . -President. .. .

James W. Nielsen ·
President
·

Figure 5-48
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•

.

.

james· W. N\elsen
Presid e nt ·

~ames

•

w. •.,_,,___.,.,,

President .

Automatically positioning the copy

Save your work by ch oosing Save fro m the File menu.

MODIFYING MULTIPLE OBJECTS AT ONCE
I

Now that you have the row of boxes drawn, you need to ch an ge the
names in each box. First you' ll change the text in all three boxes on the
second row to 10 point type.
•

Click somewhere outside the currently selected box to deselect it.

•

While ho lding down the Shift key, click o n the n am e in each of the
t hree lower boxes so the text in all three boxes is selected.

•

Select 10 point from the Size menu.

Noti ce that the ch an ge takes effect o n all the selected text. It does n ot
affect the text in the top box.
•

Select the text tool.

Double-clicking o n a tool selects· t and keeps it active until you c li ck on
another tool.

EDITING TEXT
Now you'll change the names il each box in the second row.
•

Drag through the name in the first block to select it, as show n in
Figure 5-49.
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· .Pres ide nt....

James

v . lfielsen:

President

Figure 5-49

·

James v . lfielsen
Pr esident

··

Selecting the name in the box

Feel free to type names of people who mean something to you. The
fo llowing names are suggestions; you can use whatever names you
think of.
,,. Type Carol Garms to replace t he president's name.
,.

Select President in the same box, and type:
Vice-President,
Sales

Press Return if you need to go to a new line within the box.
,.

Continuing in this same m anner, change the name and the title in
the middle box to:

Jill Aoki
Vice-President,
Manufacturing
, . Change the n ame and the title in the last box to:
Richard P. Cleaves
Vice-President,
Finance
Your boxes should look similar to the ones shown in Figure 5-50.

James W. Nie lsen
. : .. Preside nt. . .

Carol Garms
Vic·e-President~

S:llles

Figure 5-50

Jill Aol<i

1Ueh 0...<1 P . Cleaves

Vice 'Preside.nt ~ ·

Vic e -Pres ide n t_

llanUrae turing :

linance

The edited boxes

·
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Now that you have created the s cond row of boxes, using the first as a
template, you need to change the single box in the top row, the
President's box, so that it is larger than the others.
•

Select the President's box.

•

Click on the handle in the lower right corner of the President's box,
and drag to the right. When the dimensions in the size bar at the
bottom of the screen are 2 1/z" by 1", release the mouse button.

This makes the box 1/z inch wider than the others.

FORMATTING TEXT
Now you can center the text within the box.
•

While holding down the Shift key, click on the border of the
President's box, and then click on the text in the box so that both
the box and the text are selected.

Using the Shift key while selecting objects allows you to select more
than one object at a time.
a€ -K

•

To center the text within the box, choose Align from the Arrange
menu.

a€ -G

•

With the box and text within it selected, choose Group from the
Arrange menu.

This groups the centered text and the box as one object.
You did not have to change the alignment specifications as you did
when you first aligned the text, since the alignment specifications
remain the same until you change them. The Alignment command
allows you to change the alignment specifications, and the Align
command allows you to align objects based on the last alignment
specifications you set.
a€ -S

•

Save your document.

USING THE ZOOM CONTROLS
Now view the drawing in 50% size so you can finish adding the other
boxes and position them properly on the page.
•

Click the left zoom control to reduce your drawing to 50% size.

You will see "50" in the zoom percentage box.

I
DUPLICATING MULTIPLE OBJECTS
You'll duplicate the three boxes in the second row and place the
duplicates in a row at the bottom.
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,. Select the row o f three boxes by dragging around a ll three boxes with
the selection arrow, as shown in Figu re 5-51 .

l r-~-1
.

.

.

r;:~~-=:J-r~:J-r~~r ·

···

~· ~· ~J ·
- -- -- -- -.-------- -.-------- -.-- ~

Figure 5 -51

W- D

Selecting the bottom row of boxes

•

Ch oose Duplicate from the Ed it menu.

•

Positio n the duplicate boxes d irectly beneath the first row of t h ree
boxes, as shown in Figure 5-52.

1 -~-1
~]~][~J ····

Figure 5 -52

•

Position ing the duplicate boxes

C lick elsewhere on the screen to deselect the three boxes and the
tex t within the m.

RESIZING MULTIPLE OBJECTS
Next yo u' ll reduce the size of the bottom three boxes.
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•

Hold down the Shift key and click on the border of each of the
bottom three boxes.

This will select just the boxes, not the text within them.
•

Now reduce the size of all three boxes by d ragging to the left the
lower right corne r of any box, unti l the size bar at the bottom of the
window shows that the box has been reduced to P/4 inches by 1
inch, as shown in Figure 5-5 3.

1-~-1
~]~][~J '' ' '
: ~·~.-~]

1-::J. il>-----~1>-----:--<ai:-· -~-~~-

Figure 5-53

. . ..

Resizing multiple ob jects

When you release the mouse button, all three boxes are reduced to the
same size. See Figure 5-54.

1-~-1
~]~]§J ''''

Figure 5-54

The resized boxes
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Use the zoom control to enlarge the drawing to 100% size. Then use
the scroll boxes to positio n the screen so you are viewing the smaller
three boxes.

Change the names and titles as you did with the middle row of boxes.
Use names of your choice or the suggested ones that follow.
••

Change the first box so that it contains the following name and ti tle :
Mai Nguyen
Sales Manager

"•

Change the text in the middle box to the following:
Samuel Neujahr
Manufacturing Manager

,...

Change the text in the third box to read:
judith Crippin
Controller

Your boxes should now look similar to the ones shown in Figure 5-55.
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The names in the bottom row of boxes

,,.

Click somewhere on the screen to deselect the three boxes.

,,.

Choose Save from the File menu.

GROUPING OBJECTS
The next step is to cente r the text inside each box and then group the
box and the text in it.
•

:3€ - K ••

While holding d own the Shift key, select the first box in the middle
row and then the text inside that box .
Choose Align from the Arrange menu.

This centers the text inside the box, based on the last settings you made
in th e Alignme nt dialog box.

:3€ -G

•

Choose Group from the Arrange menu.
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This groups the text and the box s that MacDraw views the box and the
name in it as one object, not twd.
•

Click somewhere on the screen to deselect the grouped box and text
object.

Deselecting the previous box is an important step. If you do not deselect
it first, when you Shift-click to select the next box and text, the box you
just grouped will be included in your centering and grouping operation .
•

Continue centering the text within each box, and then group the
centered text and box. Be sure to deselect each box after you group
it and before you select the next box and text.

•

When you are finished centering text and grouping each box with
the name within it, use the zoom control to return to 509·6 size.

ALIGNING OBJECTS
Now that you can view all the boxes, you need to align them to on e
another.
•

Select the top box and drag it to the center of the top row.

Use the horizontal ruler to help you determine the approximate center.
•

Shift-click to select the box in the top row, the center o ne in the
second row, and the center one in the bottom row so that all three
are selected at the same time, as shown in Figure 5-56 .

.......

·1.... i ..... .
-1-~ ·[==-I~l · ··
! I - ~~~

EJ~~

. . . . . . .. .. .. . · ~
.

Figure 5-56

•

. . . . . ..... .... .
.
.

Selecting the three center boxes

Choose Alignment from the Arrange menu. The Alignment dialog
box will show o n your screen.
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•

In the upper right section of th e dialog box, beneath the words "To
grid ", cl ick Alig n to re move the "X". This sho uld leave bo th the
Align and Distribute boxes wit ho ut an "X" in th em.

•

Next, be sure there is a n "X" in th e Alig n box that runs ho rizontally
ac ross the bo tto m o f the dialog box. Beneath that, click Center.

Your completed dia log bo x sho uld look like the o n e shown in
Figure 5-5 7.
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Figure 5-57

(~}

Th e Alig nment dialog box

The settings in this dialog box tell Mac Draw that you do not want to do
an y horizon ta l alig nment o r distributio n, just vertica l alignment.
Return

•

C lick OK to accept t hose settings o nce you have
they are correct.

determin,~d

tha t

The three boxes you selected a re now aligned vertically.

:3€ -K

•

Click som ewh ere o n the screen to deselect the boxes you just
align ed, a nd then Shi ft-cli ck to select th e first box in the second row
and the first box in the third row.

•

Ch oose Align from the Arrange m enu .

The a lig nme nt settings you selected las t time w ill still be in effect.

:3€ - K

•

Click som ewh ere on the screen to deselect the boxes you just
align ed, and then Shift-click to select the last box in the second row
and the last box in the third ro w.

•

Choose Align again from the Arran ge menu.

Now yo u n eed to draw the lines to connect th e boxes in your
organizatio na l ch art.
•

Select t he line tool.

•

Pl ace the poi nter in the center o f t he to p box, and while ho lding
dow n the Sh ift key to constra in t he line vertically, d rag down to
d raw a stra ig ht line to the center o f the middle box in the botto m
row, as shown in Figure 5-58.
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Figure 5-58

Draw the first connecting line

MOVING OBJECTS TO THE BACK
The order in which objects appea r o n the screen , in front of or behind
each other, is ca ll ed the stacking order. The line you just drew n eed s to
be positioned behind the boxes in the ch a rt. You'll change its position
in the stackin g order now.
"•

Select th e li ne you just drew if you deselected it, an d then choose
Move To Back fro m the Arrange menu.

Now the line appears to be behind the boxes.
•

Draw two mo re vertical lines th rough the boxes on either side, as
shown in Figure 5-59.

Figure 5-59

Draw two more lines
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•

With both lines selected, move them to the back by choosing Move
To Back from the Arrange menu.

•

Zoom to 100% size using th e zoom control.

•

Draw the horizontal line to connect the three vertical lines between
the top box and the second row of boxes, as shown in Figure 5-60.
If necessary, change the length of any line that does not meet
precisely.

James W. Nielsen

· · · · · · · · ·Piesicient" · · · · ·

R~~~::.;f~::t'•
:rinance

·

';,

.,~;l

;·•:;

Figure 5-60
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•

The horizontal connecting line

Now is a good time to save all your work, if you haven't already
done so.

CREATING A DROP SHADOW
Next you'll proceed with the steps to create a shadowed effect behind
the boxes of the chart.
First you need to group all the elements in your existing chart as one
object.
3€ -A

•

Choose Select All from the Edit menu.

W-G

•

Choose Group from the Arrange menu.

•

Use the zoom control to reduce the view to SO% size.

•

Drag the whole chart to the bottom portion of the screen, about a
half-inch from the bottom, as shown in Figure 5-61.
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Figure 5-61
3€ -D

Reposition the group

.. Choose Duplicate from the Edit menu.
This places a duplicate of your grouped chart on top of the origina l, and
the dupli cate is selected.

Changing the Fill Pattern
.. Without deselecting the duplicate object, click to select a medium
gray pattern o n the pattern palette, as shown at the top of
Figure 5-62.
Th is will cause the duplicate boxes to be filled wit h gray. See Figure 5-62.

Figure 5 -62

Changing th e fi ll
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Changing the Line Pattern
•

While the duplicate chart is still selected, click on the far right square
in the pattern palette to indicate that you are referring to the line
pattern, and then click again on the same shade of gray that you
selected for the fill pattern.

This changes the duplicate lines to gray also.
Next you need to move the duplicate object so that it appears to be
peeking out from beneath the original boxes, to produce a shadowed
effect.
,,. Choose Move To Back from the Arrange menu.
Your drawing should look like th e one shown in Figure 5-63.

Figure 5-63
3€ -A

Creating a shadowed effect

3€ -G

,. Choose Select All from the Edit menu, and then choose Group from
the Arrange menu to group the shadowed chart as one object.

3€ -S

,.

Choose Save from the File menu.

USING DIFFERENT TEXT STYLES
Next you'll put the company name at the top of the chart.
,. Select the text tool.
,. Select 24 point from the Size menu, and choose Shadow from the
Style menu.
,.

Position the pointer in the center of the top portion of the screen,
and type Acme Toys, Incorporated. Then press Return.

The next line in the chart title will have smaller text and will not be
shadowed.
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·•

Choose 18 point from the Si e menu, and choose Shadow from the
Style menu to d eselect it.

•

Type Manufacturers of Fine Toys on that line.

CHANGING THE TEXT BACKGROUND
Now you'll change the background o f the text to make it stand out on
the page.
••

While your text is still selected, select a shade of gray from the
pattern palette, lighter tha n the o ne that you used for the sh adows
of the chart boxes.

This produces a light gray background fo r the title, as shown in
Figure 5-64.

Figure 5-64

•

Title with light gray background

To align the title vertically to the chart, select both the chart and the
title by Shift-clicking.

, . Choose Alignment from the Arrange menu. Make sure that the
settings in the resulting dialog box are for vertical alignment, like
the ones in the dialog box shown in Figure 5-65.
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Now you'll group the centered title with the chart.
~ -G

•

While everything is still selected, choose Group from the Arrange
menu.

,,. Click somewhere else in the screen to deselect the objects.
Finally, you'll center the chart on the page.

CENTERING THE CHART ON THE PAGE
You're going to draw a rectangle around the whole page, and then you 'll
align the chart to the rectangle. After the chart is centered in the
rectangle, you'll delete the rectangle.
•

Select empty fill, the transparent pattern, from the pattern palette.

•

Click on the far right square of the pattern palette to indicate that
you are referring to the line pattern, and then click on the solid black
pattern.

",. Select Turn Autogrid Off from the Layout menu to enable you to
place your box precisely on the screen.
•

Select the rectangle tool, and then draw a box around the entire
drawing page, keeping as close to the edges as possible.

As you draw the bottom edge of the box and you drag the pointer off
the bottom of the drawing window, notice how the scroll box in the
vertical scroll bar moves all the way to the bottom of the scroll bar, as
shown in Figure 5-66. This indicates that you are at the bottom of the
drawing page.
,. Do not release the mouse button until the rectangle reaches the
bottom of the drawing page. See Figure 5-66.

Figure 5-66

Draw a box around entire drawing page
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•

Shift-click to select the ch art so that bo th the rectan gle aro und the
page and the ch art are selec ed.

Now you 'll set the alignment so that the o bjects are centered vertically
and h orizontally.
•

Ch oose Alignment from the Arrange menu. Make sure the settings
in the resulting dialog box match the o nes shown in Figure 5-6 7, and
then cl ick OK.
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Now your chart is aligned to the center of the page.
•

Ch oose Save from the File menu.

Now that you have centered the ch art and title on the page, you no
longer need the large rectangle you just drew.
•

Click somewh ere on the screen to deselect both objects, and then
click on the rectangle to select it. Press the Backspace key (Delete on
some keyboards) to remove the rectangle.

VIEWING THE ENTIRE PAGE
The entire drawing is n ot visib le in SO% size, but you can see it all in
25% size.
,.

To view the entire page, cl ick o n the left zoom control to reduce the
drawing to 25%.

Th e screen should look similar to the o n e shown in Figure 5-68.
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Figure 5-68
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Organizatio nal chart at 25% size

•

Before you prin t the organizational chart, save it one last time.

,.

Ch oose Print from the File m enu.

,,.

Click OK to accept the default settings of the d ialog box, and print
one copy o f t h e document.

,,.

Compare your printed organizational chart with the on e in Figure
5-39 at the beginning of thi s pro ject.

If you need to m odify a pa rt of the ch art or a misspelled name, yo u must
ungroup as man y times as n eeded un til the ob ject you want to modify
is accessible. As you created this chart, you grouped on man y different
levels, so you will h ave to ungroup several t imes to access individual
o bjects in the chart.
3€ -Q

•

To exit MacDraw II, choose Quit from the Fi le me nu. If you intend
to continue with the addition al projects, just close t h e document
and don 't quit MacDraw II.

SUMMARY
• MacDraw II's tool palette contains the drawing tools th at you use to create the ob jects in a
drawin g. You select a tool by clicking on it, and the tool reverts to t he selection arrow after
each use. To keep a tool active, you do uble-click on it .
• All obj ects created in MacDraw ll, including text, lines, and shapes, ca n be fi ll ed with a
pattern, resized, duplicated, deleted, an d m oved.
• You create text using the text tool. Th e optio n s in the Font, Size, and Style menus apply to
the text typed with th e text tool. You can ch an ge an d insert characters or words in MacDraw
without ret ypi ng, and you can drag text to a n ew location in a document.
• Lines are drawn using the lin e tool. You can change the weight of a line before you b egin
drawing it or after it is drawn. The Pen menu is used to change the weight of lines d rawn wit h
the line tool an d the borders of an y sh ape drawn wit h the shape tools. You can also chan ge
the pattern of any lin e o r border. The different line styles available on the Pen m enu affect
lines and not borders of sh apes.
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• Shapes are drawn using the oval tool, the rectangle tool, the rounded rectangle tool, the
freehand tool, and the polygon tool. Shapes can be drawn either unfilled or filled with a
pattern. A shape can be resized and moved after it is drawn.
• Autogrid controls wh ere you draw an object and what size it ca n be. Using Au togrid makes
it eas ier to align ob jects, but you cannot place or draw objects between grid divisions when
Autogrid is o n. The gridlines in a drawing represent wh ere Autogrid wi ll constrain the
placement of obj ects. Horizontal and vertical rulers also enable you to control the size and
placement of objects.
• The fill and line patterns are controlled with the fill pattern box and the line pattern box on
the pattern palette.
• You select an object by cl icking on it with the se lection a rrow. You can select multiple ob jects
at one time using either the Shift-click method, by dragging through multiple objects with
the selection arrow, o r by choosing Select All from the Edit menu. Once you have selected
multiple ob jects, you can manipulate them (resize, move, d elete, d uplicate, and fi ll th em) all
at o ne time.
• The zoom controls allow you to enlarge a drawing to see de tails or reduce it so you can see
more of it on the screen. You can magnify a drawing up to 3,200% in p redetermin ed
increments and reduce a drawing to 3.12% in predetermined increments. You can ed it a
drawing at any zoom level.
• Grouping consolidates a set of objects into one combined object, which enables you to
manipulate them as a single object. It also allows yo u to set the posi tion of a n object in
relation to other objects in the group.
• You can align and distribute objects in relation to other ob jects using the Al ignment
command from the Arrange menu.

KEY TERMS
active
align, aligning
arc tool
Autogrid
constrain
corner/center control
cross-beam pointe r
deselect
distribut ing
Drawing format
Duplicate command

grid
gridllnes
grouping
handle
highlighted
insertio n po in t
layer controls
layers
line ~attern box
line tool
line Jveigh ts

e llipse
m enu bar
fill
fi ll pattern box
freehand tool

paragraph tex t
patte n palette
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Pen menu
point size
polygon tool

smooth
snap
stacking order

Reshape command
resize
rulers
ruler settings

text tool
tools palette
transparent objects
Unsmooth command

scroll arrows
scroll box
select
selection arrow
Show Size command

wrap, text wrap
zoom controls
zoom percentage box

MACDRAW II COMMAND KEYS AND SHORTCUTS
File Menu
New
Open
Close
Save
Quit
Edit Menu
Undo
Cut
Copy
Paste
Duplicate
Select All
Reshape
Smooth
Unsmooth

W-N
W-0
W -W
W -S
W-Q
Ungroup
W -Z
W-X
W-C
W-V
W-D
W-A
W -R
W-E
W-Shift-E

Arrange Menu
Move To Front
Move To Back
Align
Alignment
~otate

Group
W-Shift-G
Style Menu
Bold
Italic
Underline

W-Shift-F
W-Shift-J
W -K
W-Shift-K
~ -T
00-G

W -B
W-I
W -U

Additional Projects
The following projects are accompanied by briefer instructions than
those you have previously completed in this chapter. They require that
you apply what you learned in the first two projects. If necessary, refer
to "Using MacDraw's Tools" at the beginning of this chapter for
information and instructions about using any tools that you aren't
familiar with.
You will not be reminded to save your work- you should be thinking
of that on your own by now.
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PROJECT 3: DRAWING A WHISTL
This project makes use of the polygon too l, the circle, the corner/center
control, and the Reshape command. You'll use the zoom controls to
work in a magnified view of your drawing, and you'll use the Rotate
command to rotate text. The finished whistle is shown in Figure 5-69.

Figure 5-69

•

[QJ •

Final output for Project 3

Choose Turn Autogrid Off from the Layout menu.
Select the oval tool.

•

Hold down the Shift key and draw a circle about 1 inch in diameter.

•

Use the polygon tool to draw the mouthpiece extension, as shown
in Figure 5-70.

1

CJ. .........

. . ·C
; .. .. .. . ·P
... 1
.
.
.
.

Figure 5-70

.

..

Drawing the mou

..
..

.

pi ece of the whistle

Now that you have drawn both shapes, you need to examine them and
make sure they are touching.

Part II: Graphics

186

00 - R

•

With the polygon shape selected, use the zoom control to magnify
the view to 400%.

•

Ch oose Reshape from the Edit menu.

,. Drag the endpoints of the polygon so they touch the circle. See
Figure 5-71.

Figure 5-71

Reshaping the endpoints of the polygon

,. Click the zoom percentage box to return to lOOo/o viewing size.
00 -G

•

Select the circle and the polygon shapes, and then choose Group
from the Arrange menu.

00 - D

•

With the grouped objects still selected, choose Duplicate from the
Edit menu.

•

Position the duplicate object slightly lower and to the left of the
original, as shown in Figure 5-72.

Figure 5-72

Positioning the duplicate object
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•

Fill the front object with a
different pattern.

ay pattern and the one behind with a

Now you'll change the borders of these objects to a heavier line weight.
•

Select both objects and choose 2 point from the Pen menu. See
Figure 5-73.

Figure 5-73

•

Use the zoom control to magnify the view to 400%.

•

Draw the whistle "opening" on the mouthpiece with the polygon
tool, and fill the sh ape with black, as shown in Figure 5-74.

Figure 5-74
~ -R

Changing the line weight of the borders

Drawing a polygr

for the end "opening"

•

Use the Reshape command as n ecessary to make the four points of
the "opening" shape match the points on the end of the whistle.

•

Move to the other "opening" area of the whistle and use the polygon
tool to create that shape. Reshape as n ecessary, and fill it with black.
See Figure 5-75.
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Figure 5-75
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Creatin g the o ther "opening" with the polygon tool

•

Use the zoom control to ch ange t he view to 200% size.

•

Draw the shape tha t holds the ring with the po lygon tool. Fill it with
the same pattern as th e front o f the whistle.

•

C hoose Move Backward fro m the Arrange menu so the border of
the circle is no t obscured by the sha pe. See Figure 5-76.

Figure 5-76

•

Positio ning the small po lygon

Use the Shift key with t he oval tool to draw the circle fo r the ring.
Fill the ci rcle with the empty fill, o r transparent, pattern.

•
38 -J

C h oose 4 point from th e Pen menu to give the ring a heavier border.

• Place th e ring o n to p of the small po lygon yo u just drew, and then
ch oose Move Backward fro m th e Arrange m enu.
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The rin g now appears to be behind the polygon, as shown in
Figure S-77.

Figure 5-77

Moving the ring behind the polygon

.. Click somewh ere to deselect the ring, and then choose 2 point from
the Pen menu.

~S hi ft-J

•

Use the pol ygon tool to draw the piece o n top of the ring. Fill it with
the same pattern as the back of the whistle.

•

Ch oose Move to Back from the Arrange menu to place this polygon
in the back of the stacking order, as shown in Figure S-78.

Figure 5-78

Moving the top polygon behind the ring

•

Use the zoom control to view the drawing at 400% magnification.

•

To make the ring ap pear to be going through the top polygon, draw
a small rectangle with th e skne fill pattern and line pattern as the
back o f the whistle, as sh awl in Figure S- 79.
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Figure 5-79

The small rectangle used to "erase" part of the ring

•

Place the rectangle so that it obscures part of the ring, in effect
"erasing" it.

•

Ch ange the line pattern to black and the fill pattern to white.

, . Ch oose 4 point from the Pen menu.

I f.".::J I ••
~
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•

Draw a small white circle in the center of the main circle, about a
half-inch in diameter.

•

Set the corner/center control to draw from corner.

..

Choose a fo nt of your ch oice and 24 o r 36 point size.

1;-

[AJ

...
~-T

Set the corner/center control to draw from center.

II. .

....

Use the text tool to type your in itial, a nd then place the initial in the
center of the white circle.
Type the words What a whistle!! in a font of you r choice and in 14
or 18 point size.
Choose Rotate from the Arrange menu while the text is selected .
Positio n the X pointer at the end of the word and drag in a circular
motion to rot ate the text. The text will pivot around the end
opposite from where you place the pointer, as shown in Figure 5-80.

,.:._./:::.·-:~~('

,I!_./.:..---·----

. . ..\ Wlut a whistle !!
~:

Figure 5-80

Rotating text

. ..

.

. ..

. .

: •

·• . .
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•

Place th e text at the sam e a gle as t h e underside of th e wh istle.

Compare you r fin ished wh istle with the one shown in Figure 5-69.

Project 4: Drawing a Still Life
This pro ject uses the freeh and tool, the a rc too l, the Hesh ape comm and,
and the Sm ooth and Unsmooth commands. Th e fini sh ed drawing is
sh own in Figure 5-81. It shows some suggested foods to d raw, but yo u
can use yo ur imaginatio n . So me o ther ideas for food sh apes that wo uld
be interesting to d raw and that would exercise your creati vi ty are
breakfast food s, carrot slices, rolls, beverages, pasta, fish, a nd sandwiches .

•

Figur e 5-81

Fina l output fo r Project 4

•

Draw th e p lacem at and the napkin w ith th e rectangle tool, and fill
them with the patterns of yo ur cho ice.

•

Use the Shift key with the oval tool to draw the plate. Fil l it with
white.

•

Set the corner/center control to d raw fro m center, and then ch oose
6 point from the Pen menu .

•

Set the lin e pattern to a patte rn of your ch oice, an d t he n d raw the
border o n t he plate. See Figure 5-82.
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Figure 5-82
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Using a 6-point line weigh t for the plate border

,,. Select the placemat1 napkin1 plate 1 and border1 and then choose
Group from the Arrange menu.
,,. Click somewhere to deselect the object/ and then change the pen
size by choosing 1 point from the Pen menu.
, , . Change the line pattern to black and the fill pattern to white.
•

Scroll to the area to the right of the placemat and then select the
freehand tool.
1

,,. Draw the shape of a knife/ as shown in Figure 5-83. Don t worry if
it doesn 1 t look too good- you 11l use the Reshape command to fix it.
1

Figure 5-83

:3€ -R
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Drawing the shape of the kn ife

•

Choose Turn Autogrid Off from the Layout menu.

•

Use the zoom controls to view the drawing at 400% magnification.

•

With th e knife selected/ choose Unsmooth and then Reshape from
the Edit menu.
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Add new points on the border of the shape by clicking and move
existing points as needed until the shape resembles a kn ife. See
Figure 5-84.
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Figure 5-84
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Moving a point o n the knife shape

To remove a point fro m the border o f the sh ape, h old down th e Option
key and cl ick on the unwanted point.

::1€ -E

•

Click in the zoom percentage box to return to 100% size.

•

Choose Smooth from the Edit menu, and click o n t he selectio n
arrow to stop reshaping.

If your kn ife does not satisfy you, continue unsmoothi ng, reshaping,
and smoothing it until it looks the way you want it to.

•

When it is to your liking, fill the knife with a light gray pattern and
positio n it on the p lacemat to the right of the plate. See Figure 5-85.

Figure 5 -85

Position the completed knife on the placem at
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•

Create the spoon in the same manner and position it on the
placemat next to the knife. See Figure 5-86.

Figure 5-86

,.

Creating and reshaping the spoon

Create the fork in the same way and then place it on the napkin. See
Figure S-8 7.

Figure 5-87

Creating and reshaping the fork

•

Use the zoom controls to view the drawing at 200% size.

•

To draw the pile of peas, draw a small circle with a light fill pattern
and a gray line pattern.

•

Duplicate the circles repeatedly, and position them to form a
helping of peas. (The Command-key equivalent for the Duplicate
command, Command-O, is useful for multiple duplications.) See
Figure 5-88.
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Figure 5-88

Duplicating circles to form the peas

•

Switch between the different magnification views to suit your
drawing needs.

•

Draw the mea t with the freehand tool.

•

Draw the basic shape of the meat filled with white, and then draw
a slightly smaller shape inside of it filled with a light pattern. See
Figure 5-89.

Figure 5-89

•

Creating the meat shape

Draw the potatoes with the freehand tool using a gray line pattern.

.. Draw the gravy with the freehand tool using the sam e gray line and
fill pattern. See Figure 5-90.

196

Part II: Graphics

Figure 5-90

•
00 -T

Creating the mashed potatoes and gravy.

Draw the wedge of cornbread with the arc tool, and after it is drawn
fill it with a pattern.

,,. Use the Rotate command to help you position the cornbread on the
plate. See Figure 5-91.

Figure 5-91

The cornbread slice created with the arc tool

If you need to make a smaller "slice," reshape the arc using the Reshape
command.
Compare your finished drawing with the one shown in Figure 5-81.
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art III: Word Processing in roduces you to word processing on the
Macintosh.

Chapter 6 presents the basic concepts of word processing
applications. Chapter 7 introduces you to Microsoft Word, one of the
most sophisticated and widely used word processing applications on the
Macintosh. You will create several kinds of documents in this chapter,
including a menu and a newsletter, using Microsoft Word's desktop
publishing capabilities.
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Chapter 6: Word Processing Concepts
What You Will Learn in This Chapter
After readi ng th is ch apter, you will understand:
•

The four a reas of word processing: entering text, editing,
formatting, and printing

•

The computer definition of a paragraph

•

The concept of "word wrap"

•

The differences between using a typewriter and a word processor

•

The use of formatting to change t he appearance o f a document

•

The use of the search and replace feature

•

The use of a spelling checker and its limitations

W

ord processing is the process of using a computer to help
automate the p roduction of documents through text entry,
editing, formatting, and printing.

In its simplest fo rm, word p rocessing is similar to usi ng a typewriter.
Whatever you type on the keyboard is printed on the page. Using a word
processor is much easier tha n using a typewriter because changes to a
document are easier to make. You don't have to retype the en tire page
if you want to change a few words or paragraphs or if you want to change
the spacing or the margins.
As you produce a document on a typewriter, you must make quick,
irrevocable decisions about how you want the document to look. For
example, where will you end a line? If a word doesn't fit on a line, should
you hyphenate it, erase it and put it on the next line, or just h it the
margin release and hope you can cram the word in? How man y more
lines will fit on the page? If you type an incorrect lette r, should you erase
it, type over it, or ignore it? How can you fix a sentence in which you
left out a word?
Word processing relieves you of many of these worries and allows you
to concen trate on producing your best document. Basically four
processes are used in word processing to produce a document: entering
text, ed iting, formatti ng, and printing. The order in which these
processes are used is not fixed-you can en ter all the text and edit and
fo rmat later, o r format a nd edit as you enter the text, or use any order
that you choose. The projects in this section use a sequence of first
entering the text and then editing, formatting, and finally printing.
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ENTERING TEXT
Word processing always begins with basic text entry. But entering text
is different on a word processor than it is on a typewriter. A typewriter
commits each keystroke immediately to paper. A word processor
records what you type and shows it to you on the computer's screen.
Since most word processors include easy ways to ed it your text and
many include spelling checkers, you don't have to worry about typing
everything correctly. just start t yping. If you make m istakes, you can
correct them later.
When you create a document with a word processor and then save it on
your disk, you are saving it as a r le. A file is a collection of cha racters,
and that is actually what your document is. A document can consist of
any number of ch aracters, words, sentences, pa ragraphs, or pages-you
are limited only by the amount of storage space available on your d isk.
The terms file and document are ~nterchangeable in word p rocessing.
Another advantage of a word processor is that it relieves you of the worry
of h aving to decide if you can fit another word at the end of the current
lin e. With a typewriter the typist must keep track of the ma rgins-at the
end of a line you use the carriage return to advance to the next line. With
a word processor the program keeps track of the margi ns. If the word
doesn't fit on the line, the word processor wi ll automatically move the
word down to the next line. This process is called word wrap. Some word
processors even look up the word in a l1yphenation dictionmy, insert a
hyphen in t h e appropriate p lace, and put the rest of the word o n the
next line.
Word wrap is one of the main things that touch typists have to adjust
to when they are first learning to use a word p rocessor. When you enter
text, do not press the Return key at the end ofeach fine. Learn to press Return
on ly at the end of a paragraph. The computer meaning of a paragraph
is text that is followed by a hard carriage return (pressing Return). A
paragraph can consist of one or more characters, words, or sentences.
just as you don't have to think about where to end a line, you don 't have
tothinkaboutwhereto end a page. When you reach theendofthe page,
the word processor automatically adds a new page at the end of the
document; you just continue typing, and your new work is automatically
entered on this new page.
When you have a ll the text entered, you may discover m isspelled words,
grammatical errors, missing or extra words, or even paragraphs out of
place. These can all be easily corrected durin g another step in producing
yo ur document: editing.
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EDITING
Editing is the process of adding, deleting, and modifying the text that
you or someone else has entered. A word processor gives you tools that
h elp you correct and format your document.
If you left out a word, you can click the mouse at the point in the line
where the word belongs to set the insertion point and then type the
word. The computer moves all the text that follows this new word to the
right. When a word no longer fits at the end of the line, it wraps to the
next line, and the rest of the paragraph readjusts, or reformats,
automatically.

If you find a word that should not be in the document, you can select

the word and delete it. The paragraph will be reformatted automatically.
The words that follow move pack to the left, or even from one line to the
line above it, if there is room.
As with a typewriter, you can backspace to delete unwanted characters,
but that is the long way. The beauty of deleting with a word processor
is that you can select the word or words and just start typing over them.
You can be much more efficient with your time and avoid 'u nnecessary
steps.
For example, if a sentence (or paragraph, page, or section) doesn't say
what you want it to say, you can select that text and replace it by typing
new text. Any selected text will be deleted automatically when you type
new words. The paragraphs that are affected will be reformatted.
These are powerful editing features. Once you have used a word
processor you will probably never want to go back to using a typewriter.
Two more importanteditingfeaturesarecuttingandpasting. If a paragraph
would make more sense somewhere else in your document, you can
select that paragraph, cut it out of the document, indicate where you'd
like it to be placed, and paste it into your document at that location. The
word processor will relocate the text, close the gap that was created
when the text was removed, make room for the text where you paste it,
and automatically readjust all affected parts of the document. And you
don't have to retype the whole document!

Searching and Replacing
Very helpful in the editing process is the search and replace feature, which
allows you to search for a particular character or group of characters and
replace those characters with something else. For example, you can
search for a misspelled name such as Mr. Smith and replace all occurrences
of it with the correct spelling of Mr. Smythe. The search and replace
feature finds each occurrence in your document of whatever characters
(or words or groups of words) you are searching for and replaces those
characters with what you specify.
·
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You can even search for specific formatting characters, such as tabs and
spaces, and replace them withl other formatting ch aracters to help
automate word processing tasks.

Spell Checking
Also helpful in the editing process is having the spelling in a document
checked for you . Aspelling checkerdetermines if a word is spelled correctly
by comparing each word in a document with the entries in its dictionary.
If the word matches a dictionary entry, the spelling checker considers
the word correct. If the word is not in the dictionary, that word is
considered misspelled. Be aware, however, that all spelling checker
dictionaries have limitations. Microsoft Word's dictionary contains
about 130,000 entries, but, like most program-supplied dictionaries,
proper names, acronyms, and obscure terms are not included.
Don't depend on a spelling checker to do all your proofreading for you.
Spelling checkers only find words that they don't recognize. The word
it finds may be correct, but the spelling checker's dictionary doesn't
contain it. Or the word in the document may be wrong, but it is a legal
word. For instance, a spelling checker will know that "their" is spelled
correctly and won't be able to tell you that the word should be "there"
for a particular context. The spelling checker only knows correct
spelling, not correct usage. It doesn't know the difference between
"flower" and "flour," for example. Spell checking is not an automatic
process-it simply provides suggestions that the user needs to consider
before changing the word in question.
There are programs that check grammatical structure, but they are
beyond the scope of this book.

FORMATTING
Formatting a document involves determining how your pages will
appear when printed. You can decide to change the margins of the page;
change the font, size, and style of type throughout the whole document;
or change single characters or words in the document. You can use
multiple columns. Your document can be printed tall on the page like
the usual letter, which is called portrait orientation, or you can turn the
page sideways so the document prints out with the long side of the paper
being the top of the page, which is called landscape orientation.
Some of these decisions have al eady been made by the creators of the
word processing program. These preset selections are called defaults. They
have been previously set to the most common use for your convenience.
As you become more familiar with a program you can change some of
the settings to suit your work style and preferences.
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For instance, Microsoft Word will assume that you want a new document
to be printed vertically, to have l-inch top and bottom margins and
11/4-in ch left and right margins, to print in one column of text that is
6 inches wide, and to use New York font, set for 12-point size and
normal style.
If you don't do anything, Microsoft Word will use these settings.
However, if you want to print in three columns, with the page turned
sideways, using Times font in 10-point bold, you ca n easily do this.

Another example of a default setting is in Word's ruler. It is set to measure
in inches, but a designer may want to measure in picas. Word processors
usually allow you to change the defaults either for a single file or for the
program in general.
Default settings do not limit you. They are there to help your document
conform to conventional document formats and to h elp you get started
easily without havi ng to think about a lot of settings. The decision to
accept a default setting or to override it is entirely up to you. When you
become more proficient with Word, you can customize the program to
suit your preferences.

PRINTING
Printing your document involves getting the words on the paper. Once
you have entered, edited, formatted, and checked the text, you tell the
computer the correct type of printer to use. Then you tell the program
to print the document. The program sends the document to the printer.
This process is automatic whether the document is 1 page or, in the case
of this book, more than 700 pages.

SUMMARY
• Word processing is the process of using a computer to create documents through text entry,
editing, formatting, and printing.
• Text entry is the process of typing the text into a docu ment.
• Word wrap is the concept of the computer keeping track of the margins of a document.
• A paragraph is any character or gro up of characters that is followed by a h ard return (pressing
the Return key).
• A word processor is easier to use than a typewriter because a word processor allows you to
make changes to a document without having to retype it.
• The search and replace fea ture of a word processor locates every occurrence of a selected
character or group of characters in a document and replaces it with the character or group of
characters that you choose.
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• A spelling checker locates words in a document that do not match the entries in its dictionary.
It does not catch grammatical errors or misuse of words. It is not a replacement for
proofreading.
• Formatting refers to the appearance of the printed page.
• Page size, page orientation, margins, paragraph spacing, line spacing, and character formats
are all governed by the formatting capabilities of a word processor.
• Printing a document involves issuing a command to the word processing program to send
a document to a selected printer.

KEY TERMS
cutting
defaults
document
editing
file
formatting
hard carriage return, hard return
h yph en ation dictionary
landscape orientation

paragraph
pasting
portrait orientation
printing
reformat
ruler
search and replace
spelling checker
text entry
word processing
word wrap
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Chapter 7: Microsoft Word 4
What You Will Learn in This Chapter
After reading this chapter and completing the pro jects in it, you
should be able to:
•

Select, delete, and edit text

•

Change character formats of text

•

Move text

•

Use the Find and Change features

•

Check the spelling of a document

•

Format a paragraph

•

Format a document

•

Insert tabs, tab leaders, and borders

•

Add page numbers

•

Ad just margins

•

Save and print documents

•

Open multiple documents

•

Incorporate graphics and text

•

Create and apply styles

•

Create and modify tables

•

Create multicolumn documents using sections

•

Create headers and footers

•

Create print merge documents

ord processing is probably the most widely used application
on a microcomputer. If your creativity has been hindered by
writing with pencil and paper or by using a typewriter, you
will enjoy the benefits of using the Macintosh for word processing.

W

Like other Macintosh applications, Microsoft Word uses pull-down
menus, windows, a mouse, and many of the features you will encounter
throughout your use of the Macintosh.
Microsoft Word uses five formatting domains: the character, paragraph,
table, section, and document.
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The character is the smallest uni in the document. Characters consist
of letters of the alphabet, punctuation marks, numbers, and symbols.
Each character can be formatted individually, and groups of characters,
such as words and sentences, can be formatted in one operation.
A paragraph is a collection of characters that is followed by a hard return
(pressing the Return key). A paragraph can consist of just a few
characters, many sentences, or even a blank line. Any changes you make
to the paragraph formatting affect the entire paragraph that is selected
or that contains the insertion point. The character and paragraph are
the basic units in Microsoft Word. You'll have the opportunity to work
with many different character and paragraph formats throughout this
chapter.
A table, also called a cell table, consists of rows and columns of cells, and
each cell can contain characters and paragraphs that have different
formatting characteristics. You'll learn more about tables in Project 3 of
this chapter.
A section consists of one or more paragraphs and is followed by a section
marker. A document can be divided into many sections, and each
section can even be formatted with a different page layout, such as
different numbers of columns. Each document contains at least one
section. Project 4 in this chapter covers sections in detail.
The document is the largest unit, and it consists of the document itself.
When a document is form atted, all formatting pertains to the entire
document. Some examples of document formatting include page
margins and printing preparation.!You'll work with document formatting
at different times throughout th1s chapter.

STARTING MICROSOFT WORD
Starting Microsoft Word is just like starting the other applications
you've worked with-you locate the application's icon and double-click
on it.
Micr-osoft 'w'ord

•

Double-click on the Microsoft Word icon on your disk.

This will start Microsoft Word and open a new document entitled
"Untitledl".
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GETTING HELP
While you are wo rkin g in Microsoft Word, it is likely you'll want to m ake
use of the additional information sup plied in the o n line Help file. Th e
mate rial in the Help file is prese nted in concise, easily understood terms.
You can activate Help by ch oosing About Word from th e Apple menu
and then cl icking the Help button, or you can choose Help from the
Window menu. In either case, ass umi ng that th e Help file is presen t o n
the compute r and in the correct location, Word displays the Help
window, as sh own in Figure 7-1.
Help

.-~............~Jn
l"li crosoft Product Support
Agai n - re peati ng co mmands
Aligning and justifying text
Arithmetic
Borders
Canceling and undoing commands
Columns
Copying and moving text
Copying formats
Co unti ng text
Custo mizing the displ ay
Custo mizing menus and key assignments
Defaults
Deleting text and graphics
Documents: Cl osi ng
Converting
Creating

Figure 7-1

Help

)

:...... ( Cancel )

=

_

The Help wi ndow

You scroll through a list of topics that is o rganized alphabetically, and
select the topic you want to read about. Either double-click on the topic
name or click o nce to select the topic and t hen cl ick on the Help button.
When you've selected a topic, Word presents info rmation about that
topic.
When you are finished reading the information, you can either click the
Next button to continue getting help o r you ca n click the Previous
butto n to go back to the previous topic. When you are fi nished using
the Help window, you can close it by clicking its close box, o r click the
Cancel button. Either way, you are returned to where you left off in your
Microsoft Word documen t.
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In figure 7-2, the topic selecfed for additiona l information was
Formatting: Paragraph. The page number below the Next button
indi cates wh at page to reference in the program documentation for
greater d etail about that topic.
10

He lp

Formotllng: Porogroph
!!Contents...

About parOC)r>phs
Pareoraoh command ootions

To oet Indents, tabs, line spocinq, and other formats
affectlnq the appearance and position of a parOCJr>Ph,
use the Paragroph command ( format menu, full
men.,.), formatttnq keys,or the ruler. for more
information, see:
Hel! to~ic
Aligninq and justif!linq text
lndentlnq lines and parOC)raphs
Line and paragraph s pacinq
Ruler
~hnlll . nor•n ri!AI!.,•

Figure 7-2
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Reference l!age
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A Help topic selected

You can also get context-sensitive help on a specific command or option
without scrolling through th e list of available topics. To do this, press
Command-?, and your pointer turns in to a large question mark. When
you use th at questio n mark to select a command from one of the m enus,
to click an icon on the ruler, or to use a key sequence th at invokes a
command, the Help dialog box is presented displaying the relevan t
topic. This also works fo r getting help about an open dia log box.
With an extended keyboard-on e th at h as function keys, arrow and
directio n keys, and other keys-you can use the Help key on the
keyboard to get help and the Esc key to get out of Help.
For more information about using Help, select Using Help from the list
o f topics presented in the Help d ialog box.

SAVING YOUR WORK
Th e first time you save your document, Microsoft Word asks yo u, byway
of the d ia log box shown in Figure 7-3, wh ere you want your document
saved and what you want it to be named. After you h ave saved a
docum ent the first time, the n ext time you choose Save, Word assumes
that you want the document to be saved in the same place and under
the sa me na me. Be carefu l about saving your d ocument in the correct
place the first time you save it so you can find it later. Th e Save process
is much quicker the second and subsequent tim es, because you are not
prompted for any add itiona l information.
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Unfortunately, sometimes people are not careful, and they occasionally
lose their work because t hey saved it where they couldn't find it when
they needed it later. Clicking the Drive button repeatedly moves between
one or more floppy drives and hard drives, depending on the hardware
you are using. The Save dialog box shows the name of t he floppy disk
or hard drive as that drive is selected. Your document will be saved on
the selected disk or hard drive with the name showing in the Save d ialog
box. In the dialog box shown in Figure 7-3, the name of the disk,
Carolyn Phillips, is shown in two places. Always be aware of where you
are saving your work.
The Save As command is similar to the Save command, except that it
gives you the option to give your document a d ifferent name and save
it in a different location. Every time you choose Save As from the File
menu, you are prompted with the dialog box shown in Figure 7-3. This
is the same dialog box you see the first t ime you save your document.
When you use the Save As command and you attempt to save the
document with the same name and in the same location as before, you
will be asked if you want to replace the old document. This is because
no two files in a particular location can have the same name. If you wan t
to save different versions of the same document, use the Save As
command and give the document a different name and/or location.
Save your work often. Save at least every ten minutes, so you never lose
more than ten minutes of work. The Command-key equivalent of the
Save command, Command-S, is a helpful shortcut. Always save your
work before printing.
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Be aware that you can save a ocument before you actually type
anything into it, and that many people do it this way. However, you will
be given explicit instructions for saving your work at appropriate times
throughout the projects.

USING SHORT MENUS AND FULL MENUS
Microsoft Word provides two sets of menus: Short Menus and Full
Menus. Short Menus provides commands for routine word p rocessi ng
tasks and is intended to make the program less intimidating for
beginners. Full M enus allows you to make use of all the Short Menu
commands as well as of additional commands for more advanced word
processing tasks.
When Microsoft Word is in Short Menus mode, you'll see Full Menus
on the Edit menu. Also, when in Short Menus mode, there will not be
as many settings to choose from on the ruler. To switch to Full Menus
mode, choose Full Menus from the Edit menu. If Microsoft Word is in
Full Menus mode, you'll be able to choose Short Menus from the Edit
menu. In the projects in this chapter, you will be working in Full Menus
·
mode.

Project 1: Creating a Business Memorandum
In this first project you will produce a business memorandum. You will
enter text, set tabs o n the ruler, change several formatting characteristics,
add page numbers, and p rint your document.
As with all pro jects, read the entire project before starting. This will give
you an overview of what you will encoun ter and may save you the work
of having to backtrack if you make mistakes.
Figure 7-4 shows the completed memorandum.
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Acme Manufacturing, Inc.
12366 Coyote Lane
Dust Ring, OR 23366

MEMORANDUM

TO:
FROM:
DATE:
SUBJECT:

Larry Cassella, Eastern District Sales Manager
Karin ]ole, Vice President of Sales
July17, 1993
january through june Sales Report

Based on a compilation of your recently submitted sales reports, the
following shows the sales totals (in thousands of dollars) of our small parts
product line for the first half of the year:
Widgets
Gadgets
DooDads
Total

$746
$564
$395
$1,705

As yuu l:ctn see frum the figures, Widgets continue to be our top seller, and
Gadgets are moving along at the rate we expected. Although DooDads don't
seem to be selling too well, they are a seasonal product and we expect to
see rapid gains through late fall and into early winter.
Sales for the year closely match anticipated figures, and Widgets are
running about 10 percent above projections. I am happy with the
numbers at this point and feel our recent successes are due, in part, to the
current "Give It All You've Got" sales campaign that has been implemented
among the sales force.
In the most recent tally of this sales campaign, four of the eleven people in
your sales district are already eligible for the Las Vegas trip. Two others
are close to qualifying, and eight of the eleven have already won their
monogrammed Acme briefcases. I want you to congratulate these people
for me, Larry. I'll be speaking to them personally when we have the
district sales meeting in September.

1

Figure 7-4

Page 1 of the completed memora ndum
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Our President, S. W. Acme, has indicated to me that he is very pleased with
the results of this sales campaign. He made the following comment during
the recent sha reholders' meeting, and I am pleased to pass it on to you:
Our sales force is the backbone of our illdustry, and we now have tl1e best in the
history of Acme Manufacturing. These and women are dedicated workers, without
whom we could not be showing the profits that we are today.

I' m sure you'll make the President's remarks known to your sales staff,
Larry. I know your people are deserving of this praise.
To achieve projections on Gadgets we need to begin ou r promotions for the
fall. We can plan our television and magazine advertising strategies during
the sales projection meeting early next week. If you have any questions
prior to that, please call me.

2

Figure 7-4 (continued)

Page 2 of the completed memorandum
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TYPING IN THE TEXT
3€ -N

If you don't have a document window open, foll ow the instructions for
opening a n ew document under "Starting Microsoft Word" earlier in
this chapter.
In the upper left corner of the document window there is a vertical line
on the screen. This line flashes to draw your attention. It is called the
insertion point and shows the location where the next ch aracter you type
will appear. Since no text has bee n entered into this document, the
insertion point is at the top left corner of the text area on the page, as
shown in Figure 7-5.
'

j

File Edit

Format

Font

Document

Utilities

Window

Untitled I

Page 1

Figure 7-5

Norm II

The untitled document and the insertion point

Notice that the pointer changes sh ape when you move the mouse to
different parts of the screen. Whenever you move the mo use pointer
over the text area of the window, the pointer ch anges to thel-beam pointer.
This signifies to you that you are in a text editing a rea, and clicking the
mouse button while the pointer h as this shape will set the insertion
point to a new location.
•

Choose the font for the document. If you are using a LaserWriter,
choose Times and 14 point from the Font menu. If you are using an
ImageWriter New York is the default font, and that is fin e for this
project. Leave the font at the default values of 12 point and plain
text style if you are u sing an Image Writer.

There are two types of fonts: bitmapped fonts and laser fo nts. The
output device you will be printing to affects yo ur choice of fo nts because
a laser font will print best o n a LaserWriter, a nd, if you are using an
Image Writer, a bitmapped font will print best. In additio n, the printed
output will have the best quality if you ch oose a font size that is defined
in the System file. These defined sizes are called outline fonts and are
displayed in the size portion o f the Font menu in o utlined lettering.
Times is a laser font, and New York is a standard Image Writer bitmapped
font.

Chapter 7: Microsoft Word

213

At the start of each project in tqis chapter a LaserWriter font and an
lmageWriter font will be suggested for you to use. Base your choice on
the printer you will be using.
The example in this project uses the New York font .
You need to verify that you are using Full Menus. If you are using Full
Menus, Short Menus will be an option on the Edit menu. If Full Menus
shows on the Edit menu, select Full Menus.
•

Choose Edit in the menu bar and hold down the mouse button.

•

If Short Menus is showing at the bottom o f the Edit menu, release
the mouse button without making a selection from the menu.

If Full Menus is showing at the bottom o f the Edit menu, select Full
Menus.
Now you should be working in Full Menus mode, which is the mode
you' ll be using in all the projects in this chapter.
In th is pro ject you'll type the entire docum ent w ithout any special
form atting, and once it's typed you'llformatthe document. If you make
any err.o rs as you type, use the Backspace key (Delete key on some
keyboards) to remove the character or word and then retype it .
•

Type the following, pressing Return where indicated:
Acme Manufacturing, Inc. (press Return)
12366 Coyote Lane (press Return)
Dust Ring, OR 23366 (press Return three times)
Type MEMORANDUM in all caps, and then press Return three
times.

The first Return is to end the line, and the second and third are to create
two blank lines.
Now you'll type the memo heads, and you'll use the Tab key to separate
the heads from the names. You'll use th e default tab stops for now,
which are at half-inch intervals. Each time you press the Tab key, the
insertion point will move 1/2 inch to the right.
Don't worry about the names lining up at this point. Yo u'll change that
later.
•

Type TO: in all caps, and thel press the Tab key.

•

Type Larry Cassella, Eastern f istrict Sales Man ager, and th en press
Return.

•

Type FROM:, press the Tab key, and the n type Kari n ] ole, Vice
President of Sales. Press Return.

•

Type DATE:, press th e Tab key, and then type july 17, 1993. Press
Return.

Part III: Word Processing

214

••

Type SU BJECT:, press t he Tab key, and then type j a nua ry through
june Sa les Rep ort. Press Return three times, so that two blank lin es
are between the memo heads and th e body of the memo.

Your screen should n ow look like the one in Figure 7-6.
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Acme Manufacturing, Inc.
12366 Coyote Lane
Dust Ring, OR 23366
MEMORANDUM
TO:
Larry
FROM:
DATE:
SUBJECT:

Cassella, Eastern District Sales Manager
Kar in Jole, Vice President of Sales
July 17, 1993
January Ulrough June Sales Report

Page t

Figu re 7-6

JNorm al

The first part of the m emora ndum

It's a good idea to save your work at this point.

SAVING THE DOCUMENT
Be carefu l about saving your document in the correct place the first time
you save it so you can find it later. The Save process is much quicker th e
second and subsequent times, because you are not prompted for any
additional information.
Save your work often-save at least every ten m inu tes, so you never lose
m o re than ten minutes of work. The Command-key equivalent of the
Save command, Command-S, is a helpful sh o rtcut.
3€ -S

•

Choose Save from the File menu.

•

C lick the Drive button, if necessary, to switch drives until the name
of your data disk is showing at the top of the Save dialog box, where
Ca ro lyn Phillips is in Figure 7-7.
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Itg} Carolyn Phillips I
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The Save dialog box

, . Type Sales Report as the name of your document, and th en click the
Save button. See Figure 7-7.
Now you'll continue typing th e body o f the memo.
•

Type the first paragrap h o f the memo, allowing word wra p to move
the text onto the next line as the words reach the right ma rgin. Do
not press Return until you've ty ped the last word in the paragraph:
Based on a compilation of your recentl y submitted sales reports, the
following shows our sales totals (i n thousands of dollars) of our
small pa rts product lin e for the fi rs t half of the year:

Notice how, when a word doesn't fit o n the li ne, it drops to the n ext line
a utomatically. Word wra p e nables you to concentrate o n your typing
and not h ave to worry about the end of each line.
For th e next four lin es (the sales figu res), you'lluse the Tab key to type
the two columns of text. You'll form at the m properly when you 've
finished typing the m emorandum.
,,. Type Widgets, press the Tab key, and then type $746.
,,.

Ho ld down the Shift key whi.l e pressing Return.

The Shift-Retu rn combination is cal led a soft retum, because it causes t he
insertion point to m ove to the next line but does not start a new
paragraph. The n ext line you type will be considered part of the same
paragraph. The new-line command enables you to format all the lines
of a paragrap h by setting the insertion poi nt a nywhe re withi n one of the
lines and then selecting the desired formatting options. In this case, it
will make it easier to format the four lines in these tabbed columns since
you'll be able to work with them as one pa ragrap h. You'll see h ow-this
works in a few minutes.
.. Type Gadgets, press the Tab key, and then type $564. Press Shi ftReturn.
I
•

Type DooDads, press t h e Tabl key, and the n typ e $395. Press ShiftReturn.

.. Type Total, press the Tab key and then type $1,705. Press Return.
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If you scroll to see the last text that you typed, your screen should look
like the one shown in Figure 7-8.
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MEMORANDUM
TO:
Larry Cassella, Eastern District Sales Manager
FROM:
Karin Jole, Vice President of Sales
DATE:
July 17, 1993
SUBJECT:
January through June Sales Report
Based on a co!fipilation of your recently submitted sales reports, the
follo~ng sho'WS our sales totals (in thousands of dollars) of our small parts
product line for the first half of the year:
$746
Widgets
Gadgets
$564
booDa<:ls
$395
Total
$1,705
Page I

Figure 7-8

JNormol
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The tabbed columns

,,. Type the following three paragraphs, letting word wrap move the
words to the next line when they reach the right margin. Press
Return only at the end of each paragraph. Press the Return key only
once after you've finished typing each paragraph in the document.
You'll format the paragtaphs with a space between them later:
Sales for the year closely match anticipated figures, and Widgets are
running about 10 percent above projections. I am happy with the
numbers at this point and feel our recent successes are due, in part,
to the current "Give It All You've Got" sales campaign that has been
implemented among the sales force.
As you can see from the figures, Widgets continue to be our top
seller, and Gadget s are moving along at the rate we expected.
Although DooDads don't seem to be selling too well, they are a
seasonal product and we expect to see rapid gains through late fall
and into early winter.
In the most recent tally of this sales campaign, four of the eleven
people in your sales district arc already eligible for the Las Vegas trip.
Two others are close to qualifying, and eight of the eleven have
already won their monogrammed Acme briefcases. I want you to
congratulate these people for me, Larry. I'll be speaking to them
personally when we have our district sales meeting in September.
3€ -S

,.. Choose Save from th e File menu.
, . Type the following four paragraphs to complete the text entry of
your document:
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Our President, S. W. Acme, has indicated to me that he is very
pleased with the results of this sales campaign. He made the
following comment during the recent shareholders' meeting, and I
am pleased to pass it on to you:
"Our sales force is the backbone of our industry, and we now have
the best in the history of Acme Manufacturing. These men and
women are dedicated workers, without whom we could not be
showing the profits that we are today."
I'm sure you'll make the President's remarks known to your sales
staff, Larry. I know your people are deserving of this praise.
To achieve projections on Gadgets we need to begin our promotions
for the fall. We can plan our television and magazine advertising
strategies during our sales projection meeting early next week. If
you have any questions prior to that, please call me.
You've completed one phase of word processing: creating the document.
Now that you've typed the body of the letter, save your work again.
3€ -S

•

Choose Save from the File menu.

EDITING THE DOCUMENT
The next phase of word processing on this document is editing. Editing
covers a lot of area, but basically it means making sure the document
says what you want it to say and that it is error-free.
Show~ is a command that can be very useful when you are editing your
document.

Using Show 11/Hide 11
Every time you press a key on your keyboard, a character is inserted into
your document in that position. Pressing the Return key at the end of
a line is an instruction that tells the program to drop down one line and
go back to the left margin. Microsoft Word stores a paragraph's
formatting characteristics with the paragraph marker at the end of the
paragraph.
The space bar inserts an invisible character into the text, just like typing
one of the letter, number, or punctuation characters. The space is
invisible, but it is a real character, ~ike any other. The Tab key also causes
an invisible character to be placea in the document at the point where
the Tab key was pressed.
Using Show~ is a good way to see if you accidentally typed extra spaces
between words, and it lets you see how many blank lines you are
creating each time you press the Return key. You can tell how text is
formatted by using Show 1-for example, did a tab cause a particular
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indentation or was it set using the first-line indent setting of the ruler?
Show~ also gives you the abil ity to see and select certain characters in
your document that would otherwise be hidden.

:3€ - Y

,,. To see the hidden formatting characters in the text you've just
typed, choose Show <j[ from the Edit menu.

Your screen now shows ch aracters that you probably didn't realize you
had typed. Figure 7-9 shows an explanation of each character.
This symbol
represents where
the Tab key was
pressed.

Karin._Tole,. Vice.President.
July. 17,. 1993<Jf
E:+
SUBJECT:+ January.through.Jun .
:+

qr
qr
A dot is used to
represent where the
space bar was
pressed. It is similar
to a period but is
slightly above the
period on the line.

Bas .on .a.compilation.of.your.recen
o lowing .shovvs.our.sales.totals.(in.th
parts. product.line.for. the .first.half .of.
Widgets+ $7 46._.
Gadgets+ $564._.
DooDads+ $395._.
Total+
$1, 705<Jr
Figure 7-9

This symbol represents
where the Return key was
pressed (a hard return) and
is the symbol for the end of
a paragraph.
This is the symbol for a
soft return and is
produced by holding
down the Shift key when
pressing Return. It is
used when you want to
move to a new line but
want to keep the text part
of the same paragraph.

Viewing hidden formatting marks using S how ~

Many people choose to work with Show ~ on wh en ever they work in
Microsoft Word. Throughout this project and the others in this chapter,
you'll use th is option to enable you to see the different formatting
characters as you insert them and to make selecting those characters
easier when editing and formatting your document. These specia l
characters are visible on the screen only; they wi ll not print when you
print your docume nt.
To change back to the normal view, you choose Hide <jJ from the Edit
menu. The Show~ command isoneofthe menu commands that toggles
on and off. What appears on the menu is the opposite of what is in
effect-Hide <J[ won't be showing on the menu unless Show ~ is in effect.
See Figure 7-10.
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Selecting Text
Selecting a character, word, line, sentence, paragraph, or group of any of
these elemen ts points out to Microsoft Word t he text you want to work
with . There are several ways to select text in Microsoft Word:
•

Click t he 1-beam pointer to the left of the character, word, or line
you want to select, and then drag across the portion you want
selected. Selected text is highlighted. (This is also called wiping through

text.)
•

To select an en tire word, double-click on it.

•

To select an en tire sentence, ho ld down the Comma nd key and click
an ywhe re in the sentence.

•

The selection bar provides a means of selecting large blocks of text.
The selectio n bar is located a t the far left of the documen t a nd
appears to be a ma rgin about 1/ 8-inch wide. When you move the
1-beam pointe r into the selection bar, the I-beam changes to an
arrow tha t is pointing to the right. Figure 7-11 shows the pointer
whe n it is in the selectio n bar.

s

D
IAcm e.lvlanufacturing,. Inc:qJ
12 366 .Coy ote.Lane<lJ
Dust.Ring, .OR .. 2 3 3 6 6<lJ
qJ
qJ
~ ME1viORANDUM<lJ
qJ
Figure 7-11

The pointer in the selection bar
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•

To select an entire line using the selection bar, position the pointer
in the selection bar to the left of the line you want to select and click
the mouse button.

•

To select an entire paragraph using the selection bar, double-click in
the area to the left of the paragraph. The entire paragraph becomes
selected.

•

To select any number of lines, click and drag up or down in the
selection bar.

•

To select a larger portion of the document, click to indicate the
beginning of a selection, and then Shift-click to indicate the end of
the selection. The portion of the document that you marked for
selection will be highlighted.

•

To select an entire document, hold down the Command key and
click once in the selection bar (the arrow must be pointing in toward
the text).

Moving Text
The ability to move text or graphics from one place in a document to
another, or between documents, is convenient and time saving. To
move text, you must first select it using any of the methods described
above. By selecting, you indicate what text you want to move. After it
is selected, you cut the selected text from the document and copy it to
the Clipboard using the Cut command from the Edit menu. The
Clipboard is an area in computer memory that stores the most recently
copied or cut item .
Once the text is in the Clipboard, position your insertion point in the
document at the location the text should be moved to. Then the Paste
command places the text from the Clipboard into the document at the
insertion point.
:3€ -C

Copying works the same way as Cut, except you use the Copy command
from the Edit menu. Copy does not remove the text from the document
like the Cut command does, it just places a copy of the selected text in
the Clipboard for you to paste elsewhere in your document.
You'll move a paragraph in the Sales Report document now.
•

Select the paragraph beginning "As you can see from the figures",
which is near the middle of the Sales Report, by double-clicking
in the selection bar to the left of the paragraph, as shown in
Figure 7-12.
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Window
followmg shows our.sales.totals (in tbousands.of.dollars).of.our.small parts.
product-line. for the.flrst.half of tne year q
Wtdgets•
$746...
Gadgets•
$564...
DooDads•
$395"'
$1.705q
Total•
Sales for .the year c!OS(>Iy.match.anticipated.figures•.and. Widgets.are running
about. 1o.percent.above. projections... I .am.happy.with.tlle.numt>ers.at. this.
point.and feel our recent.success.are.due•.ln.part•. to.the.current.•Give.It.Ail.
You·ve.Got".sales.campalgn.that.has.t>een.implemented.among.tlle.sates.

Figure 7-12
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•

Selecting the paragraph to be moved

Wit h the paragraph selected, ch oose Cut from the Edit menu.

The selected paragraph is removed from the document and placed in the
Clipboard.
•

Cli ck to the left of th e first "Yord in th e pa ragraph b eginn ing "Sales
for the year" to set the insertion point in front of t h at paragraph.
Your screen sho uld look like the one in Figure 7-13 .

When you set the insertion point in fron t of the paragraph, the pointer
should not be in the selection bar, because that would cause the whole
li n e to be selected. You ca n tell if you ' re in the selection ba r- th e 1-beam
w ill change to an arrow if you are.
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following.shows.our .sates. totals.(in. thousands.of.dollars).of .our .small.parts.
product.line .for. the.first.half.of.the.year:<!!
Widgets+
$746....
Gadgets+
$564....
DooDads+ $395....
Total+
$1,705<11
!Sales. for. the. year .closely .match.anticipated.figures,.and. Widgets.are. running.
about. I 0. percent above. projections ... I .am.happy. with.the.numbers.at. this.
point.and.feet.our .recent.success.are.due,.in. part,. to. the.current. KGive. It. AU.
You've .Got• .sa!es.campaign.that.has.been. implemented .among. the .sales.
force.<!!
In.the.most.recent.tally .or. thls.sa.les.campalgn,.four .of. the.eleven.people. in. : i
your .sales.distnct.are.already .eligible.for. the. Las. Vegas.trip .. .Two.others.are. , ,
close.to.qualifying,.and.eightof.the .eleven.have.already.won. their .
monogrammed.Acme.briefcases.. . I.want.you.to.congratulate.these.people.for.
me,.Larry ... I'll.be.speaking.to.them.personally.When .we.have.our.district
sales.meeting.in.September.<i
Our

Figure 7-13
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Setting the inserti on point before m oving the text

Setting the insertio n poi nt indicates to Microsoft Word where you want
the tex t that you cut from the document to be pasted.
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,,. Ch oose Paste from the Edit m enu .
The paragraph t hat yo u cut shou ld n ow be pasted above wh ere you had
the insertion point, as shown in Figure 7-1 4.
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product.!lne.for. the.fi rst.half .of.the. year:<lf
Widgets + $746....
Gadgets +
$564....
DooDads + $395....
Total+
$1, 705'11
As. you.can.see.from .the.figures,. Widgets.continue. to.be.our.top.seller,.and.
Gadgets.are.moving.along.atthe .rate.we.expected ...Although.DooDads.don't.
seem .to. be.selling. too. well,. they .a re .a.seasonal .product. and.we.expect. to. see.
rapid.gains. through .late.fall .and.into.ear!y .Winter.<lf
jSales.for. the .year .closely .match.anticipated .figures, a nd. Widgets. are .running.
about. 10. percent .above.projections ... I .am.happy.With. the.numbers.at. this.
point.and.feel.our .recent.success.are.due,.in.par t,. to. the.current. "Give . It.All.
You've.Got".sales.campaign .that.has.been .implemented.among. the.sales.
force.<JJ
In. the.most.recent .tally .of.this.sales.campaign,.four .of.the.eleven.people .in.
your .sales.district.are.already .eligible.for .the. Las.Vegas. trip ...Two.others.are .
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Figure 7-14
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Th e paragraph after th e m ove

C h oose Sa ve from the File m enu to save th ese changes.

Searching and Replacing
Th ere m ay be times when yo u wan t to replace every occurren ce of a
word with a different word . If your d ocument is very lon g, this search
and replace p rocess could be a time-consuming task. Or m aybe yo u'd
just like to see each occurren ce o f the word to see if you've overused it,
or you want t o see each time it begins with a capital letter so you'll kn ow
h ow many sen te nces begin with th at wo rd. Microsoft Word gives you
the ability t o find characte rs, words, g roups of words, pun ctuation
m arks, o r formattin g ch aracters and to change the m to just about
anyth in g you want, using th e Find and Ch an ge commands.

Using the Find Command
The Find comman d is used to locate every occurren ce of a ch aracter o r
group o f characters. Both th e Find comman d and the C hange command
begin the search at t he insertion point. If you want to sea rch t he whole
document, it's easiest to set the insertio n p o int in fron t of the first word
in the document. If you do n't, whe n the search reach es th e end of the
document, a dialog box will ask you if you want to continue searching
fro m the beginning of t he doc ument.

:3€ - F ,,.
•

Cli ck to t he left o f the first word in the d ocu me nt, "Acm e", to set the
insertion poin t t here.
Choose Find fro m the Utilities menu .
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The dialog box tha t results is sh ow n in f-igure 7-1 5.
rind
Find Who I:

181 Whole

II~=-------~--~I

Word

181 M a tch Upp er / Lowercose

UStort Sean h JJ [ Cancel J
F~gure

7-15

The Find dialog box

The Find What box is wh ere you type the characters or words you wan t
to find . Let's see if the word "our" has been used too often in thi s letter.
•

Type o u r in the fi n d What box.

Two o ption s in this dialog box help you nar row the specific words to
fi nd: the W hole Word and Matc h Upper/ Lowercase options.
W hen you select the Whole Word optio n, Microsoft Word finds only
wo rds that stand o n thei r own , those that are preceded and followed by
a space. For exa mple, if you told Word to find every occurrence of the
wo rd "the" wi tho ut selecting the Whole Word o ptio n, it would find a ny
wo rds that had "the" anywhere in them-othe r, leathe r, theate r, and so
on. W he n you're looking fo r a specific wo rd, use t he W hole Word
option. The Whole Word optio n is the default set ting for the Fi nd dialog
box; yours sh o uld have an "x" in th e box to t he left of Whole Word. For
the search you're abou t to make you want the Whol e Word option
selected.
The Ma tc h Upper/ Lo wercase option a llows yo u to specify that you are
looking for words t hat are ca pitalized (or not) in a certain way.
Capitalizing the first letter of the wo rd in the Find What box and using
the Match Upper/Lowercase optio n will h elp you find words that begin
sentences, for example. The Match Upper/ Lowercase optio n is the
default setting fo r the Find dialog box. For the sea rch that you are about
to make you wa nt to find all occurren ces of the word "o ur", so you do
not wan t th e Match Upper/ Lowercase o ption se lected.

Return or Enter

•

Click Match Upper/Lowercase to dese lect that o ption (re move the
"x" from t he box to its left).

•

Click the Start Search button.

If a match is found, Microsoft Word highlights the wo rd in the
documen t and stops.
The first occurrence of "our" is in the fi rst paragra ph, as shown in
Figure 7-1 6.

224

Part Ill: Word Processing

'

415

File

Edit

Form at

Font

Document

utilities

Window

Sol es Report
rollowing.shows.B'!I!.sales.totals.(in.thousands.of.doUars).of.our.smaJI.parts.
product Une.ror.the ftrst .balf.of.the.year,q
$7'16 ...
Widgets+
Gadgets+
$564 ...
DooDads+
$395...
$1,705<1!
Total+
As.you.can .see.from .the. figur es,. Wi dgets.con tinue. to. be.our.top .seller ,.and.
Gadgets.are.moving.aJong.at.the.rate.we.expected...Aithough.DooDads.don't.
seem. to.be .selling.too. weu,.they.are.a. seasonal.product.and .we .expect. to.see.
rapid.gains.throu gh.late.rau.an d.into.early.winter.<i
Sales.ror .the.y 10
.ar e.r unning.
Find
about. 1o.per c
r s.at.this.
point.and.feel. Find What: l our
"Give. lt.AU.
You've.Got".Sal 181 Whole Wor d 0 Match Upper/ lowercase e.Sales.
force.<i
In.th& most .r e< (( Find NeHt
[Cancel )
.poople.in.
your.sales.dis
:.o
.0
.other s.are.
•
close.to.QuaJHyinJ!:,.and .eiRht.of.the.eleven.have.alread y .won. their.

I

)j

Figure 7-16

Return or Enter

Find ing the firs t occurrence of "our"

•

Click the Find Next button to find the next occurrence of "our."

•

Continue to click the Find Next button after each occu rrence of
"our" is found.

•

When the "End of document reached" message is shown, click O K
to that box, a nd the n click the Can cel button in the find dia log box.

There were many (11, to be exact) occurren ces of "our" in the document,
and it would sou nd bette r if some of them were changed to "the". You'll
use the Change command for that operation . Using the Find command
to coun t each occurre nce of a word to determine if the word is overused
is a good h abit. Now that thi s exercise h as given you the oppo rtunity
to see how the Find command works, yo u'll be able to see more clearly
how the Find command differs from the Change command .

Using the Change Command
The Change command is similar to the Find command. You specify the
group of characters you wa nt changed, and th en yo u specify what you
want them cha nged to.

~ - J-1

•

Since you wan t th e sea rch to start at the beginning of th e documen t,
click to the left of the first word in th e document to set the insertion
point there.

•

Choose Change from th e Utilities menu.

The d ialog box tha t results is shown in Figure 7-17. Notice t hat in the
find What box is the word "our", which you were searching fo r in the
Find operatio n. Th e Find and Change dialog boxes share the Find What
box, so that when you searc h for a word in a Find operation you don't
have to retype it in a subseq uen t Change operation.
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Find Wha t:
Change To:

181 Whole Word 0 Match Upper/ Lowercase

n

St art Search a ~

Figur e 7-17

[

Change Hll

J~

The Ch an ge dialog box

You' ll recognize the Who le Word and Match Upper/ Lowercase options
from the Find d ialog box. These options work the sa me as they d id in
the Fi nd dialog box, and their settings also ca rry over from the Find
dialog box to the Change dialog box.
•

Click in the Change To box, and type the.

There are th ree buttons at the bottom of the d ialog box. The Start Search
button causes the sea rch to begin, and you determine what action to
take when each occurrence of the group of characters is found. You
verify whether a group of characters is to be changed.
The Change All button changes all occurrences of the characters
without h aving you verify each occurrence. Use this button instead of
the Sta rt Search button if you are sure you want all occurrences changed
and don' t need to verify each change.
The Cancel button cancels the Change operation.
Return or Enter

•

Click the Start Search button.

Th e first occurrence of the word "our" is found in the first paragraph.
The Change dialog box looks like the one sh own in Figure 7-18.
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Gadgets.are.moving.along.a t.lhe.rate.we.expected...Although.DooDads.don't.
seem.to.be.selllng.too well,.they.are .a.seasonat.product.and.we.expect.to.see.

rapid for.tl!
gainM~go~~!ii~~~~~~~~~~~~~ running.
Sales
about. t o. Find Whet:
t.this.
point and
e ft. AU.
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Figure 7-18

Changing the first occurrence of "our"
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You click the Change button to replace the selected characters with the
characters in the Change To box, or you click the No Change button to
leave the selected characters unchanged. Whether you click Change or
No Change, the search continues to the next occurrence of the characters
in the document. The Change Selection button allows you to change
just the selected text, and the Change dialog box stays on the screen .
Yo u can then enter a new Find What o r Change To group of characters
and start ano ther search.
"• Click the Change button so that the first occurrence of "our" is
changed to "the" in the first paragraph .
, . Click the No Change butto n so the second occurrence of "our" in
the first paragraph is left unchanged .
•

Click the No Change button to each occurrence of "our" in the
second and th ird paragraphs.

•

In the fo urth pa ragraph, click the Change button to change the
word "our" in the last sentence so that it reads "I'll be speaking to
them personally when we have the district sales meeting in
September. "

•

Click the No Change button for each occurrence of "our" in all but
the last paragraph of the document.

,. In the last paragraph, click the No Change button to the first
occurrence of the word "o ur" in the second sentence.
•

Click the Change button so that the second occurrence of "our" in
the second sentence is ch anged to "the". The sentence sh ould now
read: "We can plan our television and m agazine advertising
strategies d uring the sales projectio n meeting early next week."

•

When you get the "End of document reached" message, click the OK
button, and then click the Cancel button in the Change dialog box
to end the operatio n.

You should have made a total of three changes in that operation .
:3€ -S

•

Save your work by choosing Save from the File menu.

You can also use the Find and Chan ge utilities to locate special
formatting characters, such as paragraph marks and tabs. When you are
searching for these characters, the caret (") precedes the letter that
represents the character. For example, to search fo r a tab mark you
would enter " tin the Find What box. You can search fo r a paragraph
mark using " p. For a list of special formatting characters that you can
search for, see Reference to Microsoft Word.
You learned how to find and change specific words in your document
using the Find and Change utilities. Next you'lllearn to use the spelling
checker to fi nd and change words that you don't usually realize are in
your document.
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Using the Spelling Checker

Microsoft Word's spelling checker is an invaluable tool for editing your
document, because it helps you locate and correct m isspelled words,
including those with typographical errors.
When using the spelling checker, Microsoft Word begins checking your
document at the insertion point. To ch eck the entire document withou t
interruptio n, yo u must set the insertion poi n t before the first word in
the docume nt. If you don' t do this, Microsoft Word will check from the
insertion point to the end of the file and then ask you if you'd like to
continue ch ecking from the beginning of the document.
If you already have a word selected and then you run a spelling check,
Microsoft Word only checks the selected word . This is handy if you've
al ready checked the entire document and just have an added word or
paragrap h to check. In that case, you select the word or paragraph before
running th e spelling ch eck and the selection is the only portion of the
document ch ecked.

~ -L

•

Use the scroll ba r to scroll backward in the docum ent to the first line
and click to the left of the line beginning with "Acme Manufacturing".

,.

Choose Spell ing from the Utilities menu.

The dialog box shown in Figure 7-19 will result.

m

Spelling

Words:

~

I

Unknown Wor d:
Chonge To:

Open Dlctlonories:
MS Dictionary
User 1

II

~

In

1088

18J ignore Words In All Caps

~

stort Check

~ [c hongt)J [Sugtjl)st)

[ Cancel]

Figure 7-19 The Spelling dialog box
The Ignore Words in All Caps option allows you to bypass any words
written in all capita l letters. This is h elpful if your document contains
ma ny acron yms, which are formed from the first letters o f several
words-for example, AM, PM, IRS. Spell ing checker dictionaries do not
usually contain acronyms. The default setting for this option is on, as
you can see by the "x" in the box to its left. Leave this option selected
when checking the Sales Report document.
Return or Enter

•

To begin the spelling ch eck, click Start Check, or press Return
(because Start Check is the default choice).

The first unknown word the spellin g checker finds is "Cassella," as
shown in Figure 7-20. Notice that this word is highlighted in the
docume nt. Although this word is not misspelled, it is common for
spelling ch ecker di ctio naries to omit proper n am es.
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Figure 7-20

~

r,.and.
s.don't.
ct.to.see.
.running.

An unknown word found in the document

Severa l options are ava ilable w hen M icrosoft Word finds an unknown
word (one that is not in its dictionary): You can type the word that you'd
like the highlighted word in your document to be ch anged to in the
Ch ange To box and t hen click the Change button. This will replace the
highlighted word in your document with the word you typed.
Another ch o ice is t h at you can click th e No Change button , which
indicates to Microsoft Word that you wan t to leave the word in question
unchanged and move on.
You ca n click the Suggest button. This indicates that you 'd like Microsoft
Word to search through its dictionary and presen t one or more words
that you may be trying to spell. If the spell checker is able to suggest any
alternatives, a list o f those words will appear in the Words portion of the
dialog box, and the first word on the list will appear in the Change To
field, as shown in Figure 7-21.
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Figure 7-21
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You can scroll through the list of suggested words a nd select a word
you'd like by clicking on that word and then clicking the Change
butto n o r pressing Return . The selected alternative word will replace the
word in your document that the spell checker identi fied as unknown.
If n one of the words that were suggested will fit the word in question,
as in this case, click the No Change button.
You could also add this unique word to the User 1 dictionary by clicking
the plus button. Word will then consider it a correct spelling in the
future.
•

Click the No Change button.

Microsoft Word continues ch ecking the document and presents each
unkn own word. This allows you to verify each word as it is located.
When the entire document is checked, a dialog box will appear to
indicate the end of the document was reached. Click OK in this box to
end the spelling session .
•

Finish ch eckingyourdocument for unknown words, making changes
wh ere appropriate.

, . When the "End of document reached" message is sh own on your
screen, click OK, which can cels the spelling session.
~ -S

,,,. Save your document when you are finish ed usi ng the spelling
checker.
Remember to proofread for incorrectly placed words and o ther grammar
problems that a spell ing ch ecker cannot catch.

FORMATTING TEXT
Now that your document is spell-checked and says what you want it to
say, the n ext step is to make it look good on the page.

Changing Character and Paragraph Formatting
The basic formatting units used in Microsoft Word are the character and
the paragraph.
Th e ch aracter is the sm allest unit in Microsoft Word. formatting
characters can involve cha nging the font, or typeface, and point size. You
can also ch ange the character attributes to bold, italic, underl ine, and
more. The position of the character on the baseline, where the botto m
edge of the characters in that font normally line up, can be changed to
create superscript and subscrip~ characters. You can also stretch o r
sh ri nk the space between charaoters.
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These are some examples of character forma tting:
Th is is Times 10 poi nt size.
Th is is Times J2 point size.
This is bold, italic, underlined, shadow.
This is superscri pt, this is su bscnp
. t.
This is condensed, this is expanded.
To change the formatting of a character or an y group of characters, u p
to and including the entire document, you must first select the characters
you wa n t to c hange. Th en you choose the attribute you wish to ch ange
to. You can also set the character formatting before typing. If no text
is selected when you choose a ch aracter format, then wh atever you type
at the insertion point will have the formatting ch aracteristics you ch ose.
Character formats are changed using the Character command, wh ich is
on the format menu, although some more commonly used formats can
be accessed directly fro m t he Format menu. Fonts and font sizes can be
accessed either fro m the Font menu or byusingthe Character command.
Some other formatting options apply only to paragraphs. A pa ragraph
is a collectio n of characters that precede a paragraph mark or hard
return, which you get when you press the Return key. A paragraph can
consist of one character, o ne word, many senten ces, o r even a blank line.
You can apply cha racter formats to entire paragraphs (as long as the
paragraph is selected), but you cannot apply pa ragraph formats to
ch aracters within a paragraph-paragraph formatting will affect the
entire pa ragra ph and not just the selected characters.
Some formatting options that apply only to paragraphs are indents,
tabs, line spacing, borders, and alignment. To apply formatting to a
pa ragraph, you do not need to select the paragraph so that it is
highlighted, as you do when applying character formats. Placing the
insertion point in a paragraph indicates the paragraph that the formatting
will affect. The ruler also reflects the curren t settings for the paragraph
that contains the insertion point. If th e pa ragraph formatting is to affect
more than o n e paragraph, you must select (highlight) all paragraphs
you wish to format. Paragraph formatting can apply to the entire
documen t, just as ch aracter formatting can, but the entire document
must be selected first .
You'll do most of the character forma tting first, and then you'll change
the paragraph formatting .
.- Scro ll to the beginning of the document and select the first line
by clicking in the se lection bar to the left of that line, as shown in
Figure 7-22.
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Figure 7-22
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Selecting the first line in the document

,... Choose Character from the Format menu.
The Character dialog box h as additio nal character formats that aren't
available on the Format menu. This dialog box also allows you to set
many characteristics at the sa me time rather than each one separately.
If you click and hold down the m ouse button in the arrow to the right
of any of the drop-down fi elds, a list of available formats is shown.
figure 7-23 sh ows the available underline formats.
Character
Font:
New York

Size:

I

Underline:
None

!OI I•• IIQJ
Col or:

I(.',

~None

Singl e
Word
Double
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IBl ack

n

I J)
OK
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!OI [ Rpply )

Position
@ Normol
By:
0 Superscri pt
0 Subscript

r-·

I

t W• >• ouu~

0 Strlkethru
OSmall Caps
0 Rll Cops
O Hidden

Figure 7-23

Spoci ng
®Normal
0 Condensed
0 EHpanded

By:

L___.l

Available underline formats

., . In the Character dialog box Sty le section, click Bold and Italic, as
shown in Figure 7-24.
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Ch aracter
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Figure 7-24

Return or Enter

(c::EJ

By:

L l

~

Se tting bold and italic character fo rm ats

Click OK.

The first line of the document is now bold and italic. Next you'll make
th at lin e h ave a larger point size than the rest of the document.
Although you could have changed the point size in the Characte r dialog
box, you probably won't use that method as often as simply selecting
th e desired size from the Font menu, as you'll do now.
•

With the sa me line still selected, choose 18 point from the Font
m enu.

If yo u don'L have Lhal particular point size installed in your system, use

any size la rger than 12 point.
The fi rst line of your document sh ould look similar to the o n e shown in
Figure 7-25.

'Acme Manufacturing, lnc:t
12366.Coyow . I.ane'l
Dust. Ring, OR.. 23366'1
q
q
MEMORANDUM'I
q
q
TO:+ Larry.Cassella,.Easwrn.District.Sales.Manager'l
FROM:+
Karln.Jole, Vlce.Presldent.or.Sates'l
DATE:+
)uty . l 7,. 1993<11
SUBJECT:+ j anuary.through.j une. Sates.Report<ll
<II
<II
8ased.on.a.compllaUon.ot .your.recenUy.submltted.sates.repor ts,.the.
tollowtng shows the sates. totals (m.thousands.or.dollar s) of our small.parts.
pr oduct.line tor the nrst.hatt ot .the.year.<ll

Figure 7-25

The first line- bold, italic, and 18 point
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The next two lines of the address will be formatted bold. You'll use the
Bold command in the Format menu to do this.
•
~

Select the two address lines at the top of the document. Be sure that
you don't include the first line, which you already formatted.

-Sh ift-B ·•

Choose Bold from the Format menu.

Next you'll use the ruler to change alignment of these lines.
~-R

•

Choose Show Ruler from the Format menu.

Using the Ruler
One of the most important parts of the Microsoft Word window is the
ruler, which is located at the top of the window, just below the title bar.
The default setting in Microsoft Word opens the window without the
ruler showing. To show the ruler on the screen, choose Show Ruler from
the Format menu. This is another menu item that toggles-if you do not
need to view the ruler, choose Hide Ruler from the Format menu.
The ruler contains controls that allow you to change much of the
paragraph formatting of your docume nt. It allows you to easily set text
alignment, line spacing, tab stops, and margins. With Microsoft Word you
can format each paragraph using different ruler settings.
Figure 7-26 shows the ruler, and the following sections describe some of
the controls and what they do.
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Line-spacing icons

Figure 7-26

\ lf

The Microsoft Word ruler

Let's discuss each of these controls and, where appropriate, you'll see
samples of how the settings affe'ct the text.
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Alignment Controls
[§!II I

=I I -1 I

I

Th ese four controls provide si m pie ways to set the alignment of an entire
text block, wh ether it is a paragraph or an enti re document. Alignm ent
re fers to t he way t h e lin es of text are placed between the left and right
margins. justification means th at the text is a ligned with both the left
and right m argins. In justified text, Microsoft Word places spaces
between th e words in a line to help t he text li ne up evenly at the left and
right m argins. Notice that th e text in each of th e followin g definitions
mimics the result you will get with tha t setting.
1=- I

This setting m akes the text left-aligned and
ragged o n the right. Th is is a lso called flus h
left. All of th e block will be aligned on its left
side but will not be justi fied o n the righ t.

I= I

This setting align s the text b lock by cen tering
each line between the margins. Th e left
and right sides will be uneven , un less the
lines a re exactl y the same length.

I -1

This setting aligns the text block at the
right ma rgin. This alignment is a lso call ed
flush right. As each line fills u p, the text
moves to t he left w h ile you type. When a
word can 't fit, it is dropped to the next line
on t he far righ t side of th e line.

I

I

This sett ing is for justified text. Both t he left and
the right sides of the text a re even . j ustified text
often h as w ide spaces between words, but
h yphenating can minimize th is problem.

Th e three lines that you just formatted, along with th e Memorandum
li ne, need to be centered on t he page. You' ll use the cen ter-align ment
setting on the ruler to accomplish this.
•

Select the lines down th rough the line containing the word
"Memo randum," as sh own in Figure 7-27.
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Selecting the lines to be centered

Click t he center-alignment icon on the ruler.

All the lines that were selected auto matically become centered between
the margins on the page.
Line Spacing

These controls affect the vertical spacing between lines of text. Notice
that the text for each definition mimics the result you will get.
1=1

This control sets single-spacing. 12-point text is
spaced at 6 lines per inch.

1=1

This control sets 1-1/2-line spacing. 12-point
text is spaced as if it were 18-point text, resulting
in 4 lines per inch . An extra half line-space is
placed between each line of text.

1=1

This sets double-spacing. 12-point text is spaced
as if it were 24 points high, resulting in 3 lines
per inch.

An extra full line-space is placed

between each line of text.
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Indent Controls

10

L

..

~

There are three indentation controls: first line, left, and right.
control the w idths and positions of lines o f text.

!Nor mal

llo..

They

The first-line indent controls the beginning position o f
the first line of text. In the picture to the left, the first
line of each pa ragraph is in dented 1/4 inch from the left
margin, which is represen ted by t he lower left tria ngle.
In Microsoft Word, you use the indent controls instead
of spaces or tabs for first-line paragrap h indents.

,..

The left indent controls whe re the text (other than the
first line of a paragraph) is positioned with respect to t he
left margin .

~

Th e right inde11tcontrols the location of text with respect
to the righ t margin. This control affects all lines of the
paragraph, even the first.

The paragraph that consists of four lines w ith the sales total for each
product needs to be inde nted by 1/2 inch from the left margin. You'll
use the indent controls o n the ruler to do that n ow.
•

Click an ywhere within th e line tha t reads "Widgets

$746."

When typing these four lines you did n ot press Return at the end of each
li ne, but instead yo u used the Shift-Re turn key com bination to go to a
n ew li ne. This kept you typing with in t he same paragraph , bu t on a
d ifferent line within that paragraph. When yo u click within any of the
fo u r lines of th is paragra ph, the form atting changes you make with the
ruler will affect the entire paragraph-all fou r lines. You'll see how this
works now.
,,. Place t he point of the arrow on the left indent marke r on the ru ler
and drag to the 1/2-in ch mark on the rule r. The first-line indent
marker moves w ith the left indent m arke r, as shown in Figure 7-28.

,..

0

•

10

File

H

INorrnal..,
Figure 7-28

•

Edit

Format

..11

..

•liD

't

F

J2
.
1'

.1'

Moving the left indent marker

When the ma rker is positioned o n the ruler, release the mouse
button.

All fou r lines in the selected paragraph are now indented 1/2 inch from
the left margin, as shown in Figure 7-29 .
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TO:+ Larry .cassella,.Eastern.District. Sales.Manager<!l
FROM:+
Karin.Jole,.Vice.President.of.Sales<!l
DATE:+
July. 17,. 1993<11
SUBJECT:+ january.through. june. Sales.Report<!l
<j[
<j[

Based .on.a.compilation .of. your .recently .su bmitted.sales reports,.the.
following.shows. the.sales totals. (in.thousands.of .dollars ).of .our .small. parts.

75 0

produc;~d~~~:-tlle$$.ri~s~~a!f.of.the .year:<!l

!i!'i'

Ga gets+
..,
DooDads + $395..,
Total +
$1, 705<11
As.you.can.see.from.the.figures,. Wiqgets.continue. to. be.our. top.seller ,.and.
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The lines indented 1/2 inch from the left margin

Tab Settings

n

t

j'

t.

Tab settings control how a column of informatio n w ill align in p resent
and succeeding rows. Each paragrap h in Microsoft Word can h ave a
different ruler. When you set the tab stops they control the current line
and all succeedi ng lines, until you cha nge o r remove tab settings.
·t

A left-aligned tab m ea?s th at the information in the
colu mn below t his tab a ligns with the left end of the
fi rst word in the column.
A center tab centers items in t he column below it.
A right-aligned tab means that the information in the
colu mn below t he tab w ill align with the right end of
the last word in the colu mn

l.

A decimal-aligned tab formats the column below it so
that all items line up at the decimal point. You can
then enter a column o f numbers and have all the
decimal points properly aligned , even wh en n o
deci mal is actually typed.
This is n ot really a tab control, but a drawing tool that
e nables yo u to place a vertica l li ne in your docum en t
corresponding to the tool's position on the rule r. The
vertica l line con tinuek down the page through each
paragrap h th at is foqruatted with t he vertica l-l ine
tool on its ruler. You
not have to press th e Tab key
o r a ny other character to create the line. This is one
way to create column separators in tabbed columns.

90
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Th ese tab setti ngs have the fol lowing effects on text (see Figu re 7-30):
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This is the left edge of the text. The margin extends all the way to
the 6-inch mark, where the text will then wrap back to the left
edge. The tabs cause the following alignment patterns for the
information entered in the columns. (Notice the line in the center of
the columns. This is the result of placing the vertical line marker on
the ruler for those paragraphs.)
This column
In this
This column $232,222 .78
- 12.223
is aligned by
column each is aligned by
the first letter
line is
the last letter
735.10
in the first
centered.
in the last
.2232
word on each
word on each
23423
line.
line.
(2,239.72~

I
INormal+ ...

Page I

Sa mples of different types of tab stops

Figure 7-30

Whe n you typed your document you pressed the Tab key to separate the
"To," "From," "Su bject," a nd "Date" fro m the text that fo llowed those
wo rds. Now you' ll use the tab settings to set a tab stop for those lines.
.. . Select th e fou r lines in th e memo head, as shown in Figure 7-31.
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Figure 7-31
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Selecting the memo heads

Click on the left-aligned tab ma rker on the rule r, and then click just
below the 1-1 /4-inch m ark on the rule r. See Figure 7-32.
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Selecting and positio ning the tab on the ruler

This causes a tab stop to be p laced in th at posi tion on the rul er for the
selected paragraphs. A tab stop controls the position of the text that was
t yped after the Tab key was pressed.
Notice that the text to the right of the tab ma rk in the line is n ow align ed
at 1-1/4-inch on the ruler in all four lines th at were selected. You can
a lso d rag the tab to w he re you want it on th e ruler if yo u want to make
adjustments later.
Using the tab settings is the only way to a li gn column s of text or
numbers. Merely spacing the sam e num ber of ti mes bet ween columns,
as is sometimes don e o n a typ ewriter, will n o t work, even though o n the
screen the text looks align ed. Wh en printed , the column s will be jagged
a nd will n ot align w ith on e another.
Th ere's a good reason fo r this- most Macin tosh fonts are proportional
fo nts. This m eans that th e wider ch aracters, such as th e up percase M,
ta ke up more space o n a line than the n arrower characters, such as the
lowercase i. Monospace fonts, however, con sist of ch aracters that are
evenly spaced on the screen an d wh en printed . Most typewriters use
mo nospace fonts, w hich is why you ca n sometimes get away wit h
spacing the same number of t im es between columns to line up text. But
it just doesn't work that way on a Macintosh, unless you a re usin g a
mo nospace font such as Monaco o r Courier.
In the second paragraph o f t he body of the mem o you also used tabs to
separate colum n s. You already changed the left indentation of this
paragra ph, and n ow yo u'll set up a deci ma l tab stop to align the column
of numbers.

-t-.

•

Click anywhere w it hin th e line that reads "Widgets

•

Click on the d ecimal ta b marker o n the ruler, and then click just
below th e 2-1/2-in ch mark on the ruler. See Figure 7-33 .
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Setting a decimal tab stop

The numbers shou ld align on .Je tab sto p, as shown in figure 7-34.
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TO:+
Lar ry .Cassella,.Eastern .District.Sales. Manager<!l
Karin.Jole,. Vice .Presiden t.of . Sales<!l
FROM:+
DATE:+
july. 17,. 1993<!1
January.through.June. Sales .Report<!l
SUBJECT:+
qr
qr
Based. on .a .compilation .of .your .r ecently.submit ted .sales.reports,.the.
following.sllows.the.sales .totals. (in .thousands.of .dollars).of .our .small.par ts.
product .line.for .the. first.half .of.the.year:<R

rom.
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to.be.our.top.seller,.and.
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Th e documen t formatted with tab sto ps

Figure 7-34
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Save these c han ges by c hoosing Save from t he File m enu .

Th e nex t fo rmatting you' ll ch ange in the document is the spacin g
bet ween paragraphs.

Paragraph Spacing
e

1::::::::1

Paragraph-spacing setti11gs control the amo u nt o f space between
paragraph s.
1~1

This setting causes paragraph s to be separated
by the sam e am ount o f space as that between
lines in the paragraph.

1::::::::1

Th is setting places 12 points of extra space
bet ween paragraphs.

The body of th e m em o n eeds to have spaces between paragrap h s. You'll
select those paragraphs a nd then use the pa ragra ph-spacing icon to
place t he space between paragraph s.
•

Click to the left of th e li ne beginning "Based on a compil atio n ", t he
first paragrap h below the m emo h eads, to set the insertio n point to
the left of the "B".

•

Use the vertical scroll bar to positi on the last paragra ph of the
documen t on the screen .

•

Hold down the Shift key while clicking after the last cha racter in the
docu men t.

The body o f the docu m ent, be low the memo heads, sh ould now be
selected . This Shih-elick m ethod of selecting is useful when you are
se lec ti ng large blocks o f text.
3C -Sh ift-0 1::::::::1 •

With the text st ill selected, cl ick on the space-between-paragraph s
ico n o n the ruler.

241

Chapter 7: Microsoft W ord

Now th e body of the m emo h as extra space after each paragraph, as
shown in Figure 7-35.

the.recent.shareholders' .meetlng,.and. I .am.pleased. to. pass.it.on .to. you:<!!
· our.sales.force.is.the.back.bone.of.o1fr.industry,.and.we.now.have.the.best. .
in. the. history .of .Acme.Manufacturing ... These.men.and. women.are.dedicated. :
work.ers,.without.Whom.we.could.not.be.showing.the.profits.that.we.ar e.
'
today."<!!
I'm.sure. you'll.mak.e. the .President's .remarks.k.nown. to.your .sales .staff,.
La rry ... I .k.now.your. people.are.deserving.of.this. praise .<!I
To.achieve.projectlons.on .Gadgets.wJ .need.to.begin.our.promotions.for.the.
fall.. .we.can. plan.our.television .and.lnagaztne.advertising.strategies.during.
the.sales. projection.meetin&.early .next. week ... If.you.have.any .questions.
prior.to.that,. please.call.me fll

Figure 7-35
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Placing ext ra space between paragraphs

Style Name Box

!Nor mal

I[ID

The style n ame box on th e ruler shows the style name of th e curre ntly
selected paragraph. A style is a set o f fo rm atting ch aracteristics that
defines the appearance o f text. Applying a style to selected text causes
the entire paragraph to take o n those cha racteristics. Hold ing down th e
mouse button on the arrow to the righ t o f the style name prod uces a
drop-down list of the styles used in the document. You'll be learning
m o re about styles in Project 2 of this ch apter.

Scale Tool
The scale tool is used to toggle between th e th ree d ifferent ru ler scales
availab le in Microsoft Wo rd. Th e o ne you've seen up to this poin t is the
normal scale, and it is the on e you 'll use prim ari ly th rougho ut this
ch apter.
The page scale is an o ther ru ler scale ava ilable, and it can be used to
m odify page margins, column widths, and sp acing between columns.
You' ll learn more about ad justin g page margins with it in just a
mo ment. In Project 4 you' ll learn m ore about colum ns.
The th ird type of ruler scale is the table scale, and it appears on ly when
the currently selected text is a table. It can be used to ch ange t h e width
of cells in a table. You'll learn mo re about tables in Project 3 wh en you
create a table.
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Margins
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Clicking on the scale icon on the ruler toggles it to the page scale.
Clicking on the icon again toggles it back to the normal scale. When
your ruler is in the page scale you can modify the margins of your entire
document. The 0 point of the ruler represen ts where the left edge of the
paper is, and you can drag the margin brackets relative to the edge of the
paper. When using this method to change t he margins (you' ll learn
some other methods in this chapter also), remember that the change
affects the entire document, not just the paragraph that contains the
insertion point.
You will be using man y of these ruler formatting features when you
work through the next four assignments in this chapter. You may need
to refresh your memory by referring back to these explanations o f the
various tools until you become familiar with their uses.
For the purposes of this project you did the typing first and formatted
the text later. Another way is to format as you go along, paragraph by
paragraph. Either way is perfectly acceptable-it is a matter of personal
preference.
Formatting settings made in the ruler affect the areas of text that you
selected before you set the ruler fo rmattin g. If you set the ruler without
selecting any text, the ruler settings will apply to subsequent paragraphs
that you type. This is the way you fo rmat your paragraphs before typing
them-set the ruler with the formatting characteristics that you want
the paragraph to have, and then type the paragraph. The ruler settings
stay in effect for each subsequent paragraph until you change them .
From this point on, the projects you'll be working th rough in this
chapter require that the ruler be showing at the top of the d ocument
window. The ruler does not print, nor does it red uce theamountofprint
area available on the paper. Once you get used to having your
formatting controls visible, you'll probably choose to view all of your
documents with the ruler showing.
Before you move on to document formatting, you need to change the
character and paragraph formatting of the president's quotation. To
make the quotation look different from the rest of the letter, you will
italicize it, reduce the point size, inde n t it on both sides, and remove the
quotation marks. This is called a block quote.
First you need to remove the quotation marks, since they are not used
with a block quote.

~

•

Locate the paragraph beginning "Our sales force is the backbone",
the third paragraph from the end of the document.

•

Select the quotation mark at the beginning of the paragraph and
press the Backspace key (the Delete key on some keyboards).
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This deletes the first quotation mark.
••

Delete the quotation mark at the end of the quote in the same
mann er.

Normally, when you quote something like this, you indent the left and
right margins about 1/2-inch as a visual cue indicating a content
change. You'll do that now.
If the insertion point is not in the paragraph where you just removed

•

the quotation marks, click anywhere in that paragraph to set the
insertion point.
. . To change the left indent of the selected paragraph, move the left
indent and first-line indent markers together by clicking in the
bottom marker and dragging both to the 1/2-inch mark on the ruler.
See Figure 7-36.
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Dragging both indent markers

Next you 'll change the right margin of this paragraph so that it is
indented more than the rest of the document.
•

Drag the right indent marker to the 5-1/2-inch mark on the ruler, as
shown in Figure 7-37.

!6

Figure 7-37

Changing the right inden tation

Now that you've adjusted the margins of this paragraph to set it off as
a block quote, the next step is to change the text of the quote to a smaller
size and to italici ze it. To change the character formatting for the
quotation, you must select the entire q uotation.
•

Move the mouse pointer into the selection bar to the left of the
paragraph and double-click.

This selects the entire paragraph, as shown in Figure 7-38.
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Norm nl • ...

Figure 7-38
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Selecting the p aragrap h using the selection bar

•

If yo u are using New York font, choose 10 point from the Fo nt menu.
If you are using Times font, choose 12 point.

•

Choose Italic from t he Format m enu.

The block quote does not have to be italicized, since it is already
differentiated from the ot her paragra phs by size and inde nt, but th e
italics makes it look even better.
Now yo u' ll chan ge the alignme nt of th is paragraph to justified, wh ich
will make it even o n bo th sides.
3€ -S hift-]

1 1 ..

'

Click on the justified -alignmen t icon on the ruler, as shown in
Figure 7-39.
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Figu re 7-39
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Using the justified-a lignmen t icon

The previo us steps have demo nstrated h o w easy it is to app ly d ifferent
pa ragraph an d character fo rmats to blocks of text.
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By now you should be getting u ed to saving your work wh enever you
make a significant ch ange to your document.
00 -S

•

Save your work n ow.

FORMATTING THE DOCUMENT
Up to this point in this project you h ave worked with character and
paragraph formatting, both of which affect the selected text. Now you'll
learn about document fo rmatti ng, wh ic h controls the look of the entire
document.

Using the Document Command
Many of the docume n t's formatjting characteristics can be set using the
Document dialog box. This dialog box appears when you choose
Document from the Format m enu.
•

Choose Document from the Format menu.

The Document dialog box is sh own in Figure 7-40.
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Figure 7-40
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Res tort Each Page

I
Th e Document dialog box

One way th e margins of your document can be changed is through the
Documen t dialog box. The defa ult margin settings a re 1 inch top and
bottom and 1-1 /4 inches left and right. To ch ange these settings, you
type in the box to t h e right of the margin you want to change.
•

Double-click in th e box to the righ t o f Left and type 1.

This chan ges the left ma rgin to 1 inch.
•

Double-click in the box to the right of Right and type 1.

This ch anges the right margin lo 1 inch.
Reme mber in the discussion of h e ruler you read about ch an ging page
margins using the scale icon to oggle to the page scale. Th at is another
way you can change page margins. You'll also learn about a third way
to chan ge page margins when you get to Project 4 in this chapter.
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The Mirror Even/Odd Margins option is used when you' re printing on
both sides of the paper and putting the pages together in book form.
The Even/Odd Headers o ption is used to crea te separate headers and
footers for the even and odd pages.
The Gutter box a llows you to en ter the amount of space you want to
leave on the inside edge of the paper for binding the document.
The Widow Contro l option is the d efault setting for a document. It
prevents a widow, the first line of a paragraph, from appearing by itself
at the bottom o f a page. When this option is set it also prevents orphans.
An orphan is the last line of a pa ragraph appearing by itself at the top
of a page.
The Number Pages From box allows you to begin numbering the
pages o f the documen t at a number other than 1. Normally you would
leave this field blank, since usually you want the page numbers to begin
with 1.
The Number Lines from box works like the Number Pages From box,
except it refers to the starting line number for numbered paragraphs.
Th e Default Tab Stops box a llows you to change the d efault tab stops,
w hi ch are set at 1/2-inch intervals.
The footnotes option allows you to determine the position of the
foo tnotes on th e printed page. The options in the drop-down Jist are
Bottom of Page, Ben eath Text, End of Section, and End of Document.
The Next File button allows you to specify a fil e that you always want
to prin t when the current file is finish ed printing.
The on ly changes you n eeded to m ake to the document in this dialog
box were to the left and right margins.
•

Click OK.

Numbering Pages
In this chapter yo u'll learn three ways to number pages. You'll numbe r
the pages in this document using the Print Preview command, discussed
in just a m om ent.
Another way to number pages is to use the a utomatic page numbering
icon found in the header and footer windows. You'll learn about
headers and footers and the page numbering icon in Proj ect 4 of this
chapter. Also in Project 4 you'lllearn a bo ut page numbering using the
Sectio n s command .

247

Chapter 7: Microsoft Word

Using Print Preview
Now that yo u've worked h ard on this letter, you are probably eager to
see what it looks like printed . You don't have to print your document
to get an overall view of its layo ut. Microsoft Word allows you to
preview it first by using the Prin t Preview feature, which is one of four
available views in Microsoft Word.
The view you have been working in so far is ca ll ed Galley View, Word 's
normal view. Unless you tell it otherwise, Microsoft Word opens any
documen t in Galley View. Galley View al lows you to write, edit, and
format your document in the fastest working environment. However,
as yo u'll lea rn in Project 4, all t,o rm ats in Galley View do n 't a lways
d isplay the way they will look when printed .

Page View is another view available in Microsoft Word. This view allows
you to see your document on the screen in approximately the same way
it will look when it is printed. You can write, edit, a nd forma t your
document in Page View also, alt ho ugh it is a much slower process tha n
in Galley View. You'll use Page View in Pro ject 4 of th is chapter.
Outline View lets you look at your document as an ou tline a nd a lter the
structure of it using the features available in this view. Outlining is a
topic not within the scope of this book.
Print Preview is the fourth view available in Microsoft Word. In Prin t
Preview you ca n view the layout of whole pages of your document.
Although this view allows only limited formatting, and you cannot
access text directly from this view, it contains some time-saving shortcuts
that allow you to see the document formatting changes immed iately.
You'll use thi s view several times whe n working through t h e projects in
th is chapter.
~ -I

•

Choose Print Preview from the file menu.

You view a sca led-down version of your document in Print Preview-it
is just like it will look on the printed page. You can't edit a document
in this view, nor can you access any of the menu commands. But you
can make som e cha nges to you r document using the four icons on the
left side of the window.
The first is th e page numbering icon , and it is one of the ways Microsoft
Word enables you to number the pages of your document and pos itio n
the page numbers. This is the npethod you'll use to numb er the pages
of this m em orandum.

Numbering Pages in Print Preview
,.

Click on the page number icon , the first one of the four.

Notice that the pointer ch angJ to a "1" with arrows on both sides.
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,. Position the insertio n po int in the center o f the bottom o f the first
page, and then click to tell Microsoft Wo rd that this is where you
want the page number to appear on all pages of the document. See
Figure 7-41.
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Figure 7-41

Numbering the pages

Microsoft Word will consecutively number each page of your document
automatically. You do not have to m anually type in each page number.
The page nu mbers that are placed in your document in Print Preview are
only visible when you are in either Print Preview or Page View or when
you actually print the d ocument. You cannot change the formatting of
the page numbers with this method of page numbering. You get a
default fo nt and size for the numbers.
The second icon on the Print Preview screen is the margins icon. If you
click on it, it displays dotted lines around the edges of the page to
indicate the boundaries of your margins, headers, and footers. There
will be more d etail about that icon in Project 4 of this chapter.
The third icon down allows you to switch from two-page viewing to onepage viewing in Print Preview.
The last icon allows you to print from this view. It works the same as if
you had selected Print fro m the File menu and it presents the Print
dialog box.
•

Click the Cancel butto n in the top right corner of this window to
return to the regular view of the d ocument, Galley View.

•

Scroll back through your document until you're before the block
quote.

Controlling Page Breaks
Notice there is now a do tted line running across the document above the
block quote, as shown in Figure 7-42. This line is what Microsoft Word
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uses to represent an automatic Pfge break. Viewing your document in
Print Preview caused the document to be paginated, wh ich is the process
of dividing the document into pages based o n the document's ma rgins,
length, and paper size.
r

•

File

Edi t

Format

Font

Document

Utilities

Wind ow
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To.achieve.projections.on.Gadgets.we.need.to.begin.our.promotions.for.the
can.plan.our.television.and.magazine.advertising.strategies.during.the.sales.
projection.meeting.early .next. week ... If. you.have.any .questions.prior. to. that,.
can.me.'ll

Figure 7-42

The automatic page break symbol

The other type of page break available in Microsoft Word is th e manual
page break. Th is is used when you want the page to brea k at a particu lar
p lace, other than where an auto matic page break would occur. A
manual page break is entered by ch oosing Insert Page Break from the
Document menu or by pressing Shift-En ter.
An automatic page break and a m anual page break look different on the
screen . Figure 7-43 shows both.

' - - automatic page break

.....................~· · ·;~-~~-~;~;··~~-~~..~~~~··· .......................................

I

Figure 7-43 Automa tic and ma nual page b reaks
To delete a manual page break select it a nd press t he Backs pace (or
Delete) key.
Finally, n ow you're ready to print your documen t. Always save your
work before printing.
3€ -S

,,. Choose Save from the File r enu.
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PRINTING THE DOCUMENT
3€- P

•

Choose Print from the File menu.

If you a re printing to an Image Writer, yourPrint d ialogbox will look like
th e one shown in Figure 7-44.

~lm~n~g~eW~r~ll-er~~------~------~----~X2~7 (~)
Qunllty:
Page Ronge:
Copies:
Poper Feed:

0 Best

® Fast er

0 Draft

® All

0 From:

To:

0

® Automatic

Section Ronge: From: I

0 Print Hidden TeKI

Figure 7-44

0

0

0 Hond Feed
0 Print Sele< lion Only

To: I

0 Prlnf NPut File

The ImageWriter Print dialog box

If you are printing to a LaserWriter, your Print dialog box will look like
the one shown in Figure 7-45.

loserWrller "LoserWrller"
Pages:® Rll 0 From:

Coples:l•l
Couer Poge:

s.2

D

®No 0 First Page 0 Los t Page

To:

GJ

D [ Concel J
~

Po per Source:® Paper Cosse tt e 0 Monuol Feed
Section Range: From: I
To: I
0 Print Selection Only

0 Print Hidde n TeKI

Figure 7-45

0 P11n1 NPut File

18] Print Back To Front

The LaserWriter Print dialog box

.,. Accept the default settings by clicking OK.
After your document prints, compare it to the finished document at the
beginning of this project and make any necessary changes.

QUITTING MICROSOFT WORD
As in most Macintosh applications, the command to quit Microsoft
Word is in the File menu.

3€ -Q

•

C hoose Quit from the File menu to exit Microsoft Word and return
to the desktop. If you want to continue with the next pro ject in this
chapter, close this document by clicking in its close box.

If you try to quit Microsoft Word or close a document without saving
you r work since making any changes, Microsoft Word will ask if you
want to save changes before closing. You ca n choose Yes (you do want
to save changes before closing), No (you do not want to save changes
before closing), or Cancel (you do not want to close the documen t) .
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Project 2: Creating a Document with Graphics
In this p ro ject you'lllearn to insert a graphic into a document. Microsoft
Word gives you t he ability to easily combine graphics and text; you just
h ave to open the applica tion the graphic is in, copy the graphic to the
Clipboa rd, a nd then paste it into your Microsoft Word document.
You can create illustratio ns in most Macintosh graphics applications,
such as MacPaint and MacDraw II, and then copy them into your text
document. You can also impo rt ch arts from Microsoft Excel, and yo u
can copy graphics from o ther Microsoft Word files. In addition, you can
pu rch ase com mercial clip art-artwork that is usually copyrighted a nd
d istributed o n disk from software sup pliers-a nd incorporate it in to
you r Microsoft Word docu ment.
In add itio n to learning about m oving gra phics into your Microsoft
Word documen t in th is project, you' ll learn to use sty les, o n e of
Microsoft Word's m ost powerful featu res. A style is a particular group of
paragraph and ch aracter form atting ch aracteristics to which you 've
assigned a nam e.
Giving a n a me to a set o f p aragraph and ch aracter fo rmatting
ch arac te ri stics in Mi c roso ft Wo rd e nabl es yo u to a pply t h ose
characteristics repeated ly an d consistently to different paragraphs in a
document, withou t having to format each e lement separately.
lf you do n 't assign a sty le explicitly in Microsoft Word, the default style,
Norma l, is ass ign ed to an y text you type. You 've been usi ng styles a ll
alo ng and proba bly d id n 't realize it.
To defi ne a style, you indicate wh ich formatting ch aracteristics that
style should contain, and then you a ttach a na me to that sty le. A style
definiti on can include ta b settings, fonts, margin settings, line spacing,
formatting such as underli ne o r italic, and an y other comma nd t hat can
be applied fro m t h e ruler or th at can apply to a character or paragra ph.
To apply a style to a paragraph, you specify a previously defin ed style
that you wan t to use fo r that paragrap h, and the ch aracteristics are
applied to the text immedi ately.
If you wa nt to m odify a pa rticular style, you ch ange its format settings,
and M icrosoft Word instantly changes every paragraph th at was assign ed
th at style definitio n . This is certainly faste r than selecti ng and ch anging
th e format fo r each paragraph separately.
A gro up of sty les attached to a document is called a style sheet. You can
t ra nsfer a style sh eet to an oth er document, so that the styles you created
are available to be used in any documen t. That way d ifferent documents
can h ave a consisten t appearance.
In th is p ro ject you' ll learn to d~fine and a pply several d ifferen t styles.
You' ll also learn to use borders, create specia l indentation effects, a nd create

tab leaders.
When com pleted, the assignmen t that you turn in sh ould look like the
one shown in Figure 7-46.
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WELCOME TO

~~Geno's

--Deli
Our famous sand wiches and specialty items are served from II :00 AM to
4:00 PM , Monday through Saturday. Closed Sunday.
Sandwiches
DELUXE REUBEN-a full 1/4-pound of corned beef, topped with
baby swiss cheese, sauerkraut, and russian dressing, served
grilled on pumpernickel bread ............·--·························· 3.95
HAWA II AN CHICKEN CLUB-sliced chicken, ham, lettuce, tomato,
and pineapple slices, piled high on our toasted sunflower-seed
bread-················ ............-.................._.......................... ...... 3.75
BACON AN D ASPARAGUS SUPREME-crispy bacon, tender
asparagus, and mushrooms, topped with melted cheddar cheese
and served hot on an onion kaiser rolL___............... ....... 3.95
Side Orders
Curly Fries ....- .............. .. 1.10
German Potato Salad ...... 1.25

Bermuda Onion Rings.......... 1. 10
Smoked Baked Beans .......... .95

Desserts
HOT FUDGE SUNDAE- two scoops of mint ice cream, smothered
with creamy hot fud ge and topped with nuts and whipped cream
......... - ................................ ···--·········.......... ........................ I .75
GENO 'S C HEESECAKE-rich and creamy, with blueberry topping,
and large enough to share ............- -............................. 2.25
Beverages
lced tea__............................. 65
Cola, Orange, Root Beer. ... 75

Milk ...... .........._ ................... 75

CA RRY-OUT AVAILABLE ON ALL MENU ITEMS

Figure 7-46

Pinal o utput of Proj ect 2

In th is p ro ject you will create a restaurant menu. It is intended that you
create it using a pa rtially completed documen t, entitled "Gena's Menu
Unformatted," that is included on the Macintosh journey Projects disk. The
artwo rk for the m en u is also o n that d isk and is en ti tled "Menu
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I

Artwork." If you are using this book in a classroom environment, check
with the instructor to ensure that "Geno's Menu Unformatted" and
"Menu Artwork" are available. For info rmation about ordering the
Macintosh Journey Projects disk, see the last page of this book. A printed
version of the unformatted menu is shown in Figure 7-47.

Our famou s sandwiches and specialty items are served from 11:00 AM to
4:00PM , Monday through Saturday. Closed Sunday.
Sandwiches
DELUXE REUBEN-a full 1/4-pound of corned beef, topped with baby
swiss cheese, sauerkraut, and russian dressing, served gri lled on
pumpernickel bread
HAWA IIAN CHICKEN CLUB- sliced chicken, ham, lettuce, tomato, and
pineapple slices, piled high on our toasted sunflower-seed bread
BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus,
and mushrooms, topped with melted cheddar cheese and served hot on an
onion kaiser roll
Side Orders
C urly Fries 1.10 Bermuda Onion Rings 1.10
Ge rman Potato Salad
1.25 Smoked Baked Beans
.95
Desserts
HOT FUDGE SUNDAE-two scoops of mint ice cream, smothered with
creamy hot fudge and topped with nuts and whipped cream
GENO ' S CHEESECAKE-rich and creamy, with blueberry topping, and
large enough to share
Beverages
Iced tea
.65 Milk .75
Cola, Orange, Root Beer .75
CARRY-OUT AVAILABLE ON ALL MENU~TEMS

Figure 7-47

Unformatted Gej o's Menu
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I

O ne way to begin this project is to locate the document entitl ed "Geno's
Menu Unformatted" and double-cl ick o n its icon. Th is will sta rt
Microsoft Word and open that documen t.

-

Geno 's Menu Unformatted

Another way to begin is to double-click on the Microsoft Word icon to
launch the ap plica tion, and then ch oose Open from the File menu.
Locate the Gen a's Me nu Unfo rmatted document (click the Drive
butto n if n ecessary), and double-click on it to open it.
~ -0

If you did not quit Microsoft Wo rd afte r the last project, ch oose Open
fro m the File me nu and dou ble-click on Gena's Menu Unformatted to
open it.
Regardless of which method you chose, the document Gena's Menu
Unformatted sh o uld be o pen ed on your screen. It should now look li ke
f igure 7-48.
'

•

10

file Edit Formot font Documen t Utilities Window
Geno's Menu Unformatted

Our famous sandvicbes arxl specialty items are served from 11:00 AM to 4:00PM,

01

~

Monday through Saturday Closed Suroay
Sandvtcl'es
DELUXE REUBEN-a full 114-pouro of comld beef, topped vilh baby sviss
cheese, sauerkraut, arxl russtan dressing, served grilled on pwnpernickel bre<w:l
HAWAIIAN CHICKEN CLUB-sliced clucken, ham, lettu:e, tomato, and pmeapple IP
slices, piled high on our toasted sunflover-seed bread
BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus, and
mushrooms, topped v ilh melted cheddar cheese arxl served hot on an onion kaiser roll
Side Orders
1.10
Curly Fries 1.10 Bermllia Onion !lings
1 25 Smoked Baked Beans
95
German Potato Salad
Desserts
HOT FUDGE SUNDAE-tvo scoopsofmintice cream, smothered vilhcrearnyhot
fllige aOO topped v ilh nuts arxl vhipped cream
GENO'S CHEESECAKE-rich and creamy, vilh blueberry topping, arx! large
enowrh to share
,,'·'·\ljc;; ('2)
(Normal
IPage
IQ I ::;:;..

~

Figure 7-48

Gena's Me nu Unfo rmatted

Let's make a copy of this document, so yo u can leave the o riginal intact.

Return or Ente r

•

Choose Save As from the fil e m enu .

•

Click the Drive button, if n ecessa ry, to be sure you a re saving the
document o n yo ur d isk.

•

Replace the name "Gena's Menu Unfo rmatted" with Gena's Menu
by typing that name in the Save Current Docume nt as box, as shown
in Figure 7-49.

•

C li ck the Save butto n.
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I(g) Corolyn Phillips]
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Soue Current Document 11s:

(g) Cllrolyn Phillips
738K BUHiiHbl e

IGeno's Menu
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Figure 7-49
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Saving the fo rmatted menu

PLACING THE GRAPHIC
The a rtwork for the m enu is in a document entitled "Menu Artwork"
on the Macintosh journey Projects disk which accompanies th is book.
You'll ope n that document now.

Opening Multiple Documents
Microsoft Word allows you to have more than one docume n t open
at a tim e. When you have multiple documents open, only o ne is
con sidered active. The active window is t he fro ntmost o ne showing o n
your screen. If you r docume nt windows are s ized and arranged so that
you ca n view more than on e at a time on the screen, you can easily spot
the active o n e because it has scroll bars and horizonta l lines on either
side of the title in the title bar. To m ake a differe nt open document
acti ve, select it from the Window menu, and Microsoft Word activates
it and places it in front of the others. You can also click anywhere in a
window to make it active.
S€ -0

•

Choose Open fro m the File menu.

You are prese nted with a dialog box that lists th e Microsoft Word
documents available to be open ed. See Figure 7-50.

Select o Document:

I(g) Cerolyn Phillips I

0 Geno's Menu
0 Geno's Menu Unforma ...
0 Menu Ar twork
D Soles Report

!=!

lg] Corolyn Phillips
691 K ouoiloble

CEll ~
~
( concel]

In

Figure 7-50

D

Rend Only

The Open dialog box
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•

Click the Drive button, if n ecessa ry, and scroll through th e list of
documen ts in the Open dia log box until you see the Menu Artwork
document.

•

Select that document from the list by cl icking on it, and then click
the Open button .

A shortcut for this procedure is to double-click Menu Artwork in the
dialog box. An other is to click o nce on Menu Artwork and th en press
Return, because the Open button is the default. Whichever method you
use, the document Menu Artwork shou ld now be active on your screen .
•

Click within th e Welcome to Geno's Deli graphic to select it .

When you select a graphic, small black squares appear in the center
botto m and on the right side of the draw ing. The border aroun d the
drawing darkens, as sh own in Figure 7-51.

a

r

File

Edit

Format

Font

ifiJ

Document

Ut ilities

Window

Menu Artwork

WELCOME TO

Geno~

Deli

Page 1

Figure 7-51

Norma

Selecting the graphic

Copying and Pasting
f!€ -C

•

Choose Copy from the Edit me nu to copy the graphic to the
Clipboard.

•

Click in the close box in th e upper left corner of the Menu Artwork
document to close it.

Now you'll place the Menu Artwork in to Gena's Menu.
f!€ - V

•

Click in the fi rst line of Geno's Menu to set the insertion point
th ere, and th en choose Paste from the Ed it menu.

Now you h ave pasted the Men u Artwork into Geno's Menu . Your screen
should look similar to the o ne shown in Figure 7-52.
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Our famous sarxlvichesam specialty items are served from 11:00 AM to '1:00PM,
=arc:oughSaturoay. Closed Surrlay.

b.
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DELUXE REUBEN-a full 1/4-pourrl of corned beef, topped vith baby sviss
,,
cheese, sauerkraut, and russian dressing, served grilled on pumpernickel bread
.
HAWAIIAN CHICKEN CLUB-sliced chicken, ham, lettoce, tomato, am pineapple ·r
slices, piled high on our toasted sunflover-seed bread
~,[BACON AND ASPARAGUS SUPREME-crispy bacon, tender asparagus, and
1m;
mushrooms, topped vith melted cheddar cheese am served hot on an onion kaiser roll ~
Pag e I
Norma
to >;·:•:•:<·>:tiT>!i:::•WY·:•:::.::i·i~::;:fj~ '2l

Figure 7-52

3€ -S

•

Placing the graphic in the document

Save yo ur work n ow by ch oosing Save from the File m en u.

You' ll use Sh ow<[ an d the ruler to h elp you fo rmat and see the effects
of your fo rm atting thro ugh out thi s project, so you sho uld activate
them n ow.

3€ - Y

,.

Choose Sh ow <j[ fro m the Edit menu .

3€-R

•

Choose Sh ow Ruler from the Format menu.

FORMATTING THE GRAPHIC
Cente ring the graphic and pl acing a border around it will make it stand
out on the me nu, so let's do t hat n ow.

Centering the Graphic
3€-Shi ft-C

I= I

3€ -M

•

To cen ter th e graphi c, click on th e graphic to select it, and then click
on the center-alignment icon o n the ruler.

•

With the graphic still selected, choose Pa ra graph from the Format
menu.

lf n ecessary, drag th e Paragraph dialog box by its title bar to move it
lower o n the screen so tha t you can see the graphic.

Adding Borders
•

Click the Borders button at the bottom of t h e Paragra ph dialog box.

•

In t he resulting Paragraph Borders dialog box, click on the secon d
li ne thickness down along th e left side of t h e di alog box to select th e
thicker single line. Then click Plain Box . See Figure 7-53.
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~PI11in DoH
Q ShlldOW DOH
0 Outside D11r

,___ _ _ __, 0 Custom
Splicing:

[=:J

Figure 7-53

The Paragraph Borders dia log box

Notice that a box is drawn arou nd the schematic d iagram to represent
the effects of your selection.

Applying Paragraph Borders
•

Click OK in the Paragraph Borders dialog box, and then click OK in
the Paragraph dialog box.

Now your menu graphic s hould have a border around it like the one
shown in Figure 7-54.
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Figure 7-54

The border around the graphic

The left and right margins on the ruler control the relative width of the
border you place around your text and graphics. Notice that the borde r
extends about 1/2 inch to the left and right of the graph ic in Figure 7-54.
That is because the left and right margins of the ruler extend that far to
either side of the graphic.
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•

Save your work.
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FORMATTING THE TEXT
Now you'll put a double line beneath the first paragraph and cha nge the
inde ntation so the paragrap h is set apart from t he rest of the m en u.
~ -M

sg.sh i ft-0

•

Click an ywh ere in the first line of the pa ragraph begi nning "Our
famous", and then choose Parag raph from the Format menu.

1::::1 •

Click on t he paragraph spacin g icon on the ru ler to create a space
before this paragraph.

•

Hold down the Shift key, select the left indent marker, and drag it
to the 1/2-inch mark on the ruler. See Figure 7-55.

torm~ ~~
Figure 7-55

12

!
t

t

T

I

Settin g a 1/2-inch indent

If you do not use the Shift key, t h e first- line indent marker and left
inden t marke r m ove together.
This ruler change causes the second li ne only o f that paragraph to be
inde n ted 1/z-inch from the left margin of that paragraph.
-

Click t he Bo rders button in the Paragraph dialog box.

•

In th e resulti ng Paragraph Borders dia log box, click on the t h ird
box down the left side to select the do uble line. Then click in the
bottom part of the schematic diagram to place a double line the re.
See Figure 7-56.

0 Plain BoH
0Shadow BoH
0 Outside Bor
'---.;,_---J

Spacin g:

Figu re 7-56

•

®Cust om

C:=J
Placing a double ine benea th the paragraph

Click O K in t h is dialog box and again in the Paragraph dialog box.

Your paragraph should n ow be forma tted like the one shown in
Figu re 7-57.
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The formatted first paragrap h

Now is a good time to save your work.

Defining Styles
Let's create some styles that you can apply to the rest of your menu.

3€ - T

•

Click in the line containing the wo rd "Sandwiches", below the
double line you just created.

•

Ch oose Define Styles from the Format menu.

The resulting dia log box is displayed in figure 7-58.

'Normol

+

Font: 14 Pofnt

NeKt style:

I

Figure 7-58

I 811sed on: INorm al
The Define Styles dialog box

Notice at the top of the dialog box that New Sty le is h ighlighted;
Microsoft Word is expecting you to create a new style. The insertion
poi nt is waiting for you to type in a style n ame. The other style in the
list is preceded by a bullet. This indicates that it is one of Microsoft
Wo rd 's automatic styles. The checkmark to the left of the style Normal
indicates that it is th e style that th e currently selected paragraph is
formatted in.

261

Chapter 7: Microsoft Word

The insertion po int is in the fi e! to the right of Style, ready for you to
type in the name of the n ew sty e you're about to create.
In the bottom rigpt co rner of the dialog box the Based on box contains
the word "Normal. " Th~s means that the style that you are about to
create will contain the characteristics of the already existing style
Normal, plus whatever modi fications you choose.
Now you'll create a style that you can use to fo rmat text as bold and with
a 12-point blank line in front of it.
•

Type Food Class for the name o f your new style, as shown in
Figure 7-59.

•

Defin e st l es:Geno's Menu

r

.,.~'!!'!!r'·

~ f

I

~

~__-;:=========:

NeHt Style:

I

Figure 7-59

•

OK IJ

[cent el

[set

D~foultl

I Dosed on: INormol
Typing the new style name

With this dialog box still open, choose Bold from the Fo rmat menu.

Notice that Bo ld becomes part of the descri ptio n of the style in the box
beneath "Food Class."
•

With this dialog box still o pen, choose Paragraph from the Format
menu.

•

In the Paragraph dialog box, type 12 in the Before box, as shown in
Figure 7-60, and then click OK.

Indents
l ett:
Right:
Fir st :

Pereqraph
Spocing

§

"" ~
Before: 121

Rfter:

R

OK

J)

I
[ ~pply I
[ Cencel

D Page Break Before D Um! NumbNIOI.I J
0 Keep With NeHt 'I D Keep lines Toget T r

(

Tabs...

) (Borders ... ) (Position ... )

Figure 7-60

Placing a 12-poin line before the paragraph
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This last action created a 12- point blank line in front of the paragraph,
similar to th e way clicking o n the paragraph-spacing icon would.
•

I

In the Define Styles d ia log box, click the Define butto n, as shown
in Figure 7-61.

r@
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.t• Normol

I

ll

I)
I
( Apply I
OK

( Con eel

[ Set Deroult

I

Styl e: Food Closs

I

I •

• r lormol + Font· 14 Point, Bol~, Space Before 12 pt

NeHt Style:

I

IDosed on: INormal

I

Defining the style

Figure 7-61

The new style, food Class, that you created is added to the list of styles.
,,.. Click OK in the Defin e Styles dialog box.
Now you should see th e results of applying that style to the paragraph
th at co ntain s th e word "Sandwiches." See Figure 7-62.
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!Food Class

IO L

0

10 Q]

Th e first style applied

The na me o f the style that you created is now showing in the styles dropdown Iist on the ruler. If you click on the arrow to the right of this style
name and hold down the mouse button, the list of styles used in this
docume nt are shown. A checkmark is beside the style name of the
paragraph that currently contains the insertion point. See Figure 7-63.
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Figure 7-63
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The styles drop-down field

Save the changes you 've made to your document.

Now you'll see how simple it is to apply this style to other paragraphs
in your document.
•

Click in the paragraph containing the words "Side Orders," in
the middle of the document.

•

Click on the arrow to the right of the sty les drop-down list on the
ruler a nd, ho lding down the mouse button, drag to the Food Class
style so it is highlighted, as shown in Figure 7-64.

Be su re you click on the a rrow to the right of the styles drop-down list,
n ot on the name.

Figur e 7-64

•

Selecting a style

Release the mo use butto n.

Th e selected paragraph sh o uld now have the same formatting
ch aracteristics as the Sandwiches paragraph.
•

Using the same method, apply the Food Class style to the paragraph
containing the word "Desserts" and to the one containing the word
"Beverages".

Now you' ll create a different style to use to format the menu items. This
style will h ave differen t left and first-line indentat ions and will have
tabs set with dot leaders. A do t leader is one of several tab leaders th at
Microsoft Word uses to fill blank spaces before a tab stop. When you
press the Tab key to move to a tab stop that has a leader, th e blank space
up to the tab stop is filled with your ch oice of dots, dashes, or underlin es.
You've probably seen dot leaders in tables of contents or b etween
columns of figures.
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You'll learn a different method for creating this style than you used
previously. Th is time you'll format the paragq1ph and then assign the
style definition by example.
•

Click in the paragraph beginning with "Deluxe Reuben ".

•

Hold down the Shift key, and click on the left indent marker on the
ruler (the botto m triangle) and drag it to the l-inch mark on
the ruler.

•

With the Shift key still down, drag the first-line indentto the 1/z-inch
mark on the ruler, so that your ruler now looks like the one shown
in Figure 7-65.
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Changing the first-line indent

Figure 7-65

Changing the left and first-lin e indent markers in this manner will result
in a hanging indent for the selected paragraph. A hanging indent is when
the first line of the paragraph starts to th.e left of the left margin.
t.

•

To set the decimal tab, click on the decimal tab marker on the ruler.
Then click on the ruler at the 5-5/8-inch marl< to positio n the tab
there.
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•

Choose Paragraph from the Format menu.

In the resulting Paragraph dialog box, notice the settings in the Indents
section, as shown in Figure 7-66. Instead of dragging the left and firstline indents to their desired positions o n the ruler, yoq could have typed
the amounts into the appropriate boxes in this dialog box. Both
methods work the same way.
•
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The Paragraph dialog box
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The indents and tab setting on yJ ur ruler and in your Paragraph dialog
box should match those shown in Figure 7-66.

Setting Tab Leaders
•

Click the Tabs button in the Paragraph dialog box.

•

Click on the decimal tab marker that you placed at the 5-5/8-inch
mark on the ruler.

•

In the Tabs dialog box, click the second button down in the Leader
section. This is the on e with the dots to the right of it, as shown in
Figure 7-67.
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Position: ~
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Figure 7-67

~

~ (Cancel)
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" D

Selecting the dot leader

This will attach a dot leader to that tab. You' ll see how a tab leader works
in just a minute.
,,, . Click OK in the Tabs dialog box, and then click OK in the Paragraph
dialog box.
·t .

Notice that the tab ma rker on your ruler now has a small dot to the left
of it. This indicates that a leader has been applied to that tab stop.
Now that your paragraph is formatted, you'll define a style based on that
formatting.
•

To assign a style name to the paragraph you just formatted, make
sure the in sertion point is somewhere within that paragraph and
then click the style name box on the ruler to select it.

•

Type Menu Item into that box as shown in Figure 7-68.
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Figure 7-68

•
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Typing in the

tl
sty!~

name

Press Return.

When you press Return, a prompt will verify that you would like to
define a style based on your current selection, as shown in Figure 7-69.
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Define st yle " Menu I tem" b ased on selection?

Figure 7-69

Return or Enter

•

Defin e styles p rompt

Cl ick Define.

You jus t went th rough the steps for d efining a style based on an
example. You now have a new style called Menu Item.
To complete the Deluxe Reuben me nu ite m, you n eed to ty pe in the
p rice.
•

C lick after "pumpernickel b read" at the e nd of that paragraph
and press the Tab key. The n type the price, 3.95, as shown in
Figure 7-70.

Sandvtche~

DELUXE REUBEN-afulll/4-pound.ofcorned.beef,.topped vithbaby.sviss.
cheese, sauerkraut, and.russiandressing, servedgrilled.on
pwnperruckeLbread+.......................................................... 3.95<11

Figure 7-70

Add ing th e price to the m e nu item

The dot lead er that you a pplied to the ta b ca uses dots to lead u p to the
tab positio n, which makes the info rmation easier fo r t he eye to follow.
~

-S

•

Save the ch anges that yo u' ve m ade to your d ocument.

Now let's app ly the Men u Item st yle to " Hawaiian Chicken Clu b".
•

C lick a n yw he re within that paragraph , and then select Menu Item
from th e style drop-down list o n the rule r.

Add the price to this m enu item.
•

C lick after "sun flower-seed bread" in that item, press the Tab key,
and th en type the price, 3. 75.

,.

Follow the same proced u re fo r a ppl yin g th e style to the Bacon and
Aspa ragus Suprem e, Ho t Fudge Sundae, and Gena's C heesecake.

•

Be su re to type in the prices fo r these item s, which are 3.95, 1.75, and
2.25, respectively.

T he re is o ne more st yle to be created fo r th is document, "Side Orders and
Beverages". This style will be indented 1/2 inc h from the left margin and
will con tain three tab stops.
•

C lick in the li ne containing "Cu rly fries".
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•
t.

Drag the left indent and
mark on the ruler.

firs~ -line

indent markers to the 1/2-inch

,,. Click on the decimal tab marker on the ruler, and then click at the
2-5/8-inch mark and at the 5-5/8-inch mark on the ruler to place
decimal tab stops the re.
•

Click on the left-aligned tab marker on the ruler, and then click at
the 3-1/4-inch mark on the ruler to place a left-aligned tab stop
there.

Your ruler should look like the one shown in Figure 7-71.

I@

The left alignment and tab stops on the ruler

Figure 7-71

•

Double-click on the first decimal tab (at 2-5/8 inches) on the ruler.

This brings up the Tabs dialog box. Be careful that you don't accidentally
move the tab marker when you double-click on it.
•

In the Tabs dialog box, click the button next to the dot leader in the
Leader section . See Figure 7-72.
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Setting a dot leader for the 2-5/8-inch tab

Click the Set button.

That sets up the tab leader for the first tab marker on the ruler.
•

Now click on the third tab marker on the ruler, which is set at
5-5/8 inch es. Click the dot lead er button for this tab marker also.

•

Click OK in the Tabs dialog box.

You h ave already defined the style attributes by setting the indentation,
tabs, and leaders. Now you n eed to name that definition. You'll use the
Define Styles dialog box to d efine this style.
3€ -T

•

Choose Define Styles from the Format menu.

•

Type Side Order/Beverage for th e style name.
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Notice that all the attributes about the style are listed in the box below
the sty le name, as shown in Figure 7-73 . This is h elpful if you n eed to
verify a particula r formatting characteristic. If you need to change a
formatting characteristic, you can do so with the dialog box open, and
the style description w ill reflect the changes.
!0~

Define St tes:Geno's Menu

M enu Item
-'• Normal

L----;:==========:
I

s t yl e: Side Drder/ Beuerage

(Set Default J
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llormel + Font: I 4 Poi nt, Inde nt: left O.Sin, Tab otopo· 2.6251n
Number Aligned ...; 3.251n; 5.625in Number Aligned ...

NeHt Style:

I

Figure 7-73

•

I Based on: INormal
The Side Order/Beverage style

Click Define in the Define Styles dialog box, and then click OK.

Thi s Side Order/Beverage style needs to be applied to German Potato
Salad, Iced Tea, and Cola, O ran ge, Root Beer.
•

sg -S

Follow the previous instructions to apply styles to these li nes.

,.. Save yo ur ch anges.
The last formatting changes you need to make t o this menu are to t h e
Carry-O ut Available line.

3€ -Sh ift-13

•

Click in the selection bar to the left of t he Carry-Out line a t the
botto m of the page to select the entire line.

I= I

•

Click on the center-alignment icon on the ruler to center th at line.
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•

Choose Bold from the Format menu, and then choose Italic from
the Format menu.

The last line of the m enu is now centered, bold, and italicized.
Now that you've made all these formatting changes, you shou ld save
and t he n print your completed document.
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•

C hoose Save from the File menu .

sg- P

•

C hoose Print fro m the File menu, and t hen click OK.

Compare your printed document to the finished menu at the beginning
o f this pro ject, and make sure they look similar.

sg -Q

•

To ex it Microsoft Word, choose Quit from t he File menu or just close
the docume nt and be ready for the next lesson .
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Project 3: Creating a Table
In thi s project you'll learn how to use the tables feature, which is new
with Microsoft Word 4. Using the tables feature is a straightforward way
to arrange text in rows and columns. Th e intersection of a row and a
column is referred to as a cell. You can put just about anything you'd like
into a cell-numbers, words, paragraphs, groups of paragraphs, or
graphics. You can format the contents of each cell with character and
paragraph formats . You can also use any number of line and border
combinations to format individual cells or the entire table.
Each cell has many of the properties of a small document, with its own
top, bottom, left, and right margins and its own selection bar. Text
word-wraps within a cell just as it does in a document.
In this project you will create an empty table and then fill it w ith data.
However, tables can also be created by selecting existing paragraphs and
converting them to a filled cell table using the Insert Table command.
This project does not detail this type of paragraph-to-table conversion
procedure, but additional information is available in Reference to Microsoft

Word.
This project produces a food value table. You'll create this table by
inserting an empty table grid and the n fillin g each cell with the
appropriate data. You'll use the ruler to center and left-align the
contents of individual cells and to set decimal tabs with in several cells
at once. You'll use cell borders to create vertical lines between columns
of cells and to create borders around groups of cells and the entire table.
Microsoft Word provides three comm ands for working with tables:
Insert Table on the Document menu, Cells o n the Format menu, and
Table on the Edit m enu. You' ll work with each of these commands in
this project.
The final o utput of this project is the table shown in Figure 7-74.
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The following is a table showing the fat and cholesterol content of certain foods
of interest to this particular study group. See Table 7.

Table 7. Fat and Cholesterol Content of Selected Foods Common
to Diets of Elderly Nursing Home Patients

Food Item
Lean ground beef
Tuna salad
Peanut butter
Whole milk
Skim milk
Butter
Vanilla ice cream

Portion Size

Total
Fat

3 oz.
1/2 cup
2 Tbsp.
1 cup
1 cup
1 Tbsp.
1/2 cup

14
10
16
8
1
11
7

Saturated
Fat
(grams)
6.0
2.0
2.0
5.0
0.2
7.0
4.0

Source: USDA, Human Nutrition Information Service.

Figure 7-74 Final output of Project 3

Cholesterol
(milligrams)
80
40
0
33
5
31
30
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,.

To begin the assign ment, do ble-click on the Microsoft Word icon .
If you did not exit Word sir ce the previous project, choose New
fro m th e File menu.

Microsoft \'lord

Your screen will sh ow a new document called "Untitled! ".
3€ -R

,. Choose Show Rule r from the Format menu.
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•

Choose Show lj{ from the Edit menu.

•

Select the paragraph m ark (<j[) in th e first line. From the Font men u
choose Helvetica 12 point if you'll be p rinting to a LaserWriter or
Geneva 12 point if you' ll be usi ng an Image Writer.

Selecting th e paragraph mark before choosing the font is an example of
setting the ch aracter forma t befo re you begin t yping. The ch aracter
fo rmat will remain in effect until you ch ange it to something else.
Th e exam ple in this pro ject uses Helvetica font.
This ti me, let's save and n am e t he document before going on with the
rest of the pro ject .
3€ -S

·•

Ch oose Sa ve from t he File menu, an d save th e document as Food
Value Table. Be sure you are saving this docum ent on yow· data d isk.

•

Type the following:
Th e foll owing is a table sh owing the fat and ch o lesterol conten t o f
certain foods of inte rest to thi s particula r study group. See Table 7.

"•

Press Return twice to create a bla nk line.

WORKING WITH CELLS
As me ntion ed earlier, a cell occurs at the intersection of a row and
column in a table. A row refers to the ho rizontal placement of cells, and
a column refe rs to the vertical p lacement of cells. In a table con sisting
of four rows and three colum n s, each row consists of three cells
horizonta lly and each column con sists of four cells vertically, as shown
in Figure 7-75 .
Column

I

l

R ow ~

Cell

Figure 7-75

Relat w nshtp between rows, columns, and cells

I

A table can consist of just o ne cell, one row, one column, or any
combination o f groups of cell s.
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A cell works like a small document that is contained within the border
of the cell. You can apply character and paragraph formatting to the
contents of a cell, and you can wrap text within a cell.
The appearance of tables can be enhanced using borders and lines.
Borders can apply to individual cells, groups of cells, or the entire table.
Lines can improve the readability of tables by separating columns o f
data and by setting headings apart from the body of the table.

Creating a Single-Column Cell
••

Choose Insert Table from the Document menu.

The dialog box that results is shown in Figure 7-76.
1nsert Tobie
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The Insert Table dialog box

Figure 7-76

,. Type 1 to replace the highlighted 2 in the Number of Column s box.
Notice that the column width changed from 3 in to 6 in when you
changed the number of columns. This is because Microsoft Word
divides the text co lumn width of your document (the distance between
the left and right margins of the page) by the number of columns in the
table, so that each column of cells is the same width. Since the column
width of this document is 6 inches, the column width of your one-cell
table is 6 inches also.
••

Accept the rest of the settings in the dialog box (shown in
Figure 7-77) by clicking OK.
Insert Table

Number of Columns:

§I k J
OK

Number of Rows:

I

Column Width:

6 in

Convert from

0
0

Pm·<tgt ·<1JIIJ ~

(Format... )

---===~==~

lob llt~limltetl

Figure 7-77

~

0 [ o m mu ll t~limlted
0 Si tll~ bt.l Side Only

Dialog box set for one 6-inch-wide column

Now you see a dotted cell grid that consists of one row and one column
and, therefore, one ce ll. The insertion point is inside the cell just to th e
left of the end-of-cell marker, which is represented by a black dot about
the size of a lowercase "o". The cell also has an end-of-row marker, just
outside and to the right of the cell grid. See Figure 7-78.
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The first table

Type the following into this cell witho ut pressing Return:
Table 7. Fat and Cholesterol Content of Selected Foods Common to
Diets o f Elderly Nursing Ho me Patients

Not ice how word wrap e nables the text to flow to a new line in the cell
witho ut you h aving to control the placement of the li nes. Altho ugh this
is a single-column cell, you can create as many lines as n eeded and still
remain w ithin the same cell .
Your screen should look li ke the o ne shown in Figure 7-79.
•

File

Edit

Format

:o
10

II

!Normal

Ifill

Font

12
D

t

1'

t.

Do cument

Utilities

Window

Food Ualue Table
13
14

15

~ 1=1 1~1 1=1

IIIIi] I -I 1 1

1

'16
~!lim 1~1

1.w.1

The.fo Ilowing. is.a.table.showing. the.fatanr .cholesterol.co nte nt of.certain. foods.
~- i nterest to.this.particular. study. gt·oup ... s re.Table.7.<!!

i"Table.T.:FaUi"nct·cfioleste"i'o rc·o-nte·nt"of.·sr le-cte·a•·Fo·oc!S":cq:nmon•to:niets•·or:···:·
L.~.l9~r..ly);l_t,J~.i.t:'9-. t!()_t!I~_..P.~.t.i_~.n..~!....... ........................................................................................................!

<!!

Page I

Figure 7-79
3€ -S

•

INormal

10 1

Cell contents of first table

Ch oose Save from the File men u .

Next you'll create a new 5-colu t n, 10-row tabl e.

I
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Creating Multiple-Column and Multiple-Cell Tables
•

Click to the left of the paragraph mark o n the last line of your
docume nt, ben eath the table above it.

•

Choose Insert Table from the Document menu.

•

In the resulting dialog box, change the Numbe r of Columns to 5 and
the Number of Rows to 10 and accept the rest o f the settings by
clicking OK. See Figure 7-80.

Number of Columns: 5
Number of Rows:
Column Width:
Conuert

0
0

From ----===:.._:==~

Pan1gn1ph~

lob 0PIImlted

Setting up a 5-column, 10-row table

Figure 7-80

Now you have a grid on your screen that looks like the one sh own in
Figure 7-81.
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101

The grid for the multicolumn table

Now you n eed to type the h eadings in th e first row of cells in the 5column table. Wh en you press Return o r Shift-Return while typing in
a cell, Microsoft Word advan ces you to th e n ext line, but keeps you
within the same cell. You press th e Tab key to advan ce to a new cell in
the table. When you are in th e last cell of a row, pressing the Tab key
advances you to the first cell in the next row.
Rather than creating a predetermined number of rows in a table, you can
also create new rows as you n eed them. Pressing the Tab key wh en you
reach the last row in a table creates a new row with the same cha racteristics
as th e on e you just left, and that row is placed directly ben eath the

Chapter 7: Microsoft Word

275

previous row. Thi s is a ha ndy fea ure, beca use it mean s you don' t have
to determine ahead of time how n an y rows yo u'll need in your table.
It also allows you to fo rmat the first row of cells, and all n ew rows you
create will be formatted the sa me as th e original row.
In this project first you a re creating th e table grid a nd typing in the data.
Th en yo u are going t o change the fo rmatting of pa rts of the ta ble o n ce
you've seen the layout of the text in the ce lls. Once you've gotten the
hang of wo rking w ith tables, feel free to for mat first and type later. As
with any document yo u create, it is a matter of personal p reference, and
no one way is better than another.
• Type the column headin gs as sh own in Figure 7-82.
These a re sh own with Sh ow~ on, so you ca n see where the new-line
commnnd, or soft return (Shift-Return), was used to advance to a new line
in the same cell.
To m ove to the next cell to t he right, press the Tab key. To move back
to a cell to th e left, press Sh ift-Tab. Or click in any cell to begin typing
there.

Figure 7-82

The column head ings in th e tab le

•

After you've typed the head ing in the last cell , press the Tab key to
advance to the next row.

•

Press t he Tab key twice to adva nce to the thi rd cell w ithin this row,
and type (grams).

•

Press the Tab key twice more to advance to the last cell, and type
(milligrams). See Figure 7-83.
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.. Press th e Tab key to advance to the next row.
.. Now type the rest of the data in the columns, pressing the Tab key
to m ove betwee n cells and also to ad vance to the next row of cells
when you have finish ed typing a row. See Figure 7-84.
:··r aB'Ie·:7::·:Fat"a:na:cno-leste·rorco·nte·nt"orse·lede-a:·Fo-oas:commo-n:to-:nielS:·oF:..··:.
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o~.a.

: +'
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! Food. Item•

! Portion. s ize• ! Fat•

Figure 7-84

Com pleting the table

! Fat•

! Cholesterol• !

.. . Save your work.
Don't worry about the unused row in th e table-you' ll get rid of it later.
Now you need to create a single-cell table at the bottom of the table you
just completed . This will contain your source information.
•

Click to the left o f the paragraph mark (9[) in the last line of the
docume nt to set the insertion point there.

•

Choose Insert Table from the Document m enu.

•

Type 1 to replace the highlighted 2 in the Number of Columns box .

•

Accept the rest of the settings in the dialog box by clicking OK. See
Figure 7-85.
I nserl Tobie

Number or Columns:

~~

Number or Rows:

1

Column Width:

6 In

Con11ert From

0
0

I'UI'II!Jl'illl h~

OK

J

~

[rormot... J

-------=====~

lob lll~llmlh~ll

Figu re 7-85

t

0 [ lltntn ll
0 Sltll~ IH.I

lll~lltnlh~tl

Sl<lo Ort ly

Dialog box set for o ne 6-inc h-wide column

Now you have another o ne-cell table beneath the multicolumn one .
·•

In that new o ne-cell table, type th e following source informati on :
Source: USDA, Human N utritio n Information Service.

3€ -S

,, . Save your wo rk.
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FORMATTING CELLS
Now that all the information has een entered, you can change the look
of the table.
1
11

Each cell has its own Selection bar" that you can use to select the
contents of the cell. The selection bar is to the left of the cell marker if
there is no data in the cell. If the cell does contain text, the selection
bar is to the left of t he text.
The title information in the first on e-cell table sho uld be bold. You'll
select that text now.
•

To select the con tents of the one-cell table that contains the title
information, click in the selectio n bar to the left of the text in that
cell. See Figure 7-86.

The cell contents become highlighted.

Figure 7-86
:3€ -Sh ift-B

•

Using the cell selection bar

Choose Bold from the Format menu.

This formatting affected only one cell. You are no t limited, h owever, to
formatting one cell at a time- you can format en tire rows, columns, and
tables by fi rst selecting the block of cells to be formatted. Next you'll
format many cells at one time.

Changing Cell and Column Widths
The first two columns of the mu ticolumn table sho uld be larger than
the other three, so let's ch ange t eir widt h to 1-1/2 inches.
••

Beginning in the cell contai ing the words Food Item," click and
drag through the selection qar of the fi rst column, and continue
dragging through the last cell of the second column.
11
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This wi ll highlight both columns, as shown in Figure 7-87.

Figure 7-87

Selecting two columns

•

Ch oose Cells from the Format m enu.

•

In the resulting dialog box, next to Width of Columns, cha nge that
box to read 1.5 in, as shown in Figu re 7-88. Then click OK.

Width of Columns 1-2:
Sp11ce Be tween Cols:
Indent Rows:

rc!D
~
~

(Borders ... J
(Preu. Column )
( NeHt Column J

Figure 7-88

Dialog box sh owing ch anged width of columns

The result of widening the columns is sh own in Figure 7-89.

Figure 7-89

Th e wider fi rst two columns
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The changes you made to the c lumn width in t he Cell s d ialog box
affected the columns you had selected. If you had selected on ly o ne
column, o ne cell, o r one or more rows, the ch ange wou ld have affected
on ly whatever you had selected.
The width of these two columns h as increased, and t he th ree columns
that weren't selected h ave remained the sam e. Each of these last three
columns n eeds to be on ly 1 inch wide, so yo u can change them in the
sam e m anner.
,.

Drag t h rough those three column s to highlight them, and t hen
choose Cells fro m the Form at menu .

•

In the Cell s dialog box, cha nge the Width o f Col umns box to 1 in,
and then click OK.

Notice that the total width of the 5-column ta ble is now t he same wid th
as the 1-column table above it.
W-S

•

Save your work n ow.

A shortcut for chan ging cell or column widt hs is to use the scale icon on
the ruler. If you cl ick on this icon while the insertion point is in a table,
the scale switches to the table scale. Th is table sca le shows "th um btacks"
placed alo ng the ruler wh ere cell margins are. You can d rag to cha nge
th e width of a cell in the row t h at contains the insertion point . The table
scale is shown in Figure 7-90.
Food Uelue Table
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Figure 7-91

The table scale on the ruler

To cha nge the width of an entire colum n using the table scale, you must
first select the column. Otherwise, the ch ange will affect only the row
that contain s the in sertio n point.
To toggle back to t he no rmal ru ler scale, click on the sca le icon. Cl icking
on the scale icon while the ruler is in the table scale takes you to th e page
scale, which h as brackets to represe nt wh ere the page margin s are.
Clicking on the scale icon again retu rns you to the normal ruler scale.
Notice that the alignment and spacing icons on the ruler are dimmed
when you are in table sca le or page scale. You must be in t he n ormal
ruler scale to access these set tings.

Changing Cell Alignment
Now t ha t the cells are th e size t h y need to be for th e data in the table,
th e alignment for each cell need to be set.
The tit le info rma tio n in the first 1-cell table should be centered.
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3€ -Shift-C

,.

Click anywhere in the first 1-cell table, and then click on the centeralignment icon on the ruler.

The text in the first column in the 5-colum n table sh ould be left aligned .
If you click in a cell in that column, you'll see that the rul er highlights
the left-alignment icon, since left alignment is t he default setting.
The text in the next column should be centered; you'll chan ge the
format to center alignment.
,,. Hold down the Option key.
Notice that the pointer changes into a downward pointing arrow.
,,. With the Option key h eld down, click on the cell in the second
column that contains the words "Portion Size."
The second column becomes highligh ted. Option-click selects an entire
column .
3€ -Shift-C

,,. Cli ck on t h e center-alignment icon o n the rul er. See Figure 7-91 .

Figure 7-91

Centering the second column

Now the data in the second column is cen tered within the column.
Notice that th e ruler becomes dimmed when more than one cell is
selected. This indicates that each cell has different margins or other
formats, and on ly the margins of the first cell selected are displayed.
The headings in the next th ree columns should be centered also.

00 -Shift-C

•

Click and drag through the six headi ng cells in the last three
columns, as sh own in Figure 7-92.

•

Click on the center-alignment icon on the ruler.
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Figure 7-92

Selecting and centering the h eading cells

Th e data in the last three columns of the rest of the table is numeric and
should be decimal aligned. To do this you n eed to set a decimal ta b for
aligning the numbers.
•

Click and drag through the last 3 columns in the 5-column table so
that just those 3 columns are highlighted.

, . Click o n the decimal tab icon, and then click on the ruler so that the
tab marker is approximately in the center of the Total Fat column,
as shown in Figure 7-93.

shO'Ning.the.fat and. choI estero 1.content of.certain. fo
lar.study.group ... See.Table. 7.qr
·leste·rol·:co'fite·nt:or'S'~lecte'd:·Fo·o'ds·:corri"·

·~~. . ~.~-~-~.~Y..:.~·r·~J.~~~~;.·. ~·:f~~~r:hl~;~. . . . . . . . . .
P~.~.i.?..~:..?..!?.~.!.......j.

Figure 7-93

Fat•

l

Fat•

~

cho

Setting a decima l tab for three columns

This will cause a deci mal tab to be set at approximately the center of each
of the three columns. When a decimal tab stop is placed in a cell,
pressing the Tab key to advance to that cell automatically advances you
to the deci mal tab position within the cell. For any tab stop other than
the decimal tab, you must use Of tion-Tab to move over to the stop.

38 -S

.. Ch oose Save from the File menu.
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Now that you've made all these formatting changes, your screen should
look like the one shown in Figure 7-94.
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Figure 7-94

The formatted table

Borders and column separators will make this table easier to read. You'll
learn how to add them next.

Adding Borders and Column Separators
,.,. Select the entire table by holding down the Option key whil e
double-clicking anywhere within the table.
The entire table becomes highlighted.
,,. Choose Cells from the Format menu, and click the Borders button
in that dialog box.
•

Select the double line from the five icons running down the left side
of the dialog box, and then click on the top, bottom, left, and right
edges of the schematic diagram to produce a border around the
whole table. Your dialog box should look like the one shown in
Figure 7-95.
Cell Borders
App ly To
®Selected Cells As Bl ock
0 Euery Cell I n Selection

Figure 7-95

Applying the border to the block of cells
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".. Click OK in that dialog box, and then click OK in the Cells dialog
box to get back to the table.
,.. Click anywhere outside the table to deselect it so you can see the
border you just created.
Next you'll place a line above and below the column headings to set
them off from the data in the columns.
•

Double-click in the selection bar to the left of the Food Item
column heading to select the whole row of column headings. See
Figure 7-96.

Figure 7-96

Selecting a row using the selection bar

,.. Choose Cells from the Format menu, and then click the Borders
button.
,.. Select the single thin line, and then click at the top and bottom of
the borders schematic to place a line above and below the selected
block of cells. Leave the double lines on the left and right of the
schematic. See Figure 7-97.
Cell Borders
Apply To
®Sel ected Cells As Block
0 Euery Cell In Sel ection

I

Figure 7-97

•

Adding borders to the headings

Click OK in that dialog box and again in the Cells dialog box.
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,,, . To place a vertical line between the columns, select the three central
column s of the table, as shown in Figu re 7-98.

Figure 7-98

Selecting the central columns

,,, . Choose Cells from the Format menu, and then click the Borders
button.
••

In the Cell Borders dialog box, click Every Cell In Selection.

This indicates that you want the borders applied to each cell in the
selected area and not to the block of cells as a whole.
•

Click on the left and right sides of the borders schematic diagram
to p lace a line on each side of each cell in the selected block, as
shown in Figure 7-99.
Cell Bor d ers
Rpply To
0 Selecte d Cells Rs Block
@Ellery Cell In Selection

Figure 7-99

Adding column sepa rators to the selected cells

•

Click OK in the Cell Borders dialog box and again in the Cells dialog
box.

•

Finally, select the last cell in the table, the one containing the source
information, as shown in Figure 7-100.
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Selecting the last cell in the table

,,. Choose Cells from the Forl at menu, and then click the Borders
button.
,,. Select the single thin line, and then click at the top of the borders
schematic to place a line above the selected cell. Leave the
double lines on the left, right, and botto m of the schematic. See
Figure 7-101.
Cell Borders
Apply To
@Sel ected Cells As Bl ock
0 Euery Cell In Selec tion
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Figure 7-101
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Adding borders to the last cell

,. Click OK in th at dialog box and again in the Cells dialog box.
3€ -S

,. Save your work.

I

Let's take a look at the table now th at you've added the borders and
column separators.
3€- y

,. Choose Hide Cj[ from the Edrt menu.
Your table should look like the one in Figure 7-102.
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Food Item
Lean ground beef
Tuna salad
Peanut butter
Whole milk
Skim milk
Butter
Vanilla ice cream

Figure 7-102

302.
112 cup
2Tbsp.
1 cup
1 cup
1 Tbsp.
112 cup

40
0
33
5
31

30

The table with the bo rde rs and column separato rs

Adding more white space in the table will keep it from looking so
cram ped. Yo u' ll do tha t now.

3€ - Y

Ch oose Show 91 from the Edit me nu.

•

Changing Spacing Between Rows
The contents of cells can be formatted using m ost of the commands fo r
character and paragra ph fo rmatting. You'll use the Paragra ph command
to add space to some o f the cells and rows.

3€ -M

10

•

C lick an ywhere within t he title cell of the table, a nd then choose
Paragraph fro m the Fo rmat menu .
In the Parag raph dialog box, in th e Spacing sectio n , type 12 in the
Before box and in th e After box, as sh own in Figure 7-103.
Par agraph

Indents
left:
Right :
Firs t :

~

B

" "El
Spacing

t

Before: 12

( Can cel )

1~

~

Rrter:

0
0

Page Break Defore
Keep With NeHt 'I!

(

Tnbs ...

)J

Une Numbl.'rintj
Keep lines Together

) ( Border s ... ) (Position ... )

Figure 7-103

•

0
0

OK

Placing a 12-point space before a nd after the text

Click OK.

Th e text in that cell now has a 12-po int space a bove a nd belo w it.
•

Do uble-cl ick in the selectio n ba r to the left o f the cell with the Food
Item column h eading to select the entire row. See Figure 7-104.
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•

Click on the space-before ic . n o n th e rul er.

This places a space abo ve the tex t in the cell s in the selected ro w, as
sho wn in Figure 7-104.

Figure 7-104

Placing a space above the row o f column h eadings

C lick in the last cell in the ta ble, the o ne containing the source
info rmatio n .
3€ -M

•

Choose Paragraph from the Format m enu .

-

In t he Paragraph d ia log box, in the Spacing sectio n, type 12 in the
Before box and in th e After box, as shown in Figure 7-105.
Per11groph
Indents
Le ft:
Right:
Firs t :

§

Sp eclng
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line NumberlniJ
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Figure 7-105

•

0
0

I~

n OK

The space Befo re and After settings

Click OK.

The text in the source info rmatio n cell n ow has a 12-point space above
and below it.
3€ -S

•

Save your work.

Now the table looks good , except fo r a few fin al to uches. You' ll do som e
final ed iting to fine-tune the appearan ce o f th e table.
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EDITING THE TABLE
The e mpty row in th e 5-colu mn table needs to be deleted. You'll delete
that row now.

Deleting Cells
•

Double-cl ick in the selecti o n bar to the left of the e mpty cells at the
e nd of th e 5-column table to select th e entire row.

•

C hoose Table fro m the Ed it me nu.

The dialog box t hat resul ts is s hown in r:igure 7-1 06.
Table
@ Row
Q Column
0 Sel ec tion

Insert

J

Delete

(Merge Cells)
(cancel )

Figure 7-106

•

Deleting the selection

C lick the Delete butto n to delete th e selected ro w.

Merging Cells
The word "(gram s)" under the heading in the Total Fat column needs to
be centered unde r bo th that column and the Saturated Fat column. To
d o this, you' ll merge two cells. When you merge two cells, yo u create
o ne ce ll that contains th e contents o f both.
•

To m erge the cell con taining the word "(gra ms)" with the e mpty
cell to its rig ht, select both cells by dragging th rough them. See
Figu re 7-107.
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Selecting th e two cells to be me rged
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•

Choose Table from the Ed it l

n u, and cJ ick Merge Cells, ass hown

in the dialog box in Figu re 7-108.
Teble
Q Row
Q Column
@ Selection
Shirt Cells

Figure 7-108

31: -S

Insert
Delete

~
Merging the cells

•

Select and delete the paragraph mark (<Jl) that was placed after
"(gram s)" in the merged cells so that the cell consists of only one
line.

•

Save your work.

•

Scroll to the beginning of the document.

If you look closely at the document you' ll see that the double border
a rou nd the table extends beyond the left of the text in the first two lines
of the docum ent. In order for the text in a table to align with the text
in the rest of the document, Microsoft Word places the border of the
table slig htly to the left of the left margin . In this case it will look better
if the border aligns with the text in the first two lines. You' ll adjust that
now.

Adjusting Margins
•

Ho ld down the O ptio n key and double-cl ick somewh ere in the
table.

This selects the whole table.
•

Click o n the sca le icon o n the ruler to d isplay the table scale.

The ruler will be dimmed, an d a "thumbtack" will appear under the
6-inch mark.
•

C lick and d rag the left in dent marker 1/8 inch to the rig ht, as sh own
in r:igure 7-109 .

Figure 7-109

Moving the left indent for the table

The en ti re table w ill shift 1/8 inch to the rig ht, and the left border of the
table wi ll line up with the text in the first two lines of the document.
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3€-R 3€- Y

•

Choose Hide Ruler from the Format menu and Hide
Ed it menu.

Cj[

from the

You sh ould be able to see your entire finished document on the screen,
as shown in Figure 7-110.

=o

Food Ualue Table

The following Is a table showing the rat and cholesterol content of certain foods
of interest to this particular study group. See Table 7.
Table 7. Fat and Cholesterol Content of Selected Foods Common
to Diets of Elderly Nursing Home Patients

Food Item

Portion Size

Lean ground beef
Tuna salad
Peanut butter
Whole mill<
Skim milk
Butter
Vanilla ice cream

3oz.
112 cup
2Tbsp.
1 cup
1 cup
1 Tbsp.
112 cup

Total
Fat

14
10
16
8
1

11
7

Saturated
Fat
Cholesterol
(grams)
(milligrams)
6.0
80
2.0
40
2.0
0
5.0
33
0.2
5
7.0
31
4.0
30

Source: USDA, Htman Nutrition Information SerYice.
Page 1

Figure 7-110

!Normal ......

IQI

The finished Food Value Table

Changing Borders
Placing the borders around the cells can be somewhat tricky. If you did
not get the effect you wanted, you can follow these steps for removing
the borders from the cells or group of cells:

3€-S 3€- P

•

Select the cell or block of cells that you want to remove the borders
from.

•

Choose Cells from the Format m enu, and then click the Borders
button.

•

In the Borders dialog box, click on each line in the borders schematic
diagram that you want to remove. This will remove the line from
the schematic.

·•

Click OK in th e Cell Borders dialog box and again in the Cells dialog
box.

•

Save your work, and then print your document.

Compare your printed document to the one at the beginning of this
project and make any necessary corrections.
•

Choose Quit from the File menu to exit Microsoft Word. Or, if you
are continuing with the next project right away, choose Close from
the File menu.
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Project 4: Creating a Newsletter
Desktop publishing is a term heard often today. It refers to using a
computer and one or more applications to create quality presentation
documents, such as magazines, newsletters, annual reports, and
brochures.
There are many page layout programs on the market that help the
desktop publisher with design and production. These programs usually
specialize in one area of desktop publishing and are used in combination
with other programs to pull together the total project.
In this project, you'lllearn to use features in Microsoft Word to create
a newsletter worthy of the term "desktop publishing." Microsoft
Word's page layout properties enable you to design the page without
having to incorporate your work into another program. Microsoft
Word also allows you to add graphics and documents from other
programs to a Microsoft Wo rd document.
This project introduces you to the section in Microsoft Word. A section
is any part of your document that you designate as separate from
another part. You can compare a section to a chapter in a book. A
chapter is a part of the whole book, but it is also separate from other
chapters.
You can divide a document into one or more sections and then form at
each section differently from other sections in the same document. You
can even have several sections on one page, each formatted differently.
The formatting characteristics applied to a section are controlled through
the section's dialog box. If you do not divide your document into
sections, Microsoft Word treats the entire document as one section, and
the settings in the Section dialog box will apply to the whole document.
You'll create four sections in a document in this project, and each
section will be formatted differently. You'll also learn how to adjust
margins using the Print Preview margins tool, and you'll be introduced
to Page View.
A finished version of the Traveling Times newsletter is shown on the next
page in Figure 7-111, and a printed version of the unformatted document
that is used in this project is sho n in Figure 7-112 on the page after that.
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February Issue, Volume 14
MOUNTAIN RACING
On any given Saturday night from April to
October, the roar of car engines can be heard
throughout the Peachtown area of Murley. North
Carolina.
Peachtown Raceway. located on old 46 just
west of Peachtown. is a dirt track that fea tures
five classes of race cars from the Enduroc lass
(the least expensive cars) to the Sportsmanclass
(some of these cars range up to $30,000! ).
Racers come from many surTounding areasof
North Carolina. Georgia, and Tennessee.
Although the monetary prizes are not very large,
the fun and excitementfor these dri vers and their
families are obvious.

All evening in the pits there is an air of
frivolity as the dri vers banter back and forth
while waiting for their turn on the track. The
more participants there are in each class, themore
and
exc itement.
competition, challenge.
Amazingly, even on a cold or dri zzly nightthe
stands are full of spectators urging on their
particul ar hero, and they don 't even seem tomind
when they are splattered with fl yingchunks of
mud.
Attending Peachtown Raceway is always a
fun evening for all. participants or spectators.
and a good way to entertain kids. Be sure to put
thi s on your list of things to do when visiting the
moumains of western North Caroli na.

Traveling Times
Bringing the world to you!
THE CAYMANS
On my recem travels to the
island of Grand Cayman
an
interesting
survived
experience.
While I slept
comfortabl y in an excl usive
resort hotel, an incredible storm
was tearing the island apart. A
"norwester." as the islanders ca ll
it. had hit the main town of
Georgetown and had done
ex tensive damage. The public
beach was completely washed
away. and debris was scattered
everywhere. Several shops in
town were underwater. and a
couple of homes had been
transported from their original
dwelling spots to new locations.
Grand Cayman is the largest
of three islands just south of
Cuba. Originally discovered by
Christopher Columbus on his
fourth voyage to North America.
it was eventually settled by
pirates and escaped slaves. In a
treaty with Spain in 1670. the
islands were transferred to
England, and
they have
remained a Bri tish Crown
Colony.

The island was an importalll
food
source
for
many
generations, since it was
inhabited with thousands of
turtles and marine crocodiles
called Caymanas (which is
where the islands got their
name). After depleting the turtle
population over the years. the
islanders now have a large turtle
farm where they hope to manage
the s pecies and prevent it from
becoming extinct. Turtle soup
and other specialty dishes are
still favorites on the island and
are served in most restaurams.
Unfortunately. most of the
turtles at the farm escapedduring
the storm.
Another illleresting aspectof
the Cay mans is the blending of
races into a comfortable.
integrated society. Being from
different parts of the world and
having several different ethnic
backgrounds. these people have
created their own un ique culture.
There is a native quality from
Jamaica and many
other
Caribb~.:an b l and~, along wi th an
aristocratic air from the English

Figure 7-111

and Wel sh influences.
The
language of the Caymans is
English, but they do have their
own melodic version of it that
they
usc
in
everyday
conversati on with each other. It
is a joy to hear. even when you
have no idea what they arc
talking about.
The Cayman Islands are a
paradbc
for
divers
and
beachcombers. Three sides of
Grand Cay man are surrounded
by a reef that is perfect for
snorkeling. while the fo urth side
has miles of white sand on its
shoreli ne and is appropriately
named Seven Mile Beach. There
are also hundreds of shipwrecks
within minutes of shore. where
divers can search for buried
treasure to their heart' s content.
At the north end ofthe island
is a tiny town called Hell. You
can imagine the remarks that
come from that place! At least I
can say I made it to Hell and
back!

Final output of Project 4

-M.Swan
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On any gi ven Saturday night from April to October. the roar of car engines can be heard
throughout the Pc<Jchtown area of Murley, North Carolina.
Peachtown Raceway. located on old 46 just west of Pcachtown. is a din track that features
live classes of race cars from the Enduro class (the least expensi ve cars) to the Sportsman
class (some of these cars range up to $30.000!).
Racers come from many surrounding areas of North Carolina. Georgia. and T ennessee.
A lthough the monetary priLes arc not very large. the fun and excitement for these dri vers
and their families arc obvious.
A l l evening i n the pits there is an air of fr ivolity as the dri vers banter back and forth while
waiting for their turn on the track . The m ore participants there are in each class. the more
competition. challenge. and excitement. A mazingly, even on a cold or drizzly night the
stands are full of spectators urging on their particul ar hero. and they don' t even seem to
mind when they arc splattered with n y ing chunks of mud.
A ttendi ng Peachtown Raceway is always a fun evening for all. participants or spectators.
and a good way to entertain kids. Be sure to put this on your list of things to do when
v isiting the mountains of western North Carolina.
On my recent travels to the island of Grand Cayman I survi ved an i nteresting experience.
While I slept comfortabl y i n an exc lusive resort hotel. an incredible storm was tearing the
island apart. A "nor wcstcr ... as the islanders call it. had hit the main town of Georgetown
and had done extensive damage. T he public beach was completely washed away. and
debris was scattered everywhere. Several shops in town were underwater, and a couple of
homes had been transported from their original dwelli ng spots to new locations.
Gmnd Cayman is the largest of three islands just south of Cuba. Originally di scovered by
Christopher Columbus on his fourth voyage to Nonh A merica. it was eventually settled by
pirates and escaped slaves. In a treaty with Spai n i n 1670. the i slands were transferred to
England. and they have remained a Br iti sh Crown Colony.
T he island was an i mportant food source for many generations, since it was inhabited wi th
thousands of turt les and marine crocodiles called Caymanas (which i s where the islands got
their name). A fter depleting the turtle population over the years, the islanders now have a
large turtle farm w here they hope to manage the species and prevent it from becoming
extinct. T urtle soup and other specia lty di shes are still favorites on the isl and and are
served in most restaurants. Unfortunately, most of the turtles at the farm escaped during
the storm.
A nother interesting aspec t or the Caymans is the blending of races into a comfortable.
i ntegrated society. Being from different parts of the world and having several di fferent
ethnic backgrounds. these people have created their own unique culture. There is a nati ve
quality from Jamaica and many other Caribbea n islands, along with an ari stocratic air from
the Engl ish and W elsh influences. The language of the Caymans is Engl ish, but they do
have their own melodic version of it that they usc in everyday conversation with each other.
It is a j oy to hear. even w hen you have no idea what they are talking about.
The Cayman Islands arc a paradise for divers and beachcombers. T hree sides of Grand
Cayman are surrounded by a reef that is perfect for snorkeling. while the fourth side has
miles of white sand on its shoreline and is appropriately named Seven Mile Beach. There
are also hundreds of shipwrecks within minutes of shore. where divers can search for
buried treasure to thei r heart 's content.
At the north end of the island i!> a tiny town called Hel l. You can i magine the remarks that
come from that pl ace! A t least I can say I m ade i t to Hell and back!

-M. Swan

I
Figure 7-112

Unfo rmatted Traveling Times n ewsletter
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Since the object of this project is not to focus on your typing skills, an
unformatted document is used. This document is supplied on the
Macintosh Journey Projects disk, which accompanies this book. Artwork
for the newsletter is also supplied on the same disk.

RETRIEVING THE UNFORMATTED DOCUMENT

I]-TravelinQ Times Unformatted

Thereareacoupleofways to begin this project. The most straightforward
way is to locate the document entitled "Traveling Times Unformatted"
and double-click on its icon. This will start Microsoft Word and open
that document.
Another way is to do uble-click on the Microsoft Word icon to launch the
application, and then choose Open from the File menu. Locate the
Traveling Times Unformatted document (click the Drive button if
necessary), and double-click on it to open it.

W -0

If you did not quit Microsoft Word after the last project, choose Open
from the File menu and double-click on Traveling Times Unformatted
to open it.
Whichever of the above methods you chose, the document Traveling
Times Unformatted should be on your screen.
Since you do not want to alter the original d ocument, the first thing you
need to do is make a copy of this document to work with.
•

Choose Save As from the File menu and change the document's
name to Traveling Times. Verify that you are saving this document
o n your data disk, and then click Save. See Figure 7-113.
I ~ Carolyn Phillips

I
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Figure 7-11 3

~
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Saving the document as Traveling Times

FORMATTING THE DOCUMENT
A couple of formatting changes need to be made to this document
before you divide it into sections.
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•

Choose Show Ruler from tl e Format menu and Show <JI from the
Edit menu .

•

Select the entire document by ho lding down the Command key and
clicking an ywhe re in the selectio n bar of the document, as shown
in Figure 7-114.

Figure 7-114

•

3€ -Shift-]

With the document selected, move the first-line indent marker on
the ruler (the to p triangle) to the 1/4-inch mark on the ruler to
indent the first line o f each paragra ph .

, .. Click on the justified-alignment icon o n the ruler to justify the text
between the margins. See f igure 7-115.

Figure 7-115

3€ -Shift-R

3€ -Shift-B

3€ -Shift-C

Selecting the entire document

The ruler with 1/ 4 inch first-line indent

-•

Scroll down to the last line in the document, "-M. Swan", and click
an ywhere in that line. Right-align that paragraph by clicking on the
right-alignme nt icon on t hl ruler.

•

Insert a blank line at the tog o f the document, and click to set the
insertion point in tha t line~J

,.,. Choose Bold from the fon~at menu, and then type MOUNTAIN
RACING in all caps. Click o n th e center-alignment icon on the ruler
to center that line.
I
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,,. Scroll to th e middle of the d ocument, where a Return marker
separates th e two newsletter articl es.

3€ -Shi ft-B

•

Insert an ot her b lank li ne in fro nt of t h e line beginning with the
words "On my recen t travels" and click in that new line to set th e
insertion point.

3€ -Shift-C

•

C hoose Bold from the fo rmat m enu, and then t ype THE CAYMANS
in a ll caps. Cen ter it using the center-alignment icon on the ruler.

W-S

•

Save t hese chan ges to your documen t.

During t he rest o f the instructions for this proj ect , you won' t be
prompted to save your work. That does n 't mean you sh ouldn't do so,
it just means you sh ould be thinking of that step on your own by now.
Now let's divide this document in to four sections.

CREATING A NEW SECTION
,,,. To set the insertion point, click in front of the Return marker
separating the two articles.
,,.

Hold down the Com m and key and press the Enter key (on the
n um eric key pad) to insert a section break m arker.

Be careful to press the Enter key just o nce. If you keep holding it down,
a series of section breaks will be created. If you had a h eavy hand on thi s
key, select t he extra sect ion m arkers by dragging through them, and
then press Backspace to d elete them .
Your screen sh ould have a double dotted line running across it. This is
t he section break m arker. See Figure 7-116.
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an. incredible.srorm. was.

Figure 7-116

The section brea k marker
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•

To create the next section, lick to the left of t he title line, "THE
CAYMANS," that you typed Ja few steps back.

The insertion point should b e to the left of the "T" in that line.

• Use the Command-Enter key sequence to insert a sectio n marke r at
that point, as shown in Figure 7-117.

10

*

File

Edit

Font

Format

Document

Utilities

Wi ndow

01

Trauel in g Tim es

.

2

IIID

JNor mel

0

1"

j'

ra:r

t.

a,., rs r

4
~ I

II

I

a ~::~

.....

features. tive.cW.es.of.JOCe.cars.rrom.1he. Enduro. clo.ss.(1he.Je.,\. expe..,ive. em ). >:>.1he.
Spon.mancla:!s.(some.of. these.cm.ronge. up. t>$30.(JOOQ.<lt
Racers . come . from. meny . sunound.tng . are.. . of . Nonh. Carollno, . OeO!ilo., . and.
Tennessee ...Altho1Jih·1he -mone10I)'.plizes.are.no\.very.lo.lie,. \lle. fun .and .exci\Omen\. for.
1hese.dr\.,.rsand.1heir.f1Ullllies.are.obvious. 'll
All.eveni:ni.ln- the.pit:J. there.!s.an.eJ.r.of.frtvolity. 83. the. dlivers. banter. be.ck.. eJ\d . forth.
while.waitin&'-for. their. tum on. the.track ...The -more. participarlts. there. are .in.each.cl&.ss •.the.
more.compe\i\ion,.cllellenge,.and.exci\Oment. ..Ame:!tngly,. eyen.on.a.cold . ~r.dlizzly. nl&ht
\lle.s\0Jids.are.full of.spec1a\Ors. Ulilng-On 1heir. paroculo.r.herof.and.\lley.don tev.n.seem. \0.
mind. vhen 1hey.ere.splanered.m\h.fly~ng.chunks.of. mud. 'll
A11endtng. Peach\Ovn. R..,.v.y. i:J. olvays . a. fun . eve~. for. oll,. par\icipanto . or.
spec1a10rs ,.01\d. a. good. vay. \0. enlllrtain kids ... Be sure.>:>. put Uu:i.on your.list of.lhini• ·\0. do.

r;:;r

l1;t

t:

'.J

111:~

i: ;.

r::~
IJ!•j•
I·I!H!:l.
;•
11

:::~::::·:::::::::::::::::::::::l::~~:~~~::::~::::::::::::
JTHI!.CAYMANS'll

0

••...O.!~~Y·. ~~~-~~:"~~~rn'!~~~~ L.~~ ·,;.~,:.~ -~~•.~·. !:':!!~!!:

1

PI Sl

Normal+...

Figure 7-117

U:i[:
!i::J.

1!:!'
:o;o

5

101 I:H, .: •. ,::;r:':':•:':) •..:,.;r;:: ·'"'"'" '•'·'· IE:~

Inserting the second section break

Now let's create the last section at the end of the document.
•

Scroll to the end of the document an d click after the last line in the
document, "-M. Swan".

The insertion point should be to the right o f the "n" in that line, at the
end of "Swan".
•

' a

Use the Command-Enter key sequence to insert a section marker
there, as shown in Figure 7-118.
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Inserting the third section break

I
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Now the docume nt is divided into four sectio n s. Th e first section will
be fo rmatted in a two-column layo ut.
••

Click an ywh ere in t he first sectio n , above th e double lines.

Thi s te lls Microsoft Wo rd which sectio n you want to apply the ch an ges
to.
,,.

C hoose Section fro m the Fo rm at menu.

The resulting dialog box is sh own in Figure 7-11 9.
Section

Sta rt: I Ne w Page

!OI 0 lm:lude £ndnotP.s

Page Number 0 Auto
0 Res tart a t t

line Numbe rs

,, 23
frorn Top:

IOff

IOI

~

rmm Right: [ o.'i~
r:Number:
olumns
Spacing:

~

Figur e 7-11 9

IOI

Count btj:
from l1~nt:

~

ODl
[Cancel )

( Apply J
[Se t Default ]

Heade r/ Footer
FromTop:
~
From Bottom: 0.5in

0 Firs t Page Special

The Sectio n dialog box

Since the optio n s in this dialog box ca n be applied to yo ur w ho le
docu ment if it consists of o nly one sectio n (and most documents d o
con sist of onl y one section ), you need to u ndersta nd w hat som e of these
options ca n do.
The Start portio n of this dia log box consists of a d rop-dow n list from
which you choose where yo u'd like the section to sta rt. The d efault is
New Page, which causes the text in a section to begin on a new page.
Othe r o pti ons are No Brea k, New Column , Even Page, and Odd Page.
You ' ll be using the New Page and No Break options in your n ewsletter.
The Page Number po rti o n allows you to n umber the pages o f th e section
(or document) autom atically . The dro p-down list in this fi eld gives you
severa l nu mber forma ts to choose from. To number pages from the
Secti on dialog box, click Auto. The From Top and Fro m Right boxes
becom e acti vated , and the page number is positioned o n the page using
those fields. The newsletter yo u are creating in th is pro ject will n ot have
page num bers.
In the Columns portion of the d ia log box, Number indicates the
number of columns that sectio n should contain, and the Spacing box
tells how much space should be between columns. The documents
you've worked with in this chapter have all consisted of one column . In
this pro ject you' ll combine two-column, o ne-column, and three-column
layouts all o n o ne page.
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The Header/Footer portion allow you to change the vertical position of
the headers and footers. (Header and footers will be discussed in more
detail later in this project.) The Frst Page Special option enables you to
create a header and footer for the first page of the section (or document)
that can be different from the standard header and footer. This is
especially useful when you are creating a document that requires a title
page, since the header and page number should not print on the title
page. You would create a blank First Page Special header and footer and
put the page number and other heading data in the standard header or
footer, which applies to each subsequent page in a section.
Now you'll use the Columns portion in this dialog box to change the
first section in the document to two-column format.

CHANGING THE NUMBER OF COLUMNS
•

Change the number of columns to 2 in the Section dialog box, as
shown in Figure 7-120, and then click OK.
Section

0:0I
[cencel

~

[Set Default I
Header/ Footer---,
FromTop:
~
From Bottom: ~

D First Pege Special
Figure 7-120

Changing the number of columns to 2

Your text is now shown in one column running down the left side of the
screen. In Galley View, which is Microsoft Word's regular view, you can't
view both columns at once, but Page View and Print Preview allow you to
view the columns arranged next to one another on the page. After you
set up the layout of your other three sections you'll use Page View and
Print Preview to view the document.
•

Scroll down to the second section of the document, the one that
consists of one Return marker with a section break both above and
below it.

.. Click in the line between tre section markers, and then choose
Section from the Format menu.
•

In that dialog box, click on tJe arrow to the right of New Page in the
Start portion, and drag down to select No Break, as shown in Figure
7-121. Then click OK or press Return.
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Changing the start to No Break

The No Break option tells Microsoft Word that this section will start
where the previous sectio n left off and will not begin o n a new page or
a new column .
Now let's work with the layout of the third section.
•

Click on the same line that contains the title "THE CAYMANS", and
choose Section from the Format menu .

'",. In the Section dialog box, change the Start to No Break, the number
of columns to 3, and the Spacing to .25 in as shown in Figure 7-122.
Then cl ick OK.
Section

I

Stur t : No Break

!ol

Pa ge Numbe r O Au to
0 Res tort at I
II 2 3
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Figure 7-122
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First Page Special

Settings for the three-column section

Now this sectio n h as a narrow column of text going down the left side
of the page.
The fourth section of the document was created so that Microsoft Word
will balance the length of the text in the columns above it. Inserting a
section that has the No Break format at the end of a document causes
Microsoft Word to ad just the lengths of t he columns in the sectio n that
precedes it until they are approximately equal.
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•

Scroll to the last section in he document, and click on the line
below the last section market in the document.

•

Choose Section from the Format menu, and in the Section dialog
box change the Start to No Break. Click OK.

ADDING AND FORMATTING A GRAPHIC
Now you'll paste the Traveling Times logo into the newsletter.
On the Projects disk is a document called "Traveling Times Logo."
00-0

•

3€ -C

,.. Click on the graphic to select it, and then choose Copy from the Edit
menu to copy it to the Clipboard.

00- W

"•

00- V

Choose Open from the File menu, and double-click on Traveling
Times Logo.

Close that document by clicking in its close box.

,.. Be sure the insertion point is in the blank line in the second section
of th e document. Choose Paste from the Edit menu to paste the
graphic into that section.
Next you'll make some formatting changes to this section.
•

r

Select the lines between the section marks, but do not include the
section marks. See Figure 7-123.
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Selecting the area between section marks

first-~ine

•

On the ruler, move the

indent marker back to 0.

•

Drag the right indent marker to the 6-1/2-inch mark, and then click
on the center-alignment icon on the ruler to center that section. See
Figure 7-124.

302

Pa1t Ill: Word Processing

r

File

•

Edit

Format

Font

Docum ent

Utilities

Wi ndow

iD

IH!)

!Normal

D

t

:t

t

1

luds ... Be sUJO 10 pu~ thio.on.J!Our. Ust of
lhin&•· lO.do.vhen.V1Sitma:.the.moun10ins
of..,..,,.mNor1hCarollna..<l!

Traveling Times

(~~J~'t;;

l.r<
\..,.. _ 'r·
Bn"ogiog IDe worltlto you.' ~-)

~,..,..,

,

===-fiiE£AYM~·"·''"':au.''"'m ...:•:~:""''·'=:"":~r..:~~....:au:~.~;;;-.::n:~~-.::-~~~=·~==:

On.my.recenl. uaveJs. 10
the . !3lml of Grm!.
Coymon . I . SU!Vlved an.
mte~une:

experience ..

PI SI

Norm al +...

Figure 7-124

Formatting the second sectio n with the ruler

Now you'll put a border around this logo and add som e space above and
below it.

3€ - M

•

Choose Paragraph fro m the Format menu, and click the Borders
button in the Paragraph dialog box.

•

In the Paragraph Borders dialog box select the double line, and then
cl ick at the top and bottom of the schematic diagram to place a
double line above and below the selected graphic, as sh own in
Figure 7-125.

0
0
0

Pl ain DOH
Shadow DoH
Outside Dar
....__ _ _ __. ®Cus tom
Spacing:

C=:J

Figure 7-125

•

Placing a double line above and below the graph ic

C lick OK in the Paragraph Borders dialog box.

That wi ll take you back to the Paragraph dialog box. You' ll ch ange the
paragraph spacing in th e Paragraph dialog box.
ln the Paragraph dialog box, you' ll tell Microsoft Word to place a 6-point
space above and below the selected paragraph or, in this case, the
selected graphic. This wi ll place a small space above and below the logo
to set it off slightly from the text.
Setting the spacin g from the Pa ragraph dialog box is similar to using the
paragraph-spacing icons on the ruler, li ke you did in Project 1. However,
using this option in the Paragraph d ialog box allows you to specify the
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exact amount of space you wa11 t placed before or afte r the selected
paragraph. To remove spacing befo re o r after a pa ragraph in thi s dialog
box, type 0 in the appropriate field.
•

In the Spacing porti on of the Paragrap h dia log box, cl ick in th e box
next to Before and type 6. Press t he Tab key to move to the box n ext
to After, and also type 6 the re, as shown in Figu re 7-126. Then
click OK.

m
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~
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Indents
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Right:
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Before: 6

[ Con ce t ]

~

~
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0
0
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[

Tabs ...

0
0

Un<l NUillllPrin\1

Keep lines Toge ther

J (Borde r s ... J ( Position ... )

Figure 7-126

Ch an ging the Before and After paragra ph spacing

W hen you return to your docum ent, yo ur logo will have a double li n e
and a 6-point space above and below it, as shown in Figure 7-127.

Figure 7-127

The logo with the borders and spaces

CREATING A HEADER
Next you' ll create a header for the newsletter.
A header is text and /or graphics ~h at appear at the top of every page,
above the body of the document. A footer can also be text and/or graphics,
but it appears at the bottom of every page, beneath the body of th e
document.
In Project 1 of this chapter you created a letterhead at the top of the
memo randum, but it was actually placed in the document itself and
printed only on the page on wh i c~1 yo u had typed it. It was don e in this
way so that it would prin t on th first page of the memorandum only.
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In this project you'll make use of the header window. You'll also learn
about the footer window since, except for the ir placem ent on the
printed page, they are very similar. You won 't use a footer in this project,
but all that you'll learn about headers can be applied to foo te rs as well.
A header o r footer prints on every page of a document, unless the
document h as multiple sections and each of those sections h as a h eader
or footer. The First Page Special header was mentioned earlier in
refere nce to the Secti on dialog box. For additional information o n
headers and footers see Reference to Microsoft Word.
The newsletter you are creating in this pro ject con sists of o nly o n e
printed page, yet the instruction s for creating headers are just as
applicable for multipage doc uments .
•

Scroll to the beginning of the newsle tter, and click anywhere in t he
first section of the document.

Since each section can h ave a separate header a nd foo ter, yo u must
indicate the sectio n for which you want the h eader opened . If you recall
from when you were setting up each section , the first section o f t h is
document is the on ly one that will begin o n a new page. Therefore, this
is the o nl y section that will need a h eader.
•

Choose Open Header from the Document m enu.

An open window entitled "Traveling Times: Head er (S l )" appears at the
bottom o f the screen . See figure 7-128.
"(Sl )" in your header title indicates the section this header applies to.
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Using the Header Window Icons
Notice the three icons below the title bar in the left corner of the header
window shown in Figure 7-128.
The leftmost icon is the page numbering icon. If you click on that icon,
it places a page number in the window at the insertion point. Using this
icon tells Microsoft Word to place the correct page number in every page
of the document, much as it does when you place a page number in a
document while in Print Preview, like you did in Project 1 of this
chapter. However, using this icon in a header or a footer allows you to
adorn the page number with dashes on either side, the word "Page" in
front of the number, or any special formatting such as font and size,
which you cannot do with the Print Preview method.
The middle icon is the automatic date icon. It places the current date
at the insertion point in the header or footer. This date changes to the
currentdatewheneveryou open or print the document. The date comes
from the computer's system clock, the settings of which you can check
or ch ange in the Control Panel from the Apple menu.
The rightmost icon is the automatic time icon. It works like the date
icon, except that it places the current time at the insertion point in the
header or footer. It also changes to the current time when the document
is opened or printed. The time comes from the computer's system clock
as well.
These icons are also found in the footer window and work in the same
manner.
If you experimented with the date, time, or page number, make sure you
have deleted them from the header window. To delete any of these
en tries, select the item and press the Backspace key.
You format the header with a ruler in the same way that you format the
document. The header window uses a separate ruler from the one that
is used for the rest of the document, however. You'll use the header's
ruler to format your header.
3€ -R
3€ -Sh ift-B

".. Choose Show Ruler from the Format menu .
".. Choose Bold from the Format menu, and then type February Issue,
Volume 14 in the header window, as shown in Figure 7-129.
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Typing text in the h eader window

Click o n the right alignment icon on the ruler in the header window
to align the text with the right margin of th e page.

Now you'll place a border beneath the text in the h eader and a space
beneath the h eader line.
•

Double-click in the top portion of the ruler in the header window,
next to on e of the numbers on the ru ler.

This is a shortcut to choosing Paragraph from the Format menu. It
brings up the Paragraph dia log box.
•

Click the Borders button in the Paragraph dialog box.
In the Paragraph Borders dialog box select the thick si ngle line, and
then click in the bottom of the diagram to place a thick line below
the paragraph, as shown in Figure 7-130.
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Figure 7-130

The Paragra ph Bo rders dialog box

•

Click OK to return to the Paragraph dialog box.

•

In the Paragrap h dialog box, type 12 in the box to the right of After
in the Spacing section, as sh own in Figure 7-131. Then click OK.
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Your h eader sh ould look like th e one shown in Figure 7-132.
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•

The completed header

Once you have esta blished that your h eader is correct, click in the
close box of the header window to close the window.

The contents of the h eader and footer are visible on ly in Print Preview
or Page View or when the document is actually printed.
You're probably curious to see t~e effects of all the formatting changes
you've made to your document. You'll do that now using Print Preview.
Have you saved your work lately?

ADJUSTING THE MARGINS
3€ - I

•

Choose Print Preview from the File menu.

It looks good, except that the newsletter has gone to a second page.
You'll adjust that now.

The margins icon in Print Preview allows you to manually adjust the
margin s and the n immediately see the results of the change. You'll
adjust t he margin s until the entire documen t fits on one page.
·•

Click on the second icon dovJn the left side of the screen. This is the
margins icon.

When you do, dotted margin Iii es appear on the righ t-hand page.
•

Click on the first page to sele tit. The margin markers appear there.

Now you'll adjust the m argins by dragging the margin markers to
different locations.
•

Click on the bottom left handle of the margin marker that runs up
the left side of the page, as srown in Figure 7-133.
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..

Clicking on th e margin marker handle

Hold down the mouse button and drag to the left so that the num ber
showing at the top of the page, after the words "Print Preview:
Traveling Times," chan ges to 0.75 in, as shown in Figure 7-1 34.
Release the m ou se button.
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Figure 7-134

Changing the left margin

..

Do the sam e with the right margin ma rker, dragging it so the margin
w idth changes to 0.75 in for tha t side also.

..

Click on the margins icon (or double-click on the page) to tell
Microsoft Word to recalculate the margins and place th is text
between the new margins.

Notice h ow adjusti ng the margins made more text fi t on the first page .
as shown in Figure 7-135.
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Print Preuiew: Trau eling Times
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Ad justing m argins to fit the text

Now let's adjust the top and bottom m argins.
~

Drag the handle for the top margin, wh ich is at the top left of the
page, so that the new dimens ion is 0.75 in .

•

Drag th e handle for the bottom ma rgin, which is at the bottom left
of the page, so that the n ew dim ension is 0.50 in .

,.

Click on the margin s icon to see the effects of these cha nges.

Your entire docume nt shou ld fit o n one page n ow, li ke the one shown
in Figure 7-136. If it doesn ' t, keep adjusting the margins in thi s manner
until all the text fits on o ne page a nd the page on the right side in Print
Preview is completely blank.
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Figure 7-1 36
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,,.

Click Cancel when you are finished.

Although Print Preview offers limited document changes, it can help
you determine how a document will look when it is printed.
When you use Page View you can see a full-scale version of your
document showing exactly how it will look when printed. And, unlike
in Print Preview, you can edit and format text while in this view.
~ -Y

~

-B

"•

Choose Hide 'I[ from the Edit menu, and then choose Page View
from the Document menu.

.. Scroll through your document to see a full-size view of how it will
look wh en printed.
~- B

"•

When you are finished, choose Page View again from the Document
menu.

Galley View is not located on any menu. If you are in Page View, a
checkmark will be to the left of Page View in the Document menu. To
get back to Galley View, ch oose Page View again, which removes the
checkmark beside Page View and returns you to Galley View.
~ - S/ ~ - P

,,. Save and print the completed newsletter.
Compare it to the finished newsletter at the beginning of the project,
and use the procedures that you learned in this project if changes are
needed to make it resemble the sample newsletter.

~

-Q

,,.

When you are finished, choose Quit from the File menu, or close the
newsletter document and choose New from the File menu to begin
the next project.

l(r:~j~ct' 5: Creating Merg~ Documents
This project introduces you to one of the best time-saving features of
Microsoft Word-print merge. You 'II create a print merge main document
and data document that all ow you to create multiple customized letters
without having to type each one as a separate letter.
Figure 7-13 7 on the following page shows the four collection letters you
will create in this project. As you create the different components of this
print merge project, you'll be shown the final document at that point
in th e project.
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Rosenfelt Office Furniture
884 High View
Danville, KY 4

Rosenfelt Office Furniture and Supplies
884 High View Plaza
Danville, KY 40422

September I0, 1993

September I0, 1993
Ms. Sandra M. Hardin
ICU Corporation
497 Seemore Drive, Sui te 3
Ashevi lle. NC 29703

Mr. Jim Bell
Libraries R Us
1492 Manuscript Dr.
Mandarin, FL 49709

Dear Ms. Hardin:
Dear Mr. Bell:
According to our records your firm has a
of $2,950.00. You may have overlooked
Please check your records and send payn
If there is some reason that you have not
please call us to discuss the problem.

Accordi ng to our records your firm has an outstanding balance of
$ 15,500.05. You may have overlooked making this payment.
Please check your records and send payment today.
If there is some reason that you have not sent your payment,
pl ease call us to discuss the problem.

Thanks for your prompt attention to this
Thanks for your prompt attention to this matter.
Sincerely,
Sincerely,

Rosenfelt Office Furniture a
884 High View I
Danville, KY 4(

Rosenfelt Office Furniture and Supplies
884 High View Plaza
Danville, KY 40422

September I 0, 1993

September I0, 1993

Ms. Kay Kusunoki
Kusunoki Printers
13 17 Beech Place
San Francisco, CA 941 13

Ms. Faye L. Mauney
In Your Prime Beauty Shop
15 Mockingbird Lane
Pinelog, TX 69007

Dear Ms. Kusunoki:

Dear Ms. Mauney:

According to our records your firm has an
of $ 150.00. You may have overlooked m
Please check your records and send paym

According to our records your firm has an outstanding balance
of $950.2 1. You may have overlooked making this payment.
Please check your records and send payment today.

IF there is some reason that you have not 5
please call us to discuss the problem.

If there is some reason that you have not sent your payment,
please call us to discuss the problem.

Thanks for your prompt attention to this n

Thanks for your prompt at ention to th is matter.

Sincerely,

Sincerely,

Steven King
Credit Manager

Steven King
Credit Manager

Figure 7-137

The customized form letters
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CREATING A COLLECTION LETTER
,1?)
'·· '·•.

-

To begin the assignm ent, double-click on the Microsoft Word icon.
If you are alread y in Word with no file open, choose New from the
Fi le menu.

t···1io::wosoft '•,·i cwd

Your screen will show a new document called "Untitledl".

~ -R

-

From th e r:ont menu choose Times 12 point if you'll be printing to
a LaserWriterorNewYork 12 point if you'll be using an Image Writer.
Choose Show Ruler from the Format m enu.

You'll begin the letter by typing the letterhead information on the first
three lines.

,.

Type Rosenfelt Office Furniture and Supplies on the first line, and
then press Return.

•

Type 884 High View Plaza on the second line, and then press
Return.

•

Type Danville, KY 40422 on th e third line, a nd then press Return
three times to place two blank lines after the letterhead.

The letterhead should be centered and bold, and the first line will have
a large r point size. You'll make those formatting changes now.
,. Select Lhe three lines you just typed by dragging down the selection
bar to the left of the text, as shown in Figure 7-138.

Figure 7-138
~

-S hi ft-C

•

Selecting the text in the letterhead

Click on the center alignment ico n on the ruler to center the selected
lines.
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3€ -Shift-B

• Choose Bold from the Forma( menu to bold face the selected lines.
• Select the first line of the lette rhead, and choose 14 point from the
Fo nt menu.
This makes the first line of the letterhead larger than the address lines.
Aft er you've made these formatting changes, your letterhead sh o uld
look like the on e shown in Figure 7-139, which was typed using Times.
ti File Edit Format Font Document Ut llllle$ Window

r

10

01

Unlllledl

!Normal

IIQ)

D

t

15

14

12
:t
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I
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1&11 1- 1 I 1 l!l::al
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Roseofelt Office Furniture and Supplies
884 High v~... Plaza
Du~ , 1CY

40422

Page 1

INormoi

Figure 7-139

The fo rmatted letterhead lines

Now you will save this document a nd name it.
3€ -S

W- y

•

Choose Save from the File me nu.

•

In the resulting Save dialog box, click the Drive button, if necessary,
to ensure that the document is saved on your data disk. Name this
docume nt Main Collection Letter, and then click the Save button .

•

Before continuing with the rest of the letter, choose Show 'II from
th e Edit m enu.

The formatting characters sh own in Sh ow 9l will allow you to keep track
of the numbe r of blank lines between several of the paragraphs and will
be of use throughout the rest of the pro ject.
•

Click to the left of th e last pa ragraph mark in the document to set
the insertion point there, and the n type today's d ate.

•

Press Return fo ur times after ty ping the d ate to place three blank
lines afte r it, as shown in Figure 7-140.
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File

Edit

Format

Font

Docum e nt

Utilities

Window

Rosenfelt.Office.Furniture.and.Supplies<lf
884.High.Viev.Pla.za<lf
Danville , . K.Y . .40422<!1

qr
qr

'

·: :

September. tO ,.1993<!1

qr
qr
qr

il

fll

::

Figure 7-140

•

The date a nd three b lank lines after it

Next type the first lin e o f the address at the insertio n point:
Ms. Vicki Fitzgera ld

•

Press Return after th at line, and th en type the remaini ng li nes of the
address, pressing Re turn after each li ne:
lXI Corporation
3211 Dow Street, E.
DuPont, MI 53022

•

After typing the Zip code, press Return twice to get a blank line, and
then type:
Dear Ms. Fitzgerald:

•

Press Return twice to get a blank line after the sal utation.

In various projects in this chapter you used the space-after-paragraph
icon on the ruler to place spaces between pa ragrap h s. Sometimes it is
just as easy to press th e Return key to place a blank line after a paragraph,
especia lly when some paragraphs will be followed by more tha n one
blank line.
•

Type the first paragraph of the letter:
According to our records your firm has an ou tstanding balance o f
$1,722.00. You may h ave overlooked maki ng this payment. Please
check your records and send payme nt today.

Con tinue typing the rest of the letter. Press the Return key twice at the
end of each paragrap h to leave a blank line between paragraphs. After
typing Sincerely, press Return four times to leave three blan k lines
before typing Steven King.
•

Type the following to fi nish the letter:
If there is some reason that you have n ot sent yo ur payment, please
call us to discuss the problem.
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Thanks fo r your prompt attention to this matter.
Sincerely,

Steven King
Credit Manager
Now is a good time to save your work.
•

Cho ose Save from the File menu.

The rest of your document should look like the one shown in Figure 7-141 .
,. •

File

Edit

Format

0

10

2

11

Font

Document

Utilities

Main Collection Letter
3
4

.,

Window

er
5
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•

<jJ

Deu Ms ..Fitzgereld :<JI
<jJ

According. to.our.records.your. finn. has.an, outs1anding. balance. of. $1 ,722.00 ... You may.
have. overlooked.malting.1hi3.payment. .. Please. check. )'"'ur. records.and. send. payment
today.<ll
<ll
If. there.is.some.reason.thet youhave.notsent )'"'ur. payment,. please. call us. to.discuss. the.
problem.<ll
<ll
Thanks. for. your. prompt attention.to.lhis.matter. <JI
<ll
Sincerely,<JI
<ll
<ll
<jJ

Steven.King<ll
Credit Manager<ll

Page 1

Figure 7-141
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The rest of the d ocument

You just created a collection letter that you could use as a template to
the n change and send to man y people. To send it to a different
company, you wo uld first use the Save As command to save this letter
under a different name, so you do not alter the o riginal. You could then
modify the letter by typing in a new company name, address, salutation ,
and amount due. You would follow this procedure for each letter you
had to send and print each letter separately.
The above procedure would not be too tedious o r time consuming if you
had o nly a few letters to mail. But what if you had to do this with 75
letters on a monthly basis? Wo~ld you want to volunteer for the job of
modi fy ing each letter manually. Not only would the project take quite
a bit of time, but also the letters ould t ake up a lot of disk storage space.
Fortunately, Microsoft Word allows you to create customized letters
using its print merge feature. I
The concept of print merge is simple: Yo u create a main document that
contains the body of your letter, and you use special fields to mark the

I
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parts that will change with each letter. You also create a data document
that contains th e info rmation you want p laced in the special fields in
the main document. When you issue the Print Merge command, the
information from the data fi le is merged with the main document
to c reate customized form letters. This concept is illustrated in
Figure 7-142.
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I

PLANNING THE MERGE PROJECli

A print merge project requires som e planning before you can actua lly
create the documents. Let's discuss some o f those con siderations.

Defining the Steps
There are two key parts to every m erge pro ject: the main d ocument and
the data document. The main document contains the body of the form
letter. Th e data docum ent contains the n am es, addresses, and other
data that will be merged with the main d ocument to create th e
customized form letters.

The Data Document
Th e con cept o f a data file is basic to all computer applications. A fi le
consists of related records. In th e fi le illustra ted in Figure 7-143, the
records are related because each record contains data about student
grades. The fi le consists of stude nt grade records.
A record consists of rela ted fields, o r ite ms. The fields shown in fi gure
7-143 are related because they each contain information, or data,
pertain ing to one particular stude nt. The individual fi elds that make up
the st udent records are the name, course, and grade.

Fi le

name

course

grade

John Jones

Anthropology 20 I

B

Mary Smith

Calculus 30 I

c

Bob Doe

Biology 204

A

Sue Greene

Chemistry I 0 I

B

+

Record

+

Field

Figure 7-143

Th e fi le/record/ fi eld relationship

The gro up of fi elds to be used in one letter is refe rred to as a record. Yo ur
data document contains a record for each letter to be sent; therefore, if
you' re sending 20 customized lette rs, your data document will contain
20 records.
In this project yo u will crea te a data document in Microsoft Word. In
some prin t merge projects you may use an existing data file for your data
document, in which case you will not have to create one. Data
d ocuments, o r databases, can be created in Excel, Microsoft Word,
FileMaker, and m any other app lications.
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If the data file does not a lready exist, you do not have to create it before
you create the m ain docume n t. However, creating the data document
first can be helpful, because you will already have establi shed the field
names in the data file, and yo u'll know to use those same field names
in the main document.

The Main Document
The main document, at the very least, contains the following:
•

The text and layout of the form letter that will not change from one
letter to the nex t

•

The merge fields, the contents of which will cha nge from letter to
letter

•

The stateme nt that tells Microsoft Word the name of the data
document to use when m erging w ith th e main docum ent

In addition to the above parts of the main document, you can have
many commands and instructions embedded in the main document.
You'll learn more abou t these later in th is pro ject.
In this project you wi ll be modifyi ng the collection letter that you just
created to use as the m ain document for t he print merge. You won't
h ave to retype the parts of the letter that will not change from on e letter
to the next.

The Print Merge Command
After the data document and the main document are completed , you
issue the Print Merge command by choosing Print Merge from the fi le
menu.
This command tells Microsoft Word to duplicate the text o f the ma in
docume nt and to sequen tially insert data from each record in the data
document in the special m erge fields in the main document. A separate
letter is created for each record in the data document.

Defining Fields
When you create the documents for the pri nt merge, yo u need to
consider the field names to be used. Th e field names in the file
illustrated in Figure 7-143 are name, course, and grade. The fi eld names
are represe ntative of the actual data in each field-the nam e field
contains th e student's name, the course field contains the name of the
course, and the grade field contains the student's grade. ft is always a
good idea to define a fi eld with a meaningful nam e that accurately
represents the fi eld 's contents. The field names "field 1" and "55" do not
accurately define the contents of a field.
With that in mind, keep the names as short and simple as possible. Use
either all uppercase or all lowercase letters so you don't have to worry
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about whether you capitalized o ne and not an other. If you use a field
name that consists of two or m o re words, do not put spaces between the
words. This is especially important if you are using a program other th an
Microsoft Word to create the data file, beca use many applications do n ot
all ow spaces embedded in fie ld names.
You can determine the fi eld names first and then use them consistently
in both the main document and the data document. Since you have
alread y typed the m ain collection letter, you probably have an idea
abo ut which parts will change from one letter to the n ext and w hich
parts will not cha nge.
The parts of the letter that will chan ge are called merge fields. A merge
fi eld acts as a placeholder in the main document- it marks the slot
where the contents of a fi eld from the data document will be inserted.
The contents of the merge fields will change with each n ew letter that
is created in the print merge process.
Let's define the field nam es you'll be using in th is project before you use
them in both the main document and the data document.
•

'

Look at the main collection letter you just typed, th e first part of
which is sh own in Figure 7-144.
•
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Rosenfelt Office Furniture lllld Supplies
884 Hlch VieY PJua
Danrille, ICY 40422
Seplember 10, 1993

i

;:.

M• . Vickll'i""erold

IX! Corpon>.oon
3211 Dov Street, 1!.

I

DuPont, Ml 53022

~·

;.:

Dear Mo. l'i""erold:
Accordlne oounoconl• :,our !inn w IIJI Out:!lalldln& bal.m:eo!$1 ,722.00. You may
bavt ovttloot.td ~this payment. Pteeoe cbeclt :,ourrocon\5 ml ,.n4 payment

;l'llge I

Figure 7-144

0
It;;
'"·
The first part of th e main collection letter
jNorm B

IQ I

It is likely that the date will ch ange if you send these collection letters
ou t each month, so th at will be the first field to name. Let's call it "date".
The custo mer name is sure to change also. Although you m ay be
tempted to group the entire name under o n e field name, n otice that the
letter uses just the title and last name in the greeting, "Dear Ms.
Fitzgerald:". In such a case, you need to be able to use each part of the
name as a separate field. Let's call the fields in th e name "title",
"firstname", and "lastn ame".
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The name of the com pany will be di fferent for each letter also. Let's call
that fi eld "companyname".
Si n ce the address will change fro m letter to letter, let's call the address
fie ld "add ress" . In some cases, you may have an address that req uires
two lines, such as a street address o n o ne li ne and a post office box o n
a nother. In that case, you wou ld break the address name field into two
parts, such as "address l " and "address2". For this project, the address
w ill require only one line, so "add ress" is sufficient.
You sho uld also break the city, state, and Zip code into separate field
names, since most mailings will probably be sorted by one of those fi elds
before be ing take n to the post office. Even though the data docu me n t
that you create for the purposes of th is pro ject will be small, it will show
you th e correct procedure to fo llow for any size mailing. Let's name
those fi elds "city", "state", and "zip".
In the greeting you ' ll print the same "t itle" an d "lastname " field s that
you use in th e address portion of the letter. You do n ot have to give
anoth er occurrence of those fie lds a different name.
The first sentence of the body of the letter states a specific amount owed.
This will also change from lette r to letter, so let's call that field
"amount". The rest of the letter will not change from on e letter to the
next in the print merge process.
You just determined the field names yo u' ll be u sing in the print m erge
docum ents. They are:
date
title
firstname
lastname
companyname
address
city
state
zip
amount
You' ll use the m in a minute wh en you c rea te the main docume nt. The
completed main document w il l look like th e one shown in Figure 7-145
on the next page.
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Rosenfelt Office Furniture and Supplies
884 High View Plaza
Danville, KY 40422
«DATA COLLECTION LETTER DATA»
<<SET date=?Piease enter today' s date:»
«date»

«title» «firstname>> <<lastname»
<<companyname>>
<<address»
<<City». <<State>> <<Zip>>
Dear «title>> <dastname>>:
According to our records your finn has an outstanding balance of S><<amount». You may
have overlooked making this payment. Please check your records and send payment
today.
If there is some reason that you have not sent your payment, please call us to di scuss the
problem.
Thanks for your prompt attention to this matter.
Sincerely,

Steven King
Credit Manager

Figure 7-145

The print merg main document
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CREATING THE MAIN DOCUMENT
In addition to add ing m erge fields to the main docu m ent, you will be
using two sets of instructio ns in this pro ject to tell Microsoft Word to do
som ething oth er than just m erge data. Merge fields a nd special
instructions m ust be enclosed within special characters to h ave Word
recogn ize the m. These special characters, called chevrons, are « and >> .
Th ese are n ot sets o f two less-th an and greater-than signs, but characters
that you ty pe using a particu lar sequence of keys.
Option-\

•

To typ e the<<, h old down th e Option key and type a backslash (\).

Sh ift-Optio n-\

•

To type t h e » , h old down the Shift and Opt ion keys and type a
backslas h (\) .

The DATA Instruction
The first instruction to be placed in this letter is the DATA instructio n.
The DATA in struction tells Word th e name o f th e da ta documen t to be
m erged with th e m ain document to create the customized letters. Th e
DATA instructio n must come before any other instruction or me rge field
in the m ain documen t, and it is usu ally the first line of th e form letter.
You' ll insert the DATA instruction now.
Option -\

•

Click to the left o f the date and press Re turn to create a blank lin e
a bove the date. Click on that blan k line, and then hold down the
Optio n key and ty pe a backslash (\) to create th e << ch aracter.

Shift-Option-\

•

Type DATA COLLECTION LEITER DATA (be sure to use all caps),
and then press Sh ift-O ptio n-backslash (\) to create t he » cha racter.
See Figu re 7-146.

r-

•

File Edit

Format Font Docum e nt

Utilities

Wind ow

Rosenfelt.Office.Furniture.and.Supplies<ll
884.High .Viev.Plaza<ll
Danville ,.:ra..404 ZZ<ll

qr
qr

<DATACOLLECTION.LETTER. DATA><ll
September. tO ,. 1993<ll

qr
qr
qr

Ms .. Vicki. Fitzgerald<ll
IXI.Corporation<ll
32tt.Dow. Stteet,. E.<ll
DuPont,. MI.. 53022<ll

qr

Dear.Ms .. Fitzgerald:<ll

qr

Figure 7-146

The DATA instruction

.,
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The DATA statement that you just typed tells Microsoft Word that the
data document to merge with this main document is called COLLECTION
LETTER DATA. See Figure 7-147.

DATA instruction

I
«DATA COLLECTION LETTER DATA»
name of data document
Figure 7-147

The parts of the DATA instruction

The SET Instruction
The next in struction to be placed in this letter is the SET instruction.
This allows you to enter the value of a field interactively for each page.
The SET instruction is used wh en the data in the field is likely to change
each time you print merge the document.
You'll use the SET instruction instead of typin g the date in the main
document. The SET instruction m ust include the word "SET" followed
by the name of the field you would like to set. Following the field name,
you type an equal sign (=) and either a value to be assigned to the field
or a prompt for Microsoft Word to use when asking you w hat value to
assign to the field. If typing a prompt, you precede it with a question
mark (?) to indicate that it is a p rompt.
•

Click in the selection bar to the left of the date to select that line.

You'll replace this line with the SET instruction for the date.
Opt ion-\

•

Press the Option-backslash (\) to get the special character
then type the following:

<< ,

a nd

SET date=?Please enter today's date:
Shift-Option-\

•

Follow that with the » ch aracter, w h ich you get by pressing ShiftOption-backslash (\).

The SET instructio n t hat you just typed tells Microsoft Word to prompt
you for the data to be inserted into the date fie ld each time you execute
the print merge. The prompt "Please enter today's date:" will appear on
the screen after you issue the Prin t Merge command. The date that you
type at that prompt will be placed in the date field and will print
wherever the me rge field "date' appears in the main document. See
Figure 7-148.
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field name that receives the information typed at screen prompt

~

«SET date=?Please enter today's date:»

I

SET instruction

Figure 7-148

Option-\ Sh ift-Option-\

•

prompt that appears on the screen

The parts of the SET in structio n

Press Return to go to the next line, and the n on that line type the
"date" field name, enclosed between the special characte rs: «date»

Your screen sh o uld now look like the one shown in Figure 7-149.
r

File

Edit

Format

Font

Document

Utilities Window

.,

Rosenfelt.Office.Furniture.and.Supplies<ll
664 .High. Viev.Plaza<ll
Danvill.e, .K.Y .. 40422<li

qr
qr

cDATA. COLLECTION.LETTER DATA><!!
c SET.de.te=?Ple85e.en1er.10de.y's.de.te::.<!l
cde.te><!l

qr
qr
qr

Ms .. VickiFi1Zgerald<!l
lXI. Corporation<!!
3211.Dov. Street,. E.<!!
DuPont,.Ivn..s3022<!1

qr

Dear.Ms .. Fitzgerald :<!I

qr

Figure 7-149
3€ -S

The SET instruction

Now is a good time to save your work.
•

Choose Save from the File menu.

The DATA and SET instructions are just two of several instructions that
Microsoft Word makes available in a print merge environment. The
IF... ELSE... ENDlf. instruction allows you to use conditional printing, which
is the process of printing a field based on the conte n ts of a particular
field. The ASK instruction is similar to the SET instruction. It allows you
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to enter a value at a particular ROint in the document in response to a
screen prompt. The NEXT instrJction allows you to either skip a record
in a data document o r print more than one record on one merge
document. The INCLUDE instruction enables you to include the entire
contents of an other document in the form letter. For more informa tion
on these adva nced features, refer to Reference to Microsoft Word.

Enclosing the Field Names
Now you're ready to replace the n ame and address lines, the greeting,
and the amount field in your letter with the m erge fields.
.. Click in the selection bar to the left of the first line to select Ms. Vicki
Fitzgerald.
O ptio n- \

Shift-Optio n-\

•

Type the following, using Option-backslash (\) to create
Shift-Option-backslash (\) to create » :

«

and

«title» «firstname» «lastname»
Remember that the merge fields you are typing in the mai n document
will be replaced with data from the data document. Be sure to use the
approp riate spaces and punctuation between these merge fields, as
though you were typing in the actual information. Using Show 91 helps
you verify that you have left a space between the fie lds, as shown in
figure 7-150.

Figure 7-150

Leaving spaces between m erge fields

•

Select the line lXI Corporation and replace it with «Companyname».

•

Select the line 3211 Dow Street, E. and replace it with «addresS>>.

.. Select DuPont (but not the comma n ext to it) in the nex t line and
replace it with «city».
,. Select Ml in the same line and replace it with <<State».
, . Select the Zip code 53022 in the same line and replace it with <<Zip».
~ -S

•

C hoose Save from the File me nu.

Your document sho uld look like the one in Figure 7-1 5 1 when you' re
finished with the above instructions. Notice the spaces between field
names a nd the comma after <<city» are still intact.
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e5 File Edit Format Font Document Utilities Window

.,

Rosenfelt.Office.Furniture.and.Supplies<l!
884.High. Viev.PJ.aza<l!
Danrille,.X:Y .. 40422<l!
<l!
<l!
c:DATACOLLECTION.LETTERDATA><l!
c:SET.date=?Please.enter.10day's.date::.<l!
«date:.<l!
<l!
<l!
<l!
c:title:..c:firstname:..c:l83tname»<ll
c:companyname:.<l!
c:address:.<l!
c:city.) ,. <S1ll.1e) .. c:zip)<l!
<l!
Dear.Ms .. Pitzgerald:<l!
<l!

Figure 7-151

The merge fields in the address lines

Now you can see the main document taking shape and how the merge
fi elds will be la id out on the page.
The greeting line will contain the "title" and "lastname" fields that you
used in the address line. The same merge field may be referred to as
many times as you want in a form letter. It is important, however, to be
consistent when typing a field name th at you are using more than once
in y6ur document. Each time the field name is used it must be typed
exactly the same way, including uppercase and lowercase letters an d
spaces, commas, and other specia l ch aracters. Copying and pasting a
field name that you've used before rather than retyping it h elps prevent
errors.
,,. Click on and drag through «title» in the first line of the address to
select it. Be sure to include the chevrons.
Double-clicking on a word selects a word, but it does not select the
ch evrons on either side of a merge field or the punctuatio n marks before
or after a word.
3€ -C

•

Choose Copy from the Edit menu to copy the selected text to the
Clipboa rd.

3€ - V

•

Click on and drag through Ms. (including the period) in the greeting
line to select it, and then choose Paste from the Edit menu to paste
the contents of the Clipboard over the selected text.

3€ -C

,,. Copy the <dastname» field from the first line of the address by
selecting it and choosing Copy from the Edit menu.

3€- V

•

Select Fitzgerald in the greeting line (but not th e colon after it) and
ch oose Paste from the Edit menu to re place it with «lastname».
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The last merge field to change i the amount field.
,,. Select the 1,722.00 (but no the dollar sign before it and not the
period after it) in the first pa agraph of the letter and replace it with
«amount>> . See Figure 7-152.
e5 File Edit Format Font Document Utilities Window

r

.,

~~~==~~_!~~~~~_j~~~=:_!~~~~~~~---- ii
<II
«DATA.COLLECTION.LETTERDATA><ll
«SET.da1ll=?Piease.en1llr.10day's.da1ll::t<!l
«da1e:t<!l
<II
<II
<II
«title:!>. «firstname:B>.«lastnamel><ll
«companyname:~><!l

«address:~><!I

«cityl> ,.cstabll>.. « zip:~><!I
<II
Dear.«title:~>. clastnamel> :<II
<II
Acconling.10.our.reconls. your. finn. has.an.oul3tanding. balance.of.$cemount» ... You may.
have.overlooked.lll8Jting. this. payment... Please.dheck. your.reconls.and. send.payment
10day.<!l
<II

Figure 7-152

The "amount" merge field

Text Formatting
The text fo rmats in the letter in this pro ject will n ot vary from on e field
to another. You can emphasize the contents of a particular merge field,
h owever, by having it print bold or italic, in a larger font, or with some
other characteristic. If you want to do this, the merge field in the main
document must be formatted the way you want the information to look
when printed .
For example, suppose you wanted the amount to print in bo ld italics
each time. You would select th e merge fi eld <<amoun t>> and choose Bold
and Italic from the Format menu. The m erge field itself would carry the
formatting so that any info rmation from the data document that prints
in place of the "amount" field on the page will also be bold and italic.
The main document n ow contains all the merge fields and instructions
needed to create the form letters.
~

-S

•

Save this completed document now.

The next step is to create the ata document. Your completed data
document will look like the o ne hown in Figure 7-153 on the following
page.
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title
Ivis.
IviL
I•Is.
I•Is.

firstrtame
las tname
companyname
addJ:ess
city
state
zip
amount
Sandre I•I.
Hal:din
ICU CoJ:porntion
497 Seemore Drtve, Suite 3
.<>.sheville
NC
29703 2,950 .00
Jim
Bell
Libl:artes R Us
1492 Nanuscrtpt DL I'llartdartn
FL
49709 15 ,500.05
Fay-e L.
I•Iauney
In Your Prtr.ne Beauty Shop 15 IviockingbM Lane
Pinelog
TX
69007 950.2 1
Kay K usunoki
K usunoki Prtntel:S
131 7 Beech Place
San FJ:aneisco
CA
94113 150.00

Figure 7-153

The print merge data document

Chapter 7: Microsoft Word

329

CREATING THE DATA DOCUMEN
You'll need to open a new doc ment that you 'll use to create the data
docume nt, the one that Microsoft Word will use to get the information
it n eeds to create each of the customized form letters.
3€ -N

•

Choose New from the Fi le menu to open a new, un titled documen t.

•

From the Font menu choose Times 12 point if you 're using a
LaserWriter or New York 12 point if you're using an ImageW riter.

The data document consists of data record s, wh ich h old th e text that is
placed in each of the customized form letters. In thi s case, you will have
one data record for each form letter you want to print.
Each data record is separated by a Return. It is important when typing
each data record not to press Return until the e ntire record is entered.

Typing in the Header Record
The first record in the data docum ent is the header record. This specia l
record lists the fields in the order in which they appear in the oth er
records, using the exact field n ames you used in the main documen t.
Each of the field names in the h eader record can be separated with a
comma or a tab character. The com ma o r tab ch aracter acts as a field
delimiter, which indicates where one field ends and the next begins. The
oth er records following the header record contain the d ata, and each of
those fie lds within each record a re a lso separated with either a com ma
or a tab character, the same as was used to separate the fields in the
h eader record. If you use commas to separate the fields, fi elds that
contain commas in the data must be surrounded by quota tion marks.
Let's enter the h eader record now.
•

In the new untitled docume nt th at you just opened, type th e
following fi eld names. Press the Tab key where indicated.
title (press Tab) firstname (press Tab) lastname (press Tab)
companyname (p ress Tab) address (press Tab) city (press Tab) state
(press Tab) zip (press Tab) amount

•

Do not p ress Return until afte r you have finish ed typing the word
a m ount.

Th e header record you just typed contains the same field names as in the
main document, spelled exactly the same way. Your head er record
sh ould look like the one show1 in Figure 7-154 .
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•
:::o

r

File

Edit

Format

Font

Document

Untitled2
13
14

12

0

Utilities

Window

..:6

J5

~

!Normal

I@

D

t

;t

wmame+
title+ firstname+
zip+ amount<l!
+

t.

I

91=1 1 ~11=1

companyname +

ij;) I

addre33+

Il-l

iml-1

•

lw1

city+ 31ate

t'll

Page 1

Figure 7-154

!Normal

_IQ_I

The header record

When you pressed the Return key after the word "amount" in your
h eader record, that indicated to Microsoft Word that those were all the
fields in the header record, and it placed the insertion point on t he next
line. That is where you'll begin your first data record.
Before you enter the data records, you need to save this document. It
is important that it be saved under the same name as you told Microsoft
Word in your DATA instruction in the main document. Figure 7-155
shows the DATA statement used in the main collection letter.

DATA instruction

,_..L_
«DATA COLLECTION LETTER DATA»
name of data document

Figure 7-155

:3€ -S

The data document name in the DATA statement

. . Choose Save from the File menu.
•

In the dialog box that appears, verify that yo u are saving this
document on your data disk. Beneath Save Current Document as,
type in the name exactly as you had it in the DATA statem ent in the
main document, in this case COLLECTION LEITER DATA (in all
caps). See Figure 7-156.

Be sure you don't type any leading o r trailing spaces when you ty pe the
fil ename.
•

Click Save to save the file to yo ur disk.
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I!g) C11r olyn Phillips I

So ue Current Document 11s:

ICOLLECT! ON LETIER DRTR
0

fllS1 \lliJI~

0

7S3K IIUIIilll ble

MllkP llllCkllll

( S11ue .,J

~

~~

[File Fonn11t ... ) Normol

Figure 7-156

~ Corolyn Phillips

Saving the data file

Entering the Data Records
•

Type the following, pressing the Tab key where indicated by (Tab).
Press Return only after you have typed the entire data record (after
the number 2,950):
Ms. (Tab) Sandra M. (Tab) Hardin (Tab)
ICU Corporatio n (Tab)
497 Seemore Drive, Suite 3 (Tab)
Asheville (Tab) NC (Tab) 29703 (Tab)
2,950.00

Your screen should look like the one shown in Figure 7-1 57.

,. a

File

Edit

Format

Font

Document
Untitled2
3

title+
+
Ms .+
+

qr

fir.nname +
lastname +
compan}'ll8l'lle +
zip+ amount<lf
Sex\dre. M. + Hanlin+
ICU.Coxporation+
A3heville +
NC+ 29703ote,950.00<ll

Page 1

Figure 7-1 57

•

Utilities

Window

.,

4

city+ stale
497Seemore.Drive ,. Sui1e.3

Normal

The first data record

Now type in the next three data records, pressing the Tab key where
indicated by (Tab). Press Return only where indicated:
Mr. (Tab) Jim (Tab) Bell (Tab) Libraries R Us (Tab)
1492 Manuscript Dr. (Tab) Mandarin (Tab) FL (Tab) 49709
(Tab)15,500.05 (press Return)
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Ms. (Tab) Faye L. (Tab) Mauney (Tab)
In Your Prime Beauty Shop (Tab)
15 Mockingbird Lane (Tab) Pinelog (Tab) TX (Tab) 69007
(Tab) 950.21 (press Return)
Ms. (Tab) Kay (Tab) Kusunoki (Tab) Kusunoki Printers (Tab)
1317 Beech Place (Tab) San Francisco (Tab) CA (Tab) 94113 (Tab)
150.00
Figure 7-158 shows the completed data file .
..

•

File

Edi t

Form at

Fo nt

Documen t

-o
__l_

!Normal
title+
+
Ms.+
+
Mr.+
+
Ms.+
+
Ms.+
+

~IQ)

Figure 7-158

•

0=

0

1'

4

_15

!ell 1~1 1::=1 1:=1

Iii) I- I I- I

13
:t

1'.

I

!6
~

iml-1

•

i.}

!.1.1

fmnname+
lastname+
companyname +
address+
city+ Slate
zip+ amount<!!
Sandre. M. + Hanl.in+
!CU. Corporation+
497. Seemore.Drive,. Suite.3
l>.sheville +
NC + 29703+2,9SO .OOGI
Jim+ Bell+ Libraries. R. Us+
1492.ManuscriptDr. +Mandarin+
FL
49709+15,SOO.OSGI
Faye.L. +
l-iauney+
In. Your.Prime.Beauty. Shop + IS. Mockingbird. Lane
Pinebg +
TX+ 69007-.950.21qr
Kay+ Kusunoki+ Kusunoki Printers+ 13!7.Beech.Piace+ San. Francisco
CA+ 94113+150.00GI

Page 1
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.,

Window

Un titled2

2

I

_10

-

Utilities

!Normal

IQ I
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Data file after entering all data records

Ch oose Save from the File me nu to save the completed data
document.

RUNNING THE MERGE
To m erge the main document with the data document, the main
docu me nt must be active on your screen.
·•

Select Main Collection Letter from the Window menu.

This will activate that document and bring it to the front.
The main document is the only one that must be open w he n you issue
the Print Merge command. The data document t hat you just created is
still open , however. Leave it open in case you need to ma ke any changes
to it.
•

Choose Prin t Merge from the File menu.

The dialog box that results gives you a choice of printing the resulti ng
documents immedi ately o r merging them to create a n ew document on
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your disk. If you ch oose New D cument, you can view and modify the
letters before sending them to he p ri nter. This is probably the best
choice, especially wh en me rging a large number of records to create a
large number of letters, but you must have enough free space on the disk
to h old the new document.

CAUTION

When you' re printing on an Ap pleTalk network, if you merge to the
printer instead of to a n ew document, other print jobs can come
between your letters because eac~ letter is viewed as a d ifferent print job.
Merging to a new document creates only one print job whe n you print
the form letters.
,,. Click New Document in the Print Merge dialog box, as shown in
figure 7-159.
Print M erge
M erge Record s:

® Rll 0

n Print l)
Figure 7-159

Fr om:

L::=J To: c=J

INew Document I

[Can cel )

Print Me rge dialog box

You sh ould n ow see a prompt asking you to en ter today's date, like the
o ne sh own in Figure 7-1 60.

eEl

Please enter today·s date:

(Stop Mer ge)

Figure 7-16 0

The date prom pt

This pro m p t is the result of t he SET instruction that you placed in the
main document.
,. Type in today's date, and t hen click OK, as shown in Figure 7-161.

Please enter to da y's da t e:

c;EJ

(~top Merge)

ISept ember I D, 1993
Figu re 7-161

Th e date entered ·n th e date dialog box

to

create a new document, it created
Wh en you to ld Microsoft Word
you r merge letters an d n amed th~m Form Letters!. This is what you'll
be viewing after t he merge comp etes. See Figure 7-1 62 (which shows
the screen with Sh ow ~ off) .
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' a

File

Edit

Format

Font

Document

Utilities

Window

Form Letters 1
4

Rosenfelt Office Furniture and Supplies
664 High Viev Plaza
Dan'7ille, ltY 40422

Stp~ember

10, 1993

Ms. Sandra M. Hordm
ICU ColjiOration
497 Stemore Drive, Suno 3
A>hoVllle, NC 29703

Dear Ms. Hord!n:

(Normal

PI Sl

Figure 7-162

The me rged documents

All the form letters are created in o ne file. As you scroll through the
docum ent, yo u' ll see each letter separated by a section marker. In thi s
case there are 4 letters in the document call ed Form Lette rsl , because
you h ad 4 records in th e data document. If yo u create a data document
w ith 100 records, you would have 100 form letters in yo ur Form Letters!
documen t.
..

Scro ll through the letters to be sure there are no errors.

3€ -S

..

Since it is always a good idea to save your work before printing, save
your form letters after you verify that they are correct.

3€ -P

•

Choose Print from the File m enu to print all the customized
collecti o n letters.

Troubleshooting
If you r letters did not merge properly, you can probably track down th e
reason. The following are some potential error messages an d the ir
causes. Eac h time yo u correct an error and re-run the print merge,
Microsoft Wo rd names the resulting fo rm letters document sequentially.
The first time you run the print merge, the letters are called Form
Lettersl. If you run the merge again, the resulting documen t will be
ca ll ed Form Le tters2, and so on. After you correct the errors, close the
corresponding Form Letters document withou t saving it before running
the print merge aga in. This wil l keep you from accumulating and
becoming confused by d ifferent versions of the form letters.

If yo u get an error m essage that says "Missing comma or tab in data
record":
•

Yo u may h ave p ressed Retu rn whi le still in the m idd le of a data
record when yo u entered the data in yo ur d ata document (which
you saved as COLLECTION LETTER DATA). You will have th e
o ption to click either OK o r Help to th is error message. Click either
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o ption and, wh en fini sh ed, th e CO LLECTION LETTER DATA
containing your m erge records w ill be shown o n the screen with the
reco rd in question h ighlighted. Turn on Show~ , if n ecessa ry, to
proofread this document for extra spaces, hard returns, or missing
fi eld delim iters (commas or tabs) . Correct a ny mistakes and try to
merge the documents again .
There is an easy way to verify that the record s in your data docume nt
have th e correct number of fields, are fo ll owed by a h ard return, and
con ta in delimiters in the proper pos iti ons. You select the who le
d ocument (Comm and-Option-M) a nd then place left-aligned tab sto ps
o n t he ruler to format the d ata in neat columns and rows. You'll
probably have to extend the right m argin on the ruler to 10 o r 11 inches
to allow one complete record to fit on o n e line, but yo u wo n't be
printing the data document an yway. Having the data in columns with
the fields in the h eader record fo rming th e column names lets yo u see
a t a glance if you have a problem in the data.
If you get a n error message that says "Data reco rd too long":

•

Yo u may have one quote missing, or yo u m ay h ave failed to en close
within quo tation m arks data that conta ined a comma in your merge
document. This is a problem on ly if you used commas instead of
tabs as field delimiters in yo ur d ata records. You w ill have the o ptio n
to click either OK or Help to thi s error message. Th e COLLECTION
LETTER OATA containing your merge records will be sh own o n the
screen , a nd the reco rd in questio n will be highlighted. Correct th e
error in the record and try again .

•

Yo u specified in your head er record that you would have n in e data
fie lds, and these were separated by e ight tabs. You sh ould always
have o ne delimiter less tha n the number of fields. Extra delimite rs
will result in a "Data record too long" error message, and yo u will
have the option to click eithe r OK or Help. Whichever opti on yo u
choose, eventually t he COLLECTION LETTER DATA co ntaining
yo ur merge records w ill be sh own on the screen, and the record in
questio n will be highlighted . Correct the record so it has t he right
number of delimiters (tabs o r commas) and try again.

If you get a n e rror m essage tha t says "U n known field n am e ":
•

A fie ld name that you used in your main document was n ot spe ll ed
the same way (this includes )punctua ti o n, spacing, a nd uppercase
and lowe rcase characte rs) ~s in the h eader reco rd in yo ur d ata
document. The field n ame if questi on w ill be high lighted o n yo ur
Main Collectio n Letter doc~m ent, a nd yo u'll be presented with a
dia log box giving you the o ptio n to continue, stop m erge, o r get
help. Regardless of the opti:f you choose, you will need to correct
th e highlighted field n ame in the ma in docu ment so it is exactly like
the field in th e header recori:t in the CO LLECTI ON LET f ER DATA
document . Then try again.
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If you get a dialog box asking you to locate a particular document name:

•

Microsoft Word canno t locate the document you h ave specified in
your DATA statement. This generally means that you d id n ot create
your data document using the same name as you indicated in the
DATA state me nt or that the document is in a different fo lder and/
or a d ifferent drive. Th is document name must be exactly the same,

including leading and trailing spaces.
The printed output of this project consist s of four letters. Be su re to
compare them with the completed versions in Figure 7-137 at the
beginning of the pro ject and make any necessary ch anges.
:3€ -Q

,,. Choose Quit from the File menu to exit Microsoft Word an d return
to the desktop. If you intend to continue with the additi onal
projects, close the current files but don't quit Word .

SUMMARY
• Microsoft Word uses five formatting domains: the character, paragraph, table, section, and
document. The character and the paragraph are the basic formatting un its in Microsoft
Word.
• The character, t h e smallest un it in a Word document, includes letters of the alphabet,
punctuation marks, numbers, and symbols. Font type and size, underlining, character styles
such as bold and italics, and spacing between characters are examples of different character
formats. Different characters within a single paragraph can have different character
formatting attributes.
• A paragraph is a collection of cha racters that is followed by a hard return. Paragraph
formatt ing, such as line spacing, tab settings, text alignment, inden tatio ns, paragraph
spacing, and paragraph borders, affect the en tire paragraph that con tains th e insertion point.
The ruler is used to format paragraphs, and ruler settings can be d ifferent for each paragraph.
• A table consists of rows and colu mns of cells, and each cell can contain characters and
paragraphs that have different formatting characteristics.
• A section consists of one or more paragraphs a nd is followed by a section marker. Each
section in a document can be forma tted differently, and each documen t con tains a t least one
section. Section form atting is controlled by the Section command, which controls the
number of columns in a section, wh ere the sectio n sh ould start, the page number the section
sho uld begin with, and whether each section sh o uld have a different heade r an d foo ter.
• The document itself is the largest formatting unit in Microsoft Word. Some examples of
document formatting are page ma rgins and printing preparation. If multiple documen ts are
open at the same time, only one can be active at a time.
• Graphics can be created in a graphics application and incorporated into a Microsoft Word
docum ent. Text and graphics can be selected and then moved, copied, or deleted from a
document.
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• A style is a set of formatting characteristics to which a name has been assigned. Once a style
is defined, it can be applied to a paragraph or a series of paragraphs to quickly and consistently
change the appeara nce of the text. A group of styles attached to a document is called a style
sheet.
• A header is text and/or graphics that appear at the top of every page of a document. A footer
is similar to a header, except that it prints at the bottom of every page of a document. A header
or footer can also contain an automatic date and time stamp and a page number.
• The print merge feature of Microsoft Word allows you to create customized form letters by
merging records from a data document with the unchanging body text of a main document.

KEY TERMS
active window
automatic page break
automatic styles
block quote
borders
cell
center tab
character
chevrons
clip art
Cli pboard
conditional printing
data document
decimal-aligned tab
delimiters
desktop publishing
document
dot lead ers
drawing tool
drop-down list
end-of-cell marker
end-of-row marker
extended keyboard
field
first-line indent
First Page Special
flush left
flush right
font
foote r

Galley View
hanging indent
header
header record
!-beam pointer
indentation controls
insertion point
justification, justified text
left-aligned tab
left indent
line spacing, vertical spacing
main document
manual page break
merge fi elds
monospace fonts
new-line command
orphan
I

page scale
Page View
paginate
paragraph
parag aph-spacing settings
point size
print merge
Print rreview
proportional fonts
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record
right-aligned tab
right indent
ruler
scale tool
section
section break marker, section
marker, section break
select
selection bar
soft return
spelling checker

style name, style
style sheet
tab leaders
tab settings, tab stops
table
table scale
tables feature
text alignment, alignment
widow
wiping through text

MICROSOFT WORD COMMAND KEYS AND
SHORTCUTS
File Menu
New
Open
Close
Save
Print Preview
Print
Quit
Edit Menu
Undo
Cut
Copy
Paste
Show/Hide~

Format Menu
Show/Hide Ruler
Character
Paragraph
Define Styles
Bold
Italics

3€-N
3€-0
a€ -W
a€ -S
a€ -1
a€ -P
3€-Q

a€ -Z
3€-X
3€-C
3€-V
a€- y

a€ -R
3€-D
3€-M
3€-T
3€ -Shift-B
3€ -Shift-1

Font Menu
Smaller point size
Larger point size

a€ -Shift-<
a€ -Shift->

Document Menu
Page View
Insert Page Break
Insert Section Break

a€ -B
Shift-Enter
:!€ -Enter

Utilities Menu
Find
Change
Spelling

a€ -F
3€-H
a€ -L

In Speller:
Suggest Word
No Change

a€ -S
3€-N
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Ruler Commands
Left-align text
3€
3€
Center text
justify text
3€
Right-align text 3€
Space After~
3€

General Co 1mands
Cancel prinh n g
types •<
types »
Select entire document
Accept the default,
or the more heavily
outlined button in a
dialog box

-Shift-L
-Shift-C
-Shift-]
-Shift-R
-Shift-0

3€ -.
Option-\
Shift-Option-\
3€ -Option-M

Return or
Enter

ADDITIONAL PROJECTS
The following projects are accompanied by briefer instructions than
those you have previously completed in this chapter. If necessary, refer
to the previous projects in this chapter for information and step-by-step
instructions for any command that you don't remember how to use.
Also, Microsoft Word's Help text contains valuable and easily accessed
information. You will not be reminded to save your work-by now you
should be thinking of that without having to be reminded.

Project 6: Creating a Report with Footnotes
In this project you'll create a report that has a different header for the
first page than for the rest of tl)e document. Proj ect 4 of this chapter
introduced you to headers and footers. You'll also learn about adding
footnotes to your document. T7e final output of Project 6 is shown on
the next two pages in Figures 7-163 and 7-164.
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Kenyon Chekelele
Artl OI
February 7, 1993

The Classical Ideal in Greek Sculpture and Architecture
The classical period of Greek architecture and sculpture began around 480 B.C. The
artwork of this period reflected the G reek infatuation with the concept of perfection
and wholeness, that of the ideal This classical ideal was represented by a striving
toward internal consistency and o rganic unity as a means to bring form out of the
chaos of nature. Balance and grace were the resul ts.

Architecture
The temples of this period were designed as idealized d welling places for perfect
beings and were built using the Do ric, To nic, and Corinthian architectural orders.
The Parthenon, a pe1fect example of the c lassical period of Greek architecture, was
erected to serve both as a shrine to Athena and as the treasury of the Delian League.
For that reason it had an east cella and a west cella. There were 17 columns on each
of its 228-foot long sides and 8 columns o n the 104-foot wide fro nt and back. T here
were 6 add itional columns o n both the east and west ends that formed the inner
porticos.
The technical skill and workmanship of the Parthenon are astonishing. No mortar
was used anywhere. The stones were cut so that when they were fitted together they
formed a single smooth surface. T he columns were constructed of sections called
drums, which were fi tted and held tightly by square plugs in the center so that the
joinings were hardly visible. The design of the Parthenon was based on the
mathematical principle of the golden section. This flexible system of dividing lines
into extreme and mean ratios was used to ensure harmonious proportions and
allowed much latitude in actual practice.
C lose examinatio n of the Parthenon shows that what seems to be straight and correct
is really a complex seri es of harmonious concave and convex curves. The architects
lctinus and Callicrates used aesthetics rather than mathematics to correct certain

optical illusions and to create the illusion of flexibility. 1 Even the fluting of the
columns was used not on ly to maintai n a rounded appearance, but also to create
g raceful curves to please the eye. T he Parthenon is a work of art, not merely an
example of skillfu l engineering.
The organization of horizontals and verticals, the relationship of length and breadth
to height, and the ratio of the solid masses to the openings between the columns all
were according to the trad ition of the Doric order of architecture. A unit of measure
I Ol ive

Dilgores,An, Man and History. New York : Gabriel Charles Press, 1972, p. 130.

Figure 7-163

Final output for page 1 of Project 6
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Page2
know as the module was used to assure the proper ratio of parts to w ho le. T he
mod ules were flexible units of measure, such as the di ameter and radius of a
column, not fi xed units like yards and feet. T he modu le varied among structures, in
keeping with the G reek ideal of structural integrity of single buildings.

Sculpture
The statues created during the c lassical G reek peri od concentrated on ty pical o r
general quali ties rather than on unique or particular ones. This was done in orde r to
seek a concept closer to pelfecti on. The most beautiful details of several mode ls
were combined to achieve the ideal.
The Doryphorus (Spear Bearer) by Po lyclitus puts into play his rational theory fo r
ideal proportions for the human fi gure. Just as the Partheno n had its modu le deri ved
from a unit of the building, Polyclitus took his module fro m a part of th e body. The
whole and all parts of the statue were ex pressed in multiples or fracti ons of the
module . As with the optical refinements of the Parthenon, Polyclitus' canon also
allowed for some flexibility to ensure harmonious grace.
The sculptor avoided representing the human being in infancy or o ld age, since these
extremes implied incompleteness or imperfection. The maj ority were fas hioned to
represent gods w ho, if portrayed as humans, must have bodies of perfecti on. In the
bronze statue of Poseidon (or Zeus) recovered from the sea off the coast of Greece,

The sculptings, or metopes, in the Doric frieze of the Parthenon were done in hi gh

relief to take full advantage of the bright sunlight. The l.ilpith n11d Ce11tnur metope
attributed to Phidias, uses the spreading fo lds of the mantle to fo rm a backdrop for

the idealistic human figu re and makes a striking contrast with the grotesque centaur. 2
Phidias' Athena Lemnin, which stood on the Athenian Acropolis, was often referred
to as "the beautiful" and approached the Greek ideal ofi chaste classical beauty.

The Dying Warrior from the east pediment of the temple at Aegina is and id ealis tic
model of simplicity and restraint. Dignity and g race are e mbodied in its portrayal of
the death of the lean and muscular warri or. T he harmo nio us proportions of the

Kritios Boy are represented by its enhanced lifelike expression and its contmpposto
stance. In both cases the essential, ideal qualities of the subj ects are captured.

2Wyman Colla, The Philosophy of Arl and Learning Chicago: Nantahala Publishi ng Company,
1980, p. 24 1.

Figure 7-164

Fin al o utput for page 2 of Pro ject 6
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The margins for The Classical Ideal report are 1 inch top and bottom an d
.75 inch left and right.
"..

Choose Document from the forma t menu to set the margins.

The font used in this pro ject is Times 14 point.
The easiest way to create this report is to type the report first, and then
go back and add the h eaders and footnotes.
...

Refer to Figures 7-163 and 7-164 and type the body of the report. Do
not type any of the header info rmation (name, class number, date,
and page number). Do n ot type the footnote referen ce marks (1 and
2) in the body text or the footno te text at the bottom of each page.

•

Format the title of the report bold and centered and the Architecture
and Sculpture headings bo ld and left-align ed. Italicize the words
that require it.

•

Use the spelling checker to check for misspellings.

Now that all the grunt work is don e, you ca n add the headers.
..

Choose Section fro m the Format menu and click the First Page
Special box in the Header/Footer portion of the Section dialog box,
as shown in Figure 7-165. Click OK when done.

rOD
[cancel )

~
[Set Oefeult J
Heoder/ Footer----,
- - - - , From Top:
~
From Bottom: ~
[8:1 First Page Special

Figure 7-165

Choosing the First Page Special header optio n

When you open the Docume nt me nu, you now have two different
headers and footers to choose from .
•

Ch oose Open First Header from the Document menu.

The header window that results will con tain the text that prints on the
first page of your document only.
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Type your n am e o n the first ine of the header, the class number on
the n ext line, and the da~e o n the last line, as shown in the
completed document in Fig ure 7-163. Press Return to create a blan k
line after the date. Format th ese lines right-align ed .

,.. Click in the line that contains th e date, and choose Paragraph
from the Format menu.
•

In th e Paragraph dia log box, click th e Borders butto n, and then
click in the bottom of th e bo rders sche matic to create an underline
borde r effect. Click OK twioe to get back to your d ocument.

,.. C lose the First Heade r wind<Dw and th en open the header window
from the Document me nu .
The contents o f the h eader window wi ll print on every page but the first.
,. . In the header wi ndow, type the word Page, press the space bar, and
then click on th e page number icon in the h eader window to place
t he automatic page number in the header. Press Return to place a
blank line after the page-number li ne .
•

Format the page-number line right-aligned, and then pl ace an
underline bo rder ben eath it like you d id in the First Header w indow.
Close the header wi ndow whe n fin ished.

•

Use Page View or Print Preview to see the different h eaders o n each
page, and then return to Ga lley View.

Next yo u' ll add the footnotes.
,.

Click to set the insertion point after the period that ends the second
sentence in th e fourth pa ragrap h of the report-the paragraph
1
beginning with "Close exan inat io n ".

This is where the footnote refere ce mark will go . The other part of the
footnote, the footnote text, wi ll go at th e end of the page.

3€ -E

,.

Ch oose Footnote fro m the Document menu.

The Footnote dialog box is shown in Figure 7-1 66.

18] Auto-numbe red Re ference

or
footnote Refer ence Merk: C J
! f ootnote Separa tors
1 (separator ... )

(cont. Separator ... ) [Cont. t'lotice ...

Figure 7-166

d

The Footnote di, log box
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Notice that Auto-num bered Referen ce is alread y selected. This o ptio n
allows Microsoft Wo rd to num ber the footnotes automatically as you go
alo ng, beginn ing with n umber 1. If yo u wanted to use a foo tnote
reference mark other than auto-num bered, you would type the cha racter
to use for t he re ference m ark in the box to the right of Footnote
Reference Mark.
Th e o th er options in the Footnote dia log box concern the footnote
sepa rato r, which is a ma rk t hat sepa rates the footno te text fro m the
ma in text of the documen t. The defau lt foo tnote separato r is a lin e two
in ches long, wh ich is sta ndard fo r m ost docu ments.
•

Since you want Word to insert an auto-nu mbered reference mark
where th e in sertio n po in t is, cl ick OK to acce pt the settings in t h e
Foot no te d ia log box.

The reference m ark is in se rted in your docu ment at the insertio n po int,
and t he footnote window opens at th e bottom o f th e screen . lf Sh ow ~
is o n, you'll see t hat t he footnote referen ce m arks are boxed with a
do tted line. Notice that the sam e footnote reference mark is a lso placed
in th e footn ote window at t he botto m of the scree n, and the insertion
point au to matically moves th ere for you to enter your foo tnote text.
•

l n th e footnote window, type t he foo tnote text th at is shown at th e
bot to m of the first page o f t he completed docu men t in Figu re 7-163.
All ch aracter a nd fo rmatting opti ons a re available in t he footnote
window just as they are in the docume nt w indow.

You can use the scro llbars to scroll aroun d in the footnote window. To
c lose t he footnote window, double-click in the sp lit ba r, as shown in
Figure 7-167.

r.than rnathetnatics.to.correct
f.flexibility. ~~· Even the.fluting.
ed.appearance).but to. create.
· les.Press..· 1972 ,. p .. 130. <Jf

Figu re 7-167

Th e split bar
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•

Now move to the second to the last paragraph of your document to
insert the second footnote.

•

Click after the second sentence in that paragraph, and insert the
second footnote in the same mannter as you did the first one.
Type the footnote text from the finished document shown in
Figure 7-164.

If you close the footnote window and would like to do some editing to

the footnote text, double-click on the footnote reference mark in the
document to reopen the footnote window.
To delete a footnote, you select the footnote reference mark in the
document and press the Backspace key. Not only does this delete the
reference mark in the document, but it also deletes the footnote text in
the footnote window and automatically renumbers any subsequent
footnotes that were auto-numbered.

I

For more information about the footnote features, refer to Reference to
Microsoft Word.

-

Your report should now be complete. Compare it to the finished
documents shown in Figures 7-163 and 7-164, and make changes as
needed.

Project 7: Creating a Form
In this project you'll use the tables feature and cell borders to create a
form. For additional help, refer to Project 3 in this chapter, which covers
the tables feature. The final outpl!tt of Project 7 is shown in Figure 7-168.
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Student Grade Averaging Form

Course Name:
Date

Item

Grade

Average------Course Name:
Date

Item

Grade

Average _ _ _ _ _ __
Course Name:
Date

Item

Grade

Average-------

Figure 7-168

Final output for Project 7
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The margins for the Student Grade Averaging Form are 1 inch top and
bottom and .75 inch left and right.
•

Use the Document command from the Fo rmat menu to set these
margins.

The font used in this project is Helvetica 12 point.
You'll need to work with Show ~ on and with the ruler showing.
•

Begin by typing the title, Student Grade Averaging Form, and then
press Return three times to create two blank lines after the title.

The title sho uld be centered and formatted bold.
•

Click to set the insertion point on the last blank line, and then
choose Insert Table from the Document menu.

•

The Insert Table dialog box should show settings for 2 columns, 1
row, and 3.5 inch column width. Accept those settings.

Now you should change the width of the first column in that table.
,,. Use the scale icon on the ruler to toggle to the table scale, and then
drag the thumbtack column markers on the ruler so that the first
column ends at 1-1/2 inches, and the second ends at 4-1/2 inches,
as in the ruler shown in Figure 7-169.
~~
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The column markers for the first table

Click o n the blank line below the table you just created, choose
Insert Table from the Document menu, and insert a table that has
5 columns and 9 rows. Accept whatever column width is shown,
since you' ll be changing the column width anyway.

,,. Select all of the new 5-column, 9-row table, and then click the scale
icon on the ruler to toggle to the table scale.
•

I~

Move the thumbtack column markers so that the first column of the
9-row table is 1-1/2 inches wide, the second column is 1/4 inch wide,
the third is 1-1/2 inches wide, the fourth is 1/4 inch wide, and the
fifth is 1-1/2 inches wide. Your ruler should look like the one shown
in Figure 7-170.
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Click to the left of the end-of-row marker in t hat row and
choose Table from the Edit menu. In the resulting dialog box,
click to insert the selection horizontally.
Now that the grid for the table is set up, type the text in the appropriate
cells as shown in Figure 7-171.
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Figure 7-171 The text in the cells

Note that Course Name is left-aligned; Date, Item, and Grade are
centered; and Average is right-aligned.
Finally, add the borders in this table to create the lines of the form.
"'•

The cell to the right of Course Name should be underli ned, so
click in that cell to set the insertion point.

'"•

Choose Cells from the Format menu, and then click the
Borders button. Click at the bottom of the borders schematic
to place a single line at the bottom of the cell, and then click
OK in both dialog boxes to return to the document.

Place a n underline in all but the last cell in the Date column beginning
with the cell below the Date heading. Do the same with the Item
column and the Grade column. The cell to the right of Average should
have an underline border also. Refer to the completed form in Figure
7-168. Turning off S how ~ lets you view the results of the underlining
more clearly.
Rather than repeating the process of creating each of the other two
tables needed in this documen t, you'll duplicate the table you just
created.
,.

Select the two blank lines after the Student Grade Averaging
Form heading as well as the entire table.

111
•

Copy the table to the Clipboard, and then click in front of the
blank line at the end of the document. Paste the table there.

Paste another copy of the table after the one you just pasted so that you
have three ide ntical tables in the document, each separated by two
blank lines.
Compare your finished table with the completed document shown in
figure 7-168.
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P

art IV: Spreadsheets introduces you to using the Macintosh to
work with numerical problems.

Chapter 8 presents the basic co cepts involved in using a Mac with
spreadsheet applications.

Chapter 9 introduces you to Jing Microsoft Excel. Th is program is
the most widely used electronic spreadsheet application on the
Macintosh. It has powerful equation-solving capabilities and produces
presentation-quality graphics. You will learn to create a number of
spreadsheets, link spreadsheets, and produce line charts, pie charts, and
bar and column charts.
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Chapter 8: Spreadsheet Conc;epts
What You Will Learn in This Chapter
After reading this chapter, you sho uld be able to:
•

Understand the basic concepts of electro n ic spreadsheets and
their use in numerica l calculat ions

•

Explain the o rganization of worksheets: rows, columns, and
cells

•

Recognize a cell 's address

•

Recogni ze a range

•

Know what can be contained in a cell: text, numbers, a nd
form ulas

•

Recognize and know how to interpret th e t hree most commo n
types of business graphics: pie charts, column charts, and line
charts

WHAT IS A SPREADSHEET?
Ever since someon e discovered how to keep track of business transaction s
there has been a need to o rganize, calculate, and present information
a bout th ose transaction s.

Manual Spreadsheets
At some point, the manual worksheet (also known as a spreadsh eet) was
created. A manual works heet help s a person to o rganize and present
information.
Small man ual worksh eets are easy to create and modify. As worksheets
get larger and mo re complex, it takes more time and effort to create, use,
a nd modify them. Complex spreadsh eets, even t hose with simple
calculatio ns, are very t ime-consumi ng to use. As a worksheet gets larger,
its potential fo r errors also increases.
Problems arise with spreadsh eets when ch anges have to be made to
correct errors or adjust to new business procedures. A m anual spreadsheet
must be reca lculated, a process th at is both time-consuming and errorpron e. Manual recalculation of a large spreadsheet can take hours o r
d ays to complete and verify.
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Electronic Spreadsheets
An electronic spreadsheet is a computerized version of the manual
works heet. It's like a sheet of pape r with the pencil, eraser, and calculator
bui lt in.
An electronic spreadsheet allows you to enter, format, calculate, print,
a nd edit your information. In add ition, it w ill ca lculate and draw charts,
wh ich then may be printed. It can also be used to keep track of lists of
info rmation, sort that information into a di ffe rent o rder, and presen t
summaries about wh at is in the list.
Spreadsheets can be used whenever you have information that can be
organized into rows and columns. They are specifically usefu l when you
have n umerical data that you in tend to perform mathematical operations
on. Once you have t he info rmation entered into the wo rksheet, you can
analyze alternative possibilities, a process th at is commonly ca lled

what if. .. analysis or modeli11g.

Spreadsheet Users
Spreadsheets are commonly used in business for accounting and
m a nagement reports. However, business people are no t the only ones
who be nefit fro m learning to use these ap plications. Anybody who
performs large groups of calculations o r complex calculations wi ll
benefit from using a spreads heet. Spreadsheets are also useful fo r
scientists, engineers, statisticia ns, medical practitioners, and anyone
else wh o performs complex, time-consum ing ca lculatio ns o n numerica l
data.
It gen era lly takes a little longer to create a worksheet e lectronically th an
it does m anually. The process m ay be faster or slower depending upo n
your familiarity with the softwa re, your typing speed, a nd how
comfortable you are with a pa rticular me thod. Once the worksheet is
created , however, the manual system can not com pete with the electron ic
version. If you change a value in a n electron ic wo rksheet, the worksheet
is recalculated with the speed of a computer and often is com pletely
recalculated before you could even find your calculator to sta rt
recalcu lating a manual worksheet.
A spreadsheet can display information o n the screen, and if you specify
a formula for it to use, it can perform n umerous calculations in a very
sho rt period of time. After these calculations are performed, the display
is auto matically updated to sho~ the results of the calcu lations. If you
change an y of the data, the ca l ~ulations are aga in performed a nd the
d isplay is updated. This rapid feedback is w hat makes a spreadsheet so
va luable.

I

W ith the knowledge of a li ttle algebra and the use of the many built-in
functions provided by a spreadsheet, you ca n perform inten sive and
sophisticated math ematical analyses of problems in the fields of business,
finance, statistics, science, engineering, and others that involve numerical
processing.
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SPREADSHEET TERMINOLOGY
Spreadsheets are o rganized around the use of a worksheet that is divided
into a table composed of rows and columns (see Figure 8-1 ).

Figure 8-1

A spreadsheet 's rows, columns, a nd cells

As you can see in Figure 8-1, each row is assign ed a number, and the
colum ns are design ated by letters of the alphabet. Althoug h you ca n see
only 19 rows and 6 columns, a spreadsh eet is much larger than that.
Spreadsheet programs ca n create works heets that are hundreds of
columns wide and thousands of rows long. Most spreadsheets, however,
are likely to be n o larger than a couple of dozen columns wide and a
hundred or so rows lo ng, and many are much sma ller tha n that.

Cells and Addresses
Each row of a spreadsheet intersects each column, a nd this intersection
is known as a cell. A cel l is the basic storage componen t of a spreadsheet.
Cells have an address that is com posed of the letter of t he co lumn and
the number of t h e row. The to p left cell is in colum n A and row 1, so it
is kn own as cell Al.
A cell must be selected before anything can be entered into it. W h en the
cell is selected, it becomes the active cell, and it can be recogn ized because
it is high lighted. Cell A1 in figure 8-1 is the active cell; it is su rrounded
by a h eavier border than the o ther cel ls.
Information ca n be en tered into the active cell. Th is information can be
o ne of three types of data: text, nu mbers, or formulas.
Text is any combi nation of words o r letters in a cell. It can be descriptive
information to identify the contents of other cells, o r it can be data, such
as custom ers' names and add resses.
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A cell can contain a number, also known as a value. This value can be any
real number, such as 1, 3.14159, 363.34, -1 7, and soon. If needed, a very
large or very small number can be entered using a spreadsheet's
variation of scientific n otatio n.

Formulas
Electronic spread sh eets are mainly used to perform numerical
calculations. These calculations are descri bed to the spreadsheet by
entering an algebraic expression, or formula, into the cell. Formulas are
composed of combinations of cell addresses, numeric constants, and
mathematical opera tors. The mathematical operators are a plus sign(+)
for addition , a minus sign (-) for subtraction, an asterisk (*) for
mu ltiplication, and a slash (/) for d iv ision.
There is a difference between sto ring a num ber or a formu la in a cell. You
could manually add the contents of the two cells Al and A2 and enter
the total into cell A3. If you then changed cell Al or A2, you would
manually have to add them again and replace the contents of A3 with
the n ew result.
Instead, a cell might have a formu la telling it to add the contents of cells
A1 and A2. Ifthis form ula were in cell A3, it would be written as=Al+A2.
(The equals sign(=) tells Excel th at a formula- not a value-is about to
be entered.) The spreadsheet would then add t he va lues o f cell Al and
cell A2 and display the result in cell A3. If you change the value in either
of the other two cells, the spreadsh eet would automatically recalculate
and display the new result in cell A3 . No matter how many times you
ch ange either or both of the first two cells, the program automatically
updates the result displayed in cell A3.

Functions
In additio n to allowing you to create simple formulas, spreadsheets
provide a set of pre-programmed fo rmulas called bu ilt-in functions. They
are convenient shorthand for a series of arithmetic formulas you could
en ter instead .
A function lets you perform co J ·Jicated calculations with less work on
your part. One of the most
on functions is SUM(), which adds a
group of numbers that are listed as a cell range within the parentheses.
Each list of numbers or cells is known as an argument of the function.
Another commo n function is AVERAGE(), which computes the average
of the numbers in its argument Jist. It does this by calculating the sum
of the numbers and then dividing the result by the total number of item s
in the argument list . Other functions are more complicated. For example,
the SQRT() fun ction calculates the sq uare root of the values listed within
the parentheses.

com~

An example of a simple business spreadsheet that uses the SUM()
function is shown in Figure 8-2. t his spreadsheet is used to calculate the
profit or loss resulting from toy sales for the first three mo nths of
the year.
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Figure 8-2

A simple profit or loss worksheet

Cell Ranges
Many formulas require you to refer to multiple cells. A range of cells is
a group of contiguous cells that is treated as a unit.
The address of a range of cells is composed of the address of the top left
cell, a colon (:), and the address of the bottom right cell in the group. For
exam ple, the range of cells that includes C2, 0 2, and E2 is referred to as
C2:E2.
Exam ples of ranges and their addresses are shown in Figure 8-3. A ra nge
may consist of several cells in a single row (C2:E2), several cells in one
column (B4:B9), or a group of cells in multiple rows and columns
(D5:E8).

Range.C2:E2

'

1i File Edit Formulo formot Ooto Options Mucro Window

~~

Range .8 4:89

Figure 8-3

II
__.!!_

_!_

Range DS:E8

Examples of cell and range names

_!_

~
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The largest group of cells in Fi re 8-3 consists of four cells in column
D and four cells in column E. This range of cells is named DS:E8. Let's
say you want the total of the values in cells DS:E8, and you want this
total stored in cell 010. You could enter a formula such as =05 + 06 +
07 +DB+ ES + E6 + E7 + E8 into cell 010, but that gets cumbersome
very quickly. Using functions and cell ranges within a formula is more
efficient. The formu la =SUM(DS:E8) can be read as "Equals the sum of
cells OS through E8."

BUSINESS GRAPHICS
A worksheet provides a detailed numerica l view of a problem. It is
difficult to summarize this information when presented as a spreadsheet,
however, because people have difficulty assimilating and understanding
large collections of numbers.
Graphical representations are absorbed and interpreted much more
quickly than numerical data. j ust as pictures, drawings, and other
graphical elements can make a book mo re interesting, business graphics
can make a presentation more interesting and more informative.
Business graphics provide a visual, easily understood overview of the data
stored in the worksheet.
Many electro nic spreadsheets provide the ability to easily create
presentation quality business graphics. All you have to do is indicate the
data to be gra phed and the style of chart to be produced, and then the
computer does the work.
In addition to helping you get your point across, high quality presentation
graphics also create a positive impression of your presentation.

Types of Business Graphics
Two types of business graphics have evolved since the development of
the electronic spreadsheet: analytical and presentation graphics.

Analytical graphics are designed to help you interpret data. Presentation
graphics illustrate data for presentations to higher management, clients,
and other presentations in which image and quality are important.
Many spreadsheet programs have the capabilities to produce high
quality graphics, although specialized presentation applications typically
offer more features. For many presentations, the combination of programs
such as Microsoft Excel and Claris MacOraw allows you to create very
high q uality graphics. Other pr<Dgrams, such as Microsoft PowerPoint
and Aldus Persuasion, will accep graphics from spreadsheets, and they
include professionally designed ormats to help you create high quality
presentations.
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Most presentation graphics programs allow you to edit and enh ance the
graphs and charts you produce. In many cases, they allow you to create
drawings, diagrams, speaker's notes, audience handouts, and slides. An
advantage of using spreadsh eet program s on the Macintosh is its
interchangeability of grap hics between programs. All c harts and graphs
produced in Macintosh spreadsheet programs may be incorporated
easily into presentation programs.
Even though the computer and spreadsheet do much of the work, you
will still n eed a certain amount of skill to create a presentation using the
correct charts. These programs provide tools, but they wi11 not substitute
for a person's skill and knowledge.

Types of Charts
Many types of charts are used to present numerical d ata. In this chapter
you are introduced to the three most common: pie charts, bar or column
charts, and line charts.
Several charts are shown in this section as samples of these three types.
Each chart represents a portion of the data contained in the business
worksheet presented previously, which is repeated in Figure 8-4 for easy
reference.
r

eJ

File

Figure 8-4

Edit

Formula

Format

Data

Options

Macro

Window

.,

A simple profit or loss worksheet

Pie Charts
A pie chart shows h ow several amounts make up a who le. O nly one
variable, or data series, may be shown using a pie chart.
Figure 8-5 shows a pie cha rt illustrating revenue (the data series). The
revenue for each month is compared to the to tal revenue for the entire
period. The slices of the pie, and the percentage of the to tal revenue
represented by each mo nth's a mount, a re ca lculated and displayed.
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e Chart
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Revenue

34. 32%
38.33%

•

January

0

Febr uar y

El

March

27.36%

Figure 8-5

Pie chart of revenue for three months

I
Sometimes it is useful to draw atten tion to on e of the values in a pie
chart. In these cases, an exploded pie cha1t is used. This means that on e
slice is p ulled away from the others to emph asize it.
In Figu re 8-6, the slice represen ting March h as been exploded .
~0

EHplo!led Pie Chart
Revenue

38.33%

Figure 8-6

•

January

0

Febr uary

El

March

Explod ed p ie ch art

Pie ch arts have the advantage of being understood by nearl y everyone.
However, th ey can on ly show th e p roportional relation of several values
withi n a single data series.

Column and Bar Charts
Column charts and bar charts are sed to illustrate discrete qua ntities a nd

compare them to differen t q ua tities of the same variable.
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Both types of charts are essen tially the same; they differ on ly in th e
o ri en tation of th e rectangles used to graph th e data. Colum n ch arts are
o ri en ted so t hat t h e rectangles a re taller than th ey are wide, w hereas bar
charts are ro tated 90°, so t he ba rs are wider than they a re ta ll. Values are
grap hed vertically in co lum n charts a nd ho rizon tal ly in bar charts.
Fig ure 8-7 shows revenue amoun ts for ja nuary, February, and Ma rch .
This chart represents t hree values wit h in the reve nue data series. It
is clear that Februa ry had the lowest revenue an d tha t March h ad
the h ig hest:
~0

0~

Col umn Chart - I Dat a Series
Revenue

$28 ,293.80

$30,000.00
$ 25,000.00
$ 20, 000.00
$15, 000.00
$ 10,000.00
$5, 000.00
$0.00
January

f ebr uary

Mar ch

f2J
Figu re 8-7

Colum n chart s ho wing three values of one variable

Unli ke pie charts, bar and co lum n charts can also show the relations hi p
be tween mu ltiple data series. Figure 8 -8 s ho ws a colum n chart
represen ting th ree data series.
Column Char t - 3 Dat a Ser ies
$30 ,000.00
$25 ,000.00
$20,000.00
•

Revenue

0

Ex pense

$ 15,000.00
$ 10,00 0.00

III Profi t/( Loss)

$5,000.00
$0.00
J anuary

f ebruary

March

($5,000.00)

Figure 8-8

Co lum n chart sh owing three instances of th ree variables
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This chart compares the re lati o n between reven ue, expense, and profit
or loss over three months. It is seful for spotting trends that may be
important. For instance, whi le ·evenue is fluctuat ing over the three
month period, expenses seem tb be stead ily increasing. Sho uld this
trend continue, it may have se~ious consequences, and it should be
carefully watched fo r the next several months.

Line Charts
If you want to present information to analyze longer trends and cycles
that can be spotted mo re easily, you can choose a line chart.
Like column charts, line ch arts all ow the presentation of multiple
occurrences, or data points, of several variables. Its advantage over column
or bar ch arts is that it a llows more data points to be graphed in a given
space than can be shown clearly in a colum n chart.
line graph
Acme Toys Annual Sales
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t-------- --------- ----------- --------- ----- ---- --- --- --- -- ----·

$60,000

-------- ----- - -------------- - -- ----- - ------ - - -- -------- - --- - ·

$40,0 00

- ----- ---- ------ ------- - ---------- - --- ---- -- - ----------- - - - .

·----·----.

120 ,ooo ;.:•->~--=-:t?:':-~~~ZS?:":":":'..a.....--=-:.:;;;;
$ 0~~~~~~---r~~--+---+-~~-+---n~~

J n

($20,000)
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-- -- --- ---------------------------- - - - - - - - -- ------ - --------- - ·

1-•-Revenue
Figure 8-9

.a- Ex pense

+

Profit/( Loss )

I

Twelve-month line chart of sales information

Figure 8-9 shows a contin uation of the data presented in Figure 8-8 over
a 12-month period. As you can see, the rising expenses noted above did
not really signal a trend. This view, which shows a longer period oftime,
offers a gli mpse into the cycl ic nature of sales for this particular toy
compan y . Another line ch art showing the last ten years of sales history
m ight provide useful insights for predicting next year's sales.
Chapter 8 has introd uced you to general spreadsheet and business
graphics concepts and terminology. Chapter 9 introduces you to Excel,
a powerful spreadsheet program [ With this program, you can increase
your ability to analyze data and create presentation grap hics.
In Ch apter9 you h aveth eoppor nityto learn to create worksh eets and
produce the three types of cha rt d iscussed in th is ch apter.
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CHAPTER SUMMARY
• Spreadsheets, or worksheets, are forms used to organize data into rows and columns.
• Electronic spreadsheets are computerized versions of manual worksheets and feature faster
an alysis and fewer computational errors t han manual m ethods.
• Cells are formed from th e intersection of rows and columns. A cell is the storage unit used
in a worksheet. There is one active cell in a worksh eet, and that is wh ere information wi ll be
entered o r modifications will be made. An y cell can be made the active cell by selecting it.
• A cell can contain eith er text, a number, or a formula. Formulas may be composed of a
combination of arithmetic expressions created by the user and built-in, pre-programmed
fo rmulas known as functions.
• A cell h as an address composed of the letter representin g its column and the number
representin g its row. Thus, a cell defin ed by the intersection of column D a nd row 14 is named
0 14. Multi ple cells, in rectangular blocks, can be treated as a single unit by defin ing a range
of cells.
• Business graphics provide clear, visual, easy to understand presen tations of the data
contained in a worksheet. Analytical graphics are used to interpret the information in the
worksheet, and p resentation graphics are highe r quality v isual aids used to illustrate the
information in the worksheet.
• Th ree types of ch arts are used commonly to graph data visually: pie, column or bar, and line
charts.

KEY TERMS
active cell
analytical grap hics
argument of a function

line ch art

bar chart
business graphics

number

cell
cell address
co lumn
column chart
data points
data series

modeling

pie chart
presentation graphics
range
row
sp readsheet
text

electro nic spreadsh eet
exploded pie chart
formula
function

value
variable
what if... analysis
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Chapter 9: Microsoft Excel 2.2
What You Will Learn in This Chapter
After reading this chapter and compl eti ng the projects in it, you
sh ould be able to:
•

Ente r data into a worksheet

•

Change the width and format of a cell

•

Select ranges of cells

•

Insert and delete rows and columns

•

Create formulas

•

Apply functions

•

Save and print worksheets

•

Create, format, and print charts

•

Link data from one worksheet into another

•

Learn shortcuts to replicate data and formu las

•

Use absolute and relative cell referencing
I

xcel is the most widely used and o ne of the best spreadsheets
available on the Macintosh. It combines spreadsheet, presentation
graphics, and limited database functions into one powerful,
integrated package.

E
STARTING EXCEL

The first step in learning to use Excel is to start the program.
Mic rosof~

Exce 1

••

Locate Excel's icon on your cr mputer's deskto p. Double-cl ick on the
icon to start Excel.

When Excel starts, it automatically open s a blank worksh eet and names
it "Worksheetl". Figure 9-1 shows this screen and iden tifies its parts.
(Th e cancel box and enter box are no t visi ble until you enter o r modify
a formula.)

Parts of a Worksheet
Each part of the worksheet screen is explained next, bu t neithe r Figure
9-1 nor the definitions cover the standard parts of a Macintosh window,
only the o bjects specific to Excel.
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Active cell:

This cell 's contents w ill be affected if yo u enter any text,
numbers, o r fo rmu las o r if yo u make any formatting
changes.

Reference area: There is o nly on e active cell at a time, a nd this area of the
screen sh ows the add ress o f that cell.

Cancel box:

This is v isible o nly w hen the fo rmula bar is active; it
allows you to can cel an y ch anges you have made to th e
contents of th e acti ve ce ll.
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Figure 9-1

b:ar

Some of Excel's con trols and ind icato rs

Enter box:

This is visible o nl y when the fo rmula bar is active; it
a llows yo u to accept any cha nges you h ave made to the
con tents of t he acti ve cell. This is the same as pressing
Enter o n the keyboa rd.

Formula bar:

This area d isplays the actual contents of the active cell.
If th e active cell contains a formula, you will see the full
formula in this area and n ot the results of calculating
that fo rmula.

Split bars:

These controls are used to di vide the Excel w indow into
two o r fo ur pan es. If you press o n t he vertical split bar, you
can drag a di viding line to the right that will split the
window into two vertical windo ws. Yo u wo uld do this,
fo r exa mple, to see tit les in column A and to tals farther
to the right. (You w ill do this in Pro ject 4.)
The horizontal split bar allows you to split the window
in to two ho rizontal panes, on e above the other. This
wo uld allow yo u to see t he top a nd bottom of a column
of va lues tha t is too lo ng to fit o n the screen.
By using both ho rizo n ta l a nd ve rtical split bars, you can
split the window into four independently scrolling
pa nes, a llow ing yo u to see fo ur section s of a large
worksh eet at the sa m e time.
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To remove a split ar, drag it back to its original position
and release it.
l
b

This area displays very brief information about the
current state of Excel (Ready, Calculating, and so on) or
information about the currently selected command.

Status bar:

Rows and Columns
Excel, like other spreadsheets, is organized around the use of a window
divided into a table composed of rows and columns.
As you can see in Figure 9-2, each row is assigned a number, and the
columns are designated by letters of the alphabet. Although you can see
only 19 rows and 6 columns, the spreadsheet is much larger than that.
I
C 1lumn

If! File Edit Formul a Format D11t a Options Macro Window
AI

I

I
WorkJheetl
D

Ro"~

2
~3~-------4-------+-----~------~-----4-------t:,r::ll

-....;r-~--------+·----+-----1·--·-·-----f-------+-----·- !.:;
~;.-J-------!---·----+-·------l-·--·---l--·---·-·-4------- \:

~H----·--·-··-i--·--·-··---+---·-· ·-···--L-i-·--···-·-· -···-·i-·- ------4------- l: i:
ll-+';'-l·-···--·-·-·-··--1---··----+-·--·-··-··-···-··! -·--·- ·---l-------·-

Figure 9-2

.;-..

-----l'!:;::

Upper left corner o~ blank worksheet

You can think of this worksheet as a huge sheet of paper that you are
looking at through a window. By clicking on the scroll bars, you cause
the sheet to move behind the window, allowing you to see other parts
of the sheet.

Cells
The intersection of a row and a column is called a cell. A cell is named
by co mbining its column letter and row number.
You can see if Figure 9-3 that there are 16,384 rows and 256 columns.
The columns are lettered A. .. Z, but then the alphabet ends, so the next
columns are AA ... AZ, then BA ... BZ, and so on, up through IV. If you
multiply the number of rows (16,384) by the number of columns (256),
you find that there is a total of 4)1 94,304 cells in an Excel spreadsheet.
The top left cell of the worksheet (see Figure 9-2) is named A1, and the
lower right cell of the workshee (see Figure 9-3) is named IV16384.
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Alth ough this many cells technically are available in the spreadsheet,
your computer probably does not have enough memory to use a ll
of them. The average spreadsh eet u sually has no more than a few
hundred rows and fewer than 100 columns, and many spreadsheets are
much smaller.
Formot

Dolo

Options

Mocro

Window

Lower right corner of blank worksheet

Figure 9-3

Ranges
A group of cells is referred to by specifying the first (upper left) cell in the
group and the last (lower right) cell. These two cell references are
separated by a colon (:). For example, a group of cells con sisting of C2,
02, and E2 is referred to as C2:E2 (see Figure 9-4). You might find it
useful to pro nounce C2:E2 as "C2 through E2".
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Examples of cell and range names

A range may consist of more than one cell in a single row (C2: E2), several
cell s in one column (B4:B9), or a group of cells in multiple rows and
columns (DS :E8) .
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Cell Contents and Attrib tes
Cells may contain text, a number, or a formula. Regard less of informatio n
type, a cell's contents is limited to a maxim um of 255 characters.
ln addition to t he actual contents, a cell may a lso contain certain
attributes tha t dete rmine how the contents will be displayed. Th ese
attri butes include text and numerical formats, border lin es or shades,
and al ignment choices. A cell, even an empty one, may have these
attributes associated with it.
Unli ke o lde r electron ic spreadsheet programs, Excel is designed to take
adva ntage of many of the graphics features of the Macintosh . By
specify ing differen t fonts, sizes, and styles, as well as other formats that
may be ap plicable, you can produce a report that no t on ly is informative,
but also is visuall y appealing.
Depe nding o n t he contents of a cell and its attributes, Excel may di splay
som ething on the screen that is different from what th e cell actually
conta in s.
figure 9-5 shows a simple worksheet that contains several kinds of data .
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Figure 9-5

A simple wo rksheet

Text
Cells A2, A4, and A6 (and others)· Figure 9-5 contai n text. An y text ca n
be typed into a cell. Text typed i o a cell is treated as a constant; it will
not be ch anged by Excel. You, owever, can modi fy it any time you
want, by selecting the cell and t ping new text.
Most worksheets contain group of numbers, and those numbers are
id entified by typing text into a jacent cells. This wo rksheet con tains
text used as labels (Date, Item 1, and so o n). It also contains text used
to represent data (Evelyn Baxter) This sp reads heet could be expanded
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to include the custome r's address, cred it information, shipping add ress,
and o ther such textual data if d esired.
None of the text cells in figure 9-5 has any special formatting attributes,
so they all show the text in t he sa me fo nt, size, and style.

Numbers
Ce ll s 132 and C6 :C9 contain numbers. Numbers are t he basic data used
in a wo rksheet to produce usefu l results. A num ber, like text, is a
co nstant value. O nce you type a number into a cell it will not change.
You a re free to go back later and change the number any time you wish.
The number in 132 is formatted to re present a date, and all of the cells in
column C a re fo rm atted to show all values rounded to two d ecimal
places.
Cells C9 and Cll have been formatted to show a solid border on the
bottom of th e cell, to represent a line indicating an arithmetic sum.
Cells C10 and Cl 2 are formatted as currency, so a dollar sign is added
in front of the number. This dollar sign is inserted by Excel, not by the
person creating the worksheet. It is not a part of t he value in the cell; it
is an attri bute that affects how the value is d isplayed .

Formulas
Cell s C lO, Cl1, and C 12 con tain formulas. The main purpose of a
spread sheet progra m is to perform numeric calculations a nd prese nt th e
results, and cells co nta ining formulas a re the basic mechanism used to
do this. In t his wo rksh eet, the re are only three formulas. You can tell
Excel to show the formulas in a wo rksheet, instead of the values
calculated by the formu las, by ch oosing Display from the O ptions m enu,
a nd then selecting Formulas. You wo uld then see the worksh eet as
shown in Figure 9-6.

Figure 9-6

Displaying form ulas in t he worksheet
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A formula must start with the eJals character(=). The formula In cell
C10 is =SUM(C6:C9). This uses t~e built-in SUM() function, which tel ls
Excel to calculate the sum of the numbers in those cells. When the sum
is calculated, it is d isp layed in the cell containing the formula.
Cell C11 says to multiply the results of the sum calcu lation by 7.2S<J1) a nd
display the res ul ts. fina lly, C12 has a formula to add the total of the
purchases an d the ca lcu lated sales tax a nd sh ow the resulting value.
Fig ures 9-5 and 9-6 represent the same worksh eet: the first shows the
di spl ay as it wo uld n o rmally be seen, and the second sh ows th e optio na l
view of the fo rmulas instead o f their calculated resu lts.
You may be wondering why the date in cell B2 was replaced by th e
number "32416". The date was entered by typing 10/1/92 . Excel
recognized this as a val id date and automatically converted it into th e
serial number represen t ing th e number of days since Excel's base date
ofjanuary 1, 1904.
Excel calcula tes a formula and displays the results, not the fo rmula itself,
on the screen T his is one of the main features that make a spreadsheet
so powerful a nd easy to use. If you change a formula, or the numbers o r
formulas in cells it refers to, Excel recalculates and displays the new
value automatica lly.

Cell Addressing in Formulas
Two types o f ce ll addressing ca n Je used when you a re crea ti ng formulas
in Excel: re lative and absolute.
In t he sample works heet just p~esented there was a formula used to
calculate th e sum of four numbers. The fo rmu la in ce ll C10,
=SUM(C6:C9), tells Excel to add the numbers found in the fou r cells just
above C10. As long as yo u do not copy this formula a nd paste it
som ewhere else in the spreadsheet or tell Excel to dupl icate the formu la
for you, you do n't h ave to be aware of how Excel addresses the cells in
the formula.
Excel h as a powerful, time-saving feature th at Jets it automatically
d uplicate formulas acc ross a row or down a column when you tell it to
do so. It is when you make use of this feature that you must be aware of
the diffe rences in relative and absolute addressing.

Relative Addressing
Most formu las used in Excel ar based on relative nddressi11g. Relative
addressing is like giving d irectiors to somebody who is tryi ng to find
someth ing n earby. Yo u might tel l him to go to the second red light, turn
left, and go three blocks. This is~ relative method of givi ng direction s.
If you we re standing in a locatio two blocks away, the sa me directions
would cause the o the r person to arrive at a d ifferen t destination.
Unless you tell it otherwise, Excel uses relative add ressing in interpreting
formulas.
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Let's assume that you wa n t to add an other column of numbers, located
in cells 06:09. Instead of having to retype the sam e formu la in cell 010,
yo u can t ell Excel to fi ll the form ula one cel l to th e righ t. W hen Excel
copies the fo rm u la into the n ext ce ll, it au to matica ll y adj usts the
fo rmula so that it reads =SUM(D6:D9) . This is because Excel t h inks you
st il l want to add th e fo ur cells above the n ew fo rm ula's location (wh ich
is now cell 0 10).
In thi s case, an d most simi lar cases, t hi s ass umption and modificat ion
would be correct.

Absolute Addressing
In so me cases, however, you will encoun te r situatio n s w he n the cell
add ress in the fo rmula sh o uld be inte rpreted as an absolute address.
f-o r exa mple, you might wan t the fo rmu la in cell 0 10 to show t he sum
o f th e cells C6:C9, just as it does in cell C l 0 . There is a sim pl e way to tell
Excel n o t to ad just th e cell referen ces in the formula. To make a cell
add ress absolute rath er than relative, yo u ch an ge th e fo rmu la to read
=SUM ($C$6:$C$9) . Absolute add resses (with t he do ll ar signs) will no t
be ad justed wh en Excel du plicates t h e fo rmu la.
Yo u will en coun ter sit uations in Projects 3 and 4 in this chapte r when
it w ill be necessary t o u se absolute addressing to prod uce t he correct
results. The reason s fo r using ahsolute rath er than re lative add ressi ng
wil l be explai n ed when ever t he situa tion arises in th ose pro jects.

Charts
In addit io n to its worksheet features, Excel has a wide range of charti ng
functio n s for displaying numeri c data in gra phic form. The chart ing
aspects of Excel also make wide use o f t he Macintosh 's gra phi cs
capabilities an d allow you to crea te presentati o n-q uality charts, w hich
can be p rinted d irectly to your ImageWriter or LaserWriter.
Excel offers a wide variety of chart types such as pie charts and bar cha rts.
You will learn about charting in Pro ject 2.
In the first fo ur projects in t h is c hap ter you wi ll lea rn to create, mod ify,
save, an d print worksh eets an d charts.

GETTING HELP
Like most top-quality Macintosh programs, Excel offers ex tensive
o n li ne h elp . Three m ain types of h e lp are avail able. (This assumes tha t
yo u copied the Excel help file from t he distri butio n disk o nto yo ur work
d isk when you origina lly insta lled t he p rogra m.)
Th e first way to get h elp is to choose Help from th e W indow menu. Th is
o ffers a va ri ety of help informatio n th ro ugh w hich you ca n browse.
W hen yo u open the Help wi ndow, you w ill see th at th e terms h ave solid
u nderlin es (see f-igure 9-7).
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Excel's opening Help screen

A term with a solid underline is known as a jump term. When you point
to this type of term and click the mouse button, Help will find the
information associated with that term and take you to it. By clicking on
these Linked terms, you can jump from one topic to another and follow
a thread of interrelated topics.
If you click on the underlined phrase Defined Terms, you then jump to
its screen (see Figure 9-8). Whenever you click on a jump term, you
descend one level deeper in the help system. To return to the level from
which you just jumped, click the Back button.
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Figure 9-8 Defined Terms help

character

Macro

Window

n sh owing definition of ASCII

I

Each dotted underlined term is called a de{i11ed terrn. If you point to this
term and then press and h old d9wn the mouse button, a box appears
containing a brief description of the term . Whe n you release the mouse
button, the box disappears.
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Clicking the Next button moves you to the next screen about that topic.
The Previous button takes you to the previous screen.
If you are familiar with Lotus 1-2-3, you can click the Lotus 1-2-3 button

to retrieve information about the Excel equivalents of Lotus 1-2-3
commands.
The second way to get help while in Excel is in the form of its contextsensitive help. If you are using Excel and want help on the current
context, press Command-/ (Command-slash). For example, if you are
working in a dialog box and want help, pressing Command-/ will
provide information about the dialog box and any options or responses
you may select.
The third way to get information, when you want to specify the context,
is to press Command-? (Command-question mark, or Command-Shiftslash). The pointer will turn into a question mark. You can then click on
an object or choose a command. Instead of the click causing an action
to occur, Excel will give you information about the object or command
you selected.
For example, suppose you are working in a worksheet, and you want
more information about the formula bar. You could choose Help and
then find the information associated with the formula bar, but there is
an easier way.
If you type Command-?, the pointer changes to a question mark. You
can then move the pointer into the formula bar area (see Figure 9-9).
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Figure 9-9
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-

Getting help by typing Command-?

Clicking the mouse button while the question mark pointer is in the
formula bar will show its Help screen (see Figure 9-10). If you had clicked
while the pointer was in the worksheet area, you would have been
presented with general information about the worksheet.
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Help screen for

t~e

formu la ba r

If you are in a dialog box when you type Comm an d-?, it wi ll work the
same as typing Com mand-/ . T he dialog box is the current context, so
you will be presented with the Help screen fo r t hat dialog box .

An y time you are working in Excel, this help feature is avai lable, and it
is usually easier than looking up a top ic in the ma nual. Remember,
however, that the manual con tai n s mo re in-depth information about
the topics than Help does.

SAVING YOUR WORK
The first t ime you save your document, Excel asks you, by way of the
dialog box shown in Figure 9-11, whe re yo u wa n t you r document saved
and what you want it to be named.
Clicking the Drive button togg~es between one or more floppy drives
and h ard drives, depending o n rhe hard ware you a re using. T he Save
dialog box shows the name of the floppy disk or hard dri ve as that d rive
is selected. You are saving you r docume nt o n the selected d isk or hard
drive with the name sh owing inlthe Save d ialog box. In the dialog box
shown in Figure9-ll, the name ofth edisk, Miguel Garcia Data, is shown
in two places. Always be aware o f where you are saving your work.
After you have saved the first tin~e, th e next ti me you choose Save Excel
assum es you want your document
to be saved in the sam e place a nd
I
under the same name. You should be careful abou t savingyour document
in the correct place the first tim e ou save it, so you can find it late r. The
Save process is much quicker th e second a nd subsequen t times, because
you are not prompted fo r an y a d iti onal in format ion.
The Save As comma nd is simil ar to the Save comma nd, except that it
gLves you the o ption to give your document a diffe ren t name and save
it in a different location. Every time you choose Save As from the File
me nu you are prompt ed with thb dialog box shown in Figure 9-11. This
is the same dialog box you see the first ti me you save your document.

I
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When you use the Save As command and you attempt to save the
document with the same name and in the same location as before, you
will be asked if you want to replace the old document. This is because
no two files in a particular location can have the same name. If you want
to save different versions of the same document use the Save As
command and give the document a different name.
Save your work often. Save at least every ten minutes, so you never lose
more than ten minutes of work. The Command-key equivalent of the
Save command, Command-S, is a helpful shortcut. Always save your
work before printing.

I(g) Miguel Garcia Datal
D CI<J~s Noh's !lu11on~ i!=! (g) Miguel Ga ...
Cl Final Project s
r-:,..,-.--.,..---,
D Geno's M<m\J llnfor... i:il = [ Eject J
D Glo~sill Y
:':H
[ Driue )
D Gnw On!J C<n·d flrt
:::n
D L.unnr Mis~lons

~'

Saue Worksheet as:

Qilfi~j

ILoan Rna lysis

[ Cancel J

Normal Format

[ Options J

Figure 9-11

The Save dialog box

Be aware that you can save a document before you actually type
anything into it and that many people do it this way. However, you will
be given explicit instructions for saving your work at appropriate times
throughout the project.

Project 1: Creating a Worksheet
I

In this project you will learn to add text, numbers, and formulas to
create a worksheet. Then you will save three different copies of the
worksheet to be used in Projects 2, 3, and 4. In Project 1, you will create
a worksheet and calculate three different loans: a student loan, a car
loan, and a house loan.
All loans are not the same; the amount it costs to pay back a loan
depends on how much was borrowed (principal), the periodic interest
rate (annual and monthly rates in these cases), and the length of time
before the loan is repaid (term of the loan) .
From these figures you can calculate the amount of the monthly
payment, the total amount to be repaid to the lender, and the amount
of interest incurred.
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The final o utput o f Project 1 is shown in Figure 9-12.

Loan Analysis
Loan Type

Miguel Garcia

Student Loan

Total Amount
Do\>tn Payment
Term of Loan
An nual Interest Rate

$2,500 .00
$0.00
5 years
8.500 percent

Amount financed
Term of Loa n

$2,500.00
60 months

Monthly Payment
Total Amount to be Repaid
Total Interest

$51 .29
$3,077.48
$577.48

6/2/90

Figure 9-12

10:29 Af1

Final o utput of Prb ject 1
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ORGANIZING A WORKSHEET
To perform a basic loan a na lysis, yo u need en te r on ly four va lues: tota l
amount, down payment, number of periodic payments, and annua l
interest rate. Th e worksh eet will then use seve ral formulas to calculate
th e loan informatio n and very quickly will display the resu lts of t hose
ca lculations on the screen.
You will in forma lly divide the works heet into two areas: data entry
(input) and results of the calculation s (output).
You can use thi s wo rksh eet to calculate any amortized loa n (assum ing
the loan is repaid monthly) . There are many situa tions w he re a ll th e
formulas an d formatting in a worksheet may be used in solving more
than one problem . In these cases it ma kes sen se to develop a standard
worksh eet, and th en copy that worksheet a nd change only the text and
numbers necessary to solve each p roble m .
A worksheet used in this manner is known as a template. A template
con ta ins all th e formulas, labels, form atting, and constant text for
solving the problem. Whenever you want to solve a problem that h as
been defin ed in a templa te, you should copy the template, a nd then
make ch anges and ente r appropriate data into th e copy. This way you
won't risk damaging or losing the original.
In Pro ject 1, you will create a general purpose loa n analysis template.
Then you will make three copies of this template, change on ly the
information that is d ifferen t, and produce three specific loan worksheets.

ADDING TEXT TO A WORKSHEET
In this worksheet you must enter tex t, numbers, and fo rmulas. It is often
easiest to en ter a ll text, then all numbers, and t hen all form ulas. You can
ente r them in a ny o rder, and it is n ot necessary to enter th em as groups.
Some people prefer to complete one part of th e worksheet before going
o n to the next. Wh en ever you create worksheets, fee l free to enter the
contents of the cell s whichever way you prefe r.
In thi s project you wi ll begin by enteri ng t he text.
Of the millions of possible cells in a worksheet, on ly o ne is active at a
time. The active cell has a border around it, and its address is listed in
the reference area of the screen .
, ,. Click cell Alto make it the acti ve cell if it is n ot al read y active . Type
Loan Type and press the Reh1rn key.
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This will enter the text into cell Al and accept it. When you accept a
cell's conten ts by typing the Retjurn key, Excel will make th e next cell
below that o ne the active cell. This a ll ows you to quickly type information
into a column of cells without having to se lect each cell and make it
active before typing its contents.
You can also have a cell's text accepted by clicking the enter box or
pressing the Enter key . If you do this, Excel accepts the text and leaves
A1 as the active cel l.
A number of keystrokes can be used to select a different active cell. When
a new cell becomes acti ve, the border aro und the fo rmerl y active cell is
removed and the new active cel.l is hig hlig hted. The active cell does not
move; Excel makes another cell active, but it looks like the active cell
moves around the screen as each cell is highlighted in turn. Speaking
loosely, many people refer to this process as m o ving the active cell.
The keys shown in Table 9-1 perform the indicated operations in Excel.
Key
Enter
Return
Shift-Return
Tab
Shift-Tab

Action
Accepts
Accepts
Accepts
Accepts
Accepts

Right arrow

Moves active cell right. If an arrow key u sed while
a formula is being entered onnodified, it will change
the fo rmula and not make a diffe rent cell active.
Moves active cell left
Moves active cell up
Moves active cell down

Left arrow
Up arrow
Down arrow

Table 9-1

formula
formula
formula
formula
formula

but does not move active cell
and moves active cell down
and moves active cell up
and moves active cell right
and moves active cell le ft

Keys that affect acti e cell and formul as in Excel

Since you want to continue entering tex t in co lumn A, you accepted the
text by pressing the Return key, which caused Excel to accept the text
into cell A1 and make the cell below Al th e new active cell. As you can
see now, cell A2 is outlined and t he reference area shows A2 is active.
Return

,. . There is no text to enter in cell A2, so press th e Return key again to
make A3 the active cell.
I
,, .

Refer to Table 9-2, and ente the a ppro pri ate text into each of the
listed cells. Note that the last three entries go into column C instead
of column A.
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Cell address

Al
A3
A4

AS
A6
A8

A9

All
A13
A14

cs

Text to be entered
Loan Type
Total Am ount
Down Paymen t
Term of Loan
An nual Interest Rate
Amount Financed
Term of Loan
Monthly Payment
Total Amount to be Repaid
Total Interest
years
percent
months

C6
C9

Text to be ente red into the worksheet

Table 9-2

When you finish, your screen should look like the one shown in
Figure 9-13.

,. *

file

Edit

Figure 9-13

fo r mula

fo r mat

Dat a

Options

Macro

Window

Worksheet with all text entered

CHANGING COLUMN WIDTHS
You will be entering numbers and formulas into column B, but you will
encounter a problem, because some of the text in column A does not fit
a nd it continues into column B. For instance, note how the label
"Annual Interest Rate" in Figure 9-13 extends into column B.
Excel allows up to 255 characters to be entered into a cell. This means
you easi ly can enter more text th an will fit into a column. If the cell to
the right is blank, Excel allows the text to "spill over" into the blank cell.
In fact, text can continue into several empty cells.
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e~ty,

If the cell to the right is not
Excel will truncate the text and
wi ll on ly disp lay whatever text will fit in to the current column width.
This does not mean that any o f the text is lost. If you cl ick o n the cell
and make it active, you will see the entire contents of that cell in the
formul a bar.
In a couple of minutes you wi ll be adding numbers and formulas in to
column B, and this will cause an y text th at overflows from column A to
be truncated . You want to be able to see all the text in column A, so you
will make the column wider.
•

+

Move the pointer to the right border of column A between the A and
B a t the top of the column.

The pointer changes into a vertical bar with arrows pointing left and
rig ht, as shown at left. While you see this pointer and you continue
pressing the m o use button, you can make column A narrower o r wider
by moving the mo use to the left or to the right.
.. Press the m ouse button and move the mouse to the right until all th e
text in column A fits into the column; then release the button.
Figure 9-1 4 sh ows how the screen looks during (left screen) and after
(right screen) this operation. The left screen sh ows that cell A's righ t
bo rder has been "grabbed" and moved past the longest t ext in column
A. (It looks like column B is being adjusted, but that is because the righ t
bo rder o f column A h as been d ~agged al most to the right borde r of
column B.) In the screen on the right, the mouse button has been
released, and Excel has resized column A and h as moved the left side of
column B to where the pointer was when the mouse butto n was
released.

Figure 9-1 4

Changing the width of column A

Now that all th e text fits into column A, none will be tru ncated.
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SAVING THE WORKSHEET
Be careful about saving your document in the correct place the first time
you save it, so you can find it later. The Save process is much quicker the
second and subsequent times, because you are not prompted for any
additional information.
Save your work often. Save at least every ten minutes, so you never lose
more than ten minutes of work. The Command-key equivalent of the
Save command, Command-S, is a convenient shortcut.
:3€: -S

,. Choose Save from the File menu.
,. Click the Drive button, if necessary, to switch drives until the name
of your data disk is showing above the Eject button, where "Miguel
Garcia" is in Figure 9-15.

I!g) Miguel Garcia Datal
D Cl<I~S NntPs ll utto n~
D Final Projects
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Saue Worksheet as:

ILoan Analysis

~·

(

:~;;~

:

~ Saue~~;J
( Cancel )

Normal Format

Figure 9-15

The Save dialog box

, . Type Loan Analysis as the name of your document, and then click
the Save button.

ENTERING NUMBERS
If you are currently attending college, or have been to college, you might

be familiar with student loans. We will use this worksheet to analyze a
loan for $2,500 for 5 years at 8.5% interest. (Of course, there are a wide
variety of terms and conditions for student loans. At the end of this
project you will be given the opportunity to analyze several loans and
compare them.)
There are only four numbers to enter into this worksheet.
,,. Refer to Table 9-3 below and enter the appropriate numbers into
each of the listed cells.
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Cell address
B3
B4

Nurrilber ~~7 entered

B5
B6

8.5

Table 9-3

Numbers to be entered into Loan Analysis worksheet

You learned earlier that Excel allows up to 255 characters to be
contained in a cell and- that text can spill over into blank cells to
the right.
The 255-character limit applies to cells containing numbers, but the
ability to "spill over" does no t apply. If a cell is not wide enough to show
the entire number contained in the cell (according to any formatting
you have chosen), Excel will always show number sign s (#) across the
cell. This is an error message to alert you to change the format of the cell
o r to make the column wider.

FORMATTING NUMBERS
Excel provides many predefined formats for displaying numbers, as well
as the ability to create your own custom formats.
Most of the values to be displayed in column B will be dollar amounts.
Some of the other values will be percentages or integers. Since most will
represent currency, let's tell Excel to display all the numbers in column
B as currency. Then let's selec 1 individual cells and assign them a
different format.
An y time you reassign the format fo r a cell, it overrides any previous
formatting.
To format all of column B, you must select a range of cells. Previously
you have worked with only a single cell at a time. Excel allows you to
select a range of cells upon which to operate, but even wh en a ran ge of
cells is selected, there still is only one active cell.
The distinction between a cell's contents and its formatting attributes
is important. There is only one active cell, and it is the only cell in which
you can enter text, numbers, or formulas. In Figure 9-16, all of column
B is selected, but only cell Bl is active. You can see this by looking into
the reference area, where it shows Bl.
You can modify the format of any selection of cells all at one time. This
will not affect the contents of the cells, but only how they will be
displayed.
•

Select column B by clicking on the letter B at the top of the column.
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Mocro

Figure 9-16

Window

Selecting an entire column

Notice that all of column B is highlighted,but cell B1 is outlined and
shown in white, and the reference area shows that B1 is the active cell
(see Figure 9-1 6).
,. Select Number from the Format menu. Select the format shown in
Figure 9-17 by clicking on it, and then click OK.
A shortcut for selecting a format from the list is to double-click on it.

Format Number
General
0
0.00
#,##0
#,##0.00
$#,##0 ;($#,##0)
$#,##0 ;[Red)($#,##0)
$#,##0.00 ;($#,##0.00)

~

(

,.

OK

~

Cancel

)

ne!e1e

)

Il:tJl

Format:

Figure 9-17

Choosing a currency number format

All the cells in column B now display their number values as currency
with two decimal places. Let's select a different format for three of the
cells that will not contain currency values.
In this case, the first and last cells contain numbers representing
currency. The cells with other formatting are in terspersed inside this
group, so it is faster to format the whole group as currency first and then
go back and deal with the exceptions.
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When you encounter a situation I here there is no clear majority of cells
with the same format, it is probably better to format each cell with its
particular format. But, whenev~r you can format a range of cells it is
faster, even if you have to go in a change a few.
The term of the loan will be entered in years. Sometimes it will be an
integer value, such as 3 or 5, but other times it might be 2.5 or 1.25 years.
Since most loans are for whole years, this was the easiest way to organize
the worksheet. We could have opted to let you enter the number of
months, which might be useful if loans are made for terms like 30
months. With a little more work, the worksheet could let you enter years
and months, such as 2 years and 6 months. It is up to the person who
designs a worksheet to determine the most useful form for entering data
into a worksheet.
You want the value to be displayed using the fewest number of digits
to the right of the decimal point. The format that will do this is the
General format. Assume that you will be the one using this worksheet
and that you will not enter some value such as 3.912767349 for the
term of the loan.
,. Select B5, where the term of the loan in years was entered, by
clicking in the cell. Choose Number from the Format menu. Doubleclick General to select and apply it.

0
0.00
#,##0
#,##0.00
$#,##0 ;($#,##0)
$#,##0 ;[Red]($#,##0)
$#,##0.00 ;($#,##0.00)

Figure 9-18

OK

)

Cancel

)

[!(1!(11 (1

Choosing a general number format

Cell B9 will contain the term of tJ;le loan in months. You want this value
to be displayed as an integer, so ~~t' s tell Excel to format cell B9 to show
no digits to the right of the decilmal point.
,. Double-click on 0 to set the format of cell B9.
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Format Number

OK

D

Cance l

Bele1e

#,##0
#,##0.00
$#,##0 ;($#,## 0)
$#,##0 ;[R ed]($#,##0)
$#,##0.00 $# ##0.00)

Figure 9-19

)

C hoosing an integer number form at

Cell 136 contains the value for the annual interest rate. Sin ce th ese
interest rates frequentl y h ave bee n designated in eigh ths of a percent,
you need to a llow th e display o f three digits to the rig ht of t he decim al
point. Excel does n ot have a predefin ed format for this, so let's create a
custom fo rmat.
•

Tell Excel that you want to fo rma t the num ber in cell 136 (use the
techniques you have used fo r the previo us cell s) . Wh en you get to
the dialog box shown in Figure 9-20, cl ick (do not double-cli ck)
on 0.00.

This format w il l now appea r in t he box a t the bottom, labeled "Format: ".
•

Positio n the pointer to the righ t of the last zero and cl ick to position
the text inse rtion point.

•

Add another 0 by typing (see Figure 9-20). Click OK to accept your
n ew custom format.

rF~o_
rm__
at~
N_um
__
b_e_
r ____________~~
~

General

0

~?}~t1::o~(~~~.##O)

$#,##0.00 ;($#,##0.00 )

w

I

K
-

OK

J

( Ca ncel )
Delete

fO

Format: I 0.000

~--------------------------~

F igure 9-20

C reating a custom num ber fo rmat

At this point, you h ave entered all the text and numbers n eeded fo r
this worksh eet, and you h ave formatted the numbers as you need them
to appear.
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Now is a good time to save you r worksheet.

FORMATTING CELLS
Anoth er formatting option is to change how data is aligned: either to the
right, left, or centered. Alignment is a purely aesthetic consideration
and has no effect on calculations or sorting. Text is automatically
aligned left, and numbers are aligned right.
Excel offers the normal style options that can be applied to individual
cells or cell ranges, such as bold, Ha lic, or underline. Because of its grid
orientation, it also provides the capability of drawing complete or
partial borders around cells. Examples would be placing a box around
a key number or emphasizing th e column h eader range by making those
cells bold and outlined.

CREATING FORMULAS
A paper spreadsheet can display text and numbers as well as an
electron ic spreadsheet can. If all you want to do is to present information,
you can do it manually or with other programs such as word processors.
The real power of an electronic spreadsheet comes from its abi lity to
store a formula in a cell, automatical ly recalculate all formu las when
something changes, and then display th e current results on the screen.

Using Excel's Built-in Functions
Excel has a total of 13 1 built-in wo rksheet fun ctio ns that you can use t o
create formulas. These functions are organized into 11 categories:
Database, Date and Time, Financial, Info rmation, Logical, Lookup,
Mathematical, Matrix, Statistical, Text, and Trigonometric.
Excel's Help h as info rmation available on each of these functio ns and
groups of related functions. One of the most used fun ctio n s is the SUM()
function, which totals the contents of a range of cells.
Let's see what Help has to say abo ut the SUM() funct ion.
•

Ch oose Help from the Window menu.

•

Click on Functions.

•

Scroll down the list of functio ns until you find SUM(), and then click
on it.

Excel presents a bri ef explanatio for t he function and some examples
of its use (see Figure 9-21).
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Help
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SUM(numbe r l ,numbe r 2, ... )
Give• toto! of ell nu mbe r> incl uded In argument..
I to 14 argument• ore ollo..,ed.
• Arquments should be numben, or erreys or references that contain
number3,

.

Q

Topics
Cancel

)
)

( Preuious )

(
(

•Exampl es

If AI :A3 eontol no the num ber• 5, 8, end 2, then:
SUM(A I :A3) glveo 15.
SUM(A I :A3, t 5,5) glveo 35.

NeH t
B ~c k

)
)

( lotus 123)

• Rel ated To plco
Gtv.. the over oge of Ito argu mento.
~
Gl v.. tall v of number. In erQumento.
{.1M:!!
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!:!!!!!!li!
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Other Statbt!g!l Fyn;tlorg

0
Figure 9-21

(
(

~

Sum () function Help screen

lf yo u wa nt to use any of these built-in functio ns, you h ave two choices
for en tering them into your formula: (1) you can type the formula int o
the form u la bar, o r (2) you can ch oose Past e Function from the Formu la
m enu . If you decide to use the Paste Function command, you h ave a
ch oice of whether to have Excel show a Jist o f mguments in the formul a
or not.
An argument is o n e of th e values o r cell addresses that w ill appear inside
the pa renth eses of the functi o n. Fo r exam ple, if yo u want to add all the
va lues in cells Al , A2, A3, and A4, you h ave two ch oices: (1) you can
enter the formula:
=Al +A2+A3+A4
Or (2) you can use the SUM() functio n:
=SUM(Al:A4)
In the first case the formula tells Excel to add the value in cell Alto the
va lue in A2 to th e va lue in A3 to th e value in A4 and then to store the
results in the current cell. In the second case, th e formu la tells Excel t o
ca lculate th e sum of the values sto red in the ran ge of cells from A1 to A4.
(The range" Al :A4" is the argument for th e SUM() function in this case.)
Both formulas w ill result in the sam e value appearing in the current cell.
The only difference is how much effort it might take you to enter t h e
formul as. If you needed the sum of on ly two or three cells, the first
fo rmu la might be the easiest. If, in stead of two o r three cells, yo u needed
the sum of 100 cells, th e second alternative would be a much better
cho ice. Both methods wo rk; yo u can ch oose the one that is most
conve nient fo r yo u.
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Entering Formulas
To enter a formula into a celt yo 1 must begin by typing an equals sign.
This equals sign is the signal t~at tells Excel that you are entering a
formula rather than t ext or a number. Rem ember, Excel displays tex t
just as you entered it, but it must calculate th e results of a fo rmula and
display the results in the cell that contains the formula.
You can always see the entire formu la whenever the cell is the active cell.
The formula will be shown in the formula bar, located just below the
m enu bar at the top of the screen . You can a lso edit a formu la in the
form ula bar.
The formula you will enter into cell B8 is =B3-B4, but don't enter it yet.
This formula tells Excel to subtract the value displayed in cell B4 from
the value displayed in cell 83 and to show the results of this ca lcul atio n
in cell B8. (Remember, this is a formula using relative addressing. It
really tells Excel to subtrac t the value in the cell that is located four cells
above B8 from the value in the cell five cells above B8 and then display
the results in B8.)
Refer back to cells B3 a nd 84. Cell B3 represen ts the tota l amount of a
purchase or prospective loan , and B4 represents the down payment
amount. Cell B8 represents the amount you will actually borrow.
There fo re, this fo rmula tells Excel to su btract the a mount of the down
payment from the total amount, giving the am ount to be financed.
Since you have previously formatted this column to show values w ith
dollar signs and commas, your result will be displayed automatically as
currency.
There are two ways to enter the formu la into Excel. You can type the
formula, or you can use the mo use to point to cells or ranges of cells to
be placed into the formu la.
You will now enter the formu la into cell B8 using each method.
•

Select cell B8 by clicking in it.

•

Type the = key, and then type B3-B4.

•

Press the Enter key to te ll Excel to accept the formula, calculate it,
display the results, and keep cell B8 active.

When you pressed the Enter key, Excel ra p idly ca lculated the results,
and yo u now see $2,500.00 displayed in cell B8 (as sh own in
Figure 9-22).
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Entering formula to calculate Amount Financed .

With such a simple formula, typing is probably the easiest way to enter
it. An alternative method for entering the formula allows you to specify
cells or ranges of cells using the mouse. Enter the formula again using
this method.
-. Select cell B8, and type the = key.
This tells Excel that you are entering a formula into this cell. As soon as
you do this, the equals sign is shown in the formula bar, and two new
boxes appear as shown to the left.
The box with the X is the can cel box. If you click in this box an y time
you are entering or editing something in the formula bar, the edit will
be cancelled, and the cell and its contents will be left as they were before
you began the current edit.
The box with the checkmark is the accept box. Clicking in this box is the
same as pressing the Enter key. The current contents of the formula bar
will be accepted into the cell.
•

Select cell B3.

An effect often called "marching ants" surrounds the cell, and B3 is
added to the fo rmula in the formula bar.
Thi s marching ants selection shows that you have selected only one cell
to be added to the formula. The marching ants are there as a visual
confirmation of the cell(s) you have selected to be added to the formula.
•

Type a minus sign.
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The marching ants disappear f om cell B3, to show it is no longer
selected. Any math operator will cause the marching ants to go away,
and the operator will be added to the formula. Excel's operators are
shown in Table 9-4.
Ogerator

"

*

I
+

-

Table 9-4

Reg resents
Exponentiation
Multiplication
Division
Addition
Subtraction

Examgle
=2"3
=2*3
=2/3
=2+3
=2-3

Meaning
2 cubed
2 ti mes 3
2 divided by 3
2 plus 3
2 minus 3

Common math operators used in Excel

.. Select cell B4.
B4 is surrounded by the marching ants, and its address is added to the
formula. The formula bar now shows =B3-B4.
•

Now press the Enter key, or click on the accept box.

As soon as you do this, the marching ants will disappear from cell B4,
and the cancel and accept boxes go away. The formula is accepted into
the cell, and Excel quickly calculates the formula and shows the result
in cell B8.
This method seems like a lot of work compared with the previous
method, and on such an easy formula it may be. However, it has the
benefit of being more intuitive. Instead of having to concentrate on the
addresses of the cells and type them in, pointing and clicking allows you
to think something like, "In this formula take this cell and subtract that
cell from it". Whenever you thinkof"this cell" or "that cell" all you have
to do is point and click.
This method of using the mouse to select cells is even easier when you
need to specify a range of cells. In that case, you click on a corne r of the
range, ho ld down the mouse button, and drag to the diagonally
opposite corner. As you drag the mouse, a rectangle will become
highlighted as you select the range of cells inside the rectangle. The
entire range is surrounded by the marching ants and the address of the
range is entered into the formula bar.
As an example, su ppose you wanted to enter =SUM(B3:D9) into cell BIZ
of a new worksheet. You could type =SUMO into the formula bar. Then
click between the parentheses to position the insertion point. This tells
Excel you want to insert somethiiilg between the parentheses. You could
type B3:09 direct ly into the formula bar if you prefer. Or, you could drag
from cell B3 to 09. As you do this the marching ants will surround the
range you are selecting. You don 't even have to look at the cell addresses;
just drag and select the ones you want, and Excel will enter their
add resses into the formula bar (see Figure 9-23).
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Entering a range into a formula by dragging w ith the
pointer

Using Paste Function
Yo u will now enter the formula into cell B9 to calculate the term of the
loa n in month s, based on the term of the loan in years, which you
previo usly entered in cell BS.
Th is fo rmula will multiply the value in cell BS by 12.
Let's te ll Excel to force th e value in cell B9 to be an integer. This may be
done by using the function INT() . The formula you will enter into cell
B9 is =INT(BS*12) . As before, you can type this into the cell, or you can
type part of it and select cell BS to add it to the formula. You wi ll use the
second m ethod, with t he addition of using Paste Function from the
Formula menu.
•

Select cell B9 and type = .

•

C hoose Paste Function from the Formula menu.

•

Scroll down in the list until you see INT(), and then double-click on
it to select it. (See Figure 9-24.) You can also enter the first letter of
an y functio n to jump to that section of the alphabetized li st.
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Pasting the integer functi on into a formula

Look a t the screen o n your computer. Notice that the for mula bar now
con tains =INTO, and the insertion point is inside the pa rentheses.
•

'"

Select cell BS, and then type *12 and accept the formula (see
Figure 9-25).
•

File

Edit

Figure 9-25
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Format
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Macro

Win dow

Completed formu la using built-in integer function

Yo ur worksheet shou ld show 6 as the term of the loan in months.

.,
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Now it is tim e to calculate o ne of the m ost im portant p arts of a loa n
analysis-th e m o nthl y paym ent. To do thi s, you will m ake use o f two
o f Excel's built-in fo rmul as: PMT() a nd Al3S(). PMT() mea ns "payment"
and ABS() stands fo r "absolute value".
The PMT() func ti o n is a multipurpose fin ancial fun ctio n . Yo u wi ll be
using it to calcu late the periodic pay me nt to repay an a mo rtized loan.
This m eans that you w ill be m aking a regula r (mo nthly) pay me nt,
whic h wil l be a pplied to the loa n in two ways. First, your pay ment will
be applied to the interest o n the remaining ba lan ce of the loan fo r the
m o nth , then a nything le ft will be appli ed to reduce the a mo unt you
owe. If you pay mo re than the regular payme nt amo unt, mo re will be
applied to reducing the ba la n ce.
T his wo rksh eet assumes tha t yo u w ill pay exactly the m onthl y payment
each m o n th.
O ne of the features o f a mo rtized loan s tha t usually comes as a surprise
t o first-time borrowe rs is the ratio of payme nt to interest versus the
payment to reduce the principal (outstanding balance). If yo u bo rrow
m on ey to buy a ho use and the loan is fo r 30 yea rs, you will be paying
o nl y a few d o ll ars to red uce the loan and hundreds o f do llars in interest.
If the loa n is fo r fewe r yea rs, the pro portio n of interest to principal will
be sm aller-you will be paying less for interest and m o re toward
principa l-but your mo nthly payments will be hig he r.
Befo re th e widespread use o f electro nic spreadsheets it was difficult for
consumers to compare differe nt loa n packages, but with this worksheet,
yo u will be able to e nter just fo ur values a nd almost immediately see the
mo nthl y pay ment, to ta l payback amo unt, and the to tal interest o ve r the
te rm of the loan .
Th e o ther functio n, ABS(), is the Absolute Value functio n. Sin ce you are
repaying a loan, the PMT() functio n wil l calcu late your m o nthl y
paym ent as a negative va lue . The p ayment am o unt o n this worksheet
sh o uld be sh own as a positive a mo unt, so the ABS() functio n is used to
make it so. Th e absol ute value functio n w ill make a negati ve number
positive and wi ll no t affect zero values o r positive numbers.
To begin the fo rmula in cell Bll you wil l start with the absolute va lue
functio n .
•

Select cell Bll , choose Paste function, select the ABSO functio n from
the li st, and acce pt it.

•

Now, again choose Paste Function, scroll down a nd select PMT()
from the li st (do no t do uble-click).

•

Check Paste Argume nts (see Figure 9-26) . Click OK.
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Pasting the payment fun ctio n and its arguments into a
formula

The formu la bar wi ll now have the AI3S() fu nction and the PMT()
function pasted into the formula bar. By ch oosing Paste Arguments, you
told Excel to add a list of dumm y a rg uments to indicate w hat needs to
be within t he parentheses for the PMT() function to calcu late the
mo nthly payment o n yo ur loan.
A dummy argument is a group of le tters tha t represent wh at the function
expects to fi nd inside the parentheses. They are called "dummy"
arguments because they are o nly placeholders and must be replaced
with actual parameters.
There are fi ve arguments for the PMT() fu nct ion : rate, n per, pv, fv, and
type. Thei r meani ngs are sh own in Table 9-5.
Argument
ra te
nper
pv
fv
type

Table 9 -5

I
Meaning
the periodic interest rate, in this case, monthly
the number of periods in the term of the loan; in
this case, it represents mo nths
present va lue (a mount to be financed)
future value (this is not applicable to this pro ject)
indica tes w hether payment is m ade at th e beginning or
end of the period (defaults to beginning) and ca n make
a big d ifference when payments are made qua rterly or
annually

Arguments necessary for PMT() function

To calcula te the monthly paym ln t, you will need to supply values only
for th e rate, number of periods, and prese nt va lue.
•

To specify t he rate, move th . po inter to the formu la bar and do ubleclick on th e word "rate."
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Figure 9-27

Replacing the rate argument with its associated value

,,. The annual interest rate is in cell 86, so click on B6 to replace the
word "rate" with the cell address B6.
This will tell Excel that the periodic rate is 8.5. However, this would not
be correct, since Excel would interpret this to mean that the monthly
interest rate is 850%, and that clearly is not correct. To convert t[le 8.5
to percent form, you must divide it by 100 to get 8.5%, which is the
annual rate, and then divide that by 12 to get the m onthly interest rate.
The easiest way is to tell Excel to divide the contents of cell B6 by 1200
to con vert it directly to the monthly interest rate as a percentage.
•

The insertion point is directly after B6, so type / 1200 to tell Excel to
divide the amount in cell B6 by 1200.

The next step is to replace the dummy argument "n per" with the
location of the cell that contains the term of the loan in months.
•

Double-click on nper to select it, then select cell B9.

•

Now tell Excel the present value, pv, is in cell B8.

Since you don 't need the last two arguments, "fv" and "type", you can
delete them from the formula bar (see Figure 9-28).
,,. Select Jv,type and press Delete (or Backspace). Be sure to include the
leading comma, and do not delete eithe r of the trailing parentheses.
Press the Enter key or cli.ck the accept box to accept the formula.

Chapter 9: Excel

393

r

Figure 9-28
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Dele ting unnecessary arguments from the fo rm ula

The pay men t fo rm ula has now bee n entered, and your d is play s ho uld
show th e m o nth ly paym ent (see Figure 9-29).
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The completed m f nth ly paym ent fo rmu la

All that is left is to add the form J las to calculate the total amo unt to be
repaid and the total interest. Th to tal amount to be repaid is ca lculated
by multiplying the number of payme nts by the payment amo unt. The
total interest is th e tota l amoLmt to be repaid m in us the amo un t
financed .
.. Enter t he formu la =Bl 1*B9 ip to cel l B13, a nd =B13-B8 into cell Bl4.
Now, in cell Bl, ty pe Student Loan.
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You have com p leted the worksh eet for Pro ject 1. The nextthingyou will
do is print the worksheet you just completed. It is always a good idea to
save a document before printing it. Save your work now.

PRINTING
Printing from Excel involves defining how you want the wo rksheet to
appear and then issuing the Print command. You can indicate ho w you
wanttheoutputto appea r by using the Page Setup co mmand . When yo u
h ave finished setting up the page's appearance, you tell Excel to prin t
the document.

Page Setup
Excel allows you to print h eaders and footers when you print your
worksh eet and gives you the o ptio n o f printing th e row and column
h eadings and grid lines shown on the screen. These optio ns are available
in the Page Setup dialog box, which is selected by choosing Page Setup
from th e File menu.
Be fore you print your worksh eet, you will modify the h eaders and
footers and choose not to print gridlines a nd row a nd column headings.

Header and Footer Formatting
•

Choose Page Setup from the File m enu.

The first thing you will do in this dialog box is ch ange the h eaders and
foote rs. A header is text that appears in the top margin, and a foo ter
appears in the bottom m argin, o f every page. In this book, the page
number and chapter title appea r in the h eader at the top o f each page.
Unless you tell Excel otherwise, it has a set of default va lues that will be
printed in the h eader and foote r. The filena me o f the d ocument (wh at
you n amed it w hen you saved it) will be displayed in the header, and the
word "Page" and the page number will appea r in the footer.
A default value is there fo r yo ur con venien ce. In man y insta nces, you
might want th ese things printed on your o utput so you can identify it
and keep the pages in orde r. A default value may easily be cha nged if you
want something e lse, or nothing at all, in the header or footer.
In this project, let's change the heade r so that the filen ame is at the left
margin and yo ur n ame is at the right m argin of the page. The output wi ll
be only one page lon g, so let's change the foote r to sh ow the d ate and
time.
Befo re you can change wh at will appear in the header and footer, you
need to know the available option s. To learn more abo ut this, you can
use Excel's He lp.
~ _7

•

Press Command-Shi ft-/ (Command-?).
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Excel o pen s its Help window an · selects the File Page Setup screen:
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Figure 9-30

•

Help screen fo r Page Setup dialog box

Move the po in ter to the un derlined words "header and footer
codes." The arrow po in ter wiU cha nge to a pointi ng h and (see Figure
9-30). Click the mo use butto n .

This tells Excel to sh ow the screen that describes these codes.
Edit
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Figure 9 -31

..

Header and footer codes for Page Setup

When you are finish ed readi g this screen, click the Cancel bu tton.

Let 's change the h eader first. ~ate r, whe n you are print ing other
works heets, you can choose wrat you want to have appear in the
headers an d footers. Fo r n ow, enter the following comm ands (substituting
your nam e in place of the words "Your Name"):
•

Header:

&LLoan Analysis&R&BYour Name

•

Foote r:

&C&D

&T
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(In sert fi ve spaces after th e "D" in the footer so the date and time w ill
be separated by five spaces instead of running togeth er.)
This h ead er format tell s Exce l t o print the wo rds "Loan Analysis" against
t h e left ma rgin of the pape r a nd to print yo ur n ame in bold cha racters
again st the right margin .
The footer fo rm at says that you want to center the curre n t d ate, five
spaces, and t h e current time at the bottom of the page.
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Figure 9-32

C h an ging th e header an d footer codes

Turning Off Gridlines and Row and Column Headings
Figure 9-32 sh ows that the gridlines and the row and column headings
will be prin ted. You can tell t h at because there is an "X" in th e check box
n ext to each o ptio n. Thi s is the defa ult.
If Print Gridlines is selected, each cell will be sh own on t he page
surrounded by dotted lines, as yo u see t he m on the screen wh en working
in the worksh eet.
Row a nd column h eadings a re the alphabetic headings that appear at
the to ps of th e columns and th e numeric headings th at a ppear on t he
left of the rows. These headings are used to determine cell ad dresses .
The out put from this loan analysis worksheet does n ot need either of
th ese features to be printed , so you can tell Excel not to p rint t hem .
.. To tu rn off th ese fea tures, click the ap propriate check boxes in the
Page Setu p d ialog box so t h e "X" d isappears in each o ne, a nd then
click OK.
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Page Preview

I

Excel allows you to preview your document before you print.
38- P

•

Choose Print from the Fil e menu, and then click Page Preview in
the Print dialog box. Click OK or press Return.

You wi ll see a reduced view of the worksheet, including the h eaders and
footers yo u just changed (see Figure 9-33).

Figure 9-33

Reduced Page Preview screen

Although this display is too small to read, it gives you an overall view
of the worksheet. There are two ways to get a closer view of it. You can
click the Zoom button, or you can move the pointer (now in the shape
of a magnifyin g glass, as shown at left) over th e part of the page you want
to see magnified and click the mouse button.
•

Use one of these methods to zoom into the previewed p age and
make it larger.

You now have several choices. Th ere are five buttons at the top of the
scree n (see Figure 9-34). Next wil l take you to the n ext page, if there is
one, and let you preview it. Previous moves yo u back to the previous
page. Either, or both, of these buttons will be dimmed if there is no page
available in that direction. In this case, the document is only one page
Lo ng, so both buttons are dimmed.
You know whatZoomdoes. Print tells Excel to quit previewing and print
the document, and Can cel tells Excel to close the screen and not print.
You remain in preview mode until you deselect Page Preview in the Print
di alog box.
Now that you have made the suggested changes, it is time to print your
document.
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•

Cli ck the Print button to print yo ur worksheet.
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WHAT IF... EXERCISES
As previo usly discussed, on e of the m ost powerful features of electronic
spreadsheets is their ability to auto m atically recalculate all formulas and
update the di splay wh en ever any changes are made.
In this last sectio n o f Pro ject 1, you will calculate several student loans,
ca r loans, and house loans, and then save the last o ne of each o f these
to yo ur disk to use in Proj ects 2, 3, and 4.
Note: When a nalyzing some of the following loan s, you may see a string
of number signs(#) in one o r m ore of the cells. This is an error message,
and it m eans thatth e value in that cell is too w ide to fit. You can rem edy
this by increasing the width of the column containing these symbols.
These exercises a re presen ted so you can experien ce the speed of Excel
a nd th e power of ''what if" analysis. As you work through th ese exercises,
you wi ll lea rn h ow easy it is to use a worksheet fo r loan analysis.
If yo u intend to work through Projects 3 and 4, you must work th rough
th ese what if ... exercises. The spreadsheets you will save in step s S, 10,
an d 15 will be used in those projects.

Calculating Student Loans
You have already entered all the data to evaluate a student loan into the
tem plate yo u created, so let's save a copy of it.
•

Choose Save As from the Fi le menu. Save a copy of t his worksheet
o nto yo ur di sk and nam e it Student Loan.
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Wh at if...
1. The interes t rate rose to 9.25%? How much would the mo nthl y
paym ent increase? How much would th e to tal interest repaid
increase?

Hint: Select the cell that co11tains the mmual interest mte. Type 9.25 and
accept it.
2. What if the interest remained at 8 .5lVc>and th e term increased to
7 years? How wou ld that affect the mo nthly paym en t and to tal
interest?

Hint: Select the cell that contains the annual interest mte. Type 8.5 and
accept it. Select the cell that contains the term of loa11, and e11ter 7
into it.
3. W h at if the in te rest remained at 8.5% and the term decreased to
3 years? How would th at affect the loan?
4.

What if t he interest rose to 11% and the term increased to 7
years? How would that a ffect the loan?

5. W h at if the amo unt is $5,000, the rate is 9°A>, and the term is 5
years?
r

a

File
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Edi t

Formula Form at
Loan Ty pe

Dat a

Options

Macr o

Win dow

.,

... Rea dy

Figure 9-35
•

Pina l versio n of Student Loan worksh eet

Save this wo rksheet with the I mo unts in step 5 fo r use with Pro jects
3 and 4.

Calculating Car Loans
You are read y to eva lua te a car loa n, so save a copy of this wo rksheet.
•

Enter Car Loa n in ce ll Bl. Ch oose Save As fro m the File menu . Save
a copy o f th is worksheet o nto your disk and na me it Car Loan.
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What if ...
6. Th e car you want to purchase costs $17,995.3 7 and the interest
rate is 12% fo r 5 yea rs? You will put down a down paym ent o f
$2,000. What is the amo unt o f the mo nthly payme nt? How
much to tal interest would you have to repay?
7. What if the inte rest rem ains at 12% and the term decreases to 4
yea rs? How would that affect the month ly paym ent and to tal
inte rest?
8. W hat if th e dealer o ffered either an interest rate o f 3 .9% or
$ 1,000 back? The term o f the loan is 5 yea rs. If you take the lower
in te rest rate your down paym ent remains at $2,000. If you ta ke
the cash bac k, yo ur interest rate is 12%, and you add the extra
$1,000 to your down payment, fo r a total of $3,000. Which is
the best dea l? Wh y?
9 . Wh at if the interest was 10%, the down pay ment was $2,000,
a nd th e term of th e loa n was 6 years? How would that affect the
loan ?
10. What if you decide to buy a different ca r, which costs $9,996.77,
a nd you can fin an ce it fo r $1,500 down at 8.9% for 5 years?
What would your mo nthly payments and total interest be?

r

4i File Edit Formula Format Dote Options Macro Window

Figure 9 -36

:3€ -S

Fin al version of Car Loan worksh eet

,.,. Save this worksheet with the a mo unts in step 10 for use with
Pro jects 3 and 4.
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Calculating House Loans
You are ready to eva luate a house loan, so save a copy of this worksheet.
•

Label this loan as a House Loan (in cell B1). Choose Save As from the
File menu. Save a copy of this worksheet onto your disk and name
it House Loan.

What if ...
11. The ho use costs $45, 000 with 15% down, and it can be financed
for 30 yea rs at 11.875%? What would be the monthly paym ent,
total amount repaid, and total interest? (Hint: Don't calculate
the down payment and then enter an amount. Enter a formula
multiplying the total amount by .1 5. After all, this is a spreadsheet
program!)
12. What if you put down 25% and financed it for 10.9%? How
would that affect the monthly payment and total interest?
13. What if you had the same terms as in # 1, but you financed it for
o nly 20 years? How would that affect the loan?
14. What if the inte rest rose to 14o/oand the term stayed at20years?
How would that affect the loan?
15. Evaluate the loan for a house costing $51,500 that you can buy
with 20% d own. You can get fixed-rate financing at 10.5%.
What are the monthly payments and total interest repaid for
this loan if the term is 10, 15, 20, 30, or 40 years.
,..

•
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Figure 9-37
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Options
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Data

Macro
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Window
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Format
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.HQ

. . . .360 .months
i

· ·~376.67

. . ..

.. ... .

$ 135 .674.13
$94.474. 13

Final versio n o f House Loan worksheet

Cha nge t he term of the loan dack to 30 years and save the worksheet
with th e amounts in step 15 for use with Projects 3 and 4.
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This completes Project 1.
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,,. Close the active worksh eet now.
You have saved the original Loan Analysis, as well as three additional
worksheets: Student Loan, Car Loan, and House Loan.
The Loan Analysis worksheet will be used in Project 2, where you will
learn to use some of Excel's charting features .
The other three worksheets will be used in Project 3, where you will
create a monthly budget, and in Project 4, where you will expand that
monthly budget into an annual budget.

Project 2: Creating Charts
In this project you will learn to create charts, modify their formats, and
print them. You will use the Loan Analysis worksheet from Project 1 to
create a column chart that compares the amount borrowed to the total
amount of interest for a loan. You will add a title and a legend to the
chart, modify the patterns used in the chart, change the format, and
print the chart . Then you will modify the worksheet, produce a pie
chart, and print it.
Many people have difficulty comparing numbers that are printed in a
list, but when those numbers are presented in a chart, they are often
easier to grasp.
To begin this project, you should have completed Project 1 first, since
you will be using the Loan Analysis worksheet that you developed there
as the basis for starting this project.
•

If you have quit Excel since completing Project 1, insert your data

disk into the drive, find the Loan Analysis document, and doubleclick on its icon.
,,. If you have not quit Excel since completing Pro ject 1, close all open

worksheets, and open the Loan Analysis worksheet that you created
in Project 1.
The final output of Project 2 is shown in Figure 9-38.
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Amount Financed versus Total Interest
$2,500 .00
$2,500.00

$2,000.00

$1 ,500.00

rnl Amount Financed
f.?fl Total Interest

$ 1,000.00

$500.00

$0.00

Figure 9-38

Final output of Project 2
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TYPES OF CHARTS
Excel offe rs a w ide va ri ety of ch a rt types, seve ral of which a re discussed
nex t.
A column chart (see Figure 9-39) o ffers com parisons betwee n two o r mo re
grou ps of da ta, known as data series. (For example, you can chart incom e
am o unts fo r severa l m onths a nd also expe nse amo unts fo r th e sam e
m o nths. This would be two da ta series. Each m o nth wo uld con ta in two
columns, o ne fo r each d ata series.) Excel has eight column cha rt
va riatio ns available.

t

OK

1J

Concel

1

NeHI .••

( Preuious... 1

Figure 9-39

Excel's column chart optio ns

A line clwrt (see Figu re 9-40) is used to show ch a nges that occur over a
period of time. They are also useful for spotting tre nds, because they
e m p h asize th e ra te of cha nge over time. Excel offers eigh t types of line
charts. Li ne c ha rts can a lso show m ore tha n o n e data series.

line

H

OK

lJ

Cancel
NeHI...

( Preulous... 1

Figure 9-40

Excel's li ne ch art options

A piechart (see Figure 9-41) sh ows a wh o le composed of a grou p of item s.
All ite m s shown in a pie c ha rt must be a part o f one sing le wh o le. This

means that only one data series 111ay be shown using a pie chart.
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((

OK

JJ

Cancel
NeHI. •.

( Preulous ... )

Figure 9-41

Excel's pie chart options

Excel also provides area, bar, scatter, and combination charts. When you
chart your data, yo u can easily change the type of chart, or one of the
styles for a chart, by choosing the one you want fro m the Gallery menu.
In fact, you might decide to display th e same data using d ifferent charts
to emphasize different aspects of the data in each cha rt.

PARTS OF A CHART
The various parts of a chart are sh own in figure 9-42 and described
below.
Yulue axis
(Y axis)

C hart tillc
J

""" Amount Financed versus T otal interest
"""
$2, 500 00

$ 2,500.00

Chart legend

$2,000.00

~ 1 ,500

00

I
Data series

D Amount f inanced

Data series
markers
~0

--Category axis
(X axis)

00

Figure 9-42

Major parts o f a chart

Chart title

Th e text used for t h e ti tle of the chart. There may
also be subtitles present.

Categoty axis

The ho rizontal axis (o r X ax is) commonly used to
show th e data classifications, or categories. A pie
chart h as n • category ax is.
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Data series markers This is the indicator used o n a ch art to represent
each gro u p of data items. A column chart o r bar
chart uses rectangles for markers, and a line chart
uses small symbols such as circles, rectangles,
triangles, and so on.
Cha1t legend

The symbols and tex t used to identify the different
g roups o f data items shown in the chart.

Tick marks

The short lines that intersect the axes and are used
to represent d ivisio ns on th e category axis and the
scale o n th e va lue axis.

Value axis

The vertical axis (or Y ax is) that is used to p lot the
qua ntity o r unit o f measure fo r the data items. A
pie chart h as no va lue axis.

CREATING A COLUMN CHART
Excel makes it easy to create a column chart from the worksheet. Some
electronic spreadsh eets make you specify many values before you ca n
see a chart. W ith Excel, you just select a group of cells, and Excel opens
a new ch art that automatically contains the data you selected o n th e
works heet.

Selecting the Cells
To produce thi s chart, you will need to select the cells contai ning th e
amount finan ced a nd the total interest.
It wo uld seem natura l to select just those two cells, but if you chart just
those cells, you will find it h arder to add a legen d to in dicate what the
cells represent. For that reason, yo u sho uld also select th e ti ties to the left
of the cells, as shown in Figu re 9-43.
•

Select cells AS and BS by pressing the mouse button o n AS and
dragging over to BS; then release the butto n .

Selecting a range of cells using this method wo rks just fi ne if all the cells
are contiguo us (n ext to each o ther with out any gaps between them).
Som etimes, as in this case, you need to select g ro ups that are not
contiguous. If yo u were to press and drag from A14 to B14 now, you
would select the new ra nge, but the process would deselect the first
two cells.
Excel gives you an easy way to ma ke no ncontiguous multi pie selectio ns.
If you select o ne o r more cells, and then ho ld down the Command key,
Excel will a llow you to add add itio na l cells o r ranges to th e current
selectio n. That is what yo u will do now to se lect the cells in row 14.
-

Hold down the Comma nd key, and select cell s A14:B14.
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Now that you have selected the c lis you want to cha rt (see figure 9-43),
you n eed to te ll Excel to open a 1ew ch art.
' a

File
A 14

Edit

I

10

Formu111 Form11t 011 t11 Op,tlons
T oto I Inter est
Loon Anolysls

I

A

B

C

.~

M11cro

Window

01
D

E

I

B

Figure 9-43 Ma king a multiple-cell selectio n using the Command key

Creating a New Chart
When you create a n ew fi le, Excel gives you a ch oice of opening o ne of
three types of files: Worksheet, Chart, o r Macro Sheet (see Figure 9-44) .

New
o worksheet
@Ch11rt
Q M ocro Shee t

Figure 9-44

((

OK

( Concel

n
I

New fil e dialog box

You have alread y completed a wo rksheet, and in this project you will
create a chart. A chart is used to display th e informatio n conta ined in
a wo rksheet in the form of a grap h ic.
A macro sh eet is used to contain a series of Excel commands that are used
to automate specific tasks. Macros are useful if you perform a task o r
series of tasks on a regula r basis. However, macros are beyond the scope
of this book.
3€ - N

•

Choose New fro m th e File menu. Si nce yo u want to create a new
ch art, select Chart and click OK.

(You could optio na lly choose to double-cl ick C hart as a shortcut.)
In a few seconds, a new windo appears o n the screen showing your
data in a column chart (see Figu e 9-45).
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.. Ready

Figu re 9-45

Creating a new column ch art

The left colum n represents the amou n t of the loan, an d the right
column represents the total interest.
Excel offers a n easy way of labelin g this cha rt so that each column's
meaning would be readily appa rent to anyone. This label is known as a
legend.

Adding a Legend
Whe never you create a chart sh owing more than one series of data, it is
a good idea to add a legend. A legend is a n area o n the chart that shows
th e pattern of each column and tells what that column represents.
Sin ce you previously chose a title to the left of each value in the
wo rks h eet before you created the chart, adding a legend is o nly a matter
of issuing the command.
•

Choose Add Legend from the C hart menu. Click the Zoom box to
en large the chart.

Excel adds a box to the right of the chart, showin g a rectangle labeled
"Amount Financed" and another rectangle labeled "Total Interest."
It is difficult to tell exactly wh at amo unt each of the colum ns represents,
but you can tell Excel to show the amoun t represented at the top of each
colu mn. To do this, you will select a different style of column chart from
the Ga llery menu.
•

Select Column from th e Gallery menu.

This will produce a d ialog box showing eight different types of col umn
charts. The one you want is shown in box number 7.
•

Click o n col umn chart sty le number 7, and then click OK

Excel quickly redraws th e cha rt, and now each column has the value
from the worksheet shown at the top of the column (see Figure 9-46).
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Gall ery

Chart

Fo mat

D

Macro

Window
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hart!
$2,500.00
$2,500.00

$2,000.00

$1,500.00

• Amount Financed

D Total Interest

$1,000.00
$577.48
$500.00
$0.00

... Reedy

Figure 9-46

Changing to column cha rt style 7

That's how easy it is to create a chart in Excel. Now that you have a good
start on this chart, it is a good t ime to save it.
The first new c hart you create in a session is named "Chartl " by de fault.
When you choose Save from the File menu, or type Comma nd-S, Excel
recognizes this as a default name and pu ts up the Save As dialog box so
you ca n name the chart and specify where it is to be saved.
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•

Save t he chart to yo ur da ta disk, and name it Loan Col umn C hart.

Adding a Title
Th e chart now shows two amoun ts, both graph ically and nume rically,
a nd indicates in t h e legend what they re present . Most charts also
contain some t ype of title that indicates what the whole chart represents.
Adding a title to your c ha rt consis ts of tell ing Excel to place text in the
title ele me nt, typing that text, and defin ing the font, size, and style
you desi re.
•

Choose Attach Text from the C hart menu .

Figure 9-47 shows t hat yo u ca n attach tex t to several elemen ts of a chart,
including the title, va lue axis, catbgory axis, and series and data points.

Attach TeHt To
®Chart Title
0 Ual ue AHi S
0 Ca t e gory AHis
0 Series and Data Point

Smi<!~ Number:
l'oint

Numbm~

Figure 9-47

n

OK

J)

( Cancel J

D
D

Attach Text d ialog box
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.. Select Chart Title if it is not selected, and th en click OK. (You can
double-click Ch a rt Title if yo u prefer.)
Excel will create a text block, attach it to the chart (surrounded by eight
selection squares), and put the word "Title" in th e formula bar as shown
in Figure 9-48.
r

File

•

Edit

Ti t le

Gallery

Chart

Format

Macro

Window

.,

Title
Loan Column Chart

DOD
DOD

CfitliD

$2,500.00
$2,500.00
$2,000.00
$1,500.00

• Amount Financed
DTotal lnterest

$1,000.00
$577.48
$500.00
$0.00

.. Ready

Figure 9-48

Attaching text to the chart ti t le

Using Selection Squares
Text objects (such as titles) are surro unded by eight selection squares
wh en they are selected. These selection squares may be black o r wh ite,
depe nding upon what type o f o bj ect is curre ntly selected.
Text surrounded by black squares may be resized and moved, but text
with white selectio n squares is sized and placed by Excel, and you ca n
not change this placement. The title wi ll be surrounded by white
squares, which indicates that Excel will automaticall y size and p lace th e
text, based o n its length, size, style, and font.
You can move o r size a text e lem ent that is surrounded by black selection
squares by clicking on o ne o f the squares and dragging it.

Chart Formatting Options
Many form atting options are provided for changing the appea rance of
a chart in Excel.
This proj ect suggests that you change the fo rmat of three eleme nts: the
text in the title, the patterns in the columns, and the placem ent of the
legend . By making these changes, you wi ll lea rn how to modify the cha rt
to suit your preferences. The method s you use here wi ll apply to any
Excel chart you create o r modify in the future .
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Formatting Text

The first formatting you will do is to change the font, size, and style of
the title.
•

While the title is selected, type Amount Financed versus Total
Interest, and then press Return.

You will see the title change in the formula bar as you type. Unlike text
in cells, text elements in Excel, such as the title, can be only one font,
size, and style.
Notice that the title is still surrounded by selection squares. To deselect
the title, you can click anywhere in the chart window outside the chart
area. This is a little difficult to do, because clicking anywhere on the
chart will select the entire chart. The easiest way to deselect an element
is to click between the top of the chart window and the top selection
squares for the title.
.. Click in the chart window to deselect the title.
Now that you have entered the title, you might notice that the default
size and style are a little too small for the title. You can make the title
larger and more distinctive by modifying it.
.. Select the title by clicking on it, and then choose Font from the Format
menu. Choose Times font, 18-point, and italic (see Figure 9-49). If
these choices are not available on your computer, make a comparable
choice from what is available.
r
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Changing the font, size, and style for the title text

Changing Patterns

There is nothing wrong with the lack and white columns on this chart
(if you h ave a color monitor the~ may be green and red), but there may
be times in the future when you ant to select a different pattern for one
or more columns.
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Selecting a d ifferent pattern is a matter of double-clicking o n the
column yo u want to cha nge a nd then selecting wh ich pattern yo u want
it to have. For this pro ject, you wi ll change t he Amo unt Financed
column to medium g ray a nd th e Tot al Interest column to a lig ht
diago nal stripe.
,. Click on the Amo unt Financed column to se lect it. C hoose Patterns
from the Format menu. Select the m edium gray pattern (secon d
from the left) inside th e Area rectangle (see Figure 9-50).
•
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Cha nging the column pattern

(As a shortcut, yo u could h ave double-clicked on the Amo unt Finan ced
column t o change th e pattern assig ned to it. You ca n use this shortcut
to format a ny element in the chart window. Double-cli cking on an
elem ent a utomatically selects it and brings up the Patte rns d ialog box.)
•

C ha nge th e Tota l Interest column to th e medium d iagon al striped
pa ttern (third fro m the right) by double-cl icking on th e To tal
Interest column and then clicking o n the app ro priate patte rn.

An y item in a chart that has a pattern can be ch anged using this method .

Moving the Legend
W h en yo u tell Excel to add a legend, the default place me n t is o n the
right side of th e chart.
Sometim es the legend wou ld look better if it were moved to a noth er
loca tion. If you click o n th e legend, you will see tha t it is surrounded by
w h ite selection sq uares, wh ich indicate th at you canno t just drag it to
a no th er locatio n.
If yo u wa n t to m ove the legend, you can select it and th en choose
Legend fro m the Forma t menu. The legend can occu py o n e o f fou r
lo ca tio ns: Bottom, Corner, Top, o r Vertical.
•

Select the legend, and use the Legend comm and in th e Format men u
to m ove it to the botto m o f the cha rt.
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When the legend was on the rig~t side, the title seemed to be off cente r.
However, w hen you m oved the legend t o the bottom, the column s got
wider, and now they look too wide for their h eight. Excel lets you m ove
the legend to any o f these four locations so you can see how the chart
will appear and c hoose th e one you like best.
,,. Try m oving the legend to the other locations, and then put it back
where it started by selecting Vertical.

at: -S ,,..

Now is a good time to save your wo rk.

After yo u've made these formatting changes, your chart sh ould look like
the one shown in Figure 9-51.
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Figure 9-51

Column chart after formatting changes

Updating the Chart
You h ave created a ch a rt that will graph whatever va lues are contained
in the Loan Ana lysis worksheet.
You can resize and move both the wo rksh eet and ch art so they are both
visible. If you modify any of the values in the worksheet, the chart will
be redrawn to reflect that ch an ge.
Depending u pon the size of you r monitor, you can choose to either slide
the window to th e right or resizEt it. The purpose is to be able to see the
chart and column B of the Loan Anal ysis worksheet at the same time. If
you have a large monitor, yo u cqn place both windows where they are
visible, and size them t o suit youuself.
Be advised, however, that how t t chart is printed is d irectly related to
how you d imension the ch art w·ndow.
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•

Move the Loan Column Chart window to the right un til the legen d
disappears from the right side of the screen (if you have a regular-size
Mac screen).

•

Use the size box of the Loan Analysis worksheet to resize its win dow.
Move the windows around un til they a re both visibl e (see
Figure 9-52).

.,

,.. .S File Edit Formula Format Data Options Macro Wind ow
loan Column Chart

Amount Financed versus Total
Interest
$2,500.00
$2,500.00
$2,000.00
$1,500.00
$1,000.00
$500.00
$0.00

m
Figure 9-52

Resizing the windows to display both the chart and t he
worksheet

Figure 9-52 shows the chart you should see if you saved th is worksheet
and used Save As to create a duplicate worksheet before entering the
student loan figures in the what if ... scenarios in Project 1.

WARNING

Do not save the changes you make to the worksheet in the next three
action steps .
Refer back to the wh at if... steps numbered 5, 10, and 15 in Project 1.
•

Enter the final values in step 5 into the worksheet and watch the
chart chan ge to reflect the new values.

..

Enter th e final values in step 10 into the worksheet and notice how
the chart changes (see Pigure 9-53).
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The ca r loa n amoun ts fro m step 10 in Project 1

Enter the final values in step 15 into the works heet and watch the
chart change again.

Notice that this chart (Figure 9-54), unlike the o ther two, shows that the
tota l interest is larger than the a m o unt fin anced. Wh y is th is?
,..

..,

"
Amount Finan ced versus Total.
Interest
$94,47 4 .13
$ 100,000. 00
$90,000.00
$80,000.00
$70,000.00
$6 0,000.00
$50,000.00
$40,000.00
$30,000.00
$20,000.00
$ 10,00 0.0 0
$0.00

$41 ,200.00

When a loan is amo rtized, the loa n is ca lcula ted so that the sum of the
payments over a period of t ime will exactly equal the sum of t he in terest
and the amount financed. As t he length of the loa n increases, the
payments decrease, but the to tal interest increases beca use you a re
paying less toward reducing the debt wit h each payment.
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A ho use Joa n finan ced for 25 years will have a higher m o nthly payment,
but the to tal inte rest will be less than a Joan financed for 30 years. In fact,
for the h ouse loan you just calculated, if you increase the term of the
loan to 107 yea rs o r more, the monthly payment will not d ecrease any
further. Adding more years to the term of the loan will o nl y increase
total inte rest.
•

Close the Loan Column Chart (without saving the ch anges).

You might find it an interesting exercise to vary nothing but the term
of the loa n and watch the interaction between total interest and the
monthly pay ment.

CREATING A PIE CHART
The amount financed plus the total interest adds up to the to tal amo un t
of a ll the payments. This means that the two compo nents make up a
whole. There is a better chart than the column chart for com paring more
than one item that adds up to a whole. The type of chart that is most
useful for this type of comparison is the pie chart.
In the next several steps of this project, you will make som e of the most
common mistakes that new spreadsheet users encounter. Then you will
lea rn how to se t up your worksheet properly to keep from making these
kinds of mistakes.
Sometimes saving your work frequently is not e nough of a safeguard

WARNING aga in st losing you r work. Since you h ave been advised that yo u will be
making a few mistakes along the way, you probably don't want to risk
losing the wo rk you put into the Loan Analysis worksheet. A good
m ethod to use when there is potential for damaging a worksheet is to
make a backup copy of the current (correct) version, and then wo rk from
that copy.
-

Choose Save As from the File m enu. Nam e the worksh eet Loan
Ana lysis 2.

You will now modify the Loan Analysis 2 worksheet so you ca n generate
a pie chart to compare the amount financed and total inte rest amounts.
You will be working with the ho use loan figures in step numbe r 15 of
the what if ... scena rio of Project 1.

Modifying the Worksheet
You will start this chart the sa me way you started the column ch art.
•

Select th e fou r cells (A8:B8 and Al4:Bl4) the sam e way you did
before.

•

Create a new chart.

•

Add a legend and move it to the bottom.

•

Select pie chart style 6.

Chapter 9: Excel

417

What happe n ed to th e total int rest amount (see Figure 9-55)'? Why is
there only one patterned recta n gle and a numbe r 1 in the legend?

I
r

-'

File

Edit

Gallery

Chart

§0

Format

Macro

Window

.,

Chart I
Amount Financed

100.00%

._Reedy

Figure 9-55 C rea ting a pie chart that doesn't do exactly w h at you wa nt

T h e answer to these questions lies in the d iffe rences between column
ch arts and pie charts. Column c h a rts allow th e comparison of multiple
values that do no t necessarily comprise a whole amount. Pie c h arts, o n
the o the r h and, on ly a ll ow the compa rison of multiple values that do
com prise a w h ole. (If you present information to other people using
c h ar ts, you would be well advised t o find a good book on ch a rting
tec hniques and study it to lea rn the differences between c h a rt types and
their adva n tages a nd disadvantages for the types of data you presen t.)
When you selected a noncontiguous group of cells, Excel assumed thi s
to represent m ore than o n e data series. To create the p ie c h art for thi s
pro ject, you h ave to rear ran ge the worksh eet so that the two amo unts
a re n ex t to each o ther (contiguous).

Adding New Formulas
You n eed to m ake a copy of the four cells and paste them on two
ad jace nt rows. Since you are becoming an experien ced Macintosh user,
you probably h ave already started hatching a pla n to accomplish this.
Maybe it goes som e thing like this:" All I have to d o is copy the first two
cells and paste them below the ast row o f the worksheet. Then 1 can
copy the oth er two cells a n d pa te them right below t h a t."
Maybe you are even more creati~e and have decided that you o nl y h ave
to copy the a m o unt fina nced cells and paste them directly below the
total inte rest amount.
This sounds like a good p lan, but it will not work.
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3€ -W

,,. Click in the close box to close the new pie chart without saving
it. (You can also choose Close from the File menu, or type
Command-W.)

3€ -C

,.,. Select cells A8:B8 and copy them. (You can use the Copy command
from the Edit menu, or type Command-C.)

3€ -V

.. Select cell Al6, and paste the two cells into A16:B16. (Use either the
Paste command from the Edit menu or type Command-V.)
How did the Amount Financed on row 16 become $376.87? The answer
to this lies in how Excel helps you in creating large and/or com plicated
worksheets.
If you examine the formul a in cell B8 and compare it with the formula

in B16, you will find that they are similar, but Excel has made some
changes for you.
Cell B16 has the formula =B11-Bl2, but cell B8 has the formula =B3-B4.
In both cases, using relative addressing, they tell Excel to subtract the
value of the cell four rows above the cell containing the formula from
the value of the cell five rows higher.
Look at the value displayed in cell B16. If you move up five rows you will
find the value $376.87. The cell four rows above B16 is empty. When
Excel tries to subtract the empty cell from the cell with $376.87, it
produces the result $376.87, just as if the value of the empty cell were
a zero.
To correct this problem, you will modify two of t he formulas using
absolute addressing. There are at least two ways to accomplish your
objective. You could easily type the new formulas into cells B16 and B17,
using the exact formulas in B8 and B14. This is a valid way to solve this
problem, but it would not help you learn about using absolute addressing
in creating formulas. Therefore, let's modify the formulas in B8 and B14,
and then copy and paste them into rows 16 an d 17.

Modifying the Formulas
Before you make the modifications to the two formulas, why don't you
erase what you already copied into row 16? There are several ways to
do this.
Since you haven't done anything since pasting the values into row 16,
the easiest way to remove them is to choose Undo from the Edit men u,
or type Command-Z. This will always undo the last thing you did.
If you want to clear some cells and it was not the last thing you did, you
can click on a cell, press the Backspace or Delete key, accept the new
empty value, and do the same to any other cells you want to clear.
Whenever you are erasing one or only a few cells, this is often the fastest
and most convenient method.
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Excel p rovides a third m ethod that is mo re useful if you want to e rase
a larger group of cells. It also provides a selective way to delete o nly the
fo rmula or fo rmat of th e cell, a no te a ttached to the cell, o r all of t h ese
attribu tes. This is performed using the Clear command from th e Edit
menu. Let's t ry this method here.

00 -B

•

Select cells A16:B16.

•

Choose Clear fro m the Edit men u.

•

Select All, and accept it by clicking OK.

Now that you h ave erased the incorrect info rmatio n, modifying the
fo rmula in cell B8 to produce correct results is a straightfo rward process.
•

Click in cell B8. Change the formula to =$B$3-$B$4 byeitherretyping
the wh o le formula o r inserting the do llar signs in the fo rmula bar.

The do llar sig ns are the means by which you inform Excel that you want
to refer to exactly cells B3 and B4 (absolute addressing), n ot the cell five
rows high er a nd th e cell belo w that (relat ive addressing).
Fo ur ways to use absolute a nd re lati ve add ressing are sh own in Table 9-6.
B4
$ B4
B$4
$B$4

Table 9-6

Rela ti ve co lu mn and re lative row (th e default)
Absolute column and relative row
Re la tive co lumn a nd absolute row
Absolute column and absolute row
Four possibilities for absol ute and relative ad d ressing

Depending upo n the circumsta nces, you mig ht use any of these fo ur
methods of addressing. Th e most co mmo n methods, by far, a re the first
and last o n es shown in the table. The two midd le forms are for special
circumstan ces, and you sho uld be ca reful in their use.
00 -C 00- V

•

Now t hat the fo rmula h as been adjusted using absolute add ressing,
copy cells A8:B8 a nd paste into cell Al 6.

00 -C 00- V

•

Modify the formula in cell B14 so th at it also uses absolute addressing,
copy A14 :Bl4, and paste into A17.

:3€ -S

•

Save yo ur wo rksh eet again.

Yo u have adjusted the fo rmulas so that t h ey will produ ce the correct
values w he n th ey are copied an d p asted, and they h ave been moved so
that they are contiguo us. It is t ime to once again try to create a pie chart.
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Creating a New Chart
~

-N

•

Select ce ll s A16:Bl7.

•

Choose New fro m the rile m enu, and create a ne w chart.

•

Select pie cha rt style 6.

..

Add a legend, and move it to the bo tto m .

Th is will produce the chart sh ow n in Figure 9-56.

r

.S File Edit Gallery Chart Format Macro Window

§0

.,

Chart2

69.63%

• Amount financed

0 Total 1nterest

.. Ready

Figure 9-56

•

Pie cha rt compa ring Am o unt Fin anced and Tota l In terest

Ch oose Save As fro m the File m enu, nam e the ch art, and save it onto
yo ur da ta disk.

Printing the Chart
Now add a ti t le of you r cho ice, change a n y patterns you wish, save the
chart, a nd prin t it. Reme mber that the d imensio ns o f printed ve rsio ns
are a result o f how the c h art appears o n your d isplay.

If you d ecid e to come back late r an d reca lculate a loan and wa nt to see
th is pie cha rt, you wi ll have to use the worksheet you saved as Loan
An alysis 2, because it is the o ne lin ked to the p ie chart yo u just created .
If you are going to do the wh at if... exercise be low, do not close the Loan
Analysis 2 wo rksheet or th e pie chart.
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WHAT IF ... EXERCISES
To com plete this exercise, ch ange the amount in the Term of Loan cell
in the Loa n Analysis 2 wo rksheet, and the chart wil l be redrawn. Click
on the chart to make it active, and print it. Click on the worksheet to
make it acti ve again and make the next change. You do not need to
create a new chart each time.
1. Using the loan conditio n s in step 15 of the ho use loa n in Pro ject 1,
modify the worksheet to p roduce the charts necessary to compare
the di fferent loa n optio ns. (The cost is $5 1,500, with 20lJt(, down, at
10 .5% per year.) Print a cha rt for t he loan a t 15, 20, and 40 years.
Compare the ch anges in mo nth ly payments and the amo unt of
inte rest you will pay to the lender. Compare the percentage
composition of the loan by compari ng th e pi c charts showi ng
amount fin anced and total interest.

This completes Pro ject 2.

Project 3: Creating Linked Worksheets
In this pro ject you will create a n ew worksh eet represe nting a m onthly
budget. It w ill be composed of th ree m ain sect ions: incom e, expenses,
and surplus/d efic it. You will learn to for mat date va lues a nd cha nge the
fon t, size, and style of values displayed in a cell.
You also w ill learn to link va lues from one wo rksheet to anot he r. This
is a very powerful and usefu l feature o f Excel.
As an example, in this project you will link the mo n th ly payment values
calculated in the student, car, and ho use loans fro m Pro ject 1. If you
were to lookat a different loan package, it would automatically reca lculate
the loan, a nd if this budge t worksheet were also o pen it wou ld be
updated as well. That way you could see the impact on the rest of your
budget caused by that particul ar Joan package.
You will a lso create two charts in th is pro ject. A pie chart w ill show t he
breakdown of all yo ur expen ses, and a column ch art w ill sh ow the
comparison s of to tal income, total expen ses, and a ny surplus o r d efi cit.
Figures 9-5 7, 9-58, and 9-59 show the fina l o utput o f Project 3.
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Miguel Garcia

Monthly Budget
Budget
Jan 1994
Income
Income #1
I nco me #2
Total I ncorne

$1 , 400.00
$735.00
$2, 135.00

Ex penses
House
Car
Education
Food
Clothes
Insurance
Utilities
Entertainment
Total Ex penses

$376.87
$ 175.97
$103.79
$250.00
$75 .00
$150 .00
$185 .00
$200 .00
$1 ,516 .63

Surplus/Deficit

$6 18.37

Figure 9-57

Final output of Project 3 worksheet
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Miguel Garcia

l"lonthl y Budget Expenses Chart

Comparison of Expenses
•

House

D Car

12.20%

!illl

Education

llll!l

Food

[ill Clothes
11 .60%

9.89%

8

Insura nce

mUtil ities
16.48%

Figur e 9-58

~Entertainment

Fina l o utput o f Pr ject 3 p ie c ha rt
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Miguel Garcia

I ncome vs. Expenses

I ncome vs. Expenses
$2,500.00
$2, 13 5.00
$2,000 .00
$ 1,516.63
$1,500.00
$1,000.00
$6 18.37

•

Total Inco me

D

Total Ex penses

IN! Surplus or Deficit

$500.00
$0.00

Figure 9-59

Final o utput o f Pro ject 3 colum n chart
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To begin this project, yo u must ave com pleted Project 1 first. You will
be using th e three worksheets that yo u developed in the wh at if...
exercises in that pro ject as imp rtant components of th is pro ject.

~

-N

•

If you have quit Excel, restart it by double-clicking on its icon.

•

If you have n ot quit Excel, close all open files.

,.. C reate a n ew worksheet by choosin g New from t he File menu.

ENTERING TEXT AND NUMBERS
,..

Enter the text sh own in Table 9-7 in the indicated cells.

Cell address

Al
A3
A6

AS
A17
A19

Table 9-7

Text to be entered
Budget
Incom e
Total Inco me
Expenses
Total Expenses
Surplus/Deficit

Text to be entered into n ew worksheet in colu mn A

These cells are used to represent titles and to tal lines.
•

Continue adding the text shown in Table 9-8 into column B.

Cell address

B4
BS

139

B10
Bll
1312

Bl3
B14
B15
B16
Table 9-8

,.

Text to be entered
Income #1
Income #2
House
Car
Education
rood
Cloth es
Insu rance
Utilities
Entertainment

Text to be entered in column B

Resize column A so that your worksheet looks like the o ne shown in
Figure 9-60.
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Figure 9-60

I
Resizing column A to simulate indented category titles

By resizing column A so that it is only abou t two ch aracters wide, you
make the categori.es look like they are in dented between the group titles
and the to tal lines. In a word processor you would h ave done this by
pressing the Tab key. Since Excel does not let you tab in a cell and typing
two or three leading spaces results in uneven alignm ent, this is the
easiest way to make your category titles and names appear to be
indented and align ed.
•

Nam e this worksheet Monthly Budget, and save it o nto your
data disk.

FORMATTING DATES
A monthly budget should be labeled with the mon th and year it
represents. Excel allows you to enter dates using more than one method.
Excel allows you to use th e DATE() function, but it also allows you to
type th e date directly, such as in 1/1 /94.
If you use t he second method (1/1/94), Excel will assign t he date format
m/d/yy to the cell. In this worksheet it is necessary to show only the
month and year, so let's tell Excel to use a different format.
,.. Enter 1/1/94 in cell CZ. Ch oose Number from the fo rmat menu,
and scro ll down to the date formats.
Excel offers fo ur stan dard formats for dates. These formats, and how
they would show 1/1/94, are listed in Table 9-9.
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Date format
m /d/yy
d-mmm-yy
d-mmm
mmm-yy

Table 9-9

Displaved as
1/ 1/ 94
1-Jan-9 4
1-j an
j a n-94

Exce l's fo u r standard date fo rm ats

Wh en you d es ign a date format, you can specify how Excel will display
the month, da y, and year, how many characte rs fo r each , the order in
which th ey will be displayed, and what punctuatio n you wa n t, if any.
The codes fo r creating these fo rmats are shown in Table 9-10.
Displa~ed

Date format
d
dd
ddd
dddd

Meani n g
d ay as number
numbe r with leading zero
da y as abbreviation
da y as full name

1-31
01-31
Mo n
Mo nday

m
mm
mmm
mmmm

m o nth as number
number with leading zero
abbreviated name
full name

1-12
01 -12
j an
j anua ry

yy
yyyy

last two digits of year
year as four-digit number

00-99
1904-2040

Table 9-10

Cod es used to create new da te form ats in Excel

This wo rksh eet will show th e d ate using the abb reviated n ame of the
m o nth and the yea r as fo ur digits. It will no t show the day, because th e
amounts in each co lumn apply to th e who le m onth . Wh en you entered
the date, you specified the first d ay of th e m o nth, but you don 't n eed
to sh ow it h ere.
,,. To crea te the custom format, click in th e Forma t box, and type
mmm yyyy (see figure 9-61) .

.-F0_~-~:-E-a+t_0_~_um_b_e_r--------.~..,.., E

ff~~~::M

h:mm:ss AM / PM
h:mm

~

I (::~::~
ll
0

Format: Immm yyyy

Figure 9-61

OK

Ente ring a custom date format

I
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Th e ability to create custom formats m akes Excel very fl exible and
a ll ows you to m ake your spreadsheet look as yo u wan t itto look. You can
crea te custom fo rm ats for time and numbers as well. Excel even allows
you to have d ifferent form ats for positive, negative, and zero values . If
you are using a colo r monitor and printer, you can have positi ve
num be rs d isplayed in black and negative numbers in red. You can even
add tex t in a for mat by encl osi ng it in quotation marks.
Altho ug h th ese types of fo rmats are beyond the scope of this book, you
ca n learn al l about them by looking up "Form at Number" in the

Microsoft Excel Reference.

NAMING CELLS AND RANGES
In Pro ject 2 you lea rn ed abo ut absolute and relative cell add ressing and
how they were used in composing formul as. Excel offers another way to
c rea te fo rmulas: by naming cells or groups of cells and then using those
n am es in the form ulas inst ead of their add resses.
Table 9-11 contains a list of five cell ra nges. When yo u e nte red fo rmulas
into the worksheet in Pro ject 1, you entered the add ress of th e cell. In
this project, yo u wi ll lea rn to n ame a cell o r range of cells and then use
the name you defined in th e formula. This makes a formula more
understa ndable and easier to read.
Cell range
C4 :CS
C6
C9:C16
C17
C l9

Table 9-11

Nam e
Income
Totai_Income
Expen ses
Totai_Exp en ses
Surplus
Na ming cells and ranges of cells

Notice thatTotai_Inco me and Total_Expenses h ave underline characters
instead o f spaces separati ng the words (see Table 9-11 ). Excel does not
allow cell na mes to have an y spaces in them. You h ave the option of
jamming th e words together, but that reduces th e legibili ty o f the
n am es. The underline charact er (creat ed by typing Sh ift-h yph en)
separates th e words without using spaces.
Let's n ame th ese five ranges and enter the formula s referring to them in
th e wo rksheet.
•

Select cells C4:CS, and then choose Define Name from the Formu la
menu.

Notice th at Excel has entered th e range of cells in the "Refe rs to:" box
using absolute addressing (see Figure 9-62).
... Na me this range Income and cl ick OK.
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m

Define Nnm e

19

IIncome
Re f er s to:

lo
Figure 9-62

•

~

Nom e:

I · $C$'1:$C$5

I

l)

OK

l

( Cancel

( Del e t e )

I

Nam e cells C4:CS as Income.

Define the Expenses, Surplus, Total_lncome, and Totai_Expenses
names in the same manner.

As you d efine each of these nam ed ranges, you will see the previously
defined n ames in the scrolling list on t he left side of the Define Na me
dialog box.

ENTERING FORMULAS
Now that you h ave defined the names of these ranges, you can use them
to create formulas that are mo re understandable. For example, t he
formula =Total_lncom e - Tota l_Expenses is much more meaningful
than =C6-Cl7.
You can enter formulas using the Paste Nam e command in the Formula
menu, or you can type the fo rmu la instead. If you choose to type the
names yourself, you must be careful that you make n o mistakes wh en
typing. The n ame must be entered exactly the same as it was defined.
Using Paste Name instead of typing the n am es will prevent making an y
mistakes due to t ypograp hica l errors o r not remembering the exact
name you defined.
The Paste Name co mmand wo,rks similarl y to t he Paste Functio n
command you have a lready learned to u se. In fact, in creating many
formulas, both of these comm ands are used.
You will enter only three fo rmul as in this worksh eet. They w ill be used
to calculate the su m of the income amounts, the sum of all the expen ses,
and the surplu s or deficit (wh ich , yo u may rem ember, is ca lculated by
subtracting the total expen ses from the total income).
Try using the Paste Name met hod first to enter the formu la fo r
calculating the tota l of the income sources. If you were told to add all
the incomes, you would have n o tro uble doing that, because you wou ld
recognize that the in com e amo u 7 ts were in cells C4 and CS. You would
the n determ ine the sum of these ~ m ounts . You might u se a formula like
total income= C4+CS or to tal in9o me = SUM(C4:CS). That's all there is
to calculating the sum of the incomes . Let 's tell Excel to do this for you.
•

Sta rt t he first formula by clic ·ing on cell C6.

•

Type = and then use Paste Fun ction to enter the SUM() functio n into
the formula bar.
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You 've told Excel that you want it to ca lculate the sum o f something, so
n ow te ll it w hich something yo u want it to add.
•

C hoose Paste Name, select Income, a nd th en cl ick OK or press Enter
o r Re turn (see fi gure 9-63).

Surplus
Tot aLE H pens e s
TotaLincome

Figure 9-63

•

n

OK

,

(

Cancel

)

( p (j ~ h~

u~ t )

Pasting a named g roup o f cells into a formula

To en ter the other two form ulas, e nter the expressions shown in
Table 9-1 2 into the proper cells.

Cell
C17
C19
Table 9-12

Formula
=SUM(Expenses)
=Total_lncome - Tota l Ex Je nses
The two rem aining form ulas for this worksh eet

These are all the fo rmulas yo u need fo r this worksheet.
•

Format al l the cells that will contain numbers as currency, and then
enter the numbers s hown in Table 9-13 into the appropriate cells (in
column C) .

Categor~

Income # 1
Income #2
Food
Clo thes
Insurance
Utilities
Entertainment
Table 9-1 3

Cell
C4
C5
Cl2
Cl3
C14
Cl 5
C16

Number
1400
735
250
75
150
185
200

Amoun ts to be e ntered into column C

Notice that you did no t enter a num ber or formula into th e Ho use, Car,
a nd Educa ti o n categories. That is because you will now link the
calculated mo nthl y payments from the worksheets you c reated in
Project 1 into t he appropria te cells in this works heet.
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PASTING AND LINKING VALUES
Excel has the ability to link a va l e in o ne wo rksh eet to a cell in another
worksh eet. Once the lin k has been establ ished, any changes made in the
first worksheet would be reflected a utomatically in the second worksheet.
If bo th wo rksh eets are o pen, the change wou ld immediately take place.
If only o ne wo rks heet was open when the change was made, a nd the
changes were saved to disk, the second works heet wou ld be updated
whenever it was next opened .
W hen you open a wo rksheet th at depends o n values located in a
different worksheet, Excel wi ll ask if you want to update the references
to that unopened worksh eet (see Figure 9-64).

Update referen ces to
unopened documents?

([

Yes

,---N-o--..)

Figure 9-64 "Upd ate references to unopen ed documen ts?" dialog box
If you answer "Yes," Excel will read the needed values and w ill the n
recalculate the worksh eet that is open to reflect any changes mad e to the
other o n e. Sometim es, thoug h, you might wa n t to prin t t he last version
of the wo rksh eet and do not want to update the document to refl ect any
ch anges made since the last time it was saved. In that case, you can
answer "No" and Excel will open the wo rksheet just as yo u last saved it.
This ability to link worksh eets is especially va luable if you have to create
reports o n a periodic b asis th at depend o n values sto red in multiple
spread sheets. If you link the worksh eets, the summary o r report document
you mu st complete can be automat ica lly updated to reflect any ch an ges
you m ay have made in th e othe r worksheets du ring the period since yo u
las t prod uced the report.
It is commo n for many fami lies to have o ne o r more loan payme nts th at
must be paid each m o nth. Over a period of severa l yea rs the amounts of
t h ese loan s will ch an ge, and it wou ld be convenient if the current
amount of the loan (s) were automatically shown in the budget worksh eet.
In t his project, the budget sh ow a ho use paym ent, a car payme nt, and
1 m o nthl y payment amou nt of each o f
an educatio n loan payment. If thF
these loans could be linked to t~e budget wo rksheet, then you would
have a powerful tool for eva luating new purchase optio ns no t o nly by
the mo nthly pay ment, but also by h ow t hey would affect your budget.
Therefo re, let's li nk each of the t hree loan s this fam ily must repay
(remember, you calculated and saved them in t he what if ... exercises in
Pro ject 1) to this budget worksh ee t.
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Let's start w ith the Stude nt Loa n works h eet. To link this loa n payment
to the budget, yo u will copy the monthl y payment amount fro m th e
Student Loan works heet and the n paste it into the app ropriate cell in th e
Mon t hl y Budget wo rksh eet.
This means t hat you must h ave two worksheets open at the sa me tim e.
If you have a large mo ni to r, this is a simp le thing to do: just move th em
to w he re they are bo th visible. O n the smalle r, stan da rd Macin tosh
screen you don't have room to sh ow two large windows. Yo u h ave a
choi ce of letting th e windows overlap or o f resizing t he m and placing
them so you can see th e appropriate pa rts o fthe worksheets at th e same
time.
Remember, o nl y o ne window in an applica tio n is active at any t ime, so
o nly o n e w ill have lines in the title bar, visible scroll ba rs, and o th er
visible controls. If the window you n eed to use is not active, click
an yw here in that window, and Excel will make it the active window.
You can also t ell Excel which wi ndow you wa nt to ma ke acti ve by
choosing its na m e from the W indow menu. All o pen worksheets, ch arts,
a nd macro sheets wi ll be listed by name in the Window me nu. If you
wa nt to activate a window that can't be seen o n the screen, just c hoose
its na me in the W indow menu a nd it w ill be bro ught forward and made
the acti ve wi ndow.
..

,. 5

Open the Monthl y Budget worksheet and then the Student Loan
worksheet. Place them so you ca n see them at the sam e time (see
fi gure 9-65).
File

Edit

Figure 9-65

•

Formula

Format

Dat a

Options

Macro

Window

.,

Arrangin g the worksheets o n screen so both are visible
at o nce

If it is not already th e ac ti ve w indow, ac ti vate t he Stude nt Loan
worksheet wi ndow.
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•

Select cell Bll (th e monthly p,aym en t amount) to make it th e active
cell.

•

Copy the payment amount.

•

Click in the Monthly Budget window to activa te it (or choose it from
the Window menu).

•

Select the Education expense cell (Cll ).

•

Choose Paste Link from th e Edit menu .

I

Paste Link is a command that saves you a lot o f wo rk when li nking
wo rksh eets. All you h ave to do is point to the cell from whi ch you want
to link an d te ll Excel to cop y it. Then, by select ing t he cell to which the
first cell will be linked and ch oosing Paste Link, you tell Excel no t only
to re me mber t he o riginatio n cell's address, but also th e name of the
worksheet, the disk o n which it is loca ted, and the pathway thro ugh the
folders to find the wo rks heet.
Excel then pastes a ll this into the destination cell. l f both wo rksheets are
open and you make a change to the Student Loan worksheet, Excel w ill
update th e Stude nt Loan worksheet, a nd then it wi ll update the
Month ly Budge t.
Try this n ow, and watch as bo th worksheets ch ange .
•

Ch an ge th e Annual In terest Rate in the Studen t Loan wo rksheet
to 10%.

If you were not watching careful ly, you m ay have missed seei ng them
change. After you make this change, you r wo rksheets sh oul d contain
the va lues shown in fi gure 9-66.

r

-'

File

Edit

Formula
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Da ta

Options

Ma cro

Window

.,

: : : ; ~- : ! : : .

Fig ure 9-66 Changing the interest rate n ow modifies both wo rksheets.
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,. Try this agai n. Leave the interest rate at lO(Y<l, and change the Total
Amount to $7,500.
You can see that the mo nthly paymen t amount rose, and in the
Month ly Budget the total expen ses increased and th e surplus d ecreased
(as sh own in Figure 9-67).
,.

j

File

Edit

Figure 9-67

Formula

Format

Data

Options

Macro

Window

...

Changing Total Amo unt affects both worksheets

Now you are fini shed w ith the Studen t Loan worksheet.

00 -S

•

C lose the Student Loan worksheet. W hen Excel as ks if you want to
save the changes, answer No, so you ca n leave it with the same
amounts it had when you o pened it.

•

Save th e Mon thl y Budget worksheet.

After closing the Student Loan worksheet, loo k at the formula in the
Education expense cell of th e Monthly Budget. The formul a will have
changed to show the names of t he disk, folders, and worksheet and the
add ress of the cell(s) that a re linked to this cell. (Your fo rmula should
look similar to the o ne shown in Figure 9-68, but there ma y be some
differences due to the way your d isk is organized.)
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Figure 9-68

fo rmula showing link to cell Bll of the Student Loa n
works heet

In this case, the fo rmu la fo r cell Cll is =' Miguel Garcia Data:Student
Loan ' !$B$11. In additio n to showing the absolute address of the cell
th at contains the informatio n (a fter th e exclamation point in th e
formula), it a lso lists the disk and worksh eet names. The address of the
worksheet (which contains the disk name, an y folders t hat must be
opened, and the worksheet's name) is enclosed in single quotes. In this
case, it says "li nk this cell to the aro un t sh own in cell Bll in the Studen t
Loan worksheet stored o n a d isk named Miguel Garcia Data".
If Miguel had stored this worksheet in t he Final Pro jects folder on h is
disk, the fo rmul a would have read =' Miguel Garcia Data:Fina l
Projects:Student Loan' !$B$11. The procedure forsto ring the worksheet's
locatio n is to name the disk, then any folders that must be open ed (Final
Pro jects), then the wo rksheet. Each of these items must be separated by
a colon (:).The entire location m ust be en closed in single q uo tes, and
this must be followed by an exclamatio n point (!) before the cell or range
address is listed. f o rtunately, Excel does all of this automat ically w hen
you ch oose the Paste Link command.

Before linking a spreadsh eet to another o n e, it is a good idea to save the
worksheet in case som ething goe~ w ro ng. If a problem occurs, you won't
lose a ny of your valuable work!. and al l you have to do is close the
wo rksheet (witlwut saving it), a 1cl then open the version yo u saved
before the proble m occurred.
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•

Using the procedure you just learned, open the House Loan and lin k
its monthly payment to the Mo nthly Budget, and then close the
Ho use Loa n.

You did remember to save the Monthly Budget before starting the next step,
didn't you?
•
00 -S

Link the monthly paym ent fro m the Car Loan worksheet to the
Monthly Budget, and close the Car Loa n .

.. Save th e Month ly Budget worksheet.
After completing th ese steps, yo u should h ave a Month ly Budget
containing the values shown in Figure 9-69.
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Figure 9-69

T he com pleted Monthl y Budget

This p roject will be used aga in in Pro ject 4, so the fi na l version must be
saved. (Do you get the feeling that saving your work often is important?)
The next time yo u open the Monthl y Budget wo rks heet, Excel will ask
you if you wa nt to u pdate refe rences to unopen ed documents.

Update re fere nces to
unopened documents?

([

Yes

J]

No
Fig ure 9-70 The dialog box you w ill see whe never you open Mo nth ly
Budget
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Excel is asking if you want it tor ad the t hree loan worksh eets that are
linked to the Monthly Budget anq ad just the budget worksheet to reflect
a ny ch anges you may h ave mad4 to the loa n wo rksh eets since th e last
time the Month ly Budget was sa ed .
This is very handy. Eve n if your budget is n ot ope n a nd you m ake
changes to one or more of the loan works heets, Excel can automatically
update the budget the n ext tim e yo u o pen it if you answer this question
wit h Yes . If you answer the question with No, the Monthly Budget will
be opened with the sam e figures it had the last time yo u saved it, even
if you did modify one or more of the other th ree worksheets to which
it is linked.

CREATING A PIE CHART
The next step in completing t his pro ject is to create a pie chart showing
a comparison of the expe nses. You will not have to move any cells,
because this worksheet was design ed to make thi s an easy task.
.. Select cells B9:C16, and then crea te a new pie chart, using pie chart
numbe r 6. Add a title and a legend, and make whatever form at
changes you prefer.
You r ch art sh ould look simi lar to th e one shown in f igure 9-71.
' l5
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Figure 9-71

Pie ch art

compa ri ~g

expense a m ounts

:3€ -S

•

Save this pie chart as Mon th y Budget Expenses Chart.

:3€ -P

•

Print the pie ch art.
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CREATING A COLUMN CHART
The pie chart was easy to create. Now let's create a column chart
comparing total income, total expenses, and surplus/deficit. You want
to sh ow the three numbers o n th e chart, and the legend should contain
a name for the numbers represented by th e colum ns in the cha rt.
To select no ncontiguo us cells or ranges of cells, use Command-click a t
th e beginning of each ran ge to te ll Excel that you want to trea t
noncon tiguo us cells as a group.
..

Select cellsA6:C6, A17:C17, andA19:C19 and create a colum n cha rt.

What's wrong with this chart? There is a space for a data series with no
data. You chose a selection three co lumns wide, a nd Excel assumed that
the first column had the title of the data series, and it does. Then Excel
assum ed that both colu mn s Band C contained data associated with that
series, but that is not correct. Because there is no informatio n in colum n
B in these rows, Excel plotted a column with a height of zero.
This is n ot what you want to do. If you moved the titles into column B,
you could select the cells in Band C in each row, and Excel's assump tions
about creating a n ew ch art shou ld work. It sure seems a shame to have
to go in and rearran ge your worksh eet after getting th is far. Luckily, you
don't h ave to do th at.
11
,.

Close the new chart without saving it. Using Command-click again,
choose only cells C6, Cl7, a nd C19. Create a new column chart. Add
a legend to the chart.

When you told Excel to add the legend, it put the legend on the right
side of the box with three patterned rectangles, but there are no words
associated with the patterns. Thi s is because yo u chose on ly cells
containing numbers, and Excel h ad n oth ing to use as nam es for those
numbers.
Th ere is an easy way to m odify th e data series you just charted so Excel
will have a n ame associa ted with each o ne.
~~•

Click on the column on the left (wh ich represents income) .

Wh en yo u do, Excel shows a formula that starts with =SERIESC, in the
formu la bar. The sp ace between the open ing parenthesis and the first
comma is where the name of the series goes .
,..

Click between the opening parenthesis and the first comma, an d
enter "Total Incom e" (you must enter th e q uotation characters) .
Accept t h e formula.
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Your chart should now look si, ilar to the one shown in Figure 9-72.
r

.,

e5 File Edit Gallery Chort Format Macro Window
s 1P 1

=5ER1ES("Total lncome",,"Monthly Budgel"!$C$6:$C$6, 1)
Chart4

$2,500.00
$2,000.00
• Tote1 1ncome

$1 , 500.00

0
$1 , 000.00

11

$500.00
$0.00

.. Ready

Figure 9-72

Naming the Total Income data series

",. Select the center column and name it "Total Expenses", and then
name the right column "Surplus or Deficit".
Your chart should have a complete legend. You can now add a title and
make any formatting changes you desire.
3€ -S

•

Save this chart as Monthly Budget Column Chart.

You now have completed Project 3. Be sureto saveacopyofthe Monthly
Budget worksheet for use in Proj ect 4.

WHAT IF ... EXERCISES
When you work through these what if. .. exercises, do not save any changes that
you make to yow· worksheets, so you will have the proper values in the Monthly
Budget for use in Project 4.
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There are a number of things you can do now. A change to any of the
three loan worksheets will affect the Monthly Budget worksheet as well
as the two charts you just created.
For example:
1.

What if you spend $1,000 this month to buy that new video camera
you've been dying to own? This will make your expenses for the
month greater than your income, and your surplus will turn into a
deficit. Hint: Try adding $1,000 to the Entertainment expense category.

2. What if you bought that $20,000 car you've been wanting? How will
that affect your budget? Could you afford it? Hint: Modify the Car
Loan worksheet and see how it affects your budget.
3. What would happen if you got a 20-year house loan instead of 30
years? How much extra money would you have for something else
by not having to make house payments for an extra ten years? (Hint:
Subtract the total amount to be repaid for the 20-year loan from the same
value for the 30-year loan.) How much would your monthly payment
increase? Would it fit into your budget?

Project 4: Developing an Annual Budget
In this project you will modify the monthly budget you created in
Project 3 and expand it into an annual budget. You will learn to use the
split bars, create a sequential data series, and make extensive use of the
Fill Down and Fill Right commands.
You will create two chart s in this project. A pie chart will show the
breakdown of all your expenses, and a line chart will show the
comparisons of total income, total expenses, and any surplus or deficit
over the 12-month period .
The final output of Project 4 is shown in Figures 9-73, 9-74, 9-75,
and 9-76.
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Budget
Jan 1994

Feb 1994

Mar 1994

Apr1994

May 1994

Jun 1994

Jul 1994

Income
Income #1
Income #2
Total Income

$1 ,400.00
$735.00
$2,135.00

$1 ,400.00
$735.00
$2,135.00

$1 ,400.00
$735.00
$2,135.00

$1 ,400.00
$735.00
$2,135.00

$1,400.00
$735.00
$2.135.00

$1,400.00
$735.00
$2,135.00

$1,400.00
$735.00
$2,135.00

Expenses
House
Car
Education
Food
Clothes
Insurance
Utililies
Savings
Entertainment
Total Expenses

$376.87
$175.97
$103.79
$250.00
$75 .00
$150.00
$185 .00
$213.50
$200.00
$1,730.13

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$185.00
$2 13.50
$200.00
$1,580.13

$185.00
$213.50
$200.0 0
$1 ,580.13

$376.87
$175.97
$103.79
$250.00
$75.00
$600.00
$140.00
$2 13.50
$200.00
$2 ,135.13

$100.00
$213.50
$200.00
$1,495.1 3

$65.00
$213.50
$200.00
$1.460.13

$376.87
$175.97
$103.79
$250.00
$75.00
$150.00
$120.00
$213.50
$200.00
$1,665.13

$404.87

$554.87

$554.87

($0.13)

$639.87

$674.87

$469.87

S urplus/ Deficit

I
Figure 9-73

Final output of Project 4, budget page 1

I
I
Aug 1994

Sep 1994

Oct1994

Nov 1994

Dec 1994

$1 ,400.00
$ 735.00
$2,135.00

$1,400.00
$735.00
$2,135.00

$1 ,400.00
$735.00
$2,135.00

$1,400.00
$735.00
$2.135.00

$1,400.00
$ 735.00
$2, 135.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$376.87
$175.97
$103.79
$250.00
$75.00

$120.00
$213.50
$200.00
$1 ,515.13

$65.00
$213.50
$200.00
$1,460.13

$65.00
$213.50
$200.00
$1 ,460.13

$100.00
$213.50
$200.00
$1,495.1 3

$170.00
$213.50
$200.00
$1 ,565.13

$619.87

$674.87

$674.87

$639.87

$569.87

Figure 9-74

Percent of
Totals Total Income

$ 1 6,800 . 66 .57%
$ 8 ' 8 2 0 . 0304 . 4 3 %
$ 2 5 ' 6 2 0 l 0000 . 0 0 %
$
$
$
$

4 ,52 2 . 41 77 .6 5%
2 , I I I . 6 <lB . 2 4 %
I ,2 4 5 . 5@1.86%
3,000 . 010 1 . 7 I %
$900 .003.5 1 %
$9 0 0.003.5 1 %
$ 1 ,500 . 0Gi .8 5%
$2 , 5 6 2 . 0 100 . 00%
$ 2,400. 0@ . 37%
$ 1 9 ' 1 4 1 .5'11 . 7 1 %
$ 6 , 4 7 8 . 4235 .2 9%

Final output of Pro ject 4, budget page 2
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Figure 9-75

Final output of Project 4 line chart
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To begin this project, you should have completed Project 3 first, since
you will be using the monthly budget you developed there as a starting
point for this project.
.. If you have quit Excel, restart it by double-clicking on the Monthly
Budget icon. If not, open Monthly Budget.
.. Save this worksheet as Annual Budget onto your data disk.
This will not change the monthly budget, but only makes a copy of it,
names the copy Annual Budget, closes the original worksheet, and
makes thi s new Annual Budget the active worksheet.

CREATING A DATA SERIES
An annual budget usually has a list of the 12 months across the top of
the budget. Then, under each month's name, there is the amount for
that month for each income and expense category.
To create the data series you need to select cells C2 through N2. You will
make use of the automatic scrolling feature of Excel. If you press the
mouse button in a cell and drag the pointer past the edge of the window,
the window will scroll and extend the selection as it scrolls.
, . Press the mouse button on cell C2 in the left pane, hold the mouse
button down, and drag the pointer to the right side of the screen .
Hold the mouse button down until you have scrolled through and
selected all the cells in row 2 over to cell N2.
That may not have been an easy thing to control if you are new to
automatic scrolling. This is a slow, and unnecessarily difficult, way to
select large numbers of cells.
Now that you have some experience in automatic scrolling and selecting,
let's learn a better way to do this.
.. Scroll back to the left, using the scroll bar, so that column A is visible
in the worksheet window.
You could add the month names now by typing them into cells 0 2
through N2, but Excel offers several easier ways to accomplish this. Let's
add the month names in this worksheet by creating a data series.
The first thing you will notice is that you cannot show a whole year on
a standard Macintosh monitor. Excel allows you to get around this
problem by using the split bars. You will use the vertical split bar
(located in the lower left corner of the worksheet window) to allow you
to see the cells on the left and right sides of the worksheet. This means
that you will not be able to see the cells in the middle of the worksheet.
•

Point to the vertical split bar and drag it over the border between
columns D and E.
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This splits the window into two vertical panes, each having its own
h orizontal scroll bar, and they both sh are the vertical scroll bar. .
•

Click o n the right pane's scroll bar u n til column N is centered in the
pan e.

One handy method for selecting cells is to click on the first o n e and then
Shift-click on the last one. This will be especia lly useful for th is project
since you will be making several wide selections.
To add the data series, you must first select cells CZ:NZ. As you have
seen, you can click on CZ and drag to NZ, but it causes the window to
scro ll and is often d ifficult to control. An easier method is to click on
the first cell and then Shift-click on the last.
•

r

Click o n cell C2 in the left pane, and then Shift-click on cell N2 in
th e right pane (see Figure 9-77).
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FigUJ·e 9-77

Making a wide selection usin g two vertical panes

This is a much faster and easier method to make selections across a
number of columns. This method also works vertically, across multiple
rows, if you split the screen using the h o rizon tal split bar.
Notice that the first cell in the selection was formatted in Project 3 as a
date. If you had not already form atted that cell as a date, you would have
to do so now.
Wh en you create a data series, the first cell in the selection must have
a value in it. If the first cell is empty, the data series will be empty. Si nce
cell C2 h as a starting date, you can create a series of dates q uickly using
the Series command.
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•

Ch oose Series fro m the Data menu.

You will see the d ialog box shown in Figure 9-78.

w@ rles
l:=l
Rows
QColumns

Step Uolu e:

Type 0 Linear
Q Growth
@ Dote

I

Figure 9-78

Date UnitQ Day
Q Weelcday
@ Month
Q Year

~

OK

( Cancel

I Stop Ualue: I

ll
l

I

Creating a series of date values

Th e data series you will create will be on a single row and will be a date
increasing by o ne month per column.

Return

•

Select Month under the Date Unit. You don 't have to specify a sto p
va lue, because Excel will automatically stop wh en it reach es the last
cell in th e selection (N2).

•

Click OK or press Return.

You sho uld n ow see the month names at the top of the co lumns as
shown in Figure 9-79.

'" a

Fil e Edi t

Formula

Format

Data

Options

Macro

... Ready

Figu re 9-79
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•

Filling a selection with a series of dates

This is a good time to save your work.

Window
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ADDING FORMULAS
Now that you have set up the month names, it is time to use Excel's
powerful replication features to quickly expand the monthly budget
into an annual budget.
The first step is to tell Excel that February's amounts are the same as
january's amounts. This will not be strictly true, but it allows you to
rapidly expand the spreadsheet and then go back and make specific
adjustments as necessary.
•

Select cell 04 and enter the formula =C4.

Excel will display 1400 as the Income #1 amount for February.
Notice that the format is not for currency. This is because you only set
the cells in column Cas currency format. Since most of the cells in this
worksheet will contain currency amounts, the next step is to select the
entire spreadsheet and choose the currency format.
•

Select the entire worksheet by clicking in the top left rectangle to the
left of Column A and above row 1.

The entire worksheet will be highlighted.
.. Select the currency format from the Format menu.
Notice that the month headings on row 2 changed to currency also. You
can correct this by selecting those cells again and formatting them with
the special date format you previously created.
•

Select row 2 by clicking the row number. Select the date format from
the Format menu.

DUPLICATING FORMULAS AND NUMBERS
Now that you have set up the proper formats, you can duplicate the
formula in cell 04 down the column so that each category's january
amount will be displayed in February also.
3€ -0

,,. Select 04:019, and choose ~ill Down from the Edit menu.
Notice that all the cells between 04 and 019 momentarily show 1400
then recalculate almost immediately. Since cells C7, C8, and C18 were
blank, Excel has put $0.00 into cells 07, 08, and 018. You want these
cells to be blank, and the easiest .Jvay to do this is to select them and use
the Clear command.
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.. Make a multiple selection of cells D7:D8 and Dl8.
~ -B

,. Choose Clear from the Edit menu, and then click All in the dialog
box. Click OK.
Your worksh eet should look like the one sh own in Figure 9-80.
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Clearing empty cells

Now you are ready to fill in all the mo nthly budgets for March through
Decem ber.
,.. Select cell D4 in the left pane, and then Shift-click on cell N1 9 in the
right pane.
This allows you to select all the cells representing February through
December. You must select t he February amounts, because you are
going to duplicate the formulas from these cells into all the months
through December.
~- R

,,. Choose Fill Right from the Edit m enu.

After you click in a cell to deselect t he large selection, your worksheet
sho uld look like the one shown in Figure 9-81
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Figure 9-81

Annual Budget after filling February values through
December

In just a few easy steps you have told Excel to expand the monthly
budget into a full 12-month annual budget.

ADDING MULTIPLE COLUMNS
Now you will add two more columns to the worksheet. Column 0 will
contain the totals for each category for the year, and column P will
contain formulas that calculate the total for each category as a percentage
of total income.
You will add the titles for the columns and then create two formulas and
use Fill Down to duplicate them.
•

Select cell 02 and enter Totals.

.. Type Percent of in cell Pl.
.. Enter Total Income in cell P2.
,.. Select these three cells, choose Alignment from the Format menu,
and in the dialog box click ight to have them align Right.
Return

,.. Click OK or press Return.

Part IV: Spreadsheets

450

Before you add the formulas for these two columns you should change
the format for the font displayed in cells 04:Pl9. If they are displayed
the same as the other values, it will be hard to see where the monthly
values end and these summary columns begin.
•

Selectcells04:P19, thenchooseFontfrom the Format menu. Change
the font to Bold and click OK.

You will now add the formulas for cells 04 and P4.
•

Select 04 and enter =SUM(C4:N4), and in P4 enter =04/$0$6.

The formula in cell P4 needs a little explanation. It tells Excel to take the
sum of all12 monthly Income #1 amounts (calculated in 04) and divide
it by the amount in 06 (which is the total annual income). You need to
use relative addressing for 04, because you want Excel to use the sum of
each respective category when you use Fill Down. You must use absolute
addressing for cell 06, because you always want to divide the total for
each category by the total annual income.
When you enter the formulas, Excel calculates the total in cell 04 but
gives you an error message in P4, #DIV/0! (see Figure 9-82). This means
that you are dividing by zero, which is an undefined mathematical
operation. You receive this error message because you have not filled the
formulas down yet, so there is no value in cell 06. This will be rectified
in the next step.
,. •
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3€ -D

•

Select cells 04:P19 and choose Fill Down from the Edit menu.

00 -B

•

Clear the unnecessary formulas in cells 07:P8 and 018:P18.

•

Select P4:P19, choose Number from the Format menu, and then
choose 0% from the scrolling list. Click OK.

The result is shown in Figure 9-83.
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.,

Budget after filling Totals and Percent of Total Income
columns

This completes most of the steps necessary to create an annual budget.
All that is left is to make a few refinements, correct three errors, and
modify some of the amounts for insurance.
Additionally, you will insert a new row so you can add a Savings
category, and you will create a pie chart and a line chart.

EDITING THE DATA
One of the most glaring problems with this worksheet is that almost
nobody pays constant monthly payments for insurance. You will now
modify this worksheet so that three insurance payments are made.
While you are doing this, you can take advantage of Excel's ability to
attach a note to a cell for an explanation about why something is being
done.
The first step is to clear all the formulas in the Insurance category for
February through December.
ljg - B

•

Select D14:N14 and clear only the formulas. If you don't remember
how to clear formulas, refer back to the "Adding Formulas" section
of this project.

Notice that the total for the Insurance category was changed, but there
seems to be a problem with th9 formulas that calculate the monthly
total expenses. This is because you started with a formula specifying a
named range and then replicated formulas that told each month to use
the same total as the month before.
You need to change the formulas for total income, total expenses, and
surplus/deficit, and then fill them to the right.
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•

Click in cell C6 and ch ange the formula to =SUM(C4:CS).

W-R

•

Select cell s C6:N6 and choose Fill Right from the Edit menu. (Do not
fill into columns 0 and P.)

a€ -R

•

Enter =SUM(C9:C16) in cell C17, select cells C1 7:N1 7, and choose
Fill Rig h t from the Edit menu .

:5€ -R

..

Enter=C6-C17 in cell C19, selectcellsC19:Nl9, and choose Fill Righ t.

This will correct the fo rm ula errors.
Many times w hen usi ng a spreadsheet, you will encounter values for
wh ich origins and purpose are n ot immediately clear. Excel lets you
attach notes to a cell to explain wh y the values are in the cell and where
they came from. These notes are not visible on the screen, and t hey will
not appear when you print unless you choose to see them.
This family, like most families, has insurance policies that cover the
house and the car. The house insurance is paid annually in April, and
the car insurance is paid twice per year, in january and again injuly. The
january payment insures the car from january through june, and the
July payment covers the next six months.
Table 9-14 lists the insu rance values that will be entered and the
explanatory notes associated w ith the payment.
Month
j anuary
April
july
Table 9-14

Ins ura n ce a mount
$150 for car insurance Qan-jun)
$600 for an nual house insurance
$150 fo r car insurance Qui-Dec)
Insurance amounts for three months

You could e nter t he th ree payments into the appropriate cells, but
without attach ing a note, you would not have an explanation for
the amounts.
Since you don'twa n t to be confused later when you open the worksheet,
enter the insurance am oun ts into th eir cells and attach the explanatory
n otes to those cells.
The easiest way to get to t he cell for April's insurance is to scroll the right
pane of the wi ndow to t he left until April is visible. This will still leave
the categories showing in the pan e on the left (see Figure 9-84).
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F14
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AnnuaiBudget

Entering April's insurance amount aft er scrolling the
righ t pane

Figure 9-84

•

.,

Enter 600 for April's insuran ce, and then choose Note from the
Fo rmula menu. Type House insurance, annual, in the Cell
Note dialog box, click Add, and then click OK or press Return (see
Figure 9-85).

Cell: Lrl_14_ ___....J

Notes In Shee t:

CJ
Figure 9-85

Note:
House ln s uran c e , annua~

Delete

Add a no te to April's insurance amount in cell F14.

If you want to see the n otes for a worksh eet, you can choose Note from
the Formula menu, and all attach ed notes will b e listed in the scrolling
list o n the left in the Cell Note dialog box. Select any cells listed , and the
associated n o te will appear in the box wh ere you just entered the n ote
for the h o use insuran ce.

•

Add the amount and note for the car insurance in july and fo r the
car insura nce in j anuary, as well. Refer back to Table 9-14 for the
in fo rmation you need.

While you are making chan ges to expenses with fluctuating amounts,
it is a good time to modify the Utilities expense. For this budget you can
assume that winter h eating bills will cause utilities to be higher than in
the spri ng and fall, and air condition ing in late summer will also be
highe r.
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•

Enter the amounts shown in Table 9-1 5 into the specified month's
utili ty expense (do not clear the existing formulas first).

Month Amount
April
May
June
July
September
November
December
Table 9-15

140
100
65
120
65
100
170

Utility expenses

INSERTING ROWS
The budget shows that you are running a surplus every month, so before
the money slips through your fingers, it might be a good idea to budget
10% of take-home pay to go into savings each month.
Although a savings category was not planned for, Excel will let you
quickly add it.
~ -I

•

Select all of row 16 by clicking on the row number to the left of the
row. Choose Insert from the Edit menu.

As a shortcut, you can also press Option-click on the row number to
insert a row. If you want more than one row, use Option-click and drag
to select the number of rows to insert.
Since you selected one row, Excel inserted one new row. If you had
selected five rows, that's how many would have been inserted. This
same command works for inserting columns if that is what is selected
before issuing the command.
The Delete command works in a similar manner. Select the rows or
columns you want to delete, and then issue the command.
The action performed by the Delete command is similar to that of Cut,
but it is not an equivalent process. Cutting a selection moves it to the
Clipboard, where it can be pasted into a new location. Delete removes
the rows or columns from the spreadsheet and closes up the space they
occupied. Deleting does not move the contents of these erased cells to
the Clipboard.

~ -R

•

Name the category by entering Savings in cell B16. The formula for
C16 is =C6*.1.

•

Select C16:N16 and choose Fill Right from the Edit menu.

You need to tell Excel to calculate the year-end summary amounts for
the new row.
~ -D

•

Select 015:P16 and choose Fill Down from the Edit menu.
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Your worksheet should now loo ' like the one in Figure 9-86.
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Figure 9-86

3€ -S

••

Fo•mat

I

Data OpUon•

Mom

Window

.,

Adjusting formu las to calculate summary values for new
category

Save your work to your data disk.

Now is a good time to print the ~orksheet. You can set the headers and
footers and decide about printing gridlines and row and column
headings.
The Annual Budget worksheet will be wider than it is tall, so change the
page orientation to wide (also kno wn as landscape).
•

Choose Page Setup from the File menu. Change the orientation of
the page to wide by clicking on the icon on the right under
Orientation that shows the page turned sideways.

00 -P ,.. Print the Annual Budget worksheet.

CREATING A LINE CHART
Creating this line chart will be fairly straightforward, since most of it is
automatic. You can format the chart's title and place the legend as you
desire. The only adjustment you ~ill need to make to the chart is adding
the data series' titles for the legT d.
Select the monthly summaries or total income, total expenses, and
surplus/deficit.
•

Click on cell C6, and then Shift-click on cell N6.

•

Now add the expenses to the selection by Command-clicking on
C18 and Shift-clicking on Nl8.

•

Use the same method to add the surplus/deficit amounts to the
selection (see Figure 9-87). J
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Making a multiple selection to create a new line chart

Figure 9-87

, . Create a new line chart and add the legend and a title. Choose the
line chart style from the Gallery menu that matches the one shown
in Figure 9-88.
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Figure 9-88

New line chart showing Annual Budget amounts
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•

Add the names for the dat series, as shown in the formula bar in
Figure 9-88 and explained i Project 3.

•

Use the Page Setup command from the File menu to choose a wide
orientation for printing.

:3€ -S

.. When you have entered all the names for the data series, save the
chart as Annual Budget Line Chart.

3€ -P

, . Print the chart.
Your chart should look like the one shown in Figure 9-89.
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Figure 9-89

Line chart after naming data series for legend

This chart will be used in the what if... exercises in this project.

CREATING A PIE CHART
This next chart will be even easier to create than the line chart. All you
have to do is select the cells showing year-end totals for the expense
categories. To keep from having to manually add all the names, you can
select them before creating the new chart.
•

I

Select the cells, as shown in igure 9-90, and create a new pie chart.
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Make a m ultiple selectio n to create n ew pie chart

•

Make the page orientation wide, and add a t itle and a legend.

•

Save this ch art as Annual Budget Expenses Pie .
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Figure 9-91

Annual Budget p ie chart com parin g expenses

You will be using this ch art and the line ch a rt in t h e what if... exercises
in th is ch apter. Now is a good time to save and print t h is ch art.
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WHAT IF ••• EXERCISES
When you work through these exercises, be sure to save your Annual Budget
worksheet first, and then do not save the changes you make in this section. As
a reminder, you might remember that you can always use the Save As
command to create a backup with a different name. You then can make any
changes to that document without affecting the original. This is a handy way
to make a backup of an important document before making any major
changes, or before trying any new procedures. It is easier to make backup copies
than it is to replace lost information.
1. What if the employer of the person earning Income #1 offered to

send this person back to school in September for some specific
courses and offered to pay half salary during the semester and
reimburse educational expenses when the semester is over?
2. If this person decides to accept the offer, the employer guarantees
a $100 per month raise (in net, or take-home, pay) starting in
December. The employee will incur $1,000 in additional educational
expenses in September.
3. You will need to adjust Income #1 to $700 for September, October,
and November. December income will be $100 more than in
August, plus the reimbursement of the $1,000 expenses.
4. Make these changes and print the worksheet. Open each of the two
charts that you just created, and print them. Compare these printouts
with what you previously printed.
5. For what month(s) will this family have to dip into savings because
their expenses exceeded their income?
Do not save these changes to your Annual Budget worksheet.

CHAPTER SUMMARY
• Excel is an electronic spreadsheet program that incorporates and integrates worksheets,
charts, macros, and databases.
• Worksheets are central to data analysis in Excel.
• Worksheets are organized in columns and rows. The intersection of a row and a column is a
cell. A cell is located by its address. Columns are named by letters and rows by numbers. A
cell will have an address designated by a letter-number combination, e.g., A9.
• A cell can contain text, a number, or a formula.

I

• Formulas refer to values and the contents of other cells. When referring to the contents of
other cells, formulas can use relative addressing or absolute addressing.
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• When the contents of a cell referred to by a formula changes, all cells dependent on that cell
change automatically.
• Excel allows you to change the width of a column and the format of a cell.
• The values shown in a worksheet can be charted into area, bar, column, combination, pie,
and scatter charts.
• Worksheets can be created, saved, opened, modified, printed, and linked.
• Excel facilitates rapid spreadsheet construction using data series and the Fill Right and Fill
Down commands.

KEY TERMS
absolute addressing
active cell
area chart
arguments
bar chart
cancel box
cell
column
column chart
combination chart
context-sensitive help
data series
defined term
dummy argument

header
horizontal split bar
jump term
legend
line chart
linked terms
pie chart
range
reference area
relative addressing
row
scatter chart
selection squares
status bar

enter box
template
fill
footer
formula bar
formula
grid lines

vertical split bar
what if... analysis
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COMMAND KEYS AND SHORTCUTS
Activity
Activate next window
Activate previous window
Calculate Now
Can cel
Clea r

Command-key equivalent
3€ -M
Shift-3€-M
3€ -=
3€ -. (period)
3€ -B

Close Window
Copy
Cut
Defin e Name
Delete

3€
3€
3€
3€
3€

Fill Down
Fill Left
Fill Right
Fill Up
Formu la Find (displays dia log box)

3€ -D
Shift-3€-R
3€ -R
Shift-3€-D
3€ -J

Formula Find n ext
Formula Fi n d previous
Go to
Help
rnse rt

3€ -H
Shift-3€-H
3€-G
3€ -/ or 3€ -?
3€ -I

New
Note
Open
Paste
Print

3€-N
Shi ft-3€-N
3€- 0
3€ -V
3€ -P

Qui t
Save
Save As
Select All Cells
Select Ch art

3€-Q
3€ -S
Shi ft-3€-S
3€ -A
3€-A

Undo

3€-Z

-W

-C
-X
-L

-K

Editing in the Formula Bar
Activity
Activate formula bar
Cancel entry

Command-key equivalent
3€ -U
3€ -. (period)
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Choosing Dialog Box Options
Comma nd-key equi valent
:1€-0ptio n-0 (zero)
:!€-Optio n-Left Arrow
:!€-Option-Rig ht Arrow
:!€-Optio n-Up Arrow
:!€-O ptio n-Down Arrow

Activity
Format
Fo rmat
Format
Format
Fo rmat

Bo rde r (Outline)
Bo rder (Left)
Bo rder (Right)
Bo rder (Top)
Bo rder (Bottom)

Format Num ber (Gen eral fo rmat)
Forma t Numbe r (0.00 format)
Forma t Num ber (h:mm AM/PM format)
Fo rmat Num ber (d-mmm-yy fo rmat)
Format Num ber
($#,##0.00; ($#,##0.00) fo rmat)

W-Optio n-3€-0ptio n- !
W-Optio n-@
W-O ptio n-#
3€-0ptio n-$

Format Number (Oo/o fo rma t)
Format Num ber (O.OOE + 00 format)
Formula Select Special (Notes optio n)
Formula Select Specia l
(Current Region o ptio n)
Fo rmul a Select Special
(Row Differen ces optio n)

W-Opti o n -o/o
W-Option- 1\
:1€-Shift-0 (letter 0)
3€ -*

Formula Select Special
(Column Differences o ptio n)
Fo rmula Select Specia l
(Precedents: Direct Only o ption )
Formula Select Specia l
(Precedents: All Levels o ption)
Fo rmula Select Specia l
(Dependents: Direct O nl y o ption)
Fo rmula Select Special
(Dependents: All Levels o ption)

W-Shift- \

O ptio ns Displ ay Fo rmulas
(toggles between formulas and values)

3€ - \

3€ -[
W-Sh ift- [
3€ -]
W-Shift-]

W -' (backquote)

Additional Projects
The fo llowing project is accompanied by briefer instructio n s than those
you have previou sly completed in this ch apter. It requires that you
apply what you learned in the first four projects. If n ecessary, refer back
to the preceding fo ur projects for information and instruction s fo r any
procedures t hat you aren' t fa miliar w ith.
You will not be reminded to save your work- you sho uld be thinking
o f that o n your own by now.
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Project 5: Bar Chart
This project is easy to complete. It requires you to create a worksheet and
then produce a bar chart. The worksheet has no formu las or calculations;
it is there just to hold the data for the chart.
The fin al output of Project S is shown in Figure 9-92.

NASA Outlays for Research and Development

1985

7.321

1984
1983
1982
1981
1980
1979
1978
1977
1976

Year
1975
1974
1973
1972
1971
1970
1969
1968
1967
1966
0 000

1.000

2.000

Figure 9-92

6.000

7.000

Final bar chart output of Pro ject S

8 000
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It is up to you how you set up your worksheet as far as formatting, titles,

and other features are concerned. You may want to model the worksheet
after the one in shown in Figure 9-93. The on ly data you actually have
to enter are the years and the amounts spent in those years. Excel has
certain defaults for determining category and data series names from
data entered into a worksheet. If the selection is wider than it is tall,
Excel expects to find the category names in the first row of the selection
and the data series names in the first column . If the selection is taller
than it is wide, Excel will look for the d ata series names in the first row
and the category names in the first column.
In either case, the top left cell in the selection should be blank.
•

One method of approaching this task is to create a data series in row
6 (starting in B6), beginning with 1966 and advancing one year with
an ending d ate of 1985.

•

You might want to put a title for row 7 in cell A7, one such as
Total Outlays. Enter the values for each year starting with 1966 by
placing the outlay amount in the cell below the year. For example,
you could put 1966 in cell B6 and then 5.933 in cell B7.

•

If you have the dates in row 6, the data series title in cell A7, and the
data series values in the rest of row 7, Excel will know how to label
each bar with the correct year. Leave cell A6 blank. Since the
worksheet will be wider than it is tall, Excel will assume that row 6
represents the categories and row 7 holds the data (see Figure 9-93) .

Series name

Figure 9-93

Excel defaults for category and series names in wide
worksheets
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The amounts in Table 9-16, in b'llions of dollars, are not adjusted for
inflation.
Year
1966
1967
1968
1969
1970
1971
1972
1973
1974
1975
1976
1977
1978
1979
1980
1981
1982
1983
1984
1985
Table 9-16

Amount
5.933
5.426
4.726
4.252
3.753
3.382
3.423
3.316
3.256
3.266
3.670
3.945
3.984
4.187
4.850
5.241
6.035
6.664
7.048
7.321
Amounts spent by NASA (billions of dollars) for R & D

.. Select all necessary cells from A6 through the dollar amount for
1985, create a new chart, and select the bar chart that shows dollar
amounts at the end of each bar.
.. Assign text to the title, category axis, and value axis to match what
is shown in Figure 9-92.
.. Choose Page Setup, and select Full Page size. This makes the chart
taller when it is printed.
This completes Project 5.
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art V introduces you to managing lists of information on the
Macintosh . You don't have to use a computer to manage small
amounts of in formation or information that rarely changes, but
if you have information that changes frequently, or if a large amount
needs to be managed, you will p~;obably find that using a computer is an
indispensable part of getting the job done.

Chapter 10: Information Management Concepts introduces you to the
organization and manipulation of information.
Chapter 11: FileMaker II shows you how to use one of the most popular
information management applications available for the Macintosh. It is
not the most powerful application and would not be suitable for large
corporations to manage their information, but for personal management,
small businesses, and departments in larger organizations, FileMaker
provides enough power and flexibility to manage informa tion.
Chapter 12: HyperCard 1.2 te~ches you how to access information
provided by others and how to deate your own stacks and use them. You
will learn to print reports and customize the stack so that it suits your
purpose.

Part V: Information Management

468

Chapter 10: Information Management
Concepts
What You Will Learn in This Chapter
After reading this chapter, you will understand:
•

The difference between data and information

•

How to organize information into databases, files, records, and
fields

•

Information management's standard operations

•

Common terminology associated with information management

!most everybody has to keep track of some type of list. This can
be a to-do list or a simple list of names and addresses. On the
other hand, it can be something as complicated as a list of a
company's financial transactions for a year or complete lists of the
resources, materials, and suppliers needed to build a skyscraper office
building.

A

PERSONAL INFORMATION MANAGEMENT
For personal use, it is often convenient to store a list in a book or on
something like 3xS cards. These methods are okay if the lists are
relatively short or if you are a very organized person.
Most likely, you already manage various lists in your daily life, such as
a shopping list, a list of things to do, or appointments on a calendar.
These types of lists are discarded when they are no longer useful. Other
types of information must be updated. Examples of the latter include
address books, business card files, credit card numbers, insurance
policies, and investments.
Like many of us, you may find that it is difficult to remember to keep this
information up to date. You might organize information in piles (on
your desk, floor, and bookshelves), or you might be the type of person
who organizes your audio library alph abetically by performer and keeps
each type of music separated by category. Most people fall somewhere
between these two groups. Regardless of your personality and preferences,
you probably don't have to manage large amounts of personal
information.
Let's say you keep a list of information concerning your friends. This list
probably contains their names, addresses, birthdays, and so on. A
convenient way to keep track of this information is to store it on a
collection of 3xS cards. Each card contains information about one
person, and the cards are stored in a box, in alphabetical order.
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This collection of cards can be c lied a file, and each card is a record of
information about one person. More than one piece of information
about the person is on a card. Each individual piece of information
(name, address, and so on) can be called a field or item.
If you meet a new person and become friends, you can fill out a new card
and add it to the file. If someone moves, you can change the information
or replace the old card with a new one with correct information. lf you
no longer want to keep information about a person, you can remove the
card and discard it.

For many personal needs, this type of a filing system is sufficient. On the
other hand, businesses, even sypall ones, must manage much more
information than most individuals.

BUSINESS INFORMATION MANAGEMENT
A business can use a file of 3x5 cards, but the situation quickly becomes
complex. Let's say you work for a small business and keep track of a list
of contacts at other businesses. These contacts can be clients, customers,
suppliers, people to whom you refer business, professional and trade
acquaintances, and others with whom you do business.
You've decided to store the information on one card for each contact
person. When the file is small, it is easily managed. There are only a few
names to remember. Then, things begin to change. People move,
change companies, change jobs in a company, change occupations, and
do all the other things that people do, including dying. Sometimes you
will know about these changes, and other times you will learn on ly
when you try to contact someone.
You may find that som e compan ies have several people whom you
regularly contact, so you start another file. Th is file is organized by
company name and lists each contact person at that company on the
company's card.
Over time, some people are listed in the contact person file, others are
listed in the company file, and some are listed in both. If a person
changes jobs, you must remember to change the information on each
card that lists the person. Of course, you don 't always remember to
do this.
Sometimes, however, you may I ave difficulty remembering how you
stored a card with the name ana address you need. Did you store it
alphabetically by the company' name, or did you store it by the last
name of the person you need to ~all? Do you also have information on
this company stored on other cards by other persons' last names? What
happens if you can only rememb1er that the person you need to contact
1
is named Piya, and you can't remember her last name or the company
for which she works.
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In a small card system, this usually is not a critical problem, but what
happens if you work in a company that has 1,000, 10,000, or 1,000,000
or more items of information that need to be managed? Would you
want to be the person who had to maintain an accurate card file on
thousands of people? Of course not. Even if you did want to do this,
there would be a point at which the collection of information would
grow so large or it would change so often that you could not perform
your duties.
For centuries, business managers have had to manage three major
resources: money, materials, and people. In this century, a new resource
has been added to this list: information. Computerization has made it
possible to manage large amounts of information, and, at the same time,
it has accelerated the rate at which information changes. To remain
competitive in a rapidly changing world, all businesses must now
manage their four major resources better.
Effective and efficient management of large amounts of changeable
information has been one of the major goals of the computing industry
since the early 1950s. As the industry has progressed and new hardware,
software, and procedures have been developed, the systems used to
accomplish this goal have changed.
Let's briefly explore the systems that have been designed to manage
business information. What types of information are managed in a
business, and who needs access to which information? The answers to
these questions are as varied as the number of organizations, but let's
look at a "typical" organization.
A traditionally organized business has a hierarchical management
structure (see Figl.lre 10-1).

Tactical
Operational
Cle rical (or Transactional)

Figure 10-1

The management hierarchy

The majority of clerical and lower-level management personnel are
located in the clerical, or transactional, level. Of all management
personnel, their duties are most defined, their daily activities are most
structured, and their decision-making authority is most restricted. They
are involved with repetitive tasks and are primarily concerned with
processing various business transactions. Their information needs
typically involve data entry, error correction, transaction tracking, and
producing periodic reports for higher management.
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As you travel up the m an ageme t hierarchy, t here are fewer people on
each level. Their daily acti viticls are less structured, they h ave mo re
latitude and authority in their d ecision m aking, and the type of
in teractio n s they have w ith the organ izatio n 's info rmatio n changes.
Personnel at th e o peration al level a re respo n sible fo r completing welld efined tasks t hat are usually sh ort-term in nature. Th ey also are
respon sible for implem enting a nd achieving goals set a t the tactical
level. Inform ation needs at this level typicall y involve operatio nal
feedbac k, in the fo rm o f detail re~orts, summary repo rts, and exception
reports. Using a retail department store as an exam ple, a deta il report
m ight sh ow every item carried in inventory, and a summary report
might sh ow sales totals for the week orga n ized by departm en t. An
exception repo1t migh t list only the best-sell ing (or worst-selling) items
sold by the store or an y departm en ts tha t d id n ot m eet their sa les
projecti on s fo r t he week.
Tactical level m anagers typically a re respon sible for setting and m eeting
goals design ed to achieve strategic obj ectives determined a t the highest
level o f the com pan y. These managers u su ally are concerned with
budgetary and operatio n al matters. They also are resp onsible for setting
relatively sh ort-term goals and for planning how to achieve those
goa ls. Much of their in formation need s revolve around periodic reports,
but occasio n ally they will seek "what if ..." an alyses to h elp th em
m ake decisions.
A wh at if... a nalysis is u sed to an swer a question such as, "What if we sell
only 75 percent of the gizmos we are projecting next yea r?" This is the
type of q uestio n that mu st be conside red when planning compa n y goals
and budgets.
Relatively few man agers and officers a re at the strategic level. Th eir d aily
activities are least structured and their decisio n s are least programmed
and restricted . Th ey are m ost con cerned with lon g-range planning and
setting o rganizati on al objectives. Th eir in fo rmation n eeds typically are
o ne-time reports on trends affect ing th e co m pany, wh at if ... an alyses,
and projectio ns.
Th e computing industry's approach to managing busin ess info rmatio n
h as pa ralleled this sh ort journey through the managem ent hierarch y.

File Management

pro~ess

In the 1950s and 1960s this
was called electronic data processing
(EDP). Data processing in volves con verting raw facts, or data, into
info rmation. Data becomes info rljllatio n w hen it is organ ized, colla ted ,
a nd sorted so that it becom es accessible and useful. Du ring this stage of
develo pment, the prima ry goal ~f business automation was to reduce
clerical costs by automa ting clerioal tasks. Each department and division
had its own set of independent com puterized system s. A large am oun t
o f the info rmati on m an agem ent effort was duplicated o n separate
m achines. O n a given m achine, tbe informatio n might be duplicated for
use by diffe rent program s.
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Most information at that stage was stored in separate files. A file might
conta in information used to produce a particu lar report. Business had
hundreds of these files and developed computerized systems to manage
them. A file might contain information on employees, customers,
accounts payable, accounts receivable, inventory, payroll, work in
progress, shipping, receiving, o r any other type of information used to
produce a management report or account for a transaction. Programs,
or groups of programs, were written to m anage each of these files, and
information management systems based on this method o f data
p rocessing were known as file management systems.
The process of keeping files up-to-date, complete, and correct is known
as fi le maintenance. Ma ny problems are associated with maintaining
multiple, separate files. For example, much of the information in one
group of files may be repeated in other files. This repetition is known as
redundancy. Systems that had to maintain hundreds of separate files ran
into the same probl ems encoun tered by an individual maintaining a
3x5 card file. Wh en information changed, all the files containing th at
information had to be in dividual ly updated, a process that was timecon suming, expensive, and prone to error. Unfortunately, the problem s
associated w ith updatin g redundant data can result in an item of
information existing as different versions in the same system.
These types of information managem en t systems did automate the
transactional and operational aspects of a company's information
resources, but they did little to help h igher management. Each
department or di vision maintain ed its own records, and company-wide
m an agement systems were not available. Managemen t wanted a way to
tie these systems together into a management infonnation system (MIS).
At the time, however, several problem s prevented this from h app ening.
First, the information on t he computers was stored on reel-to-reel
m agnetic tape. A large file might be stored on several tapes, and finding
a particular item of data to change might not be accomplish ed easily and
quickl y. Second, the information was redundant, so it might take
mounting and modi fying several tapes to accomplish a change. Third,
the information was stored in locations that might be widely separated,
and data communication over phone lines was slower, more expensive,
and less reli able than it is today.
Hardware, software, and procedures changed in the 1970s. The first
problem, data storage, was solved when the price of disk drives declined
dramatically. Not only did the price decline, but also the reliability of
disks and th e amoun t of data that could be stored on a disk increased.
In a few years, most computer systems were using disk drives as their
main m ethod of data storage.
Tapes store information sequentially; that is, one item after another. To
reach an item, all the preceding tape must pass through the system, like
finding a particu lar song on an audiocassette. Th is method is known as
sequential access. Disk drives can access informatio n sequentially, but
they can also locate information directly, a process kn own as direct access
(or random access).
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Databases
The ability to access informatio n directly led to the solution of the
second problem, redundant information. Methods were devised to
organize information so it could be accessed and processed more
efficiently. The organizational method chosen for storing information
in related files was the database. Three major types of databases are
currently in use: hierarchical, ~etwork, and relational. Of these, the
relatio n al model is used popularly in microcomputer database system s.
Therefore, it is the only one that will be explored here.

Relational Databases
A relational database can be com posed of one or more related files. Each
of these fil es is organized into a tabular structure consisting of rows that
represent records (also known as tuples) and columns that represent
fields (also known as attributes or items).
One of the major advantages of a relational database over a file
managem ent system is the reduction of data redundancy. As an example,
sch ools must manage a lot of info rmation about courses offered,
instructors, students, which courses students have taken, wh en cou rses
were take n, and grades received in the courses.
In a file managem ent system, you might include a student's n ame,
address, phone number, and other pertinent informat ion every tim e
sh e or h e takes a course; if the student takes 40 courses, the system would
contain 40 occurrences of all this info rmation. What d o you do when
the student's address changes? You have to find and change all 40
occurrences and make sure they all match.
Using a relational database system, information can be divided into
multiple files, each of which is designed for efficient data storage. Fo r
example, you can store all t he basic studen t information in the student
file, w hich would consist of name, address, ph one number, fina ncial aid
status, scholarship status, any disciplinary action taken, and other
pertinent information. Th e student is assign ed a unique identi fying
number (usually his or h er Social Security Number), a nd this number
is used to relate information in on e file with information in another
file. A field used to relate informati on in more than one file is kn own as
a key field.
An exa mple of a partial student file is shown in Figure 10-2.

Student Number

Last Name

First Name

Phone

111-22-3333
123-45-6789
321-54-9876
666-88-7777
987-45-1236
999-99-1111

Godfrey
Adams
Prather
Avary
Borreson

Geneva
Rebecca
Lillie
Arch
Lori
Jamie

555-6848
555-7452
555-1597
555-7486
555-3287
555-5874

Figure 10-2

Cavalie~

Example of a studle nt file
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One way to look at the contents of this file is to think of it as a table of
information. There are multiple rows and columns (like a spreadsheet)
in the fil e. All th e information on a particular student will be located
on the same row. Each row represents one record in t h e file (see
Figure 10-3).

Student Number

Last Name

First Name

Phone

111-22-3333
123-45-6789
321-54-9876
666-88-7777
987-45-1236
999-99-1111

Godfrey
Adams
Prather
Avary
Borreson
Cavalier

Geneva
Rebecca
Lillie
Arch
Lori
Jamie

555-6848
555-7452
555-1597
555-7486
555-3287
555-5874

Figure 10-3

A student record in the student file

Each column in the table represents a single field. Figure 10-4 shows the
field that represents the students' last names.

Student Number
111-22-3333
123-45-6789
321-54-9876
666-88-7777
987-45-1236
999-99-1111
Figure 10-4

Last Name
•

!Godfrey
Adams
Prather
A vary
Borreson
Cavalier

First Name

Phone

Geneva
Rebecca
Lillie
Arch
Lori
Jamie

555-6848
555-7452
555-1597
555-7486
555-3287
555-5874

Th e Last Name field in the studen t file

Class names and the instructors assigned to teach the class could be
stored in a class file. Of course, like the student file, more information
would h ave to be in this file than what is sh own. Each class is assigned
a class number, usually con sisting of an abbreviation for the department
teaching the course followed by a un ique identifying number for the
course within that department. Other information such as credit hours,
class h ours, lab h ours, and prerequisites would p robably be in the file as
well. Figure 10-5 shows a partial example of a class file.

Class Number

Class Name

Instructor

ACC 103
ART 101
BUS 211
EDP 150
EDP 641
PHY 453

Cost Accounting
Art Appreciation
Office Machines
Pascal I
Compiler Design
Thermodynamics I

Nichols
Dockery
Hughes
Dillard
Young
Erker

Figure 10-5

A class file
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A record of all courses taken by all students could be maintained in a
completed courses file (see Figure 10-6). This file would contain two key
fields. The Student Number field is used to relate to information in the
student file, and the Class Number field relates to information in the
class file.

Student Number Class Number

Qtr Taken

Grade

111-22-3333
123-45-6789
321-54-9876
666-88-7777
987-45-1236
999-99-1111

92-3
91-4
91-2
92-4
90-1
91-3

A
B
A
B
B
A

Figure 10-6

ACC 103
EDP 150
BUS 211
ART 101
PHY 453
EDP641

The completed courses file

When a student requests a transcript, the registrar enters the student
number assigned to that student (or former student). The database
program sorts the completed classes file by the Qtr Taken field (if the file
is not already stored in that order), finds every occurrence of the student
number in the file, and then prints a transcript. Of course, additional
processing is necessary to group the courses by quarter (or semester),
calculate the quality points earned (based on credit hours and grade
received), and calculate the student's grade point average for each
period and the cumulative grade point average. Additional information
may be added to the transcript based on information stored in other fi les
for honors earned and extracurricular activities that may be noted.
A database system using multiple, specialized files reduces redundancy
to the point where data is duplicated in the key fields only. Specifying
that the information in the key fields must not be modified eliminates
the problem of updating multiple occurrences of an item. If a student
moves, any information that needs to be changed can be found in one
place.
Each file is simple in design and easy to update. Associating, or relating,
information in different files leads to less wasted space on the disk and
a reduced possibility of information being partially updated. Unforeseen
information can be added to reports by creating and relating new files,
modifying the program to look up information in the new files, and
adding this information to the ~eport as needed.
Network Databases

The third problem that had to be overcome before management
information systems became widely useful was communication between
distant systems. In the 1970s data communication became cheaper,
faster, and much more reliable. This led to formation of wide area
networks. A wide area network is formed when several computer systems
communicate with each other by sending information over a common
carrier, such as the phone systef .
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Digital signals used in computers are not compatible with the analog
signals used in phone systems. Therefore, to send and receive computer
information over the phone lines, a conversion device is used. This
device, known as a modem, modulates a computer's digital signals into
sound (an alog signals) at one end of the phone system, a nd a compatible
modem demod ulates the sound back into electron ic d igita l signals at
the other end for the other computer. The term "modem" derives from
the process of modulating and demodulating.
Today, hundreds of databases are available worldwide on computer
networks. Anyone w ith an account and a password can use these
systems to access many types of information and to send and receive
messages (a process known as electronic mail).
With computers communicatin g over the phone li nes, information
could be accessed directly, and t ransactions could be processed as they
were made instead of being entered into the system at a later time. This
was known as t ran saction processing. The 1970s brought a big increase
in transactional processing systems.
In the 1980s information management systems became widely available.
With the introduction and widespread availability of microcomputers,
informat ion management system s went through sim ilar stages of
evolution as were seen in mainframes and minicomputers in the 1960s
and 1970s. First, file management syste ms became available, and these
were quickly followed by more powerful database systems.
Recently, information management systems, which were formerly
described using traditional terms ("file managemen t systems" and
"database systems"), have begun to blur the distinctio ns between the
two traditional system types. In the world of microcomputers, most
people refer to any information management system as a database
system, regardless of whether it meets the technica l definition. Bowing
to popular usage, this book will refe r to programs such as FileMaker
as databases.
Microcomputers brought another d ifference to computing. It is very
likely that a company will have many microcomputers located in the
same building. This situation is not as likely with min icomputers and
mainframes. As communications became more importan t during the
1980s, a new method of connecting computers was developed and
became known as a local area network. A local area 11etwork (LAN),
technically, is a conn ection of communicating computers that do not
use any lines or equipment belonging to a com mon carrie r. By popula r
usage, a group of microcomputers that send and receive information to
a nd from each other is called a LAN.
just as minicomputers and mainframes developed database systems
that operate over a wide area network, microcomputers now have
databases that work over a local a rea network. This allows multiple users
to modify info rmatio n on a common database from any computer
having access to the LAN. Once again, departments in large companies
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h ave the ir own local database management facilities. But, for the first
time, small companies have access to computing power similar to that
relegated to o nly the world's largest companies a few years ago.

USES OF INFORMATION MANAGEMENT SYSTEMS
Some of the activities and term inology associated with managing
information have already been presented, alon g with some of the
pitfalls of manual m ethods. Computerized info rmation management
systems are designed to automate many tasks. Specifically, these programs
will help you do the following:
•

Organize you r information

•

Store that in formation

•

Perform mathematical calcula tio ns

•

Add new records

•

Delete existin g records

•

Edit the contents of selected records

•

Retrieve individual records or groups of records that match specific
criteria

•

Sort the information into a different order

•

Print reports in different formats

Each of these functions is discussed below.

Organizing Information
Several types of information management programs exist, but all of
them are designed primarily to !Jelp you organize information, store it
on the computer, retrieve information, modify it, and produce reports.
Information can be organized into databases, files, records, and fields.

Storing Information
Wh en you h ave determined the organization of the information, you
describe it to the computer by creating a new file. At this time, the
program requires you to specify each field to be used and what type of
information will be contained in that field (date, number, text, graphics,
formula, and so on). In most information management p rograms, only
one type of information may bd contained in each field.
Once the o rganization is described to the computer, you may then add
information to the file. This is usua lly done by creating a new record and
then filling in each of the fields fo r that record. For a customer, this
might involve entering name, address, phone number, credit rating,
cred it limit, and other information that describes that particular customer.
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Performing Calculations
Not a ll info rma tion is directly t yped into a file. Whenever calculations
are required, it is frequently easier (and more accurate) to let the
computer do them for yo u.
for example, if you were a real estate agent an d wanted to add a new
house listing to your file, you could have fields set up fo r, among o th er
things, the length and width o f the house. Th en when you enter this
inform ation, the program could multiply the contents of these two
fields and store the square footage of the house in the ap propriate field .
You cou ld even have the cost per squa re foot calcul ated autom atically.

Adding Records
When you first defined the contents of the file, you m ight have en tered
the information you had available atthat time. Inform ation management
programs also all ow you to enter new in formation at any time after the
file is created.
If you a re running a business, you (hopefully) will have a steady strea m

of n ew customers discovering your store and purch as ing the items you
sell. The refore, the informatio n management program must allow you
to add n ew cu stomers.

Deleting Records
Not o nly does new informa tion present itself an d old information
chan ge, but also eventually som e information becomes obsolete. Suppose
you have a list of insured ho usehold item s, and one of the items listed
is a top-quali ty 35 mm camera. The camera was very expensive when you
bought it, but even with prope r care and attention it fi nally wore out.
Wh en you discard th e camera, it is a lso approp riate to d iscard the
information in the insured item s fi le.

Editing Records
The info rmation in each record will be as correct as it was when you
entered it, but, as we all know, things change.
Suppose you maintain a list of t he names and add resses of your friends.
Over a period of several years, ch ances are that many of them will have
different addresses from the ones you entered o riginally.
Informatio n management programs allow you to retrieve the reco rd
conta ining the inform ation on a particular frie nd, a nd then you can edit
any in formation stored in th at record. For example, if a frien d h as
moved to a d iffere nt state, t he street address, city, state, Zip code, and
telephone num ber will h ave to be changed .
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There is another reason that the ability to modify information contained
in a fil e is important. When the information was originally entered,
there is always the possibility that it was typed incorrectly. The program
h as to allow you to correct mistakes easily.

Retrieving Records
Information that has bee n entered into the computer is of little value if
you can't retrieve it at a later time. If you h ave a list of customers and
want to send a special mailing to all who live in a particular city or town,
you can have the computer search through the list and select only those
whose city matches the one in which you are interested. In this way you
can select subsets of the entire customer fi le. In this case, the subset is
the group of customers who live in a particular city.
You can also find a single record. Suppose you h ave a file that contains
inform ation on improvements t?at you have made to your house. At a
later time, you want to find the total cost of adding the deck. If the
improvement was entered as "deck", you can tell the program to find
the record containing "deck" and it would very quickly find the record
and show it to you on the screen.
You might also need to find information on a person, but you can only
remember part ofthat person's n ame. In manual systems, you would be
forced to look through each card until you found what you were looking
for, but in a computerized system, you can tell the computer to find all
names that match the portion you remember. The computer will do this
many times faster than you can.

Sorting Records
An info rmation management system can quickly sort an entire file, or
subset of the file, to display information in any order you want.
The records in a file are sorted into order by the contents of a ch osen
field, known as the sort field, o r the field on which the sort order will be
based . Common sort field selections include the name fields for alphabetic
sorts, Zip code field for printing mailing labels, amount-sold-this-year
field to find the best customers, and so on.
For instance, if you have a name and address file, and you want to group
the people by city, you could sort fi rst by city, then by last name, the n
by first name, and the informatio n would be sorted accordingly. If you
had the following list of names and citi es:
Wesley
june
Don
Dena
Diane
Luke

Myers-Smith
Kelong
Herring
Taylor
Herring
Kelong

~ew York

oston
1
l}tlanta
Boston
Atlanta
Boston
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The city, last name, first n am e sort command would give t he following
list:
Diane
Don
june
Luke
Dena
Wesley

Herring
Herring
Kelong
Kelong
Taylor
Myers-Smith

Atlanta
Atlanta
Boston
Boston
Boston
New York

Note that the people living in a particular city are grouped, and the cities
are presented in alphabetical order. Then, withi n each city group, the
people are sorted alphabetically by last name. If more than one person
has the same last name, they are further sorted by first name.
Sorting does not change the placem en t of the fie lds in the report, it just
modifies the order in which each record is d isplayed or p rin ted.

Creating Reports
Historically, the main use for an information management system was
to organize information so th at reports cou ld be produced. The
information was entered into the computer, and t he computer sorted
and selected the record s that met the specified criteria. Then, the
information was output in the form of a prin ted report.
Since thoseearly days, adiffe ren ttypeofuse has evolved. Mi nicomputers
and microcomputers led to an inte ractive fo rm o f information
managem ent. Interacti ve use of an informatio n management system
provides timely information on a specific sub ject almost immediately.
Th ere still are times, h owever, wh en printed re ports are more useful
than interactive access. For instance, your ba n k maintain s all of the
transactions affecting your checking account in its database, but at the
end of the month it sends yo u a prin ted statemen t so yo u can verify both
your set of records and the bank's. Any finan cial acco unting system
must maintain a paper trail, or series of printed reports, for auditing
purposes.
ln the next two chapters you will be introduced to two popular
information management systems for the Macintosh: FileMaker II and
HyperCard.

CHAPTER SUMMARY
• Each piece of info rmation is called a field or item. Several related item s that describe one
person, place, o r thing are called a record. Multiple related records may be grouped together
into a file. A database is composed of several related fi les.
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• Data is raw information. When data has been organized (processed) so that it becomes
accessible and useful, it is known as information.
• Businesses manage four major resources: money, materials, p eople, and information.
• Information must be correct and up-to-date to be use~ul. There is a time value associated with
information, because old information is not as valuable as current information.
• Different people in a business organization have different information needs. Information
management systems provide both interactive access and printed reports. Common reports
include detail, summary, and exception reports. In some cases, particularly financial
accounting system s, printed reports are n ecessary to provide an audit trail.
• What if ... analyses are used to answer questions about future possibilities. For users trying to
d evelop accurate projections, computers allow the examination of multiple scenarios such
as, "What if the inflation rate is 3 percent?" or "What if the inflation rate is 6 percent?".
• Early information management systems were known as file management systems because
information was stored in separate files that were not associated with each other. Later,
database management system s were designed to allow the information in several files to be
associated (or related), to reduce redundancy, and to allow easier updating of information.
• Info rmation in a database is stored on disk drives, so the information can be directly accessed
an d updated. Many computer system s communicate with other computer systems over
networks. Microcomputers are often connected over a local area n etwork to allow for sharing
of informatio n between computers and to allow interactive access to a centralized database.

KEY TERMS
com mon carrier

key fi eld

data
database
d etail report
direct access

local area network (LAN)

e lectronic data processing (ED P)
exception report
field
file
file maintenance
file management system
information
item

m anagement information system (MIS)
modem
rando m access
record
redumdancy
relational database
sequential access
sort field
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Chapter 11: FileMaker II
What You Will Learn in This Chapter
After reading this chapter and completing the projects in it, you
sh ould be able to:
•

Create a new file and enter data into it

•

Modify data in a file

•

Delete records

•

Find specific records and records that match one or more criteria

•

Create a new layout

•

Create calculation fields

•

Create detailed repo rts

•

Print reports

•

Link files together using lo okup fields

ileMaker is one of the best-selling information m anagement
programs for the Macintosh . It will do all the standard tasks found
in a program that manages information on a personal computer.
Unlike similar programs on most other computer systems, however,
FileMaker is designed for use on the Macintosh, and it takes advantage
of the Mac's graphics capabilities to help you create reports with visual
impact and style.

F

STARTING FILEMAKER

----

To start working with FileMaker, you need to have the FileMaker II
application and the Inven tory data file loaded into your com puter. The
Inventory file is included o n the Macintosh Journey Projects disk that is
Fil1?1'1.akl?r II
available for use with this book. (Project 1 in Chapter 1 tells you how to copy
all the files on the Projects disk onto your data disk.)
This Inventory file will be used later in Project 3. Let's open it now and
take a look at it.
.. Dou ble-click on the Inventory data file icon , as shown in
Figure 11-1.
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a

File

Edit

Uiew

.,

Special

Orooting Card Art

Trav•ling Tim•s Unformatt• d

~

Glossary

Trav•Hng Tim•s Logo

Yisual Eff•cts

~

0

lnv•ntory

Fig ure 11-1

~

Class Notos But tons

Mys tor y Docum• nt

Final Proj•cts

Opening Inven tory file from the desktop

In a few seconds the Inventory file will open and you will see a screen
like the one shown in Figure 11-2 (without the arrows a nd labels).

' 4 File Edit Select GiHl!JCH rormut Cus tom Wind ow
10
lnuentor

I 00 I
1002

WIPER BLADES
WIPER MOTOR
WINDOW BRACKETS

8.53
36.9 5
8.79
17.26
11.25
3 5.68
36.5 0
5.6 3
8.95
5.89

1. Slide control handle

2. Book

4. Status area
5. Fields

3. Active record Indicator

Figure 11-2

What's what on the FileMaker screen
I

The opening screen tells you a Jo t about the Inven tory file. The status
area shows there are 20 records ~ n the file, and the fi rst record is active.
The active record can be de te rm~ ned in two ways: the center page of the
book has the number 1 displayed, and the active record indicator (th e small
black a rea between the two vertical lines) is next to the first record.
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BROWSING THROUGH THE FILE
At this point you should see the first 12 records in the Inventory fi le on
your screen. This m eans that 8 more records a re not currentl y visible.
You can see the m by scrolling through the file.
There are two ways to scroll through the records. The first is to use the
slide control handle, and the second is to click o n the bottom page of the
book.
The slide control handle method (see Figure 11-3) will let you smoothly
and q uickly slide to a particula r record if yo u know the record number.
As you pull up or down on the slide con trol handle, the current record
number is displayed o n t he middle page of the book. When you release
the handle, the display scrolls to the record indicated in the middle book
page. This is particularly e fficient wh en you want to go to the first o r last
record in the fil e.

Records :
20
Figure 11-3

Records :
20

Records:
20

Changing active record with slide control handle

otice that the top page of the book is b lank when the first record is
active, and the bottom page is blank w hen th e last record is active. A
page with simulated text on it shows that the re are additional records
in that directio n.
The second scrolling method, clicking o n the bottom page, will take you
o ne record closer to the bottom of the file (see Figure 11-4). You can also
click o n the top page to move closer to the first record in the file.
Before

After

~t
~

Records:
20

Figure 11-4

Changing the active record by clicking on the book
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GETTING HELP
Whenever you are using a program such as FileMaker, there are times
wh en you haven't learned, or can ' t remember, the pro per procedures or
commands to perform. FileMaker li incl udes online help so you won't
have to stop what you are doing and find the information in the
reference manual.
'3€ -I

• Choose Help from the Apple menu (see Figure 11-5).
'Drue Edit Select
Rbout FlleMnke r .•.

(i<Jd~j(ll~

.'

II

XK

sEd it
Rein
Rlerm Cl ock
Calculator
Calcula tor+
Chooser
Control Pene l
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DeskDra w '"
DeskPelnt '"
OeskPainl'" 2
OeskPalnt '" 3
Olspl ey Messeg e
EHpresslonls t '"
e~o.

Cus tom

'

Window

E!ll
~

~YII~!Uil
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rornu1t
lnuentory

!!!kr.
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WI PER BLADES
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"
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5.89

:
:

'< L'<.

e oo T e<>

10

10121

(V I

Figure 11 -5

:
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Getting FileMaker help

This brings up the opening scree n for the help facility, offers some
inform atio n on using FileMaker, and allows you to open the Help file
(see Figure 11-6).

'D File

Edit

Select

Gadgeh l'ormut

Custom

Window

To ulew , edit, a dd, and dele t e re cord s, fi rs t choose Browse f rom
t he Sel ect M enu.
0 To type In a fi eld, press l ob or click In D fi eld.
0 To turn to another re cord, click o page In the book .
0 To odd or del ete r ecords, c hoo ~ e from the Edit m enu.
Sor

To find o group of r ecords, choose Find from the Select menu,
then type o re quest and click the Find button.
To re or der the r ecords, choose Sort f r om the Sel ec t menu.
To ch ange the eppeorance of rec ords f or display nnd for
printing, choose Layout from the Sel ec t menu.
To creo l e new fi elds, choose De fin e

Figure 11-6

rl om the Sel ect menu.
Ropen Help~ [cancel)

Opening the He p fi le

Click Open Help File.

"
,.:·;,

'i
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1f the r il eMaker Help file is not on your disk, you must quit FileMaker
a nd then copy the Help fi le from the distributi on disk into the folder on
your hard disk that conta ins FileMake r. The n you can re-enter File Maker
a nd again try open ing the Help file.
If you originally installed the Help file p roperl y, or if you just went back
and installed it, wh en you click the Open Help File button, you will see
the screen sh own in Figure 11-7.
File

j

r

Edit

Sel ect

G<HI(jeh

10

r ormut Cus t om

Window
0~

FlleMak er Help

~i

~

USING THE HELP FILE
To brovs r thro ugh tht He lp file :
Click ~ ~n of tht book on ttM' ltft to s u othe-r topics.
Ge-nwal information is .tt tht front of tht> fit.. Hon df.biltd VlformaUon is towards

-

tht

Rt-eords: :
69

b~k.

To choose- a topic:
Choou tht> topic you w ant from tht Custom
additional information .

m~nu.

Thtn o1ick pa9ts in tht book to s u

To c los• th• H•lp filt and r•turn to us ing Fne Haker :
Choou t:AJ:>~ from tht filt mt nu. (Or , lfl\ll~ thf Ht lp filt opt-n whllt 1,1 00 w-ork with
aMt~ f1lf ; choon tht fi~ you w.nt from tht- 'w'indov mtnu or UJt tht ~
command to opo9n tbt fi1t.)
FOf" more inform1Uon, SH tht pa~s of thf. Ff~tr mM~Ua1 rtft rtnetd at tht bottom

oftM serun
• To n~ othe-r r~cords on this topkl, click pagts of the- book • t tht top ltft of tht window.
• For mor• hf.lp on this toplO~ stt tht FlltM•ktr II Own.r's Manu• 1, pp . 82-83 .
• For htlp on otht r topios, choon tht topic IJOU ""¥It from tht Custom mtnu .

[L]

Bro~r~~st

Ql

Figure 11-7
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Using the Help file

If yo ur screen does not look like the one shown in Figure 11-7,
choose Using the Help File from the Custom menu.

The status area sh ows that there are a total of 69 records in the Help file.
If you want help on oth er topics, you can choose Scripts from the Custom
menu (see Figure 11-8). Or, to make it even easier, yo u can ch oose one
of the options available in the Custom menu.
r
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f o r instan ce, if you want more in ormation on understanding FileMaker
con cepts:
~ -2

•

Ch oose FileMaker Concepts fro m the Custom menu.
.i File Edit Select Gadgeh rormot Cus tom Window

![]

ii

FlleMBke r Hel p

~i
-
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69
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• For mort http on this topio 1 stt tht FlltM•ktr II Ownt r 1 S Manu al, pp. 7-16.
• For twlp on othtr topics, Moost tht topic lJOU Want from l.ht Custom mtnu .
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:;J J

FileMaker Co ncepts help record

Figure 11-9

This sh ows the first o f five records associated with this topic (loo k at the
status area below the book). Notice, at the end of the next to last line
o n th e screen, that yo u are told to see pages 7-16 in the FileMaker II
Owner's Ma nual for further help. Th is fi eld is upda ted for each record
in the help file, and it will tell you where to look for more info rmatio n
on each of th e 69 records.
If you can't fin d what you need Iis ted in the Custom menu, choose Find

in the Select menu and tell it wh at you wa nt to find in the Help file.
~-F

•

Choose Find from th e Select menu.

This b rings up the fo llowing screen (see Figu re 11-10), wh ere you can
enter your search criteria.
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Figure 11 -10

Finding in forma tion in th e Help file
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Now suppose th at you want to fi nd more informatio n on how to add
automat ic page numbers to a report.
.. Click in the field across the top of t he FileMaker Help window, th en
type Page Number as sh own at the top of the screen (see Figure 1110), and then click the Find butto n.
Th is finds o n e record with t h e information on page numbers and tells
you to see pages 184-186 in the reference manual (see Figu re 11-11).
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Figur e 11 -11
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Page n umberin g help

Read this screen to learn about the codes used to add the current time,
date, page number, and record n umber to any layout.
Take a few minutes n ow to look through th e Help file and familiarize
yourself with what is available an d where you can fi nd it.
Wh en you are finish ed with t he Help file, you can close th e FileMaker
Help window and go back to using the Inventory file. Wh enever you
close the Help file, you will be returned to whatever file was in use before
you asked for h elp.

:3€: - W

,,. Close the Help file by clicking in the close box.
Th is brief overview o f the Help comman d sh ould give you a start in
using this h an dy feature p rovided with FileMaker.

489

Chapter 11: FileMaker

SAVING YOUR WORK
Unlike other programs, information management applications such as
FileMaker h ave n o Save command. Since the application is design ed to
allow you to enter and update information, your work is saved
automatically by the program.
When you create a n ew file, yo u are given the opportunity to specify the
nam e of the file, the drive on which to store it, and the folder (if any)
in which it will be saved. Then, ~s you work with the file, FileMaker will
save it for you pe riodically.
This has som e good features, as well as a couple of potential problems
of which you need to be aware. When everything works correctly, you
will not lose any information. That's good. However, when something
goes wrong, it may d amage a FileMaker data file. There are two ways to
guard against serious problems with your data file: backing up the file
and saving a copy of the file.
You must re member to make a backup copy of any file that contains
importan t informatio n when working in FileMaker.
The first reason for backing up is to make an insurance copy of the file
in case of computer, di sk, o r power failure. If your equipment fails you
can lose important information. Making backups is th e only way to keep
from losing information.
The second reason is important whenever you use a program that
a uto m atica ll y saves yo ur work for yo u, especially when every
modification to a file is n o t saved when you make the chan ge. FileMaker
can tell wh en you are not working with the file . When you take a break
or stop to talk to someon e or to read something and you are not actively
using FileMaker, it will take this time to save the file. It does not save
every modification immediately after the change is made.
There are times (between when FileMaker last saved your fil e and you
take the next short b reak) that the file on the disk does n ot m atch the
work you h ave done. You might1h ave made some important ch anges to
the fil e since the last time it was saved. If the power goes out, there is the
potential that your file might be damaged.
Anoth er action that can damage a file is to stop working while FileMaker
is running and just turn off the computer (before FileMaker has a chance
to save your last modifica tions to the file). Many computer users
develop this bad habit when wo~king with other programs. For example,
you could o pen MacPaint, c rea~e a painting, save it, print it, and just
turn off the computer. Chances are you would n ot encounter any
problem s by do ing this.
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However, this is a ve1y bad /whit. When you are using a computer as
sophisticated as the Macintosh, you must follow proper procedures to protect
yourself from losing data. Always choose Quit to close an application, and
then choose Shut Down before turning off power to the computer.
Wh en using FileMaker, it is imperative that you quit the program
properly. When yo u close a file, it is updated so t h at the copy on the disk
matches what is in the computer's memory. When you choose Qu it,
FileMaker will update any open files.
If you do not fo llow these procedures, you are leaving you rself op en fo r
problems. The easiest way to avoid problems is to backup your work and

quit FileMaker properly.
FileMaker also allows you to save a copy of the file at any time while you
a re working. (This is si milar to the Save As command in other programs.)
Saving a copy of the file you are using is a good h abit to develop. In this
chapter, you w ill be reminded to save a copy of a fil e when you have
made major modifications to it, but you will not be reminded to make
backup copies usin g the Finder.
Naming and deciding whe re to store a file will be covered wh en you
create a customer fi le in Project 1. You will be introduced to savi ng a
copy of a fi le after you enter data into that file.
This concludes th e introduction to FileMaker. Before you continue with
Project 1, you sho uld close the Inventory file.

3€ - W

, . Ch oose Close from the Hie m enu.

Project 1: Creating a Database
Let's suppose that you are the owner of B & K Auto Parts, a store t hat sells
to custo mers around the country. You publish a catalog a nd adverti se
in a number of large cities. Som e of your customers are individuals, and
oth ers are businesses that use or resell the parts they purchase from you.
You want to use file Maker to keep track of customers and inventory and
to automate th e productio n of invoices when customers place o rders.
In Project 1, you will create a Custom ers file. You will learn how to define
the fie lds for each customer, enter data, format the fields for proper
disp lay, edit the data, and print the contents of the fi le.
In Project 2 yo u w ill learn to print detail ed reports based on information
in the Customers fi le. In Pro ject 3 you will create the Sales Invoices file,
and yo u will learn to interconnect files and create invoices using
inform atio n looked up in the Customers and Inven tory files.
In these th ree pro jects, you will learn the basics of using FileMaker.
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PREFIX
FIRST
Ml
LAST
TITLE
COMPANY
ADDRESS
CITY
STATE
ZIP
COUNTRY
AREA CODE
PHONE NUMBER
ENTRY DATE
CUSTOMER NUMBER
BUSINESS TYPE
REGION
PREFIX
FIRST
Ml
LAST
TITLE
COMPANY
ADDRESS
CITY
STATE
ZIP
COUNTRY
AREA CODE
PHONE NUMBER
ENTRY DATE
CUSTOMER NUMBER
BUSINESS TYPE
REGION

Ms.
Sandra
M.
Hardin

497 Seemore Drive, Apt. 3.
Asheville

NC
29702
234
555-2922
7/ 11 /86
1001

Mr.
George
M.
Lapmont
Manager
Bell Tires
2354 78th Avenue
Bellvue
WA
71356
651
555-2654
10/21 /86
1002
Tire Dealer

Figure 11 -12

1

First page of Proj ect 1
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SELECTING WORK MODES
Th ere are five work modes in FileMaker tha t allow you to do all of the
standard info rm ation managemen t tasks, as presented in Chapter 10.
Th ese modes are accessed by choosing o ne of them fro m th e Select
m enu, and the currently selected mode is indicated with a ch eckmark
(see f-igure 11-13). A brief overview of these commands follows.

Figure 11-13

r il eMaker's Select menu

Define
TheDef711ecommand is used when creating a new file or when modifying
the structure of an existi ng file. This lets yo u de fin e what fi elds make
up the records in the fi le and what types of info rm ation can be stored
within those field s.

Browse
The Browse m ode lets you view the information conta ined in a file. In
additio n to looking at the information, you can also add new data,
delete records, and modi fy data.

Find
Fi11d allows yo u to tell the computer what informatio n you wan t to find,
and the computer then searches all the records and selects o nly the ones
that match the criteria you provided. You can o ptio n ally omit records
tha t contain specified information as wel l.

Sort
If you want to access or present info rmatio n in a specific o rder, you use
the Sort command. This a llows you to specify the fields that will be used
to so rt the fil e. Yo u can sort alphabe ti ca ll y, nume ricall y, or
chronologicall y, in ascending o rdescendingorder. You can also specify
mo re tha n o ne sort field.

Layout
If you want to look at the information in a diffe rent manne r, you use the

Lnyout mode to design a different view. You can't change the contents
of a field in the layout view, but you can ch ange the position and
appearance of fie lds, graph ics, and text. This new view the n can be used
for browsing through the informatio n and fo r printing reports.
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DEFINING FIELDS
As discussed in Chapter 10, a field is the lowest level of information
storage in a file . You can desigrl a record in FileMaker that con sists of
more than one field. Once all the fields have been defined (a process
consisting of naming the field, specifying its type, and choosing any
entry options), you then can enter information into the fields.
All records in the file have the same fields, but the contents of those
fields in each record can be (and usually are) different. The data file is
the collection of all the records ithat have been entered.
The process of creating a ne""' data file consists of defining fields,
formatting fields, and entering information into one or more records.
Each record in the Customers file will contain information about one
customer. After you define all the fields and exit the definition mode,
you will automatically change to browse mode. FileMaker will create the
first record, and you then can enter information about the first customer.
What types of information need to be stored for each customer? You
need to enter the customer's name, address, and phone number, at least.
It might also be useful to know !w hen a customer was entered into the
file, so you can determine how long that person has been a customer,
and to assign a unique identifying number to each customer.

Field Types
Each field can hold only one type of information: text, number, date,
picture, calculation, or summary. Each field type is explained below.

Text
Text is a versatile type of information. It can hold anywhere from one
character to as many as you ca~ show on your layout. When you enter
text into a text field, FileMaker automatically wraps any word that doesn't
fit onto the next line. If you wi~h, you can press the Return key to end
a line or to create a blank line. This lets you organize your text into
paragraphs.
Fil eMaker can sort text fields alphabetically in ascending or descending
order based on the information at the beginning of the field.
FileMaker automatically creates an index of each word in a text field so
you can find records containin any word you need to find in any text
field of the file. Even though yoJ. can type up to about 32,000 characters
in a text field, you will find th~t Fil eMaker will slow down when you
access files with very large fie! s. For this reason it is best to keep text
fields relatively short.
Number

A number field also can contain as much information as you care to enter,
1
but it must be on only one r e. Only the numeric portion of the
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inform a tion is indexed, and FileMaker Jets you find a particular number
o r a number within a certa in ra nge that you specify.
Number fields m ay be sorted in increasing or decreasing order by value.
Number fields m ay be auto matically formatted to include commas,
dollar signs, and percent signs. You also can specify h ow m an y digits
you want to appear to the right of the decimal p oint. Fo rmatting
n um ber fields in FileMaker is similar to formatting cells in Excel.
In addition to specifyi ng a format , you can tell FileMaker to treat a
number field as representing a logical Yes or No. A value o f zero
represents No, and an y non zero value represents Yes.
Number fi elds can be used in calculation s. By putting the name of the
field in a calculation or summary fo rmula, you can tell FileMaker to
calculate other resulting values, such as how m any item s are on an
invoice, the sales tax am ount, and the total amo unt of the sale.
An y formatting that is in effect in a number field only affects the display.
Th e unformatted value is used in any calculations or summaries and in
a ny find or sort op eratio n s.

Date
You can enter a d ate by typing the numeric values for the m onth, day,
a nd year. Dates m ay be entered in th e fo rm 7/4/92or 7-4-92. These d ates
are then indexed so you can find an y specific d ate or an y date within a
specified ran ge of dates. Date fields m ay be sorted chron ologically in
norma l (ascending) o r reverse (d escen d ing) order.
Like num ber fields, date fields can be form atted in several differen t
styles. The sh ortest format is "7 /4/92" and the lon gest is "Saturday, July
4, 1992".
Date fields can be used in calculat ion an d summary formulas. For
example, to determine how lon g a custom er h as been a customer, you
can subtract the date they were entered in to your Customers file from
today's date.
Any d ate entered into a date field must include the m onth, day, and year
values. This restrictio n exists so that date calculation s will return the
correct results. If you want to store t he m onth, year, day of the week, or
any oth er subset of a date, you sh ould enter it into a t ext or number field.

Picture
A picture field lets you store a ny graphics image you can cut or copy from
any appli cation o r desk accessory. You cut or copy the p icture and then
past e it into the pictu re field .
Picture fields cannot be sorted , n o r can you do a find on the information
they contain.

495

Chapter 11: FileMaker

If you need to find information contained in a picture fi eld, yo u must
add a separate text field, where you can en ter a descript ion of the picture
field's contents. This separate text field can be used as a n index fo r
sorting or finding the contents o f the picture field .

Calculation

Calculation fields let you enter a formul a that will determine a value
based on other fields within the sam e record. Formu las can result in text,
number, or date results. These results can be form atted using the
appropriate formats for the type of resu lt the calcula tion produces (such
as text, number, or date). You can also use the results of a calculation
field in another formula in a different field.
Data cannot be directly entered into a calculation fie ld. All calculation s
are automatically updated whenever a field con tain ing a value that is
used in the formu la is modified.
All values resulting from formulas in calculation fields are automatically
indexed in FileMaker, so you can use the Find com mand to locate
specific information. You can also sort the file into alphabeticaC
numerical, or chronological order, based on the results displayed in a
calculation field.

Summary
A summary field is different from the calculation field in a very important
aspect. Calculation fields let yo u compute values using fields within the
same record only. Summary fields let you compute values using the
contents of one field spanning a group of records.
For example, you can use a calculat ion field to calculate the tota l
amount of the sale for one invoice and a summary fi eld to summarize
the total amount of all sales for the group of records cu rrently being
browsed.
Unlike a calculation fi eld, which can contai n an y formula you can
construct, a summary field allows you to choose one su mmary formula
from a predefined list consisting of average, count, fraction of total,
maximum, minimum, standard deviation, o r total.

The results shown in the summary field will change, depending on the group
of records currently being browsed. If you a re browsing the entire file, the
summary applies to all records in the file. If you a re browsing a subset
of records as the result of a find command, the summary applies to only
the records in that subset. Whe~eve r yo u mod ify information in a field
being summarized, or when yo add or delete a record, the summary
will be recalculated.
Summary fields are also differe t from calculation fields because the
values they calculate cannot be used as input into other calculation
formulas.
I
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Files cannot be sorted and specific records cannot be found based on
summary fields, because summary fields contain information that
applies to groups of records and not to specific records.
Now that you know something about what can be put into each type of
field, let's create the Customers file, define its fields, and enter the
customer records.
The first step in this process is to tell FileMaker that you want to create
a new fil e.
•

Choose New from the File menu.

FileMaker presents a dialog box so you can name the new file and
indicate where it is to be stored (see Figure 11-14).

Q Cl<hs Notl~s !lu11on~
CJ Fin al Projects
D (i<mo's Menu llnforrnd1l<HI

.·.:.:,!_i_•

[.) (iJ<J~Silr~)

Ori1.1e

D (inH!1ill9 C<tnl flr1

D

lrw(~n1or~J

D M<mu flrtwork
Cr eol e o new file n amed:

Icustomer~

Figure 11 -14

Cancel

New file d ialog box

,,. Name the file Customers, and make sure that it will be stored on
your data disk. Click New to create th e file.
FileMaker creates the new file and then opens the Field Definition dialog
box (see Figure 11-15).

s

File

Edit

em

(iddiJeh

rormot

Custom

Window

Cus tomer s
Field Definition

Field name:

Figure 11-15

Field type:
@ TeHI
O Numbe r
0 Dote
0 Pi cture
0 Calculation
0 Summary

:l€T
:l€N
:l€0
:l€P
:l€C
:l€S

[ Deselect J [

OK

[ tlt~l!~ tP ] [

[Hit

Field Defin ition dialog box
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Th e first field that you enter is a text field that will be used to store the
pre fix to be attach ed to the customer's name. The field type de faults to
Text, and that is what you want for the first several fields.
FileMaker has no rules about the way you capitalize field names. Some
peopl e prefer to capitalize all letters in a field name, others prefer to
capita lize o nly the first letter in each word, and oth ers prefer to use all
lowercase letters. Unlike some other database programs, FileMaker lets
you capitalize the names to suit yourself and also allows you to enter
spaces between the words in the field names.
In Pro ject 1, it is suggested that you use all capital letters in the field
names to easil y d istinguish between field names and other information
in the project. Pro ject 2 adds three more (calculated) fields to the
Customers file, an d it is suggested that you capitalize the fi rst letter of
these fie ld names, so you can easily disti ngu ish between the fields th at
contain calculated resul ts. Th e rest of the p ro jects in the chapter suggest
capitalizing th e first letter of each word in th e field name.
You ca n choose a style you like and name the fields to suit your
preferen ces as you con tinue to use FileMaker in othe r p ro jects after
completing this chapter.
Yo u st art definin g the fields by enteri ng th e n ame of the first field .
.. Enter PREFIX in the "field name" box. Click OK.
Depending upo n the customer, this prefix can ta ke such values as Mr.,
Ms., Mrs., Dr. , Rev., and a n umber of others. Most of the common
prefixes are in the list just mentioned.

Entry Options
In addition to providing six types of field contents, FileMaker provides
a number of en try options for fields. Thi s means that FileMaker
autom atica ll y enters som e values, provides lists from which you can
ch oose others, and checks to see that the conten ts of a fi eld m eet certain
criteria that you ca n specify.

Field Value List
In this case, you want FileMaker to display a list of name prefixes from
which you ca n choose. This makes data entry faster an d helps lo avoid
typographical and spell ing errors . Let's tell FileMaker to d isplay a list in
t he prefix fie ld.
When yo u clicked the OK button, FileMaker placed the field name an d
type in the list at the top of the Field Defin ition dialog box. You can see
PREFIX and Tex t in the upper box now.
•

Click on PREFIX to select it, and then click Entry Options.

rileMa ker d isplays the Entry Options dialog box for the PREFIX field (see
Figure 11-16).
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Loolc up ualue from another file [ Change lookup J

Figure 11-16

•

QO ~

Entry options for the PREFIX field

Click Display a list of values:.

An "X" appears in the check box to show that this option is active. Now
add the list of titles to be displayed in the PREFIX field. You should enter
one title per line, and press the Return key to go to the next line. Don't
press Return after the last title.
•

Enter Mr., Ms., Mrs., Dr., and Rev. in the list on separate lines (see
Figure 11-16).

When you have entered these values and checked that they are entered
correctly, you can accept this list and continue defining other fields.
,,,. Click OK.
When you return to the Field Definition dialog box, the word "List" has
been added on the right side of the line containing "PREFIX" and
"Text".
You have now learned how to name a field, choose the type of contents
for that field, and choose entry options for the field.
Now, you can continue defining the customer's name. Most customers
have a first name, a middle initial, and a last n ame, but you might be
tempted to enter the entire n ame into o ne field. You will find that it is
easier to use a separate field whenever possible for each piece of
information you might need to access. Separating the name into three
fields allows you to easily access any portion of the name. For example,
if you want to address somebody using their prefix title and last name,
it is easier to do if these parts of the name are in separate fields. Later,
in Project 2, you will add a calculation field to calculate the full name
(except for middle initial) based on the information in the three name
fields you will now define.
Let's start with the first name. Remember, the default field type is text,
so you don't have to ch oose the style for these fields. You will not add
any entry options to the first name or middle initial fields.
,. Type FIRST in the "Field name" box and click OK.

499

Chapter 11: FileMaker

Now defin e the middle initial field.
•

Type MI for the fi eld name,l and then click OK.

Field Requirements
The last nam e will be defin ed like these other fields, with one exception.
You want to be sure that every customer has a name entered before the
record is saved in the file. There may be times when you won't know the
first name or middle initi al, but you must enter at least the last name for
a custo mer before adding a record to your data file.
This is n ot a restriction th at fil eMaker imposes; rather, it is added here
to en sure the integrity of your data. You can tell FileMaker that the last
name fie ld must contain information before it is acceptable for saving
in the fil e. If you mistakenly omit entering a last name, FileMaker will
detect this mistake and tell you. Since this is an option for entering
information into th e fi eld, you need to add an entry option for the last
n ame fi eld.
•

'

Enter LAST for this field's name (see Figure 11-17), and then click
OK.
4i File Edit
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Figure 11-17
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Defining the last name field

Select the last n am e fi e ld, and click Entry Options (See
Figu re 1 J -17).

In this case, all you want FileMaker to do is ch eck th at a value h as been
entered into the fie ld. There is no way for FileMaker to know if the last
n ame is a valid name, but it ca n check to see that som ething is in the field
before accepting a record.
On the right side of the Entry Options dialog box is a list of check boxes,
below t he phrase "Require field to contain a:". The first item is "Value,"
and this is the on e you want to se lect.
•

Cli ck Value to select it, and then click OK (see Figure 11-18).
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Figure 11 -18

Requiring a value in the last name fi eld

The next nine fields all contain text, and none have any special entry
options.
,.. Define the following text fields: TITLE, COMPANY, ADDRESS,
CITY, STATE, ZIP, COUNTRY, AREA CODE, and PHONE NUMBER.
You should see a list of fields in the upper box with the word "Text" next
to them. It is important that the field names are spelled correctly as listed
in the instructions . If you make a mistake, select the field, a nd correct
the name.

Automatic Entry
Th e next fie ld to b e entered is a date field, and it will contain the date
when the customer was entered into the Customers file. This date will
be automatically en tered by FileMaker through th e use of an entry
optio n.
,,. Click Date, and name the field ENTRY DATE. Click OK (see
Figure 11-19).
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Figure 11-19

TeHt
TeHt
TeHt
TeHt
TeHt
TeHt
TeHt
leHt
Fie ld type:
O TeHt
O Number
@Do t e
0 Picture
0 Cal cu l ation
0 Summary

En t qjllp tions

]

XT
XN

xu
XP
XC

xs

[ oesel ect)
[

()!~ll'tf'

L ~~

l [J iiit"]

Defining the ENTRY DATE field
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Now, let's add the entry option fo r the field.
•

Select the field and cl ick Entry Options.

You can choose to h ave FileMaker automatically enter values for you
when a n ew record is added to the file. On the left side of the Entry
Options dialog box are three options. Under the p h rase" Auto-enter in
each n ew record: " is a "Today's date" check box.
All Macintosh computers h ave a clock and a calendar that run all the
time. (A battery supplies power wh en the computer is turned off or
unplugged.) The current date and time can be set using the Control
Panel desk accessory. FileMaker can check this calendar to determine
the date. It is up to you to be sure the clock and calendar are set correctly,
and don't forget t o change the clock if you live in a state with Daylight
Savings Time.
Ch oosing the Today's date op tion te lls File Maker to enter th e date that
it finds in the system 's calendar into the ENTRY DATE field.
•

Click Today's date, and then click OK (see Figure 11-20).
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Choosing automatic entry of today's date

Th e n ext field is a number field where FileMaker will automatically enter
a unique iden tifying nu mber for each customer. Let's tell FileMaker to
make the first customer n umber 1001 and then sequen tially n u mber
each customer after that.
Start by telling FileMaker th at th1s is a number field, and then enter the
name.
•

Click Number, name the fie I CUSTOMER NUMBER, and th en click
OK.

Now add the entry options.
•

Select the CUSTOMER NUM ER fie ld a nd click Entry Options (see
Figure 11-21).
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Adding entry options to the CUSTOMER NUMBER field

In the last field, ENTRY DATE, you told Fi leMaker to automati cally enter
the current date . In this field you w ill tell FileMaker to enter a n ew serial
number, starting with 1001.
,. Click A n ew serial number:, and enter 1001.
You want to be sure each customer number is different, so you need to
tell FileMaker to allow unique values only in this field.
•

'

Click Unique value only (see Figure 11-22). Now click OK to accept
these entry o ptio ns.
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Choosing entry o pt io n s for unique number

Many of your cu stomers represen t a business, so it is useful to en ter the
business ty pe for each business customer. Thi s is ano ther case wh ere a
list of va lues is helpful.

•

Create a n ew text field na med BUSINESS TYPE, and open its Entry
Options dialog box.

Now, enter the list of values available for this field .
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•

Click Display a list of values:.

•

En ter th e following items
th e list : Auto Body Repair, Auto
Dealer, Car Wash, Glass Repa ir, Mechanic, Tire Dealer, and Welder
(see Fig ure 11-23). Click OK.
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Specifying a Jist of item s for BUSINESS TYPE

A majo r ben efit o f using a Jist fo r entering info rmation into the fi eld
becom es obvio us when you try to find all customers who represent a
particul ar type o f business. By choosing from a list, you know that the
type o f business is en te red exactl y the same each time. Then if you tell
FileMaker to find all records whe re the business type is Tire Dealer you
ca n be confide nt th at it will find a ll occurren ces and no t miss an y
beca use of typographi cal erro rs o r because some were entered as Auto
Tire Dealer, fo r exam ple.
If th e business type is n ot in the li st, you can still typ e an entry into the
fi eld . Wh en you fin d that you have entered the same business type
severa l times, yo u ca n choose to define fields, and add the n ew business
type to the list.
Th e last fi eld you will define fo r the Custo m ers file is the REGION field.
Yo u have n o t yet divided your service area into regio ns, but sometime
in the near future yo u plan to do so. Let's set aside a fi eld fo r later use.
You plan to o rganize your cu sto m ers into nine regions, numbered 1
through 9, a nd yo u wan t to store this number fo r each customer.
Additio n ally, you want FileMaker to verify that the regio n number is in
this specifi ed range. This can be accomplish ed by requiring the fie ld t o
conta in a value in t he ran ge from 1 to 9 only.
•

C reate a new number field n am ed REGION.

•

In t he Entry Option s dialog box, click Value in range only, ente r
1 in the "from: " box, and then enter 9 in the "to :" box (see
Figure 11-24) . Click OK.
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Specifying a range of values for the REG ION field

You h ave now d efined all of the fields for this fil e.
•

When you return to the Field Definition dialog box, click Exit.

•

Click anywhere on the bold field titles on the left to deselect the
record.

FileMaker will ask if it is ok to allow the LAST field to remain empty.
When you defined t he fields, you told FileMaker to be sure a value
existed in the last name field before accepting a record. In a few
moments, you will enter information into this record, but, for now, tell
FileMaker it is ok.
•

Click OK.

FileMaker will create a default vertical layout showing the fields in the
order they were entered, and will create the first record (see Figure 1125). In Project 2 you will learn how to change the formats of the fields
and create three new detailed layouts for use with this file. For the
remainder of this project, you will use the default layout created for you
by FileMaker.
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Notice that the entry date and customer number have already been
entered by FileMaker. (Your date should be different from the one
shown in the figure.)
You have done a significant amount of work now, so it is a good time
to save a copy of this file.
•

Choose Save a Copy from the File menu.

FileMaker gives you three choices for the copy: Copy of this file,
Compressed copy, and Clone (see Figure 11-26).
r
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Three choices for saving a copy of the Customers file

Figure 11 -26

The first option is the default, and it is the one you will choose this time.
•

Click OK

FileMaker will suggest naming this file Copy of Customers and will place
it o n the same drive and in the same folder with the Custom ers file (see
Figure 11-27). This is what you want to do.
~
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Figure 11-27

Saving a copy
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•

Click New to create the new file.

ENTERING DATA
Now that you have defin ed all the fie lds that are necessary for th is file,
it is time to create n ew records an d enter data. FileMaker created th e first
(mostly) blan k record when yo u exited from initially defining the field s.
It h as already entered the curren t date and the customer nu mber (1001).
The oth er fie lds are blank an d will remain blank until you e nte r the data.
Let's enter the name and add ress o f your fi rst customer.
To begin ente ring data, yo u h ave to activate th e list in the PREFIX field.
•

Click to the right of th e PREFIX field label.

Clicking in the area wh ere the fields are located activates t h e record.
Wh en you click in t he PREFIX field, all the fields in the record are
o utlined with dotted lines. Th e PREFIX field is a text field with an en try
list, so the list becomes visible (see Figure 11-28) .
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Figur e 11 -28
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Ente ring the prefix data

Th e first customer is Ms. Sandra M. Hardin, so let's enter her name.
•

Dou ble-click on Ms. to en ter it into the PREFIX field .

When you select from a list, FileMaker en ters what you selected into the
field and then moves the insertion point to the beginnin g of t h e next
field, in this case, t he first n a me fie ld.
•

Type Sandra in to the fi rst name fi eld, and then press t he Tab key.

Wh en you enter th e n ame, the insertion point remains at th e end of the
field . You can choose between two methods fo r moving to the next field .
As with most operations o n the Macin tosh , you can cl ick on a field with
th e mouse to activate the field and move the insertio n point. In this
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case, there is a faster way, and t hJat is to press the Tab key. Any time you
press the Tab key, the contents 9f the current field are accepted and the
next field in the record becomes the active field. In this case, pressing the
Tab key moved the insertion point to the beginning of the middle initial
field.
,.. Type M. in the middle initial field, and then type Tab.
Now the insertion point should be at the start of the last name field.
,. Type Hardin, and then tab to the next field.
Ms. Hardin, as your customer, does not represent a company, so you
won't enter a title or company. The next information is to be entered
into the ADDRESS field.
,. Press the Tab key until the insertion point is in the ADDRESS fie ld.
Ms. Hardin's address is 497 Seemore Drive, Apt. 3, Asheville, NC 29702.

u•

In the ADDRESS field, type 497 Seem ore Drive, Apt. 3, and then tab
to the CITY field.

,.. In the CITY field, type Asheville, and then tab to the STATE fi eld.
•

In the STATE field, type NC, and then tab to the ZIP field.

•

In the ZIP field, type 29702, and th en tab to the next field.

Ms. Hardin lives in the United States so you don't have to enter anything
in the COUNTRY field. Her phone number is (234) 555-2922.
•

Tab to the AREA CODE field and enter 234, then, after moving to the
PHONE NUMBER field, enter 555-2922.

FileMaker has already entered the entry date (yours will show the
curre nt date) and the customer number (1001). The first eight customers
you will enter are old customers; some have been customers for several
years. After entering those customers, you will enter a couple of n ew
customers. In the case of a new customer, you will accept the entry date
that is automatically entered. For som eon e who already is a custo m er,
you can override the entered date and type in the correct one. Let's do
that for Ms. Hardin.
.. Tab to the ENTRY DATE field and press Backspace (or Delete) to erase
the automatic entry.
,. Type 7/11/86 for her entry date.
lf yo u would like to see the rest olf the record, you can click on the down
a rrow in the scroll bar. Click on the up arrow in the scroll bar to return
to the top of the record.

Visually inspect the information you have entered, a nd compare it with
the record shown in Figure 1 ~-29 . If you have made any mistakes,
click in the field with the error and correct your mistake.
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The next customer is Mr. George M. Lapmont.
•

Enter Mr. by double-clicking on it in the list, then enter the rest of
his name in the appropriate fields. Don' t fo rget to press the Tab key
to move to the next field.

Mr. Lapmont is the manager of Bell Tires, which is a company that
purchases from you regularly.
•

Enter Manager in the TITLE field and Bell Tires in the COMPANY
field.

Bell Tires is located at 2354 78th Avenue, Bellvue, WA 71356. Their
phone number is (651) 555 -2654.
•

Enter 2354 78th Avenue in the ADDRESS field, Bellvue in the CITY
field, WA in the STATE field, and 71356 for the ZIP field.

•

You don't need to enter a country, so skip that field by using the Tab
key. Enter 651 in the AREA CODE field and 555-2654 in the PHONE
NUMBER field.

FileMaker h as already entered the entry date and customer number into
the record, but you n eed to change the entry date.
,. Replace the date entered by FileMaker with 10/21/86.
,. Activate the BUSINESS TYPE field by moving to it using the Tab key
or by clicking in the field with the m ouse.
When the BUSINESS TYPE field becomes active, it shows the list you
defined. Bell Tires is a tire dealer.
•

Click on the down arrow in the busin ess type list to scroll down until
you can see Tire Dealer. Double-click on Tire Dealer to enter it into
th e field (see Figure 11-31).
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Now yo u can visually veri fy that the inform ation o n this custo m er is
entered correctly (see Figure 11-32).
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Completed second record

When you a re sure the informatio n is correct, acce pt this record and
create a new on e.
3€ -N

•

Choose New Record from the Edit menu.

The next custo m er to be entered is Mr. j im Bell, who lives at
1492 Document Drive, Mandarin, FL 49709. His phone number is (203 )
SSS -2731. His date for becom ing a customer was 11/01/86.
•

Enter the information for this customer into the proper fields.

When you have completed entering this data, check you r entry again st
the record as shown in Figure 11-33.
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When thi s information is corrJct, create a new record and enter the
information for your West Coast attorney, Ms. Kay B. Kusunoki.
3€ -N

•

C hoose New Record from the Edit m enu.

•

Type the attorney's name in the appropriate fie lds, a nd then type
Attorney in the TITLE field.

Ms. Kusunoki's address is 7531 Second Street, Sa n Franc isco, CA 92846.
He r phone number is (978) 555 -2383. Her en try date sh ould be
01/14/87.
•

Enter the address a nd pho ne number into the prope r fie lds.

Veri fy that you have entered this data correctly (see Figure 11-34).
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753 1 Second Street

Sen Francisco
CA
92646

Comple ted record for Ms. Kusunoki

Using what you have learned about en tering new customers, enter
t he four custome rs listed below:

Ms. Faye Mau ney
15 \1ockingbird Lane
Pine log, TX 69007
(833) 555-0927
10/ 19/87
Mrs. Mattie L. Dilbeccio
Own er
Grape C reek ew and Used Cars
14709 Main Street
Grape Creek, C 28087
(702) 555-1 092
11/06/87
Auto Dealer
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Dr. Jose S. deAngello
11 7 Third Street
Apache Junction, AZ 78273
(604) 555-7826
08/06/89
Mr. Gary H. Westmoreland
Owner
Western Carolina Welding
2741 Highway 141
Peachtree, NC 28915
(703) 555-1 273
09/29/90
Welder
You should now see Mr. Westmoreland's information on the screen (see
Figure 11-35).
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Completed record for Mr. Westmoreland

.. Now, enter two more customers, using information of your choosing.
Accept the entry date entered by the computer.
This demonstrates how FileMaker can enter the date for you automatically
for convenience and accuracy but still offers the flexibility to enter other
information in the field if needed.
.. When you have completed entering these six names, click on the
last record, anywhere to the left of the fields to deactivate the record.
When you click outside the area of the screen that con tains the fields,
the fields are no longer outlined (see Figure 11-36).
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The last record has been entered.

This is a good time to save a copy of this file. Choose Save a Copy
from the File menu, name it Copy 2 of Customers, and click New to
create the new file on your data disk.

You now have the current Customers file and two backup copies on your
data disk.

EDITING DATA
FileMaker lets you modify information in the fil e at any time. Standard
Macintosh editing techniques are used to select, modify, and delete text
in a field.
Since you can modify information in a field at any time, there are times
when it is easier and faster to duplicate a record and then edit the
information in some of the fields.

Duplicate Record
You have now entered ten customers. In this case, none of the customers
that you were entering had similar data. Sometimes, however, you will
enter a series of customers who have several fields containing the same
information. When this situation arises, you can frequently save time
by duplicating a record rather than creating an entirely new one.
Let's say that you need to add information on the following customer
(don't enter anything yet):
Mrs. june Brooks
Route 4, Box 199
Pinelog, TX 69007
(833) 555-0835
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Finding a Record
Before you add the customer, you remem ber that you already have at
least o ne customer in Pinelog, Texas, and some of the information in
that customer's record will match this one. Let's find that customer.

3€ - F

•

Choose Find from the Select me nu.

FileMaker presents you w ith the Find screen, which looks like a blank
record (see Figure 11-37).
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FileMaker's Find screen

The PREFIX field is showing its list, bu t you are not going to enter
anything in tha t fie ld. You want to fin d a ll customers w ho live in a city
named Pinelog.
•

C lic k in the C ITY fie ld and type Pin elog. C lick Find (see
Figure 11-38).
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Entering the search criteria

SIS
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By entering Pinelog in the CIT field, you tell FileMaker that you are
only interested in any record ith that name in that field. You can
further restrict the search by entering information in other fields.
When you click the Find button, FileMaker finds all records containing
Pinelog. It finds one customer who lives in a city named Pinelog: Ms.
Mauney. This is the same city where Mrs. Brooks lives, and looking at
both addresses tells you that, indeed, several fields will contain the same
information. In this case, it makes sense to duplicate Ms. Mauney's
record and modify it.
S€ -D

•

Choose Duplicate Record from the Edit menu.

Notice that this record looks just like Ms. Mauney's original record,
except that FileMaker has given it a different customer n umber already.
Now you have to ed it the fields that contain different information.
The PREFIX field is already active and showing its list. You need to
choose Mrs. from the list .
, . Double-click Mrs. to enter it in the PREFIX field.
•

Double-click on the first name field in the record and type june to
enter it as the first n ame.

, . Double-click on the existing last name and type Brooks to enter it
in the last name field.
.. Select the entire ADDRESS field by double-clicking on the first word
in the address, holding down the mouse button, and dragging to the
right until all the address is selected. Type Route 4, Box 199 to enter
the new address.
The information in the CITY, STATE, ZIP, and AREA CODE fields is the
same for both customers so those fields don't need to be changed.
,.. Double-click o n the phone number and type 555-0835.
The current date and proper customer number are entered automatically
when you duplicated the record.
Your screen sho uld look like the one shown in Figure 11-39.
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The duplicated record after editing the data

Look at the status area. It shows th at there are now 11 records in the file
and 2 are found. You told FileMaker to find the records that contain
Pinelog in the CITY field, and now there are two records that match that
c riteria.
Le t's tell FileMaker to fin d all records in the file.
00 -G

•

Choose Find All from the Select menu.

•

Now is a good time to save a copy of this fil e.

Assume th at you are done en tering information into the Customers file
and wan t to qu it .
00 -Q

•

Choose Quit from the File menu.

Delete Record
At a later date, suppose you need to delete Mrs. Brooks' record from your
file. To do this, you can open the Customers file, find the record you
want to delete, and tell FileMaker to remove th at record from the file.
•

Find the icon of the Customers file on your data disk and doubleclick on it to start FileMaker and open that file.

Before you closed the Customers file, you were looking at the last record
in the file, but now when you open the file again, the fi rst record is on
the screen. You need to find Mrs. Brooks' record.
00- F

•

Choose Fin d from the Select menu.

•

Type Brooks in the last name field, and then click Find .

The record will appear on the screen in a moment. Deleting this record
is fast and easy.
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:3€ -E

,. Choose Delete Record fro

the Edit menu.

You will be asked if you want to permanen tly delete this record (see
Figure 11-40).

•

r

File iJ!!IISelect

Ci adget~

rorm11t Custom Window

~

Customers

§~
Rtcords:

II
Found :

I

PREFIX
•oR~ T

6

Mrs.
lunA

~

I

!,=l1i

;';i'i

Permane ntly delete this record?

fioelet~

....
STATE
ZIP

[cance l)

o cou~

.,

!il:l

TX

!ii•'

69007

li:j,i

COUNTRY
AREA CODE
PHONE NUMBER
ENTRY DATE

633
555-0635
10/26/90

~

'21

Browst

Figure 11-40

-

Dialog box to con firm deletion of a record

Click Delete. The record is then removed from the Customers file.

You should now see the tenth record on the screen.

BROWSING
You have been working in Browse mode for most of this project. This
mode lets you view records, add new records, duplicate records, change
the information in a record, and delete records. This is the mode you will
use most of the time when you are working in FileMaker, because it lets
you work with the information contained in the file. Another mode,
Layout, lets you m odify the arrangement and appearance of fields,
graphics, and text. You will learn to use Layout mode in Project 2.
Since you have no t learned to create alternate layouts, you have been
looking at the information in the Customers file using the default layout
FileMaker created for you . FileMaker lets you create as many different
layouts for a file as you want. You can browse through the informatio n
in the file using any of those layouts.
Before completing Project 1, le 's practice moving through the file a
little.
I
The top left corner of the window contains the book, slide control
handle, and status area. You can use the book or the slide control handle
to move through the file and vtew different records.

I

518

Part V: Information Man agement

Using the Book
The book lets you go o ne reco rd closer to the first or last record. You can
click on t he top page of the book (i f it is not blan k) to go on e record closer
to the first record. Clicking on the bottom page of the book takes you
one record closer to t he end of the file.
Record 10 is showing on th e screen now. The bottom page is blank, and
this ind icates th at you are currently viewing the last record in the file.
If the to p page were blank, you would be viewing the first record.
..

Click the top page o f the book.

You should now see record 9 on the screen. Now that you a re not
viewi ng the last record in the file, the bottom page of the book is n o
longer blank.
Another way to use the book is to cl ick on the middle page, a nd t hen
type the num ber o f the record you want to see. Let's say you want to see
customer number 1003. The customers were numbered starti ng with
1001, and this means that customer n umber 1001 is in the first record,
number 1002is in the second record, and soon. To see customer number
1003, a ll you have to do is view the third record.
•

Click the middle page of the book, type 3, and t h en type Return or
Enter.

You should now be view ing the information fo r customer num ber 1003.

Using the Slide Control Handle
The slide control h a ndle is useful for moving quickly to the first or last
record in the fi le. Also, as yo ur file becomes larger a nd d eletio ns create
h oles in the record number sequence, you will no longer have as clea r
a relation between the book page number a nd the customer number.
Then the slide control handle will allow you to move closer to where you
th in k the record you wan t may be.
•

Poi n t to the slide control h andle, press the mouse button and w hile
ho lding t he mouse button down, d rag the h andle to the bottom.

You are now looking at the last record in t he file again . To view the first
record yo u could drag the han dle to th e top. As you drag the hand le, t he
number in the midd le page of th e book changes to represen t the record
you would see if you released the mouse button. Move to record number
3 again.
•

Drag the slide contro l h andle unti l the middle page of the book has
a 3 sh owing. Release th e m ouse button .

•

Now, use a ny of these methods to m ove to t he first record.
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PRINTING A FILE
You have now created a file, defined its fields, and entered data into the
file .
It is handy to keep a paper copy of the file in case anything happens to

the copies stored o n the di sk. (You did make several copies and a backup,
didn't you?)
There are two reports you can print whenever you have created a file and
entered data into it. Both reports are available by choosing the Print
command.
3€ - P

,,. Choose Print from the File menu . When the dialog box for printing
is displayed, accept the default values by clicking OK.
FileMaker will print a report containing all ten records and their
contents. The report should take about six pages, and the first page
should look like the one shown in Figure 11-12, at the beginning of this
project.
The second report that is useful for documenting the field definitions of
a file is also printed using the Print command.

3€ -P

·•

Choose Print from the File m enu.

This time, you want to change one of the options in the dialog box that
appears .
,,. In the bottom line of the dialog box, click Field Definitions.
This tells File Maker to print the definitions of the fields, rather than the
contents of all the records.
•

Click OK.

FileMaker will print a report that should look like the one shown in
Figure 11-41.
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Field Name

Field Type

Formula I EntrY Option

PREFIX

Text

List:
Mr.
Ms.
Mrs.
Dr.
Rev.

FIRST

Text

Ml

Text

LAST

Text

TITLE

Text

COMPANY

Text

ADDRESS

Text

CITY

Text

STATE

Text

ZIP

Text

Required vall.le

COUNTRY

Text

AREA CODE

Text

PHONE NUMBER

Text

ENTRY DATE

Date

AL!to-enter today's date

CUSTOMER NUMBER

Number

Auto-enter serial number: 1012
Unique values only

BUSINESS TYPE

Text

List:
Auto Body Repair
Auto Dealer
Car Wash
Glass Repair
Mechanic
Tire Dealer
Welder

REGION

Number

Value in range from " 1" to " 9"

Figure 11-41

Report showing field definitions of Customers file

This concludes Project 1.
You will continue to use the Custo mers file in the next two pro jects.
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Project 2: Creating Detail Reports
In Project 2, you will learn to create two types of detail reports based on
the information you entered into the Customers file in Project 1. You
will create two columnar reports and a report that prints mailing labels.
These reports will be created using FileMaker's preset styles for columnar
and label reports.
A columnar report prints information in columns, and a label report
prints information in a grid-like pattern consisting of several rows and
columns.
These reports are called detail reports because they print something for
each record that is currently selected. A summary report does not give
details for each record, it just provides information about the current
selection as a whole. Where a detail report might show how much you
are owed by each customer, a summary report might show only the total
amount you currently have in accounts receivable, the average amount
for each customer, and the number of transactions in the file.
FileMaker also lets you create a new blank report and place fields, graphics,
and text anywhere on the page. The flexibility provided by the blank
report demands a cost in terms of time and effort, but it allows you to
design a report that shows the information you want in exactly the way
you want to present it. You will learn to create a report from a blank
layout in Project 3.
The output of the three reports you'll create in Project 2 appears in
Figures 11-42, 11-43, and 11-44.
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October 27, 1991
7:33PM

FIRST
Sandra
George
Jim
Kay
Faye
Mattie
Jose
Gary
Glenda
Lois

LAST
Hardin
Lap mont
Bell
Kusunoki
Mauney
Dilbeccio
deAngello
Westmoreland
Rider
Yarmus

CUSTOMER NUMBER
1001
1002
1003
1004
1005
1006
1007
1008
1009
1010

Page 1

Figur e 11 -42 Final output of Project 2, customer name and identification

number report
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October 27, 1991
10:14 PM
FIRST
Jim
Jose
Mattie
Sandra
Kay
George
Faye
Glenda
Gary
Lois

LAST
Bell
deAngello
Dilbeccio
Hardin
Kusunoki
Lapmont
Mauney
Rider
Westmoreland
Yarmus

AREA CODE
203
604
702
234
978
651
833
827
703
826

PHONE NUMBER
555-2731
555-7826
555-1092
555-2922
555-2383
555-2654
555-0927
555-2783
555-1273
555-2826

Page 1

Figure 11-43

Final output of Project 2, customer name and phone
number report
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Mrs. Mattie L. Dilbeccio
Grape Creek New and Used Cars
14709 Main Street
Grape Creek, NC 28087

Mr. Gary H. Westmoreland
Western Carolina Welding
2741 Highway 141
Peachtree, NC 28915

Ms. Sandra M. Hardin
497 Seemore Drive, Apt. 3
Asheville, NC 29702

Mr. Jim Bell
1492 Document Drive
Mandarin, FL 49709

Ms. Faye Mauney
15 Mockingbird Lane
Pinelog, TX 69007

Mr. George M. Lapmont
Bell Tires
2354 78th Avenue
Bellvue, WA 71356

Ms. Lois J. Yarmus
Kaymus & Yarmus
7293 Aurora Avenue
Midlothian, IL 72932

Dr. Jose S. deAngello
117 Third Street
Apache Junction, AZ 78273

Ms. Glenda Rider
1294 Skyline Trail
Denver, CO 82742

Ms. Kay B. Kusunoki
7531 Second Street
San Francisco, CA 92846

Figure 11-44

Final output of Project 2, mailing labels report

CREATING CUSTOMER LISTS
FileMaker is capable of producing many different types of layouts, and
you have a wide range of formatting features to customize these layouts
to fit your particular needs. When you create a new layout, FileMaker
offers you four choices: standard, columnar, label, or blank.
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Project 1 introduced you to the s andard layout. This project will guide
you through completing colum ar and label layouts. You will learn to
create customized reports from a blank layout in Project 3.
FileMaker's columnar reports give you the tools to create ad hoc reports
quickly and easily. If you want a list of a few items from a file, you can
create that list by creating a new columnar report and specifying the
fields that should be in the report. FileMaker will create a layout showing
those fields in the order you specified. With a little practice, this process
takes only a few seconds to complete.
The first columnar report you will create lists the customers' names (last
name and then first name) and their customer numbers. In Project 3,
you will create a sales invoice file, and that file will look up information
about the customer's name and address from the Customers file. The key
field that connects these two files will be the customer number. When
a customer buys auto parts, you will enter the customer number into the
proper field on the invoice.
It is easy to print a report that shows the customers' names and numbers,

and that report can be used when entering customer information into
the Sales Invoices file. If you know the customer's name, you can look
in the list and find his or her number. (Of course, you can use the Find
command in FileMaker to find this number even faster.)
There will be times, however, when you will know a customer's number,
but not his or her name. In this situation, you want to have a report that
is printed in numerical order based on the CUSTOMER NUMBER field.
FileMaker can quickly sort a file based on any field you specify. In this
project, you will sort the customer name and number list in two ways:
alphabetically by name and numerically by customer number. The
mailing labels will be sorted by Zip code.
A report can be printed in alphabetical order by customer name, in
numerical order based on the customer number, in chronological order
based on the date of sale, or even in ascending or descending order based
on the amount of the sale. Depending on the circumstances, the
information you already have available, and what you are trying to find,
all of these formats can be very useful.

Layout Mode
FileMaker allows you to create and use several different layouts with
each data file. A layout determines how the information contained in
the selected records is presented on the screen or on a printout.
You can place text (for label? ng fields or showing explanatory
information), graphics (lines, rectangles, ovals, or images copied from
other graphics programs), and the fields used by the file. Each of these
three elements is treated as an object by File Maker. You can move, resize,
and delete graphics. Text and fields can be modified by changing their
size, position, font, style, alignment, and formatting attributes.

I
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Standard Layout
The view you have been using is the default layout that FileMaker
created, using the fields you defined in the order in which they were
d efined. This lists the name of the field on the left and then each of t he
fields from top to bottom aligned immediately to the righ t of the field
name (see Figure 11-45) .
This is not always the best way to display your information, so FileMaker
allows you to chan ge the default layout and/or create new ones.
For example, you can make a field in the standard layout longer or
shorter. You can change the font, size, style, and alignment of the text
in the fields or in the explanatory labels to the left of the fields.
If you want a more customized layout, however, the creation of a

d ifferen t layout is better than modifying the standard layout, in most
cases.
Let's give it a try. If you quit FileMaker since completing Project 1, you
should restart. Th e easiest way to open FileMaker and the Customers fil e
is to find the Customers file icon and double-click on it.
If you haven't quit FileMaker, you need to open the Customers file.

•

Open the Customers file, if it is not already open.

3€- L ",. Choose Layout from the Select menu.
This will show you the standard layout that was created for you when
you defined the fields in Project 1 (see Figure 11-45).
r

•

File

Edit

Sele ct

Gad

COMPANY

I.Fi.el.d... ..• l
COUNTRY
AREA CODE
PHONE NUMBER

Figure 11-45

Default layout created by o riginally defining fields

.,
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In Proj ect 1 all the fields were named using a ll uppercase characters. In
this project, you will add three ca~cul ation fi elds, and they will be na med
using upper- and lowercase characters to help distinguish between
them. FileMaker does not specify this style of n aming fields, it is used in
Project 2 only to h elp you differentiate between the fields you created
in Project 1 and these you define h ere.

Adding a New Layout
Adding a new layout is a straightforward process in FileMaker. When
Layout mode is chosen, the Ed it menu ch anges. Command-N in Browse
mode means create a n ew record. The sam e command in Layout mode
means create a new layout.
Before you add a n ew layout to the Customers file, let's look at the tools
available in Layout mode.

Palette Tools
FileMaker provides several tools that may be used to create n ew layouts.
The icon s representing these tools are shown in Figure 11-46, an d the
tools are then described individually.

1

2

3

~

m
4

5

6

7_.1HeJ.d.. .. .•,

Figure 11-46

L1

1 - Arrow tJ ol
2- Text tod~
3 - Line tool
4 - Rectangte tool
5 - Rounded rectangle tool
6- Oval tool
7- Field tool
8 - Part tool

Tools used in Layout mode

Arrow Tool- As you probably already know from using other Macintosh
applications, the arrow tool lets you select, move, and reshape objects.
The arrow tool also allows you to ch an ge the size of layout parts. This
tool is the default tool.
Text Tool - Clicking this tool somewhere on the layout anchors an
insertion po int where you ca n ~dd text. If text already exists, you
can edit that text by selecting part1 o f it and typing the replacement text.
Line Tool - Move the mouse to w ere you want to ancho r o n e end o f a
line, press the mouse button and ho ld it down, drag the line to where
you want it, and then release the button to anchor the other en d.
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Rectangle Tool - Move the mouse to where you want one of the corners
of the rectangle, press the mouse button and hold it down to anchor the
first corner, then drag the outline to where you want the diagonally
opposite corner. Release the mouse button to anchor the second corner
and draw the rectangle.
Rounded Rectangle Tool- This works the same as the rectangle tool, except
that the corners of the box will be rounded.
Oval Tool- As with the rectangle and rounded rectangle tools, select on e
corner, and then press the mouse button and drag to the diagonally
opposite corner. This will define a rectangle, and the oval will then be
drawn so that it is inset inside the rectangle you just defined.

I.Fle.l.d.... .• ,

Field Tool- By clicking on the field tool and then dragging it onto the
layout, you can add and position a field anywhere on the layout.
FileMaker lets you choose from a list of all the fields, so you can
designate which field you want. You can add new fields to a layout, add
fields you previously removed, or even show the same field more than
once on the same layout.
Once a field is placed, you may select it with the arrow tool and, by
dragging the box on the lower right corner, you can resize the box larger
or smaller to display the contents of the field as you want.

Part Tool- There are several parts to a FileMaker layout. The main ones
are the header, body, and footer. You may also create title header, title
footer, sub-summary, and grand summary parts. These parts will be
discussed in more detail later in this project and the next one.
To add a part, click on the part tool and then drag the part to where you
want it on the layout.
By selecting a part with the arrow tool, you can make the part longer or
shorter. All parts extend completely across the layout horizontally.
These tools allow you to place fields wherever you want, to add text
(which can be in any font or size available), and to use lines, ovals, and
rectangles to group the different parts of the layout or to add graphic
emphasis.
FileMaker also lets you import graphics from other programs (such as
MacPaint and MacDraw) and use these graphics as the background for
creating a new layout. You can draw a form in a graphics program, paste
it into FileMaker, and then add the fields onto the drawing of the form .
You can also use this capability to paste company logos and other
graphic elements onto a layout.
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Now that you are fami liar with t e tools available in Layout mode, let's
create a new customer list report. his will be a columnar report that will
list the customers' last names, first names, and customer numbers.
~ -N

.. Choose New Layout from the Edit menu.
When you issue this command, FileMaker displays a dialog box asking
for the type of new layout you want (see Figure 11-47).

L.tvouts:
1

Create B new layout which Is a:

0 Standard layout
® Columner report layout
0 label layout
0 Blenk layout

PHONE NUMBER

Figure 11-47

•

Dialog box for selecting type of new layout

Click Columnar report layout, and then click OK.

Columnar Layout
Now that you have told FileMaker that the new layout is a columnar
report, it assumes that you want to display only a few of the fie lds instead
of all of them. The next thing you see is a dia log box that will let you
choose the fields you want listed in this layout.
In this case, you want to sh ow the first name, last name, and customer
number. Let's tell FileMaker to add the FIRST field to the report.
•

Click on FIRST in the scrolling field on the left.

This selects the first name field and activates the >>Move>>button. If you
click the >>Move>> button, it tells FileMaker that you want the selected
field to be the first field in the left column of the report.
•

This is wh at you want, so click »Move>> (see Figure 11-48).
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•

File

Sel ect

G11dgets

Format

Custom

Window

Customers
Fie ld Order

Fiel d List
PREFIH
FIRST
Ml
LAST

[

1: ll~nr

J

TITLE
COMPANY
ADDRESS
CITY

Figure 11 -48

Moving the first name field into the report

Like most Macintosh commands, this is a process of selecting the object
(first name field) and then specifying the action for the object (move it
into the report). Many of these two-step commands have equivalent
shortcut commands. When specifying a field to move into a report, you
can double-click on the field you want, and it will be selected and moved
into the field order list with one action.
.. Double-click on LAST to move it into the field order list.
.. Double-click on CUSTOMER NUMBER to move it into the field
order list.
You h ave now specified the fields you want in this report, and the
dialog box should contain these three fields in the order shown in
Figure 11-49.
r

45 File II!IJI Select G11dgets Form11t Custom Window
Cust omers
Field List

Field Order

ZIP
COUNTRY
AREA CODE
PHONE NUMBER
ENTRY DATE
CUSTOMER NUMBER
BUS INESS TYPE
REG ION

~

li!i

!Iii
!!,1
l!il
~~~~

1!!!1

fit
10

Cl e11r

FIRST
LAST
CUSTOMER NUMBER

Mt>IH~

OK

~

Concel

)

J

r! :pg~r:::=l}==r===p=H=::=~=Ny=U:=:=~:==:.;~=i=~R=~"=i. =~=~:=-:~=~.=••=•.:J=-:.=-:.=-:=-:.=-:.=-:.=-:=...=.=··=•.,=:·=·:'f'=~~·
Figure 11-49

Specifying the three fields to show in this report

,. When you have verified that the fields you have chosen are correct,
click OK.
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FileMaker now produces the co umn layout using the three fields you
just chose (see Figure 11-50). No~ice that the book h as ch anged to show
that there are now two layouts for this file.
r

File

•

Edit

.,

Select

~

-;FIRST

CUSTOMER NUMBER

]EL~~~~~~~~~:h~~~I ~~~~~~~J~-~~Tp_MJ_~~~~~~ij-~~~~~~

Figure 11-50

The layout for your customer list

As part of this process, FileMaker has selected the View as List option
from the Gadgets m enu. Let's look at the differences in how this layout
works when View as List is not selected and then again when it is.

~-B

•

Choose View as List from the Gadgets menu to deselect it.

•

Choose Browse from the Select menu.

When View as List is not selected, Browse will only show one record
using the currently selected layout. Your custom er list is not a list since
you deselected this option (see Figure 11-51).

' a

File

Edit Select

10

(i <ld ~Joh

r ormo t ,Custom Window
Customers

FIRST

!.MIT

Scndrc

Herd In

CUSTOMER NUMBER

1001

Rteords :
10

'21

Browst

Figure 11-51

A columnar layout that is not a list
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Since you really wanted this to be a Jist, let's go back to select View as List
again. You can only choose commands from the Gadgets menu from
within Layout mode.
~-L

•

Choose Layout from the Select menu.

•

Choose View as List from the Gadgets menu.

Go back into Browse mode and compare the results.
~- B

•

Choose Browse from the Select menu.

You have now produced the customer list you wanted (see Figure 11-52).

' *

File

Edit

Sel ect

ID

(iildg<lh

rormut Custom Window
I

Customers

~i
-

Rtcord.s :
10

:!:!
F IRS T

!.AlU.

Sendre
George
Jtm
Key
Feye
Mellie
Jose
Gery
Glenae
Lots

Herdtn
Lepmont
Bell
Kusunokl
Meuney
Dllbeccto
deAngello
Westmorelend
Rider
Vermus

NUHBER

1001
1002
1003
1004
1005
1006
1007
1006
1009
1010

10

[L] Brow.. ~I

Figure 11-52

CUSTOH~R

10 QJ

A columnar layout with View as List selected

This is a good time to save a copy of the file. When you save a copy of
the file it also saves all the layouts that you have created.
Before you print the report, let's add page numbers. Because the value
of information is directly related to how curre nt it is, let's also add the
date and time on the printout.
You only want these items to appear once on each page. You can put the
page number at the bottom of the page in the footer, and the date and
time can go at the top right corner of the page in the header.

Headers and Footers
A header is the margin at the top of the page where normal body
information is not printed. Information placed in the header area of a
layout will be printed at the top of every page and will appear at t he top
of the screen in Browse mode. You can delete the header from any layout
by dragging the Header part to the top of the screen until it disappears.
The body area is printed once for every record. This is where the last
name, first name, and customer number fields are located in this report
(refer back to Figure 11-50).
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A foqter is the margin at the bott m of a page. Information placed in the
footer is printed at the botto m o every page and is sh own at the bottom
of the screen in Browse mode. Like th e header, the footer can be
removed from a layout. To delete the footer, drag the Footer part up to
the Body part until the Footer part disappears.
Two special parts, the title header and title footer, are used to replace the
header and footer on just the first page.
You can use FileMaker to Jearn more about headers and footers and also
about adding page numbers, the date, and the time to a layout. As you
h ave already seen, FileMaker's Help file is valuable for learning to use the
program. What can it tell you about layouts and page numbers?
Let's find o ut.
00 -I

•

Choose Heip from the Apple menu.

Now you can use one of the predefined scripts to find the layout
information.
00 -8

•

Choose Arran ging Information from th e Custom menu.

You are presented with the first of 15 records that are available for
arranging information (see Figure 11-53).
li ·· fil e

Edi t
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li<Hig <lh

m

f'ornm t Custom Window

e:J!

Flle Mulce r Help

~i
-

Rtcor$:
69
Foond :

IS

19

\tH AT 11RE LAYOUTS?
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Figure 11-53
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The first of 15 help records on layouts

It is worth your time and effort

t~

at least skim the information in t hese
15 records. One in particular h iljS the information you are looking for.
You can have FileMaker find it for you.

00 - F

•

I

Choose Find from the Select menu.

You are presented with the Find screen sh owing th e three active fields
in the Help file.
•

Type page number in the top field (see Figure 11-54).
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Figure 11-54

Finding help on page numbers

If this seems familiar to you, it may be because this is the example for
using the Help file that was presented in the introductory part of this
chapter.
If any of the records contain "page number" in the top field, FileMaker
will quickly locate them. Note that capitalization is not important when
you use Find to locate something in a file.

"•

Click Find.

FileMaker now presents you with help on adding time, date, and page
numbers to a layout (see Figure 11-55). It also mentions record numbers,
but they won't be added to this report.
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The help record for page numbers

Now that you know all about this subject, you can close the Help file and
add these codes to your customer Jist layout.
3€ - W

••

Close the Help file.
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You will ad d the page number p ceholder (##) in the foo ter area of the
layout. To d o this, you must be n Layout mo de.
:l€ - L

•

Ch oose Layout fro m the Select me nu.

Yo u must use the text tool to add these placeh olders.
•

Click o n the tex t tool in the tool pal ette.

•

Click in the footer, under the last n am e fi eld, and type Page## .

,,. Now click in the header, a t the to p of the screen above the
CUSTOMER NUMBER fi eld, and type I/. Type Return to go to the
next line, and type :: (see Figure 11-56).

"s

File

Edit

Figure 11-56
:l€ - B

•

Select

G

Custom

Window

.,

Adding text to the h ead er and footer

Ch oose Browse fro m the Select menu.

Notice that the date h as replaced t he first placeh older in the h eader
section o n the screen (see fi gure 11-57) .
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Figure 11-57 Browsing the report after modifying the header and footer

The page number and time placeholders, however, are just the way you
en tered them. These codes will be replaced with the actual page number
and time whe n the report is previewed o r printed. Let's preview the
report a nd see.

Previewing a Report
Preview shows h ow the report will look whe n it is printed. There are two
views: fu ll size and reduced . Full size shows the information at a readable
size, but, un less you have a large mo nito r, you can only see a portion of
t he page. The reduced view shows the en tire page an d h ow all the
elements are placed, but it is too sm all fo r reading the info rmation .
By switc hing be tween fu ll size a nd reduced, you can see the details of
wh at will be prin ted and also get a n overview of th e page as a whole.

3€ - U

•

Choose Preview from the File m enu.

You will see the top left corner of the report page. As you can see, the
ti me is entered into the h eader (see Figure 11-58). If you were to scroll
to the botto m o f t he page, you would find that the page number is
showing in the footer.
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lo

Previewing the customer list repo rt

You can also choose to see the reduced v iew of th e entire page.
•

Click Reduced.

You are n ow presented with a reduced view o f the page that shows the
heade r, body, a nd footer information as it will a ppear o n the page (see
Figure 11-59).

Preulew:

(Nt>!lt I'O\l•~ )

1: : ~: : : : : : .: : : :,: : :1: : : : ] [ Puge JlliJ

Fig ure 11-59

Red uced preview of the custo mer list

Notice th at th e report is n ot automatica lly cente red o n the page. Since
th is is an interna l repo rt (on e that w ill no t be sh own outside the
com pa ny) it is no t a problem , but let 's t ry m oving the date and time to
the upper right side of the page. ISom e reports that you might want to
prin t at a late r date might neetll to be centered to present a better
ap pearance.
To mo dify the report's layout, you must exit from the prev iew and then
change to Layout mode.
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•

Click Exit.

•

Ch oose Layout from t he Select menu.

Moving an object on the layout is a matter of selecting the arrow tool,
clicking on an object, and, while h oldin g down the mouse button,
dragging the object to a new location .
Let's try moving the page number object.
•

If the arrow tool is not selected, click on it to select it.

•

Click on the page number object, and drag it to the left.

Don ' t be con cerned about where to move it at this point. Notice t hat a
horizontal dotted line extends from the object to the left and right when
you move it (see Figure 11-60). This is an extension of the baselin e of the
text, and it h elps you to align th is text object with other text ob jects. If
you drag the page number h orizontally to the left, you will see that the
baseline extensio n aligns exactly with the bottom o f the page number
placeh older (Page ##) that you originally entered in the foot er.

.,

,. t5 File Edit Select Ga

CUSTOMER NUMBER

Figure 11-60

•

Dragging the page number object

Drag the page n umber object to th e right, until its left edge align s
with the left edge of th e CUSTOMER NUMBER field. Release the
mouse butto n to pl ace th e page number.

You sho uld be sure that the page number is en tirely in the footer. If you
late r preview the page or print it and you see the page n umber
overlaying the customer number in the body of the report, it means tha t
you accidentally placed the page number ob ject in the body part of the
layout. This is an easy mistake to make. The solution is to move the page
number obj ect entirely into the footer.
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You can adjust the date and time o that they print at the top right corner
of the page.
•

Click on the right scroll arrow until a vertical line appears.

This vertical line marks the right side of the page.
.. Drag the date and time placeholders to the right until they are about
an inch and a half from the right side of the page (see Figure 11-61).
"

•

file
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Custom

Window

.,

II

Figure 11-61

Layout after moving date and time placeholders

You can now preview the report to see if the date, time, and page number
are where you want them.
3€ - U 3€ - L ,,. Alternating between the Preview and Layout modes, ad just the date,
time, and page number placeholders until they are placed properly
on the page.

Printing the Report
When you have the placeholders where you want them, it is time to
print the report.
3€ - B

•

3€- P

•

Choose Browse from the Select menu.
Choose Print from the File menu. Accept the defaults by clicking
OK.

Compare the output of your report with the output sh own in
Figure 11-42.
This completes the customer list showing the customer numbers.
•

This is a good time to save a copy of your Custo mers file.
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Let's create another columnar report that lists the custom er's first name,
last name, area code, and phone num ber. It is created like t he fi rst report,
by ch anging to Layout mode and telling FileMaker to create a n ew
layout.
~-L

•

Choose Layout from the Select menu.

~

•

Ch oose New Layout from the Edit m enu.

•

When the dialog box appears, select Columnar report layout, an d
then click OK.

-N

Next, FileMaker will present a dialog box that allows yo u to select th e
fields that will appear in the report.
•

Double-click on FIRST.

•

Continue by double-clicking on LAST, AREA CODE, and PHONE
NUMBER.

You should now have four fields listed in th e Field Order box on the righ t
(see Figure 11-62).

Field List
STATE
ZIP
COUNTRY
AREA CODE
PHONE NUMBER
ENTRY ORTE
CUSTOMER NUMBER
BUSINESS TYPE

Figure 11-62

•

Field Order
FIRST
LAST
AAEA CODE
PHONE NUMBER

Clear

~

-~j~·

~it

u;

Moue

:(~~:
_:'§;

(

OK

iii

(

Cancel

~)

)

Selecting th e fi elds fo r the second columna r report

When you have verified that th e fi elds are correct, click OK.

fil eMaker quickly produces the layout you just specified . All you need
to do to customize this report is to add the page number pl aceh older in
the footer and the date and time placeh o lders in the header.
•

Click on the text tool.

•

Using th e procedures you learned in th e last few pages, ad d the date,
time, and page number p laceho lde rs in the ir appropria te posi tions.
You can align the left edge of th e page n umber wi th the left edge of
the AREA CODE field.

You sh ould now have a layout that looks like th e one sh own in
Figure 11-63.
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Figure 11-63

a€ -B

The layout for the customer phone number report

,,.

Click o n the arrow tool.

,.

C h ange to Browse mode.

The list ap pea rs on yo ur screen showing the four fields you selected.
Notice that the list is shown in the order in which you entered the
records . Because the customer number was automa tically entered as you
added customers to the file, th is resu lts in the list being shown in
custom er num ber order.
This is n ot a conven ient order for th is report. Generally, when you want
to find t h e custom er's phone number you would look for th e customer's
na me (just like using the ph on e boo k). Let 's ch ange the order of this
report so that th e names are listed in alph abetical o rder.

Sorting Records
FileMaker h as the ability to sort information in every t ype of field except
for picture field s and summary fi elds. Text fie lds can be sorted
alphabeticall y, nu mber fields can be sorted numerically, and date fields
can be sorted chro n ologically.
The way the sort works depends o n the type of field. If it is a calculation
field, the result depends on the zype of resul ts you selected for the field.
Fortunately, Fil eMa ker is sm aJ enough to determine which sort is
appropriate for each field. All ydu h ave to do is tel l it which fields to u se
fo r t he sort keys.

Sort Command
The Sort command is accessed by choosing Sort fro m the Select m enu.
If a fil e is already sorted, you can also choose the Unsort command,
which return s the records to the order in w hich th ey were added to
th e file.
j
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•

Choose Sort from the Select menu.

FileMaker puts up a dialog box and wa its for you to specify the fields to
use for sorting the file and w hethe r to sort each field in ascen ding or
descending o rder.

Ascending and Descending
For a text fie ld, ascending order means sorting the records of the file in
orde r from A to Z based o n one or m o re specified fi elds. Descending order
sorts from Z to A and is also known as a reverse sort.
Number fields are sorted based on the n u meric va lue of the specified
fie ld(s) . Ascending o rder is the sa me as sma llest to la rgest order.
Descending order is the opposite.
Date fields are sorted based on the ch ron ological o rder of the date.
Ascending sorts arrange the record s fro m ea rl iest da te to la test date.
Using a descending date sort results in the m ost recent dates being listed
first, followed by even ts that h appened furt her in the past.
FileMaker uses a series of rectangles with each one getti ng larger to
pictorially represent an asce nding sort. A series of rectangles getting
smaller represents a descending sort (see Figure 11-64).

-·•• Asc:ending Order
••·- Oesc:ending Order
Figure 11-64

Symbols used to represen t sort o rder

Sorting Levels
Files can be sorted by one or more fields. lf onl y on e sort field is specified
t h en the records will be sorted based o n the contents of that field on ly.
If m ore than one sort field is specified, the first field determines the most
significant order of th e file, and the second and subsequent fields are
used onl y when duplicate entri es ex ist in the ea rlier sorted fields.

For example, to sort a list of names in al phabetica l o rder, you could
specify th e last name fie ld for th e sort. Then everyone would be sorted
by last name. If two o r more people had the same last n ame, they wo uld
not be sorted by first na me, but wou ld appear based o n the order in
which they were added to the file.
To be sure that the names a re sorted p rope rl y-by last name fi rst, and
the n by first name for people with the same last name- yo u must
specify two sort fields. In this case, the last name field is th e most
important, so it is added to th e Sort O rder list first, and then the first
name field is added to the list.
•

Double-click on LAST in the Field List.
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The defau lt order for a fi eld is asce nding, as sh own at the bo ttom of the
dialog box. When you do u ble-clicked on the last n ame fi eld, it was
moved to the Sort Order list, and the asce nding o rder icon is shown next
to it.
•

Double-click on FIRST in the Field List.

in a sim ilar manner, the first name field is added to the li st, and the
ascen di ng o rder icon is displayed next to it as well (see rigure 11-65).
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Choosing the sort order for the report

Now you a re ready to sort the file.
•

Click Sort.

Printing the Report
C hange to Browse m ode, and then print the re po rt.
3€ -B

•

C hoose Browse from the Select menu.

When you browse the file, you should see all the custo m ers listed in
alphabetical order.

:3€ - P

..

Ch oose Print from the File menu. Accept th e defa ult va lues by
clicking OK.

Com pare the o utput of this report w ith the output of the repo rt shown
in Figure 11-43.
•

This is a good time to save a copy of your file .

CREATING MAILING LABELS
Now that you have learn ed to crea te columnar lists and ho w to sort t he m
into the order you wan t, it is time to create, sort, and print m aili ng labels
for you r customers.
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Modifying the Customers File
Before you create the label format, it will make t hi ngs easier if you add
som e new fields to the file.
Each label will have information on it t h at is stored in n ine fields in the
file: prefix, first name, middle initia l, last name, company name,
address, city, stat e, and Zip code.
Since there are on ly six lines of text available on the label, File Maker will
let you specify only six fields for automatic placement when you create
t he new label layout. Then yo u would ha ve to resize th e first fo ur fields
a nd move them up to the first line o f the label. You wo uld h ave to
manually place and resizeth eoth erfields until you completed designing
the labels.
Th ere is an easy way around this proble m that will a lso make Project 3
easier to complet e. All you have to do is create new text calculatio n fields
t hat concatenate (combine) the informati o n fro m several fields in to one
fie ld.
Yo u will create a Full Name field tha t will concatenate t he PREFIX,
FIRST, Ml, and LAST fields. Address2 will combine th e C ITY, STATE, and
ZIP fields. The third field, Phone, will combine t he AREA CODE
(enclosed in pare ntheses) and the PHON E NUMBER.
Notice that the names for these n ew fiel ds a re composed of upper- an d
lowercase letters and that t he fields already defined are all in u ppercase.
This technique is used to help you remember that th ese n ew fields a re
calculation fields that combine information alread y en tered in th e
earlier fields. Again, t his is just a matter of style and it is not req uired by
FileMaker.
Let's add t hese three fields to the fil e.

Adding Text Calculation Fields
You will define these th ree fields in a moment. You can defin e a field
fro m an y mode by choosing the Defin e comma nd, but since FileMaker
automatically places n ew fields o n w hatever layout you a re in befo re
yo u ch oose Define, let's switch to Layo ut mode first.

3€ -L

•

C h oose Layout from the Select m e nu . Use th e book or slide control
handle to change to layo ut num ber 1.

Now yo u are read y to define the three text calcu latio n fields.

3€ -C

,.

C hoose Define from the Select menu.

•

Cli ck Calcula tion to indicate the type of this field, and then type its
name, Full Name, in to the fi eld name box . Click OK.

When you click OK, FileMa ker di splays the fo rmu la d ialog box fo r a
calculation fie ld. Figure 11-66 shows w ha t yo ur screen will look like
wh en you enter the formul a.
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Calcu lation formula fo r the Full Name field

Th e calcul ation result s hould be designated as Text. Let's change how
the result is displayed from the d efault um ber.
_.

Click Text to design ate the type of calculation result.

A formula that combines four ex isting fi elds has been entered next. In
a text formula, each fi eld o r string literal (som ething inside quotation
marks) must be combin ed using the concatenate operato r, which is the
a mpersan d (&) character in FileMaker.
The form ula in figure 11 -66 says to display in the Full Na me fi eld a string
o f text composed of the prefix followed by a space, the fi rst na me,
another space, the middle initial, another space, and the last nam e.
There are three scro ll ing lists and a keypad in this dialog box. The list o n
the left contains a ll the defined fields. The keypad is availabl e so you can
click o n numbers, the decima l point, mathematical o perato rs(+ -I*),
parenth eses, quotation ma rks, a paragraph marker (<Jl), and the string
concatenation o perato r (&).
The next scro lling list contains a number of logica l operato rs, and the
last list contains built-in function s that you can use in creating formu las.
There are several ways to ente r th e formul a in the fo rmula box. You ca n
choose to t ype the entire formula if you want, o r yo u can use a
combinatio n of typing and clicking in the lists and o n the keypad to
enter the formula.
The first thing to do is enter th name o f the first fi eld.
•

C lick o n PREFIX in the fi eld names list.

This enters this word in the formula box. Now you need to tell FileMaker
to con caten ate a space character and another fi eld to this o ne.
•

Click o n & in the keypad.
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•

Click on

11
"

in the keypad.
1111

You now have PREFIX & in the formula. Th ere is no space between
the two q uotation marks, but the insertion point is automatically placed
between them, and FileMaker is waiting for you to type something
there. You will type the space bar to add one space ch aracter, and then
you must move the insertion point outside the closing quote by clicking
after the second quote or typing the right arrow key.
•

Press the space bar, and then either click after the quote or press the
right arrow key.

Now that the insertio n point is at the end of the formula, you can type
the ampersand or click on it in the keypad .
•

Click on&.

Now you n eed to add th e first name field.
•

Click on FIRST in the field n ames list.

Th e calculation formula should now read PREFIX & 11

"

& FIRST.

Refer to Figure 11-66 to see how the completed formula should look.
•

Using the steps just described, add MI and LAST to the formula,
separating each field with & 11 11 &.

If you make any mistakes you can use Backspace or Delete to erase the
part that is incorrect, and then continue entering the formula.
•

When you have verified the accuracy of your formula, click OK to
accept it.

You sho uld n ow be back in the Field Definition d ialog box, and the Full
Name field sh ould be visible at the bottom of the scrolling list. As much
of the formu la as fits is seen to the right of the field name.
Before you contin ue with the n ext two calculation fields, let's see what
the Help fil e says about defining fields, calculation formul as, functions,
and operators.

"J€ -I

•

Click Exit to leave the field definition dialog.

•

Choose He lp from the Apple menu, and then, when the opening
screen appears, click Open Help File.

You want more information about defining fie lds, so ...
"J€ - -t

•

Choose Defining Fields from the Custom menu.

FileMaker will find a group of 16 records containing information on this
topic. All 16 contain valuable information that you should look at.
Let's see what it says about text calculations.
•

Scroll to record S.
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You wi ll now see a screen like

R•corOs:

69

&

Found:

o ne shown in Figure 11-67.

MEANING

USE

Conc~ttnatt

Joins: two ttxt valuts
Tru ts tht Va1ut in quotation marks u a const.nt

Ttx t consbnt

16

t~e

Rttum ehw~ttr

lnstrts a return ohar~ettr for uch occurrtnct

Fort)(ltnplt , thtformula Fi r s t N 1me & "• &lut Name & • t~ • & Address
l tlls FiltMtktr to conuttNtt tht Ftrst Hwn., lut Nvn. , tnd Addr• ss FWJds, instrting
t sp~ bthfttn tM first nVM and th+ lut rwnt, W instr'ting a rt hrn eMr- acttr
btfort t.ht Addnss fJt\d son bf9hs on t.ht li'lt btlow tM nwnt.

Thts. S\lmbols _.., ustd Yith ttxt Rtlds, ttxt const..-.ts, lnd t•xt nsults of
c.~\ou~Uons or txprusioM.
• To SH other rteordJ: on this topic, cliek ~~of tht book at tht top ~ft of tht windc)''&'.
• For mon http on this: topic, JH tht FfltMaktr II Ovntr's M¥1U1l, p, 103 .
• For http on othtr' topics, choost tht topic \IOU lf«~l from tM Custom nvnv.

Figure 11-67

Text operators and sy mbols record in the Help file

This explain s more about w hat you just did when you entered the
formu la in the Full Name field .
•

Click the top page of the book to move to record 4 .

A reco rd appears that contai n s info rmatio n about FileMaker's
mathematical and logical operators that are u sed in calculating and
co mparing the contents of fields (see Figure 11-68).

' a

File Edit Select !i<ldgeh f"ormut Custom Window
Pll

FlleMolcer Help

Q

US IIIO OPERATORS Ill CALCULATIOII FORMULAS

=t ..

SYMIIOI.

-

RfoCOf'ds :

69

Found ;

16

EXAH'I.E

{

6 +3
6-3
6*3
6/3
6•3
6 •3
6>3
6<3
6>3
6<3

DR
NOT

1 AND 1
ODR I
NOT 1

-

•
I

.
)

(

'

2.3

RESil. T

9

MEANt«l

PM

3

Mhls

18

TWMS

2

Dtvldo

O(llo)

Equ•l
Hot Equ•l

1 <Y•s)
1 (Y..)
0(/lo)
1 (Y..)
O(Ho)

1 (Y•sl
I (Y..)
0 (l~o)
8

Gruttr TNn
ltu Than
Gruttr T"-t or Equo~l to
l tu Thin or Equal to
1 (\If'S) if Will ..... \jfS
1 (IJtS) if ~t'MN' ¥ f \lfS
I (\ju) ff nlu• ts no
Powtr

• To Itt othtr rtcords on this toplo, click P19ts of tht book .tt tht top l• ft of tht 'W'indow.
• for mort htlpon this topic, su tht FUtMakH' II o.... nt r 's Mo~nual , pp. 100-103.

• For htlp on othtr topics, choost tht topk: IJOU lw' ..nt from tht Custom mtnu .

I[IJ

Figure 11-68

•

lo

I ~ JQ:

Brow..

Help for mathematical and logical operators

Move to record 6.

Records 6 through 10 list information about FileMaker's built-in functions
(see Figure 11-69).
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'

File

j

Edi t

Select

(i<ldgeh rormll t

Cus tom

Window

!!lli

FileMaker Help

10

=t
-

RK-ords :
69
FO<Jnd:

:!,!

USING NUMER IC C ALCULATION FUNCTIONS

FUNCTION

MEANING

;r (VI ,V2,V3)

•bs (V)

absolutt (non-of9<~Un) Vllut of Y
ifYI is 1 (or not z:tro) rtsult b Y2 , othtrYiJ.t V3

;nt (V)
FV (VI ,V2,V3)

mt~ c~t ofnbt Y
futurt v •luf. of P-1\!i"Mnt Yl <~t Ylttrut r•t•

Y2 ~r

~riod

for V3

~dod.s

16

mod (V I ,V2)
r•m~ind"" of VI d1vidfd b\1 Y2
pmt (YI ,V2,Y3) p.ymtnts dut on prlnc~o~l VI o~t inltrtst r<~tt Y2 ptr ptrlod for V3
PY (VI ,V2,V3)

p«oriods
prtnnt Yl\tt of p~nwot VI It inttftSt ro~tt V2 ptr ptriOd

for'

Y3

ptriods

round (VI ,V2) nlue- ofYI r oundfod to Y2 dKimal pbcH
s itn (Y)
signof Y: 1 ifposittn,O ifuro, - 1 ifn.gatin
'Where Vis .a ~r, fitld no~rnt, or t xprusion.

• To set other rtcords on this topk, c1iek pa~s of tht book at t hf, top l•ft of tht wlndov.
• F'Or" more hE"Ip on this tGpic, su tht F"lliM»:tr' II Owntr''s Manuo~l , pp. 103-106, 1 15 .
• For help on other topics, choost tht topic \IOU wMlt from tht Custom mtnu .

frj Brows.

;;II

Figure 11-69
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Help for built-i n fu nctions

•

Skim the contents of records 6 t hrough 10.

•

Wh en you have read the reco rds, close the Help fi le .

Now that you know more about calculatio ns, operators, and functions,
let's d efine the Address2 and Phone fields.
•

Choose Layout from the Select m enu, go to layou t number 1, and
then choose Define.

The Address2 field's formula is sim ilar to the o ne you entered in the Full
Name field. This fie ld concatenates the C ITY, STATE, and ZIP fields. Th e
o nly difference is a comma that should appear after the city.
After you enter the CITY fie ld a nd the tex t conca tenate o perator in to the
formula box, you enter the quotatio n marks, with a comm a and a space
between t hem (see Figure 11-70).

' *

File

Edit

Gad_!!llts

Format

Custom

Window

Cus tom er s
Field Definition
Addr ess2

=

LAST
TITLE
COMPANY
ADDRESS
CITY
STATE
Z IP
COUNTRY

Figure 11-70

Col culatlon Resul t Is:
® TeHI 0 Number

Q Do t e

:~~:!ge 0 ~

count ()
dot e(,)
Oal eToTeHI
doy ()

c::Ji£~]

'

01/

10

( Cancel

J

Calcu lation formu la for the Address2 field
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•

Designate the calculation r ult by clicking Text.

•

Enter this form ula: CITY & ",

11

& STATE & "

11

& ZIP.

When you have done this and verified the formu la, click OK.
Now you are ready to define the Phone field .
This fi eld will contain a text result and the fo llowing formula:
11
"(

& AREA CODE & ")

11

& PHONE NUMBER.

Notice that there is a space after the right pare nthesis after the area code
(see Figure 11-71) .

•

'

File E d l t -(i<ldgeh

f"ormnt

Custom

'

Window

Customers
Field ueumuon

Phone •

1.,.. """ '"" . .,.• .,.., , . .,.
PREFIH
FIRST
Ml
LRST
TITLE
COMPANY
ADDRESS
CITY

Figure 11 -71

•

!=!

Calculation Result Is:
® Teut Q Number

0000
c:J~00

OCD00
8@00
In

(DEJ~

Q Dote

I

~
[

OK

I

abs 0
auerage ()
count ()
dot e (,.)
OoteToTeHt
doy ()

~

~

0

~

( Concel

l

Calculation formula for the Phone field

En ter the formu la as shown, verify it for acc uracy, and then click OK
to accept it.

This returns you to the Field Definition dialog box. You do n't want to
defin e any more fi elds.
•

Click Exit.

You can verify that the new fields work correctly by visually examining
them in Browse mode.
~

-B

•

C hange to Browse m ode.

•

Scroll to the bottom of the record and look at the contents of the last
three fields (see Figure 11-72).
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File

Edit

Select

(idd<jeh

!0

I ormu t

Custom

- Cu stomers

~i

ADORESS
CI TY
STATE

-

ZIP

Rtc«ds :
10

1492 Document Drive
Mandann
FL
4970 9

COUNTRY
AREA CODE

Sod<d

PHONE NUHBER
ENTRY DATE
CU STOHER NUHBER

203
555-2731
11 / 01/66
1003

BUSINESS TYPE
REG ION

full

N~m~

Adln ss2
Phone-

li!d. a.......

:)I

Figure 11 -72

Mr. Jim Bell
Menderin, FL 49709
(203) 555-2731

Window
E!l~

~

I''

I·"
,..

p.
tn

'"

1Qf2l

Browsing the records t o check the new fields

,..

Click on the bottom page of th e book to look at th e next record, and
continue c hecking all the record s.

,.

If you have any mistakes, ch oose Define and redefine th e fields that
are n o t working correctly. To do this, cl ick o n th e fie ld's name, click
Reformulate, and then re-enter the formula.

It is a good idea to print the field definitions repo rt when you h ave
modified any of the fields in the file.
~ -P

•

Choose Print from the File menu, click Field d efinitions, and then
click OK.

3€ -L

•

When everything looks ok, choose Layout from the Select menu.

You h ave completed defining the new fields, so you a re ready to create
the label layout.

Label Layout
Most labe ls are printed using o ne of two for mats: 1-up or 3-up. These a re
terms that describe how m an y labels a re o n each row. A 1-up fo rmat has
o nly one label on each row, a nd 3-ups have three on a row.
Other formats are available, but these are the most popular.

Label Dimensions
A standard letter-size sheet of paper is 8.5 inch es wide and 11 inches tall.
Depending o n the p rin ter yo u are using, you ca n use more or less of t he
page. An lmageWriter prints 8 inches horizontall y, and a LaserWriter
prints a 1i ttle less.
Mai ling labels are made by a number o f compa ni es and are ava ilable for
conti nuous feed t hrough a dot-matrix printer and o n single sheets for
laser printers.
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Most mailing labels are about 1 i ch tall. Depending on t he p rin ter you
have and the labels you buy, the abe ts may be 2.5, 3, o r 3.5 inches wide.
Since every printer wi ll print 3-up labels that are 1 inch high and 2.5
inches wide, this is the format yb u w ill use for your labels. It is also the
default size that FileMaker suggests.
This label size results in printing 33 labels per page (3 colum ns by 11
rows). Some laser printer labels are designed with a half-height label at
the top and bottom, which results in 10 rows of usable labels (and 30
labels per page).
When you choose a label format of 1 inch high and 2.5 inch es wide,
FileMaker automatically sizes the text so tha t you can print up to six
lines of text on each label.
You can design formats that will print on bo th the 33-labels-per-page
format and the format that prints 30 labels per page . The vertical
placement of the first row of l~bels can be adjusted by moving the
Header part of the label layout up o r down un t il the information is
printed exactly on the labels.

Creating the Label Layout
Creating a n ew label layo ut is a qu ick and easy process.
3€ - N

..

Choose New Layout from the Edit menu, cl ick Label Layout in the
dialog box that appears, and t hen click OK.

A dialog box will appear asking for the number o f labels you wa nt across
the page. The default is 3. Th e label size defa ult is 2.5 inch es wide and
1 inch tall.

' a

File

Select

Godgets

Formo t

Cu stom

Window

Customers

L1AEj
lQl9Q]

Figure 11 -73

-

Defining the num ber of labels across and their size

This is the format you wa n l1l so cl ick OK.

Now yo u can select the fields that will appea r in this layout: Full Name,
COMPANY, ADDRESS, and Address2.
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•

Double-click on th e ap pro pri ate fi e lds, th en c lick OK (see
Figure 11-74).

•

file_.mi_Se lect

Gad gets

format

Cu s t om

Window

Cus t omers
field Order

fi eld list
PHONE NUMBER
ENTRY DATE
CUSTOMER NUMBER
BUSINESS TYPE
RE GION
full Nam e
Rddre ss2
Phone

~
:!;
r"

~

Clear

(

MOUl'

[

OK

l

full Name
COMPANY
ROORESS
Rddress2

~

( Cancel

l

~==r=======================~~ -

~

~IIi_:
=

EHTRY DATE

[LJ

Lay out

=

[ENTRV.OiiJE ........ J

~

12_

Figur e 11-74

Selecting the fie lds to appea r in the layo ut

FileMa ker w ill then create a ne\·V label layout for you, as shown in
Figure 11-75.

r

•

File

Edit

F igure 11-75

Se lect

Gadgets

Format

Custom

Window

.,

The n ew maili ng label layout

Notice that the four lines of text are crowded aga in st the top edge of the
label. Let's center them vertically by selecting all four fj elds and
dragging them down one li n e.
You a lready learned how to move a page number object left and right.
Moving a field up and down works the same way. In fact, it will be easy
to move t hese fields, because FileMaker h as made each of the fields 1/ 6
inch high an d constra in s their m ovem en t using an invisible grid with
the sam e measurements. If you click o n a fie ld and drag it down, it will
jump down to the n ext line .
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You ca n move each o f the field s ·ndividually or select all four fi elds and
move them as a group. To select all fou r fields, click on on e to select it,
and then Shift-cl ick on each of the other field s to add it to the selection.
Another way to select all four fields is to move the pointer above the
fields, press and hold the mouse button down, drag the mouse diagonally
down and to the side to create the dotted outline of a selection rectangle,
and, when the rectangle touch es all four fields, release the mouse button
to select the fields (see Figure 11-76).
'"

-'

Fil e

Edit

Figure 11-76

•

Se lect

G

.,

Selecting four fields with the selectio n rectangle

Using e ither met h od, select the four fi elds and move them down
one line so there is a blank line at the top and on e at the bottom of
t he label.

Gadgets
You are n earl y done with th is\ layout. You are probably n ot aware,
howeve r, th at FileMake r selected several options from the Gadgets
m enu when it created this layout for you.
Press the mo use button on the Gadgets m en u title, and you will see that
three options are ch ecked to show that they are active (see Figu re 11-77).

T-Squores
_.. I nuisible Grid
TeHt Border s

XT
88Y

Uiew as lis t
confidentiol
./Colu mn Setup .. .
./Slide Object s .. .
Tob Order ...

Figure 11 -77

r:ileMake r has s lected three options.
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Th e invisible grid h as been discussed (since it is selected the fields wi ll
jump o ne line when you move them down) .
The o ther two options, Column Setup a nd Slide Objects, need some
explanation.
In the Column Optio ns dialog box, FileMaker has already selected three
columns of labels an d h as specified the order to be across a row and then
dow n to the first column in the next row (see Figure 11-78).
When you use these mailing labels, you would start at the top of the first
page and remove the top left label, then you would remove the center
one, and then the top right on e before going to the next row. If you had
these labels sorted in Zip code order, this printing order would be an
important conside ratio n.

Column Setup:
O None
® Print records In ~ columns
®
ncross
E
first
l

=~t
---·
:-:..:

0 olf]::n
-·-

Figure 11-78

Column Setup options

Sliding Objects
Slide Objects is a little more complicated t h an Column Setup.
The Slide Ob jects dialog box is shown in Figure 11-79. It contains th ree
options.

When printing, remoue unused space at the
end of fie lds by:
(ill Sliding objects le ft
(ill Sliding objects up

D Sliding port up

Figure 11 -79

Slide Ob jects options
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Sliding objects left is used when ypu want punctuation to closely follow

the end of text in a preceding field or when another field follows on the
same line. In this layout, you have already taken care of this potential
probl em by defining the Address2 field , which combines t he CITY,
STATE, and ZIP fields into one field.
Sliding objects up is used when a field is empty and you do n 't want a blank

line to print on the report. In this mailing label layout, the COMPANY
field is o n the second line. Som e customers represent a compan y and
will h ave information entered in this field, and some don't represent a
compan y and the field is empty. By telling FileMaker to slide objects up,
you won't end up with blank second lines on the labels. Don't be
surpri sed when you see blank company lines when you browse the
layout. Sliding objects on ly applies to previewing and printing the
repo rt.

pmts up is used to remove empty space when an object h as been
slid up. You do not want this checked on this layout, because all of the
labels are 1 inch tall. The parts must no t slide up in th is case.

Sliding

You can look at the label report by going into the Browse mode.

S€ - B

•

C hoose Browse from the Select menu.

You will now see the label for Mr. Bell. Noti ce that the labels are
presented in sorted order, because they were sorted alphabetically when
you created the layout.

r

File

•

Edit

Select

G<HI<J<~h

:o

Customers

~i
-

Rtcords :
10

.,

rormut Custom Window

t!);;

~
Mr. Jim Btll
1492 Doeumtnt Drivt
Mandarin, FL 49709

Sorttd

IIJ

0

Browst

~I

Figure 11-80

I

Browsing the mailing labels

IQ 121
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Yo u ca n see wh at the labels will look like when they are printed by
previewing the report.
~- U

•

Ch oose Preview fro m the File menu. When the preview co mes o nto
the screen, click the right scro ll a rrow so yo u ca n see tha t som e
records hav e three lin es and o thers have fo ur lines.

Figure 11-81 sho ws that t he slide objects up option is working correctly.

,. • liD Edit

Select

G<HI9eh

rnrmnt

Custom

Window

Customers
Preuiew:

Dr. Jose S. de Angello
1 17 Third Street
Apache Junction , A2 7 8273

Mrs . Mattie L. Dilbeccio
Grape Creek Nevt and Used Cars
14709 Main Str eet
Grape Creek, NC 28087

Ms. Ka~ 8. Kusunoki
753 1 Second Street
San Francisco, CA 92846

Mr . George M. Lapmont
Bell Tires
2354 78th Av enue
Bellvue , WA 7 1356

Ms. Glenda Rider
1294 Sk~line Tr ail
Denver CO 82742

Mr . Gary H. Westmor eland
West ern Carolina Welding
274 1 HiQhvtau 14 1

Figure 11-81

[Hit

Previewing the mailing labels

Aligning Labels on a Page
If you a re really printing these labels on pre-cut, gummed labe ls, yo u
mig ht have to do a little adjusting to be sure the tex t fits correctl y o n the
labels.
Different printe r a nd la bel combinatio n s make it im possible to g ive a ll
the steps involved for a ll com bin atio n s, but a general method can be
presented.
The m ost likely p roble m involves h ow the labels are fo rma tted o n the
page. Labels m ade fo r continuo us feed thro ugh do t-matri x printers
usua lly do n o t h ave a top margin- the first label starts at the to p of the
page.
Labels made fo r lase r printe rs sometimes have a half-inch m argin at the
to p and botto m o f the page, because some lase r printers canno t print o n
the top and botto m labels of a 33-l abels-per-page fo rm at. T hese labels
h ave a ha lf label at t he top a nd th e bo tto m, resultin g in 30 full labe ls o n
th e page.
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Adjusting th e vertical placeme~ t of th e labels involves making the
header in the layout shorter or ta~er. This can be done by clicking on the
Header part and dragging it up or down. In fact, if you n eed to, you can
rem ove the h ead er entirely, by dragging the Header part up to the top
of the screen and re leasing the mouse button .
If you print labels on both dot-matrix and laser prin ters, you can
duplicate the layout you just created and adjust one version fo r the dotmatrix printer and the other for the lase r p rin ter.
3€ -B

,.. Exit the preview, and go back to Browse mode.

Sorting Customers by Zip Code
The Customers file is presently sorted a lphabetically, but for mailing
labels you should sort by Zip code. If you mail enough letters, you can
get a discount from t he post office by sorting the letters into Zip code
order.
3€ -S

.. Choose Sort from the Select menu.
",. Specify the sort order by double-clicking on ZIP (see Figure 11-82).
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Figure 11-82

•

I<>

10'21

Ql

Specifying a Zip code sort order

Wh en you have done this, sort the fi le by cl icking Sort.
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Print Mailing Labels
You have completed creating the mailing labels, and now all t h at is left
is to print them.
a€ - P

•

Choose Print from the File menu, and accept the defaults by
clicki ng OK.

Compare the mailing labels you printed with the output shown in
Figure 11-44.
•

Don't forget to save a copy of the Customers fi le.

This completes Project 2. You have learned a lot about creating reports
usi ng the preset forma ts available in FileMaker. Project 3 wi ll lead you
through creating a n ew file and a custom layout using the blan k layout
o ptio n.

In Pro ject 1 yo u created a Custo mers file, and you produced reports from
that file in Project 2 . For Project 3 you will also use the Invento ry file,
which is included on th e Macintosh Journey Projects disk.
In this proj ect, you will create a n ew Sales Invoices fil e. You will c reate
a new layout startin g from a blank one, and you wi ll learn how to
interconnect this n ew file to the Cust omers and Inventory files.
You will lea rn how to place fields on the layout using the field tool, how
to add grap hi cs o bjects created in other applications, and h ow to add
lines and boxes to enhance the appearance of a layout.
You will use a customer number fi eld to link to in formation in the
Custom ers file and a part number field to link to the Inventory file.
You will create fie lds that can look up information in othe r fi les. For
example, the Name field can look up the customer num ber in the
Customers file and copy the customer's n ame into the Sales Invoices file.
In compl eti ng this p roject, you will learn to use many of the tools,
com m ands, and gadgets avai lable in FileMaker. You will also learn how
to forma t the information presented in a field.
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INVOICE

1417 $ outh Jonquil St.
Smyrna, GA 30829
(404) 555-7283

Auto Parts
Fax: (404) 555-6284

CUST NO
N AME
AD DR ESS

PART NO

1013
1007
1001
1008
1010
1002

IN VO I CE NUMBER
90005

1006
MI'S. Mat t i e L. Di lJJecc i o
14709 Ma i n Street
Gr ape Cr eek, NC 28087
QTY

SA LE S DATE
Oc t 29, 1990

DESCRIPTION

4
12
48
2
4
5

HEAD G,A.SKET
FLOOR MAT S
WI PER BLADES
KEY LOCK
RADIATOR CAP
WIPER MOTOR

75

I TE M COU NT

UNIT COST

$15.87
$35.68
$8.53
$36 50
$8.95
$36.95

EXT. COST

$63.48
$428. 16
$--109.--14
$73.00
$35.80
$184.75

S UB T OT AL
SALES TA X
SHIPPI NG COS T

$1,194.63
$65.70
$56.25

GRA ND T OT AL

$ 1 , 3 16 .58

Figu re 11 -83

Fin al o utput of Pro ject 3

BACKING UP CUSTOMERS AND 11 VENTORY FILES
If you were working in a real bus ness and you were usin g FileMaker to
manage the business's in form at i n , it would be vitally importa nt th at
you m ake regular bac ku ps of the informat ion in the files.
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This does not involve just saving a copy of a file periodically. Making a
backup implies that the copy is on a different disk. To protect yourself
as much as possible, you should keep two or three generations of
backups, and at least o ne copy sh ould be stored in a different building.
More than on e business h as been seriously hu rt when someone broke
into the building and sto le their computer(s). The really bad part o f the
story was when the thieves stole the backups of all the data, because the
backups were stored with the computers.
Theft, fire, or o ther catastrophic damage to your computer system,
wh en it is used to manage all of the information for a business, can be
a disaster. This damage can be lessened by getting into the h abit of
m aking daily backups of the information stored on the computer and
storing at least one copy off site.

CREATING SALES INVOICES
If you quit FileMaker after completing Project 2, yo u need to restart it .

•

Find the FileMaker icon and double-click o n it to start.

•

When the Open File dialog box appears, click New to create a new
file.

•

When the next dialog box appears, name the file Sales In voices and
then click New and save it onto your data disk.

Defining Field Types
You are once again p resented with the field Definition dialog box. You
will define 16 fields for t his fil e.

Number Fields
The fi rst four fields you will define a re number fields. They will be used
to h old the invoice number, customer number, part number, and
quantity ordered.

:3€ - N

,,.

Cli ck Number to ch oose the type of field.

..

Nam e the field Invo ice Number, and then click OK.

You will now select the entry options for this field.
,,.

Click on the field to select it, and then click Entry Options.

•

Click A new serial number: a nd type 90001 into the box.

This number represents the invoices for the year 1990, starting with
invoice number 001. This is a hint for creating invoice numbers. This file
will h ave invoices for years other than 1990.
You want each invoice to have a unique number, so yo u need to tell
FileMaker.
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•

Click Unique value only.

The Entry Options d ialog box should loo k like the one shown in
Figure 11-84.
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Figure 11-84

•

~ ~

Entry options for Invoice Number field

Click OK to accept the options.

The next fie ld will hold the customer num ber.
•

Name the n ew field Customer Number, and cl ick OK.

Create another fie ld to h old the part num ber.
•

Name the next field Part Nwnber, and click OK.

You must be able to store the quantity of each part that a custom er wants
to buy. This field will be named Qty, which is an abbreviation for
quantity.
,,. Name the next field Qty, and click OK.
This completes defining the number fi elds.

Date Fields
There is one date field for this file: Sa les Date.
You cou ld define this field as an auto-ente r fie ld and h ave FileMaker
en ter the current date wh eneve the record is added. In this case, t h at
option has not been chosen. If ypu accept orders over several days and
then process them a ll on one daf, you may e lect to enter the date they
were received as the sales date. f you always want the current date to
appea r o n the invoice, you can elect the entry option.
3€ -D

.. Click Date to ch oose the tyJ e of field.
•

Name the da te fi eld Sales Date, and click OK.
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You have now defined the first five fields, and t he Field Definition dialog
box should look like the one shown in Figure 11-85.
'
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First five fie ld definitions

Lookup Fields
The next five fields will be defined so they can lo ok up information in
the Customers fi le o r the Inventory file.
You will use the Customer Number field to serve as a link to the
Customers file, and the Part Number field will link to the Inventory file.
Fields used for this purpose are known as key fields or lookup fields.
The first four of th ese lookup fields will store text, and the last one will
store a number.
l}€ -T

,.

Click Text to choose the type of field.

•

Name the new text field Name, and then click OK.

•

Select the field in the list, and then click Entry Options.

•

At the bottom of the Entry Options dialog box, click Look up value
from another file, and then click OK.

You are p resen ted with a standard open file dialog b ox.
•

Double-click on Customers to link to that file.

The Customers file is read from the disk, and in a few seconds another
dialog box appears that contains three scrolling lists.
The top left corner of this dialog box shows the name of the field that
will receive the value looked up in the Customers file. The top right list
shows all t he field names defined in the Customers file and all ows you
to select which one to copy in to the field you are currently defining.
There are two scrolli ng lists in the middle of the dialog box. These lists
allow you to select the key field in each file.
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In this case, you want to copy th Full Name from the Custom ers file into
this n ew Nam e field. You onl want to do this when the Customer
Number field in the Sales Inv01ces fil e m atch es a value stored in the
CUSTOMER NUMBER field in the Customers fil e.
•

Click on Full Name in the "from 'Custo mers':" list.

•

In the "When what is typed in:" list, click on Customer Number.

•

In the "matches a value in:" list , click o n CUSTOMER NUMBER.

The dialog box should appear like the one sh own in Figure 11-86.
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Figure 11 -86

•

Dia log box for lookin g up Full Name

If your dialog box m atches the on e sh own in rigure 11-86, click OK
to accept the link.

Now you can use the sam e procedure to look up the address of t h e
cu stom er in the Custom ers file.
•

Create a new text field and name it Address. Click OK.

•

In the Entry Options dialog box for this n ew field, click Look up
value from a nother file. Click OK.

When you cl ick OK this time, you will not see the open file dialog box
because FileMaker expects you to continue looking up values in the
Customers fil e. You can cha nge t h e lookup fi le whenever you need to.
FileMaker re membe rs th at you are using the Custom er Number field in
the Sales Invoices file to link to the CUSTOMER NUMBER field in the
Custo mers file. All you n eed to s ecify this time is the nam e of t h e field
in the Customers file that cont in s the add ress.
'"•

Scroll to ADDRESS and click ~nit in the "from 'Customers' :"list, and
then cl ick OK (see Figure 1 ~-87) .
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Figure 11-87

Looking up the customer's address

Next, you need to look up the city/ state, and Zip code for the custo mer.
You could use three fields for this in this file, but let's take advantage of
the Address2 field you created in the Custome rs fil e in Pro ject 2.
.. Create a n ew text field and name it Add ress2. Then cl ick OK.
•

Select the Address2 field in the list, a nd then cl ick Entry Options
a nd make this fi eld a lookup field.

•

Tell FileMaker to copy the Address2 field from the Customers file
into the Address2 field in the Sales Invoices file . Click OK.

When you were creating the numbe r fields fo r the Sales Invoices fi le, you
created a field named Part Number. Lefs use tha t as a key field to look
up the description and unit cost of a pa rt in the Inventory fi le.
•

Create a text field named Description, acce pt it, ma ke it a lookup
field in the entry o ptions/ and click OK.

Th is time you want to look up values in the In ven tory file instead of the
C ustomers file .
•

C lick Switch Lookup File, and then whe n the o pen file dia log box
a ppears, double-click on Inventory.

In the lookup dialog box/ the top right list says "fro m ' lnven to ry' :11 now.
You will link the In ventory file to the Sales Invoices file using the Part
N umber fi eld in both files.
•

C lick on Description in the "from ' ln ventory':'1 list.

•

Click on Part Number in both m idd le lists.

Your d ialog box should look like t he one shown in Figure 11-88.
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•

Settings to look up Descri ption in the Inventory file

If everything matches, cl ick OK.

The last lookup field will store a number. Th e un it cost, or cost of o ne
part, is sto red in the Inventory fil e. You need to know the cost of one
item so yo u can multiply it by the quanti ty ordered by the customer to
determine the exten ded cost for that item.
~ -N

•

Click Number to choose the type of fi eld.

•

Name the new field Unit Cost, and ma ke it a loo ku p field.

The part num ber still links the Inventory and Sales Invoices files, so tell
FileMaker to copy the value in Unit Cost in the Inventory file into the
Unit Cost field in Sales Invoices.
•

Click on Unit Cost in the "from 'Invento ry' :" list.

,,.

If your screen looks like the one shown in r:igure 11-89, click OK.
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Figu r e 11-89

Setti n gs to look J p Un it Cost in the Inven tory file

This completes defining the lo okup fie lds for the Sales Invoices file.
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Calculation Fields
The next fie lds that need to be defined are six calculation fi elds.
You learned to crea te text calculation fields in Project 2, and yo u are
loo king up information in those fields and copying it into fields in the
Sales In voices file.
In th is project, you will create six simple calculation fields.
3€ -C

•

Click Calculation to choose the type of fi eld.

•

Na me the new field Ext Cost, and then click OK.

When you click OK, FileMaker shows the same dialog box you used in
Pro ject 2 to e nter a formula.
The formul a for the extended cost field is the quan tity (Qty) ordered
multiplied by the cost of an individual item (Un it Cost).
Enter the form ula Qty *Unit Cost by clicking on Qty in the fi eld Iist,
then clicking o n the asterisk(*), and finally clicking on Unit Cost
in the fie ld list (see Figure 11-90).
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•

Entering a formula to calculate extended cost

Wh en the formula is correct, click OK.

At the bottom of the Qty field in the invoice, you want Fi leMaker to
sh ow the tota l number of items ordered. Through experience, yo u have
determi ned that ch arging 75fT. per item will cover the shipping costs. To
calculate t he sh ipping costs, you first need to determine the total
number of item s ordered and then multiply that by $0.75. The first step
is to create the Item Count fie ld .
•

C reate a new number calculation field n am ed Item Count, and then
click OK.
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The Qty field will be for matted sa repeating field. Repeating fields can
hold more th an on e value. To ge the number of items ordered, you must
take the sum of a ll va lues entered in the Qty fie ld. The formu la for this
is sum(Qty).
•

Enter this formula by scrolling down the fun cti on list until you see
sum(), and t hen click on it. This moves the function to the formu la
and leaves the insertion point between the paren th eses. Now, click
on Qty in the field list to enter it between the paren th eses (see
Figure 11-91).
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~

Entering the formula for the Item Count fie ld

•

When your formula looks like the one in Figure 11-91, click OK.

•

Using the same technique, create a new calculation field named Sub
Total, and enter the following formula: sum(Ext Cost). Click OK to
accept the field and its definition.

This tells fileMaker to calculate the sum of a ll values entered in the
extended cost fie ld and put the result in the Sub Total field.
The next field will calculate sal11s tax on the order, wh ich is calculated
by multiplying the Sub Total b y 5.5 percent (or .055). When you
multiply the Sub Total (containing a value with two digits to the right
of the d ecimal point) by .055 (containing three digits right of th e
decimal point), you end up with a number with five digits to the right
of the d ecimal point. You want to round this resulting value to two digits
to the right of the decimal point.
Th e round(,) function will accomplish this. This function h as a comma
between the paren theses because it takes two arguments inside the
paren theses. The first argumentlis the value to be rounded, and in this
case tha t value is calculated by tlie formula Sub Total* .055. The second
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argument to the round function determines the number of digits to the
right of the decimal point that will be preserved. Therefore, the full
formula becomes round(Sub Total * .055,2).
This formula is shown in Figure 11-92.
15 File Edit ll!!mZIJI Gdd!Jilh rormut Custom Window
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•

Formula to calculate sales tax

Create a new ca lculation field named Sales Tax, and enter the
formula as shown in Figure 11-92. Click OK to accept it .

Had you only wanted to affect the number of decimal places displayed
instead of the actual calculation, you could omit the round function and
fix the number of digits with the Format Number command from the
Format menu.
Now you must create a new shipping cost field.
•

Create a new calculation field named Shipping Cost, and enter the
formula Item Count * .75. Click OK to accept it after you have
verified that it is correct.

The last calculation field for the Sales Invoices file is the Grand Total
field. This is the sum of the Sub Total, the Sales Tax, and the Sh ipping
Cost.
•

Create a new calculation field named Grand Total, and enter
the formula Sub Total + Sales Tax + Shipping Cost. Click OK to
accept it.

Your Field Definition dialog box should look like the one shown in
Figure 11-93.
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The formulas for the calculation fields

This completes the field definitions for the Sales Invoices file.
,. Click Exit to leave the Field Definitions dialog box.
,. This is a good time to save a copy of the file onto your data disk.

Entering Data
Now that you are in Browse mode, Jet's try entering a sales invoice into
the standard vertical layout that FileMaker just created.
Suppose that Ms. Kay Kusunoki sends an order for 3 wiper motors. Her
customer number is 1004, and the wiper motors have a part number of
1002.
,. Click just to the right of the Customer Number label to activate the
field.
,,. Type 1004 and then press Tab.
FileMaker looks up this customer number in the Customers file and
copies the customer information into the fields you specified (Name,
Address, and Address2).
Typing the Tab key accepts the information you entered into the
Customer Number field and then activates the next field: Part Number.
•

Type 1002 in the Part Number field, and then press Tab.

The unit cost and description are found and are copied into the
appropriate fields. FileMaker the attempts to calculate the Ext Cost,
Sub To tal, Sales Tax, and Grand Total fields. At this point, they all
contain zero values, because yo have not entered anything into the
Qty field .
•

Type 3 in the Qty field, and hen press Tab.

FileMaker recalculates the amounts in the fi elds (see Figure 11-94).
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First invoice with looked up and calculated values

Enter 10/29/90 in the Sales Date field to complete the transaction.

As it stands now, this layout has several problems. You can enter only
one item per invoice, and the dollar amounts are not formatted to look
like dollar amounts.
Let's solve this problem by creating a new layout . This time you will
begin with a blank layout and build it from there.
3€- L

•

Change to Layout mode.

3€- N

•

Choose New Layout from the Edit menu.

•

When the dialog box appears asking for the type of layout, click
Blank layout (see Figure 11-95). Then click OK.

Create a new l ayout which is a:

I.1:AEl

[Q9Q]

Figure 11 -95
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0
0

St andard l ayout
Columnar report layout
Label l ayout
®Bl ank l ayout

Creating a blank layout
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The first thing you will do to cr ate this new layout is to place a graphic
object.
•

Save a copy of this file, and then quit FileMaker.

Placing a Graphic
The B & K Auto Parts logo is included on the Macintosh Journey Projects
disk. It is stored twice on the disk. Both a MacPaint and a MacDraw
document are available. If you will be printing on an ImageWriter, it
doesn't make much difference which you choose, but if you are printing
on a Laser Writer, open and copy the MacDraw logo, because it will look
better when printed.
•

Using whichever application you prefer (or have available), open
one of the logo files, select the logo, and copy it.

•

Now that the logo is on the Clipboard, close the graphics application.

•

Open FileMaker again by double-clicking on the Sales Invoices icon.

•

Change to Layout mode.

You are back where you were before you quit, but now you can paste
the logo onto the layout.
•

Choose Paste from the Edit menu.

The logo will be placed onto the layout (see Figure 11-96).
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Figure 11-96
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Pasting a

Drag the logo to the top
Figure 11-97).

object from another application
the screen, into the header area (see
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.

Moving the logo into the header

You must enlarge the header so that the logo is entirely enclosed.
Placing the logo in the header area makes the logo appear on every page
printed from this layout.
•
r

Drag the Header part down below the logo (see Figure 11-98).
•
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Figure 11 -98

•

Dragging the Header part so it encloses the logo

Now drag the logo to its final position in the top left corner of the
layout (see Figure 11-99).
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Placing the logo in its final position

Adding Text Labels
Now, let's add the address and phone numbers into the header of this
layout. The default text is Geneva, 12 point, plain text, aligned left.
•

Click on the tex t tool.

If you wanted, you could scroll to the right in the layout window until
you could see the vertical Line denoting the right side of the page. You
could then enter the address and phone numbers in the top right corner
of the page. If you were printing real invoices, you would want to do this.
Since this is an exercise, it is more convenient to place the address and
phone numbers in the top right corner of the screen, rather than the top
right corner of the page.
,,. Click a couple of inches from the right side of the screen, near the
top of the header.
,,,. Type the following text into the header of the layout as shown in
Figure 11-100. (Press Return at the end of each line and again
between the phone number and fax number to make a blank line.)
1417 South jonquil St.
Smyrna, GA 30829
(404) 555-7283
Fax: (404) 555-6284
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Adding text information to the header

Now you can add the word INVOICE in t he header.
,.

Click about h alfway between the logo and t he address.

You can ch oose th e font yo u want to use and how it will appear by
making choices from the Format menu.
•

Ch oose a large, easy-to-read font such as Helvetica or Geneva, 18
po in t, underlined a nd bold, al ign ed center.

,.. Type INVOICE (see Figure 11-101).
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Forma t

Sales I nuolces

Entering m o re text in t he header

Drag th e text elem ents around inside t he header until you are
satisfied with their p lacem ent.

You are n ow ready to enter som e text labels into the body of the layout .
Select Gen eva, 9 point, bold , a nd a lign righ t fro m the Format men u.
Click in t h e body partofthe layout, and the n typeCUST NO, NAME,
and ADDRESS (see Figure 11-102).
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Entering text labels in the body of the layout

The next text to enter is the labels for invoice number and sales date (see
Figure 11-103).
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Adding text labels for fields

•

Click to the right of CUST NO and below the fax number.

·•

Select align left from the Format menu.

, . Type INVOICE NUMBER, ar d then press Return twice.
•

Type SALES DATE.

Your screen should look like the one shown in Figure 11-103.
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Adding Fields
It is time to drag some fields onto the layout, but first, you need to select
the style for the text in the fields.
•

Click on the arrow tool.

•

Choose Geneva, 9 point, plain text, and align left from the Format
menu.

•

Click on the field tool, and drag a fi eld onto the layout to the right
of the CUST NO text label.

A list will appear showing all the fi elds that are d efin ed in the Sales
Invoices file.
•

Double-click on Customer Number so the new field will show the
information you entered in the customer number.
a
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Figure 11 -104
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Adding the Customer Number field to the layout

•

Drag another field onto the layout, right below the first one, and
double-click on Name in the scrolling list.

•

Drag the Address field below the Name field.

•

Drag th e Address2 fie ld below the previous one.

Your screen should now look like the one shown in Figure 11-105.
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Enterin g the first four fields for this layout

Th e default len gth for the n ame and two address fields is not long
enough for all values. You can increase th e length of the fields quickly.
•

Drag the black square in the lower right corner of the Name field to
the right (see Figure 11-106).
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Figure 11 -106

...

Making the Name field longer

Now make the Address and Address2 the same length as the Name
field (see Figure 11-107).
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Extending the length of three fields

Add the Invoice Number and Sales Date fields to the layout as shown
in Figure 11-107.

Notice that the SALES DATE label obscures part of the bottom of the
Invoice Number field. You can fix that by moving the Invoice Number
field and label up higher on the layout.
•

Select the Invoice Number field and text label, and then drag them
up one line on the layout (see Figure 11-108).
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Moving the Invoice Number field and label
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This is a good time to save a copy of this file.

The next thing to be done is to add five text labels horizontally across
the layout (see Figure 11-109).
•

Click on the text tool, and then choose Geneva, 9 point, bold, and
align left from the Format menu.

•

Click below the address label, and then type PART NO.

•

Click a little to the right of that label, and then type QTY.

•

Continue clicking and typing in this manner until you have added
the other three text labels: DESCRIPTION, UNIT COST, and EXT.
COST.

You should now have five new text label objects (see Figure 11-109) .
,.

•
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Entering five new text labels

You can now enter the five fields that correspond with the labels you just
entered (see Figure 11-110).
•

Click on the arrow tool.

•

Choose Geneva, 9 point, plain text, and align left from the Format
menu.

•

Drag the Part Number field onto the layout.

•

Shorten the field as shown in Figure 11-110.
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Figure 11-110

•

Adding five new fields to the layout

Continue adding the fields, adjusting their position, and changing
their lengths until your screen looks like the one shown in
Figure 11-110.

Formatting Fields
FileMaker provides several formatting options that may be selected for
a field. This allows you to enter informatio n in on e format and to d isplay
it in another. For exam ple, th e entry date might be entered by FileMaker
as 10/22/90 but be displayed as Monday, October 22, 1990.
For all fields, you can select the font, size, style, and alignment of the
information displayed in the field. FileMaker offers additional formatting
optio ns for text, number, and date fields. A fourth type of forma tted
field is the repeating field. These formatting options are presented
below.
Text Fields

You h ave been formatting text fields in this project since you created the
blank layout.
Font, size, style, and alignment can be set for every field o r text ob ject.
All text within each field must be formatted the same, but all fields do
not have to be fo rm atted alike.
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Number Fields
Number fields can be formatted, or they can be left unformatted.
If you choose to format a number field, you have several choices. You
can choose to h ave FileMaker insert commas in fields that con tain a
value that is greater than or equal to 1,000.
You can choose to have FileMaker add notatio n characters to the
contents of a fi eld:
If you choose dollar notation, the field will be displayed with a
leading dollar sign and negative numbers will be enclosed in
parentheses.
If you choose percent notation, the number will be displayed as a

value 100 times greater than what it really is and will be followed by
a percent sign (%). For example, a sales tax of .055 would be
d isplayed as 5.5%.
You can specify a fixed number of digits to be displayed to the right of
the decimal point. A positive number of digits will round the number
to that many digits to the right of the decimal point. If you specify a
negative number of digits, the number will be displayed rounded that
many digits to the left of the decimal point.
For example, a value of 456.789 that is in a field with 2 fixed digits would
be displayed as 456.79. Th e same value in a field with 0 fixed digits
would be displayed as 457. If you specified -2 fixed digits, the number
would be rounded two digits to the left of the decimal point, and would
be displayed as 500.
Number fields can also be formatted to display the contents as a logical
Yes or No. If the field is empty, or if it contains non-numeric characters
(other tl)an Y, Yes, N, or No), it will be d isplayed as empty. If the field
contains a value of 0 (zero), No, or N, it will be d isplayed as No. If t h e
field conta ins any val ue except for 0 (zero), or if it con tains Yes or Y, then
it will be displayed as Yes.
The part number and quantity fields will contain integers (whole
numbers) only, so you wqnt to format them so they won't display an y
digits to the right of the decimal point.
•

Select the Part Number and Qty fields and then choose Format
Number from the Format menu.

•

When the dialog box appears (see Figure 11-111), click Fixed number
of decimal digits:, and enter 0 in the box. Click OK.
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Formatting fields to contain integer values

Figure 11-111

The unit cost and extended cost fields will display dollar amounts, and
should show dollars and cents. You should format these fields with
commas, dollar notation, and 2 fixed decimal digi ts.

r

•

Select the Unit Cost and Ext Cost fields and then choose Format
Number from the Format menu.

•

When the dialog box appears (see Figure 11-112), click Commas,
Notation: Dollar, and Fixed number of decimal digits:, and then
enter 2 in the box . Click OK.
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Figure 11-112

Formatting fields to contain dol lar amounts
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Date Fields
Date fields, calculation fields wlth date results, and date placeholders
(//) can be formatted to display Ihe date according to your preferences.
You can choose from five formats for date fields, plus one for unformatted
dates.
Unformatted date fields will display the date just as you enter it.
Let's format the date so that it will display the three-letter abbreviation
for the month, the day of the month, and then the four-digit value for
the year. Using this format, 10/22/90 would be displayed as Oct 22,
1990.
Select the Sales Date field and then choose Format Date from the
Format menu.

•

,,. When the dialog box appears, clickjul22, 1988 (see Figure 11-113).
Click OK.
'

•
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Formatting a date field

After all of the work you've done, you're probably wondering what the
invoice looks like now. Let's find out.
3€ -B ,,. Change to Browse mode.
The formats you specified have changed the presentation of the '
information shown in this layout (see Figure 11-114).
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Viewing the format ch anges

Notice that the Part Number, Qty, Unit Cost, and Ext Cost fields should
be aligned on t he right, so the numbers will line up correctly.
~- L

•

Go back to Layout mode.

•

Select the Part Number, Qty, Unit Cost, and Ext Cost fields and
then choose a lign right from the Format menu.

•

Make sure the labels above these four fields are lined up with the
right side of th e fields. Drag any labels or fields that aren't aligned
properly.

~ -B

•

Go back to Browse mode, and verify the alignment and format of the
fields you just modified.

~ -L

•

Return to Layout mode.

•

This is a good time to save a copy of the file.

Repeating Fields

Your custo mers usually o rder two to five d ifferent items with each order,
but this layout on ly lets th em order one item per invoice.
Let's make the bottom five fields repeating fields and allow for six entries
in each one.
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You can format any text, date, number, picture, or calculation field to
show more than one value by formatting the field to repeat.
•

Select the Part Number, Qty, Description, Unit Cost, and Ext Cost
fields.

,,. Choose Repeat from the F<Drmat menu, enter 6 in the Values box
wh en the dialog box appea rs (see Figure 11-115), and then click OK.
'
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Formatting fields to repeat six times

Figure 11-115

Each of the fields has n ow extended downward for five more lines (see
Figure 11-116).
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If you were to switch back to layout 1, you would only see the first item
in each of th ese fields, because the fields are only formatted for repeating
values in this layout. Any entries you made in this layout would still be
there, but you could not see or modify them in layout 1.

Adding Lines and Boxes
FileMaker provides the tools for adding lines, rectangles, rounded
rectangles, and ovals to a layout.
Let's draw rectangles around the repeating fields and their headings and
then separate the columns with vertical lines.

3€ - Y

,.

Click on the rectangle tool.

•

Choose a line width of 2 pixels from the Format menu . (Choose
the second line below hairline.)

•

Turn off th e invisible grid by ch oosing Invisible Grid from the
Gadgets menu.

"•

Draw a rectangle around the column headings as shown in
Figure 11-117.
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Figure 11-117

A rectangle surrounds the column h eadings.

·•

Change th e line width to 1 pixel (by choosing the line below the
hairline in the Format menu).

•

Draw anoth er rectangle, this time surrounding the repeating fields.
Be careful to align it correctly with the rectangle you drew around
the column headings (see Figure 11-118). Be sure that the rectangles
you draw do not overlap other rectangles or the fi elds. They must
completely enclose the fields without overlapping or touching
them.
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3€ - B

A second rectangle surrounds the repeating fields.

Choose Browse to see the results of the changes you have made.

•

Your screen should look like the one shown in Figure 11-119.
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Viewing the changes made in the layout

Change back to Layout

mo~e.

Now you are ready to add vertical lines to the layout to separate the
columns. There is an easy way to ensure that the lines are perfectly
verticaL FileMaker provides a gadget called T-Squares that will be useful
for adding these lines.
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Let's see if there is an y help available concerning lin ing up objects in the
layout.
:3€ -/

•

Open the Help file.

3€ -8

•

Choose Arranging Information from the Custom menu.

•

Go to record 5 of the 15 records found on this topic (see
Figure 11-120).
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Helpful information on lining up obj ects

This screen contains information about invisible grids and T-squares.
You should read this screen to learn mo re about using the T-squares.

The other 14 screens in this selection have valuable information that should
make more sense now that you have some experience working with layouts.
3€-W

•

After you have read this screen, close the Help file.

Now, you can use the T-squares to h elp you draw the vertical lines.
3€ -T

,.

Choose T-Squares from the Gadgets menu.

•

Drag the vertical part of the T-squares midway between the Part
Number and Qty fields.

•

Drag the h orizontal part of the T-squares to the exact bottom of the
rectangle surrounding the repeating fi elds (see Figure 11-121).

A magnet icon is showing below the part tool in the status and tool area.
The T-square lines are magnetic (will attract the po inter and any objects
it manipulates) when the magnet is black with lines emanating from it
(as it is in Figure 11-121).
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Positioning the T-squares for a vertical line

If the magnet is a hollow white outline (turned off), it means the
T-squares will not magnetically attract the mouse pointer.
•

If the magnet is turned off, click on it to turn it on.

•

Choose the line tool and set the width to 1 pixel.

Now draw the vertical line between the Part Number and Qty fields.
•

Starting at the top of the rectangle surrounding the column headings,
carefully align the pointer 9n the vertical part of the T-squares and
the top part of the rectangle.

•

Draw a line downward to the intersection of the two parts of the Tsquare, and then release the mouse button.

The "magnetic" properties of the T-square constrained the line to be
vertical and caused it to stop exactly at the bottom of the rectangle
surrounding the repeating fields.
3€ -B 3€ -L

•

Confirm that the line is correct by changing to Browse mode (see
Figure 11-122), and then return to the layout.
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The layou t after adding one vertical line

Click on th e arrow tool to select it.

•

Drag the vertical part of the T-square to the right an d place it
between the Qty and Descri ption fields.

•

Select the line tool.

•

Add a vertica l line separating these two fields.

•

Continue moving th e T-square and adding li nes until all the
columns are separated.

•

Confirm the placement of the lines by changing to Browse mode,
an d then return to the layou t.

Now you can add a box below the quantity column that will hold the
Item Count field.
00 -T

•

Remove the T-sq uare by ch oosingT-Squa res from the Gadgets menu.

... Use the rectan gle tool to add a box under the Qty field. Make it about
the size of the one shown in Figure 11-123. Do not overlap other
objects.
, . This is a good ti me to save a copy of the file.
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Adding the Calculation Fields
You have added all of th e objects to this layout except for th e calculation
fields and the text labels for those fields.
The first calculatio n field you will add to the layout is the Item Count
field. Adding a calculation field is just like adding any of the other fields:
drag a new field from the field tool, choose the name o f the field, and
ad just it for positi on, size, and font attributes.
•

Select the arrow tool.

•

Drag a field into the rectangle you drew under the quantity column,
and, after releasing the field, double-click on Item Count in the
scrolling list.

,. Place the field as shown in Figure 11-123, and size it so it fits entirely
inside the rectangle, without overlapping.
,..
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Adding the Item Count field

•

Ch oose Invisible Grid from the Gad gets menu to turn on the
invisible grid.

•

Choose Geneva, 9 point, bold, and align right from the Format
menu.

•

Add the text labels shown in Figure 11-124 to the bottom of the
layout.
I

, . Choose plain text from t hf Format m enu.
,. Drag the Sub Total, Sales !fax, Shipping Cost, a nd Grand Total
fields onto the layout (see Figure 11-124) .
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l.saJes. D.;M .. .. .. ..... J
Layouts:

PART NO

QTY

: ·.0·'·.·

~

2

L1AE;]
[gig§

DESCRIPTION

UNIT COST

EXT. COST

De~.~r.iQ!iQil.. ............. .

.......

... ....

.. .. . ..

I.Flel.d.....• l

:~
ITEM COUNT

SUB TOTAL
SALES TAX
SHIPP lNG COST
GRAND TOTAL

Sub TotalJ
Salos Tal<!
I...... ....SbloP.inq .Co~.\J

I. ...........Grand.TP.taU

---,

' :

~--- - ------------------------------- ------- ------

Figure 11-124

l

Layout #2 with all fields in place

A blank line was left between the Shipping Cost and Grand Total fields.
This was done so you can add a horizon tal line to indicate that addition
is being done.
•

Add a horizontal line between the Shipping Cost and Grand Total
fields (see Figure 11-125).

The last four fie lds you added to the layout represent dollar amounts, so
you should now format them as such .
•

Select the last four fields you added by clicking on one and then
Shift-clicking on the others.

•

Choose Format Number from the Format menu.

,.

Select Commas, Notation : Dollar, and Fixed number of decimal
digits: 2. Click OK.

Now you can make the grand total amou nt stand out by making it bold.
•

Select the Grand Total field, and then choose bold from the Format
menu.

Specifying Tab Order
You are almost done with this layout, but before you change to Browse
mode and enter some transactions, you need to change the tab order of
the fields.
In this type of layout, the top left field would be active first, and when
you type the Tab key, the next field to the right would become active.
If there were no more fields to the right, the next one down wou ld
become active.
You don't want to have to tab through the Name, Address, Address2,
and other fi elds, because the only information you will type into thi s
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form will be in the Customer Number, Sales Date, Qty, and Part Number
fields. You can change the tab order of the fields by selecting the fields
you will use and creating a tab g}oup.
•

Select the Customer Number, Sales Date, Part Number, and Qty
fields (see Figure 11-125).
j

r

File

Edit

Select

Gadgets

Format

Soles

8!
-2

Custom

Window

lnuolce ~

Heidt;:•

---~ - --- ---- - ---- --- - - -------------------- - - ----- -- ~·~··

Figure 11-125

Selecting the fields to make a tab group

If you can't select individual fie lds, it is probably because your rectangles

or fields overlap each other. Using the arrow tool and moving the
objects so they don't overlap should correct the problem.
•

Choose Tab Order from the Gadgets menu.

FileMaker displays a dialog box like the one shown in Figure 11-126.
li File Edit Select

r

Format

Custom

Window

Soles lnuoices

CUST NO

Tob Order
When browsing, FlleMaker will tab through all the
fi elds In o tob group before continui ng to the other
field s on the layout.
® Put the selected fields Into 11 tab group
He mol!!.> the S<!hH tetl lll•hls fl·orn their tab g•·oup

0

Figure 11-126

Dialog box for reating or removing tab groups

-

Select Put the selected fields into a tab group, and then click OK.

•

Click in a blank area of the layout to deselect the fields.

You have completed the creatio of this layout.
,.. This is a good time to save a copy of your file.
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Entering New Sales Invoices
Now that you h ave created this new layout, let's enter some transactions
and see how it works.
~- B

•

Change to Browse mode.

Suppose one of your customers, Ms. Sandra Hardin (customer number
1001), ordered 1 radiator hose (part number 1009) and 1 radiator cap
(part number 1010). Let's add a new record to process the transaction.
W-N

•

Choose New Record from the Edit menu.

You will enter the transaction information into this record and type the
date into the Sales Date field.
..

Type 1001 in the Customer Number fi eld, and then type Tab.

The customer informati on is read from the Customers file and displayed
on the screen.
•

Type 10/29/90 into the Sales Date field, and then tab to the next
field.

•

Type 1009 into the Part Number field, and then tab to the next field.

The contents of the Description and Unit Cost fields are read fro m the
Inventory file and displayed on the screen.
•

Type 1 into the Qty field, as shown in Figure 11-127, and then press
Tab to advance to the next field.

,. a

File

Edit

§0

Select

G<HI~Jeh

Format

Custom

.,

Window

Sales lnuoices

8!
-2

Record s:

2

INVOICE NUMBER

CUST NO j_"QQ}~~~~~~~~.·~~~.·~-~~~~~=~~~~~~~~~~J
N liME
dra M. Hardin
ADDRESS !497 Seemore Drive , Apt. 3

........................_.....,

i

f2Q.iii?.'f~~=.~~.~~·~~~=--J

,.l?..~b~~..Q.~I~................,

l.~.~~.~:Y.!.!!~...N..~.~:?.Q~.-- ......- ·- ··-···-·_j

l.!.Q/~?..(.?.9........_.._ ........)
EXT. COST

$5.63

:...........................................................! ! !""'""""""'""'"""'

t,··························································i,
;·····-·--··········-··········-·················· ······~

t····················-····································1

=··-·····-·······--··-······-···-·-··-·········-!

['0

'
I

i

t!·.·:.~·-·.·-~·.·.·.·:~.-...~.~~-.......~....~,i

i_..,..,...__,...,_,_j

SUB TOTAL
SIILES TIIX
SHIPPING COST

$5.63
$0.31
$0.75

GRIIND TOTIIL

$6 .69

Browse

F igure 11-127

Ms. Hardin's partially completed transaction

Ill

~I
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.. Complete the order by e9tering the proper information for 1
radiator cap.
The grand total for this order should be $1 6.88.
Th e next transaction, on 10/29/90, is from Mr. Gary Westmoreland
(#1008), who wants 2 engine mounts (#1014), 1 package of wiper blades
(#1001), and 1 door handle (#1004).
3€ -N

.. Add a new record, and enter the information to complete this
transactio n. Enter the current date for the sales date.
Verify that your results match t hose shown in Figure 11-128.
r

File

•

Edit

Select

G<1<l9Hh

0

Format

Custom

Sales I nuoices

B!
-

~~~lf6.f-:~·:.~~:~:~.~~.: : : ;

CUST NO ["_i_"iJ.'iJ.~:.·.·.·:.··.··.·:.·:::.·:.j::·.·.·:·.·.·:.·.·:.·.·.·.·} ...............................,
NAME !Mr . Gar\! H. Westmorel and
!
ADDRESS l2741 Highwa~ 141
l

3

Records:

PART NO

r··

--~·a;··4·:

F~~~:.~-i~~-~11
I
I

QTY

DESCRIPTION

UNIT COST

:-·········2·: !"E"r:iri'iN.E"M"ouN·r·-·
. :-···· ···1·2:98!
r·······-··,-; fw'iP.ER·a·cii·o-i:s·-·--·----·--··--·---··1 L:~=~:~~~-;~jj
[_-_::.~:-~:.TJ_. ro·ao·R--Ii'ii.Nc·c...............................
E---......................:i L.......----~-~:~?.J,·
r·~······~·······-··-··

l··············j .

.

t--·~·················~ ..f·.·.·.·.·.·.·.·.·.·.·.·.·.l. f·.·.·.·.·.·.·.·.·.··..·.·.·.·-~-·-·.·.·.·.·.·.·.·.·.·.·:.·.·.·:.-~·: .~·.·.·.·:.·.·~·.·.·.·.·.·__.·..·._·.. r.: -.~_:·_
·i_;

!.......................!

:

~

Browse

Lfii?.~i?.?.·f.,t_~·~·::: : : :::: :::;

l~~.a.~.h.~r.~~-~. ~f:..~-~.?..)..5...... ..........................1

3

[0

.,

Window

I

ITEM COUNT

I

..

SUB TOTAL
S ALES TAX
SHIPPING COST

$58 .47
$3.22
$3.00

GRAND TOTAL

$64 .69

PI

Figure 11-128

$25.96
$8 .53
$23.98

~.- -. .-· .-.·_· ~.-.·.·.·1.:

..·..·..·..·..·..·-.
· .·..·..·..·..·:_..

..............•,.................................. ..

EXT. COST

IQQJ

Mr. Westmoreland's order

Mr. Jim Bell (#1003) places an order next, and h e wants to purchase 1
mirror mount (#1005) and 1 fuel filter (#1012).
3€ -N

•

Add a n ew record, and enter the transaction.

Compare your sales invoice with the o ne shown in Figure 11-129.
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,. a

File

Edit

Select

G<HI9<lh

::o

Form at

Custom

.,

Window

Sale s lnuoices

8!
-

INVOICE NUMBER

cu~~~~ r£~~I~~--~;;;:::.·:::.·:~::.·::.·_·j·······-······-··-·····--:

4

r~·9.i?.i?.~:=:==-·:=~~:=~:.~~."J

ADDRESS ! 1492 Document Drive

Records :
4

PART NO

QTY

DESCRIPTION

UNIT COST

EXT. COST

!'''""''''1"! !11.iRRoR..i-1.ou~i·:r·· ·····················:
!"""""''1'1 fi'.u"E:t:·i'·ii:-T.£R······························1
i"'"'"'"'''i

Ill

SALES DATE

f.FiZ?."iZCi.i?.:::::::::~~:.~:.~::.~:J

t~!.n.g.~r..~!:\,..f..~..~.9.?.Q.9.....-···········-··········-·····.!

$17.26
$3 .15

i'' ''' '-' ' ' ' ' '''''' '''' ' ' ''''''' ' '''''' ''''"''"''"''' '"i

t.·..··~-~~·.·.·.·.·.·.t !-·················-·····-································!
l~·.·.·~- -..~·.·.·.·_. .·.·~---~-·.·.~·.··
i.............l
L..__ ,,,...l t.·.~-·-·.·~-.-.-~·- ..- ~.·~-·-·.~=-·.-.· -.· -.· -.~.- ·~~-·.·.·.-.-.~.-.-.~-J !__,,,,,,,,,_,_,,,,,,_
) .......... ............. .. ... ....... . ... ..... ......... ..... ,j

2
'----

rEJ

Browse

ITEM COUNT

SUB TOTAL
S ALES TAX
SHIPPING COST

$20.4 1
$ 1.12
$ 1.50

GRAND TOTAL

$23 .03

QI

IOQJ

Figure 11 -129

Mr. Bell 's completed o rder

The next order comes from Mrs. Mattie Dilbeccio of Grape Creek New
and Used Cars (#1006), and it is a large order. She wants to p u rchase 4
head gaskets (#1013), 12 floor mats (#1007), 48 wiper blades (#1001), 2
key locks (#1008), 4 radiator caps (#1010), and 5 wiper motors (#1002).
~ - .'J

Add another record, and enter the tra nsaction.

..

Compare your results with those shown in Figure 11-130.
r

a

File

Edit

Select

G <ld ~) <~ h

:o

Format

Custom

.,

Window

Sales I nuoices

8!
-

CUST NO [fQQ~.-:·:.-:::.-:.:~~~::::.~::~:=:~:.~J
NAME i Mr s. Mattie L. Dilbeccio
i
ADDRESS i 14709 Main Str eet
l!?.r..~P..~..g.r.~...~.l.• ~<:: ?.f!.Qf!.?....................... _..J

. .---·········--··-..,

5

Records :

..

5

PART NO

QTY

DESCRIPTION

INVOICE NUMBER

l9ooo§
..~.~!,~§J?..~J..!;...-··-···-··-

Lt.<:l./.?.2./_~9..........................!

UNIT COST

EXT. COST
$63.4B
$428.16
$409 .44
$73 .00
$35.BO
$ 184 .75

75
'-----

rEJ

Browse

ITEM COUNT

SUB TOTAL
S ALES TAX
SHIPPING COST

$ 1, 194.63
$65 .70
$56 .25

GRAND TOTAL

$ 1 ,3 16.5B

IQ

Figure 11-130

Mrs. Dilbeccio places a large order.

lJilil

I
0
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Next, you receive an order from s. Faye Mauney (#1005). She wants 1
package of window brackets (#1003) and 1 mirror mount (#1005).
W-N

,.

Enter the transaction, and compare your results with those shown
in Figure 11-131.
e5

r

File

Edit

Select

(iad~J<~1~

Format

Custom

.,

Window

Sales lnuoices

§0

8!
-6

[;§.~9.'~:~·.·:~.~~.~-~·~:::: : !

CUST NO [!§Q·~···:.:·.·:.·.·::.·::.·.·:.·.· ·.r ·::.·:::.·:.J ................................,
NAME !Ms. Fa~e Mauney
i
ADDRESS ~ 15 Mockingbird' Lane
1

Records :

rit-~.~~zf.i?.~.~·~·.·.·:.·: .· :: :::.J

lE!.~~.!~.9 •..!.~..~~9.!?.? ...........•...........................!

6
PART NO

QTV

UNIT COST

EXT. COST

rwiiioo\teR-,;;ci<Ei·s-·..···-······: :··············--ii791
fi1.iR.iiii·ii·FiouN_r........................1
l·-·-·······-··..·-···-·········- ········-···-··1 f.~::·.~.:~:.:T?:.:.~.~-1

$8.79
$ 17 .26

DESCRIPTION

t······-······· ···-t··················~··················~ ~-············-·········-··{

!···················-··················-··················:
~-·················~···-·· ............................... j

~-····························1

i...................L... ..................................! t.-.·.·.·.·.·.·.·.·.·.·.·-~.·.·.·.·.·.·.·.·:.-.-:.'.1
ITEM COUNT

[[j

SUB TOTAL
SALES TAX
SHIPPING COST

$26.05
$ 1.43
$ 1.50

GRAND TOTAL

$28 .98

Brows•

Figure 11-131

Ms. Mauney's order has been entered

The last order today is another G>rder from Grape Creek New and Used
Cars (#1006). This time, they order 24 radiator hoses (#1009), 12 fuel
filters (#1012), 2 engine mounts (#1014), and 60 fan belts (#1015).
W-N

•

"

Enter the order and compare it with the results shown in
Figure 11-132.
•

File

Edit

Sel ec t

0

Sales lnuoices

8!
-

:...........-.....................................:
CUST NO i 1006
!................................
NAME !Mrs. Mattie L. Dil beccio
ADDRESS l14 709 Main sjr•et
j
l§r:.a.P..~_g!.:!.~~./..f>:!f: ..?.?..Q.?..?•............................!

7

R•cords :
7

PART NO

QTV

L...................J l..............: L.......................................................!
98

ITEM

OUNT

'----

I
Brows•

[;.§~Ji:~::.-~.~=-~~~. :~·.-:.1
SALES DATE

Lfiiz~·?.z~i!·.·:.:·~:~:·:.-.-::.~:::::.-:J

UNIT COST

EXT. COST

c.-::.·.·.·.-::.-~·.·:.-.-.~:,:~:i!
' ................:>....!..?..!

$ 135. 12
$37.80
$25.96
$394 .80

DESCRIPT ION

r:~rt~JI f~ ~~~~I~~=f_;~

[[j

.,

G<ldfj(~h .Format Custom Window

'

12.98!

:::.-.:·::::.-:.-::.-:·:§·.:.~.~.1

L..........................J
;,........................... j

SUB TOTAL
SALES TAX
SHIPPING COST

$593 .68
$32.65
$73.50

GRAND TOTAL

$69 9 .83

1¢

Figure 11-132

Grape Creek New and Used Cars' second order
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This completes the data entry for today's orders.

PRINTING SALES INVOICES
Now, before printing the invoices, let's p review them to see how they
will look.
•

Choose Preview from the File m enu. Click Reduced.

If you designed your form small enough, you will see two records on the
previewed page, a nd that is not what you want. If you do have two
records showing on a page, there is a sim ple solution.
•

If you have this problem, change to Layout mode, drag the Body pa rt
farther down on the page, and then return to Browse mode.

Preview the page again . If the problem persists, change back to Layout
mode and drag the Body pa rt down some more until you only have one
record showing o n a page.
•

This is a good time to save a copy of this file.

Now that you have entered all the informatio n for today's tra nsactions,
and you have adjusted the layout to show only o ne record per page (if
necessary), it is time to print all seven of the invoices .
•

Choose Print from the File menu. Accept the d efaults by clicking OK
in the Print dia log box.

You have defined a number of fields in this file, so it is a good idea to
print a field d efiniti on report and save it fo r documentation purposes.
•

Choose Print from the File menu . Click Field Definitions, and then
click OK.

Your field definitio ns report should look like the one shown in
Figure 11-133.
Congratulations! You have com pleted Project 3.

Chapter 11: FileMaker

599

Field Na m e

Field Type

Formula I

Invoice Number

~lumber

Auto·er1ter sena l number 90008
Unique values only

Entry Option

ber

Customer Number

r~urr

Pa·t Number

' lumber

Oiy

I lumbe-r

Sal es Datf

oa· e

Name

Text

LOOI up "Full Name 1n 'Customers wne'l ·customer
Number matcnes 'CUSTOMER NUMBER"

A<.Jtlre""

Tt>xt

Loo«uo .. AODRESS" in "Customers" when · Cu:.torner Number"
matches 'CUSTOI"'ER NUMBE ~"

Address2

Tex t

Loo• up 'Address2" 1n "Customers w hen "Customer
Number· matches "CUSTOMER NUMBER"

Descnot ior.

Te~t

Loo• uo "Descr iption· 1n ' Inventory" when "Part Numoer·
matcnes "Part Number·

Una Cost

Nu~ ber

Loor uo "Uni t Cost · in Inventory· when 'Part Num ber·
matc1es Part Number

Ext Cost

Ca\cu lauon
Olumoe-J

= Oty · una Cost

1tern Count

Ca lculation
(Number)

a

Sub Total

Ca\culatro-.

- sum (Ex t Cos t )

sum (Qty)

( tJu mb ~r )

Sales Tax

Calculatlo'l
II lumber)

• round CSub Total '" 05S,2l

SniPPing Cos

Calcula::.lo'l
1Number l

- 1terr

Calcula~10n

=Sub Total • Sales Tax • Sh 1ppmg Cost

Grand Total

Count - 7S

('lumber)

Figure 11 -133

The printout of the Sales Invoices field definitions
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SUMMARY
• FileMaker provides excellent online help.
• Even though FileMaker automatically saves any changes you m ake to a fi le, it is importan t
tha t yo u regularly save a copy of the file a nd make p eriodic backups. This applies to any
application that manages important informatio n, n ot just to FileMaker.
• FileMaker has five main work modes: Define, Browse, Fi nd, Sort, and Layout. Define is used
to name the fiel ds and specify their type, entry option s, and fo rmulas. Browse is used to view
the fil e, add records, delete record s, and m odify information stored in the ex isti ng records.
Find is used to locate records with information that m atches a specific criteria. Sort rearranges
th e file in ascending or descending order based on the contents of one or more sort fields.
Layout is used to create a variety o f reports and screens for editing, displaying, and printing
the contents of the file.
• Six main field types are ava ilable in FileMaker: text, number, date, picture, calculation, an d
summary.
• Entry options are available for au tomatically entering information, providing a list to choose
from, and specifying criteria that FileMaker w ill check b efore accepting an entry into a field.
• FileMaker provides the ability to print several types of repor ts: detail rep orts, summary
reports, labels repo rts, and fie ld definitio n re ports.
• FileMaker h as a variety of tools available fo r creating and m od ifying the layout of screen s and
reports. These too ls include: a rrow tool, text tool, line tool, rectangle tool, rounded rectangle
tool, oval too l, field tool, a nd pa rt tool.
• The three main pa rts of a layout are: header, body, and footer. Title parts and summary parts
are a lso ava ilable.
• FileMaker provides the capabili ty to preview re ports before you commit th em to paper.
• Fi leMaker allows you to crea te four ty pes of new layouts: sta ndard, colu mnar, label, a nd
blank.
• Fi leMaker has the ability to look up information in one fi le and copy it into another based
on a common value stored in a key field .
• You can format fields to change how they display and prin t t heir contents.
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KEY TERMS
1-up labels
3-up labels
active record indicator
arrow tool
ascending order
backup
blank report
Body part
book
Browse mode

labels report
Layout mode
line tool
lookup field
number field
oval tool
part tool
picture field
record
rectangle tool
repeating field
rounded rectangle tool

calculation field
columnar repo rt
concatenate
date field
Define
descending order
detail report

search criteria
slide control handle
Sliding objects left
Sliding objects up
Sliding part up
Sort
sort field
stat us area
string literal
Sub-summary part
summary fi eld

field tool
field
file
Find
Footer part
footer
Header part
header

T-squares
text tool
text field

key field

FILEMAKER II COMMAND KEYS AND SHORTCUTS
Apple Menu
Help

3€ - /

File Menu
Close
Preview
Print
Quit

3€
3€
3€
3€

-W
-U
-P
-Q
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Edit Menu
Undo
Cut
Copy
Paste
Select All
New Record
Duplicate Record
Delete Record

(Browse Mode)
3€ -Z
3€ -X
3€ -C
3€ - V
3€ - Y
3€ - N
3€ -D
3€ - E

Select Menu
Browse
Find
Refind
Find All
Sort
Layout

3€
3€
3€
3€
3€
3€

Gadgets Menu
T-Squares
Invisible Grid

3€ - T
3€ - Y

-B
-F
-R
-G
-S
-L

ADDITIONAL PROJECTS
The following project is accompanied by briefer instructions than those
you have previously completed in this chapter. If necessary, refer to the
previous projects in this chapter for information and step-by-step
instructions for any command that you don't remember how to use.
Also, FileMaker's Help file contains valuable and easily accessed
information. You will not be reminded to save your work-by now you
should be thinking of that on your own.

Project 4: Creating Summary Reports
In Project 4 you will learn to create a summary report that organizes all
sales transactions by customer, lists information about each sales
invoice, summarizes total sales by customer, and provides final summaries
about all the sales invoices as a group.
You will learn to create two new parts: a sub-summary part that
summarizes information for each customer when the file is sorted by
customer number and a grand summary part that provides information
about all the transactions as a group.
You will learn to create a new layout by duplicating layout number 2
that you created in Project 3 and then modifying it for this project.
You will also learn how to select sales invoices that fall within a range
of dates. This gives you the ability to display or print a summary for a
particular month, quarter, or year in addition to summarizing all of the
transactions in the file .
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INVOICE

Auto Parts
NAME
SALES DATE

Fax: (404) 555-6284
CUST NO
SUB TOTAL

INVOICE "

Ms. Sandra M. Hard in
Oct 29. 1990
Mr. Jim

Ms. Faye

$0.80

1003
90004

$1 12

1004

90001

$6 10

1005

$2.25
$28 .98

$26.05

Mrs. Ma tt i e L. Dllbecc lo

$1 .50
S I 19 .2 0

$ 110.85

90006

$ 1.50
$23.03

$20 4 1

Mauney

Oct 29, 1990

$ I 6 . 88

$ I 4.58

90002

Ms. Kay B. Kusunol< 1
Oct 29, 1990

MONTHLY INVOICES
SHIPPING COST

SALES TAX

1001

Be ll

Oct 29, 1990

1417 Sou th Jonqui I St.
Smyrna, GA 30829
(404) 555-7283

$ 1.43

1006

II 50
$2,0 16. 4 1

Oct29, 1990

90005

$1,194.63

$65.70

$56 25

Oct 29, 1990

90007

$593.68

$32.65

$73.50

Mr. Gary H. Westmoreland
Oct 29, 1990

1008

$64.69

$58 47

90003

$3.22

$3.00

Monthly Invoices

$2,269. 19

Average Sal e

$288 38

Largest Sale

$ 1,19-163

Total Sales Tax

$ Ill 02

Smallest Sale

$14 58

Total Shipping Cost

$139.50

Private and Confidential

Internal Use On ly
Page 1

Figure 11-134

Final o utput of Project 4
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DUPLICATING A LAYOUT
To begin this project, o pen FileMaker a nd save a copy of the file.
If you h ave been experim enting with the Sales Invoices fi le, check the
status area to see that the file is n ot sorted and that all records are
currently being browsed.
3€ -S

•

You can be sure the file is not sorted by choosing Sort and then clicking
Unsort in the dialog box.

3€ -G

•

All records ca n be browsed by choosing Find All from the Select
menu.

3€ -L

•

Change to Layout mode, and scroll to layout 2.

You will now be looking at th e layout you created in Project 3. Let's
du plicate this layout.
3€ -0

•

Choose Duplicate Layout from the Ed it menu.

MODIFYING A LAYOUT
You will now see that there are three layouts associated with the Sa les
Invoices file.
Let's delete all the fields, text, and graphics objects that won't be used
in this report.
•

Select the fields and text labels shown in Figure 11-135. You can use
Shift-click to add objects to the selection. Press Backspace (o r Delete)
to delete these ob jects.

s

r

File

Edit

§0

Select

Gadgets

Format

Custom

.,

Window

Sales lnuoices

8!
-

H~2~!----------------------------------------------INVOICE NUMBER

!InYoice. N~(l)ber. .. . ... J

3

Layo~ts:

3

~
Address2
•

SALES DATE

~

------ -- - - ------

lllj§IHaliJai
Gr.a.r~ll

(D

121

Layout

Figure 11-135

TPtaJ.

Selecting the ob jects to be deleted

, . Now delete the rectangles and lines that are not needed in this
layout.
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You will be left with a layo ut th t contains most of the fields and text
you will use for this project (see Figure 11-136).
,. ei

File

Edit

Select

Gadgets

Format

Custom

.,

Window

I

---·----------------------------------------------INVOICE NUMBER
i.lnvoic,. Nvrobtr; ...... J

0

SALES DATE

l.$~)9$, D.~t9.

Layouts:
3

0

0 0

0

0

0 0

0 0

0 0

J

l.flel.d.... .• ,

Figure 11-136

The layout after deleting unnecessary ob jects

The bod y section will be much smaller in this layo ut, and yo u n eed to
make mo re room in the footer fo r later use.
•

,.

Scro ll down in the layout until you can see the Body part icon. Drag
it back up to just below the Shipping Cost fi eld. Drag the Footer part
to about 2 inch es be low the Body part (see Figure 11-137).
•

File

8!
--

Layouts :
3

Edit

Select

,

L------------------------------------------------

Figure 11 -137

Adjusting the Body and footer parts

.,
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You need to make the header about an in ch larger. You will put two rows
o f column headings in the h eader and add a line above and below these
h eadings.
•

Drag the Header part d own about an inch or so (see Figure 11-138) .
Custom

.,

Window

(404) 555- 7283
Fex: (404) 555- 6284
Layouts:

3

NAME
- -~LF.S DATE

INVOICE

'*

CUST NO
SUB TOT AL

SALES TAX

~~~~:~~ ~~ber .. ?.......... . . J
IHeJ.d ... ... l

Figure 11-138

Un'loic~. Number. ..... . J
l.s~Jes. Pale.

..J

Adjusting the objects in the header

•

Now you need to drag the text labels from the bo dy area into the
h eader area, as shown in Figure 11-138. Don't fo rget that you can
use the T-squa res to m ake this process easier and n eater.

•

Cha nge Invoice Number to Invoice# to m ake m ore room fo r the
other column h eadings.

Since every customer in th e summary repo rt will have at least two lines
of information, you can make the first line bold and the second line
plain to help differentiate them and make it m ore obv io us w hich
headings refer to which data item s.
·•

Change the second row of h eadings (starting with Sales Date) to
plain text.

,,. Add a 2-poi nt ho rizonta l line belo w the fax number a nd a 1-point
h orizontal line under the column h eadings and completely inside
the h eader.
•

Drag the Header part up to just below the second line you just added.

You now have the header for this report completed . In Project 3, there
were only three parts to the layout: t he header, the body, a nd the footer.
In this layo ut, two mo re parts will be added : a sub-summary and a grand
summary.
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ADDING A SUB-SUMMARY PART
ln this report, you will list each customer one time and, below that,
importan t information about each transaction completed by that
customer. You want the customer name to only show once, and you
want to show the customer num ber and the total of a ll t ransactions that
are listed for that customer. To do th is, you will add a sub-summary part
that wi ll be used in the report wh en the fil e is sorted by customer
number. Then, you will list the transactions in the body sectio n of the
report.
_.

Drag a new part onto the layout about an inch or so below the
header.

A dialog box will appear to let you select which body part you want this
one to represent.
,.,. Click Sub-summary when sorted by:, and then click on Customer
Number in the scrolling li st to the right (see Figure 11-139).

*

File

Edit

Select

Gadgets

Forma t

Custom

Window

(404) 555-728 3

0

1111e Ue<lde.-

I nuolce Number
U\lomer Number
0 Uody
Port Number
®S ub- summary when sorted by: Qty
0 Grand Summary
Soles Da te
0 rootl'r
Name
0 1111e rootpr
Address
Address2

OH<Hrd<w

0

Figure 11-139

•

Page brenk

Adding a sub-summary and sort requirement

Move the Name and Customer Number fields into this sub-summary
a rea (see Figure 11-140).

You can use the T-squares gadget to h elp in aligning objects in the
layout. Resizing and moving the fi elds and text labels will also be
n ecessary to get good use of the space available.
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..,

45 Fil e Edit Select Gadgets Format Custom Wi ndow

r

(404) 555-7283
Fax: (404) 555-6284
La~ outs.
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SALES TAX

SHIPPING COST
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1
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lsales. D.~te .......... J

2 .537'"

Figu re 11-140

•

Moving field s into the sub-summary part

Add a 1-po int h orizontal line at th e top of the sub-su mm ary area to
separate each customer.

Now you need to move the fields t hat wi ll be in the body into a row just
below the sub-su mmary.
•

Move the Sales Date, Invoice Number, Sub Total, Sales Tax, and
Shipping Cost fields into a row in the body o f the layout (see
Figure 11-141).

•

Drag the Body part up just below this row o f fi ve fields.

Fax: (404) 555-6284

i.HeJ.d.....• l

Figure 11-141

Placing fields in the body area o f the layout
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DEFINING SUMMARY FIELDS
At the end of the report, you want some info rmation to be presented
about the records in the file as a group. When you are managing a
business, it is usefu l to know basic statistical information about your
sales. Let's calculate the average amount of all the sales and determine
the largest and smallest purchases, the total amount for all transactions,
the total sales tax collected, and the total amount collected to cover
shipping costs.

You want this info rmation to print just o nce, and you want to reflect
summary informatio n about the file as a whole, so you need to define
six summary fi elds, create a summary part, and place the fields into
that part.
Let's d efin e the summary fie lds first.

W-S

•

Choose Define from the Select menu .

•

Click Su mmary to designate the type of field, and name the first
fi eld Monthly Invoices. Click OK or press Return .

A dialog box wi ll appear on the screen (see Figure 11-142), and
you should click Total of and select Grand Total in the scrolling list
o f fi elds.
'

•

File

Edit

l!lii!ZIII Gadgets

Format

Cu stom

Window

~

Soles lnuolces
Fiel d De finition
Summ ary Formulo:

Monthl y lnuoices •
@ Tot al of
0 Ruerage of
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O Minlmum
O MaHimum
0 Standar d Deulotlon of
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Unit Cost
EHt Cost
Item Co unt
Sub Total
Sales ToH
Shipping Cost
I

0

•

::~1~
:~;:

·Jl!

i!'f'

I

Running toto I

=•u' ""u' !l

Figure 11-142

f¥..,,,

~ (cancel)

-·

Defining the Monthly Invo ices summary field

Using this method, defin e ~he other five summary fields (Average
Sale, Largest Sale, Smallest Sale, Total Sa les Tax, and Total Shipping
Cost) as shown in Figure 11-143.
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'

•

File

Edit

Window

Field De finition
Shipping Cos t
Grand Total
Monthly lnuolces
Ruer age Sale
largest Sal e
smallest Sole
Total Sales TaH
Total Shipping Cost

•
•
•
•
•
•
•
•

Field name:

Field type:
O TeHt

XT

O Number

XN

0

XD
XP
XC
XS

Item Count • •75
Sub To tal • Sales TaH • Shippi ng cos t
Total of Grand Tota l
Rue rag e of Sub Total
MaHimum Sub Total
Minimum Sub Total
Total of Sales TaH
Total of Shipping Cost

Date
O Picture
0 Calculation
@ Summary

Figure 11-143

!!'!

£ntrtj D1111ons

flefonnutale
( Oesele< t J (
( Del ete ]

OK

L§C~

Formulas for all th e summary fields

When you exit from the Field Definition dialog box, FileMaker adds
these new fields into the body of the layout and makes the body large
enough to ho ld them (see Figure 11-144).
..

•

File

Edit

Sel ect

.,

Ga

INVOICE

14 17 South Jonqui I St.
Smyrna, GA 30829
(404) 555- 7283
Fax: (404) 555- 6284

Figure 11-144

FileMaker adds the new fields to the layout .

-

Select these fields, and format them as Geneva, 9-point, plain text,
and align right.

•

Format the summary fields to d isplay currency with commas, dollar
signs, and 2 digits to t he right of the decimal point .

You want to use the Monthly Invoices field in two different ways in this
layout. If you put this field into the sub-summary section of the report,
it will show the total amo unt of all purchases by that particular
customer. If you put this field into the grand summary section, it will
show the total amount of all purchases made by all customers.
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You will duplicate this field (and its text label) and place one Monthly
Invoices field in the sub-summary area. Then you will create the Grand
Summary part and put the other Monthly Invoices field into the grand
su mmary area.
-

Deselect the fields, and then select just the Monthly Invoices field
and its associated text label, copy them, and paste them back into
the layout. Move the new objects to any white area wh ere you can
' see them.

•

Move the Monthly Invoices field into the sub-summary area and the
text label into the header, as shown in Figure 11-145.

•

Format the Monthly Invoices field in the sub-summary area to
display bold text.

•

Rearrange the remaining six summary fields and their text and drag
them into the footer. Then drag the Body part up to just below the
Sales Date field.

ADDING A GRAND SUMMARY PART
Now you need to create the Grand Summary part and place the
summary fields inside it.
•

Drag a new part into the footer below the six summary fields, and
when the dialog box appears, click Grand Summary.

•

Arrange the fields and their text labels as shown in Figure 11-145.
Add a 2-point line at the top of the grand summary area to separate
this section from the last customer.

r

a

File

Edit

Select

God ets

I ... .

f~aJSL__

Figure 11-145

Format

Avt!j~Ot. S~liJ

I. ...... L.v:oes.tS~liJ
I. .....Smi.lles.tSalil

Custom Window

Honthl\1 lnvoic.s
Tobl S~les T~x

I..MPn\bN.InY.Q\QeiJ l
I. ...TP.ta\Sales.T.aliJ

Tobl Shipping Cost IJotaJ.SIIippin? .CP$011

Placing a grand summary part and its fields

.,
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•

Add a page number placeholder in the footer, as shown in
Figure 11-145.

This report is for your use only, so it should be labeled as private.
•

Make the footer a little larger, and add two text blocks. The first text
object should say Private and Confide ntial, and the other should say
Internal Use Only.

Your layout should now look like the one shown in Figure 11-146.

.,

el File Edit Select Gadgets Format Custom Window

r

Bi
3

Layouts:
3

. ___
! ~or~ 1---

Largest Sal•
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I. ...... LW.Q~s.t Sal!J
I. .....Sro.lll~s.t Salil

Honthl\1 lnvo;ces 1. . 1':1Pnt~ly .lnY.Q\qtiJ
Total Sales Tax

I... .TP.t~\ S•lu. T.~>IJ

Total Sh;pp;ng Cost l:r.olal.SI\iPRin9.CPJiOII

6~~~~~~~~1 - -- --------------- --------------------- --Internal Use Only

Figure 11 -146

.

:'

Th e last text objects h ave been placed.

You have completed designing the layout form, so Jet's see what it looks
like when you browse and preview this report.

BROWSING AND PREVIEWING THE REPORT
W- 13

..

Choose Browse from the Select menu.

Your screen should look like the one shown in Figure 11-147.
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,..

e5
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Edit
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SALES DATE
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SALES TAX
SHIPPING COST

Oct 29, 1990

90001

$ 110.85

$6.10

$2.25

Oct 29, 1990

90002

$14 .58

$0.80

$1.50

Oct 29, 1990

90003

$58 .47

Oct 29, 1990

90004

$20.4 1

Oct 29 . 1990

qnnnc;

$1 .194.63
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Page""
Brows•
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Figure 11-147
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Fex: (404) 555- 6284
CUST NO
SUB TOT AL

INVOICE •

1417 South Jonqui 1 St.
Smyrna, GA 30829
( 404) 555- 7283

Pri vote and Confidential

10

.,

lrormut Custom Window

Browsing the Sales Invoices re port

Where are the custo mer n am es, customer numbers, and total invoice
amounts?
The sub-summary part will only take effect when the report is sorted by
customer number.

3€ -S
3€ - U

--

Sort the file by customer number.
Preview the report (see Figure 11-148).

You can see that the report is working like you wanted.
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Previewing your summary report

Now you can ex it the preview.
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PRINTING THE REPORT
This report layout is completed . Now is a good time to print the report
and the field definitions fo r the file.
~ -P

•

Print the summary report, and then print the field defin itio ns.

SELECTING INVOICES WITHIN A RANGE OF DATES
You now have a report that will give you summary information about
the entire file, but it would be mo re useful if you could te ll Fi leMaker to
summarize all transactions for a particular period of time.
FileMaker provides the capability to produce this type of summary
report. You will use the report layout you just designed, and all you h ave
to do is select all the records that match speci fi c criteria.
You can choose a summa ry o f al l transaction s by one customer by using
the Find command. If you select Find, a report appears on the screen
showing rectangles whe re the fi eld info rmatio n would normally be. If
you type the cu stom er number into the Customer Number field and
click Find, all the tran sactions for that customer appear. (You would still
have to remember to sort by customer number after finding the records
so the sub-summary sectio n wo uld be activated.)
Another use for the Find com m and is to select all transactions within a
particular range of dates. For instance, you can te ll FileMaker to find all
sales invoices with sales dates that are between 10/1/90 and 10/31/90.
This would select the records yo u entered in Project 3.
Let's record some sales transactio ns for July 1991.
~-L

~-B

-

Switch to layout 2 and ch oose Browse mode.
Ente r the following four sales transactions.
7/14/91, Customer #1002 purchased 2 #101 7 h eadl ights and 1
#1019 battery.
7/15/91, Custom er #1005 purchased 1 #1020 fuel pump.
7/18/91, Custom er #1007 purchased 1 #1018 voltage regulato r and
1 #1019 battery.
7/22/91, Customer #1009 purchased 2 #1017 h ead lights, 1 #1018
voltage regulator, and 1 #1020 fuel pump.

~

-L

•

Switch to layout 3.

Let's find all sales transactions fo r July 1991.
~-F

•

Ch oose Find from the Select menu. Type 7 / 1/9 1...7/31/91 into the
Sales Date field.

Don't worry if it doesn't all sh ow. just type ca refull y, o r ch ange to the
layo ut and make th e sales date longe r.
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... Click Find.
~

-S

•

Sort the found reco rds by custom er number.

.

When you preview the report, you sh ould see a screen like the on e
sh own in Figure 11-149 (when you scroll a little).

,.
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•
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Previewing the summary rep ort fo r July sales

Exit the preview wh en you are read y. Print the report if you wan t.

If you want to see a summary for all the records in the fi le, you can easily
do so .
~

-G

~ -S

•

Ch oose Find All from t he Select m e nu, and then sort by customer
number.

616

Part V: Information Management

When you preview thi s report, your screen should look similar to the
one shown in Figure 11-150.
r

-'

•

Edit
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Formnt
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~to

1417 South Jonquil St.
Smyrna, GA 30829
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INVOICE

Parts
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.,alh•st Sal e
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Figure 11-150

•

Previewing all sales

recor~s

Exit from the preview.

You can produce many types of summary reports using this layout. If
you want more information about select ing records using the Find
command, try looking in the Help file.
You try a report now.
-

Print a report showing all transactions during the period from july
15, 1991, through july 18, 1991.

You might try adding a few more sales transactions and previewing or
printing some more reports.
Congratulations! You have completed all the FileMaker projects.

617

Chapter 12: HyperCard

Chapter 12: HyperCard 1.2
What You Will Learn in This Chapter
After reading this chapter and completing the projects in it, you
should be able to:
•

Understand wh at a stack is and how it can be used

•

Open stacks an d browse through the information in them

•

Add an d modify the informatio n in stacks

•

Create a n ew stack usi ng HyperCard's auth oring features

•

Create, modify, and use butto ns to contro l HyperCard's actions

•

Create, modify, and use fields to store information

•

Use the painting tools to change the appearance of stacks

•

Store graphics in stacks

•

Add visual effects to your stacks

•

Print the cards from a stack

•

Print a report based on info rmation stored in the cards of a stack

his chapter introduces you to all these aspects of usin g HyperCard,
but it does not attempt to cover all the features of the program.
Several excellen t books have been written that cover the entire
program, including referen ces to the HyperTalk scripting language a nd
samples of using it.

T

STARTING HYPERCARD
•
HyperC.:wd

Start HyperCard by double-clicking on its icon.

Whe n HyperCard opens, it p resents you with the Home stack, as shown
in Figure 12-1. Your Home card may look different from the one sh own.
HyperCa rd allows you to customize the Home stack.
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Stack Ideas

Quotations

6:52PM

HyperCard's Home stack

You can see a number of icons on the Home card. Each is linked to a card
in an other stack. Unlike icons on the desktop, you don'thave to doubleclick on one to open it. In HyperCard, all you do is click on ce on the
button, and it will then do whatever it is programmed to do. In this case
each button is programmed to take you to a specific card or stack.

USING THE GO MENU
Before you start jumping around to t he diffe ren t stacks, you should
know how to use the Go menu .
Some stacks allow yo u to m ove freely within the stack, an d some do no t.
Sin ce HyperCard is customizable by many people, you can assume
certain types of buttons will respond in a particular manner when you
cl ick them. However, their response to your click may not always be as
yo u assume.
The first thing to notice is tha t the Go menu is divided into three groups
of commands . The top group is designed to allow movement inside a
stack or to other stacks. The middle group is for use in moving inside one
stack, and the bottom grou p is important because it lets you issue
comm ands directly to the stack. These commands may be as varied as
th e number of people using the stack and can include most of the
HyperTnlk commands.
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t~e

Back

takes you back to
last card you visited, even if it was in
a completely different stack.

Home

takes you directly to the Home card.

Help

takes you to the opening card of the Help stack, which
contains a very large collection of information about
HyperCard. If you really want to get off to a flying start
with this program you should become familiar with the
use of the Help stack. Many people have learned to use
HyperCard just through the information contained there.

Recent

shows a collection of up to 42 of the last cards you have
looked at. You can return to one of these cards by clicking
on its picture.

The next group of commands lets you move around inside the current
stack.
First

takes you to the very first card in the stack, even if it is on
a different background.

Previous takes you to the card just before the current card. This is
generally the same as clicking a left arrow button.
Next

takes you to the next card in the stack, and works the same
as most right arrow buttons.

Last

takes you to the very last card of the stack.

The last group of commands allows you to do many different things,
depending on what you do after you issue the command.
Find

allows you to find a word, phrase, or even just a few
characters that appear in any field in the stack. It is a very
powerful command and searches very quickly to find
information, even if you can remember only a portion of
it. For example, if you can only remember a person's first
name, HyperCard can still find that person in an address
stack.

Message shows the Message box and allows you to type one line of
HyperTalk commands.

EXPLORING THE INTRO STACK
The Intro stack is a friendly introduction to HyperCard. It is not really
a tutorial, but it introduces you to some of the concepts involved in
using HyperCard.
,.. Cli ck the button named lnt o.
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( What Is
(

Figure 12-2

..

HyperCard~~
1

Go back

)

lntro stack opening ca rd

Click the What is HyperCard? button.

The Intra stack takes you th rough a brief introduc tion to HyperCard.
Each ca rd has an arrow pointi ng to the right. When you have fin ished
reading t he card, click on the right arrow to advance to th e next one (see
Figure 12-3).

HyperCard is a personal toolkit
You cen use Hyper Card t o crea t e you r own ap plication s
for ga t he r ing, or gani z ing, presenting, search i ng , end
customizing In f ormation .

Figure 12-3

The second card in the lntro stack

Continue workin g through the Intra stack until you come to the last
card. In a few minutes you will arrive at the card shown in Figure 12-4,
except that the rectangles will no t be showing. In fact, it may be a little
difficu lt someti mes to tell where buttons are located since they can be
made transpa rent.
~Option

•

Press the Command and Option keys at the sam e time.

621

Chapter 12: HyperCard

You will now see a rectangle drawn around each butto n on the card (as
shown in Figure 12-4).

What next?
Clt ck He lp cards t o f ind ou t mo r e aDou \ explori ng
Hy perC ard end mak ing sleek s of your ow n.
Or cl i c k Home and re l y on se r and l pl\ y to uncov er t he
une x pe c \ed.

-·-··----·to explore on my ownJ
@Home
-----------1-'-----

Figure 12-4

Using Command and Option to see the buttons

When you release the two keys, the rectangles will once again disappear,
but now you know exactly wh ere the buttons are. This feature is useful
whenever you are not sure what buttons are available on a card.
•

Now th at you have found the button s, click the Help cards button.

GETTING HELP
Figure 12-S shows the first card o f the Help stack.
The Hype rCard Help stack is a powerful learning tool and will remain
a useful refe rence even when you have become an experienced user.

HyperCard
Help
0 Int roduct ion
Cli ck the Browse tab bel ow
aft er you've seen the
Int roduction.

Figu re 12-5

The Help stack's opening card
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Notice that the Help stack looks like a spiral bound set of flip cards, or
a notebook turned sideways. The ta bs along the bottom look li ke and
function as index cards. To select the index card of your choice, move
the pointer to it and click. (Each tab is a button in disguise.)
You are in the process of learning how to browse through HyperCard,
so now would be a good time to see what the Help stack h as to say about
browsing.
•

Click the Browse tab to go to t he first card that has information
about browsing (see Figure 12-6) .

Browsing HyperCClrd

o How t o use Help
0 NClvigat ing

o Op ening st <lcks
0 Editing tex t
Searching for tex t
0 Adding CClrds to stClcks
0 Pr inting cards and st<lcks

o

Figure 12-6

Index card for help in bro wsin g th rough HyperCard

Thi s card is an index to seven topics associated with browsing through
HyperCard stacks. By read ing each o f t hese sections, you will learn the
basics of working with HyperCard. Let's see what t his sectio n has to say
about using Help .
•

Click How to use Help.

Figu re 12-7 shows the card this command will present. It tells you about
basic arrow buttons and the sh ortcut command to get help (pressing
Command-?) and provides an in troduction to using the Find command.
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How to use Help
Get to the Help cards (Wilere you are now) from
anywhere in HyperCarct1by choosing Help from the Go
menu (or typing Command-?).
• Click arrows near the bottom of the Help cards to:
go to the previous card on the topic
go to the next card on the topic
return to a list of topics or a cross reference
10 1

1

!!lLl!!!J.!!!!l.:_

1

Figure 12-7

• Choose Find from the Go me nu to search for text
within the Help stack

First h elp card of How to use Help topic

The right arrow atthebottom of the card indicates that m ore inform ation
o n th e same topic is on the next ca rd .
,. Click on the right arrow to see the next help card on this subj ect.
This card (see Figure 12-8) tells you abou t som e of the conven tions used
in th e Help stack. It discusses the G lossary and Index features of the Help
stack, two parts that are useful for finding information quickl y.

How to u se Help (cont.)
• Click asterisks in text to see more information in a
pop-up field or to go to cross-refe rences.*
• Click the Glossary tab to look up terms in the
glossary. Flip through the glossar y using the arrows at
the bottom of the cards or spec1fy text to find.
• Click the Index tab to look things up there. Clicking
an entry in the IndeK J kes you to the Help card that
explains that topic.
See also the Hypercard manual You can curl up with
it and read detailed de crlptions about Hypercard.

¢1

Figure 12-8

~

Second How to use Help card

The Help stack uses asterisks to ind icate that more information is
ava ilable about a s ~bj ect. Cli ckirg on t he asterisk either shows a hidden
fi eld with more info rmatio n o r ta kes yo u directly to a card that contains
cross-referenced materi al.
I
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At t he bottom ofth e card you can see two buttons: a left arrow (Previous)
butto n and a Return button . The lack of a right arrow (Next) button
ind icates that you h ave reach ed the end of t his bran ch of information.
If you wan ted to learn m ore about browsing, yo u could click on the
Return button an d choose an other topic from t he index on the card
shown in Figure 12-6. If you would like to explore more about this topic,
feel free to do so. When you have fi n ished reading about browsing,
con t in ue with the n ext command .
•

Click t he Index tab to go to the fi rst card in the Help stack Index.

The first Index card in the Help stack is shown in Figure 12-9. The index
gives you several ways of finding m ore information on HyperCard . Each
term to th e right of a shadowed sq ua re is surrou nded by a button. If you
click o n t he te rm, the button tell s HyperCard to take you to t he card
con ta ining more informat ion about tha t term.
15

File

Edit

Go

Index
0 Addi ng
0 b8ckgrounds
0 buttons
0 c8rds
Cl fi elds
0 St8CKS
0 te xt, typing
0 pictures
0 sp8ce between text lines
0 8iming links
0 Apple menu

Figure 12-9

0 Apple key
0 8PPIIC8tlons
0
l8unchl ng or opening other
0 8rrow or cursor keys

0 8s ten sk (* )

The first Index card

You ca n a lso look at the previous o r next card by clicking o n t he left o r
right arrow, res pectively. If you don't want to look at the in dex, you can
click on the Return button .
The Index card also has a button named Find located between the right
arrow an d the Return butto n. You saw a little about Find on t he How to
use Help cards. Let's learn m ore abo ut HyperCard's ability to q uickly
find text in a stack.
•

Click Find .

As soon as you click the Find button, t he Message box appears with
the phrase Find
showing in t he box (see Figu re 12-10). Th e Find
com mand no rmally puts th is in to the Message box, places the insertion
point between the quotatio n m arks, and then waits for you to type some
ch aracters o r one o r m ore words fo r it to find.
1111
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Index
0 Adding
0 backgr ounds
0 buttons
0 cards
o f iel ds
0 st acks
0 t ext , typing
D pictures
D space bet ween t ext lines
D aiming links
D Appl e menu

0 Apple key
0 appli cations
0
launchi ng or opening other
0 arrow or cursor keys
o ost erlsk ( *)

-~~~:_ti n~_---------------------Figure 12-10

Using the Find command

If you type th e first few characters of a word, HyperCard searc hes for any
word that begins with those cha racters in all cards in that stack. If you
t yp e o ne word, it finds any card containing that word. If you type more
than on e word, it finds only the cards that contain all the words on the
sam e card .

.. Enter find between the quo tatio n marks, and then press the Return
key.
HyperCard ign ores differe nces between uppercase and lowercase letters
during a find operation.
When you press the Return key, Find looks through all the cards on the
Index background an d quickl y sh ows th e first card conta ining the word
"find" or an y word beginning with it (see Figure 12-11).
r

•

File

Edit

Go

Index
D
D
0
D
0
D
D
D
D
D
D

Beck command
Backgr ound
buttons
f iel ds
PICture
Backgr ounds,
eddl ng or modifying
copyi ng exi sti ng
Bkgnd Info command
Backgr ound commend
beckup

Figure 12 -11

0 Blind typing
0 Bring Closer commend
o Browse tool
0
cllckmg buttons with
0 l findln!ll text w ith
0 Brush Shape commend
0 Button Inf o commend

The text h as been fo und.

The text found by HyperCa rd refe rs to finding text with t he browse tool.
Now yo u ca n cli ck the phrase to take yo u to that entry in t h e Help stack.
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•

Click the finding text with phrase.

HyperCard quickly takes you to the first card that explains how to use
the Find command (see Figure 12-12).
'

oj

File

Edit

Go i

• Choose Find fr om the Go menu. Choosing Find
displays the Message bOx (lf tt•s not already visible)
and places the Find command in it.
• Type the text you want to flnd.
• Press the Return or Enter key to start searching the
current stack for text you specified.
(If you try this now, you11 search the Help stack. If
you want to search another stack, fi rst go to that stack.)

Ex! I

Figure 12-12

•
'

Help on searching for text

When you finish reading this card, click on the right arrow.
oj

File

Edit

Go i

Searching for text (cont.)
wes~e.lnthe.l

the~you

specify

HyperCard takes you to the first card that contains all
of the text you specified (even l! the words are in a
different order), encloses the first word in a rectangle,
and closes the Message box.
• Press the Return or Enter key again to find the next
occurrence.
Command-clicking or Command-dragging across
existing text replaces any selection in the Message bOx
with that text. This ls handy for flndlng other
occurrences of text you come across.

Figure 12-13

Second card on searching for text

You now see the second help card concerning searching for text. You
know this is the end of the branch on th is topic because there is no righ t
arrow showing.
Depending on the amount of time you have and your interest in
exploring the Help stack, you can continue looking through this
informative stack. Read at least the Browse information at this point.
-

When you are ready to leave the Help stack, click the Exit tab on
the bottom right of the card.
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You are returned to th e Home c rd. If you were in a d iffere nt stack and
needed to look up something inlthe Help stack, you could choose Help
from the Go menu o r type Command-?. Then when you were finish ed
with the Help stack, clicking the Exit tab would return you exactly to
where you were before you opened the Help stack.
The Help stack is always available, easy to use, and full of useful
information . If you want to learn to use HyperCard to its fullest, you
should become familiar with the informa ti on in the Help stack and the
HyperCard manual.

SAVING YOUR WORK
You do not h ave to save your work in HyperCard the way you do in other
applications. HyperCard is designed to manage information that can
change often, so it automatically saves all changes to the disk. These
changes are saved almost as soon as they occu r, so you stand very little
chance o f losing any changes you h ave made.
There is a drawback to this method, however. lf you make a big change,
involving several operations, that you really did not want to make, you
may be forced to return the file to its original state using timecon suming methods.
Also, do n't forget that all disks fai l eventually. Even HyperCard's
dedication to saving you r work won' t save you if the d isk goes bad.
Always make a backup of important info rmation on a different disk.

USING HYPERCARD'S TOOLS
Everything in HyperCa rd in some way in volves the use of cards, stacks,
fields, and butto n s. Whether you are u sin g a stack created by som eone
else or on e that you created, these are HyperCa rd's basic building b locks.

Essential Elements
Just as the Macintosh operating syste m is based o n the desktop m etaphor,
HyperCard bases everything on stacks of cards.
Cards

You can think o f these cards as lyi ng o n a table starting at the left and
extending to the right, or you aan think of the m as being piled into a
stack. Everything in HyperCard involves at least one card, a nd most
stacks use many cards. Hype rC~ rd has a max imum limit of 16,777,216
cards, and a stack can be as large as 512 megabytes, so you shouldn't be
too concerned about runnin g 1ut of room.
Unlike a row of cards laid out o n a table or a stack of cards piled high o n
' a tabl e, the cards in a HyperCard stack are arranged in a circula r fashion.
When you reach the last card i a stack and tell HyperCard to go to the
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n ext one, it starts over again with the first card. If you are at the first card
in the stack and issue a Go Previous command, HyperCard will brin g up
the last card in the stack.
A card has two layers. Th ere is a background layer, which mo re than on e
card can share, and there is a card layer th at belon gs to t h at specific card
only. Other ob jects can be located on one of these layers.
If an obj ect (p ainting, button, field, and so forth) is located o n t he

background layer, an y n ew cards created with the sam e backgroun d will
have t his ob ject visible on them as well, an d the object will have t he
same properties and be able to do th e same thing o n all cards with
that background .
If an obj ect is located on the card layer, it will be local to that card o nly,
and if you create a n ew card with the same background , the ob ject

located on the card layer of the original card will not ap pear o n the
new card.
It is no t uncommo n for someon e new to HyperCard to mistakenly place
an object on the card layer when it should be o n t he background layer.
However, it is easy to cut the o bject from the card layer, switc h to th e
background layer, an d paste the object in to its proper layer.

Stacks
This stack of cards, whether you think of it as bein g located from left to
righ t or top to bo ttom, has certain features that are com mon to all stacks.
A stack m ay be composed of m ore th an one card, as it usually is. A stack
can even have multi ple backgrounds, with each backgro und containing
more than o ne card . The converse of t h is is not t rue: a card cannot be
in more than on e background or stack.
Regard less of h ow you picture a stack of cards, each card h as a certain
relation ship to the o ther cards in t h e stack. For any given ca rd, except
t he top o r left-most o ne, there is a card that com es before it known as
the previous card. Wh en m oving between card s in th e same stack, th e
left arrow mean s to go to th e previous card .
Likewise, for every ca rd (except the bottom or right-most o ne) t here is
a n ext card . Th e right arrow takes you to the next card .
Cards, by them selves, would n ot be very interestin g, so HyperCard
provides two oth er very important a nd usefu l objects.

Fields
A field is also known as a text field. It is an area on the card (either o n t he
background or t he ca rd layer) t ha t ca n h old editable text. All text in a
field is limited to th e sam e fo nt, size, an d style in HyperCard version 1.2.
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If a field is in the background layer, th en it will appear on every card in
that background. But unlike with pictures and buttons, each card can
store different informatio n in the fi eld .
A fi eld located on the card layer only ex ists on that particular card, so
it will not have varying contents among differe nt cards.
There can be a maximum of 32,76 7 fields on a single card (if they would
fit), and each field can store up to 30,000 ch a racters. The script
associated with each field can be up to 30,000 characters, also.

Buttons
A button exists to carry o ut some type of actio n. You have already seen
a number of buttons. Each icon on the Ho me card is a button that is
linked to a particula r card in a different stack. Other buttons, such as the
left and right arrows, functio n the same on every card (although their
actions can be customized).
If you are working in the Authoring level, you can link a button to a
different card. When you progress to scripting, you can create simple o r
complex scripts for the button to follow wh en it is activated.

Buttons in the background layer (known as background buttons) appear
on every card in that background and have the same capabilities on each
of those cards.
Card buttons appear on on e card only and are used for special purposes
that apply specifically to that card (although they can affect other cards,
stacks, and even applications and documents) .

Links
If you are in the Authoring o r Scripting level, you can establish links from
an object to an other obj ect (such as a butto n to a card). This invo lves n o
programming.
If you were to create a n ew button, you could double-click on the button
(while you are using the butto n tool), and then tell HyperCard that you
want to establish a link. A floating window appears and floats above
everything else. You can go to another card o r even open a different
stack and find a particular card, and then tell HyperCard to link to either
the stack or the currently selested card. The n ext time you click the
button using the browse tool, Hy perCard wil l take you to the place you
chose for the link.
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Home Stack
The Home stack is essential for HyperCard to operate. The first card,
known as the Home card, contains a group of butto ns that take you to
the stacks distributed by Apple with HyperCard, as shown in Figure 121. You are free to delete any buttons you don 't use and to add new
buttons as you wish. In fact, if one card is not eno ugh, you can add mo re
Home cards to the stack (see Figure 12-14) and p ut additional buttons
on the new cards. The button shown on the ca rd in Figure 12-14
automatically opens Microsoft Word.

' a

File

Edit

Go

Tools

~Home Card~

Page 2

Figure 12-14

Second Home card added to Home stack

The next three cards of the Home stack are where HyperCard stores the
paths it fo llows when looking fo r other stacks (see Figure 12-15),
applications (see Figure 12-16), and documents (see Figure 12-17) .

' a

File

Edit

Go Tools

Look tbr Stacks in:
:HyperCard St ack s:
:More Stack s:
:My Stacks:
:Hel p S t<:~cks:
: Ide<:~ St acks:
HyperCard & St <:~ cks:Mo re St acks:
H y perC ~:~rd Help:Help St acks:
HyperCard ldeas:lde a Stack s:
My Hard Disk:Star Trek Fol der Two:

Figure 12-15

.,

:~:

Pathnames for finding other stacks
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45

File

Edit

Go Tools

Objects

Look tbr Applications in:
:Applications:
:Ut ili ties:
My Hard Disk:Appl ications Fol der:Word Processing
Folder:MS Word 4 Folder:

Figure 12-16
'

Pathnames for finding applications

45 File Edit Go Tools Objects

:Hyper Car d St acks:
:Documents:

Figure 12-17

Pathnames for finding documents

You don't have to do anything to any of these cards. Whenever you issue
the command to open a stack, application, or document, HyperCard
looks in the folders listed on the appropriate card. If the file being
looked for isn't found in any of the listed folders, HyperCard puts up a
standard dialog box for opening a file, allows you to find that file
on the disk, and then opens it for you. HyperCard then adds the
pathname to the appropriate file, so you won't have to show it where to
look the next time.
I
If you change hard disks or reorganize your disk, you might want to erase
the pathnames on these cards t at are no longer correct.
User Levels

The last card in the Home stack allows you to set certain preferences for
how you like to use HyperCard, to tell it your name, and to choose a user
level (see Figure 12-18).
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s

r

File Edit

Go Tools Object s

User Preferences
user Nome: Mllrshl! Szczepansk i
User Leuel:
QBrow slng
Q Typlng

0 TeHt Rrrows

Q Palnllng

0 Power Keys

0

Ruthorlng

®scripting

~'

,.:s)"-::-~n-;::.77

;:

":~rs>j,:

Figure 12-18

0 Blind Typing

,...

User Preferences card in Home stack

just as the list of descri ptions on the last several pages suggests, you can
do many things with HyperCard. In fact, there are five levels of using
this program, so that-as you learn more about the program-you ca n
access mo re of its features. Beginners can use the program for Browsing
information previo usly compiled by other authors. With a few minutes
of practice, you can progress to Typing, which is the level that lets you
change and add info rm ation .
With a little more practice you can progress to Painting, which gives you
access to the bitmapped Painting tools. These tools work very similarly
to the ones in MacPaint.
When you feel like venturing into the world of creating your own stacks,
you can choose theA uthoringuser level. Now you can create, copy, paste,
and m odify buttons and fields. You can create links from a button to a
different card in the same st ack or a different stack.
If you want to explo re HyperTalk programming, you must set the level

to Scripting. This h ighest level gives you access to everything HyperCard
can do. As you learn to modify existing scripts and then to create
your own, you will be able to fu lly rea lize t he power of t his
remarkable application .
HyperCard does not restrict you to starting with browsing and then
progressing through the user levels in order. Many people use the
authoring level before painting, and others pai nt before typing. You
can go d irectly to the level you need for the job you are doing.

Basic Tools
Everything you do in HyperCard involves using one of four major types
of tools. There are 3 General tools (browse, button, and field) and 15
Painting tools. If you choose the authoring or scripting level, you have
access to all1 8 tools. The painting level shows all 18 tools, but does not
allow access to the button or field tool. In the browsing or typing levels,
you have access to the browse tool only.
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The tools are shown in Figure 12 19, and a short description for each one
follows.

~ Browso

General
Tools:

:i:~:n

Painting Tools:
r--

~

p

[~J Selection

77

~

,.t!l

-::--

,..(g

Brush
Spray

D
0
f--

~ Bucket

A

0

Paint Text

Figure 12-19

Eraser
Rectangle

f--

--':c-

'--

---=-

(I

Pencil

"'"'--

f--

~

=-=

Lasso

Oval
Regular Polygon

"-.... Line

-0
-v

Cl

-

Rounded Rectangle
Curve
Polygon

Tools available in HyperCard

General Tools
All user levels provide access to the browse tool. The Painting level gives
you access to the painting tools, and the Authoring and Scripting levels
let you use the button and field tools.

Browse Tool
The browse tool is used to click buttons and to select and edit text. When
not in a text field, it assumes the appearance of a hand as shown at left.
It is the only tool that will activate a button, and it is used for navigating
through a stack.
When inside an unlocked text field, the pointer changes to an I-beam
to indicate that you may use it to select and edit the text in the field or
to add more text.

Button Tool
The button tool is used to create new buttons, to see existing buttons
(even transparent ones), and to modify buttons if desired.
The button tool is only available if the Authoring or Scripting level has
been chosen. When you choose the button tool, all buttons on the card
are surrounded by a thin rectangle. If you click a button with the button
tool, the button's script is not activated. Instead, the button is selected
and then is enclosed by a moving dotted line (sometimes referred to as
"marching ants").
I
You can create a new button by ~hoosing New Button from the Objects
menu or by holding down the Command key and dragging the button
tool diagonally to establish the position of the new button on the card
or background.
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To select an existing button, make sure you are using the button tool,
then point to the button and click.
If you want to place the button on the background so it will be available

to all cards with that background, you must choose Background from
the Edit menu (or press Command-B) and then create the new button .
When you change to the background layer, the menu will have diagonal
stripes around its outer edges (see Figure 12-20).

Card layer:

ra

File

Edit

Go

Tools

Objects

Background layer:

Figure 12-20

Menu appearances for card layer and background layer

You can move buttons to different locations and change their sizes. To
move a button, first select it with the button tool, and then place the
pointer anywhere inside the button (or exactly on one of the four edges
except for a corner) and drag it to its new location. A selected button is
resized by dragging any of its corners to make it larger or smaller.
Buttons may be duplicated, copied, cut, cleared, and pasted.
You duplicate a button by selecting it, holding down the Option key,
and dragging the new copy to a different location.
You copy a button by selecting it and then choosing Copy Button from
the Edit menu (or typing Com mand-C).
A button may be cut by selecti ng it and then choosing Cut Button from
the Edit m enu (or typing Comm and-X) .
Clear a butto n by selecting it and then choosing Clear Button from the
Edit menu (or pressing the Backspace or Delete or Clear key).
Paste a button that has been previously cut or copied by choosi ng Paste
Button from the Ed it menu (or typing Command-V). A button that is
pasted will be in the same locati on from which it was copied or cut.
If you want more information about a button, or if you want to change

its style, show its n ame, lin k it to something else, or modify its script,
select the button and then choose Button Info from the Obj ects m enu
(or double-click the button).
For example, if you choose the butto n tool and then click on the right
arrow button on the Home card, HyperCard presents a dialog box
similar to the one shown in Figure 12-21.
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Figure 12-21

K

OK

Button Info dialog box

When you chose the button tool, each button on the card was outlined
to show its size and location. Double-clicking on the right arrow button
presented the dialog box that allows you to specify the appearance of the
button, its name, and some facts about how it operates.
If you are using the browse tool and want to know where all the buttons

on a card are located, and you want to use one of the buttons rather than
modify it, hold down the Option and Command keys simultaneously
and all the buttons will be outlined in gray. Then when you release the
Command and Option keys, you can click the button you want to use.
Field Tool

raJ

~

The field tool is used to create new fi elds, to see existing fields (even
I
transparent ones), and to modify fields if desired.
The field tool is only available if you have chosen the Authoring or
Scripting level. When you choose the field tool, all fields on the card are
surrounded by a thin rectangle.lf you click on a field with the field tool,
the field does not allow you to enter or modify text. Instead, it is selected
and then is enclosed by a moving dotted line.
You can create a new field by choosing New Field from the Objects menu
or by holding down the Command key and dragging the field tool
diagonally to establish the po ition of the new field on the card or
background.
Notice that the Edit menu changes depending on the tool you are
currently using. If you are using the button tool, the Edit menu says New
Button, but if you are using thJ field tool it says New Field.

I

A field is designed to hold text, and the number of lines of text that a field
can hold is determined by the font, size, and style chosen for that field.
HyperCard allows you to chodse only one font, size, and style for a
particular field.
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Creating a field is done in the same manner as creating a button, except
that you use the Field tool.
Thought must go into the placement of a field. If you are creating a field
that will be seen o n several cards, and each card will hold similar, but
different, information, then the field must be placed on the background.
If the information in the field is for a particular card and does not
correspond to similar information on other cards in the same stack, the
field should be placed on the card layer.
Wh enever you want to place an ob ject, in this case a field, on the
background layer you must first choose Background from the Edit menu.
Refer to Figure 12-20 if you want a reminder about how the menus look
when the card layer or the background layer is chosen.

CAUTION

The most common mistake made wh en creating a n ew field is putting
it on the card layer when it should h ave been on the background layer.
The easiest way to spot this problem is to go to another card . If the field
is also on this card but the contents are blank, the field is on the
background. If the field disappears, it was placed on the card layer.
If you put a field on the wrong layer, use the field tool to select the field,
cut it, ch ange to th e proper layer, and paste the field back into position.

Selecting, duplicating, cutting, copying, clearing, and pasting fields are
performed using the same proced ures that are used for buttons. The only
difference is that you must be using the field tool and it affects only
fields. (See the previous section, Buttons Tool. ")
11

WARNING

Unlike deleting a button, you can lose much valuable information if you delete
a background text field. Since a single background field can contain information
on hundreds ofcards, deleting the field would delete all the information stored
on all those cards. HyperCard will ask you to confirm that you want to do this,
and ifyou tell it to continue, there is no way to undo the cut or clear operation.
If you actually do this, HyperCard's automatic save featu re quickly makes the
changes to the stack on the disk. The only way to recover from this mistake
would be to reload a backup file if you recently made one.
just as you can get information about a button, you can get inform ation
about a field. The dialog box that appears when you choose Field Info
from the Objects menu (or double-click on a fi eld with the field tool)
allows you to set the style of the field, give it a name, lock the text so
n obody can ch ange it, unlock a field so it can be modified, ch oose the
text characteristics for the fi eld, and even modify its script.
For example, we prepared a Glossary stack (wh ich you will use in
Proj ect 1) that lists common terms and definitions associated with using
a Macintosh. If you were to open the Glossary stack, ch oose the field
tool, and double-click on the Definition field, you would see the Field
Info dialog box as sh own in Figure 12-22.
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Bkgnd field number: 2
Bkgnd field I 0 : 2

Figure 12-22

Style:
transparent
0 opaque
0 rectangle
0 shadow
® scrolling

0

field In fo dialog box in Glossary stack

Projects 2 and 3 introduce you to usi ng the button and field tools to
create, mod ify, cut, paste, and further customize both fields and
buttons.

Painting Tools
just as with buttons and fields, the Painting tools allow you to paint on
the background layer or the card layer. Any p icture shown on a
background layer appears on all cards that share t hat background. A
picture o n a card layer is seen only on that particu lar card.
The picture on the card layer is o n top of the background picture and can
obscure portions or all of the background. Painting over a field or button
does not deactivate it, but on ly hides it from view.
HyperCard's Painting tools work simila rly to the same tools in MacPain t,
but since it is a n ewer program and is written for computers wi th more
memory, HyperCard extends the power of some of the tools over what
is available in MacPaint.
Both the Tools and Patterns m enus a re known as tear-off menus a nd
may be converted fro m a menu into a palette (see Figure 12-23). These
menus are changed into palettes by dragging below the bottom of the
menu . When you pass the bottom of the menu, a gray outline of the
palette appears. Drag the palette's outline to where you wa nt it and
release the mouse button. The palette will "float" on top of everyth ing
else on the screen. If you are about to do a lot of painting, it is often
beneficial to tear off the menus and select the tools and patterns di rectly
from the pa lettes.
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~
The Tools and Patterns palettes

Selection Tool
The selection tool is used to select a rectangular portion of a picture.
Once you have selected something, it can be copied, cut, cleared,
resized, rotated, flipped, inverted, outlined, darkened, lightened, and
moved on the screen.
If you hold down the Option key while selecting an object with this tool,
the tool converts into a lasso and selects only the o bject, not the
surrounding white space.
When you move the pointer into a selected area, it changes from the
crosshairs pointer into an arrow pointer. This signifies that you can
now drag the object around on the screen .
Double-clicking on the selection tool selects the entire card picture.

Lasso
The lasso is used to select an irregular shaped area of a picture.
Once something is selected, it can be copied, cut, cleared, and moved on
the screen. The lasso is similar to the selecti on tool, but when you draw
a loop around the object(s) you want to select, it tightens around the
object and only affects it and not the white space surro unding it.
When you move the pointer into a selected area, it changes from the
lasso into an arrow pointer. This signifies that you can now drag the
obj ect around on the screen .
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Brush Tool
The brush tool is used to paint

ith the currently selected pattern.

The shape of the brush can be ch an ged by double-clicking on the brush
tool after the Tools menu has been "torn off" and mnverted into a
palette (see Figure 12-24).
j

File

Edit

Go Tools

Point

Options

Potterns

Address cards, Rotary cards

.Q ,

Figure 12-24

Dialog box for choosing new brush shape and size

The brush can be con strained to paint in a straight (horizontal or
vertical) line by holding down the Shift key (or locking the Caps Lock
key in the down position) while you paint .
Holding down the Command key while you paint with the brush
converts it into an eraser with the current brush shape.

Spray Tool
The spray tool allows you to spray the current pattern onto the picture.
By m oving the spray tool back and forth over an area, you add more of
the pattern to the picture.
Holding down the Shift key (or the Caps Lock key) while you spray
constrains the spray tool to horizontal or vertical movements.
Pressing the Command key while you spray converts it into a spray
eraser.
Bucket Tool

I

The bucket tool is used to pour the current pattern into a bounded area.
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If the area is not bounded, o r if there are any ho les (even 1 pixel wide)
in the bounda ry, the paint will spill into the rest of the ca rd.
To recover from a "paint spill," choose Undo from the Edit menu
immediately after making the mistake. (I f you do anything else, the
Undo com mand will n ot correct the problem.) Then find and correct the
hole in the bounda ry and try again. Sometimes it is easier to repair the
hole using the pen cil tool and Fat Bits (see th e section on the pencil
tool).
You can change black areas to other patterns with the bucket tool. ln this
case the edge of the black area is the bounda ry; the paint will not spi ll
into surrounding white areas.
You cannot use the bucket tool to ch ange the pattern in a filled area. To
do this, use the selectio n tool or the lasso and choose Fill from the
Paint m enu.
If you double-click on the bucket tool in the palette, you m ake the
Patterns palette alternately appear o r disappear.

Paint Text Tool
The paint text tool allows you to add text to your drawing, but painted
text is not editable after it has been deselected by clicking somewhere
else with the paint text tool or by selectin g a different tool. When the
text is deselected, it is converted into a bitmapped picture of the text and
is n o longer editable with the paint text tool. At that point, the only way
to change the text is to erase it and re-enter the text as you want it.
If th e paint text has not been deselected, you can change a ny
typograp hical errors by backspacing to the error and retyping the rest of
the text. You can also change the font, size, style, line height, and
alignm ent of the text while it is still selected.
When typing text, you can press the Return key to start a new line under
the curre nt line. This will not deselect the previous line. The new line
will be aligned under the previous lin e depending upon w hether you
have selected left, center, or righ t alignment. Left alignment is t he
default va lue.
If you want to ch ange an y of the text characteristics, choose Text
Style from the Edit menu (or double-click on the pain t text tool).
Figure 12-25 shows the resulting Text Style dialog box, and all of the
settings represent the defaults.
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Select a font an9 size by scrolling
and clicking on !your choice ...

Choose one or
more styles:
Style
O Bold
0 ltolic
0 Underlin e
O Oulllne
0Shodow
0 Condense
OEHtend
Rlign
@ Lert
0 Center
Q Right

Gregorian
Helue tlco
I Courier Oblique
I Heluetlca Obliqu
I New Century Sc
I Polollno Italic
I Times ltelic
London
Mobile
Monaco
N Heluetlca Narro

Select the alignment
of your choice.

Figure 12-25

... or enter
the text
size and
l ine height
in the edit
boxes.

See a sample of the
text before you type it.

Text Sty le dialog box

If you h ave just typed a nd deselected some text and wish to move it to

a new position, type Command-S and HyperCard will select it for you.
Paint text is not editable, nor can HyperCard's Find command locate
text that was painted. If you want to modify text or be able to have
HyperCard find it for you, create a field and enter the text there.

Eraser Tool
The eraser tool is used to eliminate portions of the picture. Erasing a
portion of a card picture exposes the background p icture underneath,
which can be somewhat disconcerting. Instead of erasing parts of a card
picture, you may find it easier to paint over someth ing using the brush
tool and a white pa ttern, using th e brush tool and the Command key to
make the brush in to a shaped eraser, or using the eraser tool and the
Command key, wh ich makes the eraser paint with white (like using
White-Out).
If you want to erase an entire card picture, double-click on the eraser tool
in the Tools palette.

Rectangle Tool
The rectangle tool is used to draw rectangles and squares.
To draw a rectangle, press the mouse button when the pointer is where
you want one of the corners, and then drag the mouse to the diagonally
opposite corner and release the button whe n the corner is where you
want it.
Rectangles may be drawn centered around a point by choosing Draw
Centered from the O ptio ns menu.
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Rectangles may be drawn filled with the curre nt pattern by ch oosing
Draw Filled from the Options menu (or by do uble-clicking o n the
rectangle tool in the palette) .
You can ch ange the line thickness of the rectangle tool by ch oosing Line
Size from the Optio ns menu (or by double-clicking o n the line tool in
the palette).
To draw a rectangle with the border lines in the current pattern, hold
down the Option key as you draw the rectangle.
To draw a bo rde rless rectangle, choose Draw Filled fro m the Option s
menu and draw the rectan gle with the Option key held down .
To constrain the rectangle to be a square, h old d own the Shift key (or
Caps Lock key) as you draw.

Oval Tool
The oval tool works like the rectangle tool, except that it draws ovals that
fit inside the rectangle you create, instead o f drawing the rectangle itself.
All the options listed for the rectangle tool work with the oval tool,
except that the Shi ft key (or Caps Lock key) constrains it to drawing a
circle.

Regular Polygon Tool
The regular polygon tool is used to easily create polygons that have regular
sides a nd angles.
Unlike the other tools, the regular polygon tool always draws from the
center outwa rd (just as if you had ch osen Draw Centered fro m the
Options menu). It makes no difference whether Draw Centered is
selected o r not.
Also unlike the other shape tools, the regular polygon tool allows you
to rotate a sha pe before it is fi xed into place. While you are drawing a
shape with this tool, you sh ould n ormally drag horizon ta lly to the right.
If you move the mo use to any other positio n, the shape will rotate. The
rotation can be constrained to 15° increments by ho lding down the
Shift key (or Caps Lock key).
Severa l sh apes a re available, and you can select one by double-clicking
on t he regular polygon too l in the Tools pale tte and then cl icking o n the
polygon of your choice in the resulting dialog box (see Figure 12-26).
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Address cards, Rotary cards

Figure 12-26

Ch oosing a regular polygon shape

Pencil Tool
Th e pencil tool is used to modify individual p ixels in a painting. It can be
used to wri te like a pencil or to erase like on e.
If the current pixel is white, the pencil makes it black, and vice versa.
The pencil tool can be constrained to draw only horizontal or vertical
lines by holding down the Shift key (or Caps Lock key) while you d raw.
Double-clicking on the pencil tool wh en it is in the Tools palette
magn ifies the screen eigh t times and takes you in to Fat Bits so you can
edit ind ividual pixels (see Figure 12-27). The floating window shows th e
actua l-size view of the picture being edited .
r

s

Fil e Edit

Go Tools Point

Options

Pa tte rns

•• ••••• ••
• •
•••
••• •••
•••
•••

Figu r e 12-27

Editing with the Pen cil tool in Fat Bits
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Line Tool
The line tool is used to d raw lines from one point on the screen t o
another. Anchor one end of the line by pressing where you want it to
start, and then (while continuing to hold the mouse butto n down)
move the mouse to where you want the line to end. The line will
continue to be displayed while you move the mouse. When you have
the line where you want it, release the mouse button to anchor the
second end of the line.
You can constrain the line to 15° increments by holding down the Shift
key (or Caps Lock key) while you draw.
Double-clicking on the line tool in the palette allows you to change the
thickness of the line (see Figure 12-28).

a

File

Edit

Go Tools Point

Options Patterns

Address cards, Rotary cards

Figure 12-28

Changing th e thickness of the line

Rounded Rectangle Tool
The rounded rectangle tool works like the rectangle tool, except that it
draws rectangles with rounded corners instead of right-angle corners.
All the options listed for the rectangle tool work with the rounded
rectangle tool.
Curve Tool
Use the curve tool to draw freehand curved shapes.
When Draw Filled is not selected, the curve tool works similarly to the
pen cil tool. If Draw Filled is selected, the curve tool automatically
connects the starting position of the curve to where you release the
mouse button at the end of the curve with a straight line. The area
bounded by the curve is then filled with the current pattern.
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A simple way to toggle Draw Fi led on or off is to d ouble-click on th e
curve tool.
You can modify the width of the line drawn by the curve tool by
choosing Line Size from the OJ?tions menu (or by double-clicking o n
the line tool).
Holding down the Option key while you draw with the curve tool causes
the curve to be drawn using the current pattern.
Polygon Tool

Th e polygon tool is used to create multi-sided objects with irregula r
shapes. This is the only shape tool that works as it does. With the other
shape tools, you hold down the mouse button until you have comple ted
drawing the object and then release it when the positio n and size are
correct.
The polygon tool works on the principle of drawing a shape with
multiple straight lines connected by several vertices (intersections) .
To draw a polygon, click wh ere you wan t th e first line to start. Then
continue clicking at the location of each of the subsequent vertices. This
is like tracing around the edge of the object with a tool that draws
multiple connected lines.
Drawing the polygon is completed by double-clicking at the last vertex.
This can be at the same point as the sta rting position or at a different
location. If Draw Filled is checked, HyperCard automatically con nects
the starting and ending points with a line and fills the res ulting polygon
with the current pattern.
Holding down the Option key while d rawing a polygon draws the
border in the currently selected pattern.
You can change polygon line widths by d ouble-clicking o n the line tool
and choosing the li!le width you prefer.
Holding down the Shift key (or Caps Lock key) constrains the lines that
make up the polygon to 15° angles.

Stack Resources
As you get more involved with HyperCard, you will fi nd that you n eed
to do something and there is no button available for that specific
purpose. HyperCard allows you to create your own buttons, and you can
give the button a ny icon that is currently available in the Home stack.
When you create a n ew button you can tell HyperCard th at you want
the button to have an icon, and you will be presented with the scrolling
list of icons shown in Figure 12-29. Icons are o n e of th e types of resou rces
that HyperCard lets you use in your stacks. You can also add sounds,
additional art, and even programming code to extend the commands
available in HyperCard.
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Icon resources for buttons

Idea Stacks
HyperCard is distri buted with four idea stacks: Art Ideas, Button Ideas, Card
Ideas, and Stack Ideas.
To open on e of these idea stacks, you need only to click the appropriate
button o n the Ho rne card.
If you look at the Art Ideas stack, you see the in dex card first (see Figu re
12-30). Th is card has th ree columns o f buttons. Clicking one of these
buttons ta kes you to the card linked to that button. The re are also four
other butto ns just to t he right of the stack's title.

D lndex1
~ ¢19
Click on. o.n y word or picture to ,o to tha. t co.rd .

G:;J

Address cards, Rotary ...

W

Animals, Wildlif~, Fish •.

~Arrows
~

Books,Artiolos, Nows ...

dc, Business, Or g. Charts ...

II) Cal~ndars, Datobooks _

!01 Disks, Disbtte Library
Figure 12-30

CJ
thll
thll

Filing cards, Later al.. .

.ij

Font- Ca iro

El_ Miscellaneous 1.

Font - Mobile

El_ Mise• llaneous 2.

~ Geography , Maps

Macintosh, Apple ...

$

Money ,Credit, Calc ...

)

Mus ic, Rocords, Tapes_

~ Holidays, Seasons
Jii'3. Home, Household Activ_

~ Notes, Notepad, Memos _

B

(_3. PoopI•, Humans

Letters, Envelopes_

First index card in Art Id eas stack
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The Tell Me... button is usually li ked to info rmation or h elp concerning
the current stack or card. ln thi case, clicking on the icon takes you to
the card sh own in Figure 12-31. This card tells you about the Art Ideas
stack. Clicking the Index button takes you back to the first index card.
You can also choose Back fro m the Go menu.

About Art Ideas...
This stack is made up of clip :~rt for you t o cut
and paste into your own stacl's.
Cl ick on t he subj ect you want in the Index to get
t o t hat art or sear ch for the subj ect you want
using t he message box.

Figure 12-31

Information card for Art Ideas stack

The Home button takes you back to the Ho me card of the Home stack.
The left arrow is the Previous button and is used to go to the previous
card. If the current card is not the top card on the list, the left arrow takes
you to the card just before the current on e. You can think of the previous
card as being eith er to the left of or just above the current card. Clicking
on the left arrow takes you to the sam e card (in this case) as pressing the
\
Tell Me ... button.
The right a rrow is the Next button and takes you to the n ext card . If th e
current card is not the bottom card of th e stack, it usually takes you to
th e card just after t h e current card. Clicking o n the right arrow in this
case takes you to the second index card of the Art Ideas stack (see
Figure 12-32) .

648

Part V: Information Management

r

File

•

Edit

Go

Tools

.,

ects

0 lndex2
~¢1~
Clic.lt on a.ny word or

pidur~

to so t o tha.t ca..rd.

~ Pictures, Photographs ...

{5

Restaurants, Food, Recipes

Q

Science, Astronomy, Chem ...

e

Symbols

1ii' Telephones, Dialing...

l

Tools, Brushes, Pens ...

D

Transportation, Autos ...

Figure 12-32

Second index card of the Art Ideas stack

Now that you know how to navigate through this stack, let 's look at one
of the cards in the Art Ideas stack. If you click the button labelled
Macintosh, Apple ... you go to the card shown in Figure 12-33.

*

File

Edit

Go

Tool s

Objec t s

M11cintosh, App le, Computers, Printers

Figure 12-33

Macintosh clip art in Art Ideas stack

This card contains a number of pictures of Macintosh computers,
printers, LocalTalk cables, connectors, and Apple Computer logos. All
of this art can be cop ied from the stack and pasted into your
stacks wheneve r you need a picture of a Macintosh computer. (Don 't
fo rget, however, that the stack is copyrighted and you have to have
Apple's permission to distribute the art in a form that others can copy
and reuse.)
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You could now click the Hom butto n and return to the Home card.
Then, if you click the button labelled Card Ideas, you go to the index
card sh own in Figure 12-34.

.,

,..

~
Address File

~

rmmB

US Stat e map

Bookshelve s

Metric Equiv .

Stationery Guide

US Zip code map US Time zones

Baby s itter

IClick on small c ar d picture t o go t o t hat card.l
Figu re 12-34

Index card to Ca rd Ideas stack

This stack has a number o f ideas for cards that can be included in your
stacks as you create them . Fo r insta nce, suppose you were taking a
chemistry cl ass and wanted to keep your n otes in a HyperCard stack for
reviewing before a test. You might decide that you would like a quick
referen ce to metric weights and measurements. You could add this to
your stack by clicking the button labelled Metric Equiv., which would
take you to the card shown in Figure 12-35.
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Equivalents
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METRIC EQU IVALENTS FOR LENGTH
I cent imeter .............0 .394 inches
I inch .. .............2.540 cent imeter s
I meter ................ ,.......3 .281 feet
1 foot ... ..... ........... ,...0 .3 .5 meters
I meter ···············+ 1 .0936 yards
1 yard ...................0 .9 144 me ter s
I kilometer ...........~ .. ..0 .62 14 mile
1 mile ... ...........1 .6r 4 kilome ters
METRIC EQUIVALENfS FOR SQUARES
1 sq . centimeter .. T 0 .1550 sq. in.
1 s q. inch ....6 .452 t q. centimeters
1 sq . meter ........... 0 .764 sq. feet
I sq. f oo\.. .....0 .0 9 90 s q. meters
1 s q. meter .......... . 196 sq. yards
1 sq. yard ........O.B 6 1 sq. meter·s
1 sq. kilometer ......0.386 s q. mile
1 s q. mile ........2 .5 s q. kilomete rs

Figure 12-35
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METRIC EQUIVALENTS FOR VOLUME
1 c ubic centimeter .....0 .06 1 cu. in.
1 c u. inch .... .16.3 9 cu. cent ime ter s
I cu.meter ............35 .3 14cu. feet
I cu. foot .. ......0 .0 2832 cu. meters
I cu. met er .......... .1 .308 cu. y ards
I cu. yard .........0 .76 4 6 c u. meters
I liter (dry) ..... ... ........0 .908 quart
I quart ( dry ) .... .......... I .! 01 liters
I liter (liquid) ......... I .0567 quarts
1 quart (liquid) .........0 .9463 liters
I US gallon (1iquid) ..... .3 .7 8 5 liters
1 Imperia l gal. (liquid) .4 .546 liters
I liter ( liquid) ......0 .264 US gallon
I liter (liquid) ...0 .220 Imperial gal.
METRIC EQUIVALENTS FOR WEIGHT
1 gr am ...................0 .03527 ounce
I ounce ......................28.35 gra ms
I kilogram ..............2 .20 46 pounds
I pound ..............0.45 36 kilogr ams
I metr ic t on ....0 .98421 English t on
I English ton ........ l .0 16 me tric ton

Metric Equivale ~ ts card in Card Ideas stack
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Then, all you have to do iscopy thecard, go back to your chemistry no tes
stack, and paste the Metric Equivalents card into the stack.
You could go to the card shown in Figure 12-36, the Button Ideas index
card, by clicking o n the Button Ideas icon on the Home card. This stack
includes seven cards from which you can copy buttons. Most of these
buttons have already been programmed to perform a fun ction, and
when you copy the button and paste it into your stack it will remember
h ow to do what it was programmed to do in the Button Ideas stack. This
is a great time saver and lets you use buttons in your stacks even if you
don't yet know how to write scripts in HyperTalk.
15 File Edit Go Tools

Click on M'!\1 'W'Ot'd or pich.r• to 90 to tNt f»rd.

~~~ ~~,.,

Fi r st, Previous, Next, Las t, Return

+ • • + +' Other Arrows
~Text

<$1 0 liiD' I cons
!!ill c;;J i i Home, Business

P ?
~

About, Help, Informati on

e c;. ~ Mi scellaneous

Figure 12 -36

Index card for Button Ideas stack

If you click on the Stack Ideas button on the Home card, you go to the

card shown in figure 12-3 7. This is the first of four index cards in this
stack.

.,

~
Phone Mess

DJ~LI:JJ
Daily List

Daily Cal 1

Daily Cal 2

LEI]
Weekly Ca13

Monthly Call

Memo

Notepad

Click on a picture to go to that card

Figure 12-37

Index card for Stack Ideas stack

Postlettes

Hand car d
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The thi rd index card is shown i Figure 12-38.

.,

,..

Dis k labels

Cassette Tape

Smm Video

Art Card 1

Border· 1

VHS Library

Ideas

~
~
Geneology

CJGJ
Border 3

Computer paper

Click on a picture to go to that card

Figure 12-38

Third index card for Stack Ideas stack

If you click the lower right button named "Computer paper," you go to

the card shown in Figure 12-39, which you will use as a starting point
in Project 3 to hold your class notes.
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My home computer sits 1dl y in the corner. How cM 1
modify it so 1t will brew a decent cup of coffee?
Chances ere you're not looking et e horne comput er s1tt1ng
i dle In the corner , but a coffee maker. Today's modern co ffee
makers do bear e strong resemblance to computers, and you're
pr obably not the first confused user to mi stake one for the
other. A good experi ment to establish the identity of the
appliance in the corner invol ves flllin~ the basket just under
the top wi th coff ee grounds, then powiing cold wat er mto the
grill on top. I f the fuses bl ow end you!end up w1th a floppy
disk covered w ith co ff ee grounds, you ~re on the wrong track.
But If, moments later , you f ind your self enjoymg e fresh
brewed cup of coffee, well then, my hunch was correct. Good
luck!

I~

<D19860uok's Br••lh

Figure 12-39

M~slor~ Thulro

The "Computer paper" card

Of course, coffee has little to do 'lith chemistry (except for t h e night just
before the test), so you could ±
c opy only the background , which also
contains the fou r buttons sho n. You could then add the n ecessary
compon ents fo r keeping your c emistry notes organized.

I

This card introduces a new icon . The Return button takes you back to
a p reviously selected card. You will make use of this button in many
stacks.
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In this short d escription of the ideas stacks you have been introduced to
some of the ways in which HyperCard's authors h ave made it easier for
you to construct your own stacks and to personalize and customize
stacks you get from others.
One of the main reasons that you can put HyperCard to work for you,
even if you don't know anything about scripting in HyperTalk, is that
the ideas stacks include many cards, buttons, and field s that are already
pre-scripted and that can be used directly in your stacks.

Utilities
HyperCard is distributed with several utility stacks that you might find
to be useful.
Address Stack
The Address stack is designed to work similarly to a rotary card file. You
can store names and addresses in this stack (see Figure 12-40). If you
need to keep multiple name and address lists you can make several
copies of this stack and keep only the names you want in each stack.

I'"

Do vi o o gborn
2 1 19 Runnymede St
Tempe , Arlzono

1r

Figure 12-40

(602)555-6692

Address stack

The Address stack also has the advantage of being linked to the other
personal stacks, such as the calendar, phone dialing, and to-do lists. If
you want, you can link any of these stacks to other stacks, including the
ones you create.
Calendar
HyperCard includes several types of calendars. There is already a
Calendar stack (see Figure 12-41) linked to the Address stack, and Stack
Ideas offers several additional calendars from which to c hoose.
Additionally, you can modify and customize an y of these stacks to suit
yourself and an y special needs you might have.
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File

Edit

Go Tools

Objects

c:o~ m ~rn

week 25 'It

199 1 June
Mon 17

Thu 20

---- - - - - - - Tue 18

Pri 21

Sa,t 22

Wed 19

Sun 23

----·-----

1(1)- - - - - ·
Figure 12-41

Calendar stack

In addition to having a calendar to note future events you must
remember, the Calendar stack includes a to-do list(see Figure 12-42). You
can add, modify, or delete any items on your list. If two pages are not
enough, you can add as many as you wish. You can even keep separate
to-do lists fo r personal, business, civic, and other needs.
r

•

File

Edit

Go Tools

Objects

To Do:
::J::::::::=::::::::::::=:~:=~~== :=~======~~
.......J......-------- -- ·- ..·----- ·---··- ·- -

·-------..----·----

:::::::i====--=--==:========
.......;------·- - - - - - -

_ _ _ _ _ _M _ _ _ _ _ _ _ __

I

:::::::::::::::=====--==--=
-~-----------

; - - - - - - -· -·- -

---·----==---=---=== I

Q
Figure 12-42

~:

To-do list in the Calendar stack

Phone Dialing

Your Address stack will probabit contain many phone numbers, and
HyperCard provides a nice feature for dialing them for you. Click on the
phone icon, and HyperCard automatically dials the number.
In addition to dialing the numders in your Address stack, HyperCard
provides a Phone stack that allow~ you to customize how the dialing will
be done, and it includes the area codes for all of the United States and
Canada.
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The Phone stack can dial a phone three ways: by creating the phone's
touch -tone sounds through the computer's speaker (not very reliable),
by digital tone dialing through a modem, or by rotary pulse dialing
through a modem. It allows you to enter the local phone prefixes and
uses th em to determine if the call is a long d istance or local call. It is even
smart enough to get an o utside line or make an international call.
You can set your preferences and local calling information directly on
the first page of the Phone stack (see Figure 12-43).

5:45AM
local Area Code:

..1Q.1.............

Ente r your local prefixes:

Click h•r• to dial

Outside line:
Toll cell :

111111

®Speaker (tone dialing)
Modem (tone dialing )
Modem (pulse dialing)

Long distance:
International:

.!......................
..!......................
..9J..L..............

0
0

. . . . . . X-.. . . . . . . . . . _..... . . . . . . . . . . . . .. . . . . .. . . . . . . . . . . . . . . . .... . . . . . . . . . . . . . . . . . . .. . . .. . . . . . . . . . . ._. ___. . . -.. . . ..
Figure 12-43

Phone stack

If you click the Area Codes button, you will be presented with a stack of
area codes, and the Message box will have the Find command already
entered with the insertion point located between the quotation marks.
To find an area code for a location, type in the name (or partof thename)
and HyperCard will find it if it is in th e stack. It will find all states and
provinces and most larger cities.
If this stack does not contain the places you need to call, search by state
or closest city and add the name of the town to the appropriate card. Of
course, you are not restricted to just adding towns to the Ph one stack.
You can also add names of friends and relatives to the appropriate cards
and can tell the time difference, nearest cities to visit, or whatever you
can think of that would work h ere. Once you get this stack it is yours to
customize as you want.
If you want to find the area codes for Arizona, for example, all you

have to do is enter th e state's name in the Message box and press the
Return key.
You can see (in Figure 12-44) that HyperCard found the appropriate card
(which h as h ad some towns added). All of Arizona has a 602 area code.
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.,

Phoenix, Flagstaff, Tucson, Tempe, Mesa, Apache Junction
For all locations in this region, dial 1-602-

find "Arizona"

Figure 12-44

Area codes in Phone Stack

This completes the overview of HyperCard. In the projects that fo llow,
you will learn to use some of HyperCard's many powerful-yet
surprisingly easy-to-use-features for yourself.

Project 1: Using an Existing Stack
In this project, you will browse through the Glossary stack that was
developed for use with this book.
When you complete this project you will know the major concepts and
conventions used in browsing through a stack. You will learn to use the
Find command, to use the Message box, and how to navigate through
dynamic links in the stack.
One of the tasks associated with writing a technical book is producing
a glossary of terms used in the book. A glossary for this type of book
contains terms relating to computers in general, the Macintosh
specifically, desktop publishing, Word processing, graphics, information
management, spreadsheets, and HyperCard.
Since we used HyperCard to coll1te and sort this information and then
export it to Word to create a tlxt glossary, we thought it would be
interesting to demonstrate the pynamic (and some of the graphics)
features of HyperCard. We sprue d up the stack a little and included it
o n the Macintosh Journey Projects d isk.
If you completed Project 1 in Chapter 1, you have already copied the
Glossary stack onto your data disk. If not, you need to copy all three
HyperCard stacks from the Projects disk onto your data disk.
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-Q

.. Quit HyperCard by choosing Quit HyperCard from the File menu.
•

If you haven't already done so, copy the Glossary stack onto your
data disk.

•

Restart HyperCard by double-clicking o n the Glossary stack's icon.

Starting HyperCard by double-clicking on a stack icon bypasses the
Home card and causes the stack you double-clicked to be loaded (see
Figure 12-45).

Figure 12-45

The first card containing terms and definitions

The card contains four fields, noted below.
• Term

Contains a word or phrase used as a glossary
entry

• Definition

Contains a definition and possibly a short
discussion about the term

• Additional Notes

Mostly used to inform you when a card
contains an explanatory pictu re

• See also

Contains dynamic links to related terms. If
you click one of the terms you are taken to a
card containing that term.

The background for this card contains nine buttons, some of whi ch are
hidden at times depending on your actions.
• Home

Shows a closing card, closes the stack, and
goes to the Home card

• Show Picture

Shows the picture that is hidden on some of
the cards. If the Additional Notes field contains
"See the Picture" then you can cl ick on this
button to show it.
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• Hide Picture

Hides he picture

• Previous

Goes to the previous card and automatically
hides the picture before leaving the current
card. If you click on the left arrow while on
the first card, it shows you the last card.

• Sort

Sorts all of the cards on the Term s and
Definitions background alphabetically by the
contents of the Term field. This is available so
you ca~ extend the glossary by adding more
terms.j~licking Sort then re-sorts the cards
very quickly so you can look through them in
alphabetical order.

• Find

First determines if you want to find a word or
phrase anywhere on a card or just in the Term
field. When you answer this question, it lets
you enter the word or phrase, and then places
the entire Find command into the Message
box and finds the first occurrence if it is in the
stack. To find an y subsequent occurrences,
press the Return key. When you are done
with this Find command, close the Message
box by clicking in its close box.

• Next

Goes to the next card and automatically
hides the picture before leaving the current
card. If you click on the right arrow while on
the last card, it shows you the first card.

• Return

If you click on a term in the See also field, the
Return button appears so you can return to
the ca(d from which you jumped.

• Tell Me

Displays the copyright notice and autho rs'
names.

As you can see on the first card (see Figure 12-45), it contains the term
"acronym ", a definition of the term, and some examples. The Additional
Notes field of this card is empty, but the See also field contains several
items that are acronyms, which also appear as terms in the stack.

NAVIGATING THROUGH DYNAMIC LINKS
The first term in the See also fielb is "ASCII". You can see the card that
contains its definition by clicki~g the word with the browse tool. The
See also field contains locked texj which means that it alone, of the four
text fields, contains informatio'( that sho uld not be changed. It also
contains a short script that remetpbers that you started on this card and
then takes you to the card contcti ning the term that you clicked.
Let's see how the dynamic links in the See also field operate.
.. Click ASCII in the See also field, as shown in Figure 12-46.
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Glossary Stack

Figure 12-46

jumping to a related term

When yo u jump to a related term, a Return arrow appears, and you can
use it to return to the original term. This lin kage supports jumping to a
series of terms through the See also fi eld. Cli cking on the Return button
will take you back through the series of cards you followed until you
reach the o riginal one. If you click the find, left arrow, or right arrow
button s, this linkage is dissolved and t h e Return button disappears.
When you click the word in the See also fie ld, HyperCard takes you
directl y to the card that contains 11 ASCII " in the Term fiel d. In add ition
to the definitio n and other information about 11 ASCII", th is card
contains "See the picture" in the Additional Notes field, as shown in
Figure 12-47.

Fig ure 12-47

Some cards h ave pictures.
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Anytime "See the picture" is sha ing in the Additional Notes field, you
can click Show Picture to see tt: hidden card picture.
•

Click Show Picture.

This card, which contains the term "ASCII ", has a picture showing the
entire ASCII character set for the Geneva font (see Figure 12-48).

0 NUL DLE
I SOH DC1
2 STX DC2
3 ET X DC3
4 EOT DC4
5 ENO NAK
6 ACK SYN
Low
7 BEL ETB
8 BS CAN
9 HT EM
A LF SUB
8 VT ESC
C FF FS
D CR GS
E SO RS

Figure 12-48

spc

..

"
$
%

&
(
)

0
2
3
4

5
6
7

a
9

"+

-

<
>

B

R

c s
D
E
F
G
H
I

v
vi

J

z

K
L
M
N

[

T

u
X
y

\

I

a
b

q
r
s
t
u

c
d

•f

v
w
X

i

y

j
k
1
m

z

c

e

t

00

l

0

±

i

¢

!

E
N

£
§

l

.f

¥

0

•'ll

I

0

a
a
a
a

~

.,
1!.

+

«

0

))

y

®

0

@

11

0
0

tM

J

nbs

A
A

2

-

9

•u

"" 0

.-'E

"

~

I
TT

f3

"

-

-

CP

0
CE

Viewing the card picture

Most of you will have little reason to know the actual numbers for each
of the characters shown, since you can easily find the characters using
the Key Caps desk accessory when you want to ty pe them from the
keyboard.
When you are finished looking at the pi cture, you can click the Hide
Picture button or click on any of the arrow button s. You really don't
have to hide the picture, because the stack is programmed to hide the
picture automatically whenever you go to a different card.
,. For practice, click Hide Picture.
You originallygottothiscard by jumping from the card with "acronym"
in the Term field. You can now go back to the card from wh ich you
originally jumped.
•

Click on the Return button (see Figure 12-49).
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Glossary Stack

Figure 12-49

Click the Return button to return to the original card

You are now returned to the "acronym" card. Now you know how to
navigate through the dynamic links in the See also field. Remember,
however, that if you go to a different card using one of the arrow keys,
the dynamic link is broken and the Return button disappears. This lets
you override the Return link in favor of exploring in a different
direction.

USING THE FIND BUTTON
Another way to find information in the Glossary stack is by clicking on
the Find button. Unlike choosing Find from the Go menu or typing
Command-F on the keyboard, this button has a script that offers you
two choices of where to look for the term or to cancel if you clicked the
button by mistake.
•

Click Find.

When you click the Find button, the Glossa ry stack asks you wh ere you
want it to look (see Figure 12-50) . The default is to limit the search to the
Term field. You can choose this by clicking on the default button or by
pressing Return or Enter.
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Figure 12-50

Telling the Glossary stack where to look for text

Click the Anywhere button if you want to extend the search to any field
in the stack. If you really do n't want to find anything, click the Cancel
button.
In this case, you will limit the search to finding a word in th e Term field
only. Two fonts with names that start with "Zapf" are available in
LaserWriters that support PostScript. Now you can see how quickly
HyperCard will find o ne of them for you.
, ,. Click Field 'Term' or press the Return key.
Now that you have told the stack where to look, it is time to enter the
word or phrase you want to find (see Figure 12-51).

{[E:J [

Figure 12-51

•

Type Zapf or ZAPF or

Cancel ]

stack what to find
(capitalization does not matter).

In a second or two the card conta ining "Zapf Chancery" is shown (see
Figure 12-52). To aid you in findin g other occurrences of the phrase you
are findin g, the Message box has become visible and a find command
has been entered for you.
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Figure 12-52

Text found in a card

Za pf C ha ncery is t he first of the two cards with the word "Zapf", and you
can now find the second very easi ly. As long as the Message box is
showing w ith the find command, all yo u have to do is press the Re turn
key to find the next occur re nce of the word or p hrase being found.
•

Press the Return key.

The next card containing "Zapf" in the Term field is shown a lmost
immed iately (see Figure 12-53).

Glossary Stack

Figure 12-53

Text found in another ca rd
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This card (a nd the preceding o n ) contains a picture showing a sample
of the font. In fact, m ost of th e s andard screen and LaserWriter outline
fonts are listed in the Glossa ry, ahd each has a samp le of the font sh own
on the card picture.
The Zapf Dingbats font contains a number of symbols; if you want to see
a sample, cli ck the Show Picture button. A better example of a sample
font picture is on the preceding card. Let's look at it.
•

C lick o n the left arrow butto n.

You now see the Zapf Chancery card . Show the picture to see a sample
o f this font (see Figure 12-54).
•

C lick Show Picture.

'I1iis is a samp(e of tlie Zapf Cliancen; font
JI'BCD'E'FG'Jfi'J'.J(£7Vf'J{O'PQ'R..STU'VWX)'Z
a6caefsliij~mnopq~~z

1234567890

Figure 12-54

A sa mple of the Zapf Chancery font

Ex plo re th e Glossary stack as much as you want . When you are ready to
go back to the Home stack, follow the instructions below.
,.

Click o n the Ho m e butto n on the to p right of the card.

The stack then sh ows the closing card, and in a few seconds it fades out
and takes you back to the Home card.
You can now continue explo ring the othe r stacks shown o n the Home
card if yo u want.
~

-Q

•

W h en you are done, choose Quit HyperCard from the File m enu .

This completes Project 1. You IjOW know h ow to move around inside
most HyperCard stacks and hoW to use the Help stack fo r learning mo re
about Hype rCard. The G lossa r~ stack is available for quickly finding
definitions an d seeing exam ples of more than 600 terms.
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Project 2: Modifying a Stack
In Pro ject 2 you will create a n ew stack from o n e of the cards sh own in
the Card Ideas stack. This stack will allow you to enter, find, and modify
names and addresses of your friends and acquaintances. You will see
how easi ly a new stack can be adapted from another o ne.
In the second part of the stack you will enter a few n ames and some
related informa tion. Then, in the final part of the proj ect you wi ll
produce mailing labels and an alphabetical list of all the n ames in the
stack.

SETTING THE USER LEVEL
This project requires that you h ave access to the authorin g capabi lities
o f HyperCard.
,. Start HyperCard.
,. Go to the User Preferences card in the Home stack by cli cking on the
left arrow button and change the user level to Authoring, as sh own
in Figure 12-55.
•

File

Edit

Go Tool s

Object s

User Prefurena::s
User Nam e: Marsha Szczepanski
User Le ue l :
0 Browsing
0 Typing
0 Painting

0
0

TeHI Arrows
Pow er Key s

.®, Authoring

U Scripting

Figure 12-55

Ch oosing the Authoring user level

.. If Text Arrows is selected, click it to deselect it. Be sure Power Keys
is a lso d eselected.

•

Go to the Hom e card by clicking on the right arrow.

When you change the user level to Authoring, you see two n ew menus
added to the menu bar: Tools and Objects.
You n ow have access to the Tools menu, whi ch allows you to choose the
button tool, fi eld tool, and any of the painting tools. The Ob jects menu
allows you to get information about the objects in the stack a nd to
chan ge certain options th at control the objects.
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COPYING STACK IDEAS ELEMEN S
Instead of creating a new address stack from scratch/ you can save
yourself a lot of work by creating a new stack based on an existing card.
For this project/ you will create a new stack from Address card 2 in Stack
Ideas.
•

Click Stack Ideas.

This opens Stack Ideas and shows you the index card.
•

Click Address card 2.

You now see the second address card sample (see Figure 12-56). You will
use this card to create a new stack. Then you will modify some of the
characteristics of the fields on the card and enter information into the
fields.

c

File Edit Go Tools
Royce Walthrop
2 I 7 Crocker Lane
Hillsdale, Ohio 44704
(21 6) 555-3452

3 kids:
Sareh ( 18)
Bill (12)
Beth (9)

Work:
General Sprocket
(2 16) 5 55 -7654

&ood Brld&e partner

Royce9/21

Charlene 4/22

Figure 12-56

The second address card in Stack Ideas

Creating a new stack from an existing card is a fast and easy process.
•

Choose New Stack from the File menu.

You are presented with a dialog box that allows you to name the new
stack (see Figure 12-5 7).
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Edit

eels

Go Tools

lest HyperCnnll

IQ: !g) Mnrshn Sz ...

es

Eject
[

Drlue

J
partner

New stack nnme:

~~]
( Concel )

Figure 12-57

•

Creating a new stack from an existing card

Name the new stack My address stack, be sure Copy current
background is selected, and save the new stack on your data disk.

In a few seconds, HyperCard does some work and you have a new stack
on your data disk. It is important to copy the current background
because it has a number of buttons and fields already in place. By
copying the background, you copy not only the graphics on the card but
also the other objects and their characteristics and scripts.
You can easily find information about your new stack using the Objects
menu.
,.

Choose Stack Info from the Obj ects menu.

A dialog box appears o n the screen telling you the name of the stack,
where it is located, the number of cards and backgrounds it contains, the
current size, and how much space is free in the stack (see Figure 12-58).
This is a new stack with only the one card and one background you just
copied. It takes up 8 kilobytes o n the disk and has no free space yet.
' 15

File

Edit

Go

Tools

Stock Nome:

I*

.fiii§JJjm.

Where: Mnrsha SzczepBn skl
Stock contolns 1 cords.
Sl11ck cont11lns I backgrounds.
Size of Stack: 8 K
Free In Stack : 0 K

Figure 12-58

Getting information about the stack
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Click OK when you have re d the information in the dialog box.

Adjusting Background Fields
One of the first changes you will make is to show the outline of the Name
and Address field and show the lines in the field. The font for the field
is currently 12-point New York, and you will change it to 12-point
Geneva.
To make it easier to work with various tools, you can convert the Tools
menu into a floating palette. This is a tear-off menu, and all you have
to do to move it on the screen is choose the menu and drag it from the
menu bar to where you want it.
•

Tear off the Tools menu and move the palette to the lower left corner
of the card (see Figure 12-59).
•

File Edit

Go Tools

Notes

Figure 12-59

Tear off the Tools menu to make it easier to use.

Now that you have the Tools palette where you can use it, you need to
choose the field tool so you can modify some of the fields on the
background.
,.

Select the field tool.

When you select the field tool, all the fields on this background become
visible. You can see that there are four fields showing on the card (see
Figure 12-60).
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File

Edit

Go Tools

Figure 12-60

Fields become visible when the field tool is chosen.

Let's examine one of the fields in more detail.
•

Click in the top left field .

The field becomes selected. This is shown by a m oving dotted line
surrounding the field. A selected field may be moved by dragging it with
the pointer. It may be reduced or enlarged by dragging one of its corners
in the appropriate d irection. It may be deleted by pressing the Backspace
(or Delete) key.
In this case, you don't want to change its size or position o r delete it.
What you will do next is to change its appearance and font characteristics.
•

Choose Field Info from the Objects menu .

A dialog box similar to a stack information box appears. In this box are
the name of the field (Name and Address), its number on the background
(1), the style of the field (transparent), and any other chosen characteristics
(none).
•

Change the style to rectangle, and click the Show Lines check box.

The dialog box should now look like the one in Figure 12-61.
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File

Edit

Field Name:

f!:tn,J. .IHII;OQII¥\

Bkgnd fi eld number: t
Bkgnd fi eld I 0: 2

Styl e:

0
0

transpar ent
opaque
® re ctangle
O shadow
0 scrolling

Figure 12-61

Setting characteristics for a field

Before you click the OK button to accept these changes, you can m odify
some of the text characte ristics.
•

Click Font.

An other dialog box appears, replacing the field information box.
figure 12-62 shows the dialog box just before you click OK to accept the
new choi ces .

Style
0 Bold

Chlcogo
Courier

Ot
tallc
0 Underlin
e
0 Outline
0Shadow
0 Co nden se
O EKtend

Figure 12-62

•

~~~···
Gregorian
Helu etlca

Setting font ch aracteristics for a field

Select Geneva fan t, and 12-, oint size. Click OK to accept the change.

To see the results o f the ch anges ou just made to the Nam e and Address
field, choose the browse tool.
•

Select the browse tool.
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The fi eld is now visible on the screen. The re is a solid rectangular frame
around th e fie ld, and dotted lines indicate each li ne of text the field can
contain, based on 12-point Gen eva (see Figure 12-63).

~---·---~~-~
--------·----..--·--···------------··--··--·--~--·---·

..

----

.
"

-

The modified Name and Add ress fi eld

Figure 12-63

Now that you can see this fi eld, you ca n modify t he field below it.
•

Select the fie ld tool, and double-cl ick on t he lower left field.

You now see a field in formation dia log box (see Figure 12-64).
'

115

File

Edit

Go

Tools

Objec ts

Fiel d N11me:

I'Phone
- - - - - - --

Bkgnd fi eld number: 2
Okgnd field I D: 3

D lock TeHt
D Show lines
D Wide Margins
D Auto Tab

Figure 12-64

•

Style:

0
0

transparent
opequ e
® rect angle
O shadow
0 scrolling

Namin g the Phone fi eld and changing its style

Name the fi eld Pho ne, a nd select th e rectangle st yle. Click OK.

After you close the dial og box, your address ca rd sho uld look similar to
the one shown in Figure 12-65 .
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Figure 12-65

The card after

c~anging

the two fie lds

You have now completed all the changes you wi ll be making to the fields
in this stack. One of the most appealing aspects of HyperCard is the
ability to continually customize and modify stacks to suit your particular
n eed s and aesthetics.

Editing Cards
Now that you have finalized the design of t his stack, change back to the
browse tool and close the Tools palette.
•

Choose the browse tool, and close the Tools pa lette.

You a re now ready to enter information into several cards. Entering text
in a field is as easy as selecting where you wa nt it and then typing it into
the fi eld.
There are several ways to position the text insertion point in the Name
and Address field. You can m ove the pointer to the first line o f the field
and click the mo use button, or, if no text insertion point is visible in any
of the fields, press the Tab key to m ove the insertio n point into the first
field on the background.
Since the Nam e and Address field is th e first background field, either
method would work in this case. When you are creating n ew cards and
entering information, you may find it easier to use the Tab key method
of placing the insertion point.
•

Press the Tab key.

The insertion point is placed into the first line of the Nam e and Address
field. You are n ow ready to enter the first person's data in your address
stack.

I

•

Type Francesco Cavaliri, and then press the Return key.

The name appears in the field and the insertion poi nt m oves to the start
of the next line in the field.
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•

Type Route 3, Box 149, and then press Return.

When you type th e last line of the address you do not n eed to press the
Return key.
•

Type Pagosa Springs, CO 82032.

This is all the information that needs to go in the first fi eld. Now you can
e nter the area code a nd phone number in the Phone field.
•

Press the Tab key to m ove the insertio n point to th e Phon e field.

•

Type (303) 555-1293.

You h ave now e ntered all the info rmatio n that will go on this card. Your
card should look like the on e shown in Figure 12-66.

.,

Figure 12-66

The stack's first card with a name and address entered

Adding More Cards
An address stack with only o ne name and address is not very useful, but
h ow do yo u add mo re information to your list? You mu st create a n ew
card for each person you want to ente r in your fi le.
Let's create a n ew ca rd and e nter ano ther person's data.
•

Ch oose New Card from the Edit menu.

•

Type the fo llowing information in the app ropriate fields:
David Wilson
1429 Denali Drive
Marietta, GA 30922
(404) 555-2916
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You should now see a card like the one shown in Figure 12-67.

Figure 12-67

•

The second name and address card

Continue creating new cards, and enter the information for the
following people:
Linda Ammerman
928 Dobie Way
Bellevue, NC 28002

(704) 555-9273

Bill Beck
Route 3, Box 992
Hanging Dog, NC 28982

(704) 555-1092

Larry Wilson
1298 Main Street
Apache Junction, AZ 92778

(602) 555-8725

George Kelischek
112 Via Viol
Brasstown, NC 28672

(704) 555-2892

Ed Smith
Marianne Myers-Smith
8392 Hilltop Lane
Spotted Fawn, TN 27202

(615) 555-2906

David Willie
9289 Rock Road
Auburn, GA 30282

(404) 555-1296

George P. Burdell
1837 Imagination Alley
Atlanta, GA 30003

(404) 555-9272
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Printing Cards
HyperCard can print one card or all the cards in the stack, but it does not
directly support a command to print only some of the cards. This can
be done, but it requires creating a HyperTalk script to accomplish it.
In this case you want to print only one card.
•

Click on the left arrow or the right arrow until you find a card you
want to print.

•

Choose Print Card from the File menu.

WORKING WITH STACKS
You now have an address stack with information on nine people. You
can add as many cards as you want to a stack like this, limited only by
the amount of disk space available on your system .
The names in this stack were entered in no particular order. One of the
main functions of information management software is to organize
information.

Sorting the Stack
When you copied the background from Stack Ideas you also copied a
number of buttons located on that background. The icons of the buttons
and their names are shown in Figure 12-68.

~

Home

~Dial

~ToDo
~View

~Calendar ~Sort
Figure 12-68

Background buttons in the address stack

The Home button does what all Home buttons do: it goes to the Home
card.
The Calendar and To Do buttons take you to the previously discussed
stacks with the same names. View shows you all the cards in a stack in
rapid sequence. To stop View (or almost any other script), type Commandperiod.
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The Sort button was previously programmed to allow you to sort by the
first word or the last word of the first line of the Name and Address field.
This assumes that you have entered the names on the first line, in first
name, middle name or initial, and then last name order.
When you copied the background, the buttons were copied and retained
their original position and characteristics, including the scripts they
had in their original stack.
Dial allows you to dial a phone number through the Phone stack. Select
the number you want to dial, and then click on the Dial button. (Do not
do this if you have a modem attached, unless it is a number you really
want dialed.)
Now that you know the names of the buttons and a little about what
they do, you can put one to work and sort the cards in the stack. Most
address lists are sorted alphabetically by last name, with people having
the same last name sorted by first name.
You can accomplish this in this stack by sorting first by first name, and
then again according to last name. When HyperCard sees two cards with
the same sort value it will not change their positions. So, when you sort
first by first name, and then by last name, HyperCard will leave the
people with the same last name in alphabetical order by first name.
Unless you have hundreds of names in the stack, the process goes fairly
quickly.
, . Click Sort and choose First Name. Then click Sort again and choose
Last Name, as shown in Figure 12-69.

'*

File

Edit

Go Too ls

Figure 12-69

Sorting the names in alphabetical order by last name

You have now completed sorting the cards into alphabetical order.
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Printing the Stack
With the stack in alphabe tical order, it is a good idea to p rint all the cards
in the stack.
HyperCard provides a command to d o this: Print Stack. When you
choose this comman d, it allows you to select various optio ns before
printing.
•

Ch oose Print Stack from the File menu.

You are presented with a dialog box like th e on e shown in Figure 12-70.
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Go

Tool s
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Coples:l•
D Monuol poper f eed
D Dorleer printin g
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[ Con cel

]

D No spoce between cord s
0
0

Pr int
Print
® Print
0 Print

one c11rd per poge
fu ll size c11rds
hol f si ze card s
quorter size cords

® Stondord format
Split- pag e forma t

0
Heoder: ~ 0 ~ ~

Figure 12-70

•

The Print Stack dialog box

Select Print half size cards and Sta nda rd format.

The botto m of the dialog box has a box with four icons that lets you
create a custom header fo r the pages on which the stack will be printed .
In order, th e icons stand fo r Date, Time, Page Numbe r, a nd Stack Name.
Clicking on o ne or more of these will en ter the respective data into the
h eader wh en the stack is printed. You can separate the informatio n with
on e or more spaces.
•

Click OK.

The stack will print on two pages, with eight cards o n th e first page and
only one on the second page. This is n ot the fastest or most effi cient way
to print a report fro m a stack, but it has the advantage of showing all the
graphics stored on each background and o n each card . Printing the stack
is a good way to document the appearan ce of a new stack in case you
n eed to crea te a simi lar one in the future.
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Printing a Report
HyperCard provides three main ways to print reports based on
info rmatio n in the stack. It onl y processes all cards and will not allow
you to select a subset of the data for a report.
The lack of ability to print info rmation that matches specific criteria is
one of the problems that inhibits using HyperCard fo r a database
management program. As w ith most th ings in HyperCard, however,
HyperTa lk provides the tools to accomplish t h is task if you are an
accom pi ished scri pter.
To complete this project, you will print each of the three types of reports
provided in Hyp erCard: labels, columns, and rows.
A number of printing option s are available when printing HyperCard
reports, but this project does not try to exhaustively cover each of the
optio ns. Instead, you are presented with an example of how you might
produce each of the three types of reports.

Labels
A label repo rt is used to create mailing labels o r o ther labels that a re
arranged several to a page in a rectangular pattern.
Each label contains in formation stored in the fields o f one card. Th e
information printed in each label is automatical ly centered o n the label.
Each label in the report you are about to print will con ta in left-align ed
text, but the left edge of the text in a ll labels will not be aligned, as
HyperCa rd will adjust the contents of each label so the text will fit as
n ear the center of the label as possible.
This is easier to understand if you print a label report.
•

Choose Print Report from the File me nu.

You are presented with a dialog box such as the one in Figure 12-71.

' li:lm!ll Edit

Go Tools Objec ts

Print report... Coples:lr . l
0 Monuol paper feed
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The selections for printin g a label report
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•

Select Labels, With the current background, Selected background
fields, and the Nam e and Address fie ld (see Figure 12-71). Then
click OK.

HyperCard prints the reports to the cu rren t ly selected p ri nter. If you a re
printing on an lmageWriter, you must use 3-up labels o n 8.5 - by 11 -inch
paper, because Hype rCard is not programmed to print o n na rrower
labels.

Columns
A colu mnar report prints t he report in vertical columns. Each field is
printed in its own column. lfthe column is too na rrow to hold the en tire
conten ts of the fi eld, the text is automa tica lly wrapped withi n the
approp riate column .
In this report, yo u will print the arne and Address field in the left
column and the Phon e field in the right colum n.
•

C hoose Columns, With the curre n t background, Selected
backgro und fi e lds, and the Nam e and Address and Phone fields
(see Figure 12-72) . Choose to print field names. Click OK.
Edit

Go

Too ls

Print report...
Coples:l•
0 Monuel paper fe ed
0 Darker printing

r- r
i

I!
I ____.___
___L
Header:

1li'n 0 l!!ll Q

Figure 12-72
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0

Labels

0

Rows:

®Co lumns

ILJ[Jj
I

Can cel J

ffi ~ !ffij

Print teHt fi elds from ell cards:
(: In the entire Hoc k
® With the curren t background
Which fi elds:
0 ( ord liPids
Sel ec ted DIICICOrllUn~

Print the names of:
0 Cords
181 Fields

Selecting optio ns fo r a column report

The report consists of a two-colurn n report listin g the information in t he
two fields. The informatio n for a particular ca rd appears side by side.
If you choose to pri n t the na mes of fields, they appear at the top of each
column, wh ile card names appear in t hei r own column o n the left side
of the re port.

Rows
If you ch oose to print a row re port, th e information for each card is
printed in a verti ca l fo rmat with th e name o f eac h field (if the optio n is
chosen ) to the left of the first line of the conten ts of that field.
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HyperCard allows you to print row reports in on e-colum n or twocolumn form at. If you ch oose th e one column -format, the information
for a single card ca n go all the way to the righ t ma rgin. A two-column
format cau ses the in format ion on two cards to be printed side by side.
In this project you will c hoose a single-column format.
To print a row report, ma ke the same selection s as you did for the
column report, with o ne exceptio n:
•

C h oose Ro ws in stead of Columns, and th e n click OK (see
Figure 12-73).
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Field 4
Print the names of:
D Cards
!81 Fields

Selectio ns fo r a row report

This completes the three reports for this project.

Dialing a Phone Number
When you copied the background for this stack, you copied an interesting
button as well. Th e Dia l butto n allows you to use your com puter to dial
the ph one automatically based on informa ti on in a stack.
Since each of t he peop le in this stack has a phone number listed, you can
use the Dial button to call them.
To use this in a real situation, you would open the Phone stack and make
any adjustments and customizati ons necessary fo r you r particular
location and computer system.
The Phone stack knows how to d ial by generati ng touch tones from the
computer's speaker or by dialing through a modem using pulse or touch
tones. If you are doing this in a computer lab or at home w ithout a
modem, you ca n h ear the sounds of the computer d iali ng if the Phone
stack is set to gen erate tones fr m its speaker.
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If your compute r is attach ed to a modem and you have modified the
Phone stack to dial through the modem, the following exercise will
actually d ial your pho ne. All the numbers are imagin ary, so the call
shouldn't really go through, but you may want to be awa re that it will
really d ia l th e phone.
You ca n use any of the cards in the stack for this exercise .
•

Select the phone number, and then click on the Dial button (see
Figure 12-74).

Figure 12-74

Using HyperCard to place a call

HyperCard goes to the Pho n e stack and attempts to dial the number you
selected. If the number has the same area code as that listed in the Phone
stack, it asks if this is a local o r long-distance call and dials according to
the preferen ces you have listed .
This concludes Proj ect 2.
W-Q

•

You can ch oose Quit HyperCard or continue with the n ext proj ect.

Project 3: Creating a New Stack
In Project 3, you create a n ew st ack called Class Notes with o ut copying
a card or background . This m eans that you must dra w the background
picture, an d yo ur new stack will not have the benefit of already h aving
the fields and button s on the background as yo u did in Proj ect 2.
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When yo u begin to use HyperC rd for automating more tasks, you will
want to create stacks that are personalized for the specific task at hand.
This project is based on the premise that you will find tasks for which
you will not be able to use one of the cards in Stack Ideas. In this project,
you will copy a po rtion of a background picture, paste it into your stack,
complete the d rawing, add new fields, and import several buttons from
other stacks (so you don' t have to write the scripts fo r them).
To m ake your stack more visually appealing, you will be introduced t o
HyperTalk scripting. Compared to oth er progra mming languages,
HyperTa lk is easy to learn and use, but it is beyond the scope of this book
to teach scripting in general.
Most of the butto ns in this stack are avail able in the Button Ideas stack,
but yo u will use a Sort button and a Print Report button that is included
in the C lass Notes Buttons stack on the Macintosh Journey Projects disk.
To demonstrate HyperCard's visual effects and how they can be u sed to
add visual appeal to yo ur stacks, we have also included a simple Visual
Effects stack on the Projects disk.
The C lass Notes stack, shown in Figure 12-75, is design ed for taking any
type of cl ass notes . It can be used for multi ple classes and will sort the
notes into chronological order within each class. The Print Report
button can be used to produce a t ext file based o n a range of dates or a
keyword search. T he resulting text file may be opened by any word
processing application for formatting a nd printing.
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Print Report

Sort

The final Class

®

otes stack

Thi s stack is also useful for rna ing class no tes if you teach any type of
class o r for o rganizing other not~s tha t ma y not necessa rily be associated
with a class. The techniques yo u will learn in t his project w ill be
applicable to many other types of stack creation.
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For most of this assignment you can leave the user level set to Authoring.
When you add the visual effects to your stack, you will need to (briefly)
change the user level to Scripting.
You should also be sure that you have copied the Class Notes Buttons
and Visual Effects stacks from the Macintosh Journey Projects disk onto
your disk. The procedure for doing this was covered in Project 1 in
Chapter 1.
If you do not presently have HyperCard open:
•

Open HyperCard by double-clicking on its icon.

CREATING THE BACKGROUND
When you create a new stack without copying a background, you must
create the picture for the background, create all the fields necessary, and
create or copy any necessary buttons.
In this case you will create the background picture with minimal help
from Stack Ideas.
To begin this project, you need to go to the third index card in Stack
Ideas.
•

Click Stack Ideas.

This will take you to the first index card in Stack Ideas.
•

Click on the right arrow button two times.

The third index card of Stack Ideas contains a miniature picture of a card
named Computer paper. This is the card you will use as the basis for
creating the background picture of the Class Notes stack.
•

Click Computer paper.

When you do this, HyperCard goes to the card and shows a short story
about determining the difference between a coffee maker and a computer.
If you would like to take a few moments to read the story before
proceeding, go ahead.
It is an interesting method for identi fying a coffee maker, but it would

not be of much use in a class notes stack. However, the picture of the
computer paper in the background might make an interesting background
for your new stack.
The picture on the background layer of a stack only serves as a visual
analogy for the purpose of the stack and how it operates. In this case, the
background picture is not of major importance, and you could have
chosen a number of different approaches for the background for a class
no tes stack.
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The background of this stack c ntains a picture and four buttons you
will eventually use on your new stack, and you can accomplish a lot of
what you will do in this project by creating a new stack based on this card
and copying the background. But, if you do that you won't learn how
to create and place all the objects in to the background of your n ew stack.
3€ - B

•

Change to the background layer by choosing Background from the
Edit menu.

The Background command is a toggle that switches between the card
layer and the background layer.
When you issue this command, HyperCard indicates that you are in the
background layer by adding a series of short diagonal stripes at the top
and bottom of the menu bar. If the menu bar is not visible, you can make
it visible by typing Command-space bar. This is a toggle command and
will either hide or display the menu bar. It is very important that the
menu bar be visible so you can see in which layer you are currently
working.
•

Tear off the Tools palette, and choose the selection tool.

You will now use this tool to copy the series of pin-feed holes and
perforation indicators on the left side of the computer paper.
3€ -C

,,. Select the area of the computer paper shown in Figure 12-76, and
then choose Copy Picture from the Edit menu.
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Figure 12-76
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Copying the left edge of the computer paper

You will now create a new stacJ
•

Choose New Stack from the File menu.

•

In the dialog box that appl ars, name the stack Class Notes, and
deselect the option Copy current background.

This creates a new stack with a blank, white background. You now will
paste the picture you copied from the Computer paper card to the
background of the only card in the new stack.
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3€ - B
~-

v

•

Change to the background layer.

• Choose Paste Picture from the Edit menu (see Figure 12-77). Do not
click anywhere to deselect the picture you just pasted into the
background layer.
"rile.. i.i1i. "cia . 'roo is·. Paint·. oiiilons. ·Patterns .................. .,
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Figure 12-77
~- V

•

Beginning to paint the new background

Paste the picture onto the background again, and be sure to leave it
selected.

This puts ano ther (selected) copy of the picture on top of the o ne you
pasted a few seconds ago. Now you will d rag the new copy straight to the
right and then flip it horizontally to form the right edge of the paper.
•

Press the Shift key and drag the picture to the right side of the screen
(see Figure 12-78).
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The background after dragging the copy of the picture

The second copy of the picture is facing in the wrong direction, so you
need to tell HyperCard to flip the picture horizontally.
.. Choose Flip Horizontal from the Paint menu.
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Thi s gives the two sides you nee for the computer paper you are about
to finish painting (see Figure d -79).
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Figure 12-79

Both sides of the paper are in place.

Painting the Background
By holding down the Shift key while you dragged th e second copy of the
picture to the right side of the card, you constrained the drag to be
exactly horizontal. This means that the tops and bottom s of the pictures
should match exactly, and you now can easily d raw a line across the top
and bottom to finish the sheet of paper.
•

Choose the line tool from the Tools palette.

,,. Press the Shift key to constrain the line tool to horizontal lines only,
and draw two horizontal lines to connect the top and bottom of the
page (see Figure 12-80).
,. ....................................... , ....... , ............... ..,
j

File

Edit

Go Tools Paint

Figure 12-80

Options

Patterns

The background after the paper is completed
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You can now complete the background by pouring a gray pattern
around the paper with the bucket tool.
•

Select the bucket tool and the medium gray pattern, and pou r the
pattern at the top of the page, above the paper.

Sometimes the pattern you pour might not align properly with the
pattern that surrounded the paper when you pasted it onto the screen
(see the thin black line above and on the right side of the computer
paper's pin-feed holes in Figure 12-81). If you encounter this problem,
you can carefully erase the part of the pattern that does not match and
then repour the pattern into the area you erased .
just as the Shift key constrains lines, circles, and squares, you can hold
it down while using the eraser tool. This causes the eraser to move only
vertica lly or horizontally, depending on how you first start moving it.
This makes it easier to erase a pattern up to the very edge of a straight
line such as around the edge of this computer paper.
A pattern is automatically aligned to the top left edge of the card, so the
pattern you pour the second time (if you need it) always matches the
pattern you poured the first time in any given card.
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Figure 12-81

The background after pouring a medium gray pattern

The next step is to add a title to the top of the background.
To do this, you wil l choose a large font a nd type the n ame at the center
of the top o f the computer paper.
•

Double-click on the paint text tool in the Tools palette.

This opens a dialog box (see Figure 12-82).
•

Ch oose 24-point Bookman (or any similar fo nt available o n your
system), select Center align ment, and click OK.
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Choosing a large font for the title

Click the paint text tool somewhere near the center of the top of the
compute r paper, and then type CLASS NOTES (see Figu re 12-83).
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Figure 12-83

En tering the stack's title

It is sometimes difficult to enter the title in an acceptable location the
first time. Rather than erasing and typing the title in a new location, you
can use the lasso to move it to a better location.
•

Select the Jasso from the Tools pa lette, and then select the title text
by carefully dragging the ~asso around it. Drag the title to the
location you prefer (see Fig~re 12-84).
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Dragging the title to a better location

This completes the painting of the background for the Class Notes stack.
You will now add the fields and labels for the fields.

Adding Background Fields
There will be four background fields in the Class Notes stack. One
contains the date; another, the name of the class; the third field contains
the assignments for the class; and the fourth field holds any notes for the
class on that date.
Before you begin creating the fields, be sure that you are still in
HyperCard's background layer (hint: look at the menu bar).
Before you begin adding fields, select the field tool from the Tools menu
or palette.
There are two easy ways to create a new field. The first is to choose New
Field from the Objects menu. This places a field somewhere on the
card. You can then use the field tool to drag the field to its
intended location.
The second way allows you to draw a field in the position where you
want it. To do this, move the field tool to o ne of the four corners of the
new field's location, hold the Command key down, and then press the
mouse button and drag to the opposite corner of the field 's location . The
outline of the field is drawn and may be modified until you release the
mouse button, at which time the new field will be placed on the card in
the location you specified.
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A field may be moved by dragginl it with the field tool or may be resized
by dragging any of the four corners.

Since you can move a field to a new location and easily change its size,
it is not critical that you initially place the field exactly in its intended
location. If you don't like where it is, you can move it or resize it at will,
even after you have typed text into it.
If you move a field after information has been entered into it, the text

will reflow based on the new size of the field.
Now it is time for you to try it.
•

Choose the field tool from the Tools palette.

•

Using one of the methods you just learned, create a new field on the
stack's background.

At this point, it is not important where the field is located, but you
should see a field somewhere on the screen similar to the one shown in
Figure 12-85 .
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Figure 12-85

Creating your first field

The field is not the right size or in the correct location.
•

Using the methods previously described, move the field to the
location shown in Figure 12-86, and resize it to approximately the
size indicated there.

Precise location and sizing are not critical factors in creating this stack.
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Figure 12-86
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Continue adding the other three fields as shown in Figure 12-87.

The style of the fields is not important right now. j ust place four fields
in approximately the locations shown. You will customize th e fields
next .
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Figure 12-87

le

The four placed fields

The first field you created becomes the Date field. The second field
should be just to the right of the first field and becomes the Class field.
The third field is for assignments. The Notes field comes last an d is the
largest.
•

Choose the paint text tool and enter the field labels shown in
Figure 12-88. The fon t and style are your choice, but be sure you are
in the background layer when you add the text.
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Figure 12-88

The fields containing assignments and notes will become scrolling fields
and allow you to type as much text as you need into the field (up to
30,000 characters). If there is too much text to be visible in the space
provided for the field, the text will scroll (similar to a word processor)
as you enter more text. Later, you can scroll up or down to see different
sections.
You have already learned how to choose fonts, sizes, and styles for the
characters to be entered into a field and also how to select the rectangular
style for a field.
In this proj ect, you can choose fonts, sizes, and styles of your choice
for the four fields. Choose rectangle as the style of t he Date and
Class fields and scrolling for the style of the Assignments and Notes
fields (see Figure 12-89).
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Naming a field and selecting its characteristics
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After clicking the OK butto n, you can see the change in the Assignments
fi eld (see Figure 12-90). The rectangle outlining this fie ld has changed,
and a scroll bar has been added on th e right side of the field.
This allows you to add more text than will show in the field and access
that text convenientl y.
r

•
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Edit

Go

Tool s

Objects

:::<:

Figure 12-90

The Assignments field has a new scroll bar.

When you finish setting the styles, options, and fonts fo r the fields, your
background sh ould look li ke the on e shown in Figure 12-91. Note that
the browse tool is chosen . This automatically takes you from the
background layer to the card layer. If you have not properly specified the
characteristics o f a fi eld it may be apparent at this poin t.
If you need to make chan ges, ch oose the appropriate tool, ch an ge to the
background layer, and ma ke th ose changes. Then select the browse tool
and see if your card compares to the on e in Figure 12-91.
r

15 File

Figure 12-91

Final paint text an d fields for the stack
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Adding Background Buttons
You can make your stack mo re conven ient by adding a few buttons on
the background layer. Moving to the n ext card, or the previous on e, is
a common thing to do in stacks. Going to the last card to add a new card
would be convenient, and to balance it out you could add a button to
go to the first card.
To leave the stack, you p robably want a butto n to go to the Home stack.
There will be times when you wa nt to quickly find something, so a Find
button also would help.
You will round out the stack's co mplement of butto ns with a button for
sorting and one for printing reports. (These reports are different from ,
and somewhat more flexible than, the on es built into HyperCard, so
your stack will have the ben efit of being able to print the standard
HyperCard reports plus these customized ones.)
Yo u will add the buttons fo r going to the first, previous, n ext, and last
cards by copying them from the Button Ideas stack. A butto n contains
a Hype rTalk script that tells Hype rCard what the button can do.
Let's start by copying the button that will be used for going to th e first
ca rd in the stack.
3€ - H

•

Choose Home from the Go menu.

•

Click Button Ideas, and find the card shown in Figure 12-92.

,,. Select the button tool.
•

Select the third First button, as sh own in Figure 12-92.
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Figure 12-92

3€ -C

Copying a First utton

,. Choose Copy Button fro m the Edit menu.
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Now that you have copied t his button, you need to go back to the Class
Notes stack and place it on the background. The easiest way to get t h ere
is to choose the Recent comman d from the Go menu. This sh ows you
a series (up to 42) of miniature pictures of the cards you have recently
visited .
Your list of recent cards depen ds on which stacks yo u have opened since
starting HyperCa rd and the manner in w h ich you chose to navigate
through those stacks. Figure 12-93 shows a sample list of recent cards.
It con ta ins the cards you have seen if you fo llowed these d irections
carefully a nd a few others to sim ulate the condition of other cards
possibly being presen t if you took a differe nt rou te.
The two important cards sh own here a re the small p icture of t h e Class
Notes stack and the one th at represents th e current card of the Button
Ideas stack (whi ch is outlined and is posi tioned on t h e right side of the
list of card s) .
To go to a recen tly visited card, click on its p icture.
•

Click on t h e p icture of th e Class Notes stack, as shown in
Figure 12-93 .

.,

Figure 12-93

A list of recently visited cards

You are immediately returned to th e card you chose. If you happened
to click on the w rong one, you can choose Recent again and click o n the
proper card .
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You will find this a very conveniJent way to move around in HyperCard.
Since some of the statks you will use will hide the menu bar, you might
want to remember that Command-R is the keyboard equivalent for
choosing Recent from the Go menu.
Now that you have copied the button you need and h ave returned to the
Class Notes stack, you can paste the button onto the background layer.
(Make sure you are on the background layer before doing the next step.)
38 -V

.. Choose Paste Button from the Edit menu.
This command places the button on this stack's background layer in the
same position it occupied in Button Ideas. Moving the button to where
you want it is a simple process.
Move the pointer to approximately the center of the button before
dragging it. If you are too close to one of the four corners, you tell
HyperCard to resize the button, and that is not what you want to do
now.
If you do resize the button, before doing anything else choose Undo
from the Edit menu to return it to its proper size.

.. Drag the button to the position indicated in Figure 12-94.
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Figure 12-94

lI e

The First button pasted into your stack

Now you can copy and paste the other three buttons from that same
card in the Button Ideas stack.
~

-R 38 -C 38 - v

•

Using what you have learned here, use the Recent command and
copy and paste the buttons you need. Drag them to their proper
positions (see Figure 12-95).
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Go back to the Button Ideas stack and copy a Home button. Return
to the Class Notes st ack and paste it and drag it to the position
shown in Figure 12-96.
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Figure 12-96 The Class Notes stack with all fields and buttons in place

Notice (see Figure 12-96) that two new buttons are at the bottom of the
computer paper. These two buttons have been scripted to sort the class
notes into ch ronological order, class order, or both and to print custo m
reports based on a range of dates or a part icular topic.
The Sort button contains a script that is not very com plex, but the script
of the Print Report button is fairly lo ng and complex. To save you from
having to enter these scripts, we have placed the two buttons (and their
scripts) into a stack named Class Notes Buttons o n the Macintosh Journey
Projects disk (see Figure 12-97).
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Figure 12-97

The Class Notes Buttons stack

If you have a copy of this disk, you can add the two buttons to your Class
Notes stack by copying and pasting.
If you do not have a copy of the disk, you can use the scripts th at are
printed on the last pages of this chapter. Typing t hem in requires that
you change to the Scripting use~ level, create two new butto ns, click on
the Script butto n in the Butto n Info dialog box, and enter the script.

Be aware that scri pting requires absolute accuracy in your typing; you
must enter the scripts exactly as shown for them to work properly. If you
do not have the Projects disk, you m ay skip adding these two buttons to
the stack and continue with the rest of the project. Then when you reach
an instruction that tells you to do something with one of these buttons
you can skip that step.
3€ -C 3€ -V

•

Copy a button from the Class Notes Buttons stack and paste it into
t he background of the Class Notes stack. Repeat this process for the
other button .

There is o ne o ther thing you might want to do to customize the stack
to reflect personal preference for going from one card to the next.
Learn ing to script in HyperTalk usually involves learning something
now, then a little more later, and before you know it you are scripting.
One of the easiest things you can do is add a visual effect to a button that
changes from o ne card to another (or one stack to an other).
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INCLUDING VISUAL EFFECTS
A number of visual effects are available in HyperCard, and they can be
combined with others for more complex transitions. You can also tell
HyperCard to perform the visual effect very slowly, slowly, fast, or
very fast.
Since explaining visual effects in print is difficult to do, we created a
Visual Effects stack that contains 20 pre-scripted visual effects samples.
Figure 12-98 shows the first card of this stack and the 20 buttons on it.

Figure 12-98

The first card of th e Visual Effects stack

Visual effects include Wipe, Iris, Venetian Blinds, Checkerboard, Dissolve,
Barn Door, Scroll, Zoom, and Plain (which is the same as not using a
visual effect).
There are two cards in this stack. The first one does all th e work, and the
second one (see Figure 12-99) is there for contrast so the effects are easily
visible.
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Figure 12-99

The second card of the Visu al Effects stack

All of these effects are similar. Th e script for the Dissolve button, fo r
example, tells Hype rCard to use the dissolve effect at a slow sp eed, go to
the next card, wait 30 ticks (this is a half-second-there are 60 ticks per
second), use the same visual effect, and go to the next ca rd (see Figure
12-100). Since there are on ly two cards, this returns you to the first card.
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Figure 12-100

The script for the Dissolve butto n

If you do n o t have access to the Visu al Effects stack, you could crea te one
for yourself by entering this script into a button and then experi men t
by ch a nging the effects used .
If you d o have access to the Visua l Effect s stack, you can open that stack
now and look at the effects available in HyperCa rd. Pick o ne that you
like and that you want your Class Notes stack to use, and then you can
modify the Previou s and Next button s to use the effect of your ch o ice.
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3€- R

•

Ch oose Open Stack from the File menu. Locate the Visual Effects
stack and the n click Open .

•

Spend as long as you want experimenting with the effects, then use
Recent from the Go menu to return to the Class Notes stack.

Remembe r which effect you liked the most, and you can use it to modify
any of th e arrow buttons you wish.
To do this, you must choose the Scripting user level. Instead of going
back home, you can issue the command directly to HyperCard using the
Message box.

3€ - M

•

Type Command-M to open the Message box, then type set userlevel
to 5 and press the Return key. (Do not enter a space in userlevel, it
shou ld be one word for this command.)

Th is sets the user level to Scripting (Browsin g = 1, Typing = 2,
Painting= 3, Authoring= 4, and Scripting= 5).
Be sure the button tool is currently selected before doing the following
steps.
•

Hold down the Command and Option keys, and click on the
Previo us (left arrow) button.

The scripting dialog box for the left arrow button appears, and should
contain this script:
on mouseUp
go to previous card
end mouseUp
This te lls HyperCard to go to the previous card when you release the
mo use button if the pointer is on the left arrow button.
If you decide you like the Scroll Right visual effect, you can change this
script to the fo llowing:
o n mouseUp
visual effect scroll right
go to previous card
e nd mouseUp
This tells HyperCard to use the effect rather than just jumping to the
card. It will look like the previous card comes in from the left of the
screen and overlays the current card.
•

When you have entered the effects you like, click OK to close the
d ialog box.

If you like, you can add visual effects to a ny of the arrow buttons or the
Home button.
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ADDING A FIND BUTTON
Now you will add a button to make finding informatio n in your notes
easier.
3€: -C

•

Go to the Button Ideas stack and copy the Find button (see
Figure 12-101).
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Copy the Find button from here.

Figure 12-101
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Use the Recent command to return to the Class Notes stack, and
paste the Find button on the background.

•

Use the button tool to drag the buttons to their final locations, as
shown in Figure 12-102 (or wherever you would prefer them).
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If you go to an y cards and an y of the buttons or fields disappear, go back
and use the appropria te tool to cut the object from the card layer a nd
paste it onto the background layer.

ENTERING DATA
A list of 11 notes for 4 classes follows. You will en ter all t his information
into the stack. Th e dates are chosen at random within a n arrow ra nge.
It does n 't matte r in which order you enter th ese notes; the Sort
comman d will put them in this order if you sort using the Both o ption .
You can enter the notes fo r ca rd one on the card that is a lready showing
in t he stack. To enter a ny oth er n otes, first choose New Card from the
Edit m enu, and then enter th e in form ation into t he appropriate fields.
Be carefu l typi ng the info rmation in t he Date and Class field s. The
information in t he other fields is to show how the stack works, an d the
content is representational only.
To begin e nte ri ng the in formation, click in the Date fi eld to put the text
insertion poin t there (or p ress th e Tab key to select the first field). Then,
after typing the info rmation for this field, you can select t he next field
by t ypin g the Tab key o r cl icking in the n ext field .
,.

Enter t he inform a tion for th e first card (as sh own in Figure 12-1 03).
Refer to t h e information below th e figure for t he actual contents.
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Date:

3/31/91

Class:

Music Appreciation

Assignments:

Read Introduction and Theory sections, Pages 1-87
Watch "From Antiquity to the Renaissance" video
Exam in two weeks

Notes:

Timbre is synonymous with tone color.
Degrees of loudness and softness in music are called
dynamics.
The relative highness or lowness of a sound is called
pitch.
The distance between lowest and highest tones of an
instrument is pitch range.
Pianissimo: soft, forte: loud, fortissimo: very loud.
The pitch of a sound is determined by the frequency
of its vibrations.
The distance in pitch between any two tones is called
an interval.
The frequency of vibrations is measured in cycles per
second (Hertz).
A dynamic accent occurs when a performer plays a
tone louder than the others surrounding it.

:3€ -r

•

Choose New Card fro m the Edit menu. Enter the in formation for
card two. Continue this process un til you have entered the
information for all 11 cards.

Card Two:
Date:

4/ 3/91

Class:

Music Appreciation

Notes:

The lowest instrument in an orchestra is the
contrabassoon.
A part of an instrument's total range is called a
register.
The highest instrument in the o rchestra is the piccolo.
Vibrato (rocking the left hand to produce small
fluctuations) is used by string players to make the
tone warmer and more expressive.
Plucking a string with a finger instead of using a bow
is called pizzicato.
Symphonic bands differ from symphonic orchestras
by not having a string section.
Woodwind instruments are so named because they
were originally made of wood.
The range of a singer's voice depends on both physical
makeup and training.
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Card Three:
Date:

4/5/ 91

Class:

Music Appreciation

Notes:

accent - stress or emphasis on a note.
beat- regular, recurrent pulsations that divide music
into equal periods of time.
downbeat - first, or stressed, beat of a measure.
measure- unit or group containing a fixed number of
beats.
meter - organization of beats into regular groupings
metronome - apparatus that produces sounds or
light flashes at a desired speed.
rhythm - particular arrangement of note lengths in
a piece of music.
syncopation - putting an accent in music where it is
not normally expected.
tempo - rate of speed of the beat of music.
upbeat- unaccented pulse preceding the downbeat.

00 -N

Card Four:
Date:

3/31/91

Class:

Oral Communications

Assignments:

Read chap. 25 - Informative Speaking
Informative speech next week - 5 to 7 minutes

Notes:

Informative speech - Select subject: What are you
interested in? Choose something you already know.
Inform: Create understanding; support materials and
info should only clarify.
Audience: What do they need to know? Select a
narrow purpose (more manageable).
Formulate bare bones first:
• Main idea: points you want to cover
• Supporting points
• Fill out body of speech with variety of support
(summaries, statistics, quotations)
• Determine overall pattern (precise order) of speech
• Intro (usually best to create this after you have
decided what you will say)
• Conclusion: tell them what you told them
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Card Five:
Da~:

4/3/91

Class:

Oral Communications

Assignments:

Persuasive speech nex t week
5 minutes or less!!!!!

Notes:

Persuasive speech
Intro: needs an attention getter, should state main
idea, what you want them to do
Points: should answer question, "Why sho uld I do
this? "
Conclusion: reiterate, sum up, last chance t o
influence, close neatly

W -N

Card Six:
Date:

4/ 5/ 91

Class:

Oral Communications

Assignments: Prepare that persuasive speech!!
Notes:

3 types of persuasive speeches:
1) logos - reason - logical argument
2) pathos - appeal to emotio n
3) ethos - how audience sees the speaker; deals with
character, how you present yoursel( credibility

W -N

Card Seven:
Date:

3/29/91

Class:

Sociology 11

Assignments:

Read chapter 10- Mass Communications
First t est will cover chapters 10-14

Notes:

Break into groups for discussions. Discuss the
following issues:
Life before people had TV
1) How are fa mily holidays different with TV?
2) How was radio different before TV?
3) Has TV taken something away from family life?
4) Give examples of 3 ads o n TV that present instant
solutions to problems.
5) Saturday morning TV - w hat products are pitched
to children? How do children respond to those ads?
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Card Eight:
Date:

4/6/ 91

Class:

Sociology II

otes:

TV is an addiction for many people - average is 4.5
hours per day per p erson.
Parents spend average of 5 minutes per day really
talking to children.
"Television violence does have an adverse effect on
those children predisposed to violence, and no one
knows how many children are predisposed to
violence." -U.S. Surgeon General
300-500 violent acts per week on network TV. Most
people witness over 11,000 "deaths" (on TV) by the
time they are 15 years old.

8€ -N

Ca rd Nine:
Date:

4/ 8/91

Class:

Sociology 11

Notes:

Political leaders have been elected by TV since 1960
(since debates between Kennedy and Nixon).
Hundreds of millions of dollars spent on this.
News is a network person's VIEW of the news. Even
if there is no intent to slant the news, the fact that
some events are reported and some aren't has a
biasing effect. Bad n ews and disasters generally make
the n ews. Good news is aired mostly on "slow news
days."
Newspapers can also slant news - yellow journalism,
banner headlines.

8€ -N

Card Ten:
Date:

3/30/91

Class:

Technical Writing

Assignments:

Read chapters 1-4 by next week
Page 39- do "audience analysis" exercise
Page 48- do "What's wrong with technical writing?"
exercise
Write paragraph to explain the part writing plays in
your job
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Notes:

Technical writmg - practical writing people do as
part of their jobs
What sets technical writing apart? - It's about
technical stuff! Usually uses different (technical)
vocabulary. Uses sequential thought process. Uses
facts, more to the point, meaning must be clear and
concise (only one meaning). Uses clear, concise
writing to convey one meaning (no ambiguity- only
one interpretation possible).

W- N

Card Eleven:
Date:

4/2/91

Class:

Technical Writing

Assignments: Write a paragraph about what type of job I want and
the type of writing I will have to do in that job.
Notes:

communicatior - exchange, dialog
medium - means by which message is conveyed
document - (text) - generic term for written object
generate -to produce (broader process than writing)
Characteristics of technical communication:
1) specific audience - only those interested in your
subject
2) objective la? guage - inform with facts
3) clear organization - 3 part form (intro, body,
conclusion)
4) visual aids - must be integral part of text

You can now check to see if you have a total of 11 cards in this stack.
•

Ch oose Stack Info from the Objects menu. It should say there are
11 cards in the stack.

If you decide to use this stack for keeping track of notes, you can create
a new stack and copy the background so all the buttons and fields are
in place. Then all you have to do is enter specific information.

SORTING
HyperCard has the ability to change the o rder of cards in a stack. This
is most easily accomplished bylcreating a Sort command so HyperCard
will rearrange cards automatic lly in the order you want.
In this stack there are three ways to sort the cards (if you copied the Sort
command from the Class Notes Buttons stack).

'
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Wh en you click on the Sort button you see a dialog box that lets you
ch oose to sort the stack by Date, Class, or Both.
Date sorts chrono logica lly by the con tents of the Date field. Be su re to
enter information consistently in the Date fiel d in the form "mm/dd/
yy", without entering leading zeros. For example, the entry fo r july 1,
1995, would be 7/1/95. It is important that you are consistent and
accurate in en tering the information in this field if you want the sort to
work properly.
Class sorts alphabetically by the contents of the Class field. Aga in, you
need to be consistent when entering the contents of this field. If you
were taking Music Appreciation and it had a class number of MUS 101,
you would need to use one o r the other identifier, but not switch
between them for different entries. If you use both nam es, the Sort script
w ill sort the entries into different classes.
Both sorts first by date a nd then again by class. This leaves all of the
en tries for a class sorted in chronological order, and the classes are sorted
alphabetically. All your Music Appreciation class notes will appear
before the Oral Comm unications class n otes, and inside each class the
notes will be sorted by date.

PRINTING REPORTS
HyperCard h as some nice reporting capabilities, as you saw in the
previo us project, but it does not allow you to print a portion o f a stack.
You can print a single card, the entire stack, or all of the cards on a
background.
The Print Report button includes a script that allows you to print a report
based o n a range of dates o r a particular topic. When you enter the
starting and ending date, or the topic, the script searches for all cards
that match the conditions you specified and prints the enti re contents
of each card to a text file .
It then asks if you want to open the file with a word processor. If you

want to do thi s, it gives you a choice of Mac Write, Other, o r Microsoft
Word. They a re listed in this o rder so Microsoft Word will be the default.
If you choose Other, you are given the opportunity to type in the name
of your word processing application. (If you make use of this stack, you
can edit the script so it defau lts to the word processor of your choice.)
If the ch osen word processing application is not already open, the script
open s the applicatio n and loads the report fil e. You can then use the
word processor to format and print the report. When you quit the word
processor, you are returned to the Class Notes stack.

A useful way to list all your class notes is to sort them using the
Both option and then use the Print Report command from the File
menu. Make the report a row report and select all four fields. This
prints a readable copy of all your class n otes sorted chronologically
within each class.
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SUMMARY
• There must be a Home stack for HyperCard to function correctly. The Home stack is used to
open other stacks and applications from HyperCard. There are several buttons on the Home
card that represent other stacks. Opening another stack simply requires clicking on its button;
you do not double-click as you would from the desktop. The user level may be set from the
Home stack.
• There are five user levels: Browsing, Typing, Painting, Authoring, and Scripting. Of these
levels, Scripting gives the most access to HyperCard's features and Browsing restricts you to
looking at a stack.
• HyperCard automatically saves all changes you make to a stack.
• HyperCard's Go menu allows you to navigate through o ne or more stacks. The Recent
command shows the last 42 cards that were visited and allows you to return to one by clicking
on its reduced-size picture.
• Three general tools are available for your use: browse, button, and field. The browse tool is
used to activate buttons and select fields for entering o r editing data. The button tool is used
to create, position, resize, and edit buttons. The field tool is used to create, position, resize,
edit, and choose the text attributes for a field.
• Buttons can contain scripts that act like small computer programs. Buttons can also be linked
to specific cards or stacks.
• HyperCard has a full set of Painting tools for producing bitmapped pictures. These pictures
may be copied and pasted into almost every other Macintosh application.
• There are two layers in every stack: background and card. Background objects are available
on every card that shares a background. Card objects are available only on the specific card
that contains them.
• HyperCard comes with a Help stack that provides extensive online help.
• Several idea stacks that are included with HyperCard contain resources for creating stacks,
cards, buttons, fields, and pictures.
• HyperCard's Find command locates any text in a stack within a few seconds at most. You can
decide to search all text or just the text in a specific field. You can choose to find any group
of characters that match what you type, or you can restrict HyperCard to finding only words
that match the words you enterect.
• HyperCard can print reports that are formatted for labels, rows, or columns.

KEY TERMS
Address stack
Authoring level
background button
background layer
browse tool

Browsing level
bru h tool
bucket tool
button
putton tool
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Cale ndar stack
card
card button
card layer
curve tool

paint text tool
Painting level
Painting tools
palette
pencil tool
Phone stack
polygon tool

dynam ic link
eraser tool

rectangle tool
regular polygon tool
rounded rectangle tool

Fat Bits
field
field tool

scripting
Scripting level
selection tool
spray tool
stack

General tools
Home button
Home card
Home stack
HyperTalk

tear-off menu
Tell Me ... button
text field
Typin g level

lasso
line tool
link

user level

Message box

visu al effect

oval tool

HYPERCARD COMMAND KEYS AND SHORTCUTS
File Menu
Open
Print Card
Quit HyperCard
Edit Menu
Undo
Cut
Copy
Paste
New Card
Text Style
Background
Pa int Menu
Select
Select All
Keep

~-0
~

-P

~-Q

~

-Z

~-X
~-C
~-V

~-N

Go Menu
Back
Home
Help
Recent
First
Prev(ious)
Next
Last
Find
Message

~

--

~ -H

~
~
~
~

~
~

-?
-R
-1
-2
-3
-4

~ -F
~ -M

~-T
~

~

-B
-S

~-A
~

-K

Objects Menu
Bring Closer
Send Farther

~

-+

~

--
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ADDITIONAL PROJECTS
The following project is accompanied by briefer instructions than those
you have previously completed in this chapter. If necessary, refer to the
previous projects in this chapter for information and step-by-step
instructions for any command that you don't rem ember how to use.
Also, HyperCard's Help file contains valuable and easily accessed
information.

Project 4: Creating a Dynamic Company Organization Chart
In this project, you will create an organization chart similar to the
second project in the MacDraw chapter. Although the charts look
almost alike, there is a big difference in what th ey do. The chart in
MacDraw is static. You create it, print it, and there it sits.
The ch art you will create in this project is a dynamic chart. When you
click on one of the people represented on the chart, HyperCard takes
you to another card that shows more information on that person. You
then can return to the chart to obtain information on someone else.
Let's get started.
-

Change the user level to Scripting.

•

Choose New Stack. Name the stack Company Organization and
store it on your data disk (see Figure 12-104).
Edit

Go Tools

I[g) Morsho Szczeponslcl ... I

~
lntr-o

~
Phone

~

Art ldus

D D & K I. O!JO Dl"<lllling

ri (

New stoclc nome:

ICompony Orgonl zotlon

Plots

'

(

I

I
D Copy current boclcgrou ~d

li1EI

~

~ [g) Morsho Sz ...

D II & K I.O!JO P<Jin lin!J I
D CI<I~S Nllh~s I1111t on~
D COli~) of CII H OmNs
:;:
D CO li~) of lrlli<H110I"!J
:•:
D CO II~J Of '>nh~s lrn•oi .. ,

1.2 .5

~

Rtl+~n

Figure 12-104

Nott s

Eject
Drlue

)
J

Boolc Sholf

LB§Oi;:J
[ Concel )
Quot~tions

5:36PM

Creating the n ew Company Organization stack
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•

Using the Painting tools, create the organization chart as shown in
Figure 12-105. The fonts are Geneva 9-point and 12-point, plain text
and bold .

Figure 12-105

•

' '*

Painting the organization chart

Center tne chart on the screen using the selection tool (see
Figure 12-106).
File

Edit

Go Tools

Point

Options Patterns

r------------------------------------------Acme Toys Incorporated
Menufecturer s of Fine Toys

Figure 12-106

•
•

Center the chart on the screen

Choose Bkgnd Info from the Objects menu .
Name this background
Figure 12-107).

Ch~ rt,

and set it so it can't be deleted (see
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•

'

File

Edit

'

Go Tools

I

Background Name: Char~

I

Background I D: 2739
Background sh11red by I cards.
Contains I background fiel ds.
Contllins 2 bllckground buttons.

181 Can•t

del ete background.

f(

[ script ..• )

I

II

M>ll>90r

OK

) ( Cancel )

I I

oc:>
Figure 12-107

Naming and protecting the background

Creating Directory Background
Now that you have completed the organization chart, it is time to create
a directory listing for each of the people on the chart.
Let's use the same background painting for the chart and the directory.
:#.: - B

..

Change to the background layer.

The chart disappears when you f hange to the background layer, but the
picture of a stack of paper is still there.

W-C

W-V

,.

Double-click on the selecti0n tool to select the entire background.

•

Copy the background.

•

Choose New Background from the Objects menu.

•

Make sure you are in the
background picture.

•

Choose the field tool, and add the background fields and text for the
directory (see Figure 12-108).

~ackground layer, and then paste the

The choices of fonts, sizes, and styles are up to you.
•

After you create the fields, double-click on each one (with the field
tool) and give it a name, such as Title, Name, Address, and so on.

•

Name this background Directory.

•

Select the browse tool.

•

Enter the information for

e president (see Figure 12-108).
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,.. .J File Edit Go Tools

Titl•

..P..r.~.S..J.Q~.O.t

Nam•

..J..~.m~.§. ...'W..,... ~.t~J..~.~.O..................................................................

Hom• Addnss

..!..1J..~..~~.l.~:'!f.!.Q.E.9.~.~---··................- ..........................................................
..!?.~!l.19.0~.Q~.•.!;llL~§I?.?.I?........._..................................................................

•

.........................................................................................................

Offic•
Ext•nsion

...!..?..?..?.............................-.........................

Offic• Numb• r

.. J..?..Q.J.!........................-....................-....

Figure 12-108
3g- N

..,

cts

The Directory background and president's in fo

Create a new card, and enter the information for the vice-president
of sales (see Figure 12-109).
..,

,.. .J File Edit Go Tools 0 ects

Titl•

..V.J~.~.:::.P..r.~.S.J..Q~.O.t

Nam•

_t;;._~.[QJ_.G.~.r.:.ro..~............-........._...................._.,_..__,___..___

Hom• Addr• ss

Hom• Phon•

Offic•
Ext•nsion
Offic• Numb•r

Figure 12 -109
3g - N

•

.....S..~J.~~.........................................................

..!1.~.?1..~rn!.l.h~.9.!l...~.Y..'-D.Y~....- ........- ...................--.................-.........
..tl~r.i!.t!.~~..!l.~-~.~~.!!.7.......- ..........._ .._._________________........
..(1.!1.11.~~-~:.!1.7..!!.;1.............................._

.J..9.JA........-.......-.....- ........._.............
..J..9...Q} ........................................................

Entering info rmatio n for the V.P. of sales

Create a new card for each of the other five people on the chart, an d
make up the information you en ter for each of them.

You should now have a background named Chart with one card and a
background named Directory with seven cards.
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Linking Cards
You created the card with the chart and each person's name. Then you
created a separate card in the Directory background for each person on
the chart. Now you need to add some buttons to allow navigation
around the stack.
•

Copy a Home button from another stack and paste it onto the
bottom right corner of the card containing the organization chart
(see Figure 12-110).

,. a

File

Edit

Go

.,

cts

Tools

Toys lncorporoted
( Acme
M6nuf6c turers of F1ne Toys
James Y . Nielsen
Pr esident

Carol Garmo
\lico-Prosidont,
Salts

Jtffrty Hal•
l'icr ·Prosidont,
Manufactur ing

Richard P. Cluvts
l'ico-Prosidont,
Finane•

I

I

I

Clyde C. Rigglo
Salts Managor

Alaway no Parks

Robtrt P . Nimon
Controlltr

Ma~ufacturing

anager

Figure 12-110

Adding a Home button to quit the stack

This button is for going back to the Home stack when you are ready to
leave this stack.
Now you will add a transparent button on top of each name in the
organization chart. Each of these buttons will be linked to the appropriate
card in the Directory background.
•

Select the button tool. Position the pointer just outside the top-left
corner of the president's box.

,,.

Press the Command key, and drag a rectangle for a new button that
surrounds the president's box.

This is a shortcut method for
•

cr~ating a new button.

Double-click this new button, make it transparent, and deselect the
option for showing its namt

Your screen should look like th l one in Figure 12-111.
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r

•

File

Edit

Go

Tools

l

0

.,

ts

Ac m e Toys lncor poroted
Menufecturers of Fine Toys
.... ·-.. ..............--·~·-

J

~

J ames Y. Nielsen
President

............. ·············+
Carol

Oarm~

Vic~-Pr~sid~nt ,

Sal~s

_j_

Clyde C.

J~ffr~y Hal~

Vice-President ,
Manufacturing

Richard P. Cl~av~s
Vlce-Pres ident,
Finane~

_j_
Riggl~

Sal~s Manag~r

Alawayno Parks
Manufacturing

_j_
Rob~rt

P . Nim~n

Controll~r

Manag~r

Figure 12-111

Adding a new button on top of the president's box

You are ready to tell HyperCard to link this button to the president's card
in the Directory background.
,..

Double-click the new button and, when its information dialog box
appears, click LinkTo.

A new mini window appears floating above the card. Most of you are
probably unfamiliar with the term mini window. HyperCard introduced
a new type of floating window that could be moved and closed, but not
resized. Its main characteristic that distinguishes it from a window is
that it floats in front of all other windows and has a gray pattern in the
title bar rather than horizontal lines. The Message box, LinkTo box, and
Tools and Patterns palettes are all mini windows. They are the exception
to the rule that all action takes place in the front window. When one or
more mini windows are present, all actions will still take place in the
active window with the exception of activity directly in the mini
window. This way you can use the palette to choose a different tool or
pattern, and draw in the active window without forcing any mini
windows to go behind the active window. Mini windows are also known
as floating windows.
This mini window allows you to link the button you just double-clicked
with a specific card in a stack or with the first card of a stack. The stack
can be the current one or any other stack.
You want to link to the president's information card.
•

Use the arrow keys on the keyboard, the Go menu, or the Commandkey equivalents to go to the next card. When the president's card
is showing under the linking mini window (see Figure 12-112), click
This Card.
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The link is now completed.
,..

-'

File

Edit

Go

Tools

Titl•

Ob

.,

cts

J:>.r.:~.~Jq~nt. . . . ..-····--··············-··-·······--···-· ·-······-····· ·······-·······--··

g0 !i!iiiiiiiiiii!i!ii#iii!iiiiiiiiiii"iiii!iiiiiiiiiiiiii;iiiii!Hiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii!iiiiiiii!iiiiiiiiiiiiiiiiiiii

Go to destination, then aim linlc at:
[ This Card~ [ This Stack J [ Cancel

Offici!
Ext•nsion

...1.?..'?,.?.____·····-··-·······-··········---·····-·-·

Offici! Numb•r

... J..?..QJ_...........-·························-···········-

Figure 12-112

Linking a button to this card

Unfortunately, you have not provided a way to get back to the chart card
without using the keyboard, the Go menu, or Command-keyequivalents.
Let's add a button to the Directory background that links to the chart
card.
,,.. In the lower left corner of the Directory background picture, draw
a small picture of the chart. y se Fat Bits to make this easier if you like
(see Figure 12-113).
' · ·• ·'rile' · iti1i · ·6o · roo is· · i>ain't' · opiions •·P'81tei-ri5 · · · · · · · · · · · · · · · · · · ...

1•••n••n••1
I

••.............I••
••
...........................
•
•
•
.•• .•• .•• .•• • .••
I • • • • • • •
•
•
•

.........
........
.........
I.........

I
I,

Figure 12-113

.........
.........
.........
.........
I
I

I
I

.........
.......
...........

......--;

I
I

I
I

Drawing a small picture of the organization chart
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•

When the picture is as you want it, create a transparent button over
it, and then link the button to the card containing the organization
chart (see Figure 12-114).

Hom• Phon•

Officl'

Extl'nsion
Officl' Numbl'r

Figure 12-114

•

Creating a button to link to the chart card

Return to the chart card, and create a button on top of each box in
the chart. Link each butto n to the appropriate card.

When you have completed this, you will be able to click on any name
in the chart, and HyperCard will show you information about that
person. Then, by clicking on the button at the bottom left corner of the
information card, you can return to the chart. When you are fin ished,
you can click the Home button to close the stack (but don't do that yet).

Printing Directory Report
You have seven ca rds in the Directory background, and each of them
contains information about one of the people in the organization chart.
This provides a convenient way to print a corporate directory (at least
for seven employees).
•

Go to one of the information cards in the Di rectory background.
Choose Print Report from the File menu, and select the options
shown in Figure 12-11 5.
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Edit

Go Tools

Print report... Copies:EJ
0 Manual paper feed
0 Darker printing

r·--····.

r -···-··-·····------------ ---- -- ----~

!·-·---~--·-·--·---··-----···--!

!r·----r-···
I ---------------------.. -·1i

-·r--·····---..--------·~----~

~--M--..

r--------~-----------------------------------1
~----.· -: ·-------·------------ ·--· ·····--i

l::==t=-! ~~:~~~:=.=~::=::_~j!

i

i.----~-·------------~----··-------------1

lab !liS
O Columns •
@ Rows·
-

1•

-

IJ

OK

I

( Cancel

CiJ[I) II:lrn
[ffiJ

rnm

Print t'\Ht fields from oil cards:
0 In the entire stack
® WitH the current background
Which f,ields:
0 Card fields
18] Selected background fields:
Title
:!':
Name
•
Addre~s
Home Phone
:i2

II

Print the names of:

0

Figure 12-115

H

fields in:

0

C a ~ds

18] Fields

Selecting options for printing the directory

By telling HyperCard to print text fields from all cards with the current
background, you restrict the prih ting to the background you were in
when you chose the command. This is handy for printing information
in a stack with multiple backgrounds when you wantonly the information
in a particular background.
~

When you have made all the selections, click OK.

This creates a two-column report with information about the seven
people on the chart.
If you like, you can also tell HyperCard to print all of the cards.

There are a number of ways this stack can be enhanced without too
much additional work. It would be easy to copy the Phone button from
another stack and paste into th~s one to automatically dial a person's
number. With a little more effort, you could add a map of the company's
headquarters and show where theI person's office is. A photograph of the
person could be scanned into the system and stored with his or her
directory card.
If you want to try any of these ei)hancements, go right ahead. You will
find that HyperCard's abilities expand more and more as you learn to
make use of them.

SCRIPTS FOR CLASS NOTES BUT ONS STACK
The following scripts may be en ered if you do not have the Macintosh
Journey Projects disk. Be careful t~ping in the scripts. The character "--{'
represents a continued line of HyperTalk code and is entered by holding
the Option key down while youl press the Return key.
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SORT BUTTON SCRIPT
on mouseUp
answer " Sort by what? " with " Date " or "Class " or " Both "
if it is " Date " then
Sort datetime by bg field " Date "
else if it is " Class " then
Sort by bg field " Class "
else
Sort datetime by bg field " Date "
Sort by bg field " Class "
end if
end mouseUp

PRINT REPORT BUTTON SCRIPT
© 1990 by John L . Dilbeck , COP
All rights reserved worldwide
on mouseUp
set cursor to 4
put the number of cards into cardcount
put space & return into ret
get the l ong name of stack
delele first word of it
delete first char of it
delete last char of it
repeat while (last char of it<> '' : " ) and (length(it) > 0)
delete last char of it
end repeat
put it into reportfilename
ask " What do you wish to name the report? " with " Enter Name Here "
repeat while it is " Enter Name Here "
beep (l)
put " You must enter a file name "
ask " What do you wish to name the report? " with " Enter Name Here "
end repeat
put it after reportfilename
answer " Do you want to produce a report based on " wi t h --,
" Cancel " or "Dates " or " Top ics "
if it is " Cancel " then
exit mous eUp
end if
Open file reportfilename
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if it is " Dates " then
-- produce a report based between two dates
ask " What is the beginning date " with " mm/dd/yy "
repeat while i t is " mm/dd/yy "
beep (1)
put " You must enter a beginning date "
ask " What is the beginning date " wi t h " mm/dd/ y y "
hide message
end repeat
put it into StartDate
convert StartDate to short date
put it into startfinddate
convert startfinddate to short date
ask " What is the ending date " with "mm/dd/ yy "
repeat while i t is " mm/dd/yy "
beep(l)
put " You must enter an ending date ~
ask " What is the ending date " with " mm/dd/ yy "
hide message
end repeat
put it into EndDate
convert EndDate to Short date
write " Class Notes Report between " & quo t e & ---,
StartDate & quote & " and " & quote & EndD a t e & q uot e ---,
& return & the long date & tab & the time & ---,
return & return to file reportfilename
Sort by bg field " Class "
Sort datetime by bg field " Date "
go to card 1 of this background
put fld " Date " into testdate
repeat until testdate >= StartDate
put " Searching ... "
go to next card
put field " Date " i nto t estdate
end repeat
hide msg
repeat while testdate >= StartDate a nd test dat e <= EndDate
write " Date :" & tab & field " Date " & return & ---,
" Class :" & tab & field " Class " & r eturn & ret u rn & ---,
" *** Assignments ***
" & field "Assignment s " & ---,
return & return & -.
" *** Notes ****
" & field " Notes ~ & retu r n & return & ---,
"- --- --- - - -------------- - --" & return & r e tu r n ---,
to file reportfilename

I

if the number of this card
exit repeat
end if

cardcount the n
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go to next card
put field " Date " into testdate
end repeat
else
produce a report based on all cards containing a certain topic
ask "What is the search topic? " with " Enter topic here "
repeat while it is " Enter topic here"
beep (1)
put "You must enter a search topic "
ask " What is the search topic? " wi th "Enter topic here"
hide message
end repeat
put it into searchcriteria
write " Class Notes Report concerning " & quote &
searchcriteria & quote & return & ~
the long date & tab & the time & return & return
to file reportfilename

~
~

go to card 1 of this background
find searchcriteria
if the result is " not found " then
beep (1)
put " That topic is not found"
wait 180
hide msg
close file reportfilename
exit mouseUp
else
put the id of this card into startedhere
put false into foundtwice
end if
repeat until (the id of this card
startedhere) and ~
foundtwice is true
put true into foundtw i ce
write "Date:" & tab & field "Date" & return & ~
" Class :" & tab & field "Class" & return & return & ~
"*** Assignments ***
" & field "Assignments" & ~
return & return & ~
" *** Notes ****
" & field "Notes" & return & return &
"------------------ - -------" & return & r eturn ~
to file reportfilename
go to next card
find searchcriteria
end repeat
end if

~
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Close file reportfilename
put " The file has been saved ."
wait 60
hide message
answer " Do you want to open the file?" with " No " or " Yes "
if it is " Yes " then
answer " Which Word Processor? " with "MacWrite " or "Other " ...,
or "MS Word"
if it is "MS Word " t hen
open reportfi l e n ame with "Microsoft Word "
else
if it is "MacWrite " then
open reportf i lena me with " MacWrite "
else
ask "What is the name of your Wo rd Processor " with ...,
" Enter Name "
if it is " Enter Name " then
beep(l)
else
open reportfilename with it
end if
end if
end if
end if
end mouseUp
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1-up labels Labels, usually mailing labels, that
are one form wide.
3-up labels Labels, usually mailing labels, that
have three forms side-by-side on each row.
absolute addressing A method of addressing a
cell or a range of cells in a spreadsheet.
Absolute addressing does not change if a
formula o r cell reference is moved, copied or
pasted. (See also relative addressing)
active cell The cell in a spreadsheet that is
marked by a heavy border. Anything typed
o n th e keyboard is entered into the
active cell .
active record indicator A small, black vertical
line that appears to the left of the current
record in FileMaker's Browse mode when
records are viewed as a list.
active window The window that is on top of all
the other windows; the window in which you
may work. The title bar and scroll bars are
highlighted . All other windows are inactive
and their title bars and scroll bars are white.

analytical graphics Charts and graphics useful
for analyzing a numeric problem. These
g raphics a re often produced using a
spreadsheet program. (See also presentation
graphics)
Apple menu The menu located on the far left of
the menu bar at the top of the screen. Instead
of the word Apple" it has the symbol of an
apple. (See also menu, menu bar)
11

application program There are two basic types
of programs: app lication and system
programs. An application program is designed
and programmed to accomplish a particular
task. For instance, Microsoft Word is a word
processing application program. Most of the
programs advertised for sale are application
programs. (See also software, systems program)
application software A term that applies to
application programs as a group. (See also
application program)
arc tool A tool in a drawing program used to draw
an arc or part of a ci rcle.

actual size A representation that approximates
how the output will look when printed. (See
also actual size window)

area chart A chart, similar to a line chart, that
emphasizes the amount of change over a
period of t ime.

actual size window When viewing a MacPaint
drawing at 800% size, the actual size window
displays the drawing at 100% (actual) size.

arguments Val ues that are enclosed in
parentheses and are used as input to a function
in a formula.

Address stack One of the personal utility stacks
included with HyperCard. It is useful for
storing names, addresses, and phone numbers.

arrow pointer The shape the mouse pointer
takes wh en it is possible to use the pointer to
select something, such as a command from
the menu bar.
arrow tool A tool available in many programs
for moving objects.

algorithm A step-by-step process used to solve a
problem or accomplish a task. A computer
program is a group of algoi"ithms coded into
a computer language in a form the computer
can follow. (See also program, software)

ascending order An order in which information
can be sorted. For text, ascending order is
A" to Z" and for numbers it is lowest value
to highest.
Authori+g level One of the five user levels in
HyperCard. The authoring level allows you
to h~ve full access to all the tools in the
program other than scripting in HyperTalk.
11

alignment How two or more objects line up,
whether graphic objects or text. With graphic
objects this can includ~ centering one object
inside of another or placing objects so that
their top edges are at the same horizontal
level. Text alignment can include horizontal
alignments such as flush left, flush right,
just ifi ed, and cen t ered, and ve rtical
alignments such as centered between the top
and bottom margins.

11

Autogrid An option in MacDraw that allows an
object to be drawn or moved according to the
division increments in a grid.
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automatic page break The point where text
auto matically goes to a new page in Microsoft
Word based on the top, bottom, left, and
right document margins.
automatic styles Predefined styles that are
built in to Microsoft Word, such as Normal
and footer.
background button A button, in HyperCard,
that is common to all cards sharing the same
background.
background layer A template, in HyperCard,
that can be shared by a number of cards.
Pictures, fields, buttons, and other objects
can be placed in the background layer and
accessed from each of the cards that share
that background.
backup Making a copy o f your data on more
than one disk. The idea is to copy all data on
a disk onto another disk at periodic intervals
depending o n how valuable the information
is, and how difficult it would be to recreate it
if it were lost.
bar chart A chart that compares items by showing
values at a specific time. It is composed of a
number of horizontal bars.
baud The rate at which data is t ransmitted in
serial communications. Common baud rates
are 300, 1200, 2400, 9600, and 19200 baud.
bit An abbreviation of Binary digiT. A bit is a
unit of information that can represent one of
two states-on or off. Eight bits are defined
as a byte.
bitmapped A method of storing a graphics
object or a font by representing each dot as
on o r off. Since a bit can easily do this, this
type of graphic or font is mapped onto a grid
of bits, resulting in an area that is bitmapped
and easy to reproduce on the screen or printer.
(See also bit, object-oriented)
blank report A report in FileMaker in which
the user specifies the placement of all fields,
text, graphics, and other objects. It is the
most flexible report format, but FileMaker
h elps the least in this report format.
block quote A quote that is indented on the
left and right so as to differentiate it from the
rest of the document. It does not require
quotation marks.
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Body part The main part of a FileMaker report.
FileMaker prints one body part for each record,
and prints as many as will fit on a page.
book A tool in FileMal<er that is used to access
other records and layouts.
border palette The portion of the MacPaint
toolbox that is used to change the weight of
the outline of an object as it is drawn.
borders Lines or boxes placed around objects
or text.
Browse mode A mode in FileMaker that lets you
view, edit, add and delete records.
browse tool The tool used in HyperCard that is
shaped like a pointing hand, and is used to
click buttons and place the insertion point
in fields.
Browsing level The user level in HyperCard that
allows you to view a stack but not make any
ch anges to it.
brush shapes The various sizes and shapes of
paint brush available with the paint brush
tool in MacPaint and HyperCard.
brush tool The brush tool is used to paint with
a specific shape using the current pattern in
MacPaint and HyperCard.
bucket tool The bucket tool is used to pour the
current pattern into an enclosed white area
or a continuous black area in MacPaint and
HyperCard.
business graphics Business graphics are no rmally
used in busin ess manageme nt and
presentations to managem ent and th ey
include pie charts, line graphs, bar charts,
and o thers. Many of these graphics are
produced by spreadsheet, data base, and
presentation programs. Business graphics may
also mea n pictorial representations and
informational screens which can be produced
by a wide variety of programs on the
Macintosh. (See also analytical graphics and
presentation graphics)
button An area on the screen that is a basic
component of the Macintosh user interface.
A button allows you to start an action by
moving the pointer into the area defined by
the button and then clicking the mouse.
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button tool The tool used in HyperCard to
create, select, modify, and delete buttons.
byte A byte is a unit of measurement that is
defined to be 8 bits. On the Macintosh we can
think of it as being the amount of storage
used to store o ne characte r, such as an "A" or
a " 1". (See also bit, kilobyte, megabyte)
cable A set of one or more wires used to send
information between peripheral devices.
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charact r A symbol having a m eaning that is
stan ard ized a n d widel y r ecog ni zed.
Common characters are the lette rs you are
reading, numbers, punctuation, and ot her
specialized symbols like dollar signs.
chevrons Special pairs of characte rs(<<, ») that
precede a nd follow a merge field in a Microsoft
Word print merge document. (See also merge

fields)

calculation field A type of fie ld in FileMaker that
contains a value calculated from other fields
in the same record .

click Quickly pressing and releasing the mouse
butto n without moving the m ouse. (See also

Calendar stack One of the person al utility stacks
included with HyperCard.

clip art Clip art includes elect ronic art, saved in
a number of formats, t hat can be pasted into
application s. The term derives from books of
art which were d istributed. You would cut
(or clip) the a rt from the page with scissors or
a knife, and paste it o n to the pasteup of
t h e docu men t you were c reating. Clip art
is distributed commercially by a number
of ven do rs.

cancel box The small box in the formula bar in
Excel. Clicking in this box discards any
chan ges made to t he active cell an d leaves it
as it was.
card A type of HyperCard object that is the basic
storage component of a stack. an d can h old
graphics, buttons, an d fields. A card h as a
background layer and a card (or foreground)
layer.
card button A button that appears on a single
card in HyperCard.
card layer The storage area of a card wh ere
objects such as graphics, fi elds, and buttons
may be p laced. Th ese objects are o nly
accessible from the card that contains them.
cell address The combination of colum n letter
and row number that identifies the location
of a cell in a spreadsheet program such as
Excel.
cell The intersection of a row and a column in an
electronic spreadsh eet, such as Excel, and in
a table, such as created using the Tables
feature in Microsoft Word. (See also column,

formu la, row, spreadsheet)
center tab Text is centered around the point at
which the center tab stop is placed on the
ruler in Microsoft Word.
Central Processing Unit (CPU) The actual
computer in a computing sys t e m. In
microcomputers, the CPU is a single integrated
circuit (chip). Larger computers h ave CPUs
that take multiple boards, each of which
contains multi ple integrated circu its.

mouse, mouse button)

Clipboard A special file, located in the system
folder on the current startu p disk, that holds
on e item. This item may be text, a picture, or
any other copyable item on a Macintosh. The
Clipboard contain s the last item cut or copied
in an y application or desk accessory. Any
time you make a new copy, the old copy on
the clipboard is replaced.
close box The sma ll, w hi te square box on the left
side of the title bar of the active window.
C li ck ing in this cl ose box cl oses and
deactivates that document, or closes a folde r
and moves up o n e level in t he file system.
Clicking in t h e close box is the same as
ch oosing Close under the File menu.
column A vertical grouping of cells in a n
electronic spreadsheet, such as Excel, and
in a table, such as is created using the
Tables feature in Microsoft Word. (See also

spreadsheet, table)
column chart A cha rt used to draw comparisons
amolg several items over a period of ti me.
columnf r report A t ype of report, available in
info~nation m anagemen t program s, where
the fields are listed across th e top row of th e
re po~t, a nd the data in those fields is listed in
columns below t he fi eld head ings.
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combination chart A chart where related
information is shown using m ore than one
chart type.
Command key A modifier key on your keyboard
that causes a command to be performed
when it is depressed along with one or more
other keys, or when depressed along with a
mouse click. The original name for the key
that is also ca lled the Apple key. New
keyboards have both the apple symbol and
the clover leaf symbol (also referred to as the
propeller symbol). Older keyboards only have
the clover leaf.
Command-key equivalent Instead of choosing
a command from a menu using the mouse,
most applications give you the o ptio n of
pressing a key in co mbination with the
Command key to issue the command. For
example, Command-S usually means Save,
Command-C is Copy, Command-X is Cut,
and Command-V is Paste.
common carrier A standard communicatio ns
network such as the Bell phone systems.
concatenate The process of joining two o r
more data items into one lo nger item by
joining the beginning of the second item to
the end of the first item.
conditional printing The ability to check the
contents of a field in a data file and insert and
print different text based o n the value of
that field .
constrain Using the Shift key while moving or
d rawing an object iri MacPaint, HyperCard
and MacDraw limits, o r co nstrains, the
movement of the object either vertically or
horizontally.

then choosing Duplicate under the File menu.
(3) To make a du plicate of an entire disk by
dragging the icon of one disk onto the icon of
a second disk. This will destroy what was on
the second disk and duplicate all of the files
on the fi rst disk onto th e second.
corner/center control The cont rol at the
bottom of the tools palette in MacDraw that
determines the starting poin t when drawing
an object (either from center to corner or
from corner to corner).
cross-beam pointer When drawing ob jects in
MacPaint, HyperCard, and MacDraw, the
arrow pointer changes to the cross-beam
pointer when it is moved into the drawing
window.
CRT (cathode ray tube) A television-like device
for displaying computer o utput.
currently selected pattern The fill or line pattern
that is shown in the currently selected pattern
portion of the patterns menu in MacPaint
and the patterns palette in MacDraw. In
MacPa int and HyperCard, the currently
selected pattern controls the pattern of the
o bjects d rawn with the filled sha pe tools and
the pattern used with the paint bucket, paint
brush, and spray can. In MacDraw it refers to
the fill and line pattern of any o bject drawn
with the shape tools except for the freehand
and polygon tools.
curve tool A tool used in HyperCard fo r drawing
free-form sh apes.
cut To remove something by selecting it, and
ch oosing Cut fro m the Edit menu. Wh at you
cut is placed on the Clipboard, and may then
be pasted o ne or more times in other locations.

context sensitive help An application help
syst em that can identify the context in which
an action occurred. The help program can
determine where the pointer is, or what you
are trying to do when you ask fo r help. The
system then tries to give you help for the
specific task you are performing, or the specific
object you are accessing.

data Raw facts.

copy (1) To m ake a duplicate of something by
selecting it, and choosin g Copy from the Edit
menu . What you copied is placed on the
Clipboard, and may then be pasted one o r
more times in other locations. (2) To make a
duplicate of a file by selecting a file icon and

data series A collection of related data points.

data document One ofthe !1ecessarycomponents
of a print merge pro ject in Microsoft Word.lt
contains the data records to be merged with
the m ain merge document.
data point A category with a corresponding
numeric value.
database An organized collectio n of data stored
in a group of related files.
date field A type of field in FileMaker that ho lds
a date.
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decima l-a lig n ed ta b When typing numbers in
columns, the m ethod of having the computer
automatically align the numbers b y lining up
the decimal poin ts.
d efa ult (1) The initial, predetermined setting for
an o ption in a program. The user has the
optio n of changing this setting, or accepting
it as is. An example is the default setting for
page margins in a word processing program .
These margin s are normally set to give
sta ndard m argins all around the page, but the
user may override these defaults and increase
or d ecrease the margin settings. (2) When
using butto n s in a dialog box, the d efault
button is t he one that is highlighted with the
larger, darker oval. Default buttons may be
chosen by clicking on the button, or by
pressing the Return or Enter key.
Define The process of naming a field in
FileMaker and specifying its t ype of contents
and entry optio n s.
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area with a menu bar over it, disk drives
on the right side and a trash can in the
lower right corner. The actua l pattern
ca n be chan ged with the Control Pan el
desk accessory.
destina ti on disk A disk that receives a fil e that is
being duplicated, copied, o r moved.
d etail repo1t A report that lists one o r more lines
of o utput for each record.
d ia log box A box that pops onto the screen and
allows the user to interact with the computer.
Almost all dialog boxes contain messages to
the user, and allow the user to respond . Ma ny
dialog boxes also allow the user to select
options and perform o ther commands. All
men u cho ices that end in an ellipsis( ...) are
followed by a dialog box requesting more
input from the user.

de li mite r A ch aracter that is used to indi cate
the end of o ne item and the beginning o f
another. When used in producing a print
m erge document in Microsoft Word, all data
fie lds are d elimited, or sepa rated, with
commas or tabs.

dimm ed Most commands in a menu appear in
black text, but dimmed commands appear in
gray text. When the com mand is dimmed, it
means that it may not be chosen at that
point. Dimmed icons represe nt di s ks,
documents, applications or folders that are
located on a disk th at has been inserted into
the system, and then subseq uently e jected.
Th e documents may n ot be opened w hile the
disk is ejected.

d escen di n g o rder An order in which info rmatio n can be sorted. For text, descending orde r
is "Z" to "A" and for numbers it is high est
value to lowest.

direct access A m eth od of accessin g da ta
without h aving to read the preceding data.
Usu a ll y applies to RAM memory an d
disk drives.

deselect Clicking somewhere on the screen so
that a selected object is no longer selected.

directo ry window The window that contains
the listing of the contents of a folder or d isk.

d es kto p publishing The use of microcomputers
and page layout programs, or fu ll-featured
wo rd processors, to completely design, edit
and layout the contents of a document. Th ese
programs then allow the user to produce
camera ready output when the document
is pr int ed o n a la ser printe r or a
phototypesetter that is capable of interpreting
PostScript output.

disk dri ve The device that contains the disk or
di ske tte. A disk drive is ab le to read
information from a di s k, a nd wr ite
information o nto a disk.

d efin ed term A te rm listed in Excel's help file.

deskto p The Macintosh interface revolves around
the metaphor of items on a desktop. files,
folders, calculators, clocks, notepads, and
oth er items a re n ormally found on desktops.
The desktop is the screen you see wh en you
first sta rt the Macintosh. It is normally a gray

doc ume nt Information created and stored on
disk by application or system program s. On
m ost computers these are called data fil es.
The Macintosh term "d ocume nt" m ay be
m ore descriptive, because each of these files
is associated with a doc um ent icon in
the Finder.
d o t leaders A series of dots that lead up to a tab
position. Tab leaders m ake it easier for the eye
to follow the area between the tab positions.
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dot-matri x printer A type of impact printer
that prints by causing small pins to strike t he
ribbon against the paper. The name is derived
from the fact that all characters are made up
of a matrix of dots (dots aligned in rows and
columns) . The printer prints by m oving a
printhead, containing the pins, left and right
across the page and causing the pins to
strike as n eeded. The Im ageWriter II from
Apple is the standard dot matrix printer fo r
the Macintosh .
double-click The process of placing the cursor
where you want it and then clicking the
mouse button twice in rapid succession
without moving the mouse. Normally, yo u
must click twice in about a half-second to be
interpreted as a double-click. The time delay
allowed for double-clicking may be changed
in the Control Panel desk accessory.
dpi (dots per inch) The number of dots displayed
o r printed in an inch. The standard Macin tosh
screen displays 72 dots per in c h. The
LaserWriter prints at 300 dpi. Th e higher the
dpi, the better the print or screen resolution.
dragging The process of positioning the cu rsor
over some ob ject, pressing the mouse button
and h olding it down, moving the mouse to
reposition th e cursor to a new location, and
then releasing the mouse button . Dragging
has three main u ses: (1) to make a large
selection by surrounding and selecting a ll
objects in the selection area; (2) to move an
icon by dragging it to a new locatio n; (3) to
choose a com mand from a menu by cl icking
on the menu n ame, dragging down to the
item d esired, and releasing the mouse button
to select that command.
drawing format The default format for saving a
drawing created in MacDraw.
drawing tool The small vertical line to the right
of the tab icons on the Microsoft Word ruler.
It is used to place a vertical line in a document
corresponding to the drawing tool's position
on the ruler.
drop-down list A list of options that drop down
when you click on the arrow to the right of
certa in option boxes, such as the underline
drop-down list available in the Character
dialog box in Microsoft Word.
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DSDD disk Double-Sided Double-Density d isks.
Standard 3.5-inch disks capable of h olding
800K.
dummy argument A placeholder argument that
indicates the type of argument that sh ould be
input to a function.
Duplicate command The command used in
MacDraw to create a dupli cate of an ob ject in
a drawing. It works like a combina tion copy
and paste command in one action .
duplicate An exact copy of the original.
dynamic link An object in HyperCard that
links to oth er ob jects. It can be a button or a
text phrase that is used to take the viewer to
a different card or other related information.
Edit menu Most Macintosh programs have an
Ed it menu following the Apple menu and File
menu. Usually the Edit menu will contain at
least Undo, Cut, Copy and Paste. It freq uently
contains Clear as well. The Edit m enu is one
of the most standardized of the menus used
on the Macintosh.
editing Changing or modifying th e contents of
a document. This includes editing on paper
whil e proofreading, and/or changin g a
document on the computer.
electronic circuit board A board containing
electronic circuits and attached integrated
circuit chips. This is also called a card or
printed circuit board.
electronic data processing (EDP) Th e processing
of data into information using electronic
devices such as computers rather than manual
or mechanical methods.
electronic spreadsheet (See spreadsheet)
ellipse An oval shape, or a ci rcle.
end-of-cell marker A small black circle that
represents the end o f a cell in a table in
Microsoft Word. The end-of-cell marker is
visible o nly when Sh ow 91 is active.
end-of-row marker A small black circle that
represents the end of a row in a table in
Microsoft Word. The end-of-row marker is
visible only when Show 91 is active.
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En ter key A key, normally found on the bottom
right corner of the Macintosh keyboa rd, that
may be used to accept an entry or confirm a
command in a dialog box. Pressing the Enter
key or the Return key will se lect th e
high lighted (default) button in a dialog box.
On many computers, the Enter and Return
keys are the same. On the Macintosh, they
often have different functions de pending on
th e program being used at the time.
ente r box A small box containing a ch eckmark
in Excel's formula bar. Clicking in this box is
the same as pressing the Enter key and accepts
an y changes that have been made in the
active cell.
eraser tool A tool used to erase all or part of an
item in MacPaint or HyperCard.
exception rep ort Areport caused by an exception
to anticipated results. This might be a report
of sales personnel who did not meet the ir
quotas, or numerical results in an experiment
outside the expected range.
expansion p01t A connector, usually o n the
outsid e of the computer, that allows the
connection of addition al peripheral devices.
An example of an expansion port is the
SCSI port.
expansio n slo t A narrow socket located o n the
main circuit board of the computer into which
you can attach a peripheral circuit board
or card.
exploded pie c hart A pie chart where on e or
more slices are pulled away (ex ploded )
from the rest of the pie to emphasize what
they represent.
fatBits The 800% magnification view in MacPaint
and HyperCard, in which you can work with
individual pixels.
field (1) A data ilem used to com pose a record. A
field is a specific type of information in an
information management program. (2) A
fie ld in HyperCard is wh ere regula r text (as
opposed to paint text) m ay be stored.
fie ld tool The tool used in HyperCard to create,
select, modify, and delete text fields.
file me nu The second (usually) menu in a
Macintosh application. It generally contains
commands that affect the entire file, such as
Save, Save As, Print, and Quit.
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fil e A s ngle specific collection of information
that has a name and is stored on a disk. This
inform ation m ay be a data document,
application program, system program, or
system data file.
file _maintena n ce The process of keeping
mfonmation in a file up to date. This can also
include making backup copies of files.
file management syst em A simple information
management system wh ere data is organized
into discrete fi les. This is a precursor to
database man agement systems and usually
has a limit of only one file open at a time.
fill pattern box The box at the far left of the
MacDraw pattern palette that reflects the
currently selected fill pattern.
fill The pattern that is inside the borders of an
object in a drawing program.
find A feature available in many applications
where you to ente r a text phrase and the
computer finds tha t phrase in the current
document if it exists.
Finder Th e application that automatically starts
when the Macintosh is turned on. It manages
and maintains the desktop, and is used to
open applicatio ns, organize files and folders
on disks, and copy fi les and fo lders.
First Page Special An option in th e Section
dialog box of Microsoft Word that creates a
special h eader and footer that prints on only
the first page of a document.
first -line indent The indentation of the first line
of a paragra ph. The fi rst-line indent setting
on Microsoft Word's ruler is used to control
this indentation.
flip The process of turning an object vertically or
horizontally in a drawing program so that a
mirror image is produced.
flopp y d isk A disk made of fl exible plastic. 5.25"
disks!are en cased in paper or plastic en velopes
and r re floppy wh en you move them. 3.5"
diskl are also made of flexible p lastic, but are
encared in a hard p lastic shell. Both are still
refeled to as a floppy d isk.
flush l e~ Ali?nment where text is a ligned on the
left margm and ragged on the right.
flush right Alignment whe re text is aligned on
the right margin and ragged o n the left.
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fo lde r A folder is par t of the Macintosh
hierarc hical file system . The main level of
the fi le system is the d isk, which may hold
m an y fil es and folde rs. Each folder may
also h old man y files and folders. On most
other compu te r systems, folders are known
as subdirectories.
fo n t A set o f characters w hich includes letters,
numbers, punctua tion , and other symbols
t hat have a consistent appearance.
footer On e o r m ore lin es o f text a nd/or graphics
that appear o n each page of a document in
the bottom margin. Footers may include page
numbers, dates, times, text, pictures, or other
graphics. (See also heade1)
Footer part The part of a fi leMaker report that
contains th e bottom m argin. It is printed on
every page and can contain page numbers,
fil e names, th e date and other similar
information.
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wh en printed. Documents are normally
opened in Ga ll ey View. (See also Page View,
Print Preview)
Gen era l tools The three HyperCard tools that
are not used for painting: Browse, Button
and Field.
grabber tool The hand-sha ped tool in MacPaint's
too lbox that is used to move a different
portion of the drawing into view.
graphical user int erface The Mac is t he premier
exampl e of this type o f user interface, which
consists o f icons, windows, and a mouse that
controls th e m oveme nt of a pointer on the
screen. Commonly abbreviated GUl.
grid Non-printing guide and control lines in
programs that help the user to align objects.
MacPaint , Hyp erCard, MacDraw, and many
other grap hics programs provide grids that
can be used fo r this purpose.
grid lines Dotted lines that can be displayed
and that ma rk the boundaries of a grid.

format ting a d isk The process of initializing a
disk so that it can store and retrieve data. This
process di vides th e disk into tracks, subdivides
the tracks in to secto rs, a nd creates a directory
structure for accessing the information.

g ro uping In MacD raw, the con solidation of
t wo o r m o re sepa rat e ob jects into o n e
composite object.

form atting In word processi ng, the process of
d etermining how text and d ocuments will
appear w hen printed.

guide lines Lines that are created in a drawing to
a id in the placem ent of objects, and that are
usually re moved before printing.

fo rmula A formula is a mathem atical equation.
In a spread sheet p rogram, yo u can w rite a
formu la that uses values stored in other cells
to calculate a value for the current cell. (See
also fi.mction)

ha ndle In MacDraw, the small black squares that
appear at each corner o f a selected object. (See
also selection squares)

formula b ar In Excel, an area on the screen just
below the m enu bar that is used for editing
and d isplaying the contents of the active cell.
freeh a nd tool A tool used in drawing programs,
such as MacPain t and MacDraw, that is used
to draw free hand shapes.
fu n ction A built-in fo rmula in a spreadsh eet
program or programming language th at can
be used for calculating commonly used
values such as square root, absolute value,
average, sta ndard deviation, and so on. (See
also formula)
Ga lley View O ne of the fo ur document views
available in Microsoft Word . Galley View
gives yo u the fastest working environment,
but does no t display the page as it will look

ha nging in de nt When the first line of a paragraph
extends (or h an gs) to the left of the left
m argin of th e rest of th e paragraph.
h ard copy When info rmation is printed on
paper it is known as h ard copy. Soft copy is
info rmatio n p resented on ly on the screen of
the computer.
ha rd d isk A d isk that is permanently sealed in its
d isk drive. These are called hard disks because
th e disk platter is normally m ade from
aluminum, wh ereas a diskette is normally
produced from plastic. Hard disks normally
store mega bytes o f da ta.
hard return Pressing th e Return key creates a
hard retu rn in a line of text, and causes the
insertion point to move to the n ext line. A
h ard return indicates the end of a paragraph.
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hardware The part of the computer that you can
touch. All physical devices are hardware. This
is opposed to software, which is abstract and
inta ngible. (See also software)
Header part The part of a FileMaker report that
contains the top margin. It is printed on
every page and can contain page numbers,
fil e n a mes, the date and other similar
information.
header One or more lines of text and/or graphics
that appear on each page of a document in
the top margin. Headers may include page
numbers, dates, times, text, pictures, or other
graphics. (See also foote!)
header record The first record in a print merge
data document in Microsoft Word. The header
record determ ines the names of the fields and
the order in which they appear in all data
records in the data document.
high-density disk The 3.5 inch disks for use
in the SuperDrive. It holds 1.4 megabytes
(1,400 kilobytes).
highlight A method used to distinguish an
object from oth ers of its kind. (1) Ahighlighted
butto n, also known as the default button, has
a n additional, darker oval surrounding it. (2)
Ahighlighted menu or menu item is inverted.
W hite pixels become black and vice-versa. (3)
Highlighted text is also inverted.
Home button A button with the icon of a house
that is used in HyperCard to return to the
Ho me card.
Home card A special card in HyperCard that is
used as a pictorial index to other stacks.
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HyperT k The built-in scripting language used
to program HyperCa rd.
hyphenation
used with
determine
words in a

dictionary A utility file that is
a word processing program to
the appropriate hyphenation of
document.

1-beam pointer The !-shaped pointer that is used
for editing and entering text.
icon Apicture that is used to represent something
else. Icons may be pictures of disk drives,
diskettes, folders, or documents, and are one
of the main parts of the Macintosh graphical
user interface.
ImageWriter A dot matrix printer introduced
and marketed by Apple Computer. (See also
dot matrix printe1)
indentation controls Th e controls on the
Microsoft Word ruler that control the
first line, left, and right indentations of a
paragraph .
indentation Moving the first line of a paragraph
and/or the subsequent lines to the left or
right. Sometimes the width of a paragraph
will be increased or decreased relative to
paragraphs above and below in order to
visually set it off from the others.
informatio n Data that has b een organized,
sorted , collated, and otherwise put into a
useful and retrievable form.
initialize
The process of preparing a new
diskette, hard disk or tape cartridge so that it
will be able to store information. This is also
known as formatting. (See also formatting)

horizontal split bar (See split bm)

input The information that is transferred into a
computer from a n external source. Original
input is usually s uppli ed through the
keyboard. Oth er input may come from a disk,
modem, scanner, mouse, trackball, or tape
drive. Input also refers to the process of
transferring information into the computer.
(See also output)

hot spot The active portion of a MacPaint,
HyperCard, or MacDraw tool that actually
does the drawing, selecting, or painting. For
exam p le, th e hot spot of the lasso tool is the
straight rope, and the hot spot of the paint
bucket tool is the drip. All pointers have a
particular h ot spot.

insertion point The place in a text document
wherb the n ext action wi ll occur. You may
mov1 the insertion point by moving the Ibear~ to a new locatio n and clicking. The
inseryon point will move tothisnew location
and a short vertical line will blink so that you
can easily spot it.

Home stack A special stack that is required for
using HyperCard. It contains one o r more
Home cards, cards for sto ring paths to stacks,
documents, and application s, and a
preferences card for setting the user level,
user name, and other options.
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item (1) A synon ym for "fi eld" when used in
te rm s o f reco rds a nd files for storing
information. (2) One of the words or phrases
listed in a menu, know n as a menu item .
jaggies The jagged lines of some printed objects
that h ave been created with bit-mapped
graphics program s.
jump term A te rm in Excel's help system that is
shown w ith a solid underline. Clicking a
jump term will take yo u to information
associated with that term.
justification The process of aligning text on the
left and right by adding extra spacing between
wo rds o r even between letters. (See also

alignment)
justified text Text that is flush on both left and
right margins. (See also aligmnent, justification)
key field A fi eld arou nd which a file is structured.
keyboard An in put device, similar to a t ypewriter,
used for inputting text into a computer.
kilobyte A unit of measurement that is normally
thought of as 1,000. However, in computer
terminology, this represents 1,024. Kilobyte
is normally abbreviated as KB. Although this
is a strange number in th e decimal number
system , it is a round number in the binary
number system the computer uses. One
kilobyt e is 1,024 bytes.
labels report A repo rt format in FileMaker and
HyperCard where information is printed on
labels, such as mailing labels.
landscape orientation The rotation of a page so
that the contents are printed sideways on the
page. Rather than the long side of the page
being vertical, it w ill be horizontal. (See also

portrait orientation)
laser printer A printing device which uses a
laser to produce a n image on a drum. Then
the drum is rotated through tiny bits of
pl as tic ca ll ed to n e r. The drum is
electrostatically ch arged and picks up the
toner in the areas charged by the laser. A piece
of paper which has been charged with the
opposite static charge is rotated past the drum,
picking up the ton er from the drum. The
paper then goes through two heated rollers
(fusers) that melt the plastic onto the paper
and fi x it there. Since a lase r printer is a nonim pact printer it can not successfully print on
multi-part forms. (See also LaserWriter)

LaserWriter A 300 dot per inch laser printer
de vel ope d and distributed b y Apple
Computer. The LaserWriter was on e of the
four main components that introduced the
desktop publishing revolution. The other
three were the Macintosh, PageMaker, and
PostScript. (See also desktop publishing, laser

printer, PostScript)
lasso (See lasso selection tool)
lasso selection tool The too l in MacPaint and
HyperCa rd that is used to select an object, but
that does not select any background around
the object. (See also selection rectangle)
layer controls The con trois at the bottom of the
tools palette that enable you to move between
named layers in a MacDraw document.
layers MacDraw and HyperCard keep different
objects in layers on the screen. Objects created
fir st are behind objects created later. In
MacDraw there are layers you can n ame and
view separately or as a group, similar to the
way you can view a stack of drawings on
transparent film. HyperCa rd keeps different
objects (buttons, fi elds, pictures, etc.) on
diffe rent lay e rs o n two main layers:
background and card.
Layout mode The mode in FileMaker that
allows yo u to a rrange fie lds, t ex t, and
graphics for producing on-screen displays
and printed reports.
leaks When filling an o bject with the paint
bucket tool in MacPaint or HyperCard, if the
border of the o bject h as gaps the pattern
"leaks" out the gap and fill s the rest of the
drawing window.
left indent Where the text in a paragraph is
positioned with respect to the left margin of
the paper.
left-aligned tab The left side of the first word in
the column be low this tab o n the Microsoft
Word rul er will align with th e position where
the tab is placed on the rule r.
legend Symbols and text that are used to identify
the data represented on a chart.
line chart A chart that sh ows the change in data
over a period o f time emphasizing direction
and rate o f ch a nge.
line pattern box The box at the fa r right of t he
MacDraw pattern pa lette that reflects the
currently selected lin e pattern.
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line spacing The vertical spacing of lines o f
text. In double spacing, fo r example, an extra
full lin e of space is placed between each line
of text.
Hnetool The drawing tool in MacPaint, MacDraw,
and HyperCard (and other graphics programs)
that is used to draw a straight line between a
starting and ending point.
line weight The thickness of a line, usually
measured in points.
link A relationship between tvvo documents
(such as Excel worksheets) that is defined in
a formula.
linked terms Terms that are associated with
oth er related terms in Excel's help system.
local area network (LAN) A group of connected
computers in a small area (such as a room
or building) that share information with
each other.
lookup field A fi eld (in FileMaker) into which
information is copied from another file based
o n match ing information in both fil es.
magnify To increase the size of the view of a
drawing to allow m ore deta il ed work. In
MacPaint the Zoom In command allows you
to magnify the drawing up to 800% of its
actua l size. MacDraw enables you to magnify
the drawing to 3200% of its o riginal size.
main document One of the two documents
used in a print merge project. The main
document always contains specia l print merge
commands, the merge fields that ho ld the
data that changes from o n e document to the
next, and the body text that does not ch ange
from one docum ent to the next.
management information system (MIS) A
co mputer ized syst e m that
provides
inform atio n to management personne l
for operat iona l, tactical, and strategic
decision making.
manual page break A page break that results
from issuing a command that causes the text
to go to a new page at a particular place in a
document. (See also automatic page break)
marching ants A term used to describe the
border of a selection made with the selection
rectangle in MacPaint and HyperCard. (See
also selection rectangle)

megabyte A unit of measurement that is
n ormally thought of as 1,000,000. However,
in computer terminology, this represents
1,048,5 76. Megabyte is normally abbreviated
as MB. Although this is a strange number
in the decimal number system , it is a
round number in the binary number
system the computer uses. One megabyte is
1,024 kilobytes.
memory Memory is an electronic device that is
capab le of sto ring information. All
Macintoshes include two types of memory:
RAM and ROM. (See also RAM, ROM)
menu A list of commands, or menu items, that
are included under the menu title in the
menu bar.
menu bar The horizontal bar at the very top of
the screen which contains a list of m enu
titles. Most menu bars are consistent in that
the first three menu titles are Apple, File and
Edit. Each application has its own distinctive
m enu bar which contains the specific set of
m enu titles and commands that are available
in that application. (See also m enu, m enu item)
menu item A command that is listed on a menu.
To access a menu item, press on the menu bar
and drag to the item you want, then release
the m o use button to select the highlighted
item. All menu items that end in an ellipsis
(... )are followed by a dialog box. (Seealsodialog
box, dragging, highlight, menu bat)

merge fields Special fields used in the main
document of a print merge project that act as
place holders for data that comes from the
data document. Merge fie lds in Microsoft
Word are enclosed with special characters
ca lled chevrons(« and»).
Message box Afloating window (or mini window)
in HyperCard used to enter commands and
show messages.
microprocessor Th e processor u sed in a
microcomputer, such as the Motorola 68000
or 68030.
modeling
The use of a hypothetical
representation of a real-world situation .
Frequently, modeling refers to u sing
spreads h eets to try to predict future
financial events.
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modem An ab brev iati o n for modul a tor/
demodulator. A modem is a device that allows
computers to communicate to other d evices
over pho ne lines . Computers use digita l
signals internally, and phon e lines use an alog
signals, so a modem h as to translate so the
computer can communicate over the phone
lines. Modulate refers tochangingfrom digital
to an alog (sound), and d emodulate refers to
translating from analog (sound) to digital.
monitor (also called CRT or VDT) A televisionlike device for displaying computer output.
monospace font Fon ts w h ere eac h letter,
regardless of its width, is given the sam e
a m o unt o f spac e. Typew rite rs u se
monospacing. (See also proportional font)
mouse A hand-held device that the user moves
on a flat surface next to the computer. As the
mouse is moved the cursor on the screen
moves in a corresponding m anner. Most
commands and selectio ns on the Macintosh
are mad e in con jun ction with pointing,
clicking, dragging and double-clicking with
the mouse . (See also click, doubleclick, dragging)
mouse button The rectangular button on the
to p of th e mouse that is used in conjunction
with moving the mouse (or not moving the
mo use) to initiate pointing, clicking, dragging,
pressing, and double-clicking. Normally, the
user positions the cursor o n an object by
moving the mouse, and starts an action by
pressing the mouse butto n. Then the action
is confirmed by releasing the mouse. (See also
click, double click, dragging)

nesting folders The process of placi ng fold ers
inside of other folders. This is the m ethod of
organizing the structure o f a hard disk into an
inverted tree structure. (See also (ofdel)
new line command Theactofmanually moving
the insertion point to a new line in a text
document wi thout creating a n ew pa ragraph.
Also called a soft return, in Microsoft Word
the new line command is Shi ft-Return. (Seen /so
insertion point, hard retum, soft return)

number A word, symbol, letter, o r combination
of symbols used to represent a ma th ematical
quantity.
number field A fi eld in FileMaker that holds a
number or a yes/no value.

object-oriented A type of drawing program
where each object in the drawing is stored as
mathematical info rmation in the com puter
rather than th e collection of dots that
bitmapped programs store for each ob ject.
(See also bitmapped)

Option key A modifier key that is used with a
character key to alter its fun ctio n. In most
fo nts, there are add itio nal symbols and
characters that m ay be formed other than the
ones that are available by using the key by
itself or with the Shift key. Two additional
combinations-with the Option key, or w ith
the Option key and the Shift key-allow each
character key to potentially p roduce a to tal of
four different characters. The Option key is
sometimes used with a tool in an applica tion
to change the normal function of the key. For
example, in MacPaint, the penci l too l allows
you to draw dot by dot, but when the Option
key is depressed, the pencil turns into a h and
that allows you to move the visible portion of
the painting arou nd on the screen.
orphans An orphan line occurs when all of a
paragraph is on one page except fo r the last
line which is on the following page.
output Information that is transferred from th e
computer to an external destination such as
the monitor, a printer, modem, o r disk drive.
Output also refers to the process of transferring
described above. (See also input)
oval tool The tool in MacPaint and HyperCard
used to draw ellipses and circles.
Page View One of four document views in
Microsoft Word. Page View allows you to see
a full-scale version o f a document as it will
look w hen printed and to edit and format
text. (See also Galley View, Prin t Preview)
page scale When you click the sca le icon on the
ruler in Microsoft Word it toggles to page
scale, w hich allows you to modify the margins
of the entire document. (See also table scale)
paginate The automatic determinatio n of where
page breaks wil l occur in a document based
on the margins, size of the font being used,
line width, a nd o ther pertinent factors. (See
also automatic page break)

paint brush tool A tool in MacPaint that a llows
you to draw freehand lin es in a variety of
shapes and patterns.
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paint bucket tool A tool in Mac Paint that allows
you to fill o bjects with a pattern.
paint text tool The tool in HyperCard that is
used to enter text into a picture. When the
text is deselected it is no longer editable as
text, but only as a picture of text.
Pa inting level The user level in HyperCard that
allows access to a nd use o f the various
p ainting tools.
Painting tools A HyperCard tool used to make
pictures, including the Pencil, Brush, Spray,
Lasso, Eraser, and o thers . Any tool in
HyperCard that is not a General tool.
palette A tear-off menu becomes a palette wh en
it is to rn off from the menu bar and becomes
a floating window. MacPaint and HyperCard
support palettes for tools and patte rns.
paragraph In word processing, text that is
followed by a ha rd return (pressing Return).
A paragraph can consist of o ne o r more
characters, words, or sentences.
paragraph spacing settings Th e settings on the
Microsoft Word ruler that con trol the am ount
of space between paragrap hs.
paragraph text Text used in MacDraw II that is
confined to a text box in the drawing w indow
and that uses word wrap to stay within the
m argins of t he text box.
part tool The tool in FileMaker that allows the
addition of new parts to the layout.
paste To place a copy of the contents of the
Clipboard-whatever was last cut o r copiedinto the current document at the insertion
point. (See also Clipboard, copy, cut)
patterns palette, Patterns menu The portion of
the drawing window in MacDraw and the
menu in MacPai nt that contain the available
fill and line patterns. (See also currently selected

pattern, fill pnttem box, line pattern box)
Pe n menu The menu in the MacDraw menu
bar that is used to control the line weights
and styles of lines and borders.
pencil tool The tool in MacPaint and HyperCard
that is used to draw a free ha nd one-pixelwide line.
peripheral An external computer device that is
used with the Macintosh, but is not an integral
part of it. Peripheral devices include disk

d ri v~s,

tape drives, graphics tablets, scanners,
printers, mo dems a nd others. These devices
are usually attached to the computer by cables,
although they may be internally mounted.
Phone stack A stack included wit h HyperCard
that can be used to dial a phone th rough the
Macintosh 's speaker or a m odem .
picture field A type of fie ld in FileMaker that
ho lds a picture.
pie chart A chart that sh ows the relationships
of the parts co mpri sing a w hole. Always
contains only one data se ries.
pixel An abbreviation for picture element,
w hich is one o f th e dots th at can be turned on
o r o f( o n a screen . A Macintosh scree n and an
lmageWriter printer have 72 p ixels per inch
m easured horizontally and verti cally for a
total of 5,184 pi xels per square inch . Th e
LaserWriter has 300 pixels per inch for a total
of 90,000 pixels per square inch. The higher
the d en sity, the fin er the resolution and the
bet ter the appearance of the output. (See also

bitmapped, dpi)
pointer A small graphic shape visible on the
screen that moves as the m ouse m oves.
Commo n shapes are arrows (n orth -east and
north-west pointing), !-beams, wrist watches
and crossbars. Many other shapes are possible,
limited o nl y by t h e imagina tio n of the
programmer. Pointers oft en ch an ge shape
over different parts of the screen to indicate
that they are capable ofdoi ngdifferent things
in some areas than in others.
points, point size A point is the smallest unit of
measurement in typograp hy and typesetting.
The re are 12 points in a pica, and 6 picas in an
inch. This mea n s that there are 72 points in
an inch. Font sizes a re measured in points on
the Maci ntosh and differe nt point sizes are
available fo r each fo nt. A 36 point font sh ould
be .S inch es high and a 144 point font should
be Z inc hes tall. (See also font)
polygo~

tool A tool in MacPaint and MacDraw
tha 9 is used to draw sh apes composed of a
sequence of connected lines.

portrait orientation The normal page orientation
for printing. This means that the long side o f
the paper is vertical and the short side is
horizon tal. The other orientatio n is called
landscape. (See also landscnpe orientation)
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PostScript A page layout language developed by
Adobe System s, Inc. that is included in the
LaserWriter printer and that gives it its special
capabilities. In addition to fo nt printing,
scaling, and rotating, it also contains many
drawing capabilities. PostScript® has become
the standard o utput lan guage for the desktop
publishing industry.
presentation graphics Informatio nal graphics
produced by a computer application such as
a spreads h ee t tha t sh ows re la ti o n s hips
involved in da ta sets. Presentation graphics
a re m o re sophisticated th a n a n a lytical
graphics because they are used to present the
information to management and people
outside of a company.
Print Preview On e o f four document views in
Microsoft Word. Print Preview allows you to
see a scaled-down view of who le pages of a
document as it will look wh en pri n ted. You
cannot access text directly while in Print
Preview, but it does allow so me limited
form atting capabilities. (See also Galley View,

Page View)
print merge A feature in many word processing
programs tha t involves creating a main
document that contains the body text, and
that contains special field s to mark the parts
that will change with each document. A data
document is also used that contains the
information to be placed in the specia l
fields in the main document. When the print
merge command is issued the information
from the data document is merged with
the main document to create customized
form documents. (See also data document,

main document)
printer A device that produces images o n paper,
photographic film, or transparencies. Many
types of printers are available. The Maci ntosh
primarily uses the lmageWriter dot matrix
printer and the LaserWriter laser printer. (See

Prog ram s are di vid ed into appli cation s
programs and syste ms programs. Program is
sy n o n y m o u s with so ftware. (See also

application program, system progra111)
proportional font A fon t in which different
characters are allowed d ifferent amounts of
space in the line of tex t depending on their
width. A "W" is given more space than an "i"
in a propo rtio nal font. Most Macintosh
fo nts a re proportionally spaced. (See also

moiiOspace {011t)
pull-down menu A menu that is hidden until
you press on its title, at which point the list
of ch oices pulls down onto the scree n
allowing you to select a command. (See also

menu, menu item)
RAM An acronym that stands for Random Access
Memory, and the part of memory th at is used
to store information that is changea ble. RAM
h o ld s a ppli cat ions p rog ram s, syste m s
programs, documents, and other data. RAM
is volatile, which mean s that the informa ti on
it contains is lost when the power is removed.

(See also mernory, ROM)
random access A method of accessing a particular
record in a file o r byte in memory without
having to read any preceding information.

(See also direct access and sequential access)
range (1) In Excel, a group of cells that are acted
upon by a comm and o r formula as a unit. (2)
In FileMaker, a criterion used for finding
information t hat is between a low value and
a hi gh va lu e, e ith e r alphabetica ll y,
chronologically, or numerica lly.
record A group of related information that
describes one pe rson, place or thing. A record
is made up o f related fi elds. A group o f re lated
records is known as a file. (See also file, field)
rectangle tool A too l used in many grap hics
program s for drawing rectangles and squares.

also dot111atrix printer, ImageWriter, LaserWriter)

redundancy Storing the sam e data in two or
more locations.

printing The process of issuing a print command
to send the contents of a document to a
printer to produce ha rd copy output.

reference area The a rea o n the screen to the left
of the formula bar in Excel that shows the row
number and column letter of the active cell.

program A set of instructio ns that tells the
computer th e complex sequence of steps
n ecessa ry to perform a p a rti cu la r task.

reformat To change the form at, or the way a
document looks wh en printed. (See also

fo rmatting)
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regular polygon tool A tool in HyperCard for
dra wing polygons with regular sides. It always
draws fro m the center outwards and a llows
rotatio n of the polygon before fixing its
location on the card.
relational database A database in which files
are organized as tables in rows and columns.
rela t ive addressin g A way o f definin g t he location o f a cell based o n its position relati ve to
the cell containing a formula in Excel.
repeating field A field that has been formatted
to allow you to store and d isplay multiple
values in one record.
Resh ape command A command in MacDraw
that e nabl es you to ch ange the shape of
o bjects drawn with the arc tool, th e polygo n
tool, a nd the freehand tool.
resize To ch ange the size of an object in a
drawing program.
resolut io n A m easure of how well a d evice can
produce an image. Higher resolutio ns produce
clearer images. Resolution is applicable to
both screen and printer o utput. A LaserWriter
produces better images than the screen or an
JmageWriter, because its resoluti on is a little
over 16 times higher. (See also rlpi, pixel)
Return key A key that normally causes the
insertion point to move down to the start of
the n ext line w h e n e diting tex t. Also
commo nl y known as the carriage return key,
it is usually used to end a paragraph, o r
produce a blank line. Wh en used with a
dialog box, the Return key can be used as a
shortcut to select the highlighted, or default,
butto n. (See also hard return)
Revert To Saved comma nd The comma nd in
Mac Paint t hat brings back to the drawing
window the last version of a document that
was saved on disk. It is used to undo erro rs
made to a drawing.
righ t indent Where the tex t in a paragraph is
positioned with respect to the right margin of
the paper.
righ t-aligned tab The right side of the first word
in the column below this tab will a lign with
the posi tion where the tab is placed o n the
Microsoft Word ruler.
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ROM A!cronym that stand s for Read On ly
Memb ry, and the part of memory that is used
to store information that is permane nt.
Information used by the computer system
throughout all applications is normally stored
in ROM. For instan ce, the procedures to
produce windows, buttons, scroll bars, a nd
other normal parts of the Macintosh interface
are stored in ROM. ROM is also used to store
the necessary instructions for the computer
to fo llow when the power is first turned on.
(See also memo1y, RAM)

rotate To move an object in a d rawing program
with its cente r point or corner as an
anchor point.
rounded rectan g le tool A painting tool avai lable in most graphics programs that is used
to draw rectangles and squares w ith
rounded corners.
rounded rect an gles Rectangles w hose corners
are formed by arcs instead of sharp angles.
row In an electronic spreadsh eet or in a cell table,
a horizontal grouping of cells. (See a lso
cell, column)

ruler (1) In a word processing program, a graphic
representation of a ruler which allows you to
set margins, tab sett ings, lin e spacing,
indentation and other settings. (2) In drawing
and paint programs, a ruler placed a lon g the
edge of the window to aid in m easuring and
placing graphic elements in t he image.
ruler settings The margin, tab, line spacing,
indentation, and o ther settings th at a re
controlled by the ruler in a word processing
program. (See ntler)
scale tool The icon on the Microsoft Word ruler
that toggles between the norm al sca le, page
scale, and table scale. (See also page scale,
table scale)

scatter c h art A chart that is used to show the
degree of relati onship between values in
different data series.
Scripting level The high est u ser level in
HyperCard that allows access to programming
(or scripting) in HyperTalk. It also allows
access to all the other features of HyperCard.
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scripting The process of modi fying the script of
a n ob ject in Hype rCard . Every item has a
script, although som e may be em pty.
scro ll arrow An outline o f an arrow located o n
each end of a scroll bar. Clicking a scroll
arrow causes th e contents of the w indow to
scro ll o ne line cl oser to th e end of th e
document to which the arrow po ints. Pressing
a scroll a rrow causes the contents o f the
w indow to scroll continuously, o ne line at a
time, in the d irection po inted to by the arrow.
(See also scroll bar, scroll box)

scroll bar A rectangular bar that may be o rien ted
vertically along the left o r right edge of a
window, or h orizon tally alo ng the top or
bottom edge. Normally vertica l scroll bars are
o n the right, a nd ho rizontal scroll bars are
along the bottom. Clicking or pressi ng in the
scroll ba r causes the contents of the window
to move a screenfull at a time. The directio n
of the scro ll depends o n the locatio n of the
scro ll box. (See also scroll arrow, scroll box)
scroll box The white square box in the scroll bar.
The scro ll box is a lso known as the thumb or
e levato r button. Th e positio n of the scro ll
box in the scroll bar gives a relative indicatio n
of whe re the contents of the window a re
located in relation to the correspo nding edges
of the document. For example, in a vertica l
scro ll bar, if t he scroll box is approximately in
the middle of t he scroll ba r, the n the window
is sh owi ng approximate ly the middl e of the
documen t from to p to bottom (or begin ning
to end). l n order to quickl y m ove to a particular
part of th e document, you ca n drag th e scroll
box to the relative position desired. This is
especially useful when going to the to p
(beginning) o r bo tto m (e nd) o f a lo n g
document. (See also scroll arrow, scroll bm)
search and re place A feature in ma n y word
processing program s tha t allows you to
auto ma ti cally locate o ne o r all occurre nces o f
a particular wo rd a nd replace it wit h a
d ifferent word.
sea rch c rite ria The value or phrase en tered in to
a find com ma nd that is used to locate any
m atch in g data.
sectio n An y part of a document th at is designated as separate from an other part. Asectio n
ca n be compared to a ch apte r in a book; a

chapter is a part of the whole book, but it is
also separate from other chapters. In Microsoft
Word, a document can be d ivided in to o ne or
m o re sections and each section ca n be
formatted di fferently from other sections in
the same document. Sectio ns are separated
by section break m arke rs. (See alsosect ion break
marker)

section break marker The double do tted line
that runs across the w idth of a document in
Microsoft Word th at ind icates th e d ivision of
two section s. Th e section break comma nd is
Command-Ente r. (See also section)
select W hen using the Maci ntosh, you generally
select an object and th en issue a command
which will operate o n tha t ob ject. How
som ething is selected is similar across all
applications. Selecting occu rs in several ways
depend ing o n t he program in use. (! )Alt hough
not common ly though t of as a selection,
positioning the insertion point is the selection
of the location where the n ext action will
occur. (2)To select an icon, click o n it. (3)To
select several icon s, click above t hem and
then drag the selection rectangle aroun d all
of them. (4)Selecting text ca n occur by
wiping through text, double clicking on a
word, dragging t h rough several lines, and
other m ethods, depend ing o n th e progra m .
Selected text is h ighlighted, or inverted. (See
also highlight)

selection a rrow The tool in Mac Draw, located at
the to p of th e tools palette, that is used to
select objects.
sel ection bar Th e a rea located at the fa r left of a
Microsoft Word document that is about 1/8inch wide and that en ables you to select large
blocks of text.
sel ection recta n g le Also called the selection
marquee, the MacPain t too l that is used for
selecting objects and tha t also selects the
background around the ob ject. (See also lasso
selection tool, marching ants)

selection squares Sma ll black squares t hat appear
at the corners of a graph ic ob ject to indicate
the o b ject is selected. (See also handle)
sequential access The method of accessing
info rmation in a file whe re all preceding
information must be read first. (See also random
access and direct access)
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Shift key A modifier key that affects character
keys. When used with an alphabetic key, it
produces the upper case letter. When used
with a numeric or symbol key, it produces the
character shown on the top of the key. This is
similar to the Caps Lock key except that it will
affect all keys and not just alphabetic keys.
(See also Shift-click)

Shift-click A selection technique that allows you
to extend the area of a selection. (l)When
used with text, you click at the first location,
scroll to the final position and click the
mouse button with the Shift key depressed.
This will extend the selection from the first
click to the final position. (2)When used with
icons or objects, it allows an icon or object to
be added to, or removed from, the current
group of selected icons or objects.
Show Size command A MacDraw command
that displays the size of an object as it
is drawn.
slide control handle A tool used for moving to
a different record or layout in FileMaker.
Sliding objects left In FileMaker, used to keep
fields and punctuation next to preceding
fields on the same row.
Sliding objects up In FileMaker, used to eliminate
blank lines when fields are empty or the
information in a field does not fill the field.
Sliding part up In FileMaker, used to eliminate
empty space in a printed report after objects
have slid up.
smooth To round the sharp angles in an object
into curves.
snap Aligning of an object or text to a grid
boundary.
soft copy When information is presented only
on the screen of the computer. Hard copy is
when information is printed on paper.
soft return A carriage return that causes the
insertion point in a word processing program
to move to a new line but does not create a
new paragraph. In Microsoft Word, a soft
return is created with the Shift-Return keys.
(See also hard return, irysertion point, new
line command)

softwar Software is synonymous with program,
whic is instructions the computer follows
when accomplishing a designated task.
Software is the intangible part of the computer,
as opposed to the physical part which is
known as hardware. (See also application
program, hardware, system program)

sort Placing items in a predetermined
alphabetical, chronological, or numerical
order.
sort field A field whose contents are used as the
basis for sorting a file or stack.
source disk The original disk being copied or
moved to a new destination. (See also
destination disk)

spelling checker A utility program that
determines if a word is spelled correctly by
comparing each word in a document with
the entries in its dictionary. If the word
matches a dictionary entry, the spelling
checker considers the word correct. If the
word is not in the dictionary, that word is
considered misspelled.
split bar In Excel, the small black rectangle
located at the top of the vertical scroll bar and
on the left of the horizontal scroll bar. It is
used to split the window into two or four
panes so different parts of the worksheet can
be seen at the same time.
spray can tool A tool in MacPaint that paints in
a "mist" of the currently selected patterq..
spreadsheet A general classification of applications that are used for numeric analysis
such as finance, budgeting, and other business
uses, as well as other uses such as engineering
and scientific calculations. Information in a
spreadsheet program is organized i~to
columns and rows. The intersections of these
columns and rows are called cells. A
spreadsheet application is also known as an
electronic spreadsheet program. (See also cell,
column, row)

I
stack A ryperCard document containing a group
of cards.
stackin~1 order The position of objects in front or
beh nd other objects.
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startup disk Th e d isk the computer reads from
when the system is first turned o n . This disk
must h ave a System file and usually a Finder.
It also will contain printing resources, desk
accessories, fonts, fkeys, sounds, a nd other
systems software. If mo re tha n o n e of the
disks attach ed to the computer h as a system
fil e, the one that is currently active is kn own
as the current startup d isk. In the Finder, this
disk is the o ne on the very to p right of the
screen . All o ther disk icons w ill be located
below the startup disk. If the re is a flo ppy disk
inserted into on e of the floppy disk drives, it
will take precedence as the startup disk over
the h ard disk. If you have m ore th an one SCSI
hard disk attached to your computer, and if
your Maci ntosh is an SE or Mac II then yo u
can ch ange the startup disk by using the
Control Pa ne l desk accessory.
status area An area on the left side o f FileMaker's
browse screen that sh ows the number of
records in the file, whether or not they are
sorted, and the number of records that have
been found by the last Find command.
status bar An area at the bottom of the Excel
screen that shows information about t he
current activity or mode.
string literal In programming or scripting, a
"string" or group of text enclosed in quotation
marks, as opposed to a string variable.
style In word processing programs, a group of
formatting c ha racteristics that have been
assigned a name. The style n ame is the name
these characteristics have been assigned. Style
can also refer to the ch ange in the overall
impression o f a font, such as bold, italic,
und e rlin ed, o utlin ed, s h adowed, an d
combinations o f these.
style sheet A group of styles attached to a
document. Transferring style sh eets to other
documents en ables different documents to
h ave a consistent ap pearance. (See also style)
Sub-summary part A part of a layout used to
d isplay or print summary info rmation when
a fil e has been sorted by the contents o f a
specified field.
summary field A fie ld that conta ins a numeric
summary o f all the va lues in a field across a
group of records.
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summary report A report that prints only
summary information without printing any
de tail for each record. (See also detail report)
System Folder A special folder on the startup
disk th at contains the System file and a ny
n ecessary reso urces t o inte rface w ith
pe ripherals, such as printers . (See also

peripheral, startup disk)
system program There are two basic types of
programs: applica tion and system programs.
Asystem program is a program wh ich con trois
the inte racti on of the hardware devices, or
a llows the user to control information storage
o n the system . It is not designed to let the user
perform a task li ke write a letter. Instead, it is
designed for tasks the computer must perform.

(See also application program)
system software The files, resources and
applicatio n s-normally located in the System
fo lder-wh ich are used by the Yfacintosh to
m ake itself run .
T-squares A Gadget available in FileMaker's
Layout mode fo r aligning objects ho rizontally,
vertically, o r both.
tab leaders A series of characters that lead up
to a tab position. Tab leaders make it easier
for the eye to fo llow the area between the
tab positions.
tab setting The positio n to which the insertion
point advances when the Tab key is pressed.
Also called a tab sto p.
table An arrangement o f rows and columns of
data. In Microsoft Word, the inte rsection of
a row and a vertically aligned column in a
table is a cell.
table scale The ruler scale that is displayed in
Microsoft Word w hen the insertion point is
in a table and the scale tool is clicked . When
in table scale, the width of columns can be
modified. (See also page scale)
tables feature A feature in Microsoft Word that
a llows the creation of tables in which each
cell can con ta in text or graphics and ca n
be form atted using any character or paragraph formatting option. (See also cell, table,

table scale)
tear-off menu A menu that can be detached
from the menu bar by dragging past the
bottom of the menu . When the menu
becomes de tac hed it is known as a palette.
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Tell Me ... button A button in HyperCard that
looks like a cartoon's dialog balloon. Clicking
this button generally provid es more
information about the stack and how to
use it.

trackbal An input device that is used similarly
to a mouse, but instead of pushing the mouse
on a desk and causing the ball inside to move,
the trackball offers a ball that you can move
directly. (See also mouse)

template A document that contains predefined
contents. This can be a word processing
template, spreadsheet template, or some other
type of template. It is designed to be used for
tasks that are often repeated so you don't
have to create the document from scratch
each time.

transparent object An object created in a drawing
program that has a transparent fill pattern,
making it possible to see other objects beneath
the transparent object. (See also fill)

text alignment The positioning of text relative
to the horizontal and vertical margins in a
document. Text alignment can include
horizontal alignments such as flush left, flush
right, justified, and centered, and vertical
alignments such as centered between the top
and bottom margins. (See also alignment, flush
left, flush right, justification)
text entry The process of typing text into a
document.
text field A type of field in FileMaker and
HyperCard that holds text.
text Information presented in the form of readable characters.
text tool The tool in graphic programs, such as
MacPaint and MacDraw, that is used for typing
text into a drawing.
title bar The horizontal area at the top of a
window that shows the name of the window
and is an indicator of whether or not that
window is active. When the window is the
active window, the title bar has a series of
horizontal lines; when the window is not the
active window, the lines are not present.
A window may be moved on the screen
by clicking in the title bar and dragging
the window to a new location. (See also
active window)
toolbox The menu in MacPaint that contains
the tools that are used to create lines, shapes,
and other drawing elements.
tools palette The group of tools that runs down
the left side of the MacDraw drawing window
and that are used to create ob jects in a
MacDraw document.

Trash An icon located o n the lower right corner
of the screen that looks like a trash can. When
you wish to throw an application or document away, you drag its icon into the trash
can. When there is nothing in the trash, the
sides of the can are straight; and when there
is something in it, the sides appear to bulge.
Files may be removed from the trash can
and replaced on the desktop until the trash
is emptied-either by starting an applicatio n, choosing Shut Down from the Special
menu, or choosing Empty Trash from the
Special Menu.
Typing level A user level in HyperCa rd that
allows browsing the stack and entering and
editing text in fields.
Undo command Acommand in most Macintosh
applications that allows you to undo the last
action of the mouse or the last com mand or,
in word processing programs, the last typing
or formatting action.
unfilled In MacPaint, filled or unfilled shapes
can be created depending on the tool selected.
A filled shape is fil led with the currently
selected pattern as it is drawn; an unfilled
shape is not filled with a pattern when it is
drawn. (See also currently selected pattern, fill)
Unsmooth command A MacDraw command
that changes a polygon or freehand shape
th at ha s b ee n smoothed back to its
o riginal form. (See also freehand tool, polygon
tool, smooth)
user lev~l A setting in the Preferences card in
Hype Card's Home stack that lets you set the
arnot nt of access you want to HyperCard's
tools commands, and features. The five user
level (from least access to most access) are:
Brow ing, Typing, Painting, Authoring, and
Scrip ing.
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video display terminal (VDT) An output device
that can receive signals by direct connection
to a computer or other video source, but
cannot receive transmitted signals.
visual effect A visual transition that takes place
on the screen in HyperCard between closing
the current card and opening the next card
that will appear.

word wrap The process of auto matically causing
a wo rd to drop to the begin ning of the next
line if it won't fit at the end of the current
line. Especially useful in a word processor, it
is a common feature of almost all windows,
text boxes and o ther places where text may
be edited on the Mac. Wo rd wrap lets you
continue typing, without regard to how much
text will fit on a particular lin e. The only time
you have to type the Return key is at the end
of a paragraph o r when you want to create a
blank line.
wristwatch pointer The po inter you see o n the
screen when the Macintosh is performing a
length y operation . You can interpret it to
mean, "Wait C} minute, I'm busy."

what if... analysis The process of analyzing
alternat ives u sing a spread sh eet. This
commonly involves changing parameters in
the spreadsheet to answer questions that begin
with "What if...".

Zoom In command A MacPaint command that
magnifies the view of a drawing jn 200%
increments, up to 800% of the actual (100%)
size. (See also FatBits, magnify, Zoom Out
command)

wide area network A system of local area
networks that are interconnected over a wide
geographical area, usually using the services
provided by a commo n carrier.

Zoom Out commanq A MacPaint command
that reduces the view of a drawing in 200%
increments, down to SO% of th e actual
(1 00%) size. (See also FatBits, magnify, Zoom In
command)
zoom box Th e white square on the righ t side of
many window title bars. Clicking in the zoom
box causes the window to expand to fill the
screen. Clicking again will resize the window
to its original size. (See a(so title bar, window)

value Generally used to mean a numeric quantity.
HyperCard stores all values as text strings,
but can still perform mathematical operations
on values that represent numbers.
variable The symbol used in a program or script
to store text or a numeric value.
vertical split bar (See split bar)

widow A widow occurs when the first line of a
paragraph appears by itself at the bottom of
a page and the rest of the paragraph is on the
next page.
window The area on the Macintosh's screen
through which you h ave access to data.
Opening a disk causes a window to open
which shows the contents of the disk. Opening
a document on the desktop opens a window
which allows you to edit the contents of that
document. Windows may be opened, closed,
moved, resized, and the contents of the
wind ow m ay be scro lled, m ove d and
mod ified.
wiping through text Positio ning the 1-beam
pointer to the left of text an d dragging to the
right to select the text in the path of the 1beam pointer.
word processing The process of using a computer
to ente r, ed it, forma t , and print t ext
documents. (See also editing, fo rmatting, text
entry, printing, word wrap)

zoom controls The contro ls in the lower left
corner of the MacDraw tools palette that
reduce and magnify the view of a d rawing
from 3.1 2% of the actual size to 3200% of the
actual size. (See also magnify, tools palette, zoom
percentage box)
zoom percentage box The box beneath the
zoom controls on the MacDraw tools palette
that refl ects the current view size of the
d rawing. (See also magnify, zoom controls)
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Deletin g 454
Inserting 454
Save 371, 378
Save As 371
Saving yo ur work 371
Selecting
Cells 406, 447
Colu mn 380
Entire worksheet 447
In d iffe rent pan es 445
Multiple selectio ns 40 6
Using Command key 406
With Shift key 445
Split ba rs 362
Sta rtin g 361
Status bar 363
Tab key 375
Templa te 374
Text365
Entering 374, 375, 425

Index

Formatting 411
Font 411
Size 411
Style 411
Truncation of 377
Vertical split bar 362
What if... analysis 398
What if... exercises 398, 399,
400,401,421,440,459
Window 414
Activating 432
Active 432
Menu 432
Moving 414
Resizing 414
Vertical split
Selecting cells 445
Window menu 432
Worksheet
Linked 431
Updating 431
Linking 421
Parts of 361
Selecting entire worksheet
447
Exception report 471
Expansion port (See Hardware)
Expansion slot (See Hardware)
Exploded pie ch art 357
Fat Bits 643
Field 473
File 9, 199, 473
Field 473
Record 473
File maintenance 472
File management 471
File Management System 472
File menu 9
FileMaker 482
Active record indicator 483
Backing up files 490
Blank report 521
Book 483
Using 484
Browse 492
Browsing 484, 517
Book 518
Scrolling 484
Selecting record 484
Slide control handle 518
Calculation field 566
Closing a file 490
Columnar report 521
Creating
Columnar report 524, 529,
540
New file 496
New layout 527
New record 508
Custom menu 486
Damaged files 489
Data
Automatic entry
Overriding 509
Duplicating 513
Editing 513
Entering 506, 569, 594
Automa tically 507
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From a list of values 506
Tab order 592
Date
Form atting 583
Define 492
Defining fields 493
Deleting
Record 516
Detail report 521
Duplicating
Layout 604
Record 513, 515
Editing
Data 513
Entering
Data 506, 594
Tab order 592
Field 493
Calculation 495, 566
Finding 495
Formatting 592
Formula 545
Indexing 495
Placing 591
Sizing 591
Sorting 495
Text 544
Date 494, 561
Calculation 494
Formatting 494
Restrictions 494
Sorting 494
Defining 493, 496, 560
Entry Options 497
A new serial number 502,
560
Auto matic entry 500, 501,
502
List of values 497, 498, 503
Look up values from
another file 562
Require value 499
Today's date 501
Unique value only 561
Value in range only 503
Indexing 493
Key 562
Lookup 558, 562, 563, 564,
565
Maximum number of 493
Naming 497
Number 493, 560
Calculation 494, 568
Finding 494
Formatting 494, 581, 592
Indexing 494
Yes or No 494
Picture 494
Placing 528
Repeating 567
Formatting 584, 585
Resizing 528
Selecting 506, 593, 604
Clicking 506
Using Tab key 506
Summary 495, 609
Change in results 495
Defining 609
Formatting 610

Sorting 613
Text 493
Calculation 544
Finding 493
Formatting 580
Resizing 5 77
Sorting 493
Field definitions
Printing 519, 550, 598
File 493
Backing up 560
Closing 490
Creating 560
Creating a new file 496
Damaged 489
In terconnecting 558
Sorting 525
Switch lookup file 564
Find 492, 614
Dates in a range 614
Find All 516, 615
Finding
Information 514
Record 514
Formula
Entering 545, 546
Function 548, 567
Logical operators 545, 547
Mathematical operators 545,
547
Summary field 610
Text 545
Concatenate 545, 548, 549
Text operators 547
Function
ROUND(,) 567
SUM() 567
Gadgets 531, 553
Invisible Grid 586, 591
T-squares 587, 588
Magnetic 588, 589
Tab order 593
View as list 531, 532
Graphics 528
Importing 528
Line 589, 592
Line width 586
Moving 571
Pasting 528, 571
Placing 528, 571
Resizing 528
Help 485, 488, 533
Arranging Info rmatio n 588
Command-/ 485
Find 487, 533, 534
Search criteria 487
Finding topics 487
Formulas 546, 547
Function 548
Logical o perators 547
Mathematical operators 547
Opening 485
Scripts 486
Icon 482
Label report 521
Layout 492
Aligning objects 588
Blank 570
Add ing fields 576
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FileMaker (continued)
Creating 570
Body 532
Columnar
Creating 529
Creating 527
Date 535, 539
Default 504, 525, 526
Duplica ting 604
Field 525
Calculation 591
Choosing 530, 540
Date 583
Deleting 604
Fo rmatting 580
Moving 553, 578, 608
Repeating 584
Selecting 593, 604
Selecting multiple 553
Tab order 592, 593
Text 579
r:oo ter 533
Gadgets 553
Column Setup 554
Invisible Grid 554
Slide Objects 554
Slide Ob jects Left 555
Slide Objects Up 555
Slide Parts Up 555
Graphi cs 525, 571
Line 586, 587
Rectangle 586, 590
Header 532
l.ahel
1-up 550
3-up 550
Adjusting fields 552
Creating 551
Defining 551
Dimensions 550, 551
For dot-matrix printer 556
For laser printer 556
Vertical Page Alignment
556, 557
Mailing labels 544
Modifying 538, 604
Page number 535, 539
Pa rt 605
Adjusting 605, 606, 608
Body 605
Footer 605
Grand Summary 611
Header 606
Placing 607
Sub-summary 607, 613
Placing
Field 525
Graphics 525
Text 525
Standard 504, 525, 526
Text525, 538
Aligni ng 538
Moving 538
Text labels 573, 575
Alignment 575
Formatting 574, 579, 591
Moving 606
Placing 579
Time 535, 539

Index

Title Footer 533
Title Header 533
Vertica l 504
Lookup field 562
Menu 526
Custo m 486
Select 526
Layout 526
Modes for working 492
Number
Calculatio n 566
r:o rmatting 581
Alignment 584
Commas 582
Dollar notation 581, 582
r:i xed number of decimal
digits 581, 582
Percent no tation 581
Yes or No 581
Opening screen 483
Part 528
Add ing 528
Body 528
Footer 528
Grand Summary 528
Header 528
Placing 528
Resizing 528, 5 72
Sub-summary 528
Title Footer 528
Title Header 528
Pasting
Graphics 528
Preview 536, 556, 613, 616
Full sized view 536
Reduced view 536, 537
Printing 519, 543, 558, 598
Field definitions 519, 550,
598
Report 539
Project 1 490
Pro ject 2 521
Project 3 558
Project 4 602
Quitting 490, 516
Record 493
Deactiva ting 512
Deleting 516
Duplicating 513, 515
Find All 516
Finding 514
New 508
Scrolli ng 484
Selecting 484
Repeating field
Fo rmatting 584
Report 521
Blank 521
Columnar 521, 540
Creating 524, 529, 540
Detail 521
Label 521
Mailing labels 544
Printing 539, 543
Sorting 613
Summary 521
Save a copy 505
Saving your work 489
Problem s 489

Screen
Active record indicator 483
Book 483
Slide control handle 483
Status area 483
Scripts 486
Scrolling 484
Select Menu 526
Layout 526
Selecting
Record 484
Slide control han d le 483, 484
Sort492, 541,542,615
Alphabet ical order 542
Ascending 542
Chronological order 542
Descending 542
umeri cal value 542
Sort fi eld 542
Unsort 604
Sorting 541, 557
Starting 482
Status area 483
Sum mary field 609
Summary report 521
Switch lookup file 564
Text
Concatenate 544
Tool
Arrow 527
Field 528
Line 527
Oval 528
Part 528
Rectangle 528
Rounded rectangle 528
Text 527
Tools
Palette 527
What's what o n the screen 483
Filled 57
Finder 2, 37
Floating window 716
Folder 3
Closing 10
Creating 27
Naming 27
Directory window 6
Do uble-clicking 6
Duplicating 29, 30
Erasing 30
Wa rning 31
Final Projects 32
NewS
Opening 6, 28
System Folder 5
Folders
Nesting 7
Font 60
Bitmapped 212
Downloadable 42
LaserWriter 212
Outline 212
point size 60
Formatti ng 201
Formatting a d isk 12
Formula 353
Graphical user interface 2

Index

Graphics
Analytical 355
Bitmapped 48, 637
Object-oriented 48
Presentation 355
GUI 35
Hanging indent 264
Hard carriage return 199
Hard copy 42
Hardware 36, 37
68000 37
68020 38
68030 38
68040 38
Cable 40
Central Processing Unit 37
CPU 37
Electron ic circuit board 40
Expansion port 40
Expansion slot 40
Keyboard 40, 41
Memory
Bit 39
Byte 39
Kilobyte 39
Megabyte 39
Permanent 38
RAM 38
ROM 38
Temporary 38
Volati le 38
Microprocessor 37
Modem 42
Baud rate 42
Monitor 41
Black and white 41
Color 41
Pixel 42
Mouse 40
Mouse button 40
Periphera l 40
Printer 42
lmageWriter 42
LaserWriter 42
PostScript 42
Storage 43
Backup 43
Disk 43
Flo ppy 43
Hard 43
Tape 43
Trackball 40
Highlight 10
Highlighted 56
HyperCard
Adding cards 672
Application
Openin g fro m HyperCard
708
ASCII 658
Autho ring 632
Back 619
Background
Copying 666
Creating 682
Field 636
Multiple cards 628
Na ming 71 2
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Picture 637, 682
Background command 683
Backgro und layer 628
Backing up 627
Browsing 632
Butto n 618, 629
Background 629, 693
Calendar 674
Card 629
Clearing 634
Clicking
With Command and
Optio n keys 700
Copying 634, 693
Creating 633, 693
Cutting 634
Deleting 634
Dial 674, 675
Dragging 695
Duplicating 634
Copy and Paste 634
With Option key 634
Find 624
Home 647, 674
Info 635
Left Arrow (Previous) 624
Linking to a card 629, 717
LinkTo 716
This Card 716
Ma rching ants 633
Moving 634
Next 64 7
Pasting 695
Previous 64 7
Print Report button script 720
Resizing 634
Return 624, 65 1
Right Arrow (Next) 624
Script 720
Selecting 633
Selection 634
Showing with CommandOption 620
Sort 674, 675
Sort button script 720
Style
Transparent 715, 718
Tell Me ... 647
To Do 674
View 6 74
Card 627, 628, 629
Background layer 628
Card layer 628
Field 636
Hom e 630
Linking 715
Maximum n umber of 627
Nex t 628
Picture 637, 659, 663
Previous 628
Printing 674
User Preferences 664
Card layer 628
Caution
Browse tool
Automatically changing to
card layer 692
Field placement on layers 636
Command key

Brush tool 639, 641
Button tool 633
Eraser tool 641
Field tool 635
Spray tool 639
Command-? 622, 627
Command-Option 620, 635
Creating
Background 682
New Stack 665, 680, 71 1
Copy current background
683
Copyi ng background 666
Data
Entering 671, 672, 673, 702
Deleted 668
Dialing 679
Draw Filled
Toggle command 645
Dynarnlc links 65 7
Edit menu 634
New Card 672
Entering
Data 671, 672, 673, 702
Fat Bits 643
Field 635
Background 629
Creating 688
Background layer 636
Card layer 636
Caution 636
Clearing 636
Copying 636
Creating 635, 636
Background 688
With Command key 635,
688
Cutting 636
Deleting 636
Warning 636
Double-clicking 670
Duplicating 636
Font 669
Size 669
Information 636
Insertion point 671
Moving with Tab key 671
Modifying 667
Moving 668, 689
Naming 670
Pasting 636
Resizing 668
Automatic text reflowing
689
Scrolling 691
Selected
Ma rching ants 668
Selecting 635, 636
Marching ants 635
Show Lines 668
Style 668
Rectangle 6 70, 691
Scrolling 691
Text 628, 635
Formatting 628, 635
Find 619, 624, 625, 626
Finding
Capitalization 66 1
Text 660, 661, 662
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HyperCard (continued)
Floating wi ndow 629, 716
Go menu 618
Back 619
Find 619
First 619
Help 619, 627
Home 619
Last 619
Message 619
Next 619
Previous 619
Recent 619, 694
Hand po inter 633
Help 619, 621, 622, 627
Asterisk 623
Browse 622
Command-? 622
Exit 627
Find 626
Glossary 623
Index 623, 624
Index tab 622
Ho me 617, 630
Ca rd 617, 618
Adding 630
Look fo r applications in
631
Look for documents in 631
Look for stacks in 630
Stack 617,618
1-ly perTalk 618, 681
Scripting 681, 696
Continued line character
719
Visual Effects 697
!-beam pointer 633
Icon 617
Layer 628
Background 628, 634
Card 628
Linking 629, 715, 717
Cards 715
Marching ants 635
Menu
Edit
Backg round 634, 683
Clear Butto n 634
Copy Button 634, 693
Copy Picture 683
Cut Button 634
New Card 672
Paste Button 634, 695
Paste Picture 684
Text Style 640
Undo 695
File
New Stack 665, 683
Open Stack 700
Print Report 677, 718
Go 618
Recent 694, 695
Objects 664
Bkgnd Info 712
Button Info 634
Field Info 636, 668
New Background 713
New Button 633, 688
New Field 635

Index

Stack Info 666, 707
Paint
Fli p Horizontal 684
Patterns 637
Tear-off 637
Tools 63 7, 664
Men u bar
Appearance
Background layer634, 683
Card layer 634
Message 619, 624
Miniwindow 716
Naviga ting 618, 619
Ob jects men u 633, 635
Field Info 636
Option key
Button tool 634
Curve tool 645
Oval tool 642
Po lygon tool 645
Rectangle tool 642
Selectio n tool 638
Painting 632
Over a field or button 637
Palette 637
Patterns 637
Showing and hiding 640
Positio ning 637
Tools 637, 683
Path names 631
Pattern
Alignment with top left edge
of card 686
Patterns menu 637
Phone dia li ng 653, 679
Modem 680
Speaker 679
Picture 637
Background 637
Card 637, 659, 663
Dragging 684
With Shift key 685
Pointer
Arrow 638
Cross beam 638
Hand 633
!-beam 633
Lasso 638
Printing
Card 674
Columns report 678
Labels report 678
Report677, 708,718
Rows repo rt 678
Stack 676
Pro ject 1 655
Project 2 664
Pro ject 3 680
Project 4 711
Quitting 656, 663
Recent 619, 694
Report
Columns report 678
Labels report 677, 678
Printing 677, 708, 718, 719
Rows report 678
Saving your work 627
Script 696
Editi ng 700

Scripting 632, 720
Continued line character 719
Optio n-Return 719
Print Report button scri pt 720
Return key with Optio n key
719
Sort button script 720
Visual Effects 697, 699, 700
Search ing fo r text (See Find)
Shift key
Brush tool 639
Dragging Picture 685
Line tool 644
Oval tool 642
Pencil tool 643
Polygon tool 645
Rectangle tool 642
Regular Polygon tool 642
Spray tool 639
Sort 675
Sorting 674, 675, 707
Stack 627, 628, 646
Address 652
Buttons 674
Art Ideas 646, 647, 649
Clip art 648
Ho me button 647
Index 646, 648, 649
Metric Equivalents card 649
Nex t butto n 647
Open ing 646
Previous button 647
Tell Me ... button 647
Button Ideas 650, 681, 693,
701
Index 650
Calendar 652, 653
To Do list 653
Class Notes
Assignments field 691
Class field 691
Date field 69 1
First button 695
Last button 696
Next button 696
Notes field 691
Previous button 696
Prin t Report button 696,
708
Print Report button script
720
Pri nting 708
Sort button 696, 708
Sort button script 720
Sorting 708
Class Notes Buttons 681, 696
Print Repo rt button 681,
697
Scripts 697
Sort butto n 681, 697
Company Orga nization 711
Chart background 712
Directory background 713
Ho me button 715
Orga niza tio n Chart button
717
Transparent buttons 715,
718
Creating 665, 681
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Index

Creating a new stack 680
Glossa ry 636, 655
acronym ca rd 658
Add itional notes field 656
ASC II ca rd 658
Card picture 659, 663
Defin iti ons field 656
Dynamic links 657
Dissolv ing 658
Find button 657, 660
Hide Picture button 657,
659
Ho me butto n 656
jumping to related terms
658
Navigating 657
Next button 657
Previous bu tto n 657
Return button 657, 659
Retu rn ing from related
term s 658
See also field 656
Show Picture but ton 656,
659
Sort butto n 657
Tell Me ... bu tton 657
Term field 656
Help 621
Home 630
lntro 619
Modifying 664
Pho ne 653, 654
Area codes 653, 654
Find ing area codes 654, 655
Local call 680
Long-distance call 680
Preferences 654
Prin ting 676
Header icons 676
Resource 645
Button 645
Icon 645
Picture 645
Sound 645
Sorting 674, 707
Stack Ideas 650, 665, 682
Computer paper
background 65 1
Com puter paper card 682
Index 650, 65 1
Return butto n 65 1
Visual Effects 681, 698
Dissolve butto n script 699
Scripti ng 699
Starting 617
Double-clicking stack icon
656
Tab key
Selecting field 67 1
Telephone d ialing 653
Text
Maxi mum characters 629
Maximum number of 629
Text field 628
Tool 632
Browse tool 632, 633
Auto mati ca lly changing to
card layer 692
Brush too l 639

Ch anging shape 639
Constrain 639
Con vert to eraser 639
Double-clicking 639
Using 639
With Command key 639
With Shift key 639
Bucket tool 639,686
Black areas 640
Do uble-clicking 640
Filled areas 640
Pattern misalig nment 686
Po uring pattern 686
Spill recovery 640
Spills 640
Using 639
W hi te areas 640
But to n tool 632, 633
Double-clicki ng 635
wit h Command key 633
Cu rve tool 644
C hangi ng line width 645
Double-cl ick 645
Draw Filled 644
Patterned border 645
Used 644
With Option key 645
Erase r tool 641
Constrai n 686
Double-clicking 641
Ex posing background
picture 641
Painting instead o f erasing
64 1
W ith Command key 641
With Shift key 686
Field tool 632, 635
Double-clicki ng on 636
General tools 632
Lasso tool 638, 687
Changing pa ttern in filled
area 640
Dragging 638
Uses of 638
Li ne tool 644
Changing li ne width 644
Constrain 644
Double-clicking 644
Using 644
W ith Shift key 644
Oval tool 642
Circle 642
Constrai n 642
Optio ns 642
Us ing 642
Pai nt text tool 640, 690
Align men t 640
Correcting 640
Double-clicking 640, 686
Fo n t 640
Line heig ht 640
Size 640
Style 640
Text Style d ialog box 641
Unable to Find 641
Pain ting
Selecting last o bject 641
Wi th Command-S 641
Pain ting tools 633, 637

Similarity to MacPaint 637
Pencil tool 643
Black painting 643
Constrain 643
Double-clicking 643
Edi ting individual pixels
643
Fat Bits 643
Whi te painting 643
Wit h Shift key 643
Polygon tool 645
C hanging line wid th 645
Completing polygo n 645
Constrain 645
Differen t fro m o ther tools
645
Double-clicking 645
Pa tterned bo rder 645
Using 645
With Option key 645
With Shift key 645
Rectangle tool 64 1
Borderless 642
Changing line wid th 642
Constrain 642
Draw Cen tered 641
Draw Filled 642
Pa tterned border lines 642
Square 642
Using 641
Wit h Optio n key 642
Regular Polygon tool 642
Constrain 642
Double-cl icking 642
Draw Centered 642
Rotati ng 642
Selecting a shape 642
Using 642
With Shift key 642
Rou nded Rectangle tool 644
Like Rectangle tool 644
Using 644
Selection tool 638
Changing pa ttern in filled
area 640
Double-clicking 638
Dragging 638
Uses of 638
With Optio n key 638
Spray too l 639
Constrain 639
Convert to eraser 639
Using 639
With Command key 639
With Shift key 639
Text (See Paint text tool)
Tools menu 637
Tools palette 683
Typing 632
Undo 640, 695
User level 63 1
Authoring 629, 632, 664, 682
Browsing 632
Pa inting 632
Scripting 629, 632, 682, 700
Setti ng 664
Setting fro m Message box 700
Typing 632
User Preferences ca rd 664
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HyperCard (continued)
Visual Effects 697, 698
Barn Door 698
Checkerboard 698
Dissolve 698
Iris 698
Plain 698
Scri pting 699
Scroll 698
Venetian Blinds 698
Wipe 698
Zoom 698
Warning
Deleting fields 636
Window
Floating 629, 637, 716
Miniwindow 716
Hyphenation dictionary 199
1-beam pointer 5, 60, 151, 212
Icon 4
Deselecting 26, 2 7
Dimmed 17
Document
Moving 22
Folder
Moving 27
Trash
Bulging 30
Information 471
Information Management 468
3 x 5 cards 468
Adding records 478
Business 469, 470
Common carrier 475
Com municating over phone
lines 476
Concepts 468
Creating reports 480
Database 473
Database Management System
473

Deleting records 478
Editing records 4 78
Field 473
Example 474
Key 473, 475
File 473
Example 473, 474, 475
File Management System 471,
472

FileMaker 482
HyperCard 617
Local area network 476
Management Informati on
System 472
Microcomputers 476
Organizing information 477
Performing calculations 478
Personal 468
Record 473
Example 474
Redundancy 472, 475
Reports 471, 480
Audit trai l 480
Detail 471
Exception 4 71
Paper trail 480
Summary 471

Retrieving records 479
Sorting 479
Sort Field 479
Sorting records 479
Storage 472
Direct access 472
Disk 472
Ra ndom access 472
Sequential access 472
Tape 472
Storing information 477
Uses of 477
Wide area network 475
Insertion point 60, 128, 212
Issuing a command 5
Item 473
jaggies 48
Key
Backspace 27
Delete 27
Enter 19
Return 19
Key field 473
Keyboard 40, 41
Keyboard equivalent (See
Command-key equivalent)
Kilobyte 39
Landscape orientation 201
LaserWriter
Resolution 41
Line chart 358
Line weights 60, 146
Local area network (LAN) 476
MacDraw 124
Active Tool 127
Align command 169
Aligning ob jects
To the d rawing page 180
Using Alignment command
165

Using Autogrid 140
Using Duplica te command
166

Without distributing 174
Alignment command 164
Autogrid
Aligning objects 140
Constraining objects 140
Ruler settings 141
Snap to grid increments 140
Turning off/on 140
Caps Lock key 152
Corner/Cen ter control 131
Deleting objects 128, 129, 146
Distributing objects
Using Alignment com mand
165

Using Duplicate command
166

Document formats 145
Drawing area 125
Duplicate command 147
Automatic alignment/
distribution 166
Duplicating a grouped object

177

Multiple objects 169
Vs. Copy and Paste 148
Filling objects
Existing object 139
Wh ile drawing 139
Formatti ng text 151, 178
Font Menu 15 L, 163
Size Menu 151, 153, 163
Style menu 153, 163
Grid 127
Gridli nes 127, 140
Hide/Show 140
Ruler settings 141
Grouping objects 157
Group command 157
Ungroup com mand 157
Handles 127, 128
Help 126
Icon 125
Layer controls 138
Layers 138
Line weights 146
Changing ex isti ng object 146
Creating new object 146
Pen menu 146
Point size 146
Preset 146
Menu Bar 125
Modifying multiple objects 167,
] 71

Pa ttern palette 129, 139
Changing fi ll pattern 139,
177

Changing line pattern 139,
178

Fill pattern box 139
Line pattern box 139
Preset patterns 139
Scroll arrows 139
Selecting a pattern 130
Transparent (empty) fil l
pattern 144
Pen me nu 146, 162
Pointer
Cross-bea m 127
!-beam 151
Printing 159, 182
Qui tting 159
Repositioni ng objects 130, 145
Reshape command 134, 186
Adding extra points 193
Removing un wanted points
193

Resizing objects 129, 130, 149
Rotate command 190
Rulers 140, 143
Hide/Show 140
Ruler settings 141
Saving your work 126
Scroll box 143, 180
Selecting a tool 127
Selecting objects 137
All objects 145
Multiple ob jects 137, 145,
164

Vs. grouping 164
Opaque 144
Tra nsparent 144

753

Index

Sh ift key
Drawing circles 131
Drawing quarter circles 132
Drawing sq uares 130
Selectin g mult iple objects 145
Deselecting 145
Show Size command 161
Smooth command 134, 136
Stacking order 175
Move Backward comma nd
188
Move To Back com m and 175
Starting 125
Text
Changing background
patte rn 179
Deleting 128, 152
Editing 128, 152
Forma tting 152, 178
Inserting 152
Paragraph 152
Repositioning 128, 154
Rotating 190
Selecting 128, 152
Text wrap 152
Tools 127
Arc 132, 196
Direction o f m ouse 132
Pa rt of circle 132
Part of ellipse 132
Freehand 133, 192
Reshape com ma n d 134
Smoo thing 133
Un smooth com mand 134
Line 129
Deleting 129
Resizing 129
Oval 131
C ircle 131
Polygon 135, 185
Smooth com ma nd 136
Rectangle 129
C ha nging fill pattern 130
Repositio ning 130
Resizing 130
Sq ua re 130
Rounded Rectangle 129
Selecti on arrow 127, 137
Dele tin g objects 146
Select ing ob jects 137, 145
Te xt 127, 152
Dele ting 128
Fonts 151
!-beam pointer 15 1
In sert io n point 128
Tools palette 127
Tra nspare nt ob jects 144
Undo comma nd 146
Uns mooth command 134
Using MacDraw vs. MacPaint
125
Zoom controls 138
En la rging view 139
Reducing view 157
Zoom percen tage box 138, 139
Macin tosh
Mo de ls a nd processors 37, 38

M acitltosh Journey Proj ects dtsk
12, 18, 94, 100, 252, 255, 294,

301, 482, 558, 571,655, 681,
682, 696, 719
MacPaint 52
Active window 102
Actual Size window 75
Aligning objects 67
Bo rder Palette 60
Ca ut io n 56
Closing a d ocumen t 107
Copying a rtwork 101
Deselecting 62
Docu me n t fo rmats 69
Draw
Fro m Cente r 1L8
Fro m Edge 118
Drawing area 125
Drawing with a patterned line
11 7
Duplicating
Copying to the Cli pboard 67
With Option and Com mand
keys 117
With Option and Shift keys
67, 87, 89
With Optio n key 67, 78, 119,
120
FatBits 74, 75
Actual Size window 75
Fill ing objects
Leaks 64
Fli ppin g an o b ject 68
Help 53
Icon 53
Invert com mand 123
Magnify 74
Menu bar 53
Opening a document 100
Pasting 103
Patte rns
Menu 57,63
Palette 57
Pointer
Cross-beam 56
Hot spot 84
!-beam 60
Printing 94, 111
Quitting 94
Revert To Saved comm and 70
Rotating 78, 108, 109
Saving your work 54
Scroll bar 80, 97, 104
Scroll box 80, 97, 104
Selecting
De leting selected object 67
Lasso 62
Lasso vs. Selection rectan gle
62
Selectio n recta ngle 61, 108
Shift key
Ali gn ing objects 67
Con straining a motion 67
68, 7 1, 87, 90, 96, 97, 1i l ,
119, 121
Sn ap to pointer 97
Shortcu ts 76

Starting 53
Text
Deleting 60
Drawing 85
Style menu 92, 104
Typing 91
Titl e bar 74
Toolbox
Positioning 55
Too ls 55
Eraser 56
Ca ution 56
Freehand
Filled 58
Unfilled 58
G rabber 63
Lasso 62, 73
Line 56
Line weigh ts 60
Oval
Circle 58
Filled 58
Unfilled 58
Paint b rush
Brush shapes 59, 81
Pai nt bucket 64, 83
Hot spot 84
Pen cil 56
Polygon
Filled 58
Unfilled 58
Recta ngle
Filled 57
Square 57
Unfilled 57
Ro unded Recta ngle
Filled 57
Unfilled 57
Select ion ma rq uee (See
Selection recta ngle)
Selection recta ngle 61 , 62
Ma rching ants 61
Spray ca n 59
Text 60, 91
Deletin g 60
Fonts 60
Insertion point 60
T race Edges comma nd 115, 116
Un do com mand 70
Usi n g MacPaint vs. MacDraw
125
Zoom In comm and 74
Actual Size (100%) 75
Magnification percent 74
Zoom Out comm a nd 76
SO% size 86
Manage m e n t Inform ation
System (MIS) 472
Megaby te 39
Memo ry (See Hardwa re)
Menu 9
Apple 9
Edit 9
File 9
Pull-down 10
Tea r-off 55
Menu ba r 9

_j
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Menu item 9
Selected 10
Microprocessor 37
Microsoft Excel (See Excel)
Microsoft Word 204
Activating a document 255
Active window 255
Au tomatic date icon 305
Automatic page break 249
Automatic styles 260
Automatic time icon 305
Block quote 242, 244
Indenting 243
Borders
Dialog box 258
Line above and below 302
Plain box 257
Caution 333
Change command 224
Change All 225
Match Upper/Lowercase 225
Special formatting characters
226
Whole Word 225
Changing document margins
242,245,307
Character 205
Character command 231
Character formatting 229
Change existing text 230
Set before typing 230, 271
Clip art 251
Copy command 220
Copying a graphic 256, 301
Creating blank lines 213
Cut command 220
Data document 317
Default tab stops 213, 246
Deleting text 213
Desktop publishing 291
Document command 245
Default tab stops 246
Even/odd header 246
Gutter 246
Mirror even/odd margins 246
Number pages from 246
Widow control 246
Document views 247
Dot leaders 263, 266
Drawing tool 237
Drop-down fields 231
Drop-down list 231, 241
Find command 222
Match Upper/Lowercase 223
Searching whole document
222
Special formatting characters
226
Whole Word 223
First Page Special Header/Footer
299
First-line indent 236
Font 212, 271
Monospace 239
Point size 229
Proportional 239
Footer 303, 304
First Page Special 299
Viewing 307

Index

Footnotes 343
Closing window 344
Opening window 345
Reference mark 344
Formatting domains 204
Full Menus 209
Galley View 247, 310
Hanging indent 264
Header303,304,343
Borders 306
First Page Special 299, 342
Header window 304
Icons 305
Viewing 307
Help
Activating 206
Context-sensitive 207
Extended keyboard 207
Hidden characters 218
Hide Ruler command 233
Hide If command 218
Icon 205
Incorporating Graphics 251
Left indent 236
Line spacing 233, 235
Main document 318
Manual page break
Deleting 249
Inserting 249
Margins 233
Monospace fonts 239
Moving text 220
New-line command (See Soft
return)
Opening a document 254, 256
Outline View 247
Page numbering
Using Header/Footer window
icons 343
Using Print Preview 247
Using section dialog box 298
Page View 247, 3 10
Paginate 249
Paragraph 205, 230
Paragraph command 261
Indents 264
Space after 303
Space before 261, 303
Paragraph formatting 230
Applying 230
Ruler 233
Paragraph ma rker 217
Paste command 220
Pasting a graphic 256, 301
Point size 229, 232
Pointer
Arrow 219
1-beam 212
Print merge 310
Chevrons 322
Conditional printing 324
Data document 316,317
DATA instruction 322
Data records 331
Delimiters 329
Erro r messages 334, 335
Field names 318, 320
Fields 315, 317
Header record

Delimiters 329
Main document 315, 318
Merge fields 319
Formatting 327
Printing 333
Records 317
SET instruction 323
Troubleshooting 334
Print Merge command 318, 332
Print Preview 247, 307
Printing 248, 250, 268
Proportio nal fonts 239
Q uitting 250
Saving before qu itting 250
Right indent 236
Ruler 202, 233
Alignment controls 234
Indent controls
First-line indent 236
Hanging indent 264
Left indent 236
Moving with Shift key 259
Right indent 236
Line spacing controls 235
Paragraph spacing settings
240
Scale tool 241
Norm al scale 241
Page scale 241, 242
Table scale 241 , 279, 289,
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Style Name box 262, 265
Drop-down list 241
Tab settings 237, 238
Center tab 237
Decimal-aligned tab 237
Drawing tool 237
Left-aligned tab 237
Right-aligned tab 237
Using tabs vs. spacebar 239
Save As command 208
Saving your work 207
Searching and replacing 222
Section 205, 29 1
2-column layout 299
3-column layout 300
Columns 298
Balancing length of text
300
Number of 298, 299, 300
Spacing between 298, 300
Viewing 299
Dialog box 298
First Page Special Header/
Footer 299
Header/Footer positions 299
Page number formats 298
Section break
Creating 296
Sectio n break marker 296
Deleting 296
Section marker 205
Start options 298
Selecting a graphic 256, 301
Selecting text 219
Entire document 220, 295
Selection bar 219
Wiping through text 219
Selection bar 219, 221

Index

Arrow pointer 219
Short Menus 209
Show Ruler command 233
Show <J1 command 217
Hard return (paragraph)
symbol218
Hidden characters 218
Soft return (new-line) symbol
218
Space symbol 218
Tab symbol 218
Soft return 215, 236, 275
Space between paragraphs 240
Spelling checker (See Spelling
Utility)
Spell ing dictionary 201
Spelling Utility 227
Adding words to dictionary
229
Checkjng entire document
227
Ignore Words jn All Caps 227
Selected text 227
Suggested words 228
Starting 205
Style 241, 251
Applying Styles 263
Automatic styles 260
Based on field 261
Creating styles 260
Define styles dialog box 268
Define styles prompt 266
Defining by example 264,
265
Defining styles 260
Style name list 262, 263
Style sheet 251
Tab leaders 263, 265, 266
Tab settings
Dot leaders 263
Tab stops 233
Tables 205, 269, 347
Adjusting margins
Table scale 289
Borders 282
Around entire table 282
Every cell in selection 284
Removing 290
Row and column separators
283, 284
Cell 205, 269, 271
Deleting 288
Merging 288
Selecting contents 277
Selection bar 277
Cells command 278
Changing cell alignment 280
Changing column width 278
Changing spacing between
rows 286
Column 271
Creating 272, 274
Creating new row as needed
274
Deleting cells 288
End-of-cell marker 272
End-of-row marker 272
Formatting cells 277
Insert Table command 272
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Colum n width 272
Number of columns 2T(-,
274
Number of rows 272
Insertion point 272
Merging cells 288
Moving back to a cell 275
Moving to new line within
cell 274
Moving to next cell 274
Moving to next row 274
Moving to tab stop in cell
281
Pa ragraph command 286
Row 27 1
Selecting an entire column
280
Selecting blocks of cells 277
Selecting entire table 282
Settin g decimal tabs 281
Table scale
Changing cell margins 279
Changing column width
279
Tables feature 269
Tex t al ignment 233, 234
Centered 234
Flush left (left aligned) 234
Flush right (right al igned)
234
justified 234
Vertical spacing 235
Word wrap 215
Miniwindow 716
Modeling 351
Modem 42, 476
Baud rate 42
Monitor (See Hardware)
Resolution 41
Mouse 4, 40
Button 4
Click 4
Double-click 4
Drag 4
Shift-click 5
Moving
Document icon 22
Folder icon 27
Nesting folders 7
New Folder 8
Object-oriented 49
Object-oriented graphics 48, 124
Opening a disk IS
Palette 55, 127
Paragraph 199, 205
Paste 67, 103
Patterns palette 55
Peripheral (See Hardware)
Pie chart 356
Exploded 357
Pixel 42, 48
Point size 229
Pointer 4, 40
Arrow 5, 219, 638
Cross-beam 56, 127, 638
Hand "633

1-beam 5, 60, 151, 212, 633
Wristwatch 5
Points 60
Portrait orientation 201
PostScript 42, 49
Presentation graphics 355
Print merge 315
Printer 42
Dot-matrix 42
lmageWriter 42
LaserWri ter 42
Program 36
Application 6
Opening 8
Quitti ng 9
Starting 8
Draw 49
Pa int 49
System 6
Pull-down menu 10
Quitting a program 9
RAM 35, (See Hardware)
Random access 472
Record 473
Redundancy 472

Reference Guide to Your
Macintosh 32
Relational database 473
Repeating field 584
Resolution 41
lmagcWriter 42
Better 42
Faster 42
LaserWriter 41
Monitor 41
Return key 19
ROM 35, (See Hardware)
Row 352
Savilig your work
Ca ution 39
Excel 371
FileMaker 489
HyperCard 627
Screen resolution (See
Resolution)
Scripting 629
SCSI 35
Search and replace 200, 222
Search criteria 487
Select 61, 219
Sequential access 472
Shift-click 5
Shut Down command 32, 490
Soft copy 42
Soft return 215
Software 36
Application 36, 37
PostScript 42
System 36, 37
Finder 37
Source disk 18
Spelling checker 201, 227
Spreadsheet 350
Active cell 352
Capabili ties 351
Cell 352

Index
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Spreadsheet (cont inued)
Address 352
Co ntents 352
Formula 353, 355
Function 355
umbe r 353
Range 354
Text 352
Va lue 353
Colu mn 352
Formula 353
Function 353
Argument 353
AVERAGE() 353
SQRT() 353
SUM() 353
Gra phics 355
Analytical 355
Charts
Bar c hart 357
Col umn ch art 357
Data poi n ts 358
Explod ed pie cha rt 357
Line chart 358
Pie chart 356
Presentatio n 355
Mathematical operators 353
Modeli ng 351
Modifying 350
O rganiza tio n 35 I
Range o f cells 354
Row 352
Terminology 352
Uses o f 35 1
What if. .. analysis 351
Stacking o rde r 175
Starting a program 8
String li tera l 545
Summa ry re port 471
Swapping disks 19
System Folder 5

System program 6
System software 36, 37
Tape drive 43
Tear-off m e nu 55, 637
Template 374
Text
Erasing 27
Text alignment 234
Text e ntry 199
Title bar 11
Toolbox 55
Trackball 40
Trash 3, 30
Bulging icon 30
Emptying 31
Empty Trash command 31
Shut Down command 31
Starting an application 31
Highlighted 30
Icon
Empty 4
Full 4
Removing contents 31
Unfilled 57
User level (Hyper Ca rd) 63 1
Value 353
Variable 356
VDT (See Hardware, Monitor)
View of directory window 23
Warning
Copying a disk 19
Erasing a fo lde r 31
What if... analysis 351
Wide area n etwork 475
Window 11
Active 11

C lose box 10, 11
C losing 11
With Option key 11
Dialog box 13
Directory 6
View 23
By date 24
By icon 25
By name 24
Default 25
Floa ting 716
Miniwindow 716
Title bar 11
Zoom box 11
Word processing 198
Cutting 200
Defaults 201
Document 199
Editing 200
File 199
Formatting 201
Landscape o rientation 201
Portra it orientation 201
l-Iard ca rriage re turn 199
Hard return 199
Paragraph 199
Pasting 200
Prin ti ng 202
Reformat 200
Search and rep lace 200
Spelling ch ecke r 201
Text e ntry 199
Word wrap 199
Word wrap 199
Worksheet (See Spreadsheet )
Wristwatc h poin ter 5
WYSIWYG 35
Zoo m box 11

Macintosh Journey P oject Disk o
The Macintosh Journey Project Disk is designed to accompany A Macintosh Journey with Guided
Projects by John Dilbeck and Nicki Fink.
This disk is not required for the completion of projects in the book, but it wi ll save time entering
data. It includes clip art, several word processing documents with most of the text already entered,
an inventory file for use with FileMaker, and three HyperCard stacks (Glossary, Class Notes Buttons,
and Visual Effects). This inexpensive disk will help you travel quickly through the projects in
A Macintosh Journey.
If you are using A Macirztosh Journey as a text for a course in which you are enrolled, your

instructor will already have this disk. You are authorized to make a copy of your instructor's
disk to use with our book.
To order, complete the coupon below, and mail it to:
Benjamin/Cummings Publishing Company
ATTN: ORDER DEPT.
ljacob Way
Reading, MA 01867-9984
Please allow approximately 10 days for delivery.

Please send me the Macintosh Journey Project Disk (31262-5) to accompany the text
A Macintosh Journey with Guided Projects by john Dilbeck and Nicki Fink.
I understand that the price of the Disk is $2.25 and this covers all costs, including
shipping and handling.
Please enclose a check or money order for $2.25 (payable to Benjamin/Cummings
Publishing Co).

Name: __________________________________~---------------------Organization: ______________________________-:------------------Address: ______________ _ __ _-:--- - - - - - -- - City: ____ _ __ __ _ _ _ _ __ _State: _ ___ Zip:___ __ _ __

Common Command-Key Shortcuts

3€- A
3€- B
3€- c
3€-o
3€- E
3€- F
3€- G
3€-H
3€ - I
3€ - J
3€- K
3€- L
3€-M
3€-N

repeat last command
page view
copy
set character formats
create footnote
find
go to page
change
page view
repaginate document
glossary
spelling checker
reformat paragraph
new (file/ folder I

HypercardrM

• -I
H-u
88- y
H-o
81 -E
81- B
81 - R
81- G

refind
findall

H-s

sort

H- L
H -T

layout

•

•

- y

•

open file
print document/ card
quit
show / hide ruler
save
define styles
enter/leave
outlining mode

3€- v
3€-w
3€- X
3€- y
3€- z
3€- ?
3€-

paste
close
cut
show/ hide

en

H- M
3€ - =
81- B
81- L
81- K
88-o
88- J
88-H
88-G
88- I

help
stop current action

H-u

- +

88--

Excel

88-A
H-A

undo

-4

text style

background
select
select all

keep
back
home

recent
recent
prev(ious)
next
last

88-M message

card/ record)

3€-o
3€- p
38-Q
3€- R
3€- s
3€- T
3€-u

88- T
88- B
88- s
H-A
H- K
88-88-H
81- R
88-1
88-2
H- 3

bring closer
send farther

activat next window

calcula

clear
define arne
delete

from A Macintosh Journey by John Dilbeck and Nicki Fink
© 1991 The Benjamin/Cummings Publishing Company

MacPainfiD

H.- T
H- M
88- L
88-a
88- B
88- I

rotate

zoomin

zoomout

88-u
MacDraw® II
3€- A
3€-o
3€ - E
3€- R

select all
duplicate
smooth
reshape

780805 312607
I SBN 0-8053-1260-9
31260
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Positioning the du plicate objects

Figure 5-46

•

Click on another part of the screen to deselect th e objects.

Mac Draw "remembers" where you placed the last duplicate object with
reference to the original as lon g as you do not deselect the duplicate
object. This feature is one of the reasons that MacDraw works well for
creating business forms and charts. You can create horizon tat vertical,
and diagonal rows of identical objects without having to draw each
ob ject sepa rately or copy thef and then align them in a row. When yo u
position the duplicate object, you establish the spacing and direction of
th e row, and each duplicate is positioned and aligned autom atically.
You' ll use this feature to crea te the rest of the boxes in the second row
of t he organizatio n al chart.

00 - D

•

Select the duplicate box a nd text with in it that you just positioned
in the lower left corner of the screen.

•

Choose Duplicate from Ithe Edit menu.

Whe n you position the du plicate that you just created, you'll establish
the direction an d spacing of the second row of objects.
-

Position the second duplicate box to the right of the original an d
align the top edges of both objects, as shown in Figure 5-47.

james w. Nielsen
. : .. President. ...

0

•

james w. Nielsen·
Pres ident
·

Figure 5-47

•I
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•

C hoose Alignment from the Arrange menu.

•

In th e resulting d ialog box, select Align and Center from th e righ t
portion of the box, and se lect Align and Center from the bottom of
the box, as shown in Figure 5-45.

Alignment ...
® To eoch other

G

181 Align 0
0

0 To grid
181 Align
ODistrlbu te
O Top
®Center
0 Bottom
O IICI!Jhf

Distribute

l e ft ®Center

0

Right

( Co ncel )

Figure 5-45

0

lllldfh

~

The Alignment dialog box

The settings you just chose for this dialog box told MacDraw to align the
objects to the center both vertically and horizontally. Notice that the
sma ll diagram in the dia log box sh ows you the effect these settings w il l
have on the ob jects.
•

Clic k OK to accept the changes you've made to the dialog box.

Now you' ll use the box you just d rew as a template for the others, sin ce
it is already the correct size and has the text centered within it. To do
so, yo u'll dupl icate it.

DUPLICATING USING AUTOMATIC ALIGNMENT
You'll duplicate the box as well as the name inside it, even though you'll
change the na mes in just a mo ment, because you want the text to retain
the same formatting characteristics (New York font, bold, an d centered)
when you re type a d iffe rent name.

3€ - D

•

If both the text and the rectangle are no t a lready selected, select
th em now, and then choose Duplicate from the Edit me nu.

•

Click on the duplicate set of objects, but not o n any of their
h andles . Drag them to the lower left side of the screen, as shown in
Figure 5-46.
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SELECTING OBJECTS
•

To select both the box and the text within it, place the selection
arrow above and to the left of the box and drag diagonally past the
bottom right corner of the box.

A dotted rectangle is created around the objects, as shown in
Figure 5-44. When you releake the mouse button, all objects within the
temporary rectangle are selected. All objects that are selected will have
handles showing.

.

'

:

.

.

fames W. lUelsen

:

.

.

.

· · · · :· · .· · ·President·
· · · · ··.: · · · · · · · .· · · · · · · · .· · · · · · · · .· ·
.

''
''
'- -- ~ ------- -~ -- -- -- - -~
.

.

. . . • . . • . • . • . . • . . . . . . . ·!·

Figure 5-44

Selecting multiple objects

Selecting multiple objects is not the same as grouping objects. Grouping
objects creates one composite object made up of all the objects that are
selected when the Group command is invoked. Selecting multiple
objects enables you to work with all selected objects at one time, but
each can still be selected separately.
Next you'll center the text within the rectangle.

CENTERING TEXT WITHIN A RECTANGLE
The Alignment command allows you to align and distribute selected
objects with each other or with the grid. Aligning refers to moving selected
objects so that their boundaries line up in a specified manner. Distributing
objects spaces them even y in a document, either vertically or
horizontally.
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I!g) Pamela Gurneri I
D Telephone Me~ sag ...

1Q !g) Pamela Gu ...
Eject
Driue

S11ue

Saue drawing as:

I• .6Hit$11UH6111®1
0

® Drawing

Figure 5-42

•

[ C11ncel

St11tlonery

0

PICT

The Save dialog box

Type Organizational Chart in the Save drawing as: box, and then
click the Save button.

Your drawing window should now have the name of your document
and the current layer showing at the top: Organizational Chart-Layer# l.

ADDING TEXT
Now you need to add some text inside the box you just drew. The first
name and title wil l be the company president's name.
•

Click on the text tool to select it, and then click inside the rectangle
in approximately the center of it.

.. Choose New York from the Font menu, and then choose 12 point
from the Size menu.
W- B

•

Choose Bold and then Center from the Style menu.

•

Type the following text in the block, pressing return where indicated:
j ames W. Nielsen (press Return)
President

Your screen should look like the one shown in Figure 5-43.

p ames W. Nie ls-;;j
President! _j

L.

Figure 5 -43

•

.

Adding text to the rectangle

Click somewhere else on the screen to deselect the text tool.
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Figure 5-41

Th e Pen menu

You learned about line weights in Pro ject 1. Th e Pen m enu also offers
diffe rent line styles.
Pla in Line, w hich is checked in the Pen m enu sh own in figure S-41, is
the default line style. The Dash ed Line o ption creates a dash ed line, and
you can custo mize the dash size and space between das hes by choosing
Dashes from the Pen Menu.
An Autosize Line h as the line's len gth autom atically printed in the
midd le. Autosize Lines are used for drawing dimensio n lines that show
the measurem e nt o f obj ects in a drawing, such as in a floor plan.
The Arrow At Start and Arrow At End options enable you to d raw lines
that begin or e nd (or both) with arrowheads. You can m odify the sh ape
of the arrowh ead by choosing Arrows from the Pen menu.
You can use an y combination of line weights, das hes, arrows, and
dimen sions o n any lin e you draw.

SAVING THE DOCUMENT
Before you get too deep into this project, it's a good idea to save what
you 've don e so far and give the d rawing a na me.

8€ -S

•

Ch oose Save from the liile m enu.

Rem ember to be careful ab? ut wh ere you are saving your d ocu ment.
Always verify tha t th e n ame of the d isk (or fo lde r) that you want your
document saved on is sh owirg at th e top of the Save d ialog box-in this
case, wh ere "Pamela Gurnari" is sh owi ng in Figure S-42. If necessa ry,
click the Drive button so t a t you are viewing the correct n a me.

ChapterS: MacDraw II
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•

Double-click on the MacDraw II icon to open a new, untitled
drawing window. If you did not exit Mac Draw after working on the
previous project, choose New from the File menu to get a new,
untitled drawing window.

Keep in mind that if you need to delete an object, select it and press th e
Backspace key (Delete key on some keyboards).
•

Select Show Rulers from the Layout menu.

You will be using the rulers to determ ine the size and spacing of the
objects in your organizational chart.

DISPLAYING THE SIZE OF AN OBJECT
A handy feature in MacDraw 11 is the Slww Size command. The size of a ny
object you draw is immediately reflected on the bottom of the screen as
you draw it. Also, any tim e you click on the border of a n object after it
is drawn, it shows you the size of that object.
•

Ch oose Show Size from the Layout menu .

•

Select the rectangle tool.

•

Create a rectangle 2 inches wide and 1 inch high.

Notice that the size of the rectan gle is displayed at th e bottom of the
screen as you draw it, as shown in Figure 5-40.

~--:-·-·----- ----·--·-i

.!i :... . ..:......i,. .: .. ... .. ..
L.~------:--~ :

Figure 5-40

•

Using the Show Size fea ture

If you clicked elsewh ere on the screen after you drew the rectangle,

click an ywhere o n the rectangle to select it.

CHANGING LINE WEIGHTS
-

To change the thickness of the lines form ing the rectangle, choose
2 point from the Pen menu, as shown in Figure 5-41.
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Acme Toys, Incorporated
I..______
M
_anufacturers

of Fine Toy.s;;.. ________.

james W. Nielsen
President

II
Caro l Garms
Vice-President,
Sales

Jill Aoki
Vice-President,
Manufacturing

II
Mai Nguyen
Sales Manager

II
Richard P. Cleaves
Vice-President,
Finance

II
Samuel Neu jahr
Manufacturing
Manager

Figure 5-39

II
Judith Crippin
Contro ller

final output of Project 2
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~ -A

•

Select both message form s by choosing Select AJI from the Edit me nu.

~-D

•

C hoose Duplicate fro m the Edit m enu.

•

Positio n the two duplica tes o n the bottom portio n of the page, as
sh own in figure 5-38.

' '--:----

Figure 5-38

••---:---

Placing two more duplicate fo rms

ow you have four telephone m essage forms in one docume nt.

PRINTING THE DOCUMENT
Befo re yo u print the d ocument, save your work.
-- Choose Save from the File menu.
Choose Print from the f ile menu. Click OK to accept the d efa ult
print option s an d print o ne copy.
Com pare yo ur printed document with th e o ne sh own in Figure S-14.
~ -Q

•

To exi t MacDraw, choose Quit fro m the Fi le menu. To continue
working on the next exercise and remain in MacDraw, close the
document by clicking in its close box.

Project 2: Creating an Organizational Chart

·

In thi s project you' ll create a corpo rate o rga n iza ti ona l chart. You' ll use

some of the tools a nd comma nds that yo u learned about in the first
project, and yo u' ll a lso learn hand y ways to create some special effects.
You' ll learn about pen and fil l patterns and about ali gn ing a nd arra ng ing
objects. The finished o rga n iza tional cha rt is sh own in Figure S-39.

